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Welcome 
Congratulations on your decision to purchase Dolphin Imaging. You are about to use the best and most advanced imaging and 
diagnostic system in the world. With Dolphin Imaging, you will produce the best records, the most effective consultation 
presentations, and the most accurate cephalometric tracings. In addition, the Dolphin Imaging program is easy to operate. 

This manual describes how to use Dolphin Imaging features to improve information flow in your practice. It describes how to 
capture patient images into the Dolphin Imaging program, perform cephalometric analyses, modify images for patient 
presentations, and use treatment simulation and prediction tools. 
Dolphin Imaging software is designed specifically for dental clinicians and trained assisting staff. Results produced by Dolphin’s 
diagnostic  and treatment planning tools are dependent on the interpretation of trained and licensed practitioners. 
Copyright 

Getting Training 
To help you get the most out of your Dolphin Imaging system, we highly recommend the comprehensive in-office training. You 
can also arrange to attend training in Dolphin’s California facility. Dolphin trainers are experienced and certified in clinical and 
treatment coordination. With this background, they are very knowledgeable in how to enhance your practice by using the imaging 
and diagnostic tools that Dolphin Imaging provides. To arrange a training session, contact Dolphin. 

Contacting Technical Support 
If you need help, you can contact Dolphin in any of these ways: 

By E-mail support@dolphinimaging.com: A support technician will respond to your message within 24 hours. 

By 
Telephone 

Toll free from the US and Canada: 1 800.548.7241  
Toll free from Australia: 1.800.881.011 (wait) 800.548.7241 
Toll free from New Zealand: 000.911 (wait) 800.548.7241 
From all other countries: +1 818.435.1368  
Telephone support hours are 5:00 AM to 6:00 PM Pacific Time (8:00 AM to 9:00 PM Eastern Time). At other 
times, you may leave a message on our emergency pager by calling 1 818.687.6327. 

By Fax +1.818.435.1369 

Web site www.dolphinimaging.com: provides the latest product information and a list of local Dolphin representatives. 

Organization of this Book 
This manual is organized into the following parts: 

• "Part I: Installation" provides step-by-step instructions for installing the Dolphin Imaging Software. 

• "Part II: Dolphin Basics" provides detailed information on using the basic features of the Dolphin Imaging software. 

• "Part III: ImagingPlus" provides detailed information on capturing and sharing patient images. 

• "Part IV: Consultation and Image Library" provides detailed information editing patient images and using the Dolphin 
Image Library.  

• "Part V: Cephalometric Tracing and Analysis" provides information on creating cephalometric analyses, superimposing 
patient tracings over the profile image, superimposing tracings over other tracings, and superimposing two images. 

• "Part VI: Treatment Simulation" provides detailed information on using the CO/CR, treatment simulation, and growth 
features of the Dolphin Imaging software. 
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• "Part VII: Interactive Treatment Analyses" provided detailed information on using the Arnett treatment simulation 
wizard, the McLaughlin Dental VTO Analysis, and the Ricketts VTO/Roth-Williams AEO VTO wizard. 

• "Part VIII: Dolphin Letters System (DLS)" describes how create customized letters using DLS, including how to set up 
patient exam questionnaires to collect the information for use in letters. It also describes creating presentations that 
use the information collected with questionnaires. 

• "Part IX: ImPlanner" describes how to use the Dolphin ImPlanner to plan the placement of implants. 

• "Part X: 3D" describes how to use Dolphin 3D to capture, view, and manipulate 3D images created from most cone-
beam computer tomography (CBCT), MRI, Medical CT, and 3D facial camera systems. 

• "Part XI: Security" describes how to set up practice locations, employee types, and employees in Dolphin Imaging for 
security purposes. 

• "Part XII: Appendices" includes several appendices that provide information that supplements the other parts of the 
manual. 

This manual also includes an Index. 

Typographical Conventions 
File names and directory names: These are shown in boldface Courier. For example: 

The dolphin.ini file contains system settings for the Dolphin Imaging software. 

Optional parameters and variables: Optional parameters appear in square brackets ([]). Variables that you replace with 
actual values are shown in italic boldface courier. In the following example: 

File#=Label, Format, [BitsPerPixel,] FileFormula 
   [ExitRoutineBatchFile=PathName] 

Label, Format, BitsPerPixel, FileFormula, ExitRoutineBatchFile and PathName are all variables that 
you replace with actual values. BitsPerPixel and ExitRoutineBatchFile=PathName are optional parameters, 
which you may omit. 
Keyboard combinations: Keys that you press together are shown with a plus sign between them. Names of keyboard keys 
(such as CTRL, ALT, ESC, or TAB) appear in small capitals. For example: 

Press ALT+O. 

Using the mouse: Whenever this document directs you to click some graphical user interface element, you should move the 
mouse to position the mouse pointer on that element. Then, press and release the appropriate mouse button. 
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Part I: Installation 
This part of the Dolphin Imaging User’s Guide provides detailed information on how to install the Dolphin Imaging software. It 
describes: 

• Installing the standard Dolphin Imaging software 

• Installing Dolphin Premium 

For information on the differences between these two Dolphin Imaging software versions, see "Dolphin versus Dolphin Premium 
with Letter System" on page 16. 
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1 Program Installation 
The Dolphin Imaging website details the system requirements for installing Dolphin Imaging. For information, go to 
http://www.dolphinimaging.com/imaging.html, and click Minimum Requirements. 
The Dolphin Imaging software is distributed on DVD. If you do not have a DVD drive, you can request an installation CD from 
Dolphin. In addition, Dolphin Imaging software updates now can be downloaded automatically over the Internet. 
The following sections describe how to install the Standard Dolphin software and Dolphin Premium. Please follow the procedure 
appropriate to the software you have purchased. 

Installing Standard Dolphin 
Before installing, please note the following requirements for installation: 

• You can mix Dolphin 11 with Dolphin versions 10 or later; you are not required to upgrade all computers in your 
practice at once. However, you cannot mix Dolphin 11 with Dolphin versions earlier than 10. 

• Your computer must meet the minimum system requirements for installing Dolphin Imaging. For information, go to 
http://www.dolphinimaging.com/imaging.html, and click Minimum Requirements. 

Note: Users of Citrix or other terminal service systems have previously been able to take advantage of a loophole, in which they 
could run multiple Dolphin stations with just one security key.  Dolphin 9 closed that loophole, so these customers will need to 
contact Dolphin Sales to obtain a network security key, and they should not install any Dolphin version later than version 9 until 
they receive the network key. 
In addition, please review the following recommendations: 

1. As with any major upgrade, please perform a complete backup of your system before installing the new software! 

2. Shut down any open programs before beginning the installation. 

3. If you are using Dolphin Imaging over a network, make sure that the imaging software has been closed on all the 
workstations. Install this update on the station where your patient files are stored (the server) before updating the other 
workstations! 

To start the installation: 

1. Start up Windows and make sure that you’ve closed any open programs.  

2. Choose one of the following three methods to start the installation process. 

� Place the installation DVD into your DVD drive. The installation will begin automatically. If the DVD was already 
inserted when the computer booted up, eject and reinsert the DVD to begin installation. 

� Start the installation process from Windows Explorer: 

� If you are running Windows XP Pro/SP2 or Windows 2003 Server, double-click on the My Computer icon 
on the desktop. Then, double-click the Dolphin DVD icon. Installation should begin within a few seconds. 

� If you are running Windows Vista, select Computer from the Start menu on the taskbar. Then, double-
click the Dolphin DVD icon. Installation should begin within a few seconds. 
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� Start the installation process from the Start menu: 

� If you are running Windows XP Pro/SP2 or Windows 2003 Server, select Run from the Start menu on the 
task bar. Enter your DVD drive’s location followed by \imaging11 and press ENTER. For example, you 
might type G:\imaging11 and press ENTER. 

� If you are running Windows Vista, enter your DVD drive’s location followed by \imaging11 in the 
Start Search text box on the Start menu, and press ENTER. For example, you might type 
G:\imaging11 and press ENTER. 

The Welcome dialog box appears and lists options for installing the software, viewing the documentation, and installing 
prerequisite software (Internet Explorer and Adobe Reader). If you need to install Internet Explorer, the installation 
program will prompt you to do so.  For information on viewing the documentation and installing Adobe Reader, see 
"Using the Documentation" on page 18. 

3. Click Install Dolphin. 

The following dialog box appears: 

 
4. Follow the instructions on the installation dialog boxes to install the software. 

Near the end of the installation procedure, the following message appears if you have a purple Dolphin Security Key 
plugged into your USB port: 
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If you have a grey Dolphin Security Key plugged into your parallel port, you do not need to remove it to continue with 
the installation. In this case, skip the next step. 

5. If you see the Warning message shown above, remove the Dolphin Security Key plugged into your USB port. Then, 
click Finish. 

The following picture illustrates the purple USB Dolphin Security Key. 

  

Progress dialog boxes appear as the driver for the Dolphin Security Key is installed. When the drivers finishing 
installing, your installation is complete. 

6. If you removed the Dolphin Security Key, plug it back into your USB port before using the Dolphin Imaging software. 
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Installing Dolphin Premium 
Because of Dolphin Imaging's database structure, several components must be installed before the imaging software. There are 
times when user interaction is required, so it is very important that you follow along with the instructions. 
Depending on your system configuration, a technician may need to work with you during the installation: 

• If the workstation that you’re upgrading is stand-alone (not on a network), you can install the software without a 
technician’s help. 

• If you run Dolphin over a network, you may need the assistance of a local technician to prepare your network for the 
database components. Have your local technician call Dolphin for requirements prior to their visit to your office. This 
helps the installation process in a couple ways: 1) The tech will be better prepared for their visit. 2) Dolphin can find out 
when your technician will be visiting your office so that a Dolphin technician can be available if needed. 

The core database installation can take between 15-25 minutes, so please make sure that you have ample time before beginning 
installation. 
  
Before installing, please note the following requirements for installation: 

• You can mix Dolphin 11 with Dolphin versions 10 or later; you are not required to upgrade all computers in your 
practice at once. However, you cannot mix Dolphin 11 with Dolphin versions earlier than 10. 

• Your computer must meet the minimum system requirements for installing Dolphin Imaging. For information, go to 
http://www.dolphinimaging.com/imaging.html, and click Minimum Requirements. 

Note: Users of Citrix or other terminal service systems have previously been able to take advantage of a loophole, in which they 
could run multiple Dolphin stations with just one security key.  Dolphin 9 closed that loophole, so these customers will need to 
contact Dolphin Sales to obtain a network security key, and they should not install any Dolphin version later than version 9 until 
they receive the network key. 
In addition, please review the following recommendations: 

1. As with any major upgrade, please perform a complete backup of your system before installing the new software! 

2. Shut down any open programs before beginning the installation. 

3. If you are using Dolphin Imaging over a network, make sure that the imaging software has been closed on all the 
workstations. Install this update on the station where your patient files are stored (the server) before updating the other 
workstations! 

To start the installation: 

1. Start up Windows and make sure that you’ve closed any open programs.  

2. Choose one of the following methods to start the installation process. 

� Place the installation DVD into your DVD drive. The installation will begin automatically. If the DVD was already 
inserted when the computer booted up, eject and reinsert the DVD to begin installation. 

� Start the installation process from Windows Explorer: 

� If you are running Windows XP Pro/SP2 or Windows 2003 Server, double-click on the My Computer icon 
on the desktop. Then, double-click the Dolphin DVD icon. Installation should begin within a few seconds. 

� If you are running Windows Vista, select Computer from the Start menu on the taskbar. Then, double-
click the Dolphin DVD icon. Installation should begin within a few seconds. 
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� Start the installation process from the Start menu: 

� If you are running Windows XP Pro/SP2 or Windows 2003 Server, select Run from the Start menu on the 
task bar. Enter your DVD drive’s location followed by \imaging11_premium and press ENTER. For 
example, you might type G:\imaging11_premium and press ENTER. 

� If you are running Windows Vista, enter your DVD drive’s location followed by 
\imaging11_premium in the Start Search text box on the Start menu, and press ENTER. For 
example, you might type G:\imaging11_premium and press ENTER. 

The Welcome dialog box appears and lists options for installing the software, viewing the documentation, and installing 
prerequisite software (Internet Explorer and Adobe Reader). If you need to install Internet Explorer, the installation 
program will prompt you to do so.  For information on viewing the documentation and installing Adobe Reader, see 
"Using the Documentation" on page 18. 

3. Click Install Dolphin. 

The Dolphin Imaging installation procedure starts. 

4. Follow the instructions on the installation dialog boxes until the following dialog box appears: 
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5. Select the type of workstation on which you are installing Dolphin Imaging. Then, click Next >. 

Select from the following options: 

Stand-alone (not 
networked) 

Select this option if you are installing Dolphin Imaging on a stand-alone workstation—that 
is, a workstation that is not networked to other workstations. If you select this option, 
continue your installation with the "To install the database components" procedure, 
below. 

Networked: IS 
Dolphin SQL 
database server 

Select this option if you are installing Dolphin Imaging on a workstation that is networked 
to other workstations and is the workstation on which you want to store the Dolphin 
database. If you select this option, continue your installation with the "To install the 
database components" procedure, below. 

Networked: IS NOT 
Dolphin SQL 
database server 

Select this option if you are installing Dolphin Imaging on a workstation that is networked 
to other workstations but is not the workstation where the Dolphin database is stored. If 
you select this option, continue your installation with the "To install the Dolphin Imaging 
Software" procedure. 

I don't know which 
of the above apply 

Select this option if you do not know whether the workstation is standalone, is a 
networked Dolphin Imaging database server, or is a networked Dolphin Imaging 
workstation that is not the server. If you select this option, a message appears directing 
you to contact your Dolphin support technician to determine the type of workstation. 

If you are installing the Dolphin Imaging software on a networked workstation, you need to work with a Dolphin support 
technician. The following dialog box gives you the option of exiting the installation procedure so that you can make an 
appointment with a Dolphin support technician. 

 

6. Click Yes to continue the installation procedure on your networked workstation. 

Or, 

Click No to exit the installation procedure. 

If you click No, the installation procedure exits. Once you have made an appointment with a Dolphin support 
technician, you can start the installation procedure again. 
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To install the database components: 
If you are installing the Dolphin Imaging software on a stand-alone workstation or on a network workstation that is the database 
server, you see several progress dialog boxes as various database components are installed. Installing the database 
components may take several minutes. When the database component installation completes, the following dialog box appears: 

 
This dialog box is the beginning of the Dolphin Imaging software installation. Continue your installation with the "To install the 
Dolphin Imaging Software" procedure, below. 
Note: During the database component installation, you may see one or more of the following dialog boxes: 

 
These dialog boxes are related to the installation of the Microsoft SQL Server for the database. You can simply ignore these 
dialog boxes, and they should eventually close on their own.  
Note: If this is the first time you are installing Dolphin Imaging, SQL Server Management Studio Express will be installed along 
with Microsoft SQL 2008. 
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To install the Dolphin Imaging software: 
The Choose Destination Location dialog box shown below is the beginning of the Dolphin Imaging software installation. 

 

1. If you are installing the software on a networked workstation that is not the Dolphin server, follow the instructions on 
the installation dialog boxes until the following dialog box appears: 
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If you are installing the software on a stand-alone workstation or on a networked workstation that is the Dolphin server, 
this dialog box does not appear, and you should skip the next step. 

2. If you are installing the software on a networked workstation that is not the Dolphin server, enter the name of the 
server. Then, click Next. 

3. Follow the instructions on the installation dialog boxes to install the software. 

4. On the last installation dialog box, click Finish.  

Note: Make sure your Dolphin Security Key is plugged in before using the Dolphin Imaging software. 

• If you have a grey Dolphin Security Key, plug it into your parallel port.  

• If you have a purple Dolphin Security Key, plug it into your USB port. The following picture illustrates the purple USB 
Dolphin Security Key. 

  

If you have installed the Dolphin Imaging software on a networked computer that is your Dolphin server, complete the steps 
below to configure it. 
Note: Stand-alone workstations and networked workstations that are not Dolphin servers do not need this configuration.  
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To configure your Dolphin server: 

1. If you are running Windows XP Pro/SP2 or Windows 2003 Server, select Run from the Start menu on the task bar. 
Type CLICONFG in the resulting dialog box, and click OK. 

Or, 

If you are running Windows Vista, type CLICONFG in the resulting dialog box in the Start Search text box on the Start 
menu, and press ENTER.  

The CLICONFG program starts, and the SQL Server Client Network Utility dialog box shown below appears: 

 

2. Make sure that the Enable shared memory protocol box is not checked. Then, click OK. 
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Part II: Dolphin Basics 
This part of the Dolphin Imaging User’s Guide provides detailed information on using the basic features of the Dolphin Imaging 
software. It describes: 

• Using the documentation and online help 

• Starting and exiting from the software 

• Using the Menus and dialog boxes 

• Using the Dolphin Imaging Main Screen 

• Using the Patient Charts or Patient Lookup features to add patients and timepoints 
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2 Introduction 
Dolphin Imaging is designed for orthodontic, oral maxillofacial surgery, and dental-specialty practices. Dolphin Imaging can assist 
your practice in the following ways: 

• Electronically store and organize patient photographs, radiographic images, and study model images.  

• Perform computerized cephalometric analyses using standard analyses or your own customized analysis. 

• Easily emphasize the condition or area of concern by zooming in on the patient’s picture on the computer screen or by 
altering the patient’s picture. 

• Establish treatment goals by showing how the patient may look during and after treatment.  

• Simulate surgical and orthodontic treatment outcomes based on scientific rules. 

• Predict skeletal and soft tissue growth based on the Bolton and Ricketts studies.  

• Create customized letters with pictures to patients, doctors, and other parties. 

• Create, customize, and save slide show presentations. 

• Drag-and-drop images into any application that supports drag-and-drop. 

• Print patient images and treatment forecasts in pre-defined or customized layouts. 

Dolphin versus Dolphin Premium with Letter System 
Since its inception, Dolphin Imaging software has stored only a small amount of personal information for each patient. While this 
scheme was initially adequate, we wanted to enhance Dolphin into a full database application. A real database allows for true 
searching and sorting of information. It also allows for storing much more detailed information for each patient. And finally, it 
allows us to develop a much richer set of features in the future, taking advantage of existing and future database technologies. 
Since Dolphin version 6.5, the Dolphin product has been split into two levels: The standard Dolphin and the Premium, full 
database version of Dolphin. Two major benefits in the Premium version are:  

• Storage of far more detailed patients information 

• An entirely new Dolphin Letter System that extracts from this rich pool of data. 

• Many advanced features, such as integration with our Dolphin Management product, AnywhereDolphin, 
capture/storage/playback of .AVI movie clips, multi-patient archive save and load, the ABO Electronic Casebook, 
Dolphin 3D and Dolphin Aquarium. 

However, there are some trade-offs with this system. Since this is a far more powerful database application, it requires more 
powerful host computers.  
Note: Switching from the existing-mode Dolphin to new Dolphin Premium with Letter System is a one-way process. Once you 
make the move to Dolphin Premium, you cannot return to standard Dolphin. 
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Trade-Offs of Standard Dolphin versus Dolphin Premium with Letter System 
The following table lists the trade-offs between the two versions, so you can decide if you are ready to make the jump to Dolphin 
Premium, or if you should stick with the standard Dolphin: 
Dolphin 11 Dolphin 11 Premium 
1:1 calibration, printing and measuring on any image; 
new program look; layout object; enhanced custom 
analysis editor; overlay digitizing. Many other new 
features. 

1:1 calibration, printing and measuring on any image; new program 
look; layout object; enhanced custom analysis editor; overlay 
digitizing. Many other new features. 

Same data capabilities as prior non-Premium Dolphin 
versions. 

Premium database capabilities, including enhanced personal 
information, enhanced patient search, multi-patient archive, storage 
of patient diagnostic information, HIPAA data security with login and 
event logging, AVI movie storage and playback, optional Digital 
Imaging and Communications in Medicine (DICOM) support, etc. 

Does not support AnywhereDolphin system Supports AnywhereDolphin system 
Does not support Dolphin Management system Built around "Dolphin Platform Database" – the foundation of both 

Dolphin Imaging Premium and Dolphin Management. 
Does not support capture, storage, and playback of .AVI 
movie clips. 

Offers capture, storage, and playback of .AVI movie clips. 

Does not support multi-patient archive save and load. Offers multi-patient archive save and load. 
Does not support the ABO Electronic Casebook. Supports the ABO Electronic Casebook. 
Does not support Dolphin 3D. Supports Dolphin 3D. 
Does not support Dolphin Aquarium. Supports Dolphin Aquarium. 
Can run on any computer running Windows 98 or newer 
that currently runs standard Dolphin versions 6 – 10. 

Requires a minimum of a Intel PENTIUM III or compatible processor 
running Windows XP Pro with SP 2. Works better with more memory 
and faster CPUs. 

Works with our old Dolphin Letter System. Will not work 
with the Premium Dolphin Letter System. 

Works with our more powerful Dolphin Premium Letter System. 

Choosing Dolphin or Dolphin Premium 
If your Dolphin computers are older and slower, and do not meet our database-mode requirements, you will need to upgrade 
your hardware before you can make the switch to Dolphin Premium with Letter System. However, if you have newer computers, 
and if you want to use our new Letter System, then you are ready to make the move to Dolphin Premium with the new Letter 
System! 
If you have questions, please contact Dolphin for help in deciding which version is right for you. 
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Using the Documentation 
This manual is distributed both in electronic form in Adobe® portable document format (PDF). You can use Adobe Reader to 
view this manual online or print any or all of the pages. Adobe Reader is available free from the Adobe Systems web site. The 
Dolphin installation program provides a link to the Adobe Systems website for your convenience. 

To install Adobe Reader from the Dolphin installation program: 

1. Start the Dolphin installation program. 

For information on starting the Dolphin installation program, see "Installing Standard Dolphin" on page 4 or "Installing 
Dolphin Premium" on page 7. 

2. Click Install Adobe Reader. 

3. Follow the instructions on the Adobe Systems web site to install Adobe Reader. 

To view the documentation from the Dolphin installation program: 

1. Start the Dolphin installation program. 

For information on starting the Dolphin installation program, see "Installing Standard Dolphin" on page 4 or "Installing 
Dolphin Premium" on page 7. 

2. Click View What's New to view a list of enhancements for this version. 

Or, 

Click View Getting Started Guide to view the Dolphin Imaging Getting Started Guide. 

Or, 

Click View Complete Manual to view the Dolphin Imaging Users Guide. 

To view the documentation after installation (Windows XP Pro/SP2 or Windows 2003 Server): 

1. From the Microsoft Windows Start menu, select Programs.  

2. Select the Adobe folder from the Programs cascade menu. 

3. To open a documentation file, select Open from the File menu. 

A dialog box appears from which you select the file to open. 

4. Select the Dolphin.pdf file on the CD-ROM in the top-level directory. 
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To view the documentation after installation (Windows Vista): 

1. From the Microsoft Windows Start menu, select All Programs.  

2. Select the Dolphin folder. 

3. Click What's New to view a list of enhancements for this version. 

Or, 

Click Getting Started to view the Dolphin Imaging Getting Started Guide. 

Or, 

Click Dolphin Manual to view the Dolphin Imaging Users Guide. 

To print the manual: 

1. Open the file you want to print in Adobe Reader as described above. 

2. Select Print from the File menu. 

A dialog box appears where you specify printing options. 

3. Specify any printing options and click OK. 

Using the Online Help 
The online help provides the same information as the printed manual, but in an easy-to-use online format. The Dolphin Imaging 
online help is a Microsoft HTML Help system. The following information will get you started using the online help. For more 
detailed information on using the online help, refer to your Microsoft documentation. 

To open the online help: 

1. Choose Contents from the Help Menu. 

Or, 

Press F1 from any dialog box.  

Or, 

Click ? on any dialog box where it appears. 

If you press F1 or click ?, the online help opens to the topic for the dialog box you are currently using. If you choose 
Contents from the Help Menu, the online help opens at a default topic. 

The following figure illustrates the online help: 
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To use the Table of Contents: 

1. Using the Contents tab in the left pane, click the topic you want to view. 

Or, 

Using the Contents tab in the left pane, click the plus sign (+) next to a book to open the book. Then, click a topic within 
that book. 

Or, 

Using the Contents tab in the left pane, click a book to view the topic associated with it. 

Only some books have associated topics. Some books are simply containers for topics within the book. 

To use the Index: 

1. Click the Index tab to open the index. 

2. Type a keyword in the text box to find topics indexed under that keyword. 

Or, 

Use the scroll bar next to the Index tab to scroll through the index.  

3. Double-click an index keyword to open the related topic. 

If more than one topic is associated with the keyword you picked, a dialog box appears listing the associated topics. 

4. If a dialog box listing topics appears, click one of the topics in the list. Then, click Display. 
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To use the Search capability: 

1. Click the Search tab. 

2. Enter one or more keywords to search for. 

3. Select any other options for your search criteria. 

4. Click List Topics to list all topics that meet your search criteria. 

The matching topics are listed on the Search tab. 

5. Select a topic in the list. Then, click Display to view that topic. 

 
Type in the Words to 
Search For 

Type one or more search keywords in this text box to search for topics containing those words, or 
select from the drop-down list of previously-entered search keywords. 

 
Click this button to combine the search keywords using AND, OR, NEAR, or NOT. 
AND: Matching topics contain the keywords on both sides of this conjunction. 
OR: Matching topics contain a keyword on either side of this conjunction. 
NEAR: Matching topics contain the keywords on both sides of this conjunction in close proximity 
to each other. 
NOT: Marching topics contain the keyword on the left side of the conjunction and do not contain 
the keyword on right side of this conjunction. 

List Topics Click this button to list all topics that meet the search criteria. 

Display Click this button to display the topic selected in the list of matching topics. 

Select Topic  Lists the topics that meet the search criteria. 

Search Previous 
Results 

Check this check box to search the results of the previous search. Using this option, you can 
easily narrow a search by adding additional search criteria. 
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Match Similar Words Check this check box to include topics containing words similar to the search keywords in your 
list of matching topics. 

Search Titles Only Check this check box to include topics containing the search keywords in their titles in your list of 
matching topics. 

Mastering the Basics 
Dolphin Imaging provides an easy-to-use graphical interface based on the Microsoft Windows operating system. If you are 
familiar with Microsoft Windows, you’ll find that many Windows concepts apply to the Dolphin Imaging program. If you are not 
familiar with Microsoft Windows, there are several ways to learn. Some sources are listed below: 

• Microsoft Windows Documentation: Microsoft Windows includes online documentation that provides instructions on 
how to use the Microsoft Windows features. Select Help and Support from your computer's Start menu to access the 
Microsoft Windows online documentation. 

• Books, videos, and CDs and DVDs: Many bookstores and libraries have a large variety of materials on learning 
Microsoft Windows. 

• Classes: Some schools and computer training businesses provide training on using Microsoft Windows. Check your 
telephone directory yellow pages under Computer Training or Schools or search for computer training on the world 
wide web. 

The following sections describe some of the basics for using Dolphin Imaging. 

Starting Dolphin Imaging 

To start Dolphin Imaging from the Microsoft Windows desktop: 

1. Click the Dolphin Imaging shortcut . 

To start Dolphin Imaging from the Microsoft Windows Start menu: 

1. From the Microsoft Windows Start menu, select All Programs.  

2. Select the Dolphin Imaging folder from the All Programs cascade menu. 

3. Select the Dolphin Imaging program icon in the Dolphin Imaging folder. 

If you do not have the Dolphin Imaging security utilities installed and enabled, Dolphin Imaging starts, and the Patient Charts 
(standard Dolphin) or Patient Lookup (Dolphin Premium) dialog box is displayed. For more information, see Chapter 4. 
If you have the Dolphin Imaging security utilities installed, a dialog box appears asking you to log in to Dolphin Imaging, as 
shown below. 
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User Name Enter you Dolphin Imaging user name. 

Password Enter you Dolphin Imaging password. 

Location Optionally, select an office location. This drop-down list box is used for multi-office practices only. 

To log in: 

1. Type your user name in the User Name text box. 

Or, 

If your practice uses finger scan login, use the fingerprint scanner to enter your fingerprint. 

2. Type your password in the Password text box. 

3. Optionally, select a location from the Location drop-down list box. 

4. Click OK. 

Dolphin Imaging starts, and the Patient Charts (standard Dolphin) or Patient Lookup (Dolphin Premium) dialog box is 
displayed. For more information, see Chapter 4. 

Using Menus 
At the top of the Dolphin Imaging main screen, there are several menus that you can use to access program features, shown 
below. 

 
The items available on these menus are described in detail in Chapter 3. 

To choose a menu item using the mouse: 

1. Click with the left mouse button on the name of the menu containing the item you want to choose. 

The menu drops down below the menu name. 

2. Drag the mouse until the mouse pointer points to the menu item you want to choose and click. 

As you drag the mouse, a highlight bar indicates the currently-selected menu item. 
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Using Cascade Menus 
Some menu items lead to cascade menus, which offer further choices. The following figure illustrates a cascade menu.  

 

To use a cascade menu: 

1. Click with the left mouse button on the name of the menu containing the item you want to choose. 

The menu drops down below the menu name. 

2. Drag the mouse until the mouse pointer points to a menu item that leads to a cascade menu (indicated by an arrow to 
the right of the menu item). 

As you drag the mouse, a highlight bar indicates the currently-selected menu item. When a menu item leading to a 
cascade menu is highlighted, the cascade menu appears. 

3. Drag the mouse until the mouse pointer points to the cascade menu item you want to choose and click. 
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Using Keyboard Shortcuts 
Keyboard shortcuts help you choose menu items quickly. Keyboard shortcuts are listed to the right of some menu items, as 
illustrated below. 

 

To use keyboard shortcuts: 

1. Simply press the indicated key or key combination to access that menu item. 

You do not need to open the menu first. 

Using Tool Bars 
Tool bars are used in Dolphin Imaging to provide quick access to the most commonly used functions. The Dolphin Imaging main 
screen and some of the program’s other dialog boxes use tool bars. The following figure shows the main screen’s horizontal tool 
bar to illustrate how you use the tool bar. 

 
This tool bar has three basic types of elements: 

button To access other dialog boxes in the Dolphin Imaging program, click the associated button with the mouse. The 
button name may contain an underlined letter, which indicates a keyboard shortcut. To use the keyboard shortcut 
for that button, press the ALT key and the shortcut key at the same time. 

drop-down 
list box 

To make selections from a list in a drop-down list box, click the arrow button on the right side of the box to open 
the list. Holding the mouse button down, drag the mouse to move the selection bar to the item you want to select. 
Then, release the mouse button. 
The drop-down list box name may contain an underlined letter, which indicates a keyboard shortcut. To use the 
keyboard shortcut, press the ALT key + the shortcut key to open the list. Then, use the UPARROW and DOWNARROW 
keys to move the selection bar to the item you want to select. 
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tabs To open another view in a dialog box, click the associated tab. In the illustration above, the tabs access the patient 
images for the indicated timepoints. 

Note: To see a brief description of any element on a tool bar, place your mouse over that element. The example below shows 
the message that appears if you place your mouse over the Email button. 

 

Entering Information in Dialog Boxes 
Use dialog boxes to enter, change, or view information in the Dolphin Imaging program. The following figure shows the Patient 
Lookup dialog box to illustrate how to use dialog boxes. 

 
This dialog box has the following types of elements: 

drop-down 
list box 

To select information in a drop-down list box, click the arrow button. Then, choose from the list of entries. To type 
information into a drop-down list box, click the box to place the cursor in it. Then, type the information you want to 
enter.  

button To activate the feature or action associated with a button, click the button with the mouse. The button name may 
contain an underlined letter, which indicates a keyboard shortcut. To use the keyboard shortcut for that button, 
press the ALT key and the shortcut key at the same time. 

tab To view or enter information on a tab, click the tab with the mouse. In the example above, the Info tab is currently 
selected. 
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check box To activate the program feature associated with a check box, check the check box by clicking it with the mouse. 
Click the check box again to uncheck it (deactivate that feature). 

radio 
button 

To select the option associated with a radio button, click the radio button with the mouse. Radio buttons are 
associated with mutually-exclusive choices. You can only select one option from a group of radio buttons. 

text box To enter information into a text box, click the box to place the cursor in it. Then, type the information you want to 
enter. If there are several text boxes in a dialog box, you can press the TAB key to move from one text box to the 
next. Press SHIFT+TAB to move to the previous text box. 

list box To make selections from a list, click the item that you want to select. Some dialog boxes, such as the example 
above, provide buttons labeled >> or << that you click to move options between list boxes. 

sizing 
gripper 

Many Dolphin dialog boxes are resizable, and many resizable dialog boxes have a "sizing gripper." To resize the 
dialog box, click and drag the sizing gripper or any corner or edge of the dialog box. 

Note: On a dialog box, you can see a brief description of any button, text box, list box, drop-down list box, radio button, or check 
box by placing your mouse over an element. The example below shows the message that appears if you place your mouse over 
one of the buttons on the Patient Lookup dialog box. 

 
The following figure illustrates three commonly-used buttons in the Dolphin Imaging Program.  

 

OK Click this button when you have finished using a dialog box to accept any changes or selections you have made and 
close the dialog box. 

Cancel Click this button to cancel your work on the current dialog box and close it. 

? Click this button to access the Dolphin Imaging online help system. 

Note: In some cases, the OK and Cancel buttons do not have text labels. 
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The Status Bar 
The status bar is displayed at the bottom of the Dolphin window.  To display or hide the status bar, select Show Status Bar from 
the View menu. 
The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus.  This area 
similarly shows messages that describe the actions of tool bar buttons as you depress them, before releasing them.  If after 
viewing the description of the tool bar button command you wish not to execute the command, then release the mouse button 
while the pointer is off the tool bar button. 
The right areas of the status bar indicate which of the following keys are latched down: 
Indicator  Description 
CAP  The Caps Lock key is latched down. 

NUM  The Num Lock key is latched down. 

SCRL  The Scroll Lock key is latched down. 

 

Exiting the Program 

To exit from Dolphin Imaging: 

1. Click the close icon  on the Dolphin Imaging main screen’s title bar. 

Or, 

Choose Exit from the File menu. 

If you are running Dolphin Premium with the Prompt on Exit preference option enabled and have not performed a pre-
backup in the past 24 hours, the dialog box shown below appears. 

2. If you have finished using Dolphin Premium for the day, click Pre-Backup and Exit to perform the pre-backup 
procedure before exiting. 

Or, 

If you expect to use Dolphin Premium again the same day as your initial session, click Exit Immediately to skip the pre-
backup procedure. 

If you are performing a pre-backup, see "To perform a pre-backup" on page 29 for more information. 
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Pre-backup and Exit Click this button to perform the pre-backup procedure, then exit. 

Exit Immediately Click this button to exit Dolphin Premium without performing a pre-backup. 

Don't Exit Return to Dolphin Imaging. 

To perform a pre-backup: 

1. When you exit from Dolphin Premium, click Pre-Backup and Exit  on the prompting dialog box. 

Or, 

Select Pre-Backup from the File menu. 

The pre-backup procedure is an important step to properly back up your image database. It prepares your system for a 
backup by moving the Dolphin patient data from the SQL Server locations to the Dolphin Working directory. When your 
backup procedure backs up your Dolphin Working directory, all patient data, including data stored in the database, will 
be backed up. 

2. Perform your regular backup routine to back up your computer. 
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3 The Dolphin Imaging Main Screen 
The main screen displays a series of patient pictures and provides buttons for accessing other areas of the Dolphin Imaging 
program. The main screen is displayed when you click OK or Cancel from the Patient Charts (Standard Dolphin) or Patient 
Lookup (Dolphin Premium) dialog box. The following figure illustrates the main screen: 

 
Note: If the menu bar and tool bars are not visible, the main screen is in Full Screen Mode. To return the screen to the format 
shown above, click the picture layout or press ESC. If the menu bar is visible, but the tool bars are not, select Show Toolbars from 
the View menu. 
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Menu bar Contains menus that you can use to access program features. For more information, see "The Menu 
Bar" on page 54. 

Horizontal tool bar Contains buttons that you use to access program feature For more information, see "The Horizontal 
Tool Bar" on page 73. 

Layout Drop-Down 
List Box 

Lists the image layouts that you can display. Each image layout contains a pre-define group of pictures 
in a specific arrangement. 

Timepoint Tabs Enables you to select the timepoint for which you want to view pictures. Dolphin Imaging uses 
timepoints to group related sets of patient pictures and X-rays. 

Vertical tool bar Contains buttons that you use to access program features. For more information, see "The Vertical 
Tool Bar" on page 72. 

Magnifying glass Indicates the picture that is currently selected.  

Image layout Displays patient pictures for the selected timepoint in the selected layout. The image layout is selected 
from the Layout drop-down list box on the horizontal tool bar.  

The Image Pop-Up Menu 
The Image pop-up menu provides options for working with the image layout and the images it contains. 

To access the Image pop-up menu: 

1. Right-click any image in the image layout. 

The Image pop-up menu is displayed.  



3 The Dolphin Imaging Main Screen Part II: Dolphin Basics 

DI_USER_GUIDE-11.5   Rev. 1.01 33 

 
The Image pop-up menu contains the following choices: 

Maximize or 
Restore 

Maximizes this image, so that it takes up the entire Dolphin Imaging main screen. If the image is already 
maximized, the Restore choice appears instead, enabling you to return to the image layout.  For more 
information, see below. 

Paste From 
File 

Pastes an image from an image file into this location in the image layout. For more information, see "To paste 
an image from a file'" on page 37. 
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Display 
Another Image 

Opens a dialog box where you can select another image captured for this patient to display temporarily instead 
of this image in the image layout. For more information, see "To temporarily view another patient image in 
place of the current image" on page 38. 

Play Plays a video file using the default player registered on your computer for the video file type. This option is only 
available if you right-click the image placeholder for a video file. For more information, see "To play a video 
file" on page 38. For information on capturing a video file, see "To capture a video file" on page 159. 
Note: Currently, only .avi files are supported.  

Open Report Opens a report that was saved from Dolphin 3D to a slot in this image layout. For more information, see "To 
open a report saved from Dolphin 3D"  on page 39. 

Add to Image 
Library 

Adds this image to the Image Library. For more information, see "To add an image to the Image Library" on 
page 287. 

Save As... Saves this image and any tracings to a file on your computer. For more information, see "To save an image to 
a file" on page 39. 

Save Original 
As... 

Saves the original (uncropped, unenhanced) image to a file on your computer. This option is only available for 
images for which an original version was saved during capture. For more information on using this menu item, 
see "To save an image to a file" on page 39. For more information on setting One-Click capture preferences to 
save the original image, see "To set One-Click Capture preferences" on page 174. 

Save Layout 
As... 

Saves this image layout to a file on your computer. For more information, see "To save an image layout to a 
file" on page 40. 

Save Movie 
as... 

Saves this movie to a file on your computer. For more information, see "To save a movie to a file”on page 42. 

Copy  Image Copies the image you are currently viewing to the clipboard. For more information, see "To copy an image to 
the clipboard" on page 42. 

Copy 
Uncropped 
Image 

Copies the original (uncropped, unenhanced) image to the clipboard. This option is only available for images 
for which an original version was saved during capture. For more information on using this menu item, see "To 
save an image to a file" on page 39. For more information on setting One-Click capture preferences to save 
the original image, see "To set One-Click Capture preferences" on page 174. 

Copy Image 
To Resolution 

Copies the image you are currently viewing to the clipboard at the resolution you select. For more information, 
see "To copy an image or layout at a specified resolution" on page 42. 

Copy Layout Copies the image layout to the clipboard. For more information, see "To copy an image to the clipboard" on 
page 42. 
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Copy Layout To 
Resolution 

Copies the image layout to the clipboard at the resolution you select.  For more information, see "To 
copy an image or layout at a specified resolution" on page 42. 

Delete Image Deletes the selected image. For more information, see "To delete an image" on page 43. 

Image Enhance (View 
Only) 

Opens the Enhance Image dialog box so that you can temporarily apply enhancement operations to 
this image. If you have zoomed in on the image, the image is zoomed in the Enhance Image dialog 
box. This option is available on view workstations only. With this option, you cannot save the enhanced 
image. For more information, see "To enhance a picture" on page 164. 

Image Calibration... Opens a dialog box where you specify information that Dolphin Imaging uses to scale the patient’s 
image so that you can print it life size or measure distances and angles on the image (see " To open 
the Image Calibration dialog box " on page 45).  

Image 
Measurements... 

Opens a dialog box where you measure distances and angles on a calibrated image. For more 
information, see " To open the Image Measurements dialog box " on page 47. 

DICOM: Upload 
Current Image to 
Server 

Uploads the currently-selected image to a Digital Imaging and Communications in Medicine (DICOM) 
server. This option is enabled only if you have Dolphin Premium and have purchased the optional 
DICOM Support module. Before uploading images, you must set up communications between Dolphin 
Imaging and your DICOM server. For more information, see "Setting Up DICOM Communication" on 
page 85. 

DICOM: Upload 
Current Layout to 
Server 

Uploads this image layout to a DICOM server. This option is enabled only if you have Dolphin Premium 
and have purchased the optional DICOM Support module. Before uploading an image layout, you must 
set up communications between Dolphin Imaging and your DICOM server. For more information, see 
"Setting Up DICOM Communication" on page 85. 

3D View... Opens Dolphin 3D so that you can view the selected 3D image. This option is enabled only if you select 
a 3D image. For more information, see "Viewing or Editing an Existing 3D Image" on page 614. 

3D Edit... Opens Dolphin 3D so that you can edit the selected 3D image.  This option is enabled only if you select 
a 3D image.  For more information, see "Viewing or Editing an Existing 3D Image" on page 614. 

Properties Opens a dialog box where you can enter properties for this image. This option is available only for 
Dolphin Premium. 

To maximize an image: 

1. Click the image that you want to maximize. 

Or,  

Right-click the image, and select Maximize from the Image pop-up menu. 

The image expands to fill the Dolphin Imaging main screen and the zoom and align tool bar appears, as shown below. 
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Click these buttons to zoom in or out on the currently-selected image. You can also use the mouse wheel to zoom 
in and out. 

  
Click this button to fit the image in the window and align it in the center of the window. 

  
Click this button to fit the image in the window and align it at the right side of the window.  

  
Click this button to open or close the Zoom/Pan window to zoom in on a particular area of the image.  

  
Click this button to open or close the Zoom/Pan window and reposition the image in the window. 
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To return to the image layout after maximizing an image: 

1. Click again or press any key (other than SHIFT or CTRL) to see all the images in the image layout. 

Or, 

Right-click the maximized image, and select Restore from the Image pop-up menu. 

To toggle display of the zoom and align tool bar: 

1. Select Show Zoom-Pan Dialog from the View menu. 

To paste an image from a file: 

1. Right-click an image that you want to replace with an image from a file. Then, select Paste From File... from the Image 
pop-up menu. 

The Select Image File dialog box appears. 

2. Specify the directory and file containing the image that you want to paste into this image layout. 

When you select an image file, the Select Image File dialog box displays a thumbnail of the image. 

3. Click Open to paste the selected image into the image layout.  
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To temporarily view another patient image in place of the current image: 

1. Right-click the image, and select Display Another Image from the Image pop-up menu. 

Or, 

Select List All Images... from the View menu. 

The dialog box shown below is displayed. 

 

2. Select the image that you want to use, and click OK. 

The image you selected appears in the image layout. 

To play a video file: 

1. Right-click the image placeholder for the video file, and select Play from the Image pop-up menu. 

Or, 

Click  on the image placeholder for the video file. 

The default video player registered on your computer for the video file type launches in a new window. 

2. Play the video file in the video player window. 

3. When you finish playing the video, close the video player window. 

For information on capturing a video file, see "To capture a video file" on page 159. 
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To open a report saved from Dolphin 3D: 

1. Right-click the image placeholder for the report, and select Open Report from the Image pop-up menu. 

The report opens in the Dolphin Imaging Report window. For more information, see " To open the Dolphin 3D Report 
Editor " on page 887.  

To save an image to a file: 

1. Right-click the image you want to save, and select Save As... from the Image pop-up menu. 

Or, 

Right-click the image for which you want to save the original (uncropped, unenhanced) version, and select Save 
Original As... from the Image pop-up menu. 

The Save Dolphin Image As dialog box appears. 

2. Specify the directory and file in which you want to save the image. 

3. Optionally, select any other options from the drop-down list boxes.  

Depending on the image type you select in the Save As Type drop-down list box, additional options may be available in 
the other drop-down list boxes.  

Note: If you select one of the JPEG 2000 file types, an additional button appears on the Save Dolphin Image As dialog 
box that enables you to set advanced options.  

4. Click Save. 

The image and any tracings are saved in the specified file. 
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Most options on this dialog box are described in the Microsoft Windows documentation.  
You can use the Save As Type drop-down list box to select the graphics file type that you want to use when saving this image. 
JPEG 24-bit is recommended for producing high quality images with a small file size and maximum compatibility between 
imaging programs. Typically, you should use the default selections for all other options. Only modify these options if you are very 
familiar with graphics files types. 

To save an image layout to a file: 

1. Right-click an image in the image layout you want to save. Then, select Save Layout As... from the Image pop-up 
menu. 

The Save As dialog box appears. 

2. Specify the directory and file in which you want to save the image layout. 

3. Optionally, select the graphics file type that you want to use from the Save As Type drop-down list box. 

Depending on the image type you select, additional options may be available in the other drop-down list boxes.  

4. Optionally, check the Save Individually box to save each image in the layout in a separate file. 

If you select this option, several files will be created in the directory you chose. These files will automatically be 
assigned names of the following format: 

SpecifiedFileName ImageSlotName.ext 
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For example, suppose you save the Composite (6) image layout, enter Jane Smith in the File Name text box, and 
select JPEG in the Save As Type drop-down list box. The following files will be created (assuming you have images in 
all the image slots): Jane Smith Facial Front.jpg, Jane Smith Facial Front Smiling.jpg, Jane Smith Facial Profile.jpg, 
Jane Smith Intraoral Center.jpg, Jane Smith Intraoral Right.jpg, and Jane Smith Intraoral Left.jpg. 

5. Optionally, select any other options from the drop-down list boxes.  

Note: If you select one of the JPEG 2000 file types, an additional button appears on the Save Dolphin Image As dialog 
box that enables you to set advanced options.  

6. Click Save. 

 
Most options on this dialog box are described in the Microsoft Windows documentation.  
You can use the Save As Type drop-down list box to select the graphics file type that you want to use when saving this image. 
JPEG 24-bit is recommended for producing high quality images with a small file size and maximum compatibility between 
imaging programs. Typically, you should use the default selections for all other options. Only modify these options if you are very 
familiar with graphics files types. 
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To save a movie to a file: 

1. Right-click the slot for the movie you want to save in the image layout. Then, select Save Movie As... from the Image 
pop-up menu. 

The Save As dialog box appears. 

2. Specify the directory and file in which you want to save the movie. 

3. Click Save. 

To copy an image or image layout to the clipboard: 

1. Right-click the image, and select Copy from the Image pop-up menu. 

Or, 

Right-click the image for which you want to copy the original (uncropped, unenhanced) version, and select Copy 
Uncropped Image from the Image pop-up menu. 

Or, 

Right-click an image in the image layout you want to copy. Then, select Copy Layout from the Image pop-up menu. 

The image or image layout is copied to the clipboard. If you are currently viewing an image with a cephalometric 
tracing, your current view (the image, the image with the tracing, or the tracing only) is copied to the clipboard. 

For more information on copying images to the clipboard, see "To copy an image to the clipboard and paste it into 
another application" on page 214. 

To copy an image or image layout at a specific resolution: 

1. Right-click the image, and select Copy Image To Resolution from the Image pop-up menu. 
 
Or, 
 
Right-click an image in the image layout you want to copy. Then, select Copy Layout To Resolution from the Image 
pop-up menu. 

2. Select the desired resolution from the drop-down menu. 

Or, 

Select Other from the drop-down menu. 

If you select Other, the Enter Resolution dialog box appears.  

3. If the Enter Resolution dialog box appears, enter the resolution, and click OK. 

The resolution you entered will appear on the drop-down list the next time you select Copy Image to Resolution. 

The image or image layout is copied to the clipboard. If you are currently viewing an image with a cephalometric 
tracing, your current view (the image, the image with the tracing, or the tracing only) is copied to the clipboard. 
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To delete an image: 

1. Right-click the image, and select Delete Image from the Image pop-up menu. 

A dialog box appears asking you to confirm the deletion. 

2. Click Yes to delete the image. 

To specify properties for an image (Dolphin Premium only): 

1. Right-click the image, and select Properties from the Image pop-up menu. 

The Image Properties dialog box is displayed. 

2. Enter any image properties you want to store for this image. Then, click OK. 

 

Date Date for this image. 

Title Image title.  

Notes Any notes you want to add for this image.  

Keywords Any keywords you want to enter for this image. Right-click this box to select from a pop-up menu of pre-defined 
keywords. 

Edit 
These... 

Click this button to add new pre-defined keywords or remove existing ones. 
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To edit the pre-defined image keywords: 

1. On the Image Properties dialog box, click Edit These.... 

The Edit Keywords dialog box opens. 

 

text box Enter a new keyword to add it to the list of pre-defined keywords. 

Add Click this button to add a new pre-defined keyword. 

Remove Click this button to remove the selected pre-defined keyword. 

list box Lists the pre-defined keywords that you can assign to an image. 
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To add a new keyword: 

1. Type the new keyword in the text box. 

2. Click Add. 

To remove an existing keyword: 

1. Select the keyword you want to remove in the list box. 

2. Click Remove. 

To close this dialog box: 

1. Click OK. 

To open the Image Calibration dialog box: 

1. Right-click the image, and select Image Calibration... from the Image pop-up menu. 

Or, 

Select an image. Then, select Image Calibration... from the Edit menu. 

The Image Calibration dialog box is displayed. You use this dialog box to specify information that Dolphin Imaging uses 
to scale the patient’s image. Once the image is calibrated, you can print it life size using the 1:1 option or you can take 
measurements on the image. 
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Zoom in on this image. 

 
Zoom out on this image. 

 
Fit the image in the window and align it in the center of the window. 

 
Zoom in on a particular part of the image 

 
Reposition the image within the window 

Distance Use this option to enter the distance in millimeters between two points on the image identified using the calibration 
line. 
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Dots-Per-Inch Use this option to calibrate the image by specifying its dots-per-inch (DPI). 

 
Save the calibration and return to the Dolphin Imaging main screen. 

 Return to the Dolphin Imaging main screen without saving the calibration. 

To calibrate the image by entering the distance between two points: 

1. On the patient’s image, click and drag each of the calibration line’s boxes to the points on the image that you want to 
use as your calibration measurement.  

For example, if you know the distance between the patient's eyes, you might position the ends of the calibration line at 
the corners of the patient's eyes. When the mouse is over one of the boxes, triangles appear around that box, and the 
box turns red. 

2. Enter the distance in millimeters between the two points in the Distance text box.  

3. Click . 

To calibrate the image by entering the DPI of the image: 

1. Enter the DPI of the image in the Dots-Per-Inch text box.  

2. Click . 

To open the Image Measurements dialog box: 

1. Right-click a calibrated image, and select Image Measurements... from the Image pop-up menu. 

Or, 

Select a calibrated image. Then, select Image Measurements... from the Edit menu. 

The Image Measurements dialog box is displayed. You use this dialog box to measure distances and angles on the 
patient's image.  
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Zoom in on this image. 

 
Zoom out on this image. 

 
Fit the image in the window and reposition it in the center 

 
Zoom in on a particular part of the image 

 
Reposition the image within the window 

Distance Use this option to measure the distance in millimeters between two specified points on the image. 

3-point angle Use this option to measure the angle between two lines joined by an apex. 
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4-point angle Use this option to measure the angle between two lines that are not joined by an apex. 

Hide Values Check this box to suppress display of the measurement numbers. 

 Copy the image along with the measurements to the clipboard.  

 Delete the selected line. 

 
Save the measurements for this image and return to the Dolphin Imaging main screen. 

To measure the distance between two points: 

1. Select Distance. 

2. On the patient’s image, click the two points between which you want to measure the distance. 

A line appears between the two points along with the distance in millimeters. 

To measure the angle between two lines joined by an apex: 

1. Select 3-point angle. 

2. On the patient’s image, click one end point for the angle, the angle's apex, and a second end point for the angle. 

 Two lines appear joined by the apex. The number of degrees for the angle appears near the apex. 

To measure the angle between two lines not joined by an apex: 

1. Select 4-point angle. 

2. On the patient’s image, click the two end points for one line. 

3. Click the two end points for the second line. 

The two lines appear along with a measurement of the angle between them. 

To copy the image and measurements to the clipboard: 

1. Click . 

The image and measurements are copied to the clipboard. You can paste the image and measurements into another 
application, typically using a pop-up menu option (right-click and select Paste from the pop-up menu) or by pressing 
CTRL+V. When you paste the image  and measurements, they appear in the other application’s window. 



Dolphin Imaging User's Guide April 2011 

50 DI_USER_GUIDE-11.5   Rev. 1.01 

To delete a line or angle from the patient's image: 

1. Click one of the end points to select the line or angle. 

When the line or angle is selected, its end points turn red. 

2. Click . 

To close the Image Measurements window: 

1. Click . 

Note: When uploading images or layouts to your DICOM server, you should make sure that you are not duplicating images 
already on your DICOM server. 

To upload an image to a DICOM server: 

1. Right-click the image you want to upload, and select DICOM: Upload Current Image to Server from the Image pop-up 
menu. 

The image is uploaded to your DICOM server. 

To upload an image layout to a DICOM server: 

1. Right-click the image in the image layout you want to upload, and select DICOM: Upload Current Layout to Server from 
the Image pop-up menu. 

The images in the layout are uploaded to your DICOM server. A separate file is created on the DICOM server for each 
image in the layout. If a duplicate image is found on the server, that image is not uploaded. 
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Image Viewing Features 

To zoom in on part of the image: 

1. Click   on the tool bar or press F2. 

Or, 

Click the image, and use your mouse wheel to zoom in. 

To zoom out after zooming in on part of the image: 

1. Click   on the tool bar or press F3. 

Or, 

Click the image, and use your mouse wheel to zoom out. 

To fit the image in the window and reposition it in the center: 

1. Click   on the tool bar or press F4. 

To fit the image in the window and reposition it at the right side of the window: 

1. Click   on the tool bar or press F5. 

To zoom in on a particular part of the image: 

1. Click  on the tool bar or press F6. 

The Zoom/Pan window opens as shown below and the cursor changes to the corner of a box. 

2. Click at one corner of the area that you want to zoom in on, and drag the mouse to the other corner of the area. 

The patient image in the main screen zooms to the area you selected. 
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To reposition the image within the window: 

1. Click on the tool bar or press F7. 

The Zoom/Pan window opens. 

2. Click and drag the image in the Zoom/Pan window. 

The patient image in the main screen pans as you move the image in the Zoom/Pan window. 

3. To close the Zoom/Pan window, click on the tool bar or press F7 again. 
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To close the Zoom/Pan window 

1. Click or   on the tool bar. 

Or, 

Press F6. 

To choose another layout: 

1. Select another layout from the drop-down list box. 

Or,  

Select Layout from the View menu. Then, select the appropriate layout from the cascade menu. 

You can select any series of pictures (image layout) available for the currently-selected timepoint. 

Note: By default, the Tracing Display Preferences dialog box appears whenever you display an image layout that 
includes tracings. For more information on this dialog box, see "To set tracing preferences" on page 78. 

To choose another timepoint:  

1. Select another timepoint using the timepoint tabs. 

Or, 

Right-click a timepoint tab. Then, select the appropriate timepoint from the pop-up menu. 

Or,  

Select Timepoint from the View menu. Then, select the appropriate timepoint from the cascade menu. 

To view the corresponding images for other timepoints: 

1. Select one of the patient's images to maximize it. Then, click   in the lower right corner.  

Or, 

Press TAB to move the magnifying glass to one of the patient's pictures. Then, press PAGEDOWN on your keyboard. 

The  icon only appears if the patient's picture is maximized and the patient has corresponding pictures for other 
timepoints. 

If you continue clicking   or pressing PAGEDOWN, Dolphin will cycle through all the timepoints, enabling you to 
compare pictures for different phases of the patient’s treatment. For example, you could view all lateral facial pictures 
taken for this patient. For more information on timepoints, see "Timepoints" on page 109. 
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To view a group of x-rays built in Dolphin 3D: 

1. Click   in the upper right corner of an x-ray image.  

When you build x-rays from a 3D volume, the x-rays are built using several different rendering filters. All the resulting x-
ray images are saved together in a single image layout slot and represented on the Dolphin Main Screen as a single 
image. The  icon only appears if the x-ray image is part of a series of x-rays built in Dolphin 3D.  For more 
information, see Chapter 25. 

If you continue clicking , Dolphin will cycle through all the x-rays, enabling you to compare x-ray images created 
from the 3D volume using different rendering filters.  

  

To view a report saved from Dolphin 3D: 

1. Right-click the report and select Open Report from the pop-up menu to view the report. 

Or, 

Click   in the upper right corner of a multi-page report to view the individual pages in the report.  

Or, 

Select a multi-page report and press F8 to view the individual pages in the report.  

The Menu Bar 
At the top of the Dolphin Imaging main screen, there are several menus that you can use to access program features. This 
section describes each of these menus. 

 
Some of the program features accessible from the menus are also accessible from buttons on the main screen. 
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The File Menu 
The following figure illustrates the File menu: 

 
The File menu contains the following choices: 

New Patient Currently unused. 

Open Patient 
Charts... 

Opens the Patient Charts or Patient Lookup dialog box. For more information, see Chapter 4. 

Save as non-
Premium, earlier 
formats 

Saves a patient’s records to an archive file in Dolphin Standard or old archive format (Dolphin version 6.0 
and earlier). For more information on archiving patients, see "To use archive operations" on page 143. 
Available only in Dolphin Premium. 

Page Setup... Opens the Dolphin Layout Editor so you can set many format options for printed output from Dolphin 
Imaging. This is an advanced feature of the Dolphin Imaging program. Please proceed with caution when 
making any changes using the Dolphin Layout Editor. For more information, see Chapter 7. 

Printer Setup... Opens the Print Setup dialog box so you can set printing options. For more information, see "To set up 
your printer" on page 226. 
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Print Opens a cascade menu offering the following choices.  
� Print...: Prints the current image layout. Opens the Print dialog box where you can select printing 

options. 
� Print Preview: Previews the print job on the computer screen.  
� Print 1:1: Prints the current image layout. Available only for images with cephalometric tracings. This 

option opens the Print dialog box with the 1:1 option already selected.  
� Print Preview 1:1: Previews the print job on the computer screen using the 1:1 print option.  
� Print to Video Printer: Prints the current image layout to a video printer. Available only on systems 

with the Dolphin DOS video card/video printer setup. 
For more information, see "Printing" on page 224. 

Save As... Saves this image to a file on your computer. For more information, see "To save an image to a file" on page 39. 

Save 
Original 
As... 

Saves the original (uncropped, unenhanced) image to a file on your computer. This option is only available for 
images for which an original version was saved during capture. For more information on using this menu item, 
see "To save an image to a file" on page 39. For more information on setting One-Click capture preferences to 
save the original image, see "To set One-Click Capture preferences" on page 174. 

Save 
Layout 
As... 

Saves this image layout to a file on your computer. For more information, see "To save an image to a file" on 
page 39. 

Rebuild 
Patient 
List... 

An advanced maintenance option used to regenerate the Dolphin patient list file from the current patient files as 
referenced by settings in your DOLPHIN.INI file (see below). This feature is for use only by Dolphin support 
technicians. 

Recent 
Patients 

Opens a cascade menu from which you can select recently-accessed patient records. 

Pre-
Backup 

Performs a pre-backup procedure. For more information, see "To perform a pre-backup" on page 29. 

Exit Exits from Dolphin Imaging. For more information, see "Exiting the Program" on page 28. 
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To rebuild the Dolphin patient list: 
Note: Rebuilding the patient list is an advanced maintenance option used to regenerate the Dolphin patient list file from the 
current patient files as referenced by settings in your DOLPHIN.INI file. This feature is for use only by Dolphin Imaging 
support technicians.  

1. Select Rebuild Patient List... from the File menu. 

A dialog box (shown below) appears that you use to start the rebuild process. 

2. Click Start to begin regenerating the patient list from your patient files. 

A progress bar on the dialog box reflects the progress of the rebuild.  

3. Click Done when the patient list regeneration is completed. 

 

Name to use for recovered timepoints Enter a name to use for timepoints recovered during this process.  

Patient ID (optional, Premium only) Enter the patient ID to rebuild a single patient. This option is available on 
Dolphin Premium only. 

Check image files Check this box to check patient image files as the patient list is rebuilt. 

Automatically fix patient files OR Automatically 
fix database tables to match image files found 

Check this box to fix any missing image links in the patient files (standard 
Dolphin) or database (Dolphin Premium) automatically as the patient list is 
rebuilt. 

 



Dolphin Imaging User's Guide April 2011 

58 DI_USER_GUIDE-11.5   Rev. 1.01 

The Edit Menu 
The following figure illustrates the Edit menu. 
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This menu contains the following choices: 

Search Unused. 

Questionnaire 
Setup... 

Opens a Questionnaire Setup dialog box so that you can set up a new Questionnaire. This feature is 
only available with Dolphin Premium. For more information, see "Setting Up a Questionnaire" on page 
506. 

Edit Referring 
Doctors... 

Opens the Edit Referring Doctors dialog box so you can add information about the doctors who refer 
patients to your practice. This feature is only available with Dolphin Premium. For more information, see 
"Editing Doctors" on page 80. 

Edit Treating 
Doctors... 

Opens the Edit Treating Doctors dialog box so you can add information about the doctors who work at 
your practice. This feature is only available with Dolphin Premium. For more information, see "Editing 
Doctors" on page 80. 

Edit Insurance 
Companies... 

Opens the Edit Insurance Companies dialog box so you can set up a list of insurance companies and 
addresses. This feature is only available with Dolphin Premium. For more information, see "Editing 
Insurance Companies" on page 83. 

Password Setup... Opens the Password Setup dialog box so you can set up requirements for Dolphin Imaging passwords. 
This feature is only available with the optional security utilities. For more information, see "Setting up 
Password Requirements" on page 958. 

Edit Employee  
Rights... 

Opens the Employee Rights dialog box so you can set rights for employees to use the various Dolphin 
Imaging features. This feature is only available with the optional security utilities. For more information, 
see "Setting Employee Rights" on page 959. 

Edit Layouts... Opens the 7dolphinscreeneditor_editing_lay_398 Dolphin Layout Editor. For more information, see 
Chapter 7. 

Edit Capture 
Sequences... 

Opens the Sequence Editor. For more information, see "Editing Capture Sequences" on page 184.  

Copy  Image Copies the image to the clipboard. For more information, see "To copy an image to the clipboard" on 
page 42. 

Copy Uncropped 
Image 

Copies the original (uncropped, unenhanced) image to the clipboard. This option is only available for 
images for which an original version was saved during capture. For more information, see "To copy an 
image to the clipboard"  on page 42. 

Copy Image to 
Resolution 

Copies the image to the clipboard using a resolution you select. For more information, see "To copy an 
image or layout at a specified resolution" on page 45. 

Copy Layout Copies the image layout to the clipboard. For more information, see "To copy an image to the clipboard"  
on page 42. 
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Copy Layout to 
Resolution 

Copies the image layout to the clipboard using the resolution you select. For more information, see "To 
copy an image or layout at a specified resolution" on page 45. 

Image Calibration... Opens a dialog box where you specify information that Dolphin Imaging uses to scale the patient’s image 
so that you can print it life size or measure distances and angles on the image (see Image 
Measurements, below). For more information, see "To open the Image Calibration dialog box" on page 
45. 

Image 
Measurements... 

Opens a dialog box where you measure distances and angles on a calibrated image. For more 
information, see "To open the Image Measurements dialog box" on page 47. 

Employees Opens the Add an Employee dialog box so that you can look up an existing employee or add a new 
employee. This feature is only available with the optional security utilities.  For more information, see 
"Setting Up Employees" on page 969. 

Employee Type Opens the Add an Employee Type dialog box so that you can look up an existing employee type or add 
a new employee type. This feature is only available with the optional security utilities.  For more 
information, see "Setting Up Employee Types" on page 967. 

Treatment Types Opens the Add a Treatment Type dialog box so that you can look up an existing treatment type or add a 
treatment type. This feature is part of the optional Treatment Card module, which is not yet available. 

Treatment Card 
Setup 

Opens the Treatment Card Setup dialog box so that you can customize your treatment card. This feature 
is part of the optional Treatment Card module, which is not yet available. 

Locations Opens the Choose a Location dialog box so that you can look up an existing practice location or add a 
new location. This feature is only available with the optional security utilities.  For more information, see 
"Setting Up Locations" on page 961. 

3D View... Opens Dolphin 3D so that you can view the selected 3D image. For more information, see "Viewing or 
Editing an Existing 3D Image" on page 614. 

3D Edit... Opens Dolphin 3D so that you can edit the selected 3D image. For more information, see "Viewing or 
Editing an Existing 3D Image" on page 614. 

DICOM Storage 
Options... 

Opens The DICOM Volume Storage dialog box so that you can set default DICOM volume storage 
options. For more information, see "Setting DICOM Volume Storage Options" on page 670. 
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The View Menu 
The following figure illustrates the View menu: 

 
The View menu contains the following choices: 

Full Screen Hides the title and menu bars on the Dolphin Imaging main screen. To exit this mode, press ESC or click 
any image. 

Side by Side Displays two images side-by-side, either horizontally or vertically (see "To display two pictures side-by-
side" on page 74). 

Image Enhance 
(View Only) 

Opens the Enhance Image dialog box so that you can temporarily apply enhancement operations to this 
image. This option is available on view workstations only. With this option, you cannot save the enhanced 
image. For more information, see "To enhance a picture" on page 164. 

Show Toolbars Toggles the display of the tool bar on the Dolphin Imaging main screen. 

Show Status Bar Toggles the display of the status bar on the Dolphin Imaging main screen. 

Show Image Titles Toggles the display of an image title on each of the images. 

Cloak Patient 
Names 

Toggles the display of the patient’s full name on the window title bar. If this option is enabled, the title bar 
shows first few letters of the patient’s first and last name, with an asterisk (*) appearing in place of the 
remaining letters. 

Show Zoom-Pan 
Dialog 

Toggles the display of the zoom and align tool bar. It this tool bar is enabled, it appears when you 
maximize an image. For more information, see "Image Viewing Features" on page 51. 
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List All Images... Opens a dialog box listing all images for this patient. From this dialog box, you can temporarily view 
another patient image in place of the current image. For more information, see "To temporarily view 
another patient image in place of the current image" on page 38. 

Timepoint Opens a cascade menu listing the timepoints for this patient. Select another timepoint from the cascade 
menu to view patient images for that timepoint. 

Layout Opens a cascade menu listing the available image layouts. You can select another layout from the 
cascade menu to view that image layout. 

Display 
Quality/Speed 

Opens a cascade menu that you can use to set options relating to the trade-offs between image quality 
and speed of the display.  
Note: These options only affect the quality of images displayed on your computer screen. Images are 
always printed at the highest quality. 
Zoom/Shrink Display Quality: Opens another cascade menu listing image quality levels. You can select 
one of the following levels: 

Traditional: The display quality that Dolphin has always used in the past. 
Good: Displays good quality images and provides the fastest performance. 
Better: The recommended choice because it provides the best balance of image quality and fast 
performance. 
Best: Displays the best quality image, but the slowest display performance. 

Use Stamps: Specifies whether to use lower resolution pictures in the image layout. Using this option 
causes the image layout to load more quickly. If you maximize an image in the layout, the high-resolution 
picture is displayed.  
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The Tools Menu 
The following figure illustrates the Tools menu. 
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The Tools menu contains the following choices: 

Letters Opens the Dolphin Letter System using the current image layout. For more information, see Chapter 
21. 

Presentation Opens a dialog box where you can set up or display a slide show of this patient’s pictures. For more 
information, see "Setting up a Slide Show Presentation" on page 194. 

Email Click this button to send an email message with the current image layout. For more information, see 
"Using the Email Feature" on page 201. 

Questionnaire Runs a questionnaire that you have defined. For more information on setting up and running 
questionnaires, see Chapter 20. 

One Page 
Questionnaire 

Runs a questionnaire using the one-page questionnaire interface. This option is only available if you 
have a special Dolphin utilities package installed and enabled. For more information on setting up and 
running questionnaires, see Chapter 20. 

Treatment Card Opens the Treatment Card for this patient. This feature is not yet available. 

Dolphin Ocean Client 
Admin... 

Opens the dialog box for setting up the Dolphin Ocean client application. Contact your Dolphin 
representative for more information. 

McLaughlin Dental 
VTO 

Opens the McLaughlin Dental VTO Analysis. For more information, see Chapter 18. 

Image Library Opens the Image Library Presenter, which you can use to review images in the image library. For 
more information, see "The Image Library" on page 283. 

AnywhereDolphin Opens a cascade menu with options for using AnywhereDolphin.  
Show Sonar Window: Opens the Sonar window, which you use to manage the Dolphin Sonar queue 
and set options for the Dolphin Sonar module. 
Upload Current Patient: Uploads the current patient to the AnywhereDolphin Internet site. 
Download Patient: Accesses the AnywhereDolphin Internet site so that you can download a patient 
stored there. 
Upload Preferences: Opens a further cascade menu that you use to toggle the following options for 
uploading patients to AnywhereDolphin: 
� Include original uncropped images (if they exist): Select this option to upload the 

original, uncropped images for this patient, if they were saved when the patient's images 
were captured. For more information, see "To set One-Click Capture preferences" on page 
174. 

� Include video and DICOM files (if they exist): Select this option to upload video or DICOM 
files for this patient, if any are available. For more information about DICOM support, consult 
your Dolphin representative. 

 For more information, see "Using AnywhereDolphin" on page 203. 
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Capture Opens the Capture Setup dialog box so you can begin capturing images. To capture images, you need 
the appropriate equipment. For more information, see Chapter 5. 

Digitize Opens the Digitize Setup dialog box so you can generate measurements by digitizing landmarks and 
tracing skeletal structures on patient images. For more information, see Chapter 10. 

Overlay Tracing+ 
Image 

Opens the Link Tracing+Image dialog box, where you can overlay a patient’s tracing over the profile 
picture for Treatment Simulation operations. For more information, see Chapter 13. 

Tracing 
Superimpositions 

Opens the Tracing Superimpositions dialog box, where you can superimpose two or more tracings for 
analysis and comparison. For more information, see Chapter 13. 

Image 
Superimpositions 

Opens the Image Superimpositions dialog box, where you can superimpose two or more patient 
images for analysis and comparison. For more information, see Chapter 13. 

Edit Opens the Edit Image dialog box, where you can modify patient images. For more information, see 
Chapter 8. 

Measurements Opens the Measurement dialog box, where you can view patient measurements based on 
cephalometric information for this patient. For more information, see Chapter 12. 

Treatment 
Simulation 

Opens the Treatment Simulation dialog box, where you can simulate orthodontic and surgical treatment 
for this patient. For more information, see Chapter 16. 

ImPlanner Opens the ImPlanner feature so you can plan the placement of implants using the patient’s X-ray 
image. For more information, see Chapter 23. 

2D Image Morph Opens the 2D Morphing feature so you can create a movie that morphs between any two images of a 
patient. For more information, see Chapter 9. 

DICOM 
Communication 
Setup 

Opens a dialog box where you can set up client/server communication with a Digital Imaging and 
Communications in Medicine (DICOM) server. This option is enabled only if you have Dolphin Premium 
and have purchased the optional DICOM Support module. For more information, see "Setting Up 
DICOM Communication” on page 85. 

Convert Patient 
Files... 

An advanced maintenance option used to convert a specific patient record or group of patient records 
to a different image format. This feature is for use only by Dolphin support technicians. For more 
information, see "Converting Patient Files" on page 66. 

Module Activation... Opens the Module Activation dialog box. Contact Dolphin to activate optional modules. 
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Preferences Opens a cascade menu offering the following choices: 
Confirmations: Specifies the Prompt on Exit option. With this option enabled, a dialog box appears asking if 
you want to perform the pre-backup procedure whenever you exit from Dolphin Imaging. This option is 
available only if you are using Dolphin Premium. 
General Preferences: Opens the General Preferences dialog box, where you can set preferences for Dolphin 
Imaging. For more information, see "To set general preferences" on page 75. 
Tracing Preferences: Opens the Tracing Preferences dialog box, where you can set preferences for tracings. 
For more information, see "To set tracing preferences" on page 78. 

View 
Database Log 

Opens a log of database activity listing what operations were performed, the date and time of each operation, 
and the user who performed it. This feature is only available if you have the optional security utilities. For more 
information see "Viewing the Database Log" on page 67. 

Options... Opens the System Options dialog box so that you can set general system options. For more information, see 
"Setting System Options" on page 70. 

 

Converting Patient Files 

To convert patient files: 
Note: Patient file conversion is an advanced maintenance option used to convert a specific patient record or group of patient 
records to a different image format for an image. This feature is used only by Dolphin support technicians. 

1. Select Convert Patient Files... from the Tools menu. 

The Patient File Conversion dialog box is displayed. 

2. Select the patients you want to convert. 

You can select individual patients from the List of Patients or select all the patients listed by clicking the Pick All button. 

3. Click Start to start the conversion process. 
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Select Patient(s) Select one or more patients to convert those patients. 

Pick All Click this button to select all patients in the Select Patient(s) list. 

Clear All Click this button to deselect all patients in the Select Patient(s) list. 

Start  Click this button to begin converting patients. 

Stop Click this button to stop converting patients. 

Exit Click this button to close this dialog box. 

Progress Indicates the progress of the conversion process 

Viewing the Database Log 
Dolphin Premium keeps a constant log of the operations performed on your database. For each operation performed, the log lists 
the date and time it was performed and the employee who performed it. You can review this log at any time. 
You can limit access to the database log to authorized Dolphin users by allowing or disallowing access to this option on the 
Security tab of the Add an Employee dialog box. For more information, see "Adding an Employee" on page 969. 
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To view the database log: 

1. Select View Database Log from the Tools menu. 

The Database Log Viewer dialog box opens. 

2. Optionally, click Selected Dates and specify a date range to list only records for operations that occurred within that 
range. 

3. Optionally, select Single Code and enter an operation code to list only records for a single type of operation. 

4. Optionally, select By Criteria and enter database search criteria to list only records that meet the specified criteria. 

5. Click Refresh to refresh the list. 

 
Date Range Specify the date range for which you want to view records.  

All Dates: Display records for all dates. 
Selected Dates: Display records for operations that occurred within the specified date range. 

Code Specify the operations for which you want to view records. 
All Codes: Display records for all operations. 
Single Code: Display records for the operation identified by the code entered in the text box. 
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Criteria Specify other selection criteria for the records that you want to view: 

All Records: Do not use any other selection criteria when selecting records to list. 
By Criteria: Use the criteria entered in the text box to select the records to list. 

Date Date and time that the operation took place. 

Patient The patient associated with the operation. 

Subscriber The insurance subscriber associated with the operation. This column is used only if you are using 
Dolphin Imaging with Dolphin Management. 

Employee The Dolphin user who performed the operation. 

Computer The workstation used to perform the operation. 

Code The code that identifies the operation that was performed. 

Note A note that describes the operation that was performed. 

Amount The amount of money associated with the operation. This column is used only if you are using Dolphin 
Imaging with Dolphin Management. 

From The ledger or account from which money associated with the operation was transferred. This column is 
used only if you are using Dolphin Imaging with Dolphin Management. 

To The ledger or account to which money associated with the operation was transferred. This column is 
used only if you are using Dolphin Imaging with Dolphin Management. 

Install This column is used only if you are using Dolphin Imaging with Dolphin Management. 

Support This column is used only if you are using Dolphin Imaging with Dolphin Management. 

Master This column is used only if you are using Dolphin Imaging with Dolphin Management. 

Version The Dolphin Imaging version. 

Type 
Description 

A description of the database change made. 

To resize the columns in the list: 

1. Move the mouse pointer to the dividing line between two column headings. 

2. When the mouse pointer changes to a two-headed arrow across a line, click and drag the mouse to resize the column 
headings. 
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Setting System Options 

To set system-wide options: 

1. Select Options from the Tools menu. 
 
The System Options dialog box opens. If you are using Dolphin Imaging with Dolphin Management, this dialog box 
contains several tabs (see the Dolphin Management online help). If you are not using Dolphin Imaging with Dolphin 
Management, this dialog box contains a single tab, General. 
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Some of the options on the General tab apply only if you are using Dolphin Imaging with Dolphin Management. For information 
on these options, see the Dolphin Management online help. The following table describes the options that apply to Dolphin 
Imaging. 
Last Patient 
Accessed 

The last patient you selected. 

Allow Fingerprint 
Login 

Check to enable Dolphin users to log in to the system using a fingerprint scanner.  
Note: Actual images of fingerprints are not stored anywhere in your system. The fingerprint 
scanner creates a unique ID based on the patterns on a person's finger. The actual fingerprint 
itself cannot ever be re-created or "stolen" from this ID. 
For more information on using fingerprint information for security purposes, please consult your 
Dolphin sales and support representative. 

 

The Help Menu 
The following figure illustrates the Help menu: 

 
The Help menu contains the following choices: 

Contents Opens the Table of Contents for the online help. 

Index Opens the Index for the online help. 

Using Help Accesses help on using the online help. 

Remote 
Support 

Accesses Dolphin's remote support feature on the Internet. Use this option when directed to do so by 
Dolphin Technical Support to enable them to connect to your computer for diagnostic purposes. 

Live Chat Opens a chat session with a Dolphin representative. 

FAQ Opens a list of frequently-asked questions. 

About Dolphin 
Imaging 

Opens a dialog box that provides the Dolphin Imaging program version and information on contacting 
Dolphin. 
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The Vertical Tool Bar 
The vertical tool bar contains buttons that you can use to access program features quickly. 

 

Click this button to open the Patient Charts (Standard Dolphin) or Patient Lookup (Dolphin Premium) 
dialog box.  For more information, see Chapter 4. 

 

Click this button to capture or scan images. To capture or scan images, you need the appropriate 
equipment. For more information, see Chapter 5. 

 

Click this button to modify an image using the editing, morphing, and image library tools. For more 
information, see Chapter 8. 

 

Click this button to create a movie that morphs between any two images of a patient.. For more 
information, see Chapter 9. 

 

Click this button to digitize landmarks and trace skeletal structures on patient images. For more 
information, see Chapter 10. 

 

Click this button to open the Measurement dialog box, where you can view patient measurements 
based on cephalometric information for this patient. For more information, see Chapter 12. 

 

Click this button to superimpose two or more tracings or two or more images for analysis and 
comparison, or to overlay a patient’s tracing over the profile photograph for Treatment Simulation 
operations. For more information, see Chapter 13. 

 

Click this button to access the Treatment Simulation features. For more information, see Part VI: 
Treatment Simulation. 

 

Click this button to use the ImPlanner feature to plan the placement of implants using the patient’s X-
ray image. For more information, see Chapter 23. 

 

Click this button to view, edit, add, or delete 3D images for this patient using Dolphin 3D. For more 
information, see Part X: 3D. 

 

Click this button to access the Dolphin Letter System using the current picture layout. For more 
information, see Chapter 21. 

 

Click this button to upload the current patient to AnywhereDolphin or download patients from 
AnywhereDolphin. For more information, see "Using AnywhereDolphin" on page 203. 

 

Launches Dolphin Management with the current patient selected. This button is enabled only if you 
have installed Dolphin Management. For more information, refer to the help for Dolphin Management. 
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Opens the Treatment Card for this patient. This feature is available with Dolphin Management only.  

 
Opens the Documents Manager for this patient. This feature is available with Dolphin Management 
only.  

 

Opens the Dolphin Aquarium for this patient. This button is enabled only if you have Dolphin Aquarium 
installed. For more information, refer to the Dolphin Aquarium documentation. 

The Horizontal Tool Bar 
The horizontal tool bar contains buttons that you can use to access program features quickly, and two drop-down list boxes that 
you can use to select the pictures you want to see. 

 

Click this button to print the current layout. For more information, see "Printing" on page 224. 

 

Click this button to set preferences. For more information, see "To set general preferences" on page 75. 

 

Click this button to display two images side-by-side, either horizontally or vertically (see below). 

 

Click this button to send an email message with the current picture layout. For more information, see "Emailing 
the Image Layout." 

 

Click this button to change the display format to Full Screen mode, so that the picture layout takes up the entire 
screen, hiding the menus and tool bars (see below). 

 

Click this button to open a dialog box where you can set up a slide show of this patient’s pictures. For more 
information, see "Setting up a Slide Show Presentation" on page 194. 

 

Click this button to open Dolphin ABO Electronic Case Submission for the current patient. This button only 
appears if you have Dolphin ABO Electronic Case Submission installed. For more information, refer to the 
Dolphin ABO Electronic Case Submission documentation. 

Note: The horizontal tool bar may include additional buttons to the right of the buttons listed above. These are custom buttons 
set up for you by your Dolphin system integrator. 
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To display two pictures side-by-side: 

1. Click one of the patient pictures to select it. 

2. Click  on the horizontal tool bar. 

Or, 

Select Side by Side from the View menu. 

3. Select Horizontal to display two images side-by-side horizontally. 

Or, 

Select Vertical to display two images side-by-side vertically 

A list box appears containing the other patient pictures. 

4. Select a picture from the list box and click OK. 

The two pictures are displayed side-by-side. 

5. Click either picture to return to the image layout. 

To change the display to full-screen mode: 

1. Click . 

Or,  

Select Full Screen from the View menu. 

The menu bar and tool bars are hidden, and the picture layout takes up the entire screen. 

To exit full screen mode: 

1. Click anywhere on the Dolphin Imaging main screen. 

Or, 

Press any key on the keyboard. 

The Dolphin Imaging main screen appears with the menu bar and tool bars. 
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Setting Preferences and Options 

To set general preferences: 

1. Select any image layout that does not contain tracings. Then, click  on the Dolphin Imaging main screen’s 
horizontal tool bar. 

Or, 

Select Preferences from the Tools menu. Then, select General Preferences from the cascade menu. 

The General Preferences dialog box is displayed. 

Note: If you select an image layout that contains tracings and then click  on the horizontal tool bar, a 
dialog box appears where you can set lateral X-ray tracing preferences. For more information on setting lateral X-ray 
tracing preferences, see "To set tracing preferences" on page 78. 

2. Select any options you want, and click OK. 
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When "Maximize" 
Picture group box 

Use this group box to specify the option you want to use when you maximize a picture. Your options 
are: 
Also maximize window: Enters full-screen mode when you maximize an image in the image 
layout.  
Show side-by-side: Enters side-by-side mode when you maximize an image in the image layout. 

Tool bar group box Pick the option for how you want the tool bar displayed. Your options are: 
Icons and Text: Displays the tool bar as small pictures with text labels.  
Icons only: Displays the tool bar icons only.  
Text only: Displays the tool bar as text labels only. 

Background Color 
group box 

Indicates the current background color. 
Change Color...: Click this button to change the background color. 

Background bitmap 
group box 

Use this group box to select a bitmap picture to use as the background. Your options are: 
None: Displays a solid color background.  
Dolphin logo: Uses the Dolphin logo as your background.  
Custom: Uses a custom picture (selected using the Select... button) as your background.  
Select...: Click this button to select a custom picture to use as a background. 
Center: Centers the picture on the background.  
Tile: Repeats the picture as small tiles on the background. 

Corner Rounding Enter a value between 0 and 500 to use to round the corners of the images displayed on the Dolphin 
Main Screen. To use square corners, set this value to 0. This value is set to 20 by default. 

Settings group box Use this group box to set additional options. 
Always open capture when cresting new patient: Check this box if you want the Capture Setup 
dialog box to open automatically after you create a new patient so you can begin capturing pictures 
for the new patient immediately. 

To change the background color: 

1. Click Change Color... on the General Preferences dialog box. 

The Color dialog box is displayed. 

2. Select the color you want to use as a background, and click OK. 
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To select a custom bitmap as a background: 

1. Click Custom in the Background Bitmap group box. Then, click Select.... 

The Select Image File dialog box is displayed. 

2. Select a file in this dialog box, and click OK. 
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File name Enter a file name to choose that file. You can use wildcards that limit the files listed in the file list. For 

example, you can enter *.bmp in this text box to limit the file list to bitmap files. 

File list Click a file from this list box to select that file.  

List files of 
type 

Specifies the types of files to list in the file list. Choosing a file type limits the file list to that type of file and 
enters a wildcard that specifies that file type in the File name text box. 

Folders Choose the folder you want in this list box, which lists the folders on the selected drive. The currently-
selected folder appears above the list box. 

Drives Choose a disk drive from this drop-down list box. 

Thumbnail  Shows a preview of the currently-selected image file. 

Network... Click this button to access other mapped disk drives on your computer network. 

To set tracing preferences: 

1. Select any image layout that contains tracings.  

By default, the Tracing Display Preferences dialog box appears whenever you select an image layout that contains 
tracings. In this case, you can skip the next step.  

2. If the Tracing Display Preferences dialog box does not appear automatically, click   on the Dolphin 
Imaging main screen’s horizontal tool bar. 

Or, 

Select Preferences from the Tools menu. Then, select Tracing Preferences from the cascade menu. 

The Tracing Preferences dialog box is displayed. 

Note: If you select an image layout that does not contain tracings and then click  on the horizontal tool 
bar, a dialog box appears where you can set general preferences. 

3. Select the analysis for which you want to specify tracing preferences from the Analysis drop-down list box. 

4. Select all the items that you want to display on the tracing. 

5. To change the color for an item, click the color sample next to the item and select a new color. 

If you want to set preferences for another analysis, repeat these steps for that analysis. 

Note: The settings you make on this dialog box apply to all patient images with the selected analysis. In addition, these 
settings are retained when you exit and restart Dolphin. 
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Analysis drop-down 
list box 

Select the analysis for which you want to set tracing preferences.  

 
Click this button to display or hide the image. 

 
Click this button to display or hide the tracing. 

Lines/Curves Click this check box to display or hide the tracing as defined in the patient’s cephalometric analysis. 

Tooth Templates Click this check box to display or hide the templates for the patient’s teeth. 

Add’l Ceph 
Structures 

Click this check box to display or hide the cephalometric structures. 

Meas Numbers Click this check box to display or hide measurement numbers as defined in the patient’s 
cephalometric analysis. 
Decimal: Enter the number of digits you want to display to the right of the decimal point. 
Use the Same Color: Check this box to use the same color for all measurement numbers. By default, 
the color of each measurement number is determined by that measurement’s deviation from the norm.  

Landmarks Markers Click this check box to display or hide the digitized landmarks. 
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Color Samples Click these boxes to change the color in which the associated element is displayed.  

Show This Dialog 
Automatically 

Uncheck this box if you do not want to display the Tracing Display Preferences dialog box whenever 
you select an image layout that contains tracings. By default, this check box is checked. 

Editing Doctors 
You can enter information about the doctors that work in your practice or with whom your practice frequently corresponds into the 
database for easy reference and for use in the Dolphin Letters System. This feature is only available with Dolphin Premium. 
Note: If you are using Dolphin Imaging with Dolphin Management, you enter information about doctors in Dolphin Management. 
For more information, refer to the Dolphin Management online help. 

To add a doctor to the database: 

1. Select Edit Referring Doctors from the Edit menu to add a doctor who refers patients to your practice. 

Or, 

Select Edit Treating Doctors from the Edit menu to add a doctor who works in your practice. 

The Edit Referring Doctors or Edit Treating Doctors dialog box lists doctors currently in the database.  

2. Click New to add a new doctor. 

The Edit Doctor Information dialog box is displayed. This dialog box is blank so you can enter information for a new 
doctor.  

3. Enter any information for this doctor. Then, click Save. 

In each text box, grey italic text indicates the information that you should enter. An asterisk indicates required 
information that you must enter for every doctor. All other information is optional. 

4. If you wish to add another doctor, click New to clear the Edit Doctor Information dialog box. 

5. When you finish adding doctors, click Close or Cancel to close this dialog box. 

6. Click Exit to close the Edit Referring Doctors or Edit Treating Doctors dialog box. 
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 Title The doctor’s title, which defaults to Dr. 

Last Name The doctor’s last name. 

First Name The doctor’s first name. 

Nickname Any nickname for this doctor. 

Birth The doctor’s birth date. By default, the check box is unchecked, which disables this text box. 
If you want to enter the doctor’s birth date, check the box to enable this text box. The current date appears 
initially. To enter the birth date, you can: 

• Type the birth date in this field using your computer’s regional date format.  

• Use the LEFT-ARROW and RIGHT-ARROW keys to move between the month, day, and year parts of the 
date. You can then use the UP-ARROW and DOWN-ARROW keys to increase or decrease the number 
for that part of the date. 

• Use a drop-down calendar to enter the birth date. For more information on using the drop-down 
calendar, see "Using the Drop-Down Calendar" on page 142. 
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Type The type of practice for this doctor. Possible values are Endodontist, General Dentist, Oral Surgeon, 
Orthodontist, Pedodontist, Periodontist, and <unknown>. 

Gender The doctor’s gender.  

Notes Any notes for this doctor. 

Company The name of the practice for which this doctor works. 

Street The street address for this doctor. 

City The city for this doctor’s address. 

State The state for this doctor’s address. 

Zip Code The zip code for this doctor’s address. 

Country The country for this doctor’s address. This value defaults to USA. 

Phone #1, 
Phone #2 

Telephone numbers for this doctor. These fields accept both letters and numbers. Some practices use one of 
these fields for another purpose, such as a database index. 

Email Email address for this doctor. 

Save Click to save the information for this doctor. 

New Click to clear the entry fields in this dialog box and begin entering information for a new doctor. 

To modify a doctor already in the database: 

1. Select Edit Doctors from the Edit menu. 

The Edit Doctors dialog box lists doctors currently in the database.  

2. Select the doctor for whom you want to change information, and click Modify. 

The Edit Doctor Information dialog box is displayed with the information currently in the database for this doctor.  

3. Change any information for this doctor. Then, click Save. 

The doctor’s information is updated in the database. 

4. Click OK.  

5. Click Close to close the Edit Doctor Information dialog box. 

6. Click Exit to close the Edit Referring Doctors or Edit Treating Doctors dialog box. 
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To delete a doctor from the database: 

1. Select Edit Doctors from the Edit menu. 

The Edit Doctors dialog box lists doctors currently in the database.  

2. Select the doctor you want to delete, and click Delete. 

A dialog box asks you to confirm the deletion. 

3. Click Yes. 

4. Click Exit to close the Edit Referring Doctors or Edit Treating Doctors dialog box. 

Editing Insurance Companies 
You can enter information about the insurance companies with which your practice frequently corresponds into the database for 
easy reference and for use in the Dolphin Letters System. This feature is only available with Dolphin Premium. 
Note: If you are using Dolphin Imaging with Dolphin Management, you enter information about insurance companies in Dolphin 
Management. For more information, refer to the Dolphin Management online help. 

To add an insurance company to the database: 

1. Select Edit Insurance Companies from the Edit menu. 

The Edit Insurance Companies dialog box lists insurance companies currently in the database.  

2. Click New to add a new insurance company. 

The Edit Insurance Company dialog box is displayed. This dialog box is blank so you can enter information for a new 
insurance company.  

3. Enter any information for this insurance company. Then, click Save. 

In each text box, grey italic text indicates the information that you should enter. All information except Company is 
optional. 

4. If you wish to add another insurance company, click New to clear the Edit Insurance Company dialog box. 

5. When you finish adding insurance companies, click Close or Cancel to close this dialog box. 

6. Click Exit to close the Edit Insurance Companies dialog box. 
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Company Name of this insurance company. 

Street The street address for this insurance company. 

City The city for this insurance company’s address. 

State The state for this insurance company’s address. 

Zip Code The zip code for this insurance company’s address. 

Country The country for this insurance company’s address. This value defaults to USA. 

Phone Telephone number for this insurance company.  

Fax Fax number for this insurance company. 

Contact Person Name of your contact person at this insurance company. 

Save Click to save the information for this insurance company. 

New Click to clear the entry fields in this dialog box and begin entering information for a new insurance company. 
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To modify an insurance company already in the database: 

1. Select Edit Insurance Companies from the Edit menu. 

The Edit Insurance Companies dialog box lists insurance companies currently in the database.  

2. Select the insurance company for which you want to change information, and click Modify. 

The Edit Insurance Company dialog box is displayed with the information currently in the database for this insurance 
company.  

3. Change any information for this insurance company. Then, click Save. 

The insurance company’s information is updated in the database. 

4. Click OK.  

5. Click Close to close the Edit Insurance Company dialog box. 

6. Click Exit to close the Edit Insurance Companies dialog box. 

To delete an insurance company from the database: 

1. Select Edit Insurance Companies from the Edit menu. 

The Edit Insurance Companies dialog box lists insurance companies currently in the database.  

2. Select the insurance company that you want to delete, and click Delete. 

A dialog box asks you to confirm the deletion. 

3. Click Yes. 

4. Click Exit to close the Edit Insurance Companies dialog box. 

Setting Up DICOM Communications 
You can set up client/server communication between Dolphin Imaging and a Digital Imaging and Communications in Medicine 
(DICOM) server so that you can capture patient images from it or upload patient images and image layouts to it. For more 
information, see "Capturing from a DICOM Server" on page 182 and "To upload an image to a DICOM server" on page 50. 
Note: This feature is available only if you have Dolphin Premium and have purchased the optional DICOM Support module.  

To set up DICOM communication: 

1. Select DICOM Communication Setup... from the Tools menu. 

The DICOM Server/Client Connections dialog box opens. 

2. Select the name of the client/server configuration properties you want to view from the Name drop-down list box. 

Or, 

Add, modify, or delete DICOM server/client connection properties as described below. 

3. Optionally, click Test Connection to test whether Dolphin Imaging can communicate with your DICOM server 
successfully. 
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4. Click OK to close this dialog box. 

 

Name Select the name of the client/server configuration properties you want to view. 

Server 
Address The IP address of the DICOM server. 

Server Port Enter the number of the port on the DICOM server that Dolphin Imaging should use to communicate with it. 

Called AE The application entity receiving the DICOM messaging service request. This should be the application name of 
your DICOM server.  

Calling AE The application entity initiating the DICOM messaging service request. Typically, this should match the value in 
the Name text box. 

Local Port The number of the port on your Dolphin Imaging server that Dolphin Imaging should use to communicate with 
the DICOM server. 

Insert Click this button to add the configuration settings to communicate with this DICOM server to your database. 

Delete Click this button to delete the configuration settings for the selected DICOM server from your database. 

Modify Click this button to change the configuration settings for the selected DICOM server in your database. 
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Secure Mode 

Select the type of security to use when communicating with the DICOM server: 
None: Don't use any security mechanism. 
ISCL: Use the Integrated Secure Communication Layer (ISCL) secure transport connection profile. 
TLS: Use the Transport Layer Secure (TLS) secure transport connection profile. 
For more information on the security your DICOM server supports, refer to your DICOM server 
documentation. 

Timeout (sec) Enter the number of seconds to use as the time out for communications between Dolphin Imaging and the 
DICOM server. 

Test 
Connection Click this button to test the connection to the DICOM server. 

To add or modify DICOM server/client connection properties: 

1. On the DICOM Server/Client Connections dialog box, click Insert to add a new set of properties. 

Or, 

On the DICOM Server/Client Connections dialog box, select the name of the client/server configuration properties you 
want to modify. Then, click Modify. 

The DICOM Server/Client Connection Properties dialog box opens. 

2. Enter or change the information necessary for the server/client connection. Then, click OK. 

 

Name Enter the application name that you want to use for this client/server configuration. 

Server 
Address Enter the IP address of the DICOM server. 

Server Port Enter the number of the port on the DICOM server that Dolphin Imaging should use to communicate with it. 

Called AE The application entity receiving the DICOM messaging service request. This should be the application name of 
your DICOM server.  



Dolphin Imaging User's Guide April 2011 

88 DI_USER_GUIDE-11.5   Rev. 1.01 

Calling AE The application entity initiating the DICOM messaging service request. Typically, this should match the value in 
the Name text box. 

Local Port Enter the number of the port on your Dolphin Imaging server that Dolphin Imaging should use to communicate 
with the DICOM server. 

Insert Click this button to add the configuration settings to communicate with this DICOM server to your database. 

To delete DICOM Server/Client connection properties: 

1. On the DICOM Server/Client Connections dialog box, select the name of the client/server configuration properties you 
want to delete. Then, click Delete. 

2. Click Yes on the dialog box that appears to confirm the deletion. 
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4 Patient Charts 
When you start Dolphin Imaging, the first dialog box you see is one of the following: 

• If you are using Standard Dolphin, the Patient Charts dialog box opens. 

• If you are using Dolphin Premium, the Patient Lookup dialog box opens.  

You can also access these dialog boxes by clicking  on the Dolphin Imaging main screen.   

Patient Charts (Standard Dolphin) 
Use the patient selection part of the Patient Charts dialog box (shown below) to select a patient. 

 
Find Use this text box to search for a patient in the patient list rather than scrolling through the list.  

Refresh Click this button to refresh the patient list manually so that you can see any changes made by the management 
system or other workstations. Available only in Dolphin Premium. 

Patient List Lists the patients that have been entered into Dolphin Imaging. This list can be sorted by the patient’s last name 
or by patient ID. 

Patients 
Selected 

Indicates the number of patients currently selected in the patient list and the number of patients that have been 
entered into Dolphin Imaging. 
Note: You can select several patients in the patient list to batch export their measurements tables. For more 
information, see "To export measurements reports for multiple patients” on page 355. 

To select a patient and return to the Dolphin Imaging main screen: 

1. Select the patient’s name from the patient list, and click OK. 

Or, 

Double-click the patient’s name in the patient list. 
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To search for a patient in the patient list rather than scrolling through the list:  

1. If the patient list is sorted by last name, enter part of a patient’s last name in the Find text box. 

Or, 

Enter part of a patient ID in the Find text box.  

The patient list scrolls to the patient name or ID you entered. If the computer beeps, the character sequence you 
entered in the Find text box was not found. 

Once you have selected a patient, the Patient Summary group box displays the information already on file for that patient. If no 
patient is selected, the Patient Summary is blank. 

 

Patient 
Information 

Lists the information already on file for this patient. 

Preview Uncheck this box to not display the patient’s picture. This may speed up performance on some slower 
machines. 

Patient Picture Shows the "smile" picture, if available, for the selected patient and timepoint. The picture name, date, and 
timepoint name is displayed beneath the picture. For information on timepoints, see below. 

Timepoints 
Use the Timepoints section of the Patient Charts dialog box to add or select a patient timepoint. Dolphin Imaging uses timepoints 
to group related sets of patient pictures and X-rays. Like different sections of a patient’s file, a timepoint may contain all the 
pictures taken of a patient on a particular office visit. You can also use a timepoint to record pictures and X-rays of a patient at a 
particular milestone in the patient’s treatment. A timepoint can contain any combination of the pictures, X-rays, forecasts, and so 
on. Each patient image that you store using the Dolphin Imaging program is associated with a timepoint in the patient’s record. 
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New... Click this button to add a new timepoint (see below). 

Copy Click this button to copy the images for the selected timepoint to the clipboard. 

Paste Click this button to paste images from the timepoint stored on the clipboard to the selected patient. For more 
information, see "To copy and paste a timepoint from one patient to another" on pages 93 and 112. 

Timepoint 
List Click an existing timepoint in this list box to select it. 

To select a patient timepoint and return to the Dolphin Imaging main screen: 

1. Double-click a timepoint in the Patient Charts dialog box. 

The Dolphin Imaging main screen appears showing a layout of patient pictures for that timepoint. 

To create a new timepoint for a patient: 

1. Click the Timepoints: New button on the Patient Charts dialog box. 

Or, 

Click the New Timepoint button on the Capture Setup dialog box (see Chapter 5). 

The New Timepoint dialog box appears as shown below. 

2. Enter the name for the timepoint you want to define. 

Or, 

Choose a name from the list of standard timepoint names. 

This name will be used to identify this timepoint in the Timepoints list box. 

3. Optionally, enter the date for this timepoint. 

The current date appears in this field automatically. To enter the timepoint date, you can: 

� Type the date in this field using your computer’s regional date setting. For example, you may use two numbers 
each for the month, day, and year separated by slashes: mm/dd/yy.  

� Use the LEFT-ARROW and RIGHT-ARROW keys to move between the month, day, and year parts of the date. You can 
then use the UP-ARROW and DOWN-ARROW keys to increase or decrease the number for that part of the date. 

� Use a drop-down calendar to enter the date as described in "Using the Drop-Down Calendar." 

4. If you want to add the timepoint name that you entered into the list of standard timepoint names, check the Add this 
Name to the list box.  

5. Click OK to create the new timepoint. 
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Date Optionally, enter or select the date for this timepoint. You can select a date using the drop-down calendar. 
You should enter the date that these pictures were taken. For more information on using the drop-down 
calendar, see "Using the Drop-Down Calendar" on page 142. 

Timepoint 
Name 

Enter the name for the timepoint you want to add or select from the list of standard timepoint names. 

Timepoints list 
box 

Lists the currently-defined standard timepoint names for your system.  

Delete Click this button to delete the currently-selected timepoint name from the list of standard timepoint names. 

Add this Name 
to the list 

Check this box to add the new timepoint name to the list of standard timepoint names. 

To delete a standard timepoint name:  

1. Click the Timepoints: New button on the Patient Charts dialog box. 

Or, 

Click the New Timepoint button on the Capture Setup dialog box (see Chapter 5). 

The New Timepoint dialog box is displayed. 

2. Select the standard timepoint name that you want to delete from the timepoint list on the New Timepoint dialog box. 

3. Click Delete. 

Note: For instructions on deleting a timepoint for a patient, see "To delete a patient, timepoint, or image" on page 148. 
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To copy and paste a timepoint from one patient to another:  

1. If you want to paste the pictures associated with a timepoint to another patient, select the patient and timepoint from 
which you want to copy pictures on the Patient Charts dialog box. 

For example, if you accidentally add patient pictures to the wrong patient, you can use this feature to copy the pictures 
to the correct patient and timepoint. 

2. Click Copy. 

3. Select the patient to which you want to paste the images.  

4. Click Paste. 

Image Layout 
Once you have selected a patient, you can view any pictures available for him or her using the image layouts. If you select a 
timepoint, the image layouts reflect the pictures available for that timepoint.  

 
Layout Select the image layout containing the pictures you want to view from this drop-down list box. 

Layout Preview Displays the pictures for the selected layout for the selected timepoint. 

To view a patient’s pictures: 

1. Select an existing timepoint for a patient.  

2. Select a layout from the Layout drop-down list box to view the patient’s pictures for that timepoint and layout.   

To compare patient pictures in a particular layout for different timepoints: 

1. Select the patient whose pictures you want to view. 

2. Select the layout containing the pictures you want to compare. 

3. Select a timepoint from the Timepoint list box to view the patient pictures for that timepoint. 

4. Select a different timepoint from the Timepoint list box to view the patient pictures for that timepoint. 
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Patient Lookup (Dolphin Premium) 
The Patient Lookup dialog box provides options for searching for a patient's chart. This dialog box offers two views: 

• Basic View offers basic search options that enable you to perform the most commonly-used searches. 

• Advanced View offers options to perform more complex searches. 

Each of these views is described in detail below. 

To switch from basic to advanced view: 

1. Click >> Advanced. 

To switch from advanced to basic view: 

1. Click Basic <<. 

Basic View 
The following figure illustrates the basic view of the Patient Lookup dialog box.  
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In the basic view, the Patient Lookup dialog box provides a New Patient button that you use to add new patient records. In 
addition, this dialog box contains the following sections: 

Patient 
Search 

Provides options to search for a patient. This section provides the following controls that you can use to look up 
patient records: 
Look For: Select the criteria that you want to use to search for a patient from the first drop-down list box. Then, 
enter the criteria in the second drop-down list box to search for patients. Alternatively, click the arrow button on the 
second drop-down list to select a recent patient. 
Find Now: Click this button to find patients that meet the search criteria you entered. 
New Search: Click this button to clear all your search criteria and begin a new search. 
>>Advanced: Click this button to switch to the advanced view. 
For more information, see "Searching For Patients" below. 

Patient 
List 

Lists the patients that meet the search criteria you entered and provides information about the currently-selected 
patient. 

Searching for Patients 
You can look up a patient's record using the Patient Lookup dialog box.  

To look up a patient's record:  
1. Select the criteria that you want to use to look up patients in the Look For drop-down list box. 

You can look up patients by the patient name, patient ID, patient phone number, patient social security number, billing 
party name, billing party social security number, or patient last name. 

2. If you selected Patient Name, ID, Phone, SSN in the Look For drop-down list box, enter part of a patient’s first name, 
last name, ID, telephone number, or social security number in the second Look For box. 

Or, 

If you selected Patient Last Name in the Look For drop-down list box, enter part of a patient’s last name in the second 
Look For box. 

Or, 

If you selected Billing Party Name, SSN in the Look For drop-down list box, enter part of a billing party's first, last 
name, or social security number in the second Look For box. 

3. Click Find Now. 
 
A list of patients meeting your search criteria appears in the patient list. You can select a patient from this list to begin 
working with that patient's record. 
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To include patients in statuses that typically wouldn't be included in a search: 

1. Check the Include patients in statuses set to not show in lookup box. 

2. Enter any other search criteria.  

3. Click Find Now. 

The search results include all patients that meet the search criteria, regardless of their status. For example, the search 
results include deleted patients that meet the search criteria. 

To clear your search criteria and begin a new search: 

1. Click New Search. 

To select from a list of recent patients: 

1. Select the patient from the second Look For box (see below). 

 

Patient List 
Use the patient list to select a patient from the list of patients that match the search criteria you entered.  
The list of patients is customizable. You can change: 

• The columns that appear: Depending on the number of columns selected for display, the current sizes of the columns, 
and the size of the Patient Lookup dialog box, you may need to use a horizontal scroll bar at the bottom of the list to 
see all the information available for each of the patients. The figure below illustrates some of the available columns. 

• The image that appears for the currently-selected patient: You can display the patient's ID photo (as illustrated below), 
one of the image layouts, or no image. 

• Whether to include all patients (regardless of their status) in search results: Check the Include patients in statuses set 
to not show in lookup box to include records for patients in statuses that typically wouldn't be included in a search, such 
as patients that have been deleted. If you are using Dolphin Imaging with Dolphin Management, checking this box 
searches records for patients whose patient status is set to a status that does not appear in patient lookup. For more 
information about Dolphin Management patient statuses, refer to the online help for Dolphin Management 

Customizing these options is described below. 
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Available Columns 

Patient The name of a patient who matched the search criteria you entered. 

Patient ID The ID of a patient who matched the search criteria you entered. 

Patient Birthdate The patient's birth date. 

Patient Phone The patient's telephone number. 

Patient Address The patient's address. 

Patient Email The patient's e-mail address. 

Patient Gender The patient's gender. 

Patient Social The patient's social security number. 

Billing Party The party responsible for paying for the patient's treatment. 

Billing Party Social The billing party's social security number. 
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Other Dialog Box Options 

Show Image>> Click this button to open a menu of the following options for the patient image to display.  
No Image: Select this option to omit the patient's image. 
ID Photo: Select this option to show the ID photo for the patient selected in the patient list. 
Layout: Select this option to show an image layout for the patient selected in the patient list. A 
cascade menu opens and lists the available image layouts.  

Include patients 
in statuses set to 
not show in 
lookup 

Check this box to search records for patients in statuses that typically wouldn't be included in a 
search, such as patients that have been deleted. If you are using Dolphin Imaging with Dolphin 
Management, checking this box searches records for patients whose patient status is set to a status 
that does not appear in patient lookup. For more information about Dolphin Management patient 
statuses, refer to the online help for Dolphin Management. 

Showing All 
Results 

Indicates the number of patients that met your search criteria and whether they are all listed in the 
patient list. 

Show More Click this button in either of the following circumstances: 
� When you first open the Patient Lookup dialog box, if only one patient is listed, to list 

patients adjacent to the current patient in an alphabetical list. 
� Following a search that resulted in more than 100 matching patients, to show all the 

patients that met your search criteria. Otherwise, only the first 100 matching patients are 
listed. 

Options... Click this button to set searching options. For more information, see "To set searching options" on 
page 99. 

To select a patient: 

1. Click the patient in the patient list. 

To return to the Dolphin Imaging main screen: 

1. Click OK. 

Alternatively, you can double-click a patient in the patient list to select that patient and return immediately to the 
Dolphin Imaging main screen. 

To re-sort the patient list: 

1. Click the column by which you want to sort the patient list. 

A down arrow appears next to the column heading, and the patient list is re-sorted. 

2. Click the column again to reverse the sort order (descending to ascending and vice-versa). 
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To resize the columns in the patient list: 

1. Move the mouse pointer to the dividing line between two column headings. 

2. When the mouse pointer changes to a two-headed arrow across a line, click and drag the mouse to resize the column 
headings. 

To show different columns in the patient list: 

1. Right-click one of the column headings. 

A pop-up menu appears listing all available columns. The columns currently selected for the display are checked. 

2. Click an unselected column to add it to the display. 

Or, 

Click a selected column to remove it from the display. 

To change the order of the columns in the patient list: 

1. In the patient list, click the heading for the column you want to move. 

2. Hold down the left mouse button, and drag and drop that column heading into a different position. 

The column moves to the location where you dropped it. 

To change the image option: 

1. Click Show Image. 

A pop-up menu appears listing the options for displaying a patient image. 

2. Select No Image to omit the image of the selected patient. 

Or, 

Select ID Photo to show the selected patient's ID photo. 

Or, 

Select Layout. Then, select the image layout you want to view from the cascade menu. 

The picture that appears for the patient if you select ID Photo depends on the pictures available for this patient.  

To set search options: 

1. Click Options.... 

The Options dialog box opens. 

2. Check the box for each searching option you want to enable. Then, click OK. 
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Enable First-
Initial-Last 
Name Search 

Check this box if you want to enable first initial, last name search. With this option disabled, if you type 
"smi" in the Patient Lookup dialog box and click Find Now, Dolphin Imaging only lists patients whose 
last name or patient ID begin with "smi." With this option enabled, Dolphin Imaging also lists patients 
whose first initial is "s" and whose last name begins with "mi." 

Show Entire 
List 

Check this box to display your entire patient list in the Patient Lookup dialog box when it first opens. 
This option is not recommended. 

Live Search Check this box to begin the search automatically if you pause momentarily when typing a search string. 
This option is not recommended. 

 



4 Patient Charts Part II: Dolphin Basics 

DI_USER_GUIDE-11.5   Rev. 1.01 101 

Advanced View 
The following figure illustrates the advanced view of the Patient Lookup dialog box.  

 
In the advanced view, the Patient Lookup dialog box provides buttons (New Patient, Details, Archive, Rename, and Delete) that 
you use to manage patient records. In addition, this dialog box contains the following sections: 

Patient 
Search 

Provides options to search for a patient. This section provides the following controls that you can use to look up 
patient records: 
Look For: Select the criteria that you want to use to search for a patient from the first drop-down list box. Then, 
enter the criteria in the second drop-down list box to search for patients. Alternatively, click the arrow button on the 
second drop-down list to select a recent patient. 
Find Now: Click this button to find patients that meet the search criteria you entered. 
New Search: Click this button to clear all your search criteria and begin a new search. 
For more information, see "Searching For Patients" below. 

Tabs This dialog box provides the following tabs: 
Basic Info Tab: Lists the patients that meet the search criteria you entered and provides information about the 
currently-selected patient. 
Info Tab: Enables you to enter search criteria such as demographic information or keywords for looking up patients. 
Records Tab: Enables you to enter search criteria to select patients based on their timepoints and images.  
Diagnostics Tab: Enables you to enter search criteria to select patients based on diagnostic information. 
Cephalometrics Tab: Enables you to enter search criteria to select patients based on cephalometric information. 
Advanced Tab: Enables you to save, load, or remove favorite searches and to search records for deleted patients. 
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If you have Dolphin Management, the following additional tabs appear on this dialog box:  
Financials Tab: Enables you to enter search criteria to select patients based on financial information. 
Scheduling Tab: Enables you to enter search criteria to select patients based on scheduling information. 
Referrals Tab: Enables you to enter search criteria to select patients based on referral information. 
Custom Fields Tab: Enables you to enter search criteria to select patients based on information in custom fields. 

 

Searching for Patients 
You can look up a patient's record using the Patient Lookup dialog box.  

To look up a patient's record:  
1. Select the criteria that you want to use to look up patients in the Look For drop-down list box. 

You can look up patients by the patient name, patient ID, patient phone number, patient social security number, billing 
party name, billing party social security number, or patient last name. 

2. If you selected Patient Name, ID, Phone, SSN in the Look For drop-down list box, enter part of a patient’s first name, 
last name, ID, telephone number, or social security number in the second Look For box. 

Or, 

If you selected Patient Last Name in the Look For drop-down list box, enter part of a patient’s last name in the second 
Look For box. 

Or, 

If you selected Billing Party Name, SSN in the Look For drop-down list box, enter part of a billing party's first, last 
name, or social security number in the second Look For box. 

Or, 

Enter search criteria on one or more of the tabs other than the Basic Info tab. 

If you enter search criteria on more than one tab, the search criteria are combined and only those patients who meet all 
the criteria are considered to be a match. 

3. Click Find Now. 
 
A list of patients meeting your search criteria appears in the patient list on the Basic Info tab. You can select a patient 
from this list to begin working with that patient's record. 

To include patients in statuses that typically wouldn't be included in a search: 

1. Click the Advanced tab. Then, check the Include patients in statuses set to not show in lookup box. 

2. Enter any other search criteria.  

3. Click Find Now. 

The search results include all patients that meet the search criteria, regardless of their status. For example, the search 
results include deleted patients that meet the search criteria. 



4 Patient Charts Part II: Dolphin Basics 

DI_USER_GUIDE-11.5   Rev. 1.01 103 

To clear your search criteria and begin a new search: 

1. Click New Search. 

To select from a list of recent patients: 

1. Select the patient from the second Look For box (see below). 

 

Basic Info Tab 
This tab appears when you open the Lookup Patient dialog box in advanced view. Initially, this tab is blank. Using this tab, you 
can: 

• select a patient from a list of patients matching search criteria that you entered 

• view information about the selected patient 

• view patient pictures 

• add, rename, or delete a patient 

• view or create timepoints for the patient 

• archive patient records or retrieve archived records 

The following figure illustrates the appearance of this tab after you have selected a patient. 
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This tab contains the following sections: 

Patient List Summarizes information about each patient that matched search criteria that you entered. 

Patient 
Summary 

Lists information already entered for the selected patient. If no patient is selected, the patient summary is 
blank. 

Timepoints Lists the timepoints for this patient, which you use to organize patient images from different time periods or for 
different purposes. Also provides buttons for managing patient timepoints.  

Image or 
Layout 

Displays the one or more of the pictures on file for the selected patient. 

This tab also contains buttons that you use to manage patient records. For more information, see "Managing Patient Records" 
below. 
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Patient List 
Use the patient list on the Patient Lookup dialog box's Basic Info tab to: 

• select a patient from the list of patients that match the search criteria you entered 

• view basic information about each matching patient.  

You can also print a copy of the patient list, copy it to the clipboard, or save it to a file. 
The list of patients is customizable. Depending on the number of columns selected for display, the current sizes of the columns, 
and the size of the Patient Lookup dialog box, you may need to use a horizontal scroll bar at the bottom of the list to see all the 
information available for each of the patients. The figure below illustrates some of the available columns. 

 

Available Columns 

Patient The name of a patient who matched the search criteria you entered. 

Patient ID The ID of a patient who matched the search criteria you entered. 

Patient Birthdate The patient's birth date. 

Patient Phone The patient's telephone number. 

Patient Address The patient's address. 

Patient Email The patient's e-mail address. 

Patient Gender The patient's gender. 
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Patient Social The patient's social security number. 

Billing Party The party responsible for paying for the patient's treatment. 

Billing Party Social The billing party's social security number. 

Other Options 

Selected/Found Indicates the number of patients currently selected in the patient list and the number of patients that met your 
search criteria. 
Note: You can select several patients in the patient list to batch export their measurements tables. For more 
information, see "To export measurements reports for multiple patients" on page 355. 

Show More Click this button in either of the following circumstances: 
� When you first open the Patient Lookup dialog box, if only one patient is listed, to list patients 

adjacent to the current patient in an alphabetical list. 
� Following a search that resulted in more than 100 matching patients, to show all the patients that 

met your search criteria. Otherwise, only the first 100 matching patients are listed. 

Print... Click this button to print the list of patients that met your search criteria.  

Copy... Click this button to copy the list of patients that met your search criteria to the clipboard.  

Save... Click this button to save the list of patients that met your search criteria to a file.  

To select a patient: 

1. Click the patient in the patient list. 

The timepoints and image layout for that patient appear. 

To return to the Dolphin Imaging main screen: 

1. Click OK. 

Alternatively, you can double-click a patient in the patient list to select that patient and return immediately to the 
Dolphin Imaging main screen. 
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To re-sort the patient list: 

1. Click the column by which you want to sort the patient list. 

A down arrow appears next to the column heading, and the patient list is re-sorted. 

2. Click the column again to reverse the sort order (descending to ascending and vice-versa). 

To resize the columns in the patient list: 

1. Move the mouse pointer to the dividing line between two column headings. 

2. When the mouse pointer changes to a two-headed arrow across a line, click and drag the mouse to resize the column 
headings. 

To show different columns in the patient list: 

1. Right-click one of the column headings. 

A pop-up menu appears listing all available columns. The columns currently selected for the display are checked. 

2. Click an unselected column to add it to the display. 

Or, 

Click a selected column to remove it from the display. 

To change the order of the columns in the patient list: 

1. In the patient list, click the heading for the column you want to move. 

2. Hold down the left mouse button, and drag and drop that column heading into a different position. 

The column moves to the location where you dropped it. 

To print the patient list: 

1. Click Print. 

The Print dialog box is displayed. 

2. Select any printing options you want and click OK. 
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Printer Indicates the printer to which the print job will be sent. 

Properties Click this button to set advanced properties for the selected printer. 

Print 
Range 

Select what you want to print. When printing the patient list, the All option is automatically selected so that the 
entire patient list prints. 

Copies Enter the number of copies you want to print. 

To copy the patient list to the clipboard: 

1. Click Copy. 

The patient list is copied to the clipboard. You can then paste it into another application, such as Microsoft Word. 

To save the patient list to a file: 

1. Click Save. 

The Save As dialog box is displayed. 

2. Select the folder where you want to save the patient list. 

3. Enter the name of the file in which you want to save the patient list. Then, click Save. 
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Patient Summary 
Once you have selected a patient, the Basic Info displays the information already on file for that patient. If no patient is selected, 
the Patient Summary is blank. 

 

Timepoints 
Use the Timepoints section of the Patient Lookup dialog box's Basic Info tab to add or select a patient timepoint. Dolphin Imaging 
uses timepoints to group related sets of patient pictures and X-rays. Like different sections of a patient’s file, a timepoint may 
contain all the pictures taken of a patient on a particular office visit. You can also use a timepoint to record pictures and X-rays of 
a patient at a particular milestone in the patient’s treatment. A timepoint can contain any combination of the pictures, X-rays, 
forecasts, and so on. Each patient image that you store using the Dolphin Imaging program is associated with a timepoint in the 
patient’s record. 

 

New... Click this button to add a new timepoint. 

Copy Click this button to copy the images for the selected timepoint to the clipboard. 

Paste Click this button to paste images from the timepoint stored on the clipboard to the selected patient.  

Date Click this column heading to sort the list of timepoints by date. 

Name Click this column heading to sort the list of timepoints by name. 

To select a patient timepoint and return to the Dolphin Imaging main screen: 

1. Double-click a timepoint in the Patient Lookup dialog box. 

The Dolphin Imaging main screen appears showing a layout of patient pictures for that timepoint. 

To resort the list of timepoints: 

1. Click a column heading to resort the list of timepoints by that column. 

2. Click the column heading again to change between ascending and descending order. 

Resorting the timepoints also changes the order in which they appear on the Dolphin Imaging main screen. 
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To resize the columns in the timepoint list: 

1. Move the mouse pointer to the dividing line between the two column headings. 

2. When the mouse pointer changes to a two-headed arrow across a line, click and drag the mouse to resize the column 
headings. 

To create a new timepoint for a patient: 

1. Click the Timepoints: New button on the Patient Lookup dialog box's Basic Info tab. 

Or, 

Click the New Timepoint button on the Capture Setup dialog box (see Chapter 5). 

Or, 

Click the Add New Timepoint button on the list of timepoint tabs in the Dolphin main screen (see below). 

 
The New Timepoint dialog box appears as shown below. 

2. Enter the name for the timepoint you want to define. 

Or, 

Choose a name from the list of standard timepoint names. 

This name will be used to identify this timepoint in the Timepoints list box. 

3. Optionally, enter the date for this timepoint. 

The current date appears in this field automatically. To enter the timepoint date, you can: 

� Type the date in this field using your computer’s regional date setting. For example, you may use two numbers 
each for the month, day, and year separated by slashes: mm/dd/yy.  

� Use the LEFT-ARROW and RIGHT-ARROW keys to move between the month, day, and year parts of the date. You can 
then use the UP-ARROW and DOWN-ARROW keys to increase or decrease the number for that part of the date. 

� Use a drop-down calendar to enter the date as described in "Using the Drop-Down Calendar." 

4. If you want to add the timepoint name that you entered into the list of standard timepoint names, check the Add this 
Name to the list box.  

5. Click OK to create the new timepoint. 
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Treatment This drop-down list box appears only if you are using Dolphin Premium with Dolphin Management.  
Select the treatment for this timepoint from this drop-down list box. If the treatment you want to select is not 
listed, select <Add New> to add a new treatment to the list of this patient's treatments (see below). 

Date Optionally, enter or select the date for this timepoint using the drop-down calendar. You should enter the 
date that these pictures were taken. For more information on using the drop-down calendar, see "Using the 
Drop-Down Calendar" on page 142. 

Timepoint Name Enter the name for the timepoint you want to add or select from the list of standard timepoint names. 

Timepoints list 
box 

Lists the currently-defined standard timepoint names for your system.  

Delete Click this button to delete the currently selected timepoint name from the list of standard timepoint names. 

Add this Name 
to the list 

Check this box to add the new timepoint name to the list of standard timepoint names. 
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To add a new treatment for this patient (Dolphin Premium with Dolphin Management only): 

1. On the New Timepoint dialog box, enter the name for the timepoint you want to define. 

Or, 

Choose a name from the list of standard timepoint names. 

2. Optionally, enter the date for this timepoint. 

3. From the Treatment drop-down list box, select the treatment to which this timepoint applies. Then, click OK. 

Or, 

Select <Add New> from the Treatment drop-down list box to add a new treatment for this patient and timepoint. Then, 
click OK. 

If you selected a treatment, the new timepoint is added with the selected treatment, and you should skip the next step.  

If you selected <Add New>, the Choose a Treatment dialog box opens listing the available treatment types for this 
patient. 

4. If the Choose a Treatment dialog box opens, select a treatment type from the list. Then, click OK. 

The new timepoint is added with the selected treatment. 

To delete a standard timepoint name:  

1. Click the Timepoints: New button on the Patient Lookup dialog box's Basic Info tab. 

Or, 

Click the New Timepoint button on the Capture Setup dialog box (see Chapter 5). 

The New Timepoint dialog box is displayed. 

2. Select the standard timepoint name that you want to delete from the timepoint list on the New Timepoint dialog box. 

3. Click Delete. 

Note: For instructions on deleting a timepoint for a patient, see page 148. 

To copy and paste a timepoint from one patient to another:  

1. If you want to paste the pictures associated with a timepoint to another patient, select the patient and timepoint from 
which you want to copy pictures on the Patient Lookup dialog box's Basic Info tab. 

For example, if you accidentally add patient pictures to the wrong patient, you can use this feature to copy the pictures 
to the correct patient and timepoint. 

2. Click Copy. 

3. Select the patient to which you want to paste the images.  

4. Click Paste. 
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Image or Layout 
Once you have selected a patient, you can view any pictures available for him or her. The image that appears for the currently-
selected patient is customizable. You can display the patient's ID photo, one of the image layouts (as illustrated below), or no 
image. If you select a timepoint, the ID photo or image layouts reflect the pictures available for that timepoint.  

 

Show Layout Check this box and select a layout from the drop-down list box to display an image layout for this patient. 

Layout Preview Displays the selected image layout for the selected timepoint. 

To change the image option: 

1. Check the Show Layout box to show an image layout for the selected patient. 

Or, 

Uncheck this box to omit the image layout. 

2. If you checked the Show Layout box, select a layout from the drop-down list box to view the patient’s pictures for that 
layout.  

To compare patient pictures in a particular layout for different timepoints: 

1. Select the patient whose pictures you want to view. 

2. Select the layout containing the pictures you want to compare. 

3. Select a timepoint from the Timepoint list box to view the patient pictures for that timepoint. 

4. Select a different timepoint from the Timepoint list box to view the patient pictures for that timepoint. 

To set search options: 

1. Click Options.... 

The Options dialog box opens. 

2. Check the box for each searching option you want to enable. Then, click OK. 
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Enable First-
Initial-Last 
Name Search 

Check this box if you want to enable first initial, last name search. With this option disabled, if you type 
"smi" in the Patient Lookup dialog box and click Find Now, Dolphin Imaging only lists patients whose 
last name or patient ID begin with "smi." With this option enabled, Dolphin Imaging also lists patients 
whose first initial is "s" and whose last name begins with "mi." 

Show Entire 
List 

Check this box to display your entire patient list in the Patient Lookup dialog box when it first opens. 
This option is not recommended. 

Live Search Check this box to begin the search automatically if you pause momentarily when typing a search string. 
This option is not recommended. 

Info Tab 
You use this tab to enter search criteria such as demographic information or keywords for looking up patients. All information on 
this tab is optional. 

To enter search criteria on this tab: 

1. Check one or more boxes in the Norm Filter group box to look up patients based on racial or ethnic norms. 

2. Click a radio button in the Gender group box to look up patients based on gender.  

3. Enter an age range to limit your search according to the patient's age. 

4. Enter a social security number to search for the patient by social security number. 

5. Select a doctor from the Doctor drop-down list box to limit your search according to the patient's primary doctor. 

6. Select a keyword from the Available list box in the Keywords group box and click >> to limit your search according to 
keywords associated with the patient.  

Repeat this step to select additional keywords for your search. To deselect a selected keyword, click it in the Selected 
list box and click <<. 
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Norm Filter Check one or more of these boxes to look up patients based on racial or ethnic norms. The options that appear 
depend on the settings in the [Race] section of your dolphin.ini file. For more information, see Appendix B. 

Gender 
Filter 

Click one of these radio buttons to look up patients based on gender. By default, your search is not limited by 
gender (Both is selected). 

Age Filter Enter the upper and lower boundaries for an age range to limit your search according to the patient's age.  
From: The lower boundary of the age range. 
To: The upper boundary of the age range. 

Doctor Select a doctor from this drop-down list box to limit your search according to the patient's primary doctor. Select 
ALL (the default) to include patients for all doctors in your search. 

Keywords Use these two lists to limit your search according to one or more keywords associated with the patient.  
Edit These...: Click this button to edit the list of predefined keywords. 
Available: Lists all the keywords that are available to use for search criteria. 
Selected: Lists the keywords that you have selected to use for your search. 

<< or >> Click these buttons to move items between the two list boxes in the Keywords group box. 
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To edit the predefined patient keywords: 

1. In the Keywords group box on the Info tab, click Edit These.... 

The Edit Keywords dialog box opens. 

 

Add Type a keyword in the text box and click this button to add a new keyword. 

Remove Select a keyword in the list and click this button to delete an existing keyword. 

Keyword List Lists the currently-defined keywords. 

To define a new keyword: 

1. Type the new keyword in the text box. 

2. Click Add. 
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To remove a keyword: 

1. Select the keyword you want to remove from the list. 

2. Click Remove. 

To close this dialog box: 

1. Click OK. 

Records Tab 
You use this tab to enter search criteria that selects patients based on their timepoints and images. All information on this tab is 
optional. 

To enter search criteria on this tab: 

1. Check one or more boxes in the Record Type (Timepoint) group box to look up patients based on timepoints. 

2. Check one or more boxes in the Image Type group box to look up patients based on image types. 

3. Enter date criteria in the Record Date group box to limit your search to timepoints or images that were created or 
changed within a particular date range. 
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Record Type 
(Timepoint) 

Check one or more of these boxes to look up patients based on the timepoints that have been entered for 
them. 

Image Type Check one or more of these boxes to look up patients based on the types of images that have been 
captured or saved for them.  

Record Date Select one of the following options to limit your search to timepoints or images that were created or changed 
within a particular date range:  
Any Time: Select this option if you do not want to limit your search by date. 
Within the Last: Select this option and select a digit and unit of time to limit your search to timepoints or 
images that were created or changed during that period. For instance, you can search for images that 
changed within the last 2 weeks or 5 months. 
From/To: Select this option and select a date range from the two drop-down list boxes to limit your search to 
timepoints or images that were created or changed during that period. 

Diagnostics Tab 
You use this tab to enter search criteria that selects patients based on diagnostic information entered for them using the 
Questionnaire feature (see Chapter 20). All information on this tab is optional. 

To enter search criteria on this tab: 

1. Select a diagnostic group in the Diagnostic Groups list box to list the items in that group. 

Or, 

Enter a text string (keyword or partial keyword) in the Keyword Search For Group Items text box and click Find to list all 
diagnostic group items that contain that string. 

The diagnostic group items that match the criteria you entered appear in the Available Group Items list box. 

If you entered a text string and clicked Find, the list of matching diagnostic group items may be long. You can then 
select a diagnostic group from the Diagnostic Groups list box to limit the matching group items to those that match the 
text string and the selected diagnostic group. 

2. Select a diagnostic item in the Available Group Items list box and click >> to limit your search to patients with that 
diagnosis.  

Repeat this step to select additional group items for your search. To deselect a selected group item, click it in the 
Selected Group Items list box and click <<. 
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Diagnostic Groups Lists the diagnostic groups defined for your system, which are set up as questions on the 
Questionnaire Setup dialog box. For more information, see "Setting Up a Questionnaire" on page 506. 

Keyword Search for 
Group Items 

Enter a text string and click Find to search all diagnostic groups and group items for that string.  

Available Group 
Items 

Lists diagnostic group items in the selected diagnostic group that match the entered search keyword. 

Selected Group Items Lists diagnostic group items that you have selected to use for your search. 

<< and >> Click these buttons to move group items between the Available Group Items and Selected Group Items 
list boxes. 

Cephalometrics Tab 
You use this tab to enter search criteria that selects patients based on cephalometric information. On this tab, you select an 
analysis and a measurement from that analysis. Then, you identify the range of values for the measurement that you want to use 
to select patients. All information on this tab is optional. 
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To enter search criteria on this tab: 
1. Select the analysis that you want to use to select patients from the Analysis drop-down list box. 

2. Select a measurement from the selected analysis using the Measurement drop-down list box. 

3. Click and drag the lower and/or upper boundaries of the range to identify a range of values that you want to use to 
select patients. 

4. Click Left to select patients for whom the selected measurement is to the left of the lower range boundary. 

Or, 

Click Right to select patients for whom the selected measurement is to the right of the upper range boundary. 

Or, 

Click Inside (the default) to select patients for whom the selected measurement is within the range identified by the 
upper and lower range boundaries. 

Or, 

Click Outside to select patients for whom the selected measurement is outside the range identified by the upper and 
lower range boundaries. 

When you select one of these options, the blue shading moves so that it identifies the selected range. 
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Analysis Select the analysis that you want to use to select patients from this drop-down list box. 

Measurement Select the measurement that you want to use to select patients from this drop-down list box. 

View in 
Editor 

Click this button to view the selected analysis in the Custom Analysis Editor. For more information, see Chapter 
11. 

Range Select the range that you want to use to select patients. The blue selector indicates the range of values that will 
be used to select patients. 
Left: Select this option to select values to the left of the lower boundary (move the blue selector to the left side 
of the curve). 
Right: Select this option to select values to the right of the upper boundary (move the blue selector to the right 
side of the curve). 
Inside: Select this option to select values between the upper and lower boundaries (move the blue selector to 
the center of the curve). 
Outside: Select this option to select values outside the upper and lower boundaries (move the blue selector to 
the two sides of the curve). 
Std Dev: Select this option to use standard deviation as the units on the curve. Standard deviation is a 
statistical term that indicates the expected variation of data from the norm. For instance, if a measurement has a 
small standard deviation, the measurements for most patients are expected to be close to the norm. If a 
measurement has a large standard deviation, it is not expected that most patient's measurement will be close to 
the norm. 
Value: Select this option to use the actual measurement values as the units on the curve. 

Financials Tab 
You use this tab to enter search criteria that selects patients, billing parties, or insurance companies based on the amount owed. 
This tab only appears if you also have Dolphin Management. All information on this tab is optional. 

To enter search criteria on this tab: 

1. Select an option in the Search For group box. 

2. Enter a dollar amount in the Amount Owed text box. 

3. Specify how you want to use the amount owed to identify patients, billing parties, or insurance companies by selecting 
options from the two drop-down list boxes. 
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Search For group 
box 

Select what you want to search for in this group box. You can search for patients, billing parties, insurance 
companies, or billing parties and insurance companies.  
Note: If you select Billing Parties, Insurance Companies, or Billing Parties and Insurance Companies, 
search criteria from all other tabs is ignored when you perform the search. 

Amount Owed Enter a dollar amount in this text box to search based on the amount that patients, billing parties, or 
insurance companies owe. 

Look for amounts 
that are 

Select one of the following options to specify how to select accounts based on the amount owed:  
More Than This Amount: Select this option to select accounts with an amount owed that is greater than 
the dollar amount entered in the Amount Owed text box. 
Less Than This Amount: Select this option to select accounts with an amount owed that is less than the 
dollar amount entered in the Amount Owed text box. 
Equal To This Amount: Select this option to select accounts with an amount owed that is equal to the 
dollar amount entered in the Amount Owed text box. 
Not Equal To This Amount: Select this option to select accounts with an amount owed that is not equal 
to the dollar amount entered in the Amount Owed text box. 

Owed In Select one of the following options to select accounts based on aging of the amount owed: 
Total Due: Select this option to compare the total due amount with the dollar amount entered in the 
Amount Owed text box. 
Current Due: Select this option to compare the current due amount with the dollar amount entered in the 
Amount Owed text box. 
Over 30: Select this option to compare the over 30 amount with the dollar amount entered in the Amount 
Owed text box. 
Over 60: Select this option to compare the over 60 amount with the dollar amount entered in the Amount 
Owed text box. 
Over 90: Select this option to compare the over 90 amount with the dollar amount entered in the Amount 
Owed text box. 
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Unbilled: Select this option to compare the unbilled amount with the dollar amount entered in the Amount 
Owed text box. 
Account Balance: Select this option to compare the account balance amount with the dollar amount 
entered in the Amount Owed text box. 

 

Scheduling Tab 
You use this tab to enter search criteria that selects patients based on recalls or appointments scheduled. This tab only appears 
if you also have Dolphin Management. All information on this tab is optional. 

To enter search criteria on this tab: 

1. Check the Search Recalls box to search for patients based on scheduled recalls. 

Or, 

Check the Search Appointment box to search for patients based on scheduled appointments. 

Or, 

Check both boxes to search for patients based on both recalls and appointments. 

2. Enter search criteria in the Details group box to narrow your search by date, location, or orthodontist. 

3. Check one or more appointment statuses to limit your search by appointment status. 

4. Select one or more procedures and click >> to limit your search by the scheduled procedure. 

When you click >>, the selected procedures moved from the Available list box to the Selected list box. To deselect a 
procedure, click it in the Selected list box and click << to move it back to the Available list box. 
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Search Recalls Check this box to search for patients with scheduled recalls. 

Search 
Appointments 

Check this box to search for patients with scheduled appointments. 

Date Select an option from this drop-down list box to limit your search to patients with scheduled recalls or 
appointments during a specific date range. Possible values are: Any Date (do not limit the search by date), 
Last Year, Last Quarter, Last Month, Last Week, Yesterday, Today, Tomorrow, This Week, Next Week, 
This Month, Next Month, Quarter To Date, Year To Date, and Range. If you select Range, enter a date 
range using the drop-down list boxes below the Date drop-down list box. 

Location Select an option from this drop-down list box to limit your search to patients with scheduled recalls or 
appointments at a specific practice location. 

Orthodontist Select an option from this drop-down list box to limit your search to patients with scheduled recalls or 
appointments with a specific orthodontist. 

Appointment 
Status 

Check one or more appointment statuses to the limit your search to patients with scheduled recalls or 
appointments in the selected statuses. 

Procedures Select one or more procedures to limit your search to patients with scheduled recalls or appointments for 
those procedures.  
Available: Lists all procedures set up for your practice that have not been selected for this search. 
>>: Click this button to move the selected procedures from the Available list box to the Selected list box. 
<<: Click this button to move the selected procedures from the Selected list box to the Available list box. 
Selected: Lists the procedures selected for this search. 

Referrals Tab 
You use this tab to enter search criteria that selects patients based on referrals. This tab only appears if you also have Dolphin 
Management. All information on this tab is optional. 

To enter search criteria on this tab: 

1. Enter search criteria in the Look For Patients Referred To Us group box to search for patients based on who referred 
them to your practice. 

Or, 

Enter search criteria in the Look For Patients We Have Referred group box to search for patients based on who your 
practice referred them to. 
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Referred 
By 

Select a referral type from the first drop-down list box and a specific referral of the selected type from the second 
drop-down list box to search for patients referred to your office by that referral. 

Date Select an option from the first drop-down list box to limit your search to patients referred during a specific date range. 
Possible values are: Any Date (do not limit the search by date), Last Year, Last Quarter, Last Month, Last Week, 
Yesterday, Today, Tomorrow, This Week, Next Week, This Month, Next Month, Quarter To Date, Year To 
Date, and Range. If you select Range, enter a date range using the second and third drop-down list boxes. 

Status Select an option from this drop-down list box to limit your search to patients in the specified patient status. 

Referred 
To 

Select an option from this drop-down list box to limit your search to patients that your practice referred to the 
specified doctor. 
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Custom Fields Tab 
You use this tab to enter search criteria that selects patients based on values entered on the Custom tab of the Edit a Patient 
window in Dolphin Management. This tab only appears if you also have Dolphin Management. All information on this tab is 
optional. 

To enter search criteria on this tab: 

1. Select a custom field in the Available User-Defined Fields list box. 

2. Enter a value in the Value to look for text box to search for patients with that value in the selected custom field. 

 

Available User-Defined Fields Select a custom field from this list box to search for patients based on the value of this field. 

Value to look for Enter a value in this text box to search for patients with that value in the selected custom field. 
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Advanced Tab 
You use this tab to perform previously-saved favorite searches, save or remove favorite searches, and enter advanced search 
criteria. All information on this tab is optional. 

 

Favorite 
Searches 

Select the favorite that you want to use to select patients from this drop-down list box or enter the name of a new 
favorite search. 

Load Loads the selected favorite search. 

Save Saves the current search as a favorite. 

Remove Removes the selected favorite search. 

Other 
Search 
Criteria 

Enter additional advanced search criteria. 
Include patients in statuses set to not show in lookup: Check this box to search records for patients in 
statuses that typically wouldn't be included in a search, such as patients that have been deleted. If you are using 
Dolphin Imaging with Dolphin Management, checking this box searches records for patients whose patient status 
is set to a status that does not appear in patient lookup. For more information about Dolphin Management patient 
statuses, refer to the online help for Dolphin Management. 
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To perform a favorite search: 

1. Select a previously-saved favorite search from the drop-down list box in the Favorite Searches group box. 

2. Click Load. 

The criteria for the favorite search you selected are entered on the tabs of the Patient Lookup dialog box. 

3. Make any changes to the search criteria. Then, click Find Now to execute the search. 

All patients meeting the search criteria are listed in the Patient List on the Basic Info tab. 

To save a favorite search: 

1. Enter the criteria for the search you want to save. 

Your criteria can consist of a string in the Look For text box; information entered on the Info, Records, Diagnostics, 
Cephalometrics, Financials, Scheduling, Referrals, and Custom Fields tabs; and/or criteria entered in the Other Search 
Criteria group box on the Advanced tab. 

2. Click Save. 

The Save Search dialog box is displayed. 

3. Enter the name that you want to use for this favorite search. Then, click OK to save it. 

To remove a favorite search: 

1. Select a previously-saved favorite search from the drop-down list box in the Favorite Searches group box. 

2. Click Remove. 

A dialog box appears asking you to confirm removal of the favorite search. 

3. Click Yes to remove the search. 

Or, 

Click No to cancel the removal. 
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Managing Patient Records 
The Patient Charts (standard Dolphin) or Patient Lookup advanced view (Dolphin Premium) dialog box contains the following 
buttons that you use to manage this patient’s record: 

 

Click this button to add a new patient. For more information, see "Adding or Changing Patients 
(Standard Dolphin)" below, "Adding or Changing Patients (Dolphin Premium)" on page 131, or "Adding 
or Changing Patients (with Dolphin Management)" on page 142. 

 Click this button to change the information for the selected patient. For more information, see "Adding or 
Changing Patients (Standard Dolphin)" below,  "Adding or Changing Patients (Dolphin Premium)" on 
page 131, or "Adding or Changing Patients (with Dolphin Management)" on page 142. 

  

Click this button to archive the selected patient’s record or to load a patient record from an archive. In 
Dolphin Premium, this feature is only available from the Patient Lookup dialog box's advanced view. For 
more information, see "To use archive operations" on page 143. 

  

Click this button to rename the selected patient, timepoint, or image.  In Dolphin Premium, this feature is 
only available from the Patient Lookup dialog box's advanced view.  For more information, see 
4charts_to_rename_a_patient,_tim_3192 page 147. 

  

Click this button to delete the selected patient, timepoint, or image.  In Dolphin Premium, this feature is 
only available from the Patient Lookup dialog box's advanced view.  For more information, see 
4charts_to_delete_a_patient,_tim_2278 page 148. 

Adding or Changing Patients (Standard Dolphin) 

To add a new patient or change a patient’s information (if you are using the Standard Dolphin Imaging software): 
Note: If you are using Dolphin Premium, see "Adding or Changing Patients (Dolphin Premium)" on page 131. If you are using 
Dolphin Imaging with Dolphin Management, see "Adding or Changing Patients (with Dolphin Management)" on page 142. 

1. Click New Patient... on the Patient Charts dialog box to add a patient. 

Or, 

Select the patient whose information you want to change. Then, click Details. 

The Patient Information dialog box is displayed. 

If you are adding a new patient, the Patient Information dialog box is blank so you can enter information for a new 
patient. If you are changing information for an existing patient, this dialog box contains the information currently on file 
for the selected patient. 

2. Enter or change any information for this patient. Then, click OK. 

In each text box, grey italic text indicates the information that you should enter. An asterisk indicates required 
information that you must enter for every patient. All other information is optional. 

To indicate a missing tooth, click that position on the tooth diagram.  
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ID The patient ID used to keep track of the patient’s records. Use the same patient ID that you use in your office 
management system. The patient ID should be unique to this patient and can be any combination of up to ten 
characters including letters, numbers, hyphens, and underscore characters. 

Last Name The patient’s last name. 

First Name The patient’s first name. 

Birth The patient’s birth date. The current date appears in this field initially, but you must change it to the patient’s 
actual birth date. To enter the birth date, you can: 

• Type the patient’s birth date in this field using your computer’s regional date format. For example, you 
may use two numbers each for the month, day, and year separated by slashes: mm/dd/yy.  

• Use the LEFT-ARROW and RIGHT-ARROW keys to move between the month, day, and year parts of the 
date. You can then use the UP-ARROW and DOWN-ARROW keys to increase or decrease the number for 
that part of the date. 

• Use a drop-down calendar to enter the birth date. For more information, see "Using the Drop-Down 
Calendar" on page 142. 

Norm The most appropriate category for this patient. Used only if you use comparisons to racial and gender norms in 
your practice. 
For those practices that use comparisons to racial and gender norms, Dolphin Imaging includes standard 
measurements and can perform these comparisons. 

Gender The patient’s gender. Used only if you use comparisons to racial and gender norms in your practice.  

Phone #1, 
Phone #2 

Telephone numbers for this patient. These fields accept both letters and numbers. Some practices use one of 
these fields for another purpose, such as a database index. 
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Notes Any notes for this patient. 

Tooth 
Diagram 

Use this diagram to indicate missing teeth. The inner diagram is for baby teeth. 
Click a tooth in the diagram to mark it as absent. If you make a mistake, click the tooth again to return it to 
present. 

Adding or Changing Patients (Dolphin Premium) 

To add a new patient or change a patient’s information if you are using Dolphin Premium: 
Note: If you are using the Standard Dolphin software, see "Adding or Changing Patients (Standard Dolphin)" on page 129. If you 
are using Dolphin with Dolphin Management, see Adding or Changing Patients (with Dolphin Management)" on page 142. 

1. To add a patient in the Basic view, click New Patient... on the Patient Lookup dialog box. Then, select New Patient 
from the pop-up menu that appears. 

Or, 

To add a patient in the Advanced view, click New Patient... on the Patient Lookup dialog box's Basic Info tab. Then, 
select New Patient from the pop-up menu that appears. 

Or, 

To change a patient's information, select that patient. Then, click Details.... 

The Patient Information dialog box opens and displays several tabs for information about this patient (see below).  

To add a new patient from a DICOM file or set of files: 

1. In the Basic view, click New Patient... on the Patient Lookup dialog box. Then, select New Patient From DICOM from 
the pop-up menu that appears. 

Or, 

In the Advanced view, click New Patient... on the Patient Lookup dialog box's Basic Info tab. Then, select New Patient 
From DICOM from the pop-up menu that appears. 

2. Browse to and select a DICOM file or file set. 

Dolphin Imaging loads the patient information from the DICOM file or file set to create a new patient record. Then, the 
Patient Information dialog box opens and displays several tabs for information about this patient. On this dialog box, 
you can confirm the patient details and provide in any missing information (see below).  

To enter patient information: 

1. Click any tab to enter information on that tab. 

When you first open the Patient Information dialog box, the General tab is displayed. All the tabs are illustrated and 
described below. 
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If you are adding a new patient manually (not from a DICOM file or set of files), the Patient Information dialog box is 
blank so you can enter information for a new patient. If you are changing information for an existing patient, this dialog 
box contains the information currently on file for the selected patient. If you are adding a new patient from a DICOM file 
or set of files, this dialog box contains the information imported from the DICOM file or set of files. 

In blank text boxes, grey italic text indicates the information that you should enter. An asterisk indicates required 
information that you must enter for every patient. All other information is optional. 

To indicate a missing tooth, click that position on the tooth diagram on the General tab. 

2. When you finish entering or changing information on all tabs of this dialog box, click OK. 

Patient Information General Tab 
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ID The patient ID used to keep track of the patient’s records. Use the same patient ID that you use in your office 
management system. The patient ID should be unique to this patient and can be any combination of up to ten 
characters including letters, numbers, hyphens, and underline characters. 

Last Name The patient’s last name. 

First Name The patient’s first name. 

Nickname Any nickname for this patient. 

Birth The patient’s birth date. The current date appears in this field initially, but you must change it to the patient’s 
actual birth date. To enter the birth date, you can: 
� Type the patient’s birth date in this field using your computer’s regional date format. For example, you 

may use two numbers each for the month, day, and year separated by slashes: mm/dd/yy.  
� Use the LEFT-ARROW and RIGHT-ARROW keys to move between the month, day, and year parts of the 

date. You can then use the UP-ARROW and DOWN-ARROW keys to increase or decrease the number for 
that part of the date. 

� Use a drop-down calendar to enter the birth date. For more information, see "Using the Drop-Down 
Calendar" on page 142. 

Norm The most appropriate category for this patient. Used only if you use comparisons to racial and gender norms in 
your practice. 
For those practices that use comparisons to racial and gender norms, Dolphin Imaging includes standard 
measurements and can perform these comparisons. 

Gender The patient’s gender. Used only if you use comparisons to racial and gender norms in your practice.  

Tooth 
Diagram 

Use this diagram to indicate missing teeth. The inner diagram is for baby teeth. 
Click a tooth in the diagram to mark it as absent. If you make a mistake, click the tooth again to return it to 
present. 

Home Select this radio button if you are entering the patient’s home address. If you select this radio button, the 
Company text box is disabled. You can enter either the patient’s home or office address, but not both. 

Office Select this radio button if you are entering the patient’s office address. If you select this radio button, the 
Company text box is enabled. You can enter either the patient’s home or office address, but not both.  

Company The company for which this patient works. 

Street The street address for this patient. 

City The city for this patient’s address. 

State The state for this patient’s address. 
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Zip Code The zip code for this patient’s address. 

Country The country for this patient’s address. This value defaults to USA. 

Phone #1, 
Phone #2 

Telephone numbers for this patient. These fields accept both letters and numbers. Some practices use one of 
these fields for another purpose, such as a database index. 

Email Email address for this patient. 

Patient Information Details Tab 
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Title The patient’s title. 

Model # The number for the study model for this patient. 

Salutation Salutation to use on letters to this patient. 

Keywords Right-click to select one or more keywords you want to assign for this patient. The keywords you select are 
displayed in the Patient Summary section of the Patient Lookup dialog box.  

Edit These... Click this button to edit the patient keywords.  

Notes Enter any notes for this patient. Right-click to access a pop-up menu of options for editing the text in this box. 

Treating 
Doctor 

Select the doctor treating this patient using this drop-down list box.  

Edit Click this button to edit the information currently in the database for the selected treating doctor or to add a 
new doctor. For more information, see "Editing Doctors" on page 80. 

Referring 
Doctor 

Select the doctor who referred this patient using this drop-down list box.  

Edit Click this button to edit the information currently in the database for the selected referring doctor or to add a 
new doctor. For more information, see "Editing Doctors" on page 80. 
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To edit the predefined patient keywords: 

1. In the Keywords group box on the Info tab, click Edit These.... 

The Edit Keywords dialog box opens. 

 

Add Type a keyword in the text box and click this button to add a new keyword. 

Remove Select a keyword in the list and click this button to delete an existing keyword. 

Keyword List Lists the currently-defined keywords. 

To define a new keyword: 

1. Type the new keyword in the text box. 

2. Click Add. 
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To remove a keyword: 

1. Select the keyword you want to remove from the list. 

2. Click Remove. 

To close this dialog box: 

1. Click OK. 

Patient Information Billing Party Tab 

 

Title The billing party's title. 
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Last Name The billing party's last name. 

First Name The billing party's first name. 

Nickname Any nickname for the billing party. 

Birth The billing party's birth date. By default, the check box is unchecked, which disables this text box. If you want to 
enter the billing party's birth date, check the check box to enable this text box. The current date appears initially. 
To enter the birth date, you can: 
� Type the billing party's birth date in this field using your computer’s regional date format. For example, 

you may use two numbers each for the month, day, and year separated by slashes: mm/dd/yy.  
� Use the LEFT-ARROW and RIGHT-ARROW keys to move between the month, day, and year parts of the 

date. You can then use the UP-ARROW and DOWN-ARROW keys to increase or decrease the number for 
that part of the date. 

� Use a drop-down calendar to enter the birth date. For more information, see "Using the Drop-Down 
Calendar" on page 142. 

Gender The billing party's gender.  

Notes Any notes you want to enter for the patient or billing party. 

Home Select this radio button if you are entering the billing party's home address. If you select this radio button, the 
Company text box is disabled. You can enter either the billing party's home or office address, but not both. 

Office Select this radio button if you are entering the billing party's office address. If you select this radio button, the 
Company text box is enabled. You can enter either the billing party's home or office address, but not both.  

Company The company for which the billing party works. 

Street The street address for the billing party. 

City The city for the billing party's address. 

State The state for the billing party's address. 

Zip Code The zip code for the billing party's address. 

Country The country for the billing party's address. This value defaults to USA. 

Phone #1, 
Phone #2 

Telephone numbers for the billing party. These fields accept both letters and numbers. Some practices use one 
of these fields for another purpose, such as a database index. 

Email Email address for the billing party. 
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Patient Information Referral Tab 

 

Title The doctor’s title. 

Select Click this button to select from a list of previously-entered referrals. 

Last Name The doctor’s last name. 

First Name The doctor’s first name. 

Nickname Any nickname for this doctor. 
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Birth The doctor’s birth date. By default, the check box is unchecked, which disables this text box. If you want to 
enter the doctor’s birth date, check the check box to enable this text box. The current date appears initially. 
To enter the birth date, you can: 
� Type the birth date in this field using your computer’s regional date format. For example, you may 

use two numbers each for the month, day, and year separated by slashes: mm/dd/yy.  
� Use the LEFT-ARROW and RIGHT-ARROW keys to move between the month, day, and year parts of 

the date. You can then use the UP-ARROW and DOWN-ARROW keys to increase or decrease the 
number for that part of the date. 

� Use a drop-down calendar to enter the birth date. For more information, see "Using the Drop-Down 
Calendar" on page 142. 

Gender The doctor’s gender.  

Notes Any notes for this doctor. 

Home Select this radio button if you are entering the doctor’s home address. If you select this radio button, the 
Company text box is disabled. You can enter either the doctor’s home or office address, but not both. 

Office Select this radio button if you are entering the doctor’s office address. If you select this radio button, the 
Company text box is enabled. You can enter either the doctor’s home or office address, but not both.  

Company The company for which this doctor works. 

Street The street address for this doctor. 

City The city for this doctor’s address. 

State The state for this doctor’s address. 

Zip Code The zip code for this doctor’s address. 

Country The country for this doctor’s address. This value defaults to USA. 

Phone #1, 
Phone #2 

Telephone numbers for this doctor. These fields accept both letters and numbers. Some practices use one of 
these fields for another purpose, such as a database index. 

Email Email address for this doctor. 
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To select a previously-entered referral: 

1. Click Select. 

A dialog box appears listing the referring doctors that you have previously entered. 

2. Select a referring doctor from the list. Then, click Select. 

The information entered for the selected referral is entered on the Referral tab of the Patient Information dialog box. At 
this point, you can make any changes to this information. 

 

Patient Information Insurance Tab 
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Select an Insurance 
Company 

Select this patient’s insurance company from the database using this drop-down list box.  

Edit Insurance 
Company 

Click this button to add a new insurance company to the database or to edit the information for the 
insurance company you selected using the drop-down list box. For more information, see "Editing 
Insurance Companies” on page 83. 

Summary When you select an insurance company, contact information for the company appears in this section of 
the dialog box. 

Adding or Changing Patients (with Dolphin Management) 

To add a new patient or change a patient’s information if you are using Dolphin Imaging with Dolphin Management: 

1. Click New Patient... on the Patient Lookup dialog box's Basic Info tab to add a patient. 

Or, 

Select the patient whose information you want to change. Then, click Details. 

Dolphin Management launches if it isn’t already running.  

2. Enter or change the patient’s information in Dolphin Management. 

Using the Drop-Down Calendar 

To use the drop-down calendar to enter a date: 

1. Click the drop-down button next to the date text box. 

A drop-down calendar appears as shown below. If the date text box currently contains a date, that date is marked in 
blue. Today’s date is circled in red. 

2. Select the date you want using the calendar. 

To select a date using the calendar, you have the following options: 

� Click the arrow buttons in the upper right and upper left corners of the drop-down calendar to move to the next or 
previous month. 

� Click a date on the calendar to select that date.  

� Click the year to access buttons used to increase or decrease the year. Then, click the upper button to increase 
the year, or click the lower button to decrease the year. 

� Click the month to access a drop-down list of months. Then, select a month from the list.  
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Archiving Patients to a File 

To use archive operations: 

1. Optionally, select one or more patients to archive from the patient list on the Patient Charts dialog box or the advanced 
view of the Patient Lookup dialog box. 

If you plan to get a patient from an archive, you do not need to select a patient. 

If you are not using Dolphin Premium, you can select only one patient to archive at a time. 

If you are using Dolphin Premium, you can select several patients. To select several adjacent patients, SHIFT+click the 
patients. To select several patients that are not adjacent, CTRL+click the patients. 

2. Click Archive. 

Or, 

Select Save as Old Archive from the File menu if you want to archive the patient using the Dolphin 6.0 archive format. 

A dialog box prompts you for the Archive option you want. 
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Get patient from Archive Select this option to load a patient from an archive file. 

Save patient to Archive Select this option to save the patient to an archive. This option saves the entire patient 
record to an archive file. 
If you are running Dolphin Premium and selected Save as Old Archive from the File menu, 
only this option is available on this dialog box. 

Merge Timepoints from Archive Select this option to merge timepoints from an archive. 

Get patient from Internet Select this option to load a patient that was saved to the Internet using AnywhereDolphin. 
For more information, see "Getting Patients from the Internet" on page 204. 

Save patient to Internet Select this option to save a patient archive to the Internet for use with AnywhereDolphin 
This option saves the entire patient record to the Internet. For more information, see 
"Saving Patients to the Internet" on page 205. 

Upload with the original 
uncropped images (if they exist) 

Select this option to upload the original, uncropped images for this patient, if they were 
saved when the patient's images were captured. 

Upload with video and DICOM 
files (if available) 

Select this option to upload the video or DICOM files for this patient, if any are available. 
For more information about DICOM support, consult your Dolphin representative. 

Upload with 3D files (if available) Select this option to upload the Dolphin 3D files for this patient, if any are available. For 
more information about Dolphin 3D, see Part X: 3D. 
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Don’t let others modify the 
patient file(s) when archived 

Check this check box to prevent anyone from making changes to this archived patient. No 
changes can be made to the archived patient until the patient’s record is loaded again from 
the archive. Available only with Dolphin Premium. 

Note: If you are using Dolphin Premium, archiving a patient saves diagnosis codes but not the associated text. Since Dolphin 
Premium allows you to customize the text associated with diagnosis codes, this may cause difficulties if you load an archived 
patient on a computer other than the computer on which the archive was saved. For example, if you archive a patient on a 
computer that uses the default text for diagnosis codes described in Appendix A and then load that archived patient on a 
computer that has customized diagnosis text, the patient’s record on the new computer reflects the customized diagnosis text. 

To get a patient from or save a patient to an archive: 

1. On the Archive Patient Files dialog box, select an archive operation in the Disk/Network Archive group box and click 
OK. 

The Choose an archive file... dialog box is displayed. 

 

Look in or 
Save in 

Indicates the current folder. The files in the current folder are listed in the File List. You can use the drop-
down list box to navigate to a different folder. 

 
Click this button to navigate to the next folder up in your computer’s folder hierarchy. 

 
Click this button to make a new folder within the current folder. 

 
Click this button to open a cascade menu of display options for the file list. You can view the files in this 
directory as small or large icons, as a list, as a list with details, or as thumbnails. 

File list Click a file from this list box to select that file. If you are using Dolphin Premium, you can select more than 
one file. 
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File name Enter a file name in this text box to choose that file. By default, this text box contains wildcards that limit 
the files listed in the file list to archive files. If you are using Dolphin Premium and have archived patients 
in the new archive format, archive files have a .DAZ extension. Otherwise, archive files have a .DAR 
extension.  

Files of 
type or 
Save as 
 type 

Specifies the types of files to list in the file list. Choosing a file type limits the file list to that type of file and 
enters a wildcard that specifies that file type in the File name text box. 
If you are using Dolphin Premium, this drop-down list box defaults to Dolphin Archives (*.daz). If you want 
to load or merge from old archive format files (Dolphin version 6.0 or earlier), select Dolphin Archive 6.0 
(*.dar, *.pf, *.dat) from this drop-down list box to display these files in the file list.  If you want to save to old 
archive format files, select Dolphin Premium 6.5 Archives (*.daz) or Dolphin Premium 7.x/8.x Archives 
(*.daz) from this drop-down list box. 

Patient Indicates the patient name and patient ID for the currently-selected archive file. 

2. If you are loading one or more patients from archive files, select the files in this dialog box. 

3. Click OK to perform the archive operation. 

� If you are saving to an archive, the selected patient’s chart is saved to the file you chose. 

Note: If you are using Dolphin Premium, archiving a patient saves diagnosis codes but not the associated text. 
Since Dolphin Premium allows you to customize the text associated with diagnosis codes, this may cause 
difficulties if you load an archived patient on a computer other than the computer on which the archive was saved. 
For example, if you archive a patient on a computer that uses the default text for diagnosis codes (described in 
Appendix A), and then load that archived patient on a computer that has customized diagnosis text, the patient’s 
record on the new computer reflects the customized diagnosis text. 

� If you are loading from an archive, the patient’s chart is loaded from the file you chose, and that patient is added 
to the patient list in the Patient Lookup dialog box.  

� If you are merging from an archive, the patient’s chart is merged from the file you chose into the selected patient’s 
chart. 

4. If you are saving to an archive using Dolphin Premium, click Yes to remove the patient from the patient list or No to 
retain the patient in the patient list. 

Or, 

If you are loading from an archive using Dolphin Premium, click Yes to remove the archive file or No to retain the file. 

5. If you are loading from an archive using Dolphin Premium, click Overwrite All to overwrite all patients that already exist 
in your database with those you are loading from the archive. 

Or, 

Click Don't Overwrite Any to skip all patients that already exist in your database. 

Or, 

Click Prompt Individually If you want Dolphin Imaging to ask whether to overwrite whenever it encounters a patient that 
already exists in your database. 

When the archive operation is complete, the Patient Charts (Standard Dolphin) or Patient Lookup (Dolphin Premium) 
dialog box is displayed. 
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Renaming Patients, Timepoints, or Images 

To rename a patient, timepoint, or image (Standard Dolphin): 
1. To rename a patient, select that patient from the patient list. 

Or, 

To rename a timepoint, select a patient from the patient list and the timepoint you want to rename from the Timepoints 
list box. 

Or, 

To rename an image, select a patient from the patient list, the timepoint containing the image from the Timepoints list 
box, and the layout containing the image from the Layout drop-down list box. Then, click the image you want to 
rename. 

2. Click Rename. 

3. Select Patient to rename a patient, Timepoint to rename a timepoint or change the timepoint date, or Image to rename 
an image. 

4. Make any changes in the appropriate Name text box and click OK. 

To rename a patient or timepoint (Dolphin Premium): 

1. To rename a patient, select that patient using the advanced view of the Patient Lookup dialog box. 

Or, 

To rename a timepoint, select a patient using the advanced view of using the Patient Lookup dialog box. Then, select 
the timepoint you want to rename from the Timepoints list box. 

Note: If you are using Dolphin Imaging with Dolphin Management, you use Dolphin Management to rename patients. 
You cannot rename patients in Dolphin Imaging. For information, refer to the Dolphin Management online help. 

2. Click Rename. 

3. Select Patient to rename a patient. 

Or, 

Select Timepoint to rename a timepoint, change the timepoint date, or change the treatment for a timepoint. 

4. Make any changes. 

5. (Optional) Check the Add this Name to list box if you are renaming a timepoint and want to add the new timepoint 
name to the list of standard timepoint names. 

6. Click OK. 
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To rename an image (Dolphin Premium): 

1. On the Dolphin Imaging main screen, right-click the image you want to rename, and select Properties from the Image 
pop-up menu. 

The Image Properties dialog box opens. 

2. Enter the new name for this image in the Title text box. Then, click OK. 

Deleting Patients, Timepoints, and Images 

To delete a patient, timepoint, or image (Standard Dolphin): 

1. To delete a patient, select that patient from the patient list. 

Or, 

To delete a timepoint, select a patient from the patient list and the timepoint you want to delete from the Timepoints list 
box. 

Or, 

To delete an image, select a patient from the patient list, the timepoint containing the image from the Timepoints list 
box, and the layout containing the image from the Layout drop-down list box. Then, click the image you want to delete. 

2. Click Delete. 

If you have selected an image, a thumbnail of the image appears in the Patient Delete dialog box. 

3. Select Patient to delete a patient, Timepoint to delete a timepoint, or Image to delete an image. Then, click OK. 

A confirmation dialog box appears. 

4. Click Yes to delete. 

By default, Dolphin Imaging deletes patient records, timepoints, or images entirely. In some cases, however, you can set an 
option in the [defaults] section of the dolphin.ini file to specify that these records be placed in the recycle bin upon deletion, so 
that you can retrieve them, if necessary. You can use the recycle bin feature in the following circumstances: 

• If you are using Dolphin Imaging on a standalone workstation 

• If you are using Dolphin Imaging on the server for your network 

For information on setting this option, see "[defaults]" on page 1030. 

To retrieve a deleted patient, timepoint, or image if you are using the recycle feature (Standard Dolphin):    

1. Move the file for the patient, timepoint, or image from your computer's recycle bin to your C:\Dolphin\Working 
directory. 

2. Rebuild your patient list as described in "To rebuild your patient list" on page 56. 
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To delete a patient or timepoint (Dolphin Premium): 

1. To delete a patient, select that patient using the advanced view of the Patient Lookup dialog box. 

Or, 

To delete the images stored in a timepoint or an entire timepoint, select a patient using the advanced view of the 
Patient Lookup dialog box. Then, select the timepoint you want to delete from the Timepoints list box. 

Note: Deleting an entire timepoint deletes all the images and diagnostic data associated with that timepoint. 

2. Click Delete. 

3. Select Current Timepoint's Images to delete only the images stored in the current timepoint. 

Or, 

Select Current Timepoint to delete the images and diagnostic data stored in the current timepoint. 

Or,  

Select Entire Patient to delete the entire patient record. 

4. Click OK. 

A confirmation dialog box appears. 

5. Click Yes to delete. 

To delete an image (Dolphin Premium): 

1. On the Dolphin Imaging main screen, right-click the image you want to delete, and select Delete Image from the Image 
pop-up menu. 

A dialog box appears asking you to confirm the deletion. 

2. Click Yes to delete the image. 

To retrieve a deleted patient, timepoint, or image if you are using the recycle feature (Dolphin Premium):    

1. Move the file for the patient, timepoint, or image from your computer's recycle bin to your C:\Dolphin\Working 
directory. 

2. Enter the patient's demographic data using the patient ID that was originally assigned to the patient. 

If you are using Dolphin Premium, the patient demographic data is stored in an SQL database, which does not provide 
a "recycle bin" feature. You must manually enter this information again using the Patient Information dialog box. In 
addition, you must use the patient's original patient ID, so that the rebuild process can match the deleted timepoints 
and/or images to the correct patient record. 

3. Rebuild your patient list as described in "To rebuild the Dolphin patient list" on page 56.
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Part III: ImagingPlus 
This part of the Dolphin Imaging User’s Guide provides detailed information on using the ImagingPlus Dolphin Imaging module. 
This module is the heart of all Dolphin Imaging products. Carefully designed for quick and intuitive learning, Dolphin ImagingPlus 
lets you efficiently and easily capture, retrieve, print, and present patient image records. 
This part of the Dolphin Imaging User’s Guide Help describes: 

• Capturing patient images 

• Creating slide show presentations 

• Emailing patient images 

• Saving patient records to and getting them from the Internet 

• Transferring patient images into Microsoft PowerPoint or Microsoft Word 

• Printing patient images 

• Creating custom image layouts for viewing or printing images 
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5 Image Capture 
This chapter describes the dialog boxes that you use to capture or scan and crop patient pictures. 
Before you begin capturing pictures, you need to select a patient using the Patient Charts or Patient Lookup dialog box. Then, 

you access the Capture Setup dialog box by clicking  on the Dolphin Imaging main screen’s vertical tool 
bar. 

Note: Although Dolphin Imaging provides powerful features to enhance photographs and X-ray images, there is no substitute for 
high-quality original images. Consult your Dolphin support technician for tips on taking high-quality pictures with your digital 
camera. Consult your X-ray vendor for tips on taking high-quality X-rays.  
The following figure illustrates the Capture Setup dialog box: 

 

Timepoint Use this group box to select an existing timepoint or add a new timepoint. Click a column heading to resort the 
listed timepoints using that heading. This group box contains the following elements: 
New... button: Click this button to add a new timepoint. For more information, see page 110. 
Date: Indicates the date that the currently selected timepoint was created. 
Name: Indicates the name of the timepoint. 

Capturing Use this group box to select the sequence of pictures or individual image you want to capture. This group box 
contains the following elements: 
Sequence Tab: Select this tab to choose from the capture sequences that have been defined.  
Image Tab: Select this tab to choose from individual image names to capture only one image. 
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When the Sequence tab is selected, this group box contains the following additional elements: 
List box: Lists the images in the currently-selected sequence. 
Edit... button: Click this button to open the Sequence Editor. For more information on editing capture 
sequences, see "Editing Capture Sequences" on page 184. 

Input Use this group box to select the source from which you want to capture images. Your options are: 
Scanner, TWAIN driver: Select this option if you are capturing images using a Twain device (typically a 
scanner). This option is typically used when scanning X-rays using a scanner. You select the Twain device from 
the drop-down list box. Refer to the Dolphin Imaging web site (www.dolphinimaging.com) for recommended 
scanners. 
Image file, memory card: Select this option if your images are currently stored in image files on a memory card. 
Digital X-ray: This option is available if you have purchased a digital X-ray package. In this case, this option 
identifies the name of the digital X-ray package. For more information, see Appendix C. 
Digital Video: Select this option to capture a digital video file. This option is only available for systems equipped 
with video capturing devices. For more information, see "To capture a video file" on page 159. 
DICOM Server/PACS: Select this option if you are capturing images from a DICOM Server. This option is 
enabled only if you have purchased the optional DICOM Support module and set up DICOM communication. For 
more information on editing capture sequences, see "Capturing from a DICOM Server" on page 182 and "Setting 
Up DICOM Communication" on page 85. 

Layout Edit 
Box 

Use this group box to edit the image layout associated with the currently-selected capture sequence. This group 
box appears only when the Sequence tab is selected in the Capturing group box. 
This group box is labeled with the name of the image layout associated with the currently-selected capture 
sequence. It depicts the arrangement of images in the image layout. 
Edit... button: Click this button to open the Dolphin Layout Editor. For more information, see Chapter 7. 

Start 
Capture 

Click this button to start image capture with the currently-selected options. 

One-Click  Select this option to view all the pictures in the selected capture sequence at once, crop or enhance them, and 
capture them. For more information, see "Capturing Images" on page 154. 

Autoload Check this box to load the first group of images from your memory card automatically into the One-Click Capture 
layout. This feature is useful if you consistently take only one picture for each image in the layout and take the 
images in order. Otherwise, you may not want to use this option. 

Sequential  Select this option to view, crop or enhance, and capture the selected image or sequence of images one at a 
time. For more information, see "Using Sequential Capture" on page 175. 

Save 
Settings 

Click this button to save the settings you have selected in this dialog box. This saves the selected capture source 
and scanner driver as the settings to use for the currently selected capture sequence. For example, you can pre-
set your facial images to be captured from a memory card and your X-rays to be captured from a scanner. 
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Using One-Click Capture 

Capturing Images 
Using the One-Click feature, you can download an entire capture sequence at the same time. Then, you can crop, resize, 
reorder, and capture all the images in the sequence. The following procedures describe how to: 

• Capture images from a memory card, Twain device (such as a scanner), or DICOM Server/PACS 

• Capture video files 

• Capture images from a non-standard folder on your computer 

• Drag and drop images into One-Click capture from Windows Explorer or Outlook 

To capture images on a memory card using the One-Click feature: 

1. Select an existing timepoint from the Timepoint list box. 

Or,  

Click New... in the Timepoint group box to create a new timepoint. In the resulting dialog box, enter a descriptive name 
for this timepoint and click OK. 

2. Select the Sequence tab in the Capturing group box. Then, select the capture sequence you want to capture from the 
list of capture sequences. 

3. Select the source from which to capture the images in the Input group box. 

4. Make sure the One-Click radio button is selected. Then, click Start Capture. 

The One-Click Capture Setup dialog box displays all the images in the sequence as shown below. Any previously-
captured patient images are loaded automatically into the One-Click Capture image layout. This allows you to replace 
or re-crop previously-captured images selectively. 

By default, the dialog box is maximized. However, you can click the Restore Down window icon in the upper-right 
corner (next to the X icon that closes the dialog box) to make the dialog box smaller. Then, you can resize this dialog 
box by clicking and dragging the edges. 

5. Make any adjustments to the images and click Save. 

A progress dialog box appears to show the progress of the operation. 

If you click Save, the images are cropped and saved as they appear in the One-Click Capture dialog box, unless you 
have selected the Crop Later option in the mode group box. If you selected Crop Later, the images are simply saved--
they are not cropped. You can return to the One-Click Capture dialog box at any time to crop the images. To do this, 
follow the One-Click steps listed above. In the previous step, you will be in the One-Click Capture dialog box showing 
your previously captured images. From there, you can crop, replace, enhance, and/or rotate these previously captured 
images. 

When you click Save, the Dolphin Imaging program remembers whether the One-Click Capture Setup dialog box is 
maximized. In addition, if you moved the alignment guidelines, the Dolphin Imaging program remembers their location 
for this capture sequence. 
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Mode Provides a choice between the following modes: 
Size & Crop: Use this mode to resize or crop the images in this capture sequence. You can also select this 
mode by clicking an image with the right mouse button and selecting it from the pop-up menu.  
Swap: Use this mode to swap the positions of two images in the image layout. Use this mode to correct the 
image layout if the pictures in this sequence were taken out of order. 
Crop Later: Use this mode to save the images in this capture sequence without resizing or cropping them. You 
can return to the One-Click Capture dialog box at any time to resize or crop the images.  

Flip Click this button to flip the selected image vertically (up to down). You can also flip an image by clicking it with 
the right mouse button and selecting Flip from the pop-up menu. 

Mirror Click this button to flip the selected image to its mirror image (left to right). You can also flip an image to its mirror 
image by clicking it with the right mouse button and selecting Mirror from the pop-up menu. 

Rotate Click this button to access the Image Rotation dialog box, where you can specify how much to rotate the image. 
You can also rotate an image by clicking it with the right mouse button and selecting Rotate from the pop-up 
menu. 

Enhance Click this button to enhance the image. You can also enhance an image by clicking it with the right mouse button 
and selecting Enhance from the pop-up menu. 

Full Scr Click this button to expand the selected image to fill the entire screen temporarily. This is useful for checking the 
fine details of an image. To return to the One-Click Capture dialog box, click the image or press any key.  
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Prefs Click this button to set One-Click Capture preferences. 

Layout 
Preview 

Shows a preview of the layout that will be created when these images are captured. 
The layout preview includes yellow (unlocked) or gray (locked) guidelines. Yellow (unlocked) guidelines start at 
the top and left. You can click and drag these guidelines over the pictures in the layout and use them to line up 
the pictures (see below). 

Save Click this button to crop the images in this sequence as they are displayed in the dialog box and save them. 
When you click Save, if you have maximized the dialog box or moved the alignment guidelines, these settings 
are also saved. 

Sequence & 
Files 

Lists the image names, file names, and thumbnails for all images in this sequence. If the folder and file names 
are too long to fit in the Files column, ellipses are used to make the file names fit. You can drag the column 
divider between Sequence and File to change the space allocation between these columns. 

Unused 
Pictures 

This group box allows you to access patient pictures not currently loaded into the image layout. 
Browse...: Click this button to capture image files from another folder. 
Reload with these images: Click this button to load different pictures into the image layout. 
Show Thumbnails: Check this box to view thumbnails of all the images on your memory card or folder in the 
One-Click Capture Setup dialog box. Thumbnails are useful for identifying the image files you want to use. 
However, if you have many image files on the memory card or the image files are very high resolution, displaying 
the thumbnails may take some time. 
Unused Pictures List: Lists file names for any image files in the current image folder that are not used in the 
image layout. If you checked the Show Thumbnails check box, this list also displays thumbnails of the unused 
pictures. 

To capture images from a Twain device (scanner or digital camera) using the One-Click feature: 

1. Select an existing timepoint from the Timepoint list box. 

Or,  

Click New... in the Timepoint group box to create a new timepoint. In the resulting dialog box, enter a descriptive name 
for this timepoint and click OK. 

2. Select the Sequence tab in the Capturing group box. Then, select the capture sequence you want to capture from the 
list of capture sequences. 

3. Select Scanner, TWAIN Driver as the source from which to capture the images in the Input group box. 

4. Make sure the One-Click radio button is selected. Then, click Start Capture. 

The following figures show examples of the One-Click capture working with different TWAIN drivers (specifically, the 
Minolta RD-175 digital camera and the Epson Expression Pro version 1.5). Functionality of TWAIN drivers varies. For 
information for your specific TWAIN driver, please contact Dolphin. 

The procedure that you use to save the image depends on your TWAIN driver. For example, the Minolta TWAIN 
capture displays all the pictures taken by the digital camera. You can then select some or all the images displayed, and 
click Acquire.  
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After you have acquired the full sequence of TWAIN images, the One-Click Capture Setup dialog box displays all the 
images in the sequence. You can resize this dialog box by clicking and dragging the edges, or you can click the 
maximize icon in the upper-right corner to fill the screen with the window. 

5. Make any adjustments to the images, and save them. 

If you have resized the One-Click Capture Setup dialog box, the Dolphin Imaging program remembers these settings 
when you save the images. 

 



Dolphin Imaging User's Guide April 2011 

158 DI_USER_GUIDE-11.5   Rev. 1.01 

 

To capture images from a DICOM Server/PACS using the One-Click feature: 

1. Select an existing timepoint from the Timepoint list box. 

Or,  

Click New... in the Timepoint group box to create a new timepoint. In the resulting dialog box, enter a descriptive name 
for this timepoint and click OK. 

2. Select the Sequence tab in the Capturing group box. Then, select the capture sequence you want to capture from the 
list of capture sequences. 

3. Select DICOM Server/PACS as the source from which to capture the images in the Input group box. 

4. Make sure the One-Click radio button is selected. Then, click Start Capture. 

If the patient exists on the DICOM server, a window opens that shows a tree structure of images available on the 
server for that patient. 

5. Navigate in the tree structure to the image you want to capture. 

Double-click items in the tree structure to open that branch of the tree and view subordinate items. 

6. Select the image you want to capture and click Keep. 

A thumbnail of the image you selected appears in the lower part of the window with a number. 

7. Repeat steps 5 and 6 for each image that you want to capture from the DICOM server. 
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You can drag and drop the image thumbnails to re-order the images so that they match the order for the image layout 
that you are capturing. If you accidentally select the wrong image, select it and click Remove to remove it from the 
lower part of the screen. 

8. Click Done to capture the images. 

The One-Click Capture Setup dialog box displays all the images in the sequence. By default, the dialog box is 
maximized. However, you can click the Restore Down window icon in the upper-right corner (next to the X icon that 
closes the dialog box) to make the dialog box smaller. Then, you can resize this dialog box by clicking and dragging 
the edges. 

9. Make any adjustments to the images, and click Save. 

When you click Save, a progress dialog box appears to show the progress of the operation. 

If you click Save, the images are cropped and saved as they appear in the One-Click Capture dialog box, unless you 
have selected the Crop Later option in the mode group box. If you selected Crop Later, the images are simply saved--
they are not cropped. You can return to the One-Click Capture dialog box at any time to crop the images. To do this, 
follow the One-Click steps listed above. In step 4, you will be in the One-Click Capture dialog box showing your 
previously captured images. From there, you can crop, replace, enhance, and/or rotate these previously captured 
images. 

When you click Save, the Dolphin Imaging program remembers whether the One-Click Capture Setup dialog box is 
maximized. In addition, if you moved the alignment guidelines, the Dolphin Imaging program remembers their location 
for this capture sequence. 

To capture a video file: 

1. Select an existing timepoint from the Timepoint list box. 

Or,  

Click New... in the Timepoint group box to create a new timepoint. In the resulting dialog box, enter a descriptive name 
for this timepoint and click OK. 

2. Select the Sequence tab in the Capturing group box. Then, select the capture sequence into which you want to capture 
the video file. 

3. Select Digital Video as the source from which to capture in the Input group box. 

4. Make sure the One-Click radio button is selected. Then, click Start Capture. 

5. Click Browse.... 

A dialog box opens where you can select a different folder from which to capture image files. 

6. Select the folder containing the video file, and click OK. 

The Unused Pictures list box shows thumbnails and file names for the image files in this folder. 

When you click OK, a dialog box appears asking whether you would like Dolphin to use the selected folder as its 
default image folder from now on.  

7. Click Yes to use this folder as the Dolphin image folder. Otherwise, click No. 

8. Click and drag the video file from the Unused Pictures list to the image layout. 

The image layout shows the first frame of the video file as an image placeholder for the video in the layout. 

For information on playing a video file, see "To play a video file" on page 38. 
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To capture image files in another folder: 

1. On the One-Click Capture Setup dialog box, click Browse.... 

A dialog box opens where you can select a different folder from which to capture image files. 

2. Select another folder, and click OK. 

A dialog box appears asking whether you would like Dolphin to use the selected folder as its default image folder from 
now on.  

3. Click Yes to use this folder as the Dolphin image folder. Otherwise, click No. 

The Unused Pictures list box shows file names for the image files in this folder. You can check the Show Thumbnail 
box to preview the images in this folder. 

4. If the images are in the correct order for the capture sequence, select the first picture in the sequence from the Unused 
Pictures list box. Then, click Reload With These Images to load the selected image files into the image layout. 

Or, 

If the images are not in the correct order for the capture sequence, click and drag each picture to the correct slot in the 
image layout. 

Or,  

If the images are not in the correct order for the capture sequence, select the first picture from the sequence from the 
Unused Pictures list box, and click Reload With These Images. Once the pictures are in the image layout, use the 
swap feature to move them into the correct image slots in the layout. 

For more information on swapping pictures in an image layout, see "To swap pictures" on page 172. 

To drag and drop pictures from the Windows Explorer into the One-Click Capture Setup dialog box: 

1. In the Microsoft Windows Explorer, click the picture you want to drag and drop into the One-Click Capture Setup dialog 
box. 

2. Hold the left mouse button down, and drag the picture to an image slot in the image layout. 

3. Release the mouse button when the pointer is over the image that you want to replace with the picture from the 
Windows Explorer. 

The following figure illustrates this operation. 
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To drag and drop pictures from Microsoft Outlook to One-Click capture: 
1. Start Microsoft Outlook and open the email message containing the pictures.  

2. Arrange the One-Click Capture Setup dialog box and the email message window so that both are visible on your 
Microsoft Windows desktop. 

3. On the email message window, select one or more pictures that you want to drag and drop. 

4. Hold down the mouse button and drag the pictures to an image slot on the One-Click Capture Setup dialog box. 
Release the mouse button. 

The pictures appear in the One-Click Capture Setup dialog box, as shown below. 

Note: If an image contains tracings (such as a digitized X-ray image or a tracing superimposed over the patient’s 
profile photograph), both the image and the tracing appear. 
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Correcting Pictures 
The following procedures describe how to: 

• Align pictures in the image layout 

• Resize or crop pictures 

• Maximize pictures 

• Enhance pictures 

• Reduce "red eye" 

To use the alignment guidelines: 

1. On the One-Click Capture Setup dialog box, select Size & Crop from the Mode group box. 

Or, 

Right-click a picture, and select Size & Crop from the pop-up menu. 

2. Select one of the alignment guidelines (either the horizontal or vertical line) and drag it over the image layout. 

For example, if you are working with the facial intra-oral occlusal pictures, you may want to drag one of the horizontal 
lines and place it at the patient’s eyebrows on the facial pictures to align them in the image layout. You may want to 
drag another horizontal line over the bottom row of pictures to line up the point where the patient’s teeth meet. 
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Similarly, you may want to place the vertical lines over the columns of pictures on the right and left to center the 
pictures below each other. 

3. Click Prefs to open the One-Click Preferences dialog box. 

The One-Click Preferences dialog box opens. 

4. Check the Lock Guidelines check box. Then, click OK. 

Locking the guidelines prevents you from accidentally moving them when you move the pictures in the image layout. 

5. If any pictures are out of alignment in the layout, click and drag them to line them up with the alignment guidelines. 

To resize or crop one of the pictures: 

1. On the One-Click Capture Setup dialog box, select Size & Crop from the Mode group box. Then, select the image you 
want to resize or crop. 

Or, 

Right-click a picture, and select Size & Crop from the pop-up menu. 

A cropping rectangle appears around that image with eight sizing handles and four rotation handles around the edges 
as shown below. For information on using the rotation handles, see "To rotate a picture using the rotation handles" on 
page 170. 

2. Click and drag the sizing handles to resize the cropping rectangle. 

If either the Info on Layout or Info as Tooltips check boxes are checked on the One-Click Preferences dialog box (see 
"To set One-Click Capture preferences" on page 174), a zoom percentage indicates the expansion or shrinkage of the 
image as compared to the original, "fit-to-frame" size (100%). 

Note: To crop models, frame each model so that its base just fits into the crop box frame. On tall models, you may 
have open space on the sides of the image. 

To crop x-rays, crop squarely around the x-ray image.  
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To maximize a picture so that it takes up the entire screen: 

1. On the One-Click Capture Setup dialog box, select the image you want to maximize. Then, click Full Scr. 

Or, 

Right-click the picture you want to maximize, and select Full Scr from the pop-up menu. 

2. To return to the One-Click Capture dialog box, click the maximized picture. 

Or, 

Press any key on the keyboard. 

To enhance a picture: 

1. On the One-Click Capture dialog box, select the picture you want to enhance. Then, click Enhance. 

Or, 

Right-click the picture you want to enhance, and select Enhance from the pop-up menu. 

Or, 

On the Cropping dialog box, click Enhance. 

Or, 
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On the Digitize palette, click . 

Or,  

On the Treatment Simulation tool bar (see "Using the Treatment Simulation tool bar" Error! Bookmark not defined.) 

click . 

Or, 

On a view workstation, right-click an image on the Dolphin Main Screen. Then, select Image Enhance (View Only) from 
the pop-up menu. 

Or, 

On a view workstation, select an image on the Dolphin Main Screen. Then, select Image Enhance (View Only) from the 
View menu. 

The Enhance Image dialog box opens, as shown below. 

2. Select the Enhancement tab if it isn’t already selected. 

You can also use the Redeye Reduction tab to correct red eyes in the picture. For details on using the Redeye 
Reduction tab, see "To reduce red eye" on page 168. 

3. If you want to enhance only part of the image, draw a boundary around that area of the image and make sure that the 
Enhance Within Boundary check box is selected. 

To draw a boundary: 

Click and release the left mouse button on a point where you want to begin drawing the boundary 

Move the mouse to begin drawing the boundary. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position. 

Click the mouse button whenever you want to place a point and change the direction of the line. 

If you make a mistake, click the right mouse button to undo the line to the last point you placed. 

To complete the boundary, click the left mouse button again on the first point to close the boundary. 

Alternatively, you can hold down the left mouse button and drag the mouse to draw the boundary without placing 
points. Using this method, you may be able create a smoother boundary. However, you may find it more difficult to 
draw the boundary. In addition, undoing is more cumbersome, since this method effectively creates many points and 
lines in the boundary. 

4. Use the sliders, check boxes, and other controls to set enhancement options. 

Check the Fast Preview box to open a small preview window while you are moving the sliders that shows a preview of 
the enhancement. When you finish moving the slider, the preview window closes, and the image in the Enhance Image 
dialog box changes to reflect the options you chose.  

If you are not using the Fast Preview option, the image in the Enhance Image dialog box changes as you move the 
sliders.  

When you are happy with the way the image appears, click OK to save the enhanced image. 
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Image Shows the image you are currently enhancing. 

Apply Display 
Smoothing 

Check this box to smooth out the image for display on a computer monitor. 

Fast Preview Check this box to open a small preview window when changing enhancement options. When 
enhancing an image, the changes are displayed more quickly in a preview window. 

Brightness Move the slider to adjust the brightness of the image. 

Contrast Move the slider to adjust the light/dark contrast of the image. 
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Gamma Move the slider to adjust the light/dark contrast of the image. 

Hue Move the slider to adjust the hue of the image.  

Saturation Move the slider to adjust the color saturation of the image.  

Blur/Sharpen Move the slider to adjust the blurriness/sharpness of the image. 

Emboss Move the slider and select the direction of the light to create an embossed effect. 

Invert Check this box to invert the image colors (change a negative to a positive or vice-versa). 

Equalize Check this box to equalize the image colors. 

Undo All Click this button undo all the enhancement settings. 

Freeze  Click this button to keep all the enhancements that you have made so far when adding another 
enhancement. 

Auto-Preview Check this box to preview the enhancements automatically as you make changes. 

For the Emboss enhancement option, you can pick the direction of the light source used for the embossing effect as shown 
below. 
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To red/ce "red eye": 

1. On the Enhance Image dialog box, select the Red Eye tab. 

2. Check the Do Redeye Reduction check box. 

Two circles appear on the patient’s image as shown below. 

3. Optionally, click AutoZoom to zoom in on the patient’s image. 

4. Click and drag the center of the two circles to the patient’s eyes. 

When clicking and dragging the center of a circle, the cursor changes to a hand icon. 

5. Click and drag the edges of the circles to resize them to the size of the red dots in the patient’s eyes. 

When clicking and dragging the edge of a circle, the cursor changes to a double-headed arrow. 

6. Adjust the Threshold and Darkness sliders to achieve the best appearance. 
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Do Redeye 
Reduction 

Check this box to reduce the appearance "red eye" in the photograph. The sliders set the levels for 
"red eye" reduction. 

AutoZoom  Click this button to zoom in on the patient’s image. 

Threshold Move this slider to adjust the amount of area within the reduction circle to darken.  

Darkness Move this slider to adjust darkness applied the image. 
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Flipping and Rotating Pictures 

To flip a picture horizontally to its mirror image (right to left): 
1. On the One-Click Capture Setup dialog box, select the image you want to flip. Then, click Mirror. 

Or, 

Right-click the picture you want to flip, and select Mirror from the pop-up menu. 

Or, 

On the Cropping dialog box, click Mirror. 

To flip a picture vertically (top to bottom): 

1. On the One-Click Capture Setup dialog box, select the image you want to flip. Then, click Flip. 

Or, 

Right-click the picture you want to flip, and select Flip from the pop-up menu. 

Or, 

On the Cropping dialog box, click Flip. 

To rotate an image 90 degrees using Quick Rotate: 

1. On the One-Click Capture Setup dialog box, right-click the picture you want to rotate. 

2. Select one of the Quick Rotate options from the pop-up menu. 

You can quickly rotate the image 90 degrees clockwise or counter-clockwise. 

To rotate a picture using the rotation handles: 

1. On the One-Click Capture Setup dialog box, select the image you want to rotate. 

A cropping rectangle appears around that image with eight sizing handles and four rotation handles around the edges 
as shown below. For information on using the sizing handles, see "To resize or crop one of the pictures" on page 163. 

2. Click and drag one of the rotation handles to rotate the picture. 

The color that fills the empty corners resulting from rotating the image is set in the Rotate Image dialog box. 

Note: For best results, keep the mouse down, rotate the image back and forth until you see the desired result, then 
release the mouse button. If you rotate the image using several, separate rotation operations, the image quality can 
degrade, especially on lower resolution images. 
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To rotate a picture a specific number of degrees using the Rotate Image dialog box: 

1. On the One-Click Capture Setup dialog box or Cropping dialog box (see "To crop and capture the image" on page 
180), select the image you want to rotate. Then, click Rotate. 

The Rotate Image dialog box is displayed. 

Note: On the One-Click Capture dialog box, you can also rotate pictures using the rotation handles as described 
above. 

2. Pick a rotation amount and click OK. 

Or, 

Click the Let Me Specify radio button, and enter the number of degrees that you want to rotate the image. 

3. Select the color with which you want to fill the empty corners resulting from rotating the image from the Fill Color group 
box. 

The One-Click Capture Setup dialog box or the Cropping dialog box is displayed with the image rotated. 
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Number of degrees 
radio buttons 

Pick one of these radio buttons to rotate the image the indicated number of degrees. These buttons 
are useful for images that are just slightly slanted or were photographed side-ways. 

Let me specify. 
Rotate: 

Pick this radio button and enter a number of degrees to rotate the image. 

Fill Color Select the color with which you want to fill the empty corners resulting from rotating the image. 

Adding, Removing, and Reordering Images 
The following procedures describe how to: 

• Swap pictures in an image layout 

• Load a different set of pictures into One-Click capture 

• Copy and paste pictures into One-Click capture 

• Remove pictures from the capture sequence 

To swap pictures: 

1. Select one of the pictures you want to swap. 

You can select a picture to swap from the image layout preview, from the Sequence and Files list, or from the Unused 
Pictures list. In addition, you can drag and drop a picture into the picture layout from any Microsoft Windows program 
that supports drag-and-drop. 

2. Drag that picture on top of the picture with which you want to swap it. 

You can drag a picture to the image layout preview, the Sequence and Files list, or the Unused Pictures list.  
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To load another set of pictures into the image layout: 

1. Select the image in the Sequence and Files list from which you want to reload this capture sequence. 

For example, if only the last three images in the sequence are incorrect, select the third image from the end of the 
sequence. 

2. Select a picture in the Unused Pictures list box. 

Or, 

Use the Browse... button to select a picture.  

3. If the images are in the correct order for the capture sequence, select the first picture in the sequence from the Unused 
Pictures list box. Then, click Reload With These Images to load the selected image files into the image layout. 

Or, 

If the images are not in the correct order for the capture sequence, click and drag each picture to the correct slot in the 
image layout. 

Or,  

If the images are not in the correct order for the capture sequence, select the first picture from the sequence from the 
Unused Pictures list box, and click Reload With These Images. Once the pictures are in the image layout, use the 
swap feature to move them into the correct image slots in the layout. 

For more information on swapping pictures in an image layout, see "To swap pictures" on page 172. 

To copy and paste images into the image layout: 

1. Copy a patient image to the clipboard. 

For example, you can open an image from the Dolphin Imaging main screen or the Microsoft Windows Explorer, right-
click it, and select Copy from the pop-up menu to copy the image to the clipboard. 

2. Open the One-Click Capture window. 

3. Right-click the slot in the image layout to which you want to copy this image. Then, select Paste from the pop-up menu. 

Or, 

Click the slot in the image layout to which you want to copy this image. Then, press CTRL+V or SHIFT+INS on your 
keyboard to paste the image. 

To remove a picture from the sequence: 

1. Drag and drop the picture you want to remove from the image layout or the Sequence and Files list to the blank area at 
the bottom of the Unused Pictures list. 

Or, 

Right-click the picture you want to remove from the image layout, and select Clear from the pop-up menu. 
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Setting One-Click Capture Preferences 

To set One-Click Capture preferences: 

1. Click Prefs. 

The One-Click Preferences dialog box appears. 

2. Check the boxes for any options you want. Then, click OK. 

 

Display Page 
Setup Bkgd 
Color 

Check this box to use the printer background color on the One-Click Capture dialog box. This enables you 
to see how the image layout will appear when printed. 

Image Info on 
Layout 

Check this box to display image information on each image in layout preview. The information displayed is 
the image type, image scale percentage (percentage zoomed in or out), and the image file path. 

Image Info as 
Tooltip 

Check this box to display image information as tool tips for each image in layout preview. The information 
displayed is the image type, image scale percentage (percentage zoomed in or out), and the image file 
path. To view the information, place your mouse over one of the images in the layout preview. 

Lock Guidelines Check this box to lock the alignment guidelines at their current location. Locked guidelines are gray. 
Unlocked guidelines are yellow. Locking guidelines prevents you from accidentally moving a guideline when 
you are trying to move an image. 

Save Original 
Images 

Select one of the following radio buttons: 
No: Select this option to save only the images with the modifications that you make in the One-Click 
Capture Setup dialog box. 
Compressed: Select this option to save two versions of the images: a version with the modifications that 
you make in the One-Click Capture Setup dialog box and a compressed version of the images as they were 
originally taken by the digital camera. This is the recommended option if you want to save the original, 
unmodified images. 
As Is: Select this option to save two versions of the images: a version with the modifications that you make 
in the One-Click Capture Setup dialog box and an uncompressed version of the images as they were 
originally taken by the digital camera. This option can consume large amounts of disk space. 
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Reverting to the Original Images 

To revert to the original images as they were taken by the digital camera: 
1. Set the Save Original Images option on the 1-Click Preferences dialog box to either Compressed or As Is (see above). 

2. Make any changes (such as cropping, rotating, or enhancing) to the images in the One-Click Capture Setup dialog box. 
Then, click Save to save the modified images and close the dialog box. 

3. Return to the One-Click Capture Setup dialog box by clicking Capture on the Dolphin main screen and One-Click 
Capture on the Capture Setup dialog box. 

The One-Click capture dialog box shows the images that you previously modified and saved. 

4. Right-click one of the images. Then, select Revert to Original from the pop-up menu. 

The modified image is replaced with the original, unmodified image on the One-Click Capture Setup dialog box. 

Using Sequential Capture 
Using Sequential Capture, you can individually download, crop, enhance, and capture the images in a sequence.  
Note: In most cases, you will probably find One-Click capture more convenient than sequential capture. 

To capture images from image files on a memory card using Sequential Capture: 

1. Select an existing timepoint from the Timepoint list box. 

Or,  

Click New... in the Timepoint group box to create a new timepoint. In the resulting dialog box, enter a descriptive name 
for this timepoint and click OK. 

2. Select the sequence of pictures you want to capture from the Sequence tab in the Capturing group box. 

3. Select Image File, Memory Card as the source from which to capture these images in the Input group box. 

4. Select the Sequential radio button to select Sequential Capture. 

5. Click Start Capture to begin capturing the pictures. 

The dialog box shown below prompts you for the image file you want to capture. 

6. Select the first image in the capture sequence, and click OK. 

The picture you selected is displayed in the Cropping dialog box. 
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File name Enter a file name in this text box to choose that file. By default, this text box contains wildcards that limit the files 
listed in the file list to image files. 

File list Click a file from this list box to select that file. 
If your computer currently has a memory card, the image files that the memory card contains are listed. Otherwise, 
the image files in your Dolphin capture folder (which is specified in your DOLPHIN.INI file) are listed. For more 
information on the DOLPHIN.INI file, see Appendix B. 
If you took the pictures in the proper order for the capture sequence, the image files will be listed in that order in the 
File Name list box. 

List files 
of type 

Specifies the types of files to list in the file list. Choosing a file type limits the file list to that type of file and enters a 
wildcard that specifies that file type in the File name text box. 

Folders Choose the folder you want in this list box, which lists the folders on the selected drive. The currently-selected 
folder appears above the list box. 

Drives Choose a disk drive from this drop-down list box. 

Network... Click this button to access other disk drives on your computer network. 
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To capture images from a Twain device (typically a scanner) using Sequential Capture: 

1. Place the X-ray and the Dolphin calibration ruler on the scanner.  

The Dolphin calibration ruler is used to simplify image calibration for tracing purposes. If you do not have a Dolphin 
calibration ruler, you can contact Dolphin to obtain one. Alternatively, you can place a semi-transparent object with a 
known fixed length, such as a small piece of paper, on the scanner when you scan the X-ray image. 

Place the X-ray face down on the scanner. Place the top of the skull to the right side of the scanner. The X-ray image 
should face the Dolphin calibration ruler, and the ruler should be on top of the X-ray film. 

2. Select an existing timepoint from the Timepoint list box. 

Or,  

Click New... in the Timepoint group box to create a new timepoint. In the resulting dialog box, enter a descriptive name 
for this timepoint and click OK. 

3. From the Sequence tab in the Capturing group box, select the Ceph (Scan) or Pano (Scan) capture sequence, which 
are capture sequences containing only one picture. 

4. Select Scanner, TWAIN driver as the source from which to capture the image in the Input group box. 

5. Select the scanner you are using from the drop-down list box in the Input group box. 

6. Select the Sequential radio button to select Sequential Capture. 

7. Click Start Capture to begin capturing the pictures. 

At this point, the scanner driver takes over the capture process. If this is the first image you are scanning and you are 
using an older scanner model, the scanner lamp may take about 30 seconds to warm up to achieve the correct color 
temperature. The scanner performs a preview scan of the image. Then, a dialog box similar to the figure below 
displays a preview of the scan. 

Note:  The appearance of the dialog box you see depends on the scanner you are using.  The figure below shows the 
appearance of this dialog box for Hewlett-Packard Deskscan 4, 5, and 6000 series scanners. Refer to the Dolphin 
Imaging web site (www.dolphinimaging.com) for recommended scanners. Refer to your scanner documentation for 
information about setting your scanner up. 

8. Examine the preview image to make sure that the image rectangle encompasses the part of the image you want to 
capture and the Dolphin calibration ruler. If necessary, change the image rectangle size or location using your scanner 
driver program.  

9. Make any modifications to the settings for the scanner driver program for the final scan. 

For more information on the options available, refer to your scanner and scanner driver documentation. 

10. Click Final to perform the final scan. 

At this point, the scanner driver program delivers the scanned image to the Cropping dialog box. Depending on your 
scanner driver and its settings, you may need to rotate the scanned image 90 degrees. 
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Twain driver 
palette 

Set scanning options using this palette. For information on the options available, refer to your scanner 
documentation. 

Preview image Indicates how the final scanned image will look. 

Selection 
rectangle 

Indicates the boundaries of the scanned image. 
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To crop an image captured using Sequential Capture. 
When you select an image to capture, that image is displayed in the cropping dialog box, as shown below. 

 

Video This button is only available for systems equipped with video capturing devices. Using this option, you can 
adjust the video image using the AVI or Video for Windows interface driver. For more information, contact 
Dolphin. 

Enhance Click this button to enhance the image. For more information, see "To enhance a picture" on page 164. 

Skip Click this button to skip the current image and proceed to the next image file. For more information, see "To 
pick another picture" on page 181. 

Rotate Click this button to access the Image Rotation dialog box, where you can specify how much to rotate the 
image. For more information, see "To rotate a picture a specific number of degrees using the Rotate Image 
dialog box" on page 171. 

Flip Click this button to flip the image vertically (up to down). For more information, see "To flip a picture 
vertically" on page 170. 

Mirror Click this button to flip the image to its mirror image (left to right). For more information, see "To flip a picture 
horizontally" on page 170. 
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Reload Click this button to return to the Choose an Image File dialog box so you can pick another image file. For 
more information, see "To pick another picture" on page 181. 
Note: if you are using video capture, this button is labeled Freeze. 

Capture Click this button to capture the current image, as cropped, into Dolphin Imaging. For more information, see 
below. 

Capturing 
image name 

Indicates which image in the sequence you are currently capturing. 

Scale Indicates the scaling percentage at which the image is being displayed. 

File loaded file 
name 

Indicates the name of the image file on which you are currently working. 

To crop and capture the image: 

1. If you are capturing an X-ray, rotate the image so that it is right side up and faces right. 

For more information on rotating the image, see "To rotate a picture using the rotation handles" on page 170.  

2. Click and drag the boxes to resize the cropping rectangle. 

Or, 

Press SHIFT+UpArrow to make the cropping rectangle bigger or SHIFT+DownArrow to make the cropping rectangle 
smaller. 

Or, 

Press CTRL+UPARROW or CTRL+DOWNARROW to resize the rectangle faster. 

Or,  

Press ALT, then click and drag to resize the rectangle without maintaining its proportions (to make the rectangle larger 
in only one direction). 

If you are capturing an X-ray, make sure that the cropping rectangle encompasses the entire X-ray and the Dolphin 
calibration ruler. 

3. Check that the correct image name is displayed at the top left of the image capture area under the tool bar. 

4. Click Capture. 

If you are capturing a capture sequence from a memory card, the Choose an Image File dialog box is displayed so you 
can capture the next image in the sequence. 

If you took your pictures in the correct sequence and cropped them properly when you took them, you can simply keep 
pressing the RETURN key to capture the entire sequence. 

When you finish capturing all the pictures in the sequence, the main screen displays the images you captured. 



5 Image Capture Part III: ImagingPlus 

DI_USER_GUIDE-11.5   Rev. 1.01 181 

To pick another picture: 

1. Click Reload. 

Or, 

Click Skip. 

The Choose an Image File dialog box is displayed so you can select another image file. If you clicked Skip, a message 
appears asking you to confirm that you want to skip the current image. Then, the Choose an Image File dialog box is 
displayed with the file for the next image in the sequence automatically selected. 

Capturing Study Model Images 
Typically, you use Sequential Capture to capture a study model image that contains both arches in a single picture. To make 
digitizing the image easier, you can include the Dolphin calibration ruler or another ruler in the picture. 

To capture a study model image: 

1. On the Capture Setup dialog box, select an existing timepoint from the Timepoint list box. 

Or,  

Click New... in the Timepoint group box to create a new timepoint. In the resulting dialog box, enter a descriptive name 
for this timepoint, and click OK. 

2. In the Capturing group box, select the Image tab. 

3. In the list box, select Undigitized Arch to capture a study model image. 

4. In the Input group box, select Image File, Memory Card as the source from which to capture the image. 

The Sequential radio button is selected automatically. 

5. Click Start Capture. 

The dialog box prompts you for the image file you want to capture. 

6. Select the file containing the study model image, and click OK. 

The study model image is displayed in the Cropping dialog box. 

7. Click and drag the boxes to resize the cropping rectangle. 

Or, 

Press SHIFT+UpArrow to make the cropping rectangle bigger or SHIFT+DownArrow to make the cropping rectangle 
smaller. 

Or, 

Press CTRL+UPARROW or CTRL+DOWNARROW to resize the rectangle faster. 

Or,  

Press ALT, then click and drag to resize the rectangle without maintaining its proportions (to make the rectangle larger 
in only one direction). 

Make sure that the cropping rectangle encompasses the entire image and the Dolphin calibration or other ruler (if the 
picture includes a ruler). 
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8. Click Capture. 

 

Capturing from a DICOM Server 
You can use either One-Click or Sequential Capture to capture to capture images from a DICOM server.  
Note: Dolphin Imaging does not create new patient records based on the downloaded DICOM files. The patient must exist in 
Dolphin Imaging before you download and capture the images. During the capturing session, Dolphin Imaging extracts the 
images from the DICOM files and discards all other information.  

To begin capturing an image from the DICOM server: 

1. On the Capture Setup dialog box, select an existing timepoint from the Timepoint list box. 

Or,  

Click New... in the Timepoint group box to create a new timepoint. In the resulting dialog box, enter a descriptive name 
for this timepoint, and click OK. 

2. Select the Sequence tab in the Capturing group box. Then, select the capture sequence you want to capture from the 
list of capture sequences. 

3. In the Input group box, select DICOM Server/PACS as the source from which to capture the image. 

4. Select the One-Click radio button to use One-Click Capture. 

Or 

Select the Sequential radio button to use Sequential Capture. 
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If images for the current patient exist on the DICOM server, a window similar to the example below opens: 

 

To select the images you want to capture: 
1. Double-click the nested items in the tree structure on the left until you find the patient image you want to capture.  

2. Click the image you want to download that image, 

3. Click Keep on the menu bar. 

A thumbnail of the image appears in the lower part of the window along with a number. 

4. Repeat steps 1-3 until you have selected all the images you want to capture. 

5. If the image thumbnails are not in the correct order for the capture sequence, drag and drop the thumbnails to reorder 
them. 
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To capture the selected images: 

1. Click Done on the menu bar. 

The One-Click Capture Setup or Sequential Capture dialog box opens. In the One-Click Capture Setup dialog box, the 
downloaded images appear in the Unused Pictures list on the right. 

2. Capture the images using One-Click or Sequential Capture. 

For more information, see "To load another set of pictures into the image layout" on page 172 or  "Using Sequential 
Capture" on page 175. 

 

Editing Capture Sequences 
Using the Sequence Editor, you can change the images in a sequence, reorder the images in a sequence, and set other options 
for a capture sequence. 

To edit a capture sequence: 

1. In the Capturing group box of the Capture Setup dialog box, select the Sequence tab. 

2. Optionally, select the capture sequence you want to edit from the list box. 

From within the Sequence Editor, you can change the sequence you are editing or define a completely new capture 
sequence. 

3. Click Edit in the Capturing group box. 

The Sequence Editor dialog box displays information for the capture sequence, as shown below. 
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  Click this button to begin defining a new capture sequence. For more information, see "To begin defining 
a new capture sequence" on page 186. 

  Click this button to open and edit an existing capture sequence. For more information, see "To select an 
existing capture sequence to edit" on page 187. 

  Click this button to save the current capture sequence. For more information, see "To save the capture 
sequence" on page 189. 

Capture images 
from: 

Select the default device to use for capturing images for this sequence. This default can be changed on 
the Capture Setup dialog box. 

Use this image 
layout: 

Select the image layout to use for this capture sequence from this drop-down list box. 

Edit Layout Click this button to edit the selected image layout. For more information, see Chapter 7. 

(Available images) Lists the images that you can add to the capture sequence. 

Use All Click this button to use all the images listed in the Available Images list box in this capture sequence. 
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>> or << Click this button to move images between the Available Images and Capture These Images In This 
Order list boxes. 

Capture These 
Images In This 
Order 

Lists the images in the capture sequence in the order that they will be captured. 

Clear All Click this button to remove all the images from the capture sequence. 

Where to find the 
image 

Specify where the Dolphin Imaging program should look for this image.  
Capture the Next Image: Specifies that the Dolphin Imaging program should increment the file name for 
the previous image and look for this image under the new file name. 
Text Box: Specify a specific file name that the Dolphin Imaging program should use when looking for 
this image. 

Apply these 
operations 

Select options for enhancing the image selected in the Capture These Images In This Order list box 
during capturing. 
Brightness: Check this box and enter a value in the text box to adjust the brightness of the image. A 
positive value brightens the image, and a negative value darkens it. 
Contrast: Check this box and enter a value in the text box to adjust the difference between the lightest 
and darkest parts of the image. A positive value increases the contrast, and a negative value decreases 
it. 
Saturation: Check this box and enter a value in the text box to adjust the amount of color in the image. 
A positive value increases the saturation, and a negative value decreases it. 
Hue: Check this box and enter a value in the text box to adjust the hue of the image. 
Sharpen: Check this box and enter a value in the text box to adjust the sharpness of the image. A 
positive value sharpens the image, and a negative value blurs it. 
Equalize: Check this box to equalize the image colors. 
GrayScale: Check this box to change the image from color to gray scale. 
Mirror: Check this box to flip the image to its mirror image (left to right). 
UpsideDown: Check this box to flip the image vertically (up to down).  
Rotate: Check this box to rotate the image and specify the number of degrees in the text box. A positive 
value rotates the image to the right, and a negative value rotates it to the left. 
Scale: Check this box and enter the scaling percentage to use in the text box to scale the image.  
Gamma: Check this box and enter a value in the text box adjust the light/dark contrast of the image. A 
value of 100 is normal, a value between 0 and 100 increases the light/dark contrast of the image, and a 
value greater than 100 decreases the light/dark contrast of the image. 
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To begin defining a new capture sequence: 

1. Click   on the tool bar. 

Or, 

Select New from the File menu. 

All the images are removed from the Capture These Images In This Order list box. 

To select an existing capture sequence to edit: 

1. Click   on the tool bar. 

Or, 

Select Open... from the File menu. 

The Existing Capture Sequences dialog box appears so that you can select an existing capture sequence. 

2. Select the capture sequence you want to edit in the list box. Then, click Select. 

When you select a capture sequence in the list box, two additional buttons appear so that you can rename or delete 
the capture sequence. The following figure shows how this dialog box appears after a capture sequence is selected in 
the list box. 
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list box Lists the existing capture sequences. 

Select Click this button to edit the capture sequence selected in the list box. 

Rename Click this button to rename an existing capture sequence. This button appears only after a capture sequence is 
selected in the list box. 

Delete Click this button to delete an existing capture sequence. This button appears only after a capture sequence is 
selected in the list box. 

To rename an existing capture sequence: 

1. Click   on the tool bar. 

Or, 

Select Open... from the File menu. 

The Existing Capture Sequences dialog box appears. 

2. Select the capture sequence you want to rename in the list box. Then, click Rename. 

The Change Sequence Name dialog box appears. 

3. Enter a new name for this capture sequence in the New Name text box. Then, click Change. 

 

Current Name Indicates the current name of this capture sequence. 

New Name Type a new name for this capture sequence in this text box. 

Change Click this button to change the capture sequence name. 
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To delete an existing capture sequence: 

1. Click   on the tool bar. 

Or, 

Select Open... from the File menu. 

The Existing Capture Sequences dialog box appears. 

2. Select the capture sequence you want to delete. Then, click Delete. 

To specify the capture device and image layout for the capture sequence: 
1. In the Capture Images From group box, select the default device to use when capturing images for this capture 

sequence. 

2. Select the image layout to use for this capture sequence from the Use This Image Layout drop-down list box. 

To add one or more images to the capture sequence: 

1. Click one or more images in the Available Images list box. Then, click the button labeled ">>". 

Or,  

Click Use All to add all the available images to the capture sequence. 

The image or images you selected move to the Capture These Images In This Order list box. 

To remove one or more images from the capture sequence: 

1. Click one or more images in the Capture These Images In This Order list box. Then, click the button labeled "<<". 

Or, 

Click Clear All to remove all images from the capture sequence. 

To change the order in which images are captured: 

1. In the Capture These Images in This Order list box, click an image and drag it to a new location in the list. 

To set options for each of the images in the sequence: 
1. Select each image in the sequence from the Capture These Images In This Order list box. 

2. Set the location where Dolphin should look for that image in the Where to Find The Image group box. 

3. Specify any operations to apply to the image in the Apply These Operations group box. 
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To save the capture sequence: 

1. Click  on the tool bar. 

Or,  

Select Save from the File menu. 

Or, 

Select Save As... from the File menu to save this capture sequence under a new name. 

If this is a new capture sequence or you selected Save As..., the Existing Capture Sequences dialog box appears. 

2. Enter a name for this capture sequence. 

Or, 

Select an existing capture sequence from the list box to save this sequence using that name. 

Note: If you select an existing sequence name from the list box, your new options will overwrite any options previously 
defined for that capture sequence. 

3. Click Save. Then, click OK on the confirmation dialog box that appears indicating that the capture sequence was 
saved. 
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list box Select an existing capture sequence name to overwrite that sequence. 

Save As Enter a new name for this capture sequence 

Save Click this button to save the capture sequence. 

To change view options for the Sequence Editor dialog box: 

1. Select Toolbar from the View menu to toggle whether the tool bar appears. 

All tool bar options are available from the menus. 

2. Select Status Bar from the View menu to toggle whether the status bar appears at the bottom of the dialog box. 

Printing a Capture Sequence 

To print the capture sequence: 

1. Select Print from the File menu.  

The Print dialog box is displayed. 

2. Select any printing options you want, and click OK. 
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Printer Indicates the printer to which the print job will be sent.  
Note: Dolphin does not retain printer settings when you exit the program. To retain printer settings, set them 
using the Microsoft Windows Printers Control Panel. 

Properties Click this button to set advanced properties for the selected printer. 

Print 
Range 

Select what you want to print. Your options are: 
All: Print an entire document. From the main screen, you would typically use this option. 
Pages: Print only pages in the specified range. 
Selection: Print just what you have selected. 

Copies Enter the number of copies you want to print. 

To preview your print job: 

1. Select Print Preview from the File menu.  

A preview of the print job appears.  

2. Click Print to print the print job. 

Or, 

Click Close to close this dialog box. 
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Print Click this button to print the print job. 

Next 
Page 

Click this button to view the next page of the print job. This button is available only if the print job is more than 
one page long. 

Prev 
Page 

Click this button to view the previous page of the print job. This button is available only if the print job is more 
than one page long. 

Two 
Page 

Click this button to view two pages of the print job side-by-side. This button is available only if the print job is 
more than one page long. 

Zoom In Click this button for a closer view of the print job. 

Zoom 
Out  

Click this button zoom back out after zooming in. 

Close Click this button to close the preview dialog box. 

To exit from the Sequence Editor: 

1. Select Exit from the File menu. 
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6 Presenting and Sharing Patient Images 
This chapter describes the Dolphin Imaging features that you can use to present patient images as an online slide show, share 
patient images via email or over the Internet, drag-and-drop images into other applications (such as Microsoft Word and 
PowerPoint), use Dolphin Image Controls and layout objects to use Dolphin images in other applications (such as Microsoft 
Word and PowerPoint), and print images. 

Setting Up a Slide Show Presentation 
You can easily set up a slide show of patient pictures for presentation purposes. You can select any combination of patient 
pictures, from any timepoints, to show the patient’s progress over time. 

To use the slide show presentation feature: 

1. Click   on the Dolphin Imaging main screen’s horizontal tool bar. 

Or, 

Select Presentation from the Tools menu. 

The Slide Show Presentation Setup dialog box is displayed, as shown below. Using this dialog box, you can set up a 
new slide show or load an existing slide show you have already set up and saved. 
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list box Select the source for the image that you want to use in this slide show using this list box. You can 
add images from the timepoints for this patient or from the image library. 

Images Available Lists the images from the selected image source (either the timepoints in the patient's record or 
the image library). Select an image from this list box to add it to the slide show. 

Zoom Check this check box to open a window that shows a close up view of the last image selected in 
the Images Available list box. 

Select All Click this button to add all the images in the Images Available list box to the slide show. 

>> or << Click this button to move images between the Images Available and Current Slide list boxes. 

Same Number of 
Images Per Slide 

Check this box to use the selected number of images for each slide in the slide show. Use the 
associated drop-down list box to specify the number of images to use for each slide. This box is 
checked by default.  
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Current Slide Lists slides in the slide show.  

• If the Same Number of Images Per Slide box is checked, this list box lists all the images 
in the slide show. 

• If the Same Number of Images Per Slide box is not checked, this list box lists only the 
images for the current slide. In this case, the following additional controls appear that you 
use to add images to individual slides: 

Use the slider to select a particular slide in the slide show. 

Click  to insert a new, blank slide before the current slide in the slide show. 

Click  to insert a new, blank slide at the end of the slide show. 

Clear All Click this button to move all the images from the Current Slide list box to the Images Available list 
box. 

Show! Click this button to play the current slide show. 

Close Click this button to close this dialog box. 

Saved Sequences Select a previously-saved slide show from this drop-down list box to play or change that slide 
show. 

Transition Select the type of transition you want to use between slides in the show from this drop-down list 
box. 

Save Click this button to save the current slide show. 

Delete Click this button to delete the current slide show. 

Automatically 
Advance Slide 

Check this box and select a number of seconds to automatically advance the slide when playing a 
slide show. If you do not check this box, you can manually control the slide advance by clicking the 
slide when you are ready to transition to the next slide. 

Loop Continuous 
Until "ESC" 

Check this box to specify that the slide show should loop until you press ESC. Otherwise, the slide 
show stops playing when it reaches the last slide. 

Display Title Check this box to display the image titles during the slide show.  

Font... Click this button to set the font for the image titles. 
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Creating or Opening a Slide Show 

To set up a new slide show: 

1. Select the source for the images you want to add to this slide show from the list box in the upper left corner of the Slide 
Show Setup dialog box. 

You can add images from the current patient's timepoints or from the image library. 

2. Specify how you want to assign images to slides in the slide show. 

� You can use the same number of images for each slide. In this case, Dolphin automatically assigns images 
to slides. 

� You can manually assign images to slides. 

Each of these options is described below. 

3. Add images to this slide show. 

4. Select any other options you want for this slide show. 

5. Save the slide show as described below. 

6. When you are finished using the Slide Show Setup dialog box, click Close to close it. 

To open an existing slide show: 

1. Select a previously-saved slide show from the Saved Sequences list box. 

Once you have opened a slide show, you can make any modifications to it such as adding images, removing images, 
and changing other options. 

Assigning Images to Slides 

To automatically assign images to slides: 

1. Check the Same Number of Images Per Slide check box. 

2. Specify the number of images that you want to use for each slide. 

3. Add images to this slide show, as described below. 

When you use this option, the Current Slide list box lists all the slides in the slide show. When you play the slide show, 
Dolphin automatically assigns the images to slides. For example, if you specify that each slide should contain two 
images, Dolphin automatically assigns the first two images in the Current Slide list box to the first slide, the third and 
fourth images in the Current Slide list box to the second slide, and so on. Dolphin automatically creates as many slides 
as needed to show all the images in the Current Slide list box. 
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To manually assign images to slides: 

1. Uncheck the Same Number of Images Per Slide box. 

When you uncheck the Same Number of Images Per Slide box, the options illustrated below are added to the Slide 
Show Setup dialog box. 

 
2. Using the slider, select the slide to which you want to add images. 

3. Add images to this slide as described below. 

To add a new slide before the current slide: 

1. Click . 

A new, blank slide is added before the currently-selected slide. 

To add a new slide at the end of the slide show: 

1. Click . 

A new, blank slide is added at the end of the slide show. 

Using Images in a Slide Show 

To add images to a slide show: 

1. If you have not already done so, select the source for the images you want to add to this slide show from the list box in 
the upper left corner of the Slide Show Presentation Setup dialog box. 

You can add images from the current patient's timepoints or from the image library. 

2. Click the images you want to include in the slide show from the Images Available list box. 

You can click a single image or several images. To deselect an image, click a highlighted image again. 

3. Click the >> button to move the selected image (or images) into the Current Slide list box. 

If you checked the Same Number of Images Per Slide box, moving an image to the Current Slide list box adds that 
image to the slide show. When you play the slide show, Dolphin automatically assigns the image to a particular slide. 

If you did not check the Same Number of Images Per Slide box, moving an image to the Current Slide list box adds 
that image to the current slide in the slide show.  
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To view close-ups of the available pictures 

1. Check the Zoom box. 

2. Select a picture in the Images Available list box.  

A window opens that displays a close-up view of the selected picture. If you continue selecting pictures in the Images 
Available list box, the close-up view window shows each picture as you select it. 

 

To close the close-up view window: 

1. Uncheck the Zoom box. 

To remove images from a slide show: 

1. If necessary, select the individual slide containing the image you want to remove. 

You only need to select the slide if the Same Number of Images Per Slide box is not checked. 

2. Click one or more images that you want to remove from the slide show from the Current Slide list box. 

You can click a single image or several images. To deselect an image, click a highlighted image again. 

3. Click the << button to move the selected image (or images) into the Images Available list box. 
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Saving a Slide Show 

To save a slide show: 

1. On the Slide Show Presentation Setup dialog box, click Save. 

A dialog box opens where you can type a name for this slide show. 

2. Type a name for this slide show. Then, click OK. 

Deleting a Slide Show 

To delete a slide show: 

1. Open the slide show you want to delete if it is not already open. 

2. Click Delete. 

A dialog box opens asking you to confirm the deletion. 

3. Click Yes to delete the slide show. 

Or,  

Click No to cancel the delete operation. 

Playing a Slide Show 

To play a slide show: 

1. Open the slide show you want to show if it is not already open. 

2. Click Show! 

When all the images in the slide show have been displayed, the Slide Show Setup dialog box appears. 

3. When you are finished using the Slide Show Presentation Setup dialog box, click Close to close it. 

To control slide transitions during a show: 

1. Click the currently-displayed image, press ENTER, the SPACE BAR, or the RIGHT ARROW key to transition to the next 
image in the slide show. 

These controls work even if the Automatically Advance Slide box is checked for this slide show. 

2. Press the LEFT ARROW or the BACKSPACE key, or click the right mouse button to transition to the previous image in the 
slide show. 

3. Press the PAUSE key to freeze a slide show in Auto Show mode. 

Press the PAUSE key again to resume the slide show. Alternatively, press ENTER, the SPACE BAR, the RIGHT ARROW key, 
or the LEFT ARROW key to resume the slide show. 

4. Press ESC to end the slide show at any time. 
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Using the Email Feature 
Using the Dolphin Email feature, you can email the current image layout. The Dolphin email feature automatically attaches the 
displayed image layout as one JPEG image to an email message and sends the message to any recipients you choose. 
Note: The Email feature only emails a JPEG image of the image layout. It does not email movies or 3D volume data (for patients 
with 3D images). 
If you are using Dolphin Premium, Dolphin creates a list of recipients using the email addresses you have entered in the patient’s 
chart. Specifically, Dolphin Premium supports storing email addresses for the patient, the patient’s billing party, the referring 
doctor, or the patient’s insurance company.  
To use the Dolphin Imaging email feature, you must have a properly configured Messaging Application Programming Interface 
(MAPI) email program and a valid email account set up. Examples of MAPI email programs include Microsoft Outlook Express 
and Eudora. AOL is not a MAPI program and is not compatible with the Dolphin Imaging email feature. 

To send an email message containing the current image layout: 

1. Click  on the Dolphin Imaging main screen’s horizontal tool bar. 

Or, 

Select Email from the Tools menu. 

The Email dialog box appears, as shown below. 

2. If you are using Dolphin Premium, select the recipients to whom you want to send this email message from the 
Recipient List. 

3. Optionally, modify the email message subject in the Message Subject text box. 

4. Enter any notes that you want to accompany the image layout in the Notes text box. 

5. Click Compose Email to launch your email program and make additional changes to this email message before 
sending it. 

Or, 

Click Send Immediately to send this message immediately (Dolphin Premium only). 

If you are using Dolphin Premium and you selected a recipient for whom no email address is entered in the patient’s 
record, Dolphin prompts for an email address. When you enter the email address, Dolphin adds it to the patient’s 
record. 

If you click Compose Email, your email program launches with a new email message containing the current image 
layout and the information entered in this dialog box. You can then add recipients, type more text to accompany the 
image layout, or add other email attachments. 
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Recipient List Select the recipients to whom you want to send this email message. If you are using Dolphin Premium, this 
list box contains the email addresses entered in this patient’s chart. 

Message 
Subject 

Optionally modify the subject of this email message. 

Notes Enter any text notes that you want to accompany the image layout. 

Compose 
Email 

Click this button to launch your email program with a new email message containing the current image layout 
and the information entered in this dialog box.  

Send 
Immediately 

Click this button to send the email message composed in the Email dialog box immediately, without first 
launching your email program (Dolphin Premium only). 

Advanced>> Click this button to expand this dialog box to specify more options (see below). 

To specify advanced email options: 

1. Click Advanced>> on the Email dialog box. 

The Email dialog box expands to show additional features. 

2. Set any of the options in the Attached Image Details group box. 
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Resolution Select the resolution to use for the image layout. 

File Type Select the image file type to use for the image layout. 

Bits per Pixel Select the number of bits to use to represent each pixel in the image layout. 

Default Click this button to return the Attached Image Details to their default values. 

Using AnywhereDolphin 
AnywhereDolphin is an Internet-based image record sharing and backup service available with Dolphin Premium that enables 
your practice to store, organize, share, and distribute patient records through private, password-protected accounts. With 
AnywhereDolphin, you can electronically store a full set of patient records safely and securely, and share those records with 
colleagues, referring doctors, parents, and patients. 
Anywhere Dolphin is a paid service. For pricing information, refer to the Anywhere Dolphin web site, www.anywheredolphin.com. 
This section describes how to get patients from the Internet and save patients to the Internet using AnywhereDolphin. It also 
describes how to set up the Dolphin Sonar module, which is the part of Dolphin Imaging that interacts with the AnywhereDolphin 
web site. 
Before you can get patients from the Internet or save patients to the Internet, you must log in to AnywhereDolphin. Depending on 
how Dolphin Sonar is set up on your system, you may need to log in whenever you open any dialog boxes associated with 
AnywhereDolphin, or you may be prompted to log in only when you try to transfer patients to or from AnywhereDolphin. 
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To log in to AnywhereDolphin: 

1. When the Sonar Secure Login dialog box appears, type your AnywhereDolphin user name and password in the text 
boxes.  

2. Click OK. 

If you do not have an AnywhereDolphin account, you can click the link on the Sonar Secure Login dialog box to go to 
AnywhereDolphin and set up an account. 

To log out: 

1. On the Dolphin Sonar dialog box, click Logout. 

Or, 

Exit Dolphin Imaging. 

If you exit Dolphin Imaging without logging out from AnywhereDolphin, a prompt appears asking if you would also like 
to logout. 

2. If a prompt appears asking if you want to logout from AnywhereDolphin, click Yes. 

Getting Patients from the Internet 

To get patients from the Internet: 

1. Open the Archive Patient Files dialog box. Then, select Get Patient From Internet, and click OK. 

Or, 

Click and select Download Patient from the pop-up menu. 

The Sonar Secure Login dialog box appears. 

2. If you have just started the Dolphin Sonar module, log in to AnywhereDolphin. 

After you have logged into AnywhereDolphin, a dialog box appears where you can select the patient you want to get 
from the Internet (see below). This dialog box lists patient records that you have uploaded to AnywhereDolphin 
(indicated by Owner in the Record Owner column) and patient records that others have uploaded to AnywhereDolphin 
and elected to share with you. For more information on sharing patient records, refer to the AnywhereDolphin web site 
(www.anywheredolphin.com). 

3. Select the patient that you want to get from the Internet.  

4. Set any options for downloading the patient. Then, click Download.  

Depending on how Dolphin Sonar is set up on your system, the patient's record may download immediately, or the 
Dolphin Sonar dialog box may appear with the download task listed in the Dolphin Sonar queue. If the Dolphin Sonar 
window opens, see "Processing Dolphin Sonar Queues" on page 210 for information on how to start the download 
process. 

If the patient you selected already exists, the downloaded patient record is merged with the existing information for that 
patient. For example, no existing pictures for the patient are overwritten with pictures from the Internet. 

The Dolphin Sonar dialog box tracks the download process and indicates when the download completes. 
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Patient ID The ID for the patient. 

Patient Name The patient's name. 

Record Owner Indicates the AnywhereDolphin user who owns the patient record. "Owner" in this column 
indicates that you own the patient record. 

Download with the 
original uncropped 
images (if they exist) 

Check this box to download any original, uncropped images that exist for this patient on the 
AnywhereDolphin site. 

Download with video 
and DICOM files (if 
available) 

Check this box to download any available video or DICOM files for this patient. 

Download with 3D files 
(if available) 

Check this box to download any available 3D volume files for this patient. 

Download Click this button to get the selected patient from the Internet. 

  

Saving Patients to the Internet 
Dolphin Imaging uses the Dolphin Sonar module to upload patient records to the Internet. Patients that you want to upload to 
AnywhereDolphin are placed in an upload queue so that they can be uploaded in the background while you do other work. 
Depending on how you have configured Dolphin Sonar on your workstation, the patient records may upload in the background. 
In this way, uploading patients to the Internet does not interrupt work on any of your Dolphin workstations. 
The Sonar Server must have Internet access and must have the Dolphin Imaging software installed. The frequency that the 
Sonar Server uploads patients from the queue to AnywhereDolphin depends on preferences that you set for the server. 
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To upload the currently-selected patient from the Dolphin Main Screen:  

1. Click and select Upload Current Patient from the pop-up menu. 

The Sonar Secure Login dialog box appears. 

2. If you have just started the Dolphin Sonar module, log in to AnywhereDolphin. 

Depending on how Dolphin Sonar is set up on your system, the patient's record may upload immediately, or the 
Dolphin Sonar dialog box may appear with the upload task listed in the Dolphin Sonar queue. If the Dolphin Sonar 
dialog box opens, see "Processing Dolphin Sonar Queues" on page 210 for information on how to start the upload 
process. 

To upload a patient from the Patient Lookup dialog box: 

1. Click Archive to open the Archive Patient Files dialog box.  

2. Select Save Patient to Internet. 

3. Optionally, check the box to upload the original, uncropped images if they exist. 

4. Optionally, check the box to upload video and DICOM files if any are available for this patient. 

5. Click OK. 

The Sonar Secure Login dialog box appears. 

6. Log in to AnywhereDolphin. 

If you do not have an AnywhereDolphin account, you can click a link on the Sonar Secure Login dialog box to go to 
AnywhereDolphin and set up an account. 

Depending on how Dolphin Sonar is set up on your system, the patient's record may upload immediately, or the 
Dolphin Sonar dialog box may appear with the upload task listed in the Dolphin Sonar queue. If the Dolphin Sonar 
dialog box opens, see "Processing Dolphin Sonar Queues" on page 210 for information on how to start the upload 
process. 

The Dolphin Sonar dialog box tracks the upload process and indicates when the upload completes. In addition, a message 
appears above the Microsoft Windows tray confirming completion of the upload task. Depending on how you have configured 
your AnywhereDolphin account, AnywhereDolphin may send you an email message confirming that the patient was successfully 
uploaded.  
When an upload task completes, the message above the Microsoft Windows tray, the Dolphin Sonar window, and any email 
confirmation you receive provide a link that you can click to open a browser window and navigate to the patient record that was 
just uploaded to AnywhereDolphin. 
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To set upload preferences: 

1. Click and select Upload Preferences from the pop-up menu. 

2. Select Include original uncropped... to include original, uncropped images when uploading a patient's record. 

Or, 

Select Include AVI, DIC, etc... to include AVI, DIC, or other video files when uploading a patient's record. 

Or, 

Select Include 3D files (if they exist) when uploading a patient's record that includes 3D volume files. 

When you select one of these options, a check mark appears next to it on the menu. To disable an option, select it 
again from the menu, and the check mark disappears.  

Setting up Dolphin Sonar 
The Dolphin Sonar module is the part of Dolphin Imaging that interacts with the AnywhereDolphin web site. 

To set up the Dolphin Sonar module: 

1. On the Dolphin Imaging Main Screen, click . Then, click Show Sonar Window. 

Or, 

On the Dolphin Imaging Main Screen, click . Then, click Upload Current Patient. 

Or, 

On the Dolphin Imaging Main Screen, click . Then, click Download Patient. 

Or, 

On the Archive Patient Files dialog box, select Save/Backup Patient to Internet. Then, click OK. 

If the Dolphin Sonar module has not been previously set up, you may see the following message: 

 

2. If this message appears, click Yes. 

The Welcome to Dolphin Sonar dialog box appears.  
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3. Click Continue... 

The Sonar Secure Login dialog box dialog box appears. 

4. On the Sonar Secure Login dialog box, click Options. 

The Sonar Options dialog box appears (see below). 

To change Dolphin Sonar options: 

1. On the Sonar Secure Login dialog box, click Options. 

Or, 

On the Dolphin Sonar dialog box, click Options. 

Or, 

Click the Dolphin Sonar icon ( ) in the Microsoft Windows tray on the Dolphin Sonar Server. Then, select 
Options.... 

The Sonar Options dialog box appears (see below). 

To set Dolphin Sonar options: 

1. On the Sonar Options dialog box, set any options, and click OK. 

If the folder specified as the Sonar Folder does not exist, a message appears asking whether you would like to create 
the folder. 

2. If this message appears, click Yes. 

3. Click OK on the Sonar Options dialog box to save your settings. 
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Automatically Process 
Queued Items as Soon as 
Possible 

Check this box to instruct the Dolphin Sonar module to upload or download patient records 
to AnywhereDolphin as soon as possible after they are queued. 

Show Sonar if it is Hidden 
When it Receives a New 
Task From Dolphin 

Check this box to show the Dolphin Sonar dialog box on the Sonar Server whenever the 
Dolphin Sonar module receives a new task. 

Minutes Enter the number of minutes that your workstation must be inactive before items in your 
Sonar queue are made available to other workstations on your network for processing. For 
example, you could use this option to process all upload and download operations for all 
workstations in your practice at once on a single workstation. 

Sonar Folder Enter the name of the folder to use to store the queue in this text box, or click the Browse 
button (...) to browse to the folder. 
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Processing Dolphin Sonar Queues 
The Dolphin Sonar queue contains tasks for uploading patient records to and downloading them from AnywhereDolphin. It is only 
necessary to manually process the Dolphin Sonar queue if you have not set the Dolphin Sonar module to automatically process 
queued items as soon as possible. If you have set this option for the Dolphin Sonar module, the queue is processed 
automatically. 
A Dolphin Sonar queue that is not configured for automatic processing can become inactive if a Dolphin Imaging user places 
tasks in it and either: 

• closes the Dolphin Sonar window before processing the pending items in the queue 

• leaves pending items in the queue for more than the number of minutes configured in their Dolphin Sonar options 

In this case, another Dolphin Imaging user can access the pending items in the inactive queue and process them. Using this 
feature, you can process the Dolphin Sonar queues for several workstations at one time. 

To process the Dolphin Sonar Queue: 

1. On the Dolphin Imaging Main Screen, click . Then, click Show Sonar Window. 

Or, 

Click the Dolphin Sonar icon ( ) in the Microsoft Windows tray on the Dolphin Sonar Server. Then, click Show 
Dolphin Sonar. 

The Dolphin Sonar dialog box appears and lists any tasks in the Dolphin Sonar queue. 

2. If you have just started the Dolphin Sonar module or if it is not set to require login whenever it is started, log in to 
AnywhereDolphin. 

If you have just started the Dolphin Sonar module and it is set to require you to login upon startup, the 
AnywhereDolphin Login dialog box appears automatically. If not, click Login on the Dolphin Sonar dialog box to open 
the AnywhereDolphin Login dialog box.  

On the AnywhereDolphin Login dialog box, type your AnywhereDolphin user name and password in the text boxes. 
Then, click OK. 

When you log in to AnywhereDolphin, the Login button on the Dolphin Sonar dialog box changes to a Logout button. 

3. Click Start Queue to start processing the tasks in the Dolphin Sonar queue. 

The Start Queue button changes to Stop Queue, so you can stop queue processing. 

The Status column indicates the progress of an upload or download task. When an upload task completes, the Status 
column contains a link that you can click to view the uploaded patient record online. When a download task completes, 
the Status column indicates a status of Completed. 

Note: If you close the Dolphin Sonar window before processing the items in the queue, your queue becomes inactive. 
Other computers on your network can then access your queue and process the pending items in it. For more 
information, see "To process inactive queues" on page 212. 
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Login or Logout Click this button to log in to or out from AnywhereDolphin. 

Start Queue or 
Stop Queue 

Click these buttons to start or stop queue processing. 

Go Online Click this button to open a browser window and navigate to the AnywhereDolphin web site. 

Hide Click this button to minimize the Dolphin Sonar dialog box.  

Inactive Queues Click this button to view pending tasks in inactive Dolphin Sonar queues for other computers on 
your network. This option enables you to process the pending tasks in inactive queues. 

Options Click this button to set options for the Dolphin Sonar module. 

Task The queued Dolphin Sonar task. 

Description A description of the Dolphin Sonar task. 

Status The current status of the Dolphin Sonar task. Possible status values are: 
Pending: This patient record is waiting in the queue. 
Processing: This patient record is currently being transferred. 
Complete: This patient record has been transferred. 
View Online: Click this link to view the patient record on AnywhereDolphin. 

To remove an item from the Dolphin Sonar queue: 

1. Right-click the item you want to remove in the queue. Then, select Remove From Queue from the pop-up menu. 

Or, 

Select the item you want to remove in the queue. Then, press DEL on your keyboard. 
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To clear all completed tasks from the Dolphin Sonar queue: 

1. Right-click an item in the queue.  

2. Select Clear Completed Items from the pop-up menu. 

To view an uploaded patient record on AnywhereDolphin: 

1. Click the View Online link in the status column for the item you want to view. 

Or, 

Right-click the item you want to view in the queue. Then, select Go To Record Online from the pop-up menu. 

To process inactive queues: 

1. On the Dolphin Imaging Main Screen, click . Then, click Show Sonar Window. 

Or, 

If the Dolphin Sonar module is already started, click its icon ( ) in the Microsoft Windows tray on the Dolphin Sonar 
Server. Then, click Show Dolphin Sonar. 

The Dolphin Sonar dialog box appears and lists any tasks in the Dolphin Sonar queue. 

2. If you have just started the Dolphin Sonar module, log in to AnywhereDolphin. 

If you have just started the Dolphin Sonar module and it is set to require you to login upon startup, the 
AnywhereDolphin Login dialog box appears automatically. If not, click Login on the Dolphin Sonar dialog box to open 
the AnywhereDolphin Login dialog box.  

On the AnywhereDolphin Login dialog box, type your AnywhereDolphin user name and password in the text boxes. 
Then, click OK. 

When you log in to AnywhereDolphin, the Login button on the Dolphin Sonar dialog box changes to a Logout button. 

If there are any items in inactive queues, the Inactive Queues button is active. 

3. Click Inactive Queues. 

The Inactive Queues dialog box opens and lists the inactive queues that you can process. 
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4. To process one of the inactive queues, select it and click OK. 

A message appears indicating the number of items that have been imported from the inactive queue to your Dolphin 
Sonar queue. In rare cases, you may see a message indicating that no items could be imported. This message only 
appears when someone else in your office is processing inactive queues at the same time that you are, and that 
person imported the inactive queue items before you did. 

5. Click OK. 

The imported items appear in your queue on the Dolphin Sonar window. 

6. Process your queue to transfer the items to or from AnywhereDolphin. 

Transferring Images to Other Applications 
This section describes two ways that you can transfer Dolphin Imaging pictures to another application: 

• You can drag and drop a picture from the Dolphin Imaging main screen into any application that supports drag-and-
drop, such as Microsoft Word or PowerPoint. 

• You can copy a picture to the clipboard and paste it into another application. 

Note: Dolphin also provides an image control and layout object mechanisms for inserting patient pictures into Microsoft Word 
documents, PowerPoint presentations, and Excel spreadsheets. For more information, see "Using Dolphin Image Controls" on 
page 215 and "Using Dolphin Layout Objects" on page 220. 

To drag and drop a picture from the Dolphin Imaging main screen into another application: 
1. Start the application into which you want to drag and drop a Dolphin Imaging picture, if it isn’t already started.  

2. Arrange the Dolphin Imaging main screen and the other application window so that both are visible on your Microsoft 
Windows desktop. 

3. On the Dolphin Imaging main screen, select the picture you want to drag and drop. 

4. Click the selected picture, hold down the mouse button, and drag it into the other application’s window. Release the 
mouse button. 

The Dolphin Imaging picture appears in the other application’s window, as shown below. 

Note: If the image contains tracings (such as a digitized X-ray image or a tracing superimposed over the patient’s 
profile photograph), both the image and the tracing appear. 
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To copy an image to the clipboard and paste it into another application: 

1. Right-click the image, and select Copy Image (or Copy Image To Resolution, if you want to specify the resolution used) 
from the Image pop-up menu to copy the image to the clipboard. 

Or, 

Right-click the image, and select Copy Uncropped Image from the Image pop-up menu to copy the uncropped version 
of image (if it exists) to the clipboard. 

Or, 

Right-click the image, and select Copy Layout (or Copy Layout To Resolution, if you want to specify the resolution 
used) from the Image pop-up menu to copy the entire image layout to the clipboard. 

2. Paste the image or image layout into the other application’s window. 
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Typically, you can paste from the clipboard using a pop-up menu option (right-click and select Paste from the pop-up 
menu) or by pressing CTRL+V. When you paste the image, it appears in the other application’s window, as shown 
below. 

If you have pasted the image and tracing into Microsoft Word or PowerPoint, you can then edit the picture and 
manipulate it. For instance, you can ungroup the image and the tracing, and manipulate the elements independently. 

Note: You may need to perform the ungroup operation more than once before you can independently move the lines, 
curves, and numbers that make up the tracing. 

 

Using Dolphin Image Controls 
You can use the Dolphin Image Control to insert patient pictures into Microsoft Word documents, PowerPoint presentations, and 
Excel spreadsheets. To use the Dolphin Image Control, you perform the following basic steps: 

1. Insert a Dolphin Image Control into the document, presentation, or spreadsheet. 

2. Specify the patient image to use for the Dolphin Image Control. 

This section describes each of these tasks. 
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To insert a Dolphin Image Control into a document, presentation, or spreadsheet:  
1. Open the document, presentation, or spreadsheet into which you want to insert the Dolphin Image Control. 

2. From the Microsoft Insert menu, select Object. 

The Object dialog box is displayed. For more information on this dialog box, refer to the documentation for the 
Microsoft application you are using. 

 
3. Select Dolphin Image Control from the Object dialog box, and click OK. 

The Dolphin Image Control appears in your document, presentation, or spreadsheet as shown below. 

4. Click somewhere other than the Dolphin Image Control to de-select it.  
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To specify the patient image for a Dolphin Image Control: 

1. Right-click the Dolphin Image Control. 

A pop-up menu is displayed. If the pop-up menu does not appear, click somewhere other than the Dolphin Image 
Control to de-select it. Then, right-click the Dolphin Image Control again. 

2. From the pop-up menu, select Dolphin Image Control Object. Then, select Properties from the cascade menu as 
shown below. 
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The Dolphin Image Control Properties dialog box is displayed. 

3. Enter the patient ID for the patient whose picture you want to use. 

Or, 

Select the patient ID from the drop-down list box. 

4. Select the timepoint and picture you want to use from the drop-down list boxes.  

5. Optionally, select an image resolution from the Max Size drop-down list box. 

Selecting a lower resolution for images results in a smaller file for your document, presentation, or spreadsheet. If you 
import several Dolphin images, you may want to use lower resolution images, especially if you plan to email the 
resulting document, presentation, or spreadsheet.  

6. Click OK. 

The Dolphin logo is replaced with the patient image you specified. 
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Patient ID Type the Patient ID for the patient whose picture you want to use 

Timepoint Select the timepoint for the picture you want to use. 

Image Type Select the picture you want to use. 

Max Size Select the image resolution. Lower resolution images result in a smaller file. 

Use Background 
Color 

Check this box to use a background color to fill any space within the Dolphin Image Control not 
occupied by the patient's picture. 

Colors tab Use this tab to set a background color. 

If the patient's picture does not take up the entire Dolphin Image Control, you can fill the unused space with a background color. 

To use a background color: 

1. Check Use Background Color on the Dolphin Image Control Properties dialog box. 

2. Click the Colors tab. 

3. Select the background color you want. Then, click OK. 
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Using Dolphin Layout Objects 
You can use the Dolphin Layout Object to insert patient pictures into Microsoft Word documents, PowerPoint presentations, and 
Excel spreadsheets. To use the Dolphin Layout Object, you perform the following basic steps: 

1. Insert a Dolphin Layout Object into the document, presentation, or spreadsheet. 

2. Specify the image layout to use for the Dolphin Layout Object. 

This section describes each of these tasks. 

To insert a Dolphin Layout Object into a document, presentation, or spreadsheet:  
1. Open the document, presentation, or spreadsheet into which you want to insert the Dolphin Layout Object. 

2. From the Microsoft Insert menu, select Object. 

The Object dialog box is displayed. For more information on this dialog box, refer to the documentation for the 
Microsoft application you are using. 

 
3. Select Dolphin Layout Object from the Object dialog box and click OK. 

The Dolphin Layout Object appears in your document, presentation, or spreadsheet as shown below. 

4. Click somewhere other than the Dolphin Layout Object to de-select it.  
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To open the Dolphin Layout Object Properties dialog box: 

1. Right-click the Dolphin Layout Object. 

A pop-up menu is displayed. If the pop-up menu does not appear, click somewhere other than the Dolphin Layout 
Object to de-select it. Then, right-click the Dolphin Layout Object again. 

2. From the pop-up menu, select Dolphin Layout Object Object. Then, select Properties from the cascade menu as 
shown below. 
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The Dolphin Layout Object Properties dialog box opens. 

 

Find... Click this button to get the patient information from Dolphin Imaging.  If you are using Standard Dolphin, 
the Patient Charts dialog box opens. If you are using Dolphin Premium, the Patient Lookup dialog box 
opens. For more information on these dialog boxes, see Chapter 4. 

Timepoint Use this drop-down list box to select the timepoint for the pictures you want to use 

Layout Use this drop-down list box to select the image layout you want to use. 

Analysis Use this drop-down list box to select the cephalometric analysis. 

Images Under 
Tracings 

Check this box to include the patient images (rather than just tracings) in the selected image layout. 

Tracings Check this box to include tracings on the images in the selected image layout. 

Image Titles Check this box to include titles on the images in the selected image layout. 

Logo Images Check this box to include any logo images defined as part of the selected image layout. 
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Empty Frames Check this box to include empty image or text frames defined in the selected image layout. 

Text 
+Header/Footer 
lines 

Check this box to include all text as well as any header and footer lines defined in the selected image 
layout. 

To set properties for a layout object: 
1. Click Find...to select the patient information to use for this layout object. 

If you are using Standard Dolphin, the Patient Charts dialog box opens. If you are using Dolphin Premium, the Patient 
Lookup dialog box opens. For more information on these dialog boxes, see Chapter 4. 

After you select the patient, the patient's name and ID are displayed in the Patient group box. Additionally, that 
patient's timepoint, layout, and cephalometric analysis information are imported into the Timepoint, Layout, and 
Analysis drop-down list boxes. 

2. Use the Timepoint drop-down list box to select the timepoint you want to use. 

3. Use the Layout drop-down list box to select from the available layout options. 

4. Use the Analysis drop-down list box to select from the available cephalometric analyses. 

5. Optionally, check the boxes for any other options you want to use.  

6. Click OK or Apply to use the settings and close the Dolphin Layout Object Properties dialog box. 

The Dolphin Layout Object changes to indicate the patient, timepoint, and image layout you have assigned to it. The 
Dolphin Layout Object will be replaced by the appropriate image layout when you print the Microsoft Word document or 
Excel spreadsheet, or run the PowerPoint presentation. 
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Printing 
From the Dolphin Imaging main screen, you can print the current layout or set up printing options. You can also preview a print 
job before actually printing it. 

To print the current layout: 

1. Click   on the Dolphin Imaging main screen’s horizontal tool bar. 

Or, 

Select Print from the File menu. Then, select Print... from the cascade menu. 

The Print dialog box is displayed. 

2. Select any printing options you want, and click OK. 

 

Printer Indicates the printer to which the print job will be sent. You set the printer for the image layout using the File menu 
Printer Setup option, as described in "To set up your printer." If you have not specified the printer setup, Dolphin 
uses the default printer settings for your computer. 
Note: Dolphin does not retain printer settings when you exit the program. To retain printer settings, set them using 
the Microsoft Windows Printers Control Panel. 

Properties Click this button to set advanced properties for the selected printer. 
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Print 
Range 

Select what you want to print. Your options are: 
All: Print an entire document. From the main screen, you would typically use this option. 
Pages: Print only pages in the specified range. 
Selection: Print just what you have selected. 

Copies Enter the number of copies you want to print. 

Print 1:1 Check this box to print an image using the 1:1 option, which scales the image according to the calibration specified 
for it. This option is selected by default if the image has been calibrated. Images with cephalometric tracings are 
calibrated when they are digitized. Images without cephalometric tracings can be calibrated using the Image 
Calibration option on the Image pop-up menu. For more information, see "The Image Pop-up Menu" on page 32.  

Preview Check this box to preview your print job on the computer screen. You can use this option to preview the location of 
your practice logo and the information about your practice. 

To preview your print job: 

1. Check the Preview box on the Print dialog box, and click OK. 

Or, 

Select Print from the File menu. Then, select Print Preview from the cascade menu. 

A preview of the print job appears in the Dolphin Layout Editor window. 

Note: Any changes you make to the print preview using the Dolphin Layout Editor apply to this print job only. They are 
not saved to the Dolphin layout. 

For more information on the options the Dolphin Layout Editor offers, see Chapter 7. 

2. Click  to print the print job. 

Or, 

Select Exit from the File menu to close this dialog box. 



Dolphin Imaging User's Guide April 2011 

226 DI_USER_GUIDE-11.5   Rev. 1.01 

 

To set up your printer: 
1. Select Printer Setup... from the File menu.  

The print setup dialog box is displayed. 

2. Select any options you want and click OK. 
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Printer Select the printer to which you want to send your print jobs.  

Properties Click this button to set advanced properties for the selected printer. 

Paper Select the paper size and source using these drop-down list boxes. 

Orientation Select the orientation of the print job on the paper. Your options are portrait or landscape. The icon in this group 
box shows how the selected option will print. 

Network... Click this button to access other mapped disk drives on your computer network. 
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7 Layout Editor  
Using the Layout Editor dialog box, you can create and edit the layouts used when viewing and printing images.  
Note: The Layout Editor feature is an advanced feature of the Dolphin Imaging program. Please proceed with caution when 
making any changes in the Layout Editor. 

To open the Layout Editor: 

1. Click Edit in the Image Layout group box of the Capture Setup dialog box. 

Or, 

Select Page Setup... from the File menu. 

Or, 

Select Edit Layouts... from the Edit menu. 

The Layout Editor dialog box is displayed using the current image layout. 
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Menu Bar Contains menus that you can use to access program features. 

Tool Bar Contains buttons that you use to access program features. 

Preview Shows a preview of the layout. 

Page Gallery Displays thumbnails of the pages in this layout. 

To exit from the Layout Editor: 

1. Select Exit from the File menu. 

Using the Tool Bar 
The Layout Editor tool bar contains the following buttons: 

 Click this button to open and edit an existing layout. For more information, see "Opening a Layout" on page 
239. 

  Click this button to save the current layout. For more information, see "Saving the Layout" on page 239. 

 

Click this button to print the current layout. For more information, see "Printing Layouts" on page 266. 

 

Click this button to add a new text label to this layout. For more information, see "Using Text Labels" on page 
249. 

 

Click this button to add a new image to this layout. For more information, see "Using Images" on page 243. 

 

Click this button to toggle Locked mode for any selected objects. When an object is locked it cannot be moved 
or resized, avoiding accidental misalignment of images.  For more information, see "Locking and Unlocking 
Objects" on page 265. 

 

Click this button to delete the selected objects from the layout. For more information, see "Deleting Objects" on 
page 262. 

 

When two or more objects are selected, click this button to align them with the left side of the first object 
selected. For more information, see "Aligning Objects" on page 259. 
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When two or more objects are selected, click this button to align them with the right side of the first object 
selected. For more information, see "Aligning Objects" on page 259. 

 

When two or more objects are selected, click this button to align them with the top of the first object selected. 
For more information, see "Aligning Objects" on page 259. 

 

When two or more objects are selected, click this button to align them with the bottom of the first object 
selected. For more information, see "Aligning Objects" on page 259. 

 

When two or more objects are selected, click this button to resize them to be the same width as the first object 
selected. For more information, see "Making Several Objects the Same Size" on page 257. 

 

When two or more objects are selected, click this button to resize them to be the same height as the first object 
selected. For more information, see "Making Several Objects the Same Size" on page 257. 

 When two or more objects are selected, click this button to resize them to be the same width and height as the 
first object selected. For more information, see "Making Several Objects the Same Size" on page 257. 

 

Select a magnification percentage from this drop-down list box to change the magnification.  For more 
information, see page 242. 

 

Click this button to zoom in on the layout. For more information, see page 242. 

 

Click this button to zoom out from the layout. For more information, see page 242.." 

 

Click this button to change the magnification so that the layout fits in the window. For more information, see 
page 242. 
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Using the Menu Bar 
At the top of the Layout Editor window, there are menus that you can use to access program features.  

• File Menu 

• Edit Menu 

• View Menu 

• Insert Menu 

• Format Menu 

• Tools Menu 

• Groups Menu 

This section describes each of these menus. 

The File Menu 
The following figure illustrates the File menu: 

 
The File menu contains the following choices: 

New Layout Creates a new layout. For more information, see "Creating a New Layout" on page 238. 

Open Layout... Opens an existing layout for editing. For more information, see "Opening a Layout" on page 239. 

Save Layout Saves the current layout. For more information, see "Saving the Layout" on page 239. 

Save Layout As... Saves the current layout under a new name. For more information, see "Saving the Layout"  on page 
239. 

Export Page to 
Image... 

Exports the currently-selected page in the layout to an image file on your computer.  For more 
information, see below. 
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Page 
Setup... 

Opens the Page Setup dialog box so that you can adjust the paper size, background color, margins, page 
orientation, and preset printer for the currently-selected page.  For more information, see "Setting Up the Page" on 
page 241. 

Print... Prints the current layout. For more information, see "Printing Layouts" on page 266. 

Exit Exits the Layout Editor. 

To export a page to an image file: 

1. Select Export Page to Image... from the File menu. 

The Save Page to Image File dialog box opens. 

2. Click the button labeled .... 

The Save As dialog box opens. 

3. Specify the image file in which you want to save the current page.  

4. Optionally, select the type of image (JPEG, PNG, or bitmap) from the Save As Type drop-down list box. Then, click 
Save. 

5. Set any other options on the Save Page to Image File dialog box. Then, click Save. 

 

Save Path The image file in which you want to save the current page. Click the button labeled ... to browse to the file. 

Color Select this option to save this page as a color image. 

Greyscale Select this option to save this page as a greyscale image. 
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Resolution (dots per inch)  Select the resolution for this page as a number of Dots Per Inch (DPI). 

Preview Displays a preview of the page you are exporting. 

The Edit Menu 
The following figure illustrates the Edit menu: 

 
The Edit menu contains the following choices: 

Undo Undoes previous operations in order. You can undo any number of operations. 

Redo Redoes undone operations. You can redo any number of operations as long as you did not make any 
changes to the layout after the undo operation.. 

Copy page to 
Clipboard 

Copies the current page and places it on the clipboard as an image. 

Cut Cuts one or more selected objects and places them on the clipboard. For more information, see "Cutting, 
Copying, and Pasting Objects" on page 263. 

Copy Copies one or more selected objects to the clipboard. For more information, see "Cutting, Copying, and 
Pasting Objects" on page 263. 

Paste Pastes one or more previously cut or copied objects from the clipboard. For more information, see 
"Cutting, Copying, and Pasting Objects" on page 263. 

Delete Deletes one or more selected objects. For more information, see "Deleting Objects" on page 262. 

Select All Selects all objects in the layout. 
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The View Menu 
The following figure illustrates the View menu: 

 
The View menu contains the following choices: 

Margins Toggles the display of the green margin lines. For more information, see "To toggle display of the green margin 
lines" on page 242. 

Printable 
Area 

Toggles the display of the red "printable area" guidelines. For more information, see "To toggle display of the red 
"printable area" guidelines" on page 242. 

Image Titles Opens a cascade menu that you can use to show or hide the title labels for all images. For more information, see 
"Displaying Image Titles" on page 244. 

Image 
Borders 

Opens a cascade menu that you can use to show or hide the borders around all images. For more information, 
see "Displaying Image Borders" on page 244. 

Page Gallery Toggles the display of the page gallery. For more information, see "Using the Page Gallery" on page 237. 

Hide Labels Toggles the display of the all the labels in a layout. For more information, see "To toggle display of all text labels" 
on page 252.  

The Insert Menu 
The following figure illustrates the Insert menu: 

 
The Insert menu contains the following choices: 

Label Places a label on the layout. For more information, see "Using Text Labels" on page 249. 

Image Places an image on the layout. For more information, see "Using Images" on page 243. 

Group Displays a list of previously-saved groups of objects so that you can choose one to insert into the layout. For more 
information, see "To insert a previously-saved object group into your design" on page 265. 
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The Format Menu 
The following figure illustrates the Format menu: 

 
The Format menu contains the following choices: 

Background 
Color... 

Sets the background color of the currently-selected page. 

Image Corner 
Rounding... 

Toggles rounded corners on the images 

Align Opens a cascade menu that you can use to align the selected objects on the left, right, top, or bottom. For 
more information, see "Aligning Objects" on page 259. 

Make Same Size Opens a cascade menu that you can use to resize the selected objects to be the same height, same width, 
or both the same height and width. For more information, see "Making Several Objects the Same Size" on 
page 257. 

Center Opens a cascade menu that you can use to center the selected objects horizontally or vertically on the 
page. For more information, see "Centering Objects" on page 260. 

Horizontal 
Spacing 

Opens a cascade menu that you can use to adjust the horizontal spacing of the selected objects as 
follows: 
Make Equal: Space the selected objects evenly. 
Increase: Increase the space between the selected objects. 
Decrease: Decrease the space between the selected objects. 
Remove: Remove the space between the selected objects, making them flush with each other. 
For more information, see "Changing Object Spacing" on page 260. 
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Vertical 
Spacing 

Opens a cascade menu that you can use to adjust the vertical spacing of the selected objects as follows: 
Make Equal: Space the selected objects evenly. 
Increase: Increase the space between the selected objects. 
Decrease: Decrease the space between the selected objects. 
Remove: Remove the space between the selected objects, making them flush with each other. 
For more information, see "Changing Object Spacing" on page 260. 

Order Opens a cascade menu that you can use to adjust the ordering of the selected objects as follows: 
Bring to Front: Place the selected object in front of other objects. 
Send to Back: Place the selected object behind other objects. 
For more information, see "Changing Object Layering" on page 261. 

Snap To Opens a cascade menu that you can use to align the selected objects as follows: 
Margin: Opens a further cascade menu that you can use to align the selected objects along the left, right, top, or 
bottom page margin. 
Printer Hard Margin: Opens a further cascade menu that you can use to align the selected objects along the 
left, right, top, or bottom hard margin.  
If you have specified a printer on the page setup dialog box, the hard margins specify how close to the paper 
edge the specified printer can print. Otherwise, the hard margins are at the paper edges. 
For more information, see "Aligning Objects" on page 259. 

 

The Tools Menu 
The following figure illustrates the Tools menu: 

 
The Tools menu contains the following choices: 

Link Labels to 
Image 

Establishes a link between the selected labels and image so that data tokens such as the image title, timepoint 
information, and so on can be read from that image when rendering the label text. For more information, see 
"Linking Labels to an Image" on page 253. 

Unlink Labels 
from Image 

Break the linkage between labels and an image. For more information, see "Linking Labels to an Image"  on 
page 253. 
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The Groups Menu 
The following figure illustrates the Groups menu: 

 
The Groups menu contains the following choices: 

Group Objects Group the selected objects into a single object. 

Ungroup Objects Split the selected object group into individual objects.   

Save Group As... Store a group of objects for later reuse.   

Insert Group Insert a previously-stored object group on the current design.   

For more information, see "Using Object Groups" on page 263. 

Using the Page Gallery 
The page gallery displays thumbnails of the layout's pages. Most layouts have a single page.  

To scroll through the pages in the gallery: 

1. Click and drag the scroll bar to the left of the page gallery. 

To view a page from the gallery: 

1. Double-click a page in the gallery to display it in the center pane in the window. 

To toggle display of the page gallery: 

1. Select Page Gallery from the View menu. 

Or, 

Right-click the page gallery. Then select Hide Page Previews from the pop-up menu to hide the page gallery. 

To delete a page from the layout: 

1. Click and drag the scroll bar to the right of the page gallery until the page you want to delete appears in the center part 
of the window.  

2. Click the page to select it. 
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A red outline appears around the page. 

3. Click . 

Or, 

Select Delete from the Edit menu. 

Alternatively, you can right-click the page and select Delete from the pop-up menu. 

A dialog box appears asking you to confirm the deletion. 

4. Click Yes to delete the page. 

To change the order of the pages in a multi-page layout: 

1. Right-click the page you want to move in the page gallery. 

2. Select Move Page to Number from the pop-up menu. 

3. Select the new page number for the selected page from the cascade menu. 

Managing Layouts 
This section describes how to create a new layout, open an existing layout, save a layout, and delete a layout. 

Creating a New Layout 

To create a new layout: 

1. Select New Layout... from the File menu. 

The Page Setup dialog box opens. 

2. Enter page setup options for the new layout.  

For information on setting these options, see "Setting up the Page" on page 241. 

3. Click OK. 

The new layout appears in the Layout Editor window. 



7 Layout Editor Part III: ImagingPlus 

DI_USER_GUIDE-11.5   Rev. 1.01 239 

Opening a Layout 

To open an existing layout: 

1. Click . 

Or, 

Select Open Layout... from the File menu. 

A dialog box appears where you can select the layout that you want to open. 

2. Select a layout from the list box, and click Open. 

Saving the Layout 
Saving your layout automatically shares your design among all Dolphin stations on your network. 

To save the layout: 

1. Click . 

Or, 

Select Save Layout or Save Layout As... from the File Menu. 

If you had previously saved this layout and you did not select Save Layout As..., the layout is saved, overwriting the old 
version. 

If you have not previously saved this layout or if you selected Save Layout As..., a dialog box opens where you can 
specify a name for this layout.  

2. Select an existing layout name that you want to use for this layout from the list box.  

Or, 

Type the name that you want to use for this layout in the text box.  

3. Click Save. 

If you selected an existing layout name, your new layout is written over the existing layout.  

Layouts are saved in the Dolphin\Working folder on your server, so that saved layouts are available to all 
computers on your network, and they are backed up along with the rest of your Dolphin Imaging data. 
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Deleting a Layout 

To delete a layout: 

1. Click . 

Or, 

Select Open Layout... from the File menu. 

A dialog box appears where you can select a layout that you want to open. This dialog box also offers the option to 
delete a layout. 

2. Select the layout you want to delete from the list box. Then, click Delete. 

A dialog box appears asking you to confirm the deletion. 

3. Click Yes to delete the layout. 

Editing Layouts 
This section describes how to edit a layout. It describes: 

• setting up the layout page  

• using images and text labels 

• resizing and repositioning objects 

• deleting objects 

• cutting, copying, and pasting objects 

• using object groups 

• locking and unlocking objects 

• setting options 

• working with layout pages 
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Setting Up the Page 
You use the Page Setup dialog box to set a layout's basic properties. The first step in creating a new layout is to enter page 
setup options. After creating the layout initially, you can change these options at any time. 

To set up the page: 

1. Select Page Setup... from the File Menu to set options for the layout on which you are currently working. 

Or, 

Select New Layout from the File menu to create a new layout. 

Or, 

Right-click the layout. Then, select Page Setup... from the pop-up menu. 

Page Setup dialog box opens. 

2. Enter page setup options. Then, click OK. 

 
Paper group box Use these options to set the paper size. 

drop-down list box: Select from a list of standard paper sizes. 
Custom: Check this box to enter a custom paper size. 
Width: Enter the width for a custom paper size. The units for this measurement depend on the 
Measurement Units selection (see below). 
Height: Enter the height for a custom paper size. The units for this measurement depend on 
the Measurement Units selection (see below). 

Margins group box Use these options to set the right, left, top, and bottom margins. The units for these 
measurements depend on the Measurement Units selection (see below). 
Margins act as guidelines. You can place objects outside the margins. 
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Orientation group box Select the page orientation. 
Portrait: Prints so that the short edges of the page are at the top and bottom. 
Landscape: Prints so that the long edges of the page are at the top and bottom. 

Background Color Click the color sample to set the background color for the layout. 

Measurement Units 
group box 

Select the units, either inches or millimeters (mm), that you want to use when entering 
measurements such as margin dimensions for this layout. 

Preset Printer Select the printer that you want to use by default when printing this layout. You can change to a 
different printer when printing a layout. 

Use these settings as 
defaults 

Check this box to use these settings as defaults for all layouts. 

To zoom in: 

1. Click . 

To zoom out after zooming in: 

1. Click . 

To fit the design in the window: 

1. Click . 

To select a magnification factor: 

1. Select a magnification percentage from the drop-down list on the tool bar. 

To toggle display of the green margin lines: 

1. Select Margins from the View menu. 

To toggle display of the red "printable area" guidelines: 

1. Select Printable Area from the View menu. 
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Using Images 

To add an image to your layout: 

1. Click . 

Or, 

Select Image from the Insert menu. 

Or, 

Right-click the layout, and select Add Image from the pop-up menu. 

Your cursor changes to a placeholder-drawing icon ( ). 

2. Click and drag to draw an image placeholder of the size you want for this image. 

3. Right-click the image placeholder. 

4. Select Image Type from the pop-up menu. Then, select the type of image you want to use from the cascade menu. 

You can also set the image type for a placeholder by setting its properties. You would do this, for example, to add a 
logo or other image file from your computer to a layout. For more information, see "Setting Image Properties" on page 
244. 

To toggle rounded corners for the images: 

1. Select Image Corner Rounding... from the Format menu. 

Sizing Images Within Placeholders 
Two options determine how to size images within placeholders: 
Draw 1:1 This option scales the image according its resolution. Depending on the placeholder size, the image may 

be too large or small for the placeholder. 

Show Whole 
Image 

This option scales the image so that it is as large as possible and still fit entirely within the placeholder. 

To change the sizing option: 

1. Right-click the image. 

2. Select the sizing option from the pop-up menu. 

To change the placeholder size to match the image size: 

1. Right-click the image. 

2. Select Snap to Image Size from the pop-up menu. 
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Displaying Image Borders 
You can display an image border that is the same size and shape as the image placeholder. 

To toggle display of an image's borders: 

1. Right-click the image. 

2. Select Show Border from the pop-up menu. 

3. Deselect the image by clicking somewhere else on the page. 

When you deselect the image, the placeholder boundary disappears, and you can see whether the image border 
displays. 

Note: You can specify whether you want to display the borders for an image and set the image border's color and width by 
setting image properties. For more information, see "Setting Image Properties" below and "Layout Tab" on page 245. 

To toggle display of all image borders: 

1. Select Image Borders from the View menu. 

2. Select Show All from the cascade menu to show the borders on all the images. 

Or, 

Select Hide All from the cascade menu to hide the borders on all the images. 

Displaying Image Titles 
You can display an image title for each of the images. 
On the properties for an image, you can specify whether you want to display its title. For more information, see "Setting Image 
Properties" below. 

To toggle display of all image titles: 

1. Select Image Titles from the View menu. 

2. Select Show All from the cascade menu to show the titles for all the images. 

Or, 

Select Hide All from the cascade menu to hide the titles for all the images. 

Setting Image Properties 
By setting image properties, you can specify the following information: 

• Layout options for formatting the image 

• Image source and title 

• Options for displaying a tracing on the image 
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To set image properties: 

1. Right-click the image, and select Properties from the pop-up menu. 

Or, 

Double-click the image. 

2. Click a tab, and set any options on that tab. 

3. When you finish setting properties, click Close. 

Layout Tab 
On this tab, you can view and set options that determine the formatting of the image. 

 

 

 

Dimensions group 
box 

Indicates the current position, height, and 
width of the image. 
X: The horizontal distance, in inches, from 
the left side of the image to the left side of 
the page. 
Y: The vertical distance, in inches, from the 
top of the image to the top of the page. 
Width: The width of the image in inches. 
Height: The height of the image in inches. 

Display group box Specify the following options for displaying 
this image: 
Print 1:1: Check this box to display the 
image according to its resolution. 
Show Border: Check this box to display a 
border around the image. 
Border Color: Click the color sample to 
select the color of the image border. 
Width: Specify the width of the border in 
millimeters (mm). 
Show Image Title: Check this box to 
display the title of the image. You can 
customize this title on the Image tab (see 
below). 
Show “image (not) to scale” label: 
Check this box to display "Image drawn to 
size" on images using the Print 1:1 option 
and "Image not drawn to size" on images 
that don't use the Print 1:1 option. 
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Image Tab 
On this tab, you can set the image source and customize the image title. 

Image Source 
group box 

Specify the source of the image. 
Dolphin 2D: Select this option and choose an 
image from the drop-down list box to load that 
image from Dolphin 2D into this image 
placeholder. 
Rename: Click this button to change this 
image slot's name. 
Show All: Check this box to include all 
Dolphin 2D image slots in the drop-down list 
box. Otherwise, the drop-down list box only 
includes the images that are actually available 
for this patient.  
Load 2D image from timepoint: Select the 
timepoint for the image from this drop-down list 
box. 
From File: Select this option and click 
Browse... to choose an image file from your 
computer (such as a logo) to load into this 
image placeholder.  

Image Title Enter a custom title to use instead of the title 
embedded in the image. 

 

 

 

 

To rename the image slot: 

1. On the Image tab, click Rename. 

2. Enter a new name for the image slot. Then, click OK. 
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Tracing Tab 
On this tab, you can set options for displaying a tracing on the image. 

 

To set font options: 

1. Click the button labeled ... next to the Font field. 

The Font dialog box opens. 

2. Set any font options. 

3. Click OK. 

Analysis group 
box 

Select the analysis for which you want to set 
tracing preferences from the Selected Analysis 
drop-down list box.  

Display group box Set options for each item you want to display on 
the tracing. 
Show Image: Check this box to display the 
image along with the tracing. 
Show Lines/Curves: Check this box to display 
the tracing as defined in the patient’s 
cephalometric analysis. 
Show Tooth Templates: Check this box to 
display the templates for the patient’s teeth. 
Show Add’l Ceph Structures: Check this box 
to display the cephalometric structures. 
Color Samples: Click these boxes to change 
the color in which the associated element is 
displayed.  
Tracing line width (mm): Enter the width in 
millimeters (mm) for the tracing lines. 

Measurements 
group box 

Set options for displaying measurements on the 
tracing: 
Show Measurements: Check this box to display 
measurement numbers as defined in the 
patient’s cephalometric analysis. 
Font: Displays the font selected for the 
measurement numbers. Click the button labeled 
... to open the Font dialog box and change the 
font (see below). 
Font Size: Select the font size for the 
measurement numbers. 
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Font Select the font face. 

Font Style Select the font style. 

Size Select the font size. 

Strikeout Check this box to apply the strikeout effect. 

Underline Check this box to underline the text. 

Sample Displays a preview of your chosen settings. 

Script Select the script type. 
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Using Text Labels 
With text labels, you can add static text to your layout and you can pull in data from the current patient's record, such as the 
patient's name and age. You can also add other variable information such as a print date. 

To add a text label: 

1. Click . 

Or, 

Select Label from the Insert menu. 

Or, 

Right-click the layout, and select Add Label from the pop-up menu. 

Your cursor changes to a label-drawing icon ( ). 

2. Click and drag to draw a text label placeholder of the size you want. 

3. Double-click the text label placeholder. 

Or, 

Right-click the text label placeholder, and select Properties from the pop-up menu. 

The Properties dialog box opens. 

4. (Optional) Enter any static text you want to appear for this label in the Edit Text box. 

5. (Optional) In the Edit Text box, place the cursor where you want to insert data from the patient record or other variable 
information (such as the date). Then, select a data field from the Data Field drop-down list box, and click Insert at 
cursor to insert that data field at the current cursor location. 

The Preview box shows the text that will appear for this text label when the selected data fields are replaced with the 
appropriate data. 

Note: If one or more data fields in a label reference data in a patient's record (such as the patient's name, age, or 
doctor) or data specific to a particular image (such as the image title or analysis), you need to link the label to a patient 
image so that the data fields can be replaced by the appropriate information. For more information, see “Linking Labels 
to an Image” on page 253. 

6. Set any other properties for the text label. Then, click Close. 
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Dimensions 
group box 

Indicates the current position, 
height, and width of the text 
label. 
X: Enter the horizontal distance, 
in inches, from the left side of the 
text label to the left side of the 
page. 
Y: Enter the vertical distance, in 
inches, from the top of the text 
label to the top of the page. 
Width: Enter the width of the text 
label in inches. 
Height: Enter the height of the 
text label in inches. 

Alignment 
group box 

Click the button for the location 
that you want the text label to 
appear within its placeholder. 

Font group 
box 

Specify the font for the text label. 
Text box: Displays the font 
selected for the text label. 
...: Click this button to open the 
Font dialog box and change the 
font (see below). 
spinner: Select the font size. 
Color: Click the color sample to 
select the color of the text. 
Bold: Check this box to use 
boldface for the text label. 
Italic: Check this box to use 
italics for the text label. 
Underline: Check this box to use 
underlining for the text label. 
Strikeout: Check this box to use 
a strikeout effect for the text 
label. 

 
 
 

Border group 
box 

Specify options for placing a border around the text label. 
Show Border: Check this box to display a border around the text label. 
Border Color: Click the color sample to select the color of the text label border. 
Width: Specify the width of the border in millimeters (mm). 

Background 
group box 

Specify options for using a background color to set off the label.  
Show Background: Check this box to use a background color.  
Color: Click the color sample to select the color to use. 
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Edit Text group 
box 

Specify the text you want for this text label. 
Text Box: Enter the text for this label. 
Data Field: Select a data field from this drop-down list box to insert data from the patient record or 
other variable data. 
Insert at cursor: Click this button to insert the selected data field at the current cursor location in 
the text box. 
Preview: Shows a preview of the text that will appear for this text label when the data fields are 
replaced with the appropriate data. 

To set font options: 

1. Click the button labeled ... next to the Font field. 

The Font dialog box opens. 

2. Set any font options. 

3. Click OK. 

 
Font Select the font face. 

Font Style Select the font style. 

Size Select the font size. 

Strikeout Check this box to apply the strikeout effect. 

Underline Check this box to underline the text. 

Sample Displays a preview of your chosen settings. 

Script Select the script type. 
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To toggle display of all text labels: 

1. Select Show Labels from the View menu to show all the text labels. 

Or, 

Select Hide Labels from the View menu to hide all the text labels. 

Hiding labels is useful, for example, to hide patient information for privacy reasons. 

To set the horizontal alignment of the text in a label placeholder: 

1. Right-click the text label. 

2. Select Horizontal Alignment from the pop-up menu. 

3. Select Left from the cascade menu to align the text to the left. 

Or, 

Select Center from the cascade menu to align the text in the center. 

Or, 

Select Right from the cascade menu to align the text to the right. 

To set the vertical alignment of the text in a label placeholder: 

1. Right-click the text label. 

2. Select Vertical Alignment from the pop-up menu. 

3. Select Top from the cascade menu to align the text on the top. 

Or, 

Select Center from the cascade menu to align the text in the center. 

Or, 

Select Bottom from the cascade menu to align the text on the bottom. 
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Linking Labels to an Image 
If one or more data fields in a label reference data in a patient's record (such as the patient's name, age, or doctor) or data 
specific to a particular image (such as the image title or analysis), you need to link the label to a patient image so that the data 
fields can be replaced by the appropriate information. You can link more than one text label to a particular image in a single step.  

To link one or more text labels to an image: 

1. Click an object that you want to link. Then, hold down the CTRL key while clicking other objects to select them as well. 

You can select several text labels, but only one image. 

Note: If you select a label that is already linked to an image, the existing link will be replaced by the new link you are 
creating.  

2. Select Link Labels to Image from the Tools menu. 

A line appears between each text label and the image. 

 

To remove the link between one or more text labels and an image: 

1. Click a text label that you want to unlink.  

2. Optionally, hold down the CTRL key while clicking other text labels to select them as well. 

3. Select Unlink Labels from Image from the Tools menu. 
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Using Annotations 
With annotations, you can add lines, arrows, ellipses, and rectangles to your layout. You can also add text labels as described in 
"Using Text Labels." 
 

To add a line: 

1. Click . Then, select Line from the pop-up menu. 

Your cursor changes to a drawing icon ( ). 

2. Click and drag to draw the line. 

You can set the line's color, thickness, or style (solid, dashed, or dashed-dotted) by setting its properties. For more 
information, see "Setting Image Properties" on page 244. 

To make the line horizontal or vertical and lock it that way: 

1. Right-click the line, and select Lock Orientation from the pop-up menu. 

2. Select Horizontal from the cascade menu to lock the line in a horizontal orientation. 

Or, 

Select Vertical from the cascade menu to lock the line in a vertical orientation. 

At this point, you can move the line and it will stay in its locked orientation. 

To add an arrow: 

1. Click . Then, select Arrow from the pop-up menu. 

Your cursor changes to a drawing icon ( ). 

2. Click and drag to draw the arrow. 

You can set the arrow's color, thickness, style (solid, dashed, or dashed-dotted), and arrowhead characteristics by 
setting its properties. For more information, see "Setting Image Properties" on page 244. 
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To make the arrow horizontal or vertical and lock it that way: 

1. Right-click the arrow, and select Lock Orientation from the pop-up menu. 

2. Select Horizontal from the cascade menu to lock the arrow in a horizontal orientation. 

Or, 

Select Vertical from the cascade menu to lock the arrow in a vertical orientation. 

At this point, you can move the arrow and it will stay in its locked orientation. 

To add an ellipse: 

1. Click . Then, select Ellipse from the pop-up menu. 

Your cursor changes to a drawing icon ( ). 

2. Click and drag to draw the ellipse. 

You can set the ellipse's line color, thickness, or style (solid, dashed, or dashed-dotted) by setting its properties. For 
more information, see "Setting Image Properties"on page 244. 

To add a rectangle: 

1. Click . Then, select Rectangle from the pop-up menu. 

Your cursor changes to a drawing icon ( ). 

2. Click and drag to draw the rectangle. 

You can set the rectangle's line color, thickness, or style (solid, dashed, or dashed-dotted) by setting its properties. For 
more information, see "Setting Image Properties" on page 244. 

To change the shape of an annotation:  

1. Right-click the annotation. 

2. Select Shape from the pop-up menu. Then, select the shape you want from the cascade menu. 

You can also change an annotation's shape by setting its properties (see below). 
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Setting Annotation Properties 
Once you have drawn a line, arrow, ellipse, or rectangle, you can set its properties to specify the line color, thickness, or style 
(solid, dashed, or dashed-dotted). In the case of arrows, you also can set the arrowhead characteristics. 

To set annotation properties: 

1. Double-click the annotation. 

The Properties dialog box opens. 

2. Set any properties for the annotation. Then, click Close. 

Shape group box Specify the annotation shape (line, arrow, 
ellipse, or rectangle). 

Line Settings 
group box 

Specify options for the line or lines used to 
draw the annotation. 
Color: Click the color sample to select the 
color. 
Thickness: Specify the width of the line or 
lines in millimeters (mm). 
Line Style: Specify the line style (solid, 
dashed, or dashed-dotted). 

Arrow Settings 
group box 

Specify arrowhead characteristics. These 
options are only available for arrows. 
Head Width: Specify the width of the 
arrowhead in millimeters (mm). 
Head Length: Specify the length of the 
arrowhead in millimeters (mm). 
Filled: Select this option for a solid 
arrowhead. 
Outline: Select this option for an arrowhead 
outline. 
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Resizing Objects 
To resize a single object, you can click and drag its resizing handles as described below, or you can set its properties (see 
"Using Text Labels" on page 249 and "Setting Image Properties" on page 244.).  You also can set several objects to be the same 
size. 

Using the Resizing Handles 

To resize an object using the resizing handles: 

1. Click and drag one of the resizing handles to resize the object. 

When you place your mouse pointer over a resizing handle, the pointer turns into a double-headed arrow. The figure 
below illustrates the resizing handles.  

 
Note: You can also use the object properties to specify the size of an object. For more information, see "Using Text Labels" on 
page 249 and "Setting Image Properties” on page 244.  

Making Several Objects the Same Size 

To make several objects the same size: 

1. Click one of the objects that you want to resize.  

2. Hold down the CTRL key while clicking the other objects that you want to resize. 

Select the object to which you want to resize the other objects first. The objects you subsequently select will be resized 
to match the object you selected first. 

3. Click  to make the objects the same width. 

Or, 

Select Make Same Size from the Format menu. Then, select Width from the cascade menu to make the objects the 
same width.  

Or, 
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Click  to make the objects the same height. 

Or, 

Select Make Same Size from the Format menu. Then, select Height from the cascade menu to make the objects the 
same height.  

Or, 

Click  to make the objects the same width and height. 

Or, 

Select Make Same Size from the Format menu. Then, select Both from the cascade menu to make the objects the 
same width and height.  

Repositioning Objects 
To reposition objects, you can click and drag them, align them with each other, or center them on the page. You can reposition a 
single object by clicking and dragging or by setting its properties (see "Using Text Labels" on page 249 and "Setting Image 
Properties" on page 244).  
You also can change the layering of objects to control how they overlap. 

Clicking and Dragging Objects 

To move a single object: 

1. Click and drag the object to a new position. 

Note: You can also use the object properties to specify the location of an object. For more information, see "Using Text Labels"  
on page 249 and "Setting Image Properties” on page 244.  

To move several objects: 

1. Click one of the objects that you want to move. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects in this layout. 

2. Click and drag the objects to a new position. 
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Aligning Objects 
You can align several objects with each other or with the page margins. 

To align two or more objects: 

1. Click one of the objects that you want to align.  

2. Hold down the CTRL key while clicking the other objects that you want to align. 

Select the object to which you want to align the other objects first.  

3. Click  to align the left sides of the objects. 

Or, 

Select Align from the Format menu. Then, select Left from the cascade menu to align the left sides of the objects.  

Or, 

Click  to align the right sides of the objects. 

Or, 

Select Align from the Format menu. Then, select Right from the cascade menu to align the right sides of the objects.  

Or, 

Click  to align the tops of the objects. 

Or, 

Select Align from the Format menu. Then, select Top from the cascade menu to align the tops of the objects.   

Or, 

Click  to align the bottoms of the objects. 

Or, 

Select Align from the Format menu. Then, select Bottom from the cascade menu to align the bottoms of the objects.   

To align the objects to that page margin: 

1. Click the object that you want to align to the page margin.  

2. Optionally, hold down the CTRL key while clicking the other objects that you want move when aligning the first-
selected object to the page margin. 

If you select more than one object, the objects retain their placement relative to each other when the object selected 
first is aligned to the margin.  
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3. Select Snap To from the Format menu.  

4. Select Margin, then select Left, Right, Top, or Bottom to align to that page margin.   

Or, 

Select Printer Hard Margin. Then, select Left, Right, Top, or Bottom to align to that printer hard margin.   

If you have specified a printer on the page setup dialog box, the hard margins specify how close to the paper edge the 
specified printer can print. Otherwise, the hard margins are at the paper edges. 

Centering Objects 
You can center one or more objects horizontally or vertically. 

To center objects: 

1. Click an object that you want to center. 

Or, 

Click an object that you want to center. Then, hold down the CTRL key while clicking other objects to select them as 
well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Select Center from the Format menu. 

3. Select Horizontally from the cascade menu to center horizontally. 

Or, 

Select Vertically from the cascade menu to center vertically. 

Changing Object Spacing 
You can change the spacing of objects either horizontally or vertically. 

To change the horizontal spacing of several objects: 

1. Click and drag to select several adjacent objects. 

Or, 

Click one of the objects that you want to select. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Select Horizontal Spacing from the Format menu. 
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3. Select Make Equal to space the selected objects evenly. 

Or, 

Select Increase to increase the space between the selected objects. 

Or, 

Select Decrease to decrease the space between the selected objects. 

Or, 

Select Remove to remove the space between the selected objects, making them flush with each other. 

To change the vertical spacing of several objects: 

1. Click and drag to select several adjacent objects. 

Or, 

Click one of the objects that you want to select. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Select Vertical Spacing from the Format menu. 

3. Select Make Equal to space the selected objects evenly. 

Or, 

Select Increase to increase the space between the selected objects. 

Or, 

Select Decrease to decrease the space between the selected objects. 

Or, 

Select Remove to remove the space between the selected objects, making them flush with each other. 

Changing Object Layering 
You can change the layering of objects to control how they overlap. 

To change the layering of objects: 

1. Click the object that you want to move to the front or back. 

2. Select Order from the Format menu. 

3. Select Bring to Front from the cascade menu to bring the selected object to the front. 

Or, 

Select Send to Back to send the selected object to the back. 
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Deleting Objects 
You can delete a single object, or you can delete several objects simultaneously. 

To delete a single object: 

1. Click an object, and click . 

Or, 

Right-click an object, and select Delete from the pop-up menu to delete it. 

Or, 

Click an object to select it. Then, press DEL on your keyboard. 

Or, 

Click an object to select it. Then, select Delete from the Edit menu. 

A dialog box opens asking you to confirm the deletion. 

2. Click Yes to delete the object. 

To delete several objects: 

1. Click and drag to select several adjacent objects. 

Or, 

Click one of the objects that you want to select. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Click . 

Or, 

Select Delete from the Edit menu.. 

Or, 

Press DEL on your keyboard. 

A dialog box opens asking you to confirm the deletion. 

3. Click Yes to delete the selected objects. 
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Cutting, Copying, and Pasting Objects 
You can cut or copy one or more objects to the clipboard. Then, you can paste them elsewhere in your design. 

To cut or copy objects to the clipboard: 

1. Click an object to select it. 

Or, 

Click and drag to select several adjacent objects. 

Or, 

Click one of the objects that you want to select. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Select Cut from the Edit menu to cut the objects to the clipboard, removing them from their present locations. 

Or, 

Select Copy from the Edit menu to copy the objects to the clipboard, leaving them in their present locations. 

To paste objects from the clipboard: 

1. Select Paste from the Edit menu to paste the objects from the clipboard into the current location. 

Using Object Groups 
Grouping objects enables you to combine several objects into a single object. Then, you can use the objects in the group as a 
unit, or save the object group for later reuse. 

To group several objects: 

1. Click and drag to select several adjacent objects. 

Or, 

Click one of the objects that you want to select. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Select Group Objects from the Group menu. 
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To ungroup the objects in an object group: 

1. Click one of the objects in the object group to select the group. 

2. Select Ungroup Objects from the Group menu. 

To save an object group for later reuse: 

1. Click one of the objects in the object group to select the group. 

2. Select Save Group As... from the Group menu. 

The Save Group As dialog box opens. 

3. Enter a name for this object group in the Group name text box. 

Or, 

Select an object group from the Existing Groups list box to overwrite an existing object group. 

4. Click Save. 

5. If you are overwriting an existing group, click Yes on the confirmation dialog box that appears. 

 

Existing Groups Select an object group from this list box to overwrite or delete an existing object group. 

Delete Click this button to delete the object group selected in the Existing Groups list box. 

Group name Enter a name in this text box to save this object group under a new name. 

Save Click this button to save the object group. 
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To insert a previously-saved object group into your design: 

1. Select Insert Group from the Groups menu.  

Or, 

Select Group from the Insert menu. 

2. Select the object group you want to insert from the cascade menu. 

To delete a previously-saved object group: 

1. Click an object group. 

2. Select Save Group As... from the Group menu. 

The Save Group As dialog box opens. 

3. Select the object group you want to delete from the Existing Groups list box. 

4. Click Delete. 

Locking and Unlocking Objects 
Locking objects prevents them from being moved or resized, avoiding accidental misalignment of images. You can still change a 
locked object's properties.  

To lock one or more objects: 

1. Click an unlocked object to select it. 

Or, 

Click and drag to select several adjacent unlocked objects. 

Or, 

Click one of the unlocked objects that you want to select. Then, hold down the CTRL key while clicking other unlocked 
objects to select them as well. 

2. Click . 

Or, 

Right-click and select Locked from the pop-up menu. 

To unlock one or more objects: 

1. Click a locked object to select it. 

Or, 

Click and drag to select several adjacent locked objects. 

Or, 
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Click one of the locked objects that you want to select. Then, hold down the CTRL key while clicking other locked 
objects to select them as well. 

When you select a locked object, the tool bar button has a blue outline as follows: . 

2. Click . 

Or, 

Right-click and select Locked from the pop-up menu. 

Printing Layouts 

To print a layout: 

1. Click . 

Or, 

Select Print from the File menu.  

The Print dialog box is displayed. 

2. Select any printing options you want, and click OK. 

If your layout has multiple pages, you can suppress printing of one or more of them. 

To suppress printing of a page: 

1. Right-click the page you want to suppress in the page gallery. 

2. Select Exclude Page from Printout from the pop-up menu. 

The  icon appears on the page to indicate that the page will not print when you print the layout. 

To remove printing suppression for a page: 

1. Right-click a page with a  icon.  

2. Select Include Page in Printout from the pop-up menu. 
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Part IV: Consultation and Image Library 
This part of the Dolphin Imaging User’s Guide provides detailed information on using the Consultation and Image Library Dolphin 
Imaging module. This module includes user-friendly tools to quickly and clearly convey your treatment recommendations to the 
patient to gain the patient’s understanding. 
This part of the Dolphin Imaging User’s Guide describes: 

• Editing images using cut and paste 

• Modifying images using touch-up brushes 

• Click-and-drag image morphing 

• Using the Image Library 
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8 Image Edit 
You can use the edit function to modify any image. Some of the tasks that you can perform with the edit function are: 

• Cutting and pasting selected areas of an image. 

• Moving, flipping, stretching, and rotating selected areas of the image. 

• Drawing, roughing, and blending colors on the image. 

• Morphing selected areas of the image. 

• Replacing a patient’s original smile with a smile from the image library to show after treatment results or show the 
patient’s appearance with a variety of appliances. 

Understanding the Edit Dialog Box 
Before you access the Edit dialog box, you need to: 

• Select a patient using the Patient Charts or Patient Lookup dialog box, as described in Chapter 4.  

• Select an image on the Dolphin Imaging main screen, which is described in Chapter 3.  

Then, you can access the Edit dialog box by clicking  on the Dolphin Imaging main screen’s vertical tool 
bar. Alternatively, you can select Edit from the Tools menu. 
The following figure illustrates the Edit dialog box: 
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Patient summary Provides the name and ID of the selected patient.  

Tool Bar Provides buttons for accessing image editing tools (see below). 

Palette Provides tools for modifying the image. The palette’s appearance depends on the editing tool you are 
using. 

Zoom and align 
tool bar 

Provides tools for zooming in, zooming out, and aligning the image in the window. For more 
information, see "To maximize an image"  on page 35. 
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Using the Edit Tool Bar 
The Edit Tool Bar contains the following buttons: 

 
Opens the Cut tool. For more information, see "Using the Cut Palette" on page 274. 

 
Opens the Morph tool. For more information, see "Using the Morph Palette" on page 277. 

 
Opens the Brushes tool. For more information, see "Using the Brushes Palette" on page 281. 

 
Opens the Image Library. For more information, see "Using the Image Library" on page 283. 

 
Opens the ImPlanner feature. For more information, see Chapter 23.. 

 
Displays the modified image side-by-side with the original image. For more information, see "Viewing Two Images 
Side by Side" on page 272. 

 
Opens the original records window. For more information, see "To view the patient's other images in an Original 
Records Window" on page 412. 

 
Toggles the display of the patient’s tracing. 

 
Opens the Enhance tool. For more information, see "To enhance a picture" on page 164. 

 
Sets display preferences. For more information, see "To set general preferences" on page 75. 

 
Opens the measurements table. For more information, see Chapter 12. 

 
Undoes the previous operation. 

 
Saves the image. For more information, see "Saving a Modified Image," below. 

 
Prints the image. For more information, see "Printing" on page 224. 

 Copies the image and/or its tracings to the clipboard. 

Saving a Modified Image 

To save a modified image: 

1. Click on the tool bar. 

The Save Image dialog box is displayed. 

2. Enter an image title. 

3. Select a slot from the Save As list box in which to save this image, and click OK. 

Note: If you are viewing two images side by side when you save, the side-by-side view of the two images is saved. 
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Image Title Enter a title for this image, up to 25 characters. 

New Notes Optionally enter any notes for this image. 

Into Slot Select one of the slots available for each timepoint in which to save this image.  
A message below this list box indicates whether the selected slot already contains an image. If you select a 
slot containing an image, the existing image is overwritten with the new image. 

Current Slot 
Notes 

If you select a slot that already contains an image, the notes previously entered for that slot appear in this text 
box. 
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Viewing Two Images Side by Side 

To view the modified image side-by-side with the original image: 

1. Click  on the tool bar. 

The Side-by-Side Compare dialog box is displayed: 

 
2. Select the amount of the images you want to show. 

If you picked Full, the two images are displayed side-by-side in the Edit dialog box. 

If you picked 1/2... or 2/3..., a rectangle appears on the Edit dialog box so that you can select the half or two-thirds of 
the images you want to view, as shown in the first figure below. 

3. If you picked 1/2... or 2/3..., click and drag the rectangle to select the part of the images you want to view. Click the left 
mouse button again to view the two images side-by-side. 

The images appear side by side as shown in the second figure below. If you click Save at this point, the side-by-side 
images are saved. For more information on saving edited images, see "Saving a Modified Image" on page 270. 

4. When you finish viewing the images side-by-side, click the image again. 

The original image disappears, and only the image you are editing is displayed. 
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Using the Cut Palette 
Using the Cut palette, you can cut and paste areas of the image. You can also select an area of the 
image and move it, rotate it, stretch it, or flip it. 

Arrow buttons Once you have created a polygon for the image (see below), you can click 
these buttons to move the selection.  

 

 

Selecting an Area of an Image 

To select an area (creating a polygon): 
1. Click the left mouse button on a point where you want to begin drawing the polygon. 

2. Release the mouse button and move the mouse to begin drawing the polygon. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position. 

3. Click the mouse button whenever you want to place a point and change the direction of the line. 

If you make a mistake, click the right mouse button to undo the line to the last point you placed. 

4. To complete the polygon, click the left mouse button again on the first point to close the polygon. 

Alternatively, you can hold down the left mouse button and drag the mouse to draw the polygon without placing points. 
Using this method, you may be able create a smoother polygon, although you may find it more difficult to draw. In 
addition, undoing is more cumbersome, since this method effectively creates many points and lines in the polygon. 

When you finish drawing the polygon, a rectangle appears enclosing it. In addition, the push pin appears at one corner 
of the rectangle. The figure below illustrates the rectangle and push pin. 

 
At this point, you can make changes to the area inside the polygon. The effects of your changes vary depending on whether the 
push pin is out (as illustrated above) or in.  
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Moving and Placing the Push Pin 

To move the push pin and place it:  
1. Click and drag the push pin to the location where you want to place it.  

2. Click the push pin to push it in.  

Making Changes with the Push Pin Out 
With the push pin out, you can make the types of changes described below. 

To move the area inside the polygon:  
1. Click anywhere inside the rectangle and drag the contents to the new location. 

To stretch both sides of the area inside the polygon: 

1. Move the mouse to the middle 1/3 of any side of the rectangle. 

The mouse pointer changes to a double-headed arrow.  

2. Click and drag the rectangle to stretch the image inside the polygon.  

To stretch the area inside the polygon in four directions: 
1. Move the mouse to a corner of the rectangle. 

The mouse pointer changes into a double-headed arrow. 

2. Click and drag the rectangle to stretch the image inside the polygon in four directions. 

The polygon only stretches equally in all four directions if you drag the mouse at a 45º angle. If you drag the mouse at 
a steeper angle, the polygon stretches more in height. If you drag the mouse at a shallower angle, the polygon 
stretches more in length. 

To flip the area inside the polygon: 

1. Move the mouse near one corner of the rectangle until the mouse pointer changes into a flip symbol. 

To flip the area inside the polygon vertically, place the mouse pointer along the top of the rectangle. To flip the area 
inside the polygon horizontally, place the mouse pointer along one side of the rectangle. 

2. Click to flip the image inside the polygon. 
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Making Changes with the Push Pin In 
With the push pin in, you can make the types of changes described below. 

To rotate the area inside the polygon around the push pin: 

1. Click anywhere inside the rectangle and drag the contents around the push pin. 

The area inside the polygon moves as illustrated below. 

 

To stretch one side of the area inside the polygon: 

1. Move the mouse to the middle 1/3 of any side of the rectangle. 

The mouse pointer changes to a double-headed arrow.  

2. Click and drag the rectangle to stretch the image inside the polygon.  

To stretch the area inside the polygon proportionally in two directions: 

1. Move the mouse to a corner of the rectangle. 

The mouse pointer changes into a double-headed arrow. 

2. Click and drag the rectangle to stretch the image inside the polygon in two directions. 

The polygon only stretches equally in two directions if you drag the mouse at a 45º angle. If you drag the mouse at a 
steeper angle, the polygon stretches more in height. If you drag the mouse at a shallower angle, the polygon stretches 
more in length. 
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Using the Morph Palette 
Using the Morph palette, you can creatively warp and stretch parts of an image. Morph is an excellent tool to quickly change an 
image for communicating treatment goals with patients. This is also an excellent tool for fine-tuning the soft tissue profile contour 
and touching up image enhancements.  

Point Morph Select this option to morph the image from a single point. 

Curve Morph  Select this option to morph the image based on control points 
along a curve. 
Redefine Curve: Click this button to redefine a morph curve. 

Define Boundary 
  

Select this option to morph the image only within a defined 
boundary. Using this option gives you more precise control and 
speeds up processing of the changes. 
Use: Check this box to use a previously-defined boundary. 

Undo Click this button to undo the last morph operation. 

Redo Click this button to redo the last undo operation. 

Undo All Click this button to undo all morph operations. 

Preview Check this check box to hide the morph curve. 

Note: After you morph an image, you may want to display the before and after images side-by-side. For more information, see 
"Viewing Two Images Side by Side" on page 272. 

Using Point Morph 

To use Point Morph: 
1. Select Point Morph on the Morph palette. 

2. Click and drag an area of the image using the mouse. 

As you drag the mouse, the area affected by the morph operation increases. To morph only a small section of the 
image, click and drag a small distance. Then, click and drag again. 

Note: Using Point Morph in conjunction with a morph boundary gives you greater control over the changes to the 
image and also saves time by speeding up the processing of your changes. 
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Using Curve Morph 

To use Curve Morph: 

1. Select Curve Morph on the Morph palette. 

2. Define the morph curve. 

There are two ways to define the morph curve: 

� You can click and hold the left mouse button while moving the mouse to draw the curve. When you finish drawing 
the curve, release the mouse button. 

� You can click and release the left mouse button on a point where you want to begin the morph curve. Then, move 
the mouse to draw the curve. As you move the mouse, you’ll see a line extending from the point to the current 
mouse position. Click the mouse button whenever you want to place a point and change the direction of the curve. 
To complete the morph curve, double-click the left mouse button, or click the last point you placed again. 

Although the first method of drawing may be faster, the second method gives you more precision on where the control 
points are placed along the curve. You use these control points to change the image along the morph curve. 

The figure below illustrates the morph curve and indicates some of the control points along the curve: 
. 

 
If you make a mistake, click the right mouse button to undo to the last point you placed. If you want to start over, click 
Redefine Curve. If you click Redefine Curve after you have morphed the image using the curve, a dialog box appears 
asking whether you want to keep the changes you’ve made to the image. Click Yes to keep the changes and define a 
new curve, or click No to discard the changes. 

3. Click and drag any control point on the morph curve to morph the image. 

When the mouse is over one of the points, a circle appears around that point. When you move the point, the image 
changes to conform to the curve’s new shape, as shown below: 
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4. Optionally, check the Preview box to view the results of morphing by hiding the morph curve.  

To continue morphing, uncheck the Preview box. 

Morphing Within a Boundary 

To define a boundary and morph within that boundary: 

1. Select Define Boundary on the Morph palette. 

2. Click the left mouse button on a point where you want to begin drawing the boundary. 

3. Release the mouse button and move the mouse to begin drawing the boundary. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position.  

4. Click the mouse button whenever you want to place a point and change the direction of the line. 

5. To complete the boundary, click the left mouse button again on the first point to close the boundary. 

The following figure illustrates a completed morph boundary. 

 

If you make a mistake, click the right mouse button to undo the line to the last point you placed. If you want to start 
over again, click Remove. 
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When you complete the boundary, the Use box is automatically checked so you can begin morphing within the 
boundary. 

6. Select either Point Morph or Curve Morph to determine how you want to morph the image within the boundary.  

For more information, see "Using Point Morph" on page 277 and "Using Curve Morph" on page 278. 

7. Morph the image. 

Only that part of the picture that is within the boundary changes, as shown below. 

 

Undoing Your Changes 

To undo your morphing changes: 

1. Click Undo to undo your last change. 

Or, 

Click Undo All to undo all the changes you’ve made. 

If you change your mind after clicking Undo or Undo All, click Redo to reinstate your changes. 
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Using the Brushes Palette 
Using the Brushes palette, you can "paint" on the image. The Brushes palette provides brushes to paint colors on the image, 
rough up colors, or blend colors.   

  Select this brush to select the colors under the brush position and 
paint with them.  

  Select this brush to blend colors and edges. 

  Select this brush to rough up the colors.  

 Select this brush to draw with the currently-selected color.  

 Click this button to pick a color from the image to use for painting 

Color 
Sample 

Click the color sample to pick a standard color or define a custom 
color. 

  
Select this button to undo the latest changes to the image. 

  
Select this button to redo a previous undo operation. 

Size Size of the brush. All brushes default to the largest size. 

Opacity The level of opacity in the drawn line (high, medium, or low). By default, this attribute is set to the lowest level. 

To use a brush: 
1. Click the brush you want to use on the palette. 

2. Select any attributes for that brush. 

3. Click and drag on the image to apply the brush. 

To pick a color from the image to use for painting: 

1. Click on the Brushes palette. 

2. Click a point on the image containing the color with which you want to draw. 

The color you picked appears in the color sample. 
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To pick a basic or custom color to use for painting: 

1. Click the color sample on the palette. 

The Color dialog box is displayed. 

2. Click one of the basic colors using the samples on the left side of the dialog box. 

Or, 

Select a custom color using the tools on the right side of the dialog box. Then, click Add to Custom Colors. 

3. Click OK. 

The color you picked appears next to the Draw Color on the palette. 
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Using the Image Library 
Using the Image Library, you can replace a patient’s smile with one selected from an image library to show after treatment 
results or the patient’s appearance with a variety of appliances. To access the image library, you use the Image Library palette, 
shown below. 
Note: After you replace a patient’s smile with an image from the image library, you may want to display the before and after 
images side-by-side. For more information, see "Viewing Two Images Side by Side" on page 272. 
  

Get Image... Click this button to get an image from the image library. 

Add to Library... Click this button to add an image or category of images to the image 
library. 

Rename... Click this button to rename an image in the image library. 

Delete... Click this button to delete an image or image category from the image 
library. 

Arrow buttons Once you have added an image from the image library, you can click these 
buttons to move that image.  

Restart Click this button to undo the last operation 

Cntr After selecting an area of the image, move this slider to adjust the contrast 
of the selected area.  

Int After selecting an area of the image, move this slider to adjust the 
intensity of the selected area.  

Blur After selecting an area of the image, move this slider to adjust the 
blurriness of the selected area.  

Sat After selecting an area of the image, move this slider to adjust the color 
saturation of the selected area.  
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Replacing a Patient's Smile 

To replace a patient’s smile with an image from the image library: 

1. Draw a polygon around the patient’s teeth. 

To draw the polygon, click the left mouse button on a point where you want to begin drawing. Release the mouse 
button and move the mouse to begin drawing the polygon. As you move the mouse, you’ll see a line extending from 
the point to the current mouse position. Click the mouse button whenever you want to place a point and change the 
direction of the line. To complete the polygon, click the left mouse button again on the first point to close the polygon. 
The figure below illustrates the polygon. 

 
If you make a mistake, click the right mouse button to undo the line to the last point you placed. 

2. Select on the Edit dialog box to access the Image Library Tool. 

3. Click Get Image. 

The Get Image dialog box is displayed. 
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Category Select the category of the image you want to use from this drop-down list box. 

Name Select the name of the image you want to use from this list box. 

4. Select the category of the image you want to use from the Category drop-down list box. 

5. Select the name of the image you want to use from the Name list box. 

6. Click OK. 

The image you picked appears within the polygon as shown below.  

 
7. Reposition the image, if necessary, by clicking and dragging it with the mouse, by using the arrow keys, or by using the 

arrow buttons on the palette. 

Once the image is placed properly, you may want to use the Brushes tool to make the image look more natural. You 
might also want to use the Side-by-Side feature to compare the modified image with the original image. 
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Maintaining the Library 

To view the image library: 

1. On the Dolphin Imaging main screen, select Image Library from the Tools menu. 

The Image Library Presenter dialog box appears, as shown below. 

2. Select the category of images you want to view from the Category drop-down list box. 

3. Select any image in the category to see a close-up view of that image. 

4. Click Close to close this dialog box. 

 

To add an image to the Image Library using the Edit dialog box: 

1. Select the image you want to add to the image library from the Dolphin Imaging main screen. 

Usually, you will want to use the intra-oral center picture. 

2. Click Edit to access the Edit dialog box. 

3. Select on the Edit dialog box to access the Image Library Tool. 



8 Image Edit Part IV: Consultation and Image Library 

DI_USER_GUIDE-11.5   Rev. 1.01 287 

4. Draw a polygon around the patient’s teeth. 

To draw the polygon, click the left mouse button on a point where you want to begin drawing. Release the mouse 
button and move the mouse to begin drawing the polygon. As you move the mouse, you’ll see a line extending from 
the point to the current mouse position. Click the mouse button whenever you want to place a point and change the 
direction of the line. To complete the polygon, click the left mouse button again on the first point to close the polygon. 

If you make a mistake, click the right mouse button to undo the line to the last point you placed. 

5. Click Add to Library. 

The Image Library: Add dialog box is displayed: 

6. Select the category to which you want to add this image from the Category list box. 

7. Type an image name in the Name text box, and click OK. 

 

Category Select the category to which you want to add an image from this list box. 

Name Type a name for this image or image category in this text box.  

Add Category Check this box to add a category with the specified name to the Image Library. 

To add an image to the Image Library directly from the Dolphin Imaging main screen: 

1. Right-click the image on the Dolphin Imaging main screen, and select Add to Image Library from the Image pop-up 
menu. 

Usually, you will want to use the intra-oral center picture. 

The Image Library: Add dialog box is displayed: 

2. Select the category to which you want to add this image from the list box. 

3. Type a name for this image in the Name text box, and click Add. 
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To delete an image from the Image Library: 

1. Select on the Edit dialog box to access the Image Library Tool. 

2. Click Delete. 

The Image Library: Delete dialog box is displayed: 

3. Select the category containing the image you want to delete. 

If you wish to delete an image category, you must first delete all the images it contains. 

4. Select the image that you want to delete. Then, click OK. 

 

Category Select the category that you want to delete or from which you want to delete an image from this list box. 

Name Lists the images within the selected image category. Select one of these images to delete it. 

Delete 
Category 

Check this box to delete the selected category from the Image Library. This check box is only available if you 
have deleted all the images in the category. 

To add an image category to the Image Library: 

1. Select   on the Edit dialog box to access the Image Library Tool. 

2. Draw a polygon around the patient’s teeth. 

3. Click Add to Library. 

The Image Library: Add dialog box is displayed. 



8 Image Edit Part IV: Consultation and Image Library 

DI_USER_GUIDE-11.5   Rev. 1.01 289 

4. Type an image category name in the Name text box. 

5. Check the Add Category check box, and click OK. 

To delete an image category from the Image Library: 
1. Delete all the images in the image category.  

2. Select the image category from the Category list box. 

3. Check the Delete Category box. Then, click OK. 

To rename an image or image category: 

1. Select on the Edit dialog box to access the Image Library Tool. 

2. Click Rename. 

The Image Library: Rename dialog box is displayed: 

3. Select the category that you want to rename or that contains the image you want to rename. 

4. If you want to rename the category, check the Rename Category check box. 

Or,  

If you want to rename an image, select the image in the Name list box. 

5. Type a new name for the image or image category name in the New Name text box. Then, click OK. 
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Category Select the category you want to rename or from which you want to rename an image from this list box. 

Name Lists the images within the selected image category. Select one of these images to rename it. 

New Name Type a new name for this image or image category. 

Rename Category Check this box to rename the selected category in the Image Library.  
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9 2D Morphing 
With this feature, you can create a movie that morphs between any two images of a patient. For example, you can morph 
between before and after treatment images. You can save the movies generated with this feature in your Dolphin database and 
export them as AVI movies. 

To access the 2D Morphing module:: 

1. Click  on the Dolphin main screen.  

Or, 

Select 2D Image Morph from the Tools menu. 

The 2D Morph Editor window opens.  

 

Select Initial 
Image... 

Click this button to select the image you want to use as the starting point for the morphing operation. For more 
information, see "To select the images you want to use as the start and end points for the morphing operation" 
on page 293. 

Select Final 
Image... 

Click this button to select the image you want to use as the end point for the morphing operation. For more 
information, see "To select the images you want to use as the start and end points for the morphing operation" 
on page 293. 

Refresh Click this button to create a preview of the morph operation that you can use to see whether you have added 
enough feature lines.  For more information, see "To check the result " on page 294. 
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Movie Length 
(sec.) 

Use this slider to set the length of the morph movie in seconds. For more information, see "To generate a 
morph movie" on page 295. 

Resolution 
Mapping 

Use this slider to set the resolution to use for the morph movie and the preview image. A lower resolution 
results in faster movie generation but a lower image quality. For more information, see "To generate a morph 
movie" on page 295. 

Image Sequence 
(0-100%) 

Use this slider to set the percentage of the morph operation that you want to view as a preview. For more 
information, see "To check the result " on page 294. 

Last Frame (sec.) Use this slider to set the duration of the last frame in the morph movie in seconds. For more information, see  
"To generate a morph movie" on page 295. 

Load Lines... Click this button to load a previously-saved set of feature lines.  For more information, see "Saving and 
Loading Feature Lines" on page 298. 

Save Lines... Click this button to save the current set of feature lines in a file.  For more information, see "Saving and 
Loading Feature Lines" on page 298. 

Import Ceph 
Click this button to import the patient's cephalometric tracings to use as a set of feature lines. This option is 
only available if the initial and final images contain cephalometric tracings.  For more information, see "To 
import a patient's cephalometric tracings to use as feature lines" on page 293. 

Save Image... Click this button to save your current preview image in your Dolphin database.  For more information, see 
"Saving the Preview Image" on page 297. 

Save Movie... Click this button to save the generated morph movie in your Dolphin database. For more information, see "To 
save a morph movie you have created" on page 295. 

Export Movie... Click this button to export the generated morph movie to a file. For more information, see "To save a morph 
movie you have created" on page 297. 

Generate Movie... Click this button to generate a morph movie using your current settings. For more information, see  "To 
generate a morph movie" on page 295. 

Movie 
Preferences... 

Click this button to change the codec to use to create the movie. The codec is the program that compresses 
and decompresses the movie data. Changing the codec is an advanced operation. In most cases, you can 
simply use the default codec selection.  For more information, see "Setting Movie Preferences" on page 299. 

Morphing Between Two Images 
To morph between two images, you need to: 

• Select the images you want to use as the starting and end points for the morphing operation. 

• Draw feature lines that Dolphin uses as guides to perform the morphing operation. 

• Check the result to make sure that you have added enough feature lines for smooth morphing between the two 
images. 
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To select the images you want to use as the start and end points for the morphing operation: 

1. Click Select Initial Image.... 

The Image/Record Chooser dialog box opens. 

2. Select the image you want to use as the starting point for the morphing operation. Then, click OK. 

For example, you might pick a pre-treatment image as the starting point. 

3. Click Select Final Image.... 

The Image/Record Chooser dialog box opens  again. 

4. Select the image you want to use as the end point for the morphing operation. Then, click OK. 

For example, you might pick a simulated-treatment image or an actual post-treatment image as the end point. 

To draw a feature line: 

1. On the initial image, click where you want the feature line to start. 

2. Click again where you want the feature line to end. 

For example, you might draw feature lines along parts of the profile, across the front of the ear, and so on.  

3. On the final image, click and drag the feature line's end points so that the line is in corresponding locations on both 
images. 

If necessary, you can zoom in, zoom out, or pan to assist in locating the feature lines properly. For more information, 
see "Image Viewing Features” on page 51. 

Note: If the initial and final images contain cephalometric tracings, you can import the tracings to use as feature lines (see 
below). 

To import a patient's cephalometric tracings to use as feature lines: 

1. Select initial and final images that contain cephalometric tracings. 

For example, you can select the patient's profile photograph superimposed with the patient's tracing. For more 
information on selecting the initial and final images for a morphing operation, see "To select the images you want to 
use as the start and end points for the morphing operation" above.  For more information on superimposing a patient's 
tracing over the profile photograph, see "Tracing+Image" on page 358. 

2. Click Import Ceph. 

The tracing of the patient's soft tissue profile appears on each image. 
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To check the result: 

1. Optionally, use the Resolution Mapping slider to set the resolution to use for the preview image. 

2. Move the Image Sequence slider to the 50% (half-way) point. 

3. Click Refresh.   

An image that is morphed half-way between initial and final images appears.  If you see any ghosting, as opposed to 
smooth morphing, you need to add more feature lines at that part of the anatomy.  
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To generate a morph movie: 

1. Use the Movie Length (sec.) slider to set the duration of the movie in seconds. 

2. Use the Resolution Mapping slider to set the resolution to use for the morph movie.  

A lower resolution results in faster movie generation but a lower image quality. 

3. Use the Last Frame (sec.) slider to set the duration of the movie's last frame in seconds. 

4. Click Generate Movie... 

Depending on the resolution you selected, generating the movie may take a few moments. When the movie generation 
process finishes, the movie opens and plays in your default movie player (Windows Media Player, for example). 

Saving and Exporting Morph Movies 
Once you have generated a morph movie, you can save it in your Dolphin database or export it to a file on your computer. 

To save a morph movie you have created: 

1. Click Save Movie.... 

2. Optionally, change to a different image layout as described below. 

3. Click a slot in the image layout to save the movie in that slot. 

4. Optionally, enter a new image slot title to use for the movie in the Image Title text box. 

5. Click Save... 

The movie is stored as part of this patient's record and is available on the Dolphin Imaging main screen. 
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Image Layout Displays the currently-selected image layout. Click a slot in the layout to save the movie in that slot. 

Image Title Enter an image title to use for the movie. Initially, this field contains the title defined in the image layout for the 
selected image slot. 

Change 
Layout... Click this button to select a different image layout. 

Save... Click this button to save the movie in the selected image slot in the selected layout. 

To choose a different image layout: 

1. Click Change Layout.... 

2. Select the image layout in which you want to save this movie from the drop-down list box. Then, click OK. 
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To export a morph movie to a file: 

1. Click Export Movie.... 

The Save As dialog box appears. 

2. Specify the directory and file in which you want to save the movie. 

3. Click Save. 

Saving the Preview Image 
Once you have created a preview image, you can save it in your Dolphin database. For more information on creating a preview 
image, see "To check the result " on page 294. 

To save the preview image in your Dolphin database: 

1. Click Save Image.... 

2. Optionally, change to a different image layout as described below. 

3. Click a slot in the image layout to save the image in that slot. 

4. Optionally, enter a new image slot title to use for the image in the Image Title text box. 

5. Click Save... 

The preview image is stored as part of this patient's record and is available on the Dolphin Imaging main screen. 
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Image Layout Displays the currently-selected image layout. Click a slot in the layout to save the preview image in that slot. 

Image Title Enter an image title to use for the preview image. Initially, this field contains the title defined in the image 
layout for the selected image slot. 

Change 
Layout... Click this button to select a different image layout. 

Save... Click this button to save the preview image in the selected image slot in the selected layout. 

To choose a different image layout: 

1. Click Change Layout.... 

2. Select the image layout in which you want to save this preview image from the drop-down list box. Then, click OK. 

Saving and Loading Feature Lines 
Once you have drawn feature lines on the patient's image, you can save them so that you can load them later. This can save 
time when performing future morph operations. For more information on drawing feature lines, see "To draw a feature line" on 
page 293. 

To save the feature lines: 

1. Click Save Lines.... 

The Save As dialog box appears. 

2. Specify the directory and file in which you want to save the feature lines. 

3. Click Save. 

To load previously-saved feature lines: 

1. Select initial and final images for a morph operation. 

For more information, see "To select the images you want to use as the start and end points for the morphing 
operation" on page 293. 

2. Click Load Lines.... 

The Open dialog box appears. 

3. Specify the directory and file containing the saved feature lines. 

4. Click Open. 

The feature lines from the file are applied to the initial and final images in the 2D Morph Editor dialog box. 
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Setting Movie Preferences 

To use a different codec to generate the movie: 

1. Click Movie Preferences.... 

The Dolphin Codecs dialog box opens. On this dialog box, you can select the codec you want to use to generate the 
movie and enter options for it. 

2. Select a codec from the Compressor drop-down list box. 

Note: The computer or other device that you use to play the resulting movie must support the codec that you select. 

3. Set any other options for the codec, and click OK. 

 

Compressor Select the codec you want to use from this drop-down list box. Some codecs may not be supported by 
your computer, depending on your computer's hardware and software configuration. 

Compression 
Quality 

Use this slider to set the quality value to use when compressing the movie. A lower value results in a 
lower quality movie and a smaller file size (due to higher compression). This option is not available for all 
codecs. 

Key Frame Every n 
frames 

Check this box and enter the number of frames that the movie will take to transition from one frame in 
your script to the next. This option is not available for all codecs. 

Configure Click this button enter additional configuration options for the selected codec. These configurable options 
depend on the codec you selected. In addition, this button is not available for all codecs. 
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Part V: Cephalometric Tracing and Analysis 
This part of the Dolphin Imaging User’s Guide provides detailed information on using the Cephalometric Tracing and Analysis 
Dolphin Imaging module. This module enables you to quickly and accurately trace cephalometric radiographs, create progress 
superimpositions, and much more. Using this high-tech, industry-proven module, you can dramatically reduce the tedious and 
time-consuming task of tracings and analyses. 
This part of the Dolphin Imaging User’s Guide Help describes: 

• Digitizing landmarks on the patient’s radiograph using standard and customized analyses 

• Automatically and manually tracing structures on the digitized radiograph 

• Viewing tables of the patient’s cephalometric measurements  

• Superimposing two or more tracings for comparison 

• Overlaying the patient’s tracing over the profile photograph for treatment simulation purposes 
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10 Digitize 
This chapter describes the dialog boxes you use to digitize images. Typically, you would digitize landmarks on X-ray images that 
you have scanned into Dolphin Imaging. 
Note: Although Dolphin Imaging provides powerful features to enhance X-ray images, there is no substitute for high-quality 
original images. Before using Dolphin Imaging for X-ray diagnostics, consult your X-ray system vendor to ensure that you have 
the best possible quality X-rays.  
In digitizing images, you specify landmarks on the image that are used for cephalometric analyses. Once you have digitized 
images for a patient, you can easily view measurements for different types of analyses, view skeletal tracings over the image, or 
print the tracings and measurements. 
Dolphin Imaging can automatically draw the skeletal cephalometric structures. You simply identify some key landmarks, and 
Dolphin Imaging automatically draws the structures, saving you lots of time. The structures generated are based on statistics of 
relationships between key landmarks. Therefore, it is very important that you digitize these landmarks accurately. 
If the patient is under 18 years of age, you can select Growth Analysis when digitizing the patient’s images. This option is only 
available for patients under 18 years old. 

Notes for Digitizing Digital Radiographs 
Traditional film X-rays produce radiographs that are slightly larger than life-size, similar to the way a nearby light source shining 
on a person creates a larger-than-life-size shadow on a wall. For example, if a patient's skull is physically 200mm, it may show 
up as 230mm on film. The closer the film plate is to the patient and the farther the X-ray emitter focal point is from the patient, the 
less magnification is introduced. Since traditional cephalometric research was done with tracing paper over film, traditional norms 
are based on these enlarged sizes, not on actual patient size.  
Digital X-ray systems that have a ruler embedded at mid-line distance in the head-holder nosepiece do not introduce this 
magnification.  The ruler is magnified along with the patient, so if you calibrate Dolphin using the nosepiece ruler, you get actual, 
non-magnified results. The following list provides ruler lengths for some popular digital X-ray systems. 
Digital X-Ray System Ruler 

GE/Instrumentarium Orthoceph OC100 D, 
Orthopatomograph - OP100 D 

50 mm long, where each large graduation is 5 mm 

Planmeca Dimax, Dixi 45 mm long, where each large graduation is 5 mm 

Sirona ORTHOPHOS/Sidexis 50 mm long, where each large graduation is 5 mm 

Kodak/Practice Works/Trophy The Nasion bar has 4 ball bearings spaced 10 mm apart, 
making 40 mm total 

When possible, we recommend arranging the Nasion bar so that the entire ruler length is visible in the X-ray image. This is 
because a longer distance between ruler points will result in greater accuracy of scaling. For instance, if a ruler with 10 large 
graduations is visible in the x- ray image, with each large graduation being equal to 5 millimeters, the top-most and bottom-most 
graduations would be equal to 50 millimeters. You would then enter a value of 50 mm in the Ruler Length field of the Digitize 
Setup dialog box when starting a digitizing session. 
If you are using an indirect digital x- ray system such as Gendex/DenOptix or Air techniques/ScanX, it may be necessary to affix 
a rod or wire of a known length to the X-ray machine so that it appears in the image. Then, you can enter its length in the Ruler 
Length field of the Digitize Setup dialog box. Alternatively, if you know the Dots Per Inch (DPI) setting used by your digital X-ray 
system, you can select DPI as your calibration method on the Digitize Setup dialog box and enter the appropriate value. 
Since the traditional literature was based on magnified films, you may want to re-introduce the magnification to your digital 
system. This is a step backward, but allows digital images to match the old, magnified film images from the research literature. 
Also, if you want to overlay an old film radiographs with a new digital radiographs, you need to magnify the new digital 
radiographs to match the old film radiographs. To re-introduce film magnification to your digital images, you need to determine 
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the magnification percentage of your old film system so that you can adjust your digital images to match. You can do this in one 
of the following ways: 

• Contact the manufacturer of the film system, and ask them what magnification it introduces into radiographs.  

• Measure the "X-ray to Object Distance" (XOD), which is the distance from the focal point of the X-ray emitter to the 
midline of the patient head holder.  Measure the "Object to Film Distance" (OFD), which is the distance from the patient 
midline to the film plate.  The magnification percentage is calculated at OFD / XOD x 100.  

• Take a metal calibration ruler (like the one in Planmeca's system), or even a piece of bracket wire of a known length. 
Attach it to the nose holder at patient midline.  Take a traditional film X-ray. Develop the film, and measure the ruler 
image on the resulting film. The magnification percentage is the 100 * (measured / actual - 1).  For example, if a 45mm 
ruler shows up as 51.75mm on film, then the magnification percentage is 100 * (51.75 / 45 - 1) = 15%. 

Once you have determined the magnification percentage of your old film system, you can make the appropriate adjustment when 
digitizing your digital radiographs. For example, assume that the film magnification is 15%, and your digital X-ray system has a 
built-in 45mm ruler.  When digitizing in Dolphin, you should specify that the ruler length is 45 + 15% = 45 * 1.15 = 51.75mm. If 
you have already digitized digital images that do not have this magnification correction, you can update them by completing the 
following steps: 

1. On the Digitize Setup dialog box, select the Existing Session (Add/Modify Points) option. 

2. Change the Ruler Length text box to the adjusted measurement (for example, from 45 to 51.75 mm). 

3. Click Save Settings to save your changes. 

4. Click Start Digitize. 

5. On the Digitize dialog box, click OK to save your work without actually re-digitizing any points. 

Digitize Setup 
Before you begin digitizing images, you need to: 

• Select a patient using the Patient Charts or Patient Lookup dialog box, as described in Chapter 4.  

• Select a timepoint for the selected patient. You can select a timepoint on the Patient Charts dialog box, the Patient 
Lookup dialog box, or on the Dolphin Imaging main screen (described in Chapter 3). 

• Select the image that you want to digitize. 

Note: If you have Dolphin 3D and you have built radiographs from a 3D volume, the radiographs are built using several 
different rendering methods. All the resulting radiograph images are saved together in a single image layout slot on the 
Dolphin Imaging main screen. You can choose this group of images and digitize them. For more information on 
building radiographs from a 3D volume, see Chapter 25.  

Then, you need to access the Digitize Setup dialog box by clicking  on the Dolphin Imaging main screen. 
The following figure illustrates the Digitize Setup dialog box: 
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Patient: Indicates the currently-selected patient. 

1. Ceph 
analyses  

Use this group box to select the type of image and the analyses you want to digitize. This group box contains the 
following elements: 
Type icons: Select the type of analyses you want. Your options are: 

  

 Lateral X-ray digitizing. 

  

 Frontal X-ray digitizing. 

  

 Model arch digitizing using the Bolton arch analysis. 

  Analysis list box: Select one or more analyses from this list box. The analyses depend on the Type icon you 
chose. An at-sign (@) indicates a Dolphin-proprietary analysis, and square brackets ([ ]) indicate a custom analysis 
created for a specific doctor, practice, or institution (included for your examination). All other analyses are standard 
analyses.  
Clear All: Click this button to deselect all analyses. 

  
 

Click this button to open the custom analysis editor to create your own analysis. For more information, see 
Chapter 11. 

2. Auto-
drawn 
structures 

Select the structures that you want to be traced automatically for this analysis. If you select structures in this list 
box, Dolphin Imaging generates the landmarks necessary to draw the structures automatically. 
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3. 
Digitizing 
session 

Select the type of digitizing session. You have the following options: 
New Session (Capture new image first): Select this option to capture the image and then digitize it.  
New Session: Select this option to digitize an image you have already captured, clearing any points previously 
digitized. Typically, you use this option. 
Existing Session (Add/modify points): Select this option to add or modify points on an image you have already 
digitized. This option is only available if you already have a digitized image for this patient. With this option, Dolphin 
retains any manually-drawn structures for the digitized image and updates any automatically-drawn structures. 

4. 
Calibrate 
Image 

Select the image calibration option you want to use. You have the following options: 
Ruler: Select this option to scale the X-ray using the Dolphin calibration ruler. To use this option, the Dolphin 
calibration ruler must have been placed on the scanner when the X-ray was captured or a piece of metal of a 
specific length can be placed next to the patient when using digital X-ray systems to take X-ray images. This is the 
default and recommended option. 
Note: If you do not have a Dolphin calibration ruler, you can contact Dolphin to obtain one. Alternatively, you can 
place a semi-transparent object with a fixed size, such as a small piece of paper, on the scanner when you scan the 
X-ray image. 

Ruler Length: If you selected Ruler and you are not using a Dolphin calibration ruler, you need to specify 
the length of the ruler you are using. If you are using a Dolphin calibration ruler, this text box defaults to the 
correct value. See "Notes for Digitizing Digital Radiographs" on page 302 for information on the ruler 
lengths to enter for digital X-ray systems.  

DPI: Select this option to scale the image using the scanned image's dots-per-inch (DPI) setting.  
DPI: If you selected DPI, enter a value in this text box if you do not want to use the DPI calibration setting 
stored with the image when it was originally scanned. 

Landmarks: Select this option to scale the X-ray using landmarks. Use this option if the ruler was not placed on the 
scanner when the X-ray was captured. You must manually measure the distances indicated in this group box to 
generate accurate tracings. 

Tip of Nose to ST: Enter the distance in millimeters.  
Porion to Orbitale: Enter the distance in millimeters. 

Start 
Digitize 

Click this button to begin digitizing. 

Save 
Settings 

Click this button to save the settings you have selected in this dialog box. If you click this button, the analyses you 
selected in this dialog box are remembered and automatically selected the next time you open this dialog box. 
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To begin digitizing an image: 
1. In the Ceph Analyses group box, select a Type icon.  

2. Select one or more analyses from the Ceph Analysis list box. 

The selection bar indicates each analysis you have selected. To deselect a selected analysis, click that analysis again. 
To deselect all selected analyses, click Clear All. 

3. Optionally, select any structures that you want Dolphin Imaging to draw automatically from the Auto Drawn Structures 
list box. 

Note: Even though automatically drawing structures is designed to be as efficient as possible, please remember that, 
similar to cephalometric analysis, the more structures you select for Dolphin Imaging to draw, the more landmarks you 
will need to digitize. 

Typically, you would select the analyses and structures you usually need when you first begin using Dolphin Imaging 
and save those settings using the Save Settings button. From that point, whenever you access the Digitize Setup 
dialog box, those analyses and structures are automatically selected. 

4. In the Digitizing Session group box, select the digitize method you want to use. 

5. In the Calibrate Image group box, select the method you want to use to calibrate the image. 

Ruler is the default and recommended option. 

6. Click Save Settings to save your settings so that Dolphin Imaging will remember them the next time you digitize an 
image. 

7. Click Start Digitize. 

Depending on the digitize session you chose, you should continue with one of the following procedures: 

� If you chose New Session (Capture new image first), the Capture Setup dialog box appears. See Chapter 5 for 
information on how to use this dialog box. After you finish capturing the image, the Digitize dialog box is displayed, 
as described below. 

� If you chose New Session or Existing Session (Add/modify points), the Digitize dialog box is displayed, as 
described below. 

Digitize Landmarks 
Once an image is captured, you can digitize the image to generate the analyses. You use the Digitize dialog box, shown below, 
to digitize landmarks on the image. 
Note: If you are digitizing radiographs built from a 3D volume, you can view the image created using each of the rendering 
methods. Press F8 on your keyboard to switch among the different rendering methods. If you continue pressing F8, Dolphin will 
cycle through all the radiographs, enabling you to compare radiograph images created from the 3D volume using different 
rendering methods. 



10 Digitize Part V: Cephalometric Tracing and Analysis 

DI_USER_GUIDE-11.5   Rev. 1.01 307 

 

Image Displays the image you are currently digitizing. 

>> or << Click this button to display a description of the landmark currently selected in the Landmarks list box. When you 
click this button, the dialog box expands to show the description, and this button changes to <<. Click << to return 
the display to its original appearance. 

zoomed 
window 

Shows a close-up of the current mouse pointer position on the patient's image. This close-up enables you to see 
more detail so that you can accurately digitize the landmarks. 

Digitize 
Tab 

Use this tab to digitize landmarks on the patient's image. This tab includes the following controls: 
Visual Cues: Indicate the location of the current landmark using a red X and a pointer. 
Landmarks list box: Lists each of the landmarks that you need to digitize for this analysis. As you digitize each 
landmark, the selection bar moves automatically to the next one. 
Next: Click this button to go to the next landmark in the list that you haven't already digitized. 
Show Overlay Tracing: Check this box to show the overlay tracing while digitizing the image. For more 
information, see "Overlaying an Existing Tracing" on page 314. 
Main Tracing Color: Click the color sample to choose a different color to use for the tracing structures created as 
part of digitizing this image. 



Dolphin Imaging User's Guide April 2011 

308 DI_USER_GUIDE-11.5   Rev. 1.01 

Overlay 
Tab 

Use this tab to overlay a tracing from another timepoint on the patient's image. Overlaying an existing tracing can 
provide a shortcut to digitizing the landmarks for this image. 
Timepoint/Record: Click this button to select a timepoint containing a tracing that you want to overlay on the 
patient's image. 
Overlay Display: Check this box to display the overlay tracing in the selected color (see below). 
Color Sample: Shows the color in which the overlay tracing is displayed. Click the color sample to choose a 
different color. 
Structures Only: Check this box to display only the structures (and no landmarks) on the overlay tracing. 
Analysis: Select the analysis for the overlay tracing from this drop-down list box. 
Transfer Calibration: Transfers the calibration of the overlay tracing to the current radiograph image in order to 
match the scale of the tracing and image. For more information, see "To transfer the calibration" on page 318. 
Transfer Structures: Opens a pop-up menu from which you choose the structures that you want to transfer from 
the overlay tracing to this image. For more information, see "To transfer a structure from the overlay tracing to the 
image" on page 318. 
Align Tracings: Opens a dialog box that you can use to specify how the overlay tracing should be aligned with 
the image. For more information, see page 316. 

Digitize Tool Bar Buttons 

 
Opens the original records window. For more information, see “Using the Original Records Window” on page 412. 

 
Toggles the audio cues. 

 
Toggles the display of the patient’s x-ray image. 

 
Toggles display of the calculated landmarks. 

 
Toggles the display of the patient’s tracing. 

 
Opens the Enhance tool. For more information, see "To enhance a picture" on page 164. 

 
Returns the image to its original, un-enhanced appearance. 

 
Refreshes the calculated landmarks and automatically-drawn structures after you have modified points. 

 
Undoes the previous operation. 

 
Omits the current landmark. 

 
Opens the Custom Structures feature to manually draw structures or modify the automatically-drawn structures. 

 
Aligns the image to a reference plane. For more information, see "To align the patient’s image to a reference 
plane" on page 361. 
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To digitize landmarks: 

1. Zoom in on the image, if necessary, so that the landmarks are clearly visible. 

2. Optionally, overlay an existing tracing for this patient on the patient's image. 

If you have already digitized an image for this patient (for example, for another timepoint), you can overlay that tracing 
on the patient's image. Then, you can use that tracing as a guide in digitizing the patient's image.  

Depending on the patient's treatment, many of the digitized landmarks may be the same across several timepoints. In 
this case, using a tracing from an earlier timepoint as a digitizing guide may save time.  

3. Using the visual cues and the Landmarks list box as a guide, click each landmark in order. 

As you go through the list of landmarks, the selection bar in the Landmarks list box indicates the current landmark. If 
you are unfamiliar with a landmark’s location, the cartoon and description of the landmark provide a guide.  

If you are familiar with the landmarks, using the audio cues may make digitizing go faster. Rather than looking at the 
Landmarks list box or the cartoon, an audio cue will guide you through the list of landmarks. Also, you can also click >> 
and << to view or hide a description of the selected landmark. 

Note: If you have difficulty seeing how the molars occlude in the patient’s radiograph, you may find it helpful to open an 
original records window and display the patient's right buccal photograph. For information on using the original records 
window, see “Using the Original Records Window” on page 412. 

If you selected any structures for Dolphin to draw automatically ("Auto Structures"), those structures are drawn 
immediately when you digitize the required landmarks. You can modify these structures by clicking and dragging the 
associated landmarks on the Digitize dialog box.  

Note: To skip a landmark when digitizing, click . 

4. For each image that you digitize, check each of the key components and results to ensure accuracy. 

The following table lists some common key components to be aware of in orthodontic analyses: 

After Digitizing... Check... Other landmarks involved 

Soft tissue pogonion E-Plane (Aesthetic plane or Nose-chin line) Tip of nose 

Gonion Mandibular Plane Menton 

Mesial L6 Posterior bite Mesial U6 

The Dolphin Imaging program does not automatically check the validity of the landmark locations. You must verify that 
the landmarks are placed properly by you or your technician. If you briefly hold and "hover" your mouse at a digitized 
landmark, a tooltip displays the landmark’s name to help you verify the landmarks you have digitized, as shown below. 
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As shown above, manually digitized landmarks appear in red. Landmarks automatically calculated by the Dolphin 
Imaging program are gray. In addition, a calculated landmark has an asterisk (*) in its tooltip. The movement handles, 
which enable you to move the outlines of the teeth, are blue. 

You can review the calculated landmarks and automatically-generated structures, and modify them if necessary.  

When you finish digitizing all the landmarks, the selection bar in the Landmarks list is on <<end of list>>.  

5. Click OK to save the digitized image and return to the Dolphin Imaging Main Screen. 

Or, 

Click on the tool bar to add custom tracings to the digitized image. 

Digitizing the Airway 
Some analyses include points that you can digitize to delineate the patient's airway.  As you digitize one of these analyses, 
horizontal lines appear on the patient's image to help you locate the airway points. Once you have digitized the airway points, 
you can do treatment planning that takes the patient's airway into account. 
The following figure illustrates the digitized airway points for the Arnett/Gunson FAB Ortho analysis. 
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Digitizing Study Models 
Dolphin Imaging offers arch analyses that you can use to digitize study models. 

To digitizing a study model image: 

1. In the Ceph Analyses group box, select .  

The arch analyses are selected automatically in the Ceph Analysis list box. 

2. In the Digitizing Session group box, select New Session (Capture new image first) if you have not captured a study 
model image yet. 

Or, 

Select New Session if you already have captured a study model image. 

3. In the Calibrate Image group box, select the method you want to use to calibrate the image. 

Ruler is the default and recommended option. 

4. Click Start Digitize. 
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Depending on the digitize session you chose, you should continue with one of the following procedures: 

� If you chose New Session (Capture new image first), the Capture Setup dialog box appears. See "Capturing 
Study Model Images" on page 181 for information on capturing a study model image. After you finish capturing 
the image, the Digitize dialog box is displayed. 

� If you chose New Session or Existing Session (Add/modify points), the Digitize dialog box is displayed. 

5. Zoom in on the image, if necessary, so that the landmarks are clearly visible. 

6. Using the visual cues and the Landmarks list box as a guide, click each landmark in order. 

7. Click OK to save the digitized image and return to the Dolphin Imaging Main Screen. 
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Changing a Landmark's Location 

To change the location of a landmark: 

1. Click the landmark in the Landmarks list box. 

Or, 

Press the UPARROW key until the selection bar in the list box is over the landmark name. 

A pair of intersecting dotted lines appears on the digitized image to identify the landmark selected in the Landmarks list 
box. 

2. Click the correct location for the landmark. 

Alternatively, you can simply click and drag the landmark: 

1. Move the mouse over the landmark you want to move. 

When the mouse is over one of the landmarks, the mouse pointer changes to small triangles surrounding the 
landmark.  

2. Click and drag the landmark to a new location. 

Note: If you change the location of any of the points on a digitized image, Dolphin changes the location of the associated 
landmark.  
When you move landmarks, the curve changes in different ways depending on the color of the point: 

• When you click and drag a red point (a digitized landmark), the curve and all the grey points between it and the next 
red point move to accommodate the new location of the red point you are moving. 

• When you hold down the CTRL key while clicking and dragging a red point, only the red point moves. The adjacent grey 
points do not move. 

• When you click and a grey point (a calculated landmark), only the curve adjacent to that point moves. The adjacent 
grey and red points do not move. 

To recalculate after moving a landmark: 

1. Click  on the tool bar. 

The Dolphin Imaging program recalculates the calculated landmarks and automatically-generated structures. 

Moving and Rotating the Tooth Outlines 

To move a tooth outline: 
1. Move the mouse over the blue movement handle for the tooth outline you want to move. 

The figure below identifies the handles used to move tooth outlines. When the mouse is over a movement handle, the 
mouse pointer changes to small triangles surrounding the handle.  

2. Click and drag the tooth outline to a new location. 
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To rotate a tooth outline: 
1. Move the mouse over the blue rotation handle for the tooth outline you want to rotate. 

The figure below identifies the handles used to rotate tooth outlines. When the mouse is over a rotation handle, the 
mouse pointer changes into a rotation icon surrounding the handle.  

2. Click and drag the tooth outline to rotate it. 

 
Note: Moving and rotating tooth outlines can be especially useful in conjunction with the Overlay Tracing feature. With this 
feature, you can transfer tracings from any pre-treatment cephalogram to a progress or post-treatment cephalogram, thus 
creating the new tracings with a minimum of effort. During treatment, however, the teeth are likely to move. By moving and/or 
rotating the entire tooth outline, you can easily move the teeth from their location on the pre-treatment tracing to the correct 
progress or post-treatment location. 

Overlaying an Existing Tracing 
If you have already digitized an image for this patient (for example, you have digitized a radiograph for another timepoint), you 
can overlay that tracing on the current image. Once you have correctly aligned the existing tracing over the image, you can 
transfer structures from the existing tracing to the image. 
This feature is particularly useful to construct before and after treatment digitized images. For example, suppose you have 
created a timepoint called Initial that contains images for the patient taken before beginning treatment. These initial images 
include a digitized radiograph. Then, you treated the patient, created a timepoint called Final, and took images (including a 
radiograph) to record the treatment result. On the patient's radiograph, the landmarks and structures affected by the treatment 
would change. However, some of the landmarks and structures may have remained the same. To simplify digitizing the final 
radiograph, you could overlay the tracing for the initial radiograph and transfer all the structures that did not change to the final 
radiograph. Then, you would only need to digitize the landmarks that changed.  
Before you can overlay an existing tracing, you must digitize calibration points on the patient's image. For example, if you are 
using the ruler to calibrate your image, you must digitize the Ruler Point 1 and Ruler Point 2 before you click the Overlay tab. 
Similarly, if you are using landmarks to calibrate your image, you must digitize the Tip of Nose, ST Pogonion, Porion, and 
Orbitale before you click the Overlay tab. 
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To select the overlay tracing: 

1. Click the Overlay tab. 

2. On the Overlay tab, click Timepoint/Record. 

The Image/Record Chooser dialog box is displayed. 

 
3. Select the image with the tracing that you want overlay on the patient's image. Then, click OK. 

The tracing for the image that you selected appears over the current image, along with a movement control that you 
can use to resize and/or rotate the tracing. 
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To overlay the tracing for a different analysis: 
1. On the Overlay tab on the Digitize palette, select the analysis for the tracing that you want to overlay from the Analysis 

drop-down list box. 

After you have chosen the overlay tracing, you must align it with the radiograph image. If the tracing is not to the same scale as 
the radiograph, you can first scale it so that it matches. Once the tracing and radiograph are scaled the same, you can align them 
using the following mechanisms: 

• You can click and drag the tracing to align it over the patient's image. 

• You can use the movement control to resize and/or rotate the tracing relative to the patient's image. 

• You can use digitized landmarks to align the tracing if you have digitized some landmarks on this radiograph. 

To click and drag the tracing to align it to the radiograph: 

1. Place your mouse cursor anywhere on the tracing except the movement control. 

The cursor appears as a hand icon . 
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2. Click and drag to move the tracing in any direction. 

To resize the tracing: 

1. Place your mouse cursor over the box at the top of the movement control. 

The cursor appears as a rotation icon . 

2. Click and drag the box up to enlarge the tracing. 

Or, 

Click and drag the box down to reduce the size of the tracing. 

To rotate the tracing: 

1. Place your mouse cursor over the small box at the center of the movement control. 

The cursor appears as directional arrows . 

2. Click and drag the movement control to place the small box at its center at the location around which you want to rotate 
the tracing. For example, if you want to rotate the tracing around the Porion, place the small box at the center of the 
movement control over the Porion. 

3. Place your mouse cursor over the box at the top or bottom of the movement control. 

The cursor appears as a rotation icon . 

4. Click and drag the box to rotate the tracing. 

Bear in mind that if you use the box at the top of the movement control, the tracing may change size as well as rotate. 

To use digitized landmarks to align the tracing: 

1. On the Overlay tab of the Digitize palette, click Align Tracings. 

The Digitize Session Tracing Alignment dialog box opens with options for aligning the tracing to the image using 
digitized landmarks. 

2. Select a pre-defined alignment from the Use Predefined Alignment drop-down list box. 

Or, 

Create a custom alignment by selecting landmarks from the Align Tracings At and In the Direction Of drop-down list 
boxes. 

The tracing is aligned with the image according to the option you selected. 
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Use 
Predefined 
Alignment 

Select a predefined alignment to align the tracing with the image using that alignment. The options listed in this 
drop-down list box depend on the landmarks that you have digitized for the radiograph. 

Align tracings 
at 

Select the landmark that you want to use to align the tracing with the image. Typically, you would choose a 
landmark whose location did not change. The options listed in this drop-down list box depend on the landmarks 
that you have digitized for the radiograph. 
For example, if you have digitized the Porion on the radiograph, you can select this landmark to align the 
tracing and image. In this case, Dolphin Imaging places the tracing's Porion landmark directly on top of the 
Porion landmark you digitized on the radiograph. 

In the 
direction of 

Select the landmark to use as the second point on the axis along which you want to align the tracing and 
image. The options listed in this drop-down list box depend on the landmarks that you have digitized for the 
radiograph. 
For example, suppose you digitized the Porion and Orbitale on the radiograph, and you selected Porion as the 
landmark at which to align the tracing and image. You could then select Orbitale in this drop-down list box to 
define an alignment axis running between the Porion and Orbitale. In this case, Dolphin Imaging places the 
tracing's Porion landmark directly on top of the Porion landmark you digitized on the radiograph. Dolphin 
Imaging then rotates the tracing relative to the radiograph so that the Orbitale landmarks are either on top of 
each other (if this landmark did not move) or in line with each other (if this landmark did move).  

Once you have scaled and aligned the overly tracing, you can transfer the calibration from the overlay tracing to the radiograph 
image. Once you have transferred the calibration, it is recommended that you do not change the size of the overly tracing. 

To transfer the calibration: 

1. On the Overlay tab of the Digitize palette, click Transfer Calibration. 

2. On the confirmation dialog box that appears, click Yes. 

Once you have aligned the tracing with the image, you can transfer one or more structures from the tracing to the image. 
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To transfer a structure from the overlay tracing to the image: 

1. On the Overlay tab of the Digitize palette, click Transfer Structures. 

A pop-up menu opens listing options for transferring structures from the overlay tracing to the image.  

2. Select a structure from the list to transfer it from the overlay tracing to the image. 

To transfer all listed structures from the overlay tracing to the image: 

1. On the Overlay tab of the Digitize palette, click Transfer Structures. 

A pop-up menu opens listing options for transferring structures from the overlay tracing to the image.  

2. Select All (Below) to transfer all listed structures from the overlay tracing to the image. 

To identify a specific group of structures that you want to transfer from the overlay tracing to the image: 

1. On the Overlay tab of the Digitize palette, click Transfer Structures. 

A pop-up menu opens listing options for transferring structures from the overlay tracing to the image.  

2. Select Choose Group from List. 

The Transfer Structures Selection dialog box opens. 

3. Click each structure that you want to transfer in the Complete List list box. 

Or, 

Click Select All below the Complete List list box to select all the listed structures. 

4. Click Add>> to move the selected structures from the Complete List list box to the Transfer These When Available list 
box. 

The selected structures move to the Transfer These When Available list box.  

If you make a mistake, you can click one or more structures in the Transfer These When Available list box and click 
<<Del to move them back to the Complete List list box.  

5. Click OK to transfer the structures listed in the Transfer These When Available list box from the overlay tracing to the 
image. 

Dolphin Imaging transfers all the identified structures that are available on the overlay tracing to the image. 
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Complete List Lists all the structures that you may be able to transfer from the overlay tracing to the image. Structures 
identified with an asterisk (*) are available for transfer from the overlay tracing to the image. 

Transfer These 
When Available 

Lists the structures that you have identified for transfer from the overlay tracing to the image. If these 
structures are available on the tracing, Dolphin Imaging will transfer them to the image when you click 
OK. 

Add>> Moves the structures selected in the Complete List list box to the Transfer These When Available list box. 

<<Del Moves the structures selected in the Transfer These When Available list box to the Complete List list box. 

Select All Selects all the structures in the associated list. 

Deselect All Deselects all the structures in the associated list. 
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Custom Structures 
Using the Auto-Drawn Structures feature on the Digitize Setup dialog box, you can specify the skeletal cephalometric structures 
that you want Dolphin Imaging to draw automatically. Using this feature can save you a lot of time, because you simply identify 
some key landmarks, and Dolphin Imaging automatically draws the structures. For more information on how to use this feature, 
see "Digitize Setup" on page 303. 
If you want to add custom structures, you can trace them manually as described in this section.  
Note: The Dolphin Imaging program uses an advanced mathematical technique called "piece-wise cubic splines." Using a spline, 
you can easily create complex curves as though they were done manually by a professional. The result is very smooth and 
accurate curves that do not look like computer-generated jagged lines. If you are familiar with a similar technique, the Bezier 
curve, splines are much easier to use from the user’s perspective. 

Tracing Custom Structures 

To trace custom structures: 

1. After digitizing the landmarks, click  on the tool bar. 

The Custom Structures palette replaces the Digitize palette. 
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Image Displays the image on which you are currently tracing structures. 

Add custom 
structure 

Select this option to add structures to your tracing (see below). 

Remove 
structure 

Select this option to remove structures from your tracing (see below). 

Modify structure Select this option to modify a structure on your tracing. You have the following options. 
Move all Points: Select this option to move all the points on one spline. This moves the spline to a new 
location without changing its shape.  
Move Point: Select this option to move a single point on a spline and change the shape of the spline.  
Add Point: Select this option to add a point to a traced structure and change the shape of the spline. This 
option is only available for structures that you added manually. 
Delete Point: Select this option to delete a point from a traced structure and change the shape of the 
spline. This option is only available for structures that you added manually. 

To add a custom structure: 
1. Select the Add Custom Structure option. 

2. Click and release the left mouse button on a point where you want to begin tracing. 

3. Move the mouse to begin tracing. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position. 

4. Click the mouse button whenever you want to place a point and change the direction of the line. 

If you make a mistake, click the right mouse button to undo to the last point you placed. 

5. To complete the tracing line, double-click the left mouse button. 

6. When you finish tracing structures, click . 

Alternatively, you can hold down the left mouse button and drag the mouse to draw the tracing line without placing points. Using 
this method, you may be able create a smoother line. However, you may find it more difficult to draw the line. In addition, undoing 
is more cumbersome, since this method effectively creates many points and line segments in the tracing. 
Note: The Dolphin Imaging program internally keeps track of which structures were automatically generated and which were 
manually drawn. Automatically-generated structures appear as solid lines, while manually-drawn structures appear as dotted 
lines. These distinctions are especially important for the Treatment Simulation program. 
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To remove a structure: 
1. Select the Remove Structure option. 

2. Move the mouse over one of the points on the structure. 

An X appears over that point, and all points on the curve turn red. 

3. Click the left mouse button to remove the traced structure. 

If you are removing an automatically-generated structure, a dialog box asks you to confirm the deletion. 

4. If you are removing an automatically-generated structure, click Yes to confirm the deletion. 

To move a structure: 
1. Select the Modify Structure option. 

2. Select the Move all Points sub-option. 

3. Move the mouse over one of the points on the structure. 

Small triangles surround the point, and all points on the curve turn red. 

4. Click and drag the structure to a new location. 

Adding, Moving, and Deleting Points 

To add a point on a manually-drawn structure: 
1. Select the Modify Structure option. 

2. Select the Add Point sub-option. 

3. Move the mouse to the location on a line where you want to add a point. 

The mouse pointer turns into an up-arrow. 

4. Click and drag the mouse to the location where you want the new point to be. 

When you click on the line, the new point appears in red surrounded by small triangles. As you drag the mouse, the 
line changes shape to accommodate the new point’s location. 

To move a point: 
1. Select the Modify Structure option. 

2. Select the Move Point sub-option. 

3. Move the mouse over one of the points on the structure. 

Small triangles surround the point, and the point turns red. 

4. Click and drag the point to a new location. 

The line changes shape to accommodate the point’s new location. 
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To delete a point on a manually-drawn structure: 
1. Select the Modify Structure option. 

2. Select the Delete Point sub-option. 

3. Move the mouse over one of the points on the structure. 

An X appears over that point, and the point turns red. 

4. Click to delete that point. 

To exit from Custom Structures: 

1. Click . 

The custom tracings are saved, and the Digitize palette replaces the Custom Structures palette. 
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11 Custom Analysis Editor 
You can use the custom analysis editor to create your own analyses. To create a custom analysis, you select from the following 
types of analysis items that are currently defined for use in Dolphin Imaging analyses: 

• Groups and Measurements: These items are typically listed on measurements tables. Measurements can be the 
distances between particular landmarks, angles, ratios, and so on. The groups categorize related measurements. 

• Tracing Lines: These lines identify the structures that Dolphin Imaging can automatically draw when you digitize a 
patient's radiograph using a particular analysis. 

• Misc. Landmarks: These landmarks are included in the analysis but are not used to create measurements and tracing 
lines. 

Using the custom analysis editor, you can arrange and group these items, define custom names for them, define properties for 
them such as whether they should appear on the measurements tables and tracings, where they should appear on tracings, and 
what colors to use for them. 
The custom analyses you define are stored in two files: CstAnalysis.bin and CstLateralMs.bin. The CstLateralMs.bin file is only 
present if you have created custom group categories or custom norms. You can copy these two files to another computer to 
share your custom analyses. Bear in mind, however, that copying these two files to another computer overwrites any custom 
analyses that were already defined on the target computer.  
Also, upgrading Dolphin Imaging does not overwrite these two files. Therefore, your custom analyses are retained when you 
upgrade the software. 

To open the custom analysis editor: 

1. Click  on the Digitize Setup dialog box. 

Or, 

Click  on the Measurements dialog box. 

The following figure illustrates the Custom Analysis Editor dialog box: 
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The Custom Analysis Editor dialog box contains the following sections: 

Search for 
Measurements, Lines 
and Landmarks 

Provides options for searching through the existing analyses for the measurements, tracing lines, 
and landmarks that you want to use in your custom analysis. 

Available Measurements Lists the measurements available based on the search criteria entered in the Search for 
Measurements, Lines and Landmarks group box. 

Available Tracing Lines Lists the tracing lines available based on the search criteria entered in the Search for 
Measurements, Lines and Landmarks group box. 

Available Misc. 
Landmarks 

Lists miscellaneous landmarks available based on the search criteria entered in the Search for 
Measurements, Lines and Landmarks group box. 

 
Click this button to move the selected measurement in the Used Measurement list box up in the list. 
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Click this button to move the selected measurement in the Used Measurement list box down in the 
list. 

 
Click this button to use the selected item in the Available Measurements, Available Tracing Lines, or 
Available Misc. Landmarks list box in your custom analysis. When you click this button, the selected 
item moves to the Used Measurements, Used Tracing Lines, or Used Misc. Landmarks list box, as 
appropriate. 

 
Click this button to remove the selected item in the Used Measurements, Used Tracing Lines, or 
Used Misc. Landmarks list box from your custom analysis. When you click this button, the selected 
item moves to the Available Measurements, Available Tracing Lines, or Available Misc. Landmarks 
list box, as appropriate. 

Used Measurements Lists the measurements you have selected for your custom analysis.  

Used Tracing Lines Lists the tracing lines you have selected for your custom analysis  

Used Misc. Landmarks Lists landmarks you have selected for your custom analysis. 

Using the Custom Analysis Editor Tool Bar 
The Custom Analysis Editor tool bar contains the following buttons: 

 
Creates a new custom analysis. For more information, see "To create a new custom analysis" on page 329. 

 
Opens an existing analysis. For more information, see "To open an existing analysis" on page 329. 

 
Saves the current custom analysis. For more information, see "Saving a Custom Analysis" on page 342. 

 
Removes the selected item in the Used Measurements, Used Tracing Lines, or Used Misc. Landmarks list box 
from your custom analysis. When you click this button, the selected item moves to the Available Measurements, 
Available Tracing Lines, or Available Misc. Landmarks list box, as appropriate. For more information, see "To 
remove an item from a custom analysis" on page 333. 

 
Inserts a group sub-heading to your custom analysis above the currently-selected measurement item. This 
heading appears on the measurements table. For more information, see "Adding a Custom Heading" on page 
334. 

 
Opens the properties dialog box for the selected item in the Used Measurements, Used Tracing Lines, or Used 
Misc. Landmarks list box. For more information, see "Setting Analysis Item Properties" on page 335. 

 
Opens the Tracing Preview window so that you can preview a tracing using your custom analysis. For more 
information, see "To preview your custom analysis" on page 343. 

 
Opens a dialog box that provides general information about the custom analysis editor. 
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Using the Menu Bar 
At the top of the Custom Analysis Editor dialog box, there are three menus that you can use to access program features.  

• File Menu 
• View Menu 
• Help Menu 

This section describes each of these menus. 
   

The File Menu 
The following figure illustrates the File menu: 

 
The File menu contains the following choices: 

New Creates a new, blank custom analysis. For more information, see "To create a new custom analysis" on page 329. 

Open Opens an existing custom analysis. For more information, see "To open an existing analysis" on page 329. 

Save Saves the current custom analysis. For more information, see "Saving a Custom Analysis" on page 342. 

Save As... Saves the current custom analysis using a new file name. For more information, see "Saving a Custom Analysis" 
on page 342. 

Recent 
File 

Opens the identified, previously-created custom analysis. For more information, see "To open an existing analysis" 
on page 329. 

Exit Closes the Dolphin Custom Analysis Editor dialog box. 

The View Menu 
The following figure illustrates the View menu: 
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The View menu contains the following choices: 

Toolbar Toggles the display of the tool bar on the Custom Analysis Editor dialog box.  

Status Bar Toggles the display of the status bar on the Custom Analysis Editor dialog box. 

   

The Help Menu 
The following figure illustrates the Help menu: 

 
The Help menu contains the following choices: 

Help Topics Opens a window that displays the online help. 

About CstAnaly Opens a dialog box that provides the Dolphin Custom Analysis Editor program version. 

Creating or Opening Custom Analyses 

To create a new custom analysis: 

1. Click  to create a new custom analysis. 

Or, 

Select New from the File menu. 

At this point, you can define your analysis by adding items to it. 

To open an existing analysis: 

1. Click . 

Or, 

Select Open... from the File menu. 

Or, 

Select the analysis from the list of recently-opened files on the File menu. 

If you selected the analysis from the list of recently-opened files on the File menu, the analysis opens and you should 
skip the next step. Otherwise, the Open Analysis dialog box appears listing the standard analyses and any custom 
analyses you have created. 
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2. Select the analysis you want to open, and click OK. 

When you open an existing analysis, the Used Measurements, Used Tracing Lines, and Used Misc. Landmarks list 
boxes list the analysis items that the analysis currently contains. At this point, you can add items to or remove items 
from the analysis. 

Adding and Arranging Analysis Items 

Finding an Analysis Item 
The first step in creating a custom analysis is to find the analysis items you would like it to include. To do this, you select from the 
analysis items that are currently defined for use in Dolphin Imaging analyses. These items are grouped into the following 
categories: 

• Groups and Measurements: These items are typically listed on measurements tables. Measurements can be the 
distances between particular landmarks, angles, ratios, and so on. The groups categorize related measurements. 

• Tracing Lines: These lines identify the structures that Dolphin Imaging can automatically draw when you digitize a 
patient's radiograph using a particular analysis. 

• Misc. Landmarks: These landmarks are included in the analysis but are not used to create measurements and tracing 
lines. 

To find an analysis item, you use the Search for Measurements, Lines and Landmarks group box, which is illustrated below. 
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Single 
Analysis 

Select this radio button and select from the associated drop-down list box to list the available analysis items 
used in the specified analysis. 

Search All Select this radio button to find an analysis item based on one or more of the following search criteria: 
Measurement Type: Check this box and select from the associated drop-down list to find measurements of 
a particular type. You can view measurements that are distances, angles, percentages (ratios), or 
measurements of any other type. 
Uses Landmarks: Check this box and click Landmarks... to find an analysis item that uses one or more 
landmarks. 
Name Contains: Enter a partial name in this text box to find an analysis item based on its name. 

To find an analysis item if you know the name of an existing analysis that includes it: 

1. Select the Single Analysis radio button in the Search/Sort group box. 

2. Select the analysis containing the item you want to use from the Single Analysis drop-down list box. 

To find a measurement based on measurement type: 

1. Select the Search All radio button in the Search/Sort group box. 

2. Check the Measurement Type check box. 

3. Select the type of measurement from the Measurement Type drop-down list box. 

The Available Measurements list box lists measurements of the type you selected. 

To find an analysis element that uses particular landmarks: 

1. Select the Search All radio button in the Search/Sort group box. 

2. Check the Uses Landmarks check box. 

3. Click Landmarks.... 

The Select Landmark(s) dialog box is displayed as shown below. 

4. Select one or more landmarks, and click OK. 

The Available Measurements, Available Tracing Lines, and Available Misc. Landmarks list boxes list analysis items 
that use the landmarks you selected. 

Note: If you close the Select Landmark(s) dialog box and re-open it, it remembers the landmarks you had selected. 
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Landmarks list box Click one or more landmarks to select them. To deselect a selected landmark, click it again. 

Clear All Click this button to deselect all selected landmarks. 

To find an analysis item based on its name: 

1. Enter a partial name in the Name Contains text box. 

The Available Measurements, Available Tracing Lines, and Available Misc. Landmarks list boxes list analysis items 
whose names match your entry. 

To find an analysis item based on several criteria: 

1. Select the Search All radio button in the Search/Sort group box. 

2. Use any combination of the three searching strategies described above. 

The Available Measurements, Available Tracing Lines, and Available Misc. Landmarks list boxes list analysis items 
that meet all the search criteria you entered. 
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To re-sort available analysis items in the list boxes: 
1. Click the column heading in the Available Measurements, Available Tracing Lines, or Available Misc. Landmarks list 

box to re-sort the analysis items in that list box using that property. 

For example, to sort the Available Tracing Lines by ID, click the ID column heading in the Available Tracing Lines list 
box. 

Adding an Item to a Custom Analysis 

To add an item to a custom analysis: 

1. Select the analysis item from the Available Measurements, Available Tracing Lines, or Available Misc. Landmarks list 

box. Then, click   to add the selected analysis item to your custom analysis. 

Or, 

Right-click the analysis item in the Available Measurements, Available Tracing Lines, or Available Misc. Landmarks list 
box. Then, select Add from the pop-up menu to add the selected analysis item to your custom analysis. 

Or, 

Double-click the analysis item in the Available Measurements, Available Tracing Lines, or Available Misc. Landmarks 
list box. 

If the analysis item you want to add is not listed in one of these list boxes, you must find it in an existing analysis. For 
more information, see "Finding an Analysis Item" on page 330. 

To select several items that are adjacent in a list box, click the item at the top of the group. Then, SHIFT+click the item 
at the bottom of the group.  

To select several item that are not adjacent in a list box, click the first item. Then, CTRL+click the other items you want 
to select. 

When you add an item to your custom analysis, the selected item moves to the Used Measurements, Used Tracing 
Lines, or Used Misc. Landmarks list box, as appropriate. If the item is a measurement, a symbol in the left column 
indicates whether the item will appear on measurement tables or tracings. If the measurement's properties specify that 
it should appear on both, the item appears twice in the list, as shown in the figure below.  
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Removing an Item from a Custom Analysis 

To remove an item from a custom analysis: 

1. Select the analysis item from the Used Measurements, Used Tracing Lines, or Used Misc. Landmarks list box. 

2. Click  to remove the selected analysis item from your custom analysis. 

Or, 

Click  to remove the selected analysis item from your custom analysis. 

Alternatively, right-click an analysis item from the Used Measurements, Used Tracing Lines, or Used Misc. Landmarks 
list box. Then, select Remove from the pop-up menu. 

The selected item moves to the Available Measurements, Available Tracing Lines, or Available Misc. Landmarks list 
box, as appropriate. 

Adding a Custom Heading 

To add a custom heading: 

1. Select the item in the Used Measurements list box above which you want to add the custom heading. 

You must have at least one item in the Used Measurements list box before you can add a custom heading. 

2. Click . 

The Measurement Group Heading dialog box is displayed. 

3. Type the name for this heading, and click OK. 

The custom heading is added to the Used Measurements list box. 

Note: If a heading is already in an existing analysis, you can find it and add it to your custom analysis just like any other analysis 
item.  
To change a custom heading, you can set its properties. For more information, see "Setting Properties for a Custom Heading" on 
page 335. 

Reordering Measurements 

To change the order of measurements in your custom analysis: 
1. Select a measurement in the Used Measurements list box.  

2. Click  to move this measurement up in the list box. 

Or, 
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Click  to move this measurement down in the list box. 

Alternatively, right-click a measurement in the Used Measurements list box. Then, select Move Up or Move Down from 
the pop-up menu. 

Setting Analysis Item Properties 
You can set properties for any of the items in the Used Measurements, Used Tracing Lines, or Used Misc. Landmarks list boxes. 
The properties you can set depend on the type of item. 

Setting Properties for a Custom Heading 

To set properties for a group heading: 

1. Double-click a group heading in the Used Measurements list box. 

Or, 

Right-click a group heading in the Used Measurements list box. Then, select Properties from the pop-up menu. 

Or, 

Select a group heading in the Used Measurements list box. Then, click . 

The Measurement Group Heading dialog box is displayed. 

2. Type a new name for this group, and click OK. 

Setting Properties for a Measurement 

To set properties for a measurement: 

1. Double-click a measurement in the Used Measurements list box. 

Or, 

Right-click a measurement in either the Available Measurements or the Used Measurements list box. Then, select 
Properties from the pop-up menu. 

Or, 

Select a measurement in either the Available Measurements or the Used Measurements list box. Then, click . 

The Measurement Properties dialog box is displayed. 

2. If you are viewing properties for a measurement from the Used Measurements list box, set any properties for this 
measurement, and click OK. 

For measurements from the Available Measurements list box, you can only view the properties. 



Dolphin Imaging User's Guide April 2011 

336 DI_USER_GUIDE-11.5   Rev. 1.01 

 
Measurement 
Name 

Lists the names currently defined for this measurement. To customize this measurement's name, you 
can select from this drop-down list or type in a new name. 

Display on 
Measurement 
Table 

Check this box to display this measurement on the measurement table for this analysis. 

Display on 
Tracing At 

Check this box to display this measurement on the tracing for this analysis. 
Drop-down list box: Select from a list of the tracing locations currently-defined for this 
measurement. 
Custom Loc...: Click this button to define a custom location. 

Value Calculation 
Script 

Describes the calculation used to arrive at this measurement.  
Note: Although you cannot change this script, you can select it, copy it to the clipboard, and paste it 
elsewhere (such as in an email message). 

Location 
Calculation Script 

Describes the calculation used to arrive at a landmark location.  
Note: Although you cannot change this script, you can select it, copy it to the clipboard, and paste it 
elsewhere (such as in an email message). 

Use Norms Use these controls to specify the gender or racial norms to use for this analysis. 
Drop-down list box: Select from a list of the norm sets currently-defined for this measurement. 
Custom Norms...: Click this button to define a set of custom norms. 
Reverse Wiggle: Check this box to reverse the direction of the measurement table polygon/wiggle-
gram.  By default, the graph wiggles left for measurements below the norm and right for 
measurements above the norm. If you select check this box, the graph wiggles right for 
measurements below the norm and left for measurements above the norm. 

List of Norms Lists the norms for the currently-selected norm set. You can select the text in this box, copy it to the 
clipboard, and paste it elsewhere (such as in an email message). 

Analyses... Click this button to view a list of the analyses that use this measurement. 
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To view the analyses that use this measurement: 

1. Click Analyses... 

The Used in Analyses dialog box opens listing the analyses that use this measurement. 

2. Click Close to close the Used in Analyses dialog box. 

To define a custom location: 

1. On the Measurement Properties dialog box, click Custom Loc.... 

The Custom Tracing Location dialog box is displayed as shown below. 

2. Enter a description for this location. 

3. From the Landmark drop-down list box, select the landmark near which you want this measurement to appear on the 
patient's tracing. 

4. Specify where you want this measurement to appear in relation to the landmark using the Horizontal Alignment, 
Vertical Alignment, and Offset group boxes. Then, click OK. 

When you change the selections in these group boxes, the preview window shows how the measurement (the 
numbers) will appear in relation to the landmark (the circle) on the patient's tracing. 

 
Description Enter a description of this location in this text box. This description is used to identify the location in the 

Display on Tracing At drop-down list box on the Measurement Properties dialog box. 
Landmark Select the landmark near which you want this measurement to appear on tracings. 

Horizontal 
Alignment 

Select one of these radio buttons to align the measurement horizontally in relation to the selected 
landmark. 
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Vertical 
Alignment 

Select one of these radio buttons to align the measurement vertically in relation to the selected landmark. 

Offset Enter an offset in millimeters in either of these text boxes. To update the preview, click another control in 
this dialog box. 
Horiz: Enter a horizontal offset to offset the measurement from the alignment specified in the Horizontal 
Alignment group box. Enter a positive number to offset the measurement to the right. Enter a negative 
number to offset the measurement to the left. For example, if you selected Center in the Horizontal 
Alignment group box and entered -10 in this text box, the measurement will appear 10mm to the left of the 
landmark's center on the patient's tracing. 
Vert: Enter a vertical offset to offset the measurement from the alignment specified in the Vertical 
Alignment group box. Enter a positive number to offset the measurement up. Enter a negative number to 
offset the measurement down. For example, if you selected Center in the Vertical Alignment group box 
and entered -10 in this text box, the measurement will appear 10mm below the landmark's center on the 
patient's tracing. 

preview 
window 

Shows a preview of the location. In the preview, the numbers indicate the measurement's location and the 
circle indicates the location of the selected landmark. 

To define a set of custom norms: 

1. Select a norm set that you want to edit or use as the basis of a new norm set from the Use Norms drop-down list box 
on the Measurement Properties dialog box. 

2. Click Custom Norms. 

The Custom Norms dialog box is displayed as shown below. 

Note: Some norm sets are not editable. If you selected one of these from the Use Norms drop-down list box on the 
Measurement Properties dialog box, the Custom Norms dialog box is not populated with any data. 

3. If you are creating a new custom norm set, enter a descriptive name for this norm set. 

If you do not enter a name, the custom analysis editor selects a name to use for this norm set as follows: 

� If you selected an existing custom norm set from the Use Norms drop-down list box on the Measurement 
Properties dialog box, the custom analysis editor assumes you simply want to edit that existing norm set. The new 
information you enter overwrites the settings for that existing norm set. 

� If you selected a standard norm set from the Use Norms drop-down list box on the Measurement Properties dialog 
box, the custom analysis editor does not overwrite the standard norm set. Instead, it creates a new custom norm 
set and assigns the default name "Set" plus a number. For example, if Set 1, Set 2, and Set 3 already exist, the 
custom analysis editor would assign Set 4 as the default name of a new custom analysis. 

4. Specify whether the norms in this set vary by age or race by checking or unchecking the appropriate boxes. 

5. Complete the table to specify the norm set. 

For example, if both the Norms Vary by Age and Norms Vary by Race check boxes are checked, you would enter the 
following information in the table: 

� In the Age row, enter the ages in years for which you want to specify norms.  

� In the Norm row, enter a norm in each column in which you entered an age.  

� In the Std Dev row, enter a standard deviation in each column in which you entered an age. 
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The following table illustrates a norm for Male Caucasians at ages 10, 15, and 20: 

   Age #1 Age #2 Age #3 

  Age 10 15 20 

Male Caucasian Norm 55.25 60.49 65.3 

  Std Dev 2.5 2.5 2.5 

6. Click OK. 

 
Norm Set 
Name 

Enter a descriptive name for this norm set. 

Norms Vary 
by Age 

Check this box to enter a set of norms that vary depending on the patient's age. Checking this box adds 
cells to the table to accommodate norm values for different ages. 

Norms Vary 
by Race 

Check this box to enter a set of norms that vary depending on the patient's race. Checking this box adds 
cells to the table to accommodate norm values for different races. 

Table Enter the norm values in the cells in the table. The number of table cells depend on whether the Norms 
Vary by Age and Norms Vary by Race boxes are checked.  
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Setting Properties for Tracing Lines 

To set properties for a tracing line: 

1. Double-click a tracing line in the Used Tracing Lines list box. 

Or, 

Right-click a tracing line in either the Available Tracing Lines or the Used Tracing Lines list box. Then, select Properties 
from the pop-up menu. 

Or, 

Select a tracing line in either the Available Tracing Lines or the Used Tracing Lines list box. Then, click . 

The Line Properties dialog box is displayed as shown below. 

For tracing lines from the Available Tracing Lines list box, you can only view the properties. However, if you are 
viewing properties for a tracing line from the Used Tracing Lines list box, you can set properties for the line by following 
the next two steps. 

2. Select the line color. 

3. Specify whether the line should appear on patient tracings, during digitizing, or both. Then, click OK. 
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Line Color Select a radio button for the color to use for this tracing line.  

Default Line Color: Use the default color that is set on the Tracing Preferences dialog box. 
Custom Color: Use the custom color indicated by the color sample.  
Color Sample: Click this sample to set a custom color. 

Display Check one or more of these boxes to specify where you want this tracing line to appear. If you check 

During Digitizing, a red asterisk (*) appears next to the pencil line icon ( ) for the tracing line on the 
Custom Analysis Editor dialog box. 

Calculation 
Script 

Describes the calculation used to arrive at this tracing line.  
Note: Although you cannot change this script, you can select it, copy it to the clipboard, and paste it 
elsewhere (such as in an email message). 

Analyses... Click this button to view the analyses that use this tracing line. 

To view the analyses that use a tracing line: 

1. Click Analyses... 

The Used in Analyses dialog box opens and lists the analyses that use this tracing line. 

2. Click Close to close the Used in Analyses dialog box. 

Viewing Properties for a Landmark 
The Landmark Properties dialog box lists the properties for this landmark. If you are viewing the properties of a calculated 

landmark (identified on the Custom Analysis dialog box using a funnel icon ), this dialog box shows the script used to arrive 
at the landmark location, as shown below. 
Note: You cannot change landmark properties. However, you can select the calculation script on this dialog box, copy it to the 
clipboard, and paste it elsewhere (such as in an email message). 

To view properties for a landmark: 

1. Double-click a landmark in the Used Misc. Landmarks list box. 

Or, 

Right-click a landmark in either the Available Misc. Landmarks or the Used Misc. Landmarks list box. Then, select 
Properties from the pop-up menu. 

Or, 

Select a landmark in either the Available Misc. Landmarks or the Used Misc. Landmarks  list box. Then, click . 
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Saving a Custom Analysis 
When you save a custom analysis, you save all the settings, give the analysis a name, and make it available for use in other 
parts of the Dolphin Imaging program such as Digitize Setup, Measurements, and so on. 

To save a custom analysis: 

1. Click . 

Or, 

Select Save from the File menu. 

Or,  

Select Save As... from the File menu. 

If you clicked  or selected Save from the File menu and you have previously saved this custom analysis, the 
analysis is saved. In this case, skip the next step. 

If you have not previously saved this custom analysis or you selected Save As... from the File menu, the Analysis Save 
As dialog box opens so that you can provide a name for this analysis. 

2. In the Analysis Save As dialog box, enter a name for this custom analysis. Then, click OK. 
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Note: You cannot save a custom analysis using the same name as one of the existing Dolphin-provided or custom 
analyses. This feature prevents you from accidentally modifying an existing analysis. 

Previewing a Custom Analysis 

To preview your custom analysis: 

1. Save your custom analysis if you haven't already done so. 

2. Click . 

The Tracing Preview window opens. It shows a tracing created using your custom analysis. You can resize the window 
for a larger view. 

 
The Tracing Preview window uses a Dolphin layout object to display the preview. If you want, you can set properties for this 
Dolphin layout object. For example, you can select a different patient or timepoint to use for the preview, set different display 
options, and so on. 

To open the Layout Control Properties dialog box: 

1. Click the Tracing Preview window. 

The Layout Control Properties dialog box opens. For more information, see "To specify properties for a Dolphin Layout 
Object" on page 221. 
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Deleting a Custom Analysis 
You can only delete custom analyses. You cannot delete the analyses that were installed with the Dolphin Imaging program. 

To delete a custom analysis: 

1. Click . 

Or, 

Select Open... from the File menu. 

The Open Analysis dialog box is displayed. 

 
2. Select the analysis you want to delete, and click Delete. 

Or, 

Click Delete All to delete all custom analyses. 

A dialog box opens asking you to confirm the deletion. 

3. Click Yes to confirm the deletion. 

Or, 

Click No to return to the Custom Analysis Editor without deleting any custom analyses. 
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12 Measurements 
After you have digitized cephalometric landmarks for a patient, you can view detailed measurements from the tracings. This 
chapter describes the dialog box that you use to view or print a table of cephalometric measurements for different types of 
analyses.  
Before you view measurements, you need to select a patient for whom you have digitized images using the Patient Charts or 
Patient Lookup dialog box (see Chapter 4). Then, you can access the Measurements dialog box. 

To open the Measurements dialog box: 

1. Click  on the Dolphin Imaging main screen. 

Or, 

Click  on the tool bar on the Edit or Treatment Simulation dialog boxes.  

The following figure illustrates the Measurements dialog box: 

 
The Measurements dialog box contains the following sections: 

Patient 
summary 

Provides information about the selected patient (see below). 

Display options Provides buttons and drop-down list boxes that you use to select the image, analysis, and format for the 
measurements display. For more information, see "Display Options" on page 346.  
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Measurements Lists the measurements for the image and analysis selected using the display options. For more information, 
see "Measurements" on page 347. 

Other Options Provides buttons that you use to perform other operations such as exporting or printing the measurements 
table. For more information, see "Other Options" on page 348. 

To see more of the measurements table, you can click and drag the top or bottom of the dialog box to resize it.  

Patient Summary 
The patient summary part of the Measurements dialog box is illustrated below. 

 
This part of the dialog box lists: 

• The patient’s name and patient ID 

• The patient’s gender and racial category (if specified on the Patient Charts or Patient Lookup dialog box, described in 
Chapter 4) 

• The patient’s birth date and age. 

Display Options 
The display options part of the Measurements dialog box is illustrated below. 

 

Timepoint Select a timepoint from this drop-down list box. 

Image 
buttons 

Select the type of image you want to use. Your options are: 

  

 

Currently unsupported. 

  

 

Currently unsupported. 

  

 

A lateral X-ray digitized image, available on any system with Image Capture enabled. 

  

 

A frontal X-ray digitized image, available on any system with Image Capture enabled. 
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A model arch digitized image (Bolton analysis), available on any system with Image Capture enabled. 

Image Select the image that you want to use for this analysis from this drop-down list box. 

Analysis Select the analysis you want to perform from this drop-down list box. The analyses that you selected when you 
digitized the image are listed along with any other analyses that can be computed using the landmarks you 
digitized. 

Dev Norm Select the option you want to use to display deviation from the norms. Your options are: 
Standard: displays deviations from the norms as a numerical list. 
Polygon/Wiggle-gram: displays deviations from the norms graphically using a red line. 

Measurements 
The measurements part of the Measurements dialog box using the standard option for displaying norms is illustrated below. The 
information contained in this list depends on the analysis you chose. 

 

Group/Measurement The measurements for the analysis are grouped by type.  

Value The value for each measurement is listed in this column. 

Norm The norm for the patient’s gender and racial classification are listed in this column. This value is 
considered normal or average for this measurement. 

Std Dev The standard deviation for this measurement is listed in this column. Standard deviation is a statistical 
term that indicates the expected variation of data from the norm. For instance, if a measurement has a 
small standard deviation, the measurements for most patients are expected to be close to the norm. If a 
measurement has a large standard deviation, it is not expected that most patient's measurement will be 
close to the norm. 
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Dev Norm The patient’s deviation from the norm is listed in this column. This value is calculated as follows: 
Dev Norm = ( Value - Norm ) / Std Dev. 
For example, suppose a patient's value for SNA is 84 degrees, the norm is 82 degrees, and the 
standard deviation is 3.5. The patient's deviation from the norm would be: 
( 84 - 82 ) / 3.5 = 0.6 
This means this customer is 2 degrees above norm (84 - 82 = 2) for this measurement. Every 3.5 
degrees above normal is one standard deviation. So, the patient is 0.57 standard deviations above 
normal (2 / 3.5 = 0.57) In the measurements table above, 0.57 is rounded up to 0.6.  

Scroll Bar Use the scroll bar to scroll through the list of measurements. 

Measurement listing Lists the values for each measurement. Colors indicate deviations from the norm as follows: 
Black: a deviation less than or equal to 1. 
Green: a deviation greater than 1 and less than or equal to 2. 
Blue: a deviation of greater than 2 and less than or equal to 3. 
Red: a deviation of greater than 3. 

The measurements part of the Measurements dialog box using the polygon option for displaying norms is illustrated below. 

 

Other Options 

 
Print this analysis. 

 
Export this analysis. 

 
Copy this analysis to the clipboard. Dolphin Imaging copies the formatted measurement table onto the 
clipboard with the proper font, color, and column alignment.  You can paste the formatted measurement 
table from the clipboard into Microsoft Office or other applications.  In some applications you use "Edit | 
Paste" and in others "Edit | Paste Special" to paste the formatted measurements table. 
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Click this button to open the custom analysis editor to create your own analysis.  

Hide Values Check this box when using the Polygon/Wiggle-gram view to hide the Value, Norm, and Std Dev 
columns in the measurements table. 

Use Same 
Color 

Check this box to suppress the color coding used in the measurements table. 

Printing the Measurements Table 

To print the measurement table: 

1. Click Print. 

The Print dialog box opens. 

2. Set any options or properties for the print job. Then, click OK. 
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Printer Indicates the printer to which the print job will be sent.  

Properties Click this button to set advanced properties for the selected printer. 

Print Range Select what you want to print. Your options are: 
All: Print an entire document.  
Pages: Print only pages in the specified range. 
Selection: Print just what you have selected. 

Copies Enter the number of copies you want to print. 

Include Tracing Check this box to print the patient's tracing along with the measurements table. 

Preview Check this box to preview your print job on the computer screen.  

To preview your print job: 

1. Check the Preview box on the Print dialog box, and click OK. 

Or, 

Select Print from the File menu. Then, select Print Preview from the cascade menu. 

A preview of the print job appears in the Dolphin Layout Editor window. 

Note: Any changes you make to the print preview using the Dolphin Layout Editor apply to this print job only. They are 
not saved to the Dolphin layout. 

For more information on the options the Dolphin Layout Editor offers, see Chapter 7. 

2. Click  to print the print job. 

Or, 

Select Exit from the File menu to close this dialog box. 
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To specify the analysis for the table: 

1. Right-click the measurements table, and select Analysis from the pop-up menu. 

2. Select an analysis from the cascade menu. 

To toggle display of the polygon/wigglegram: 

1. Right-click the measurements table, and select Show Wigglegram from the pop-up menu. 

To toggle display of the measurement values: 

1. Right-click the measurements table, and select Show Values from the pop-up menu. 

To set properties for the measurements table: 

1. Right-click the measurements table, and select Properties from the pop-up menu. 

Or, 

Double-click the table. 

The Properties dialog box opens so that you can view and set properties that determine the formatting of the table. 
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2. Set any properties. Then, click Close. 

Display 
group box 

Specify the following options for the table: 
Analysis: Select an analysis from this drop-
down list box. 
Show Values: Check this box to display the 
measurement values on the table. 
Show Wiggle-gram: Check this box to 
display the polygon/wigglegram on the table. 

Font group 
box 

Displays the font selected for the 
measurements table. Click the button labeled 
... to open the Font dialog box and change 
the font (see below). Select the font size 
using the spinner. 

Wiggle Specify the following options for the 
polygon/wigglegram: 
Wiggle line width (mm): Enter the width in 
millimeters (mm) for the polygon/wigglegram 
line. 
Wiggle line color: Click the color sample to 
change the color of the polygon/wigglegram 
line.  
Scale Font: Displays the font scale. Click the 
button labeled ... to open the Font dialog box 
and change the font (see below). Select the 
font size using the spinner. 
Scale line width (mm): Enter the width in 
millimeters (mm) for the scale line. 
Scale font color: Click the color sample to 
change the font color for the scale. 

 

To set font options: 

1. Click the button labeled ... next to the Font field. 

The Font dialog box opens. 

2. Set any font options. 

3. Click OK. 
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Font Select the font face. 

Font Style Select the font style. 

Size Select the font size. 

Strikeout Check this box to apply the strikeout effect. 

Underline Check this box to underline the text. 

Sample Displays a preview of your chosen settings. 

Script Select the script type. 

Exporting the Measurements Table 

To export the measurement table: 

1. Click Export. 

The Save As dialog box is displayed. 

2. Select the directory and file name for the exported file.  

3. Select Tab-Delimited Text File from the Save as Type drop-down list box. Then, Click Save. 
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Save In Specify the folder in which to save the exported file. 

File Name Specify the name of the file in which to save the exported measurements table. 

Save as Type Select the type of file that you want to export. Your options are: 
Tab-Delimited Text File: save the exported file with tabs between the columns. This format is suitable for 
importing into the rows and columns of a spreadsheet. 
Standard Text File: save the exported file with spaces between the columns. This format is suitable for 
importing into a word-processing document. 

Include Header/ 
Footer 

Check this box to include the header and footer that are used when printing the measurements table. 
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To export measurements reports for multiple patients: 
1. Open the Patient Charts or Patient Lookup dialog box (see Chapter 4). 

2. Select the patients for which you want to generate measurements reports from the patient list. 

To select several adjacent patients, click the first patient, then SHIFT+Click the last patient. To select several non-
adjacent patients, click the first patient, then CTRL+Click any other patient. 

When you select several patients from the patient list, the OK button changes to a Batch button. 

3. Click Batch. 

The Batch Process Patients dialog box appears. 

4. Enter the directory in which you want to store the exported measurements reports in the Export Path text box.  

Or, 

Click the button next to the Export Path text box to browse to the directory. 

The exported measurement reports are saved in the directory you specified. Each report file is named using the 
patient’s ID and the analysis used to create the report.  

 

To transfer an exported measurements table into Microsoft Excel: 
1. Start Microsoft Excel. 

2. Select Open from the File menu. 

3. In the Open dialog box, select All Files (*.*) from the Files of Type drop-down list box. 

4. Select the file for an exported measurements table, and click Open. 

A dialog box for Step 1 of the import wizard appears where you specify information about the file. 
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5. Select the Delimited radio button. Then, click Next. 

A dialog box for Step 2 of the import wizard appears. 

 

6. In the Delimiters group box, check the Tab box. Then, click Next. 

A dialog box for Step 3 of the import wizard appears. 
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7. Select the General radio button. Then, click Finish. 

The measurements table appears in a Microsoft Excel spreadsheet. 
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13 Superimposition 
This chapter describes how to perform the following tasks: 

• superimpose a patient’s tracing on the profile photograph.  

• superimpose a patient's tracing over another tracing. 

• superimpose a patient's image over another image. 

Tracing+Image 
After you have digitized cephalometric landmarks for a patient, you can superimpose the patient’s cephalometric tracing over the 
profile image for the following purposes: 

• to analyze the patient’s soft tissue profile against the patient’s cephalometric tracing. 

• to perform common treatment simulation procedures such as CO/CR conversion and growth forecasting using the 
patient’s soft tissue profile image. 

• to prepare a case for a patient consultation or a conference with a referring doctor.  

• to give the patient a printout of the profile image with cephalometric tracings for documentation purposes. 

Many research papers have indicated that superimposing a cephalometric tracing over a patient’s image is extremely inaccurate 
and can only serve as a rough estimate of how the patient’s cephalometric tracings would fit over the patient’s profile. Therefore, 
we highly recommend that you capture radiographic images and take soft tissue images in such a way as to minimize 
discrepancies between them in orientation and view angle. Keep in mind, however, that due to the radiograph machine design 
and the distortions of the camera’s optical lens, the two images will never match exactly. 
Note: Beginning with Dolphin version 7, the Superimposition function does alter the measurements of the original cephalometric 
tracing. A superimposed tracing’s lines and angles are not only visually altered to fit the image, but its original measurements are 
also modified.  

To select the image to link with the tracing: 
1. Select a patient for whom you have a lateral cephalometric tracing and a lateral image using the Patient Charts or 

Patient Lookup dialog box (see Chapter 4). Then, click OK. 

2. On the Dolphin Imaging main screen, click  on the vertical tool bar. Then, select Link 
Tracing+Image for Treatment Simulation from the pop-up menu. 

Or, 

Select Overlay Tracing+Image from the Tools menu. 

The Linking Tracing+Image Setup dialog box opens so that you can select the image that you want to superimpose 
with the patient's tracing. By default, the profile image for the current timepoint is selected. 

3. If the image on the right is the correct image, click Continue>>. 

Or, 

If the image on the right is not the correct image, click Choose Image... (see below). 



13 Superimposition Part V: Cephalometric Tracing and Analysis 

DI_USER_GUIDE-11.5   Rev. 1.01 359 

 
Link the Tracing in this Image Shows the tracing that will be used in this superimposition. 

...with this Image Shows the image that will be used in this superimposition. 

Choose Image... Click this button to select another patient image to superimpose with this tracing. 

Continue>> Click this button to begin superimposing the tracing with the image. 

To select another image for this superimposition: 

1. Click Choose Image.... 

The Image/Record Chooser dialog box opens. 

2. Select the image you want to use in your superimposition. Then, click OK. 
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Note: You can superimpose tracings for either the frontal view or the lateral view. The following procedure describes how to 
superimpose tracings for the lateral view. If you need help in superimposing using the frontal view, please contact Dolphin. 
After you select the image to link to the patient's tracing, the Link Tracing+Image dialog box is displayed. 

 
For information on the options offered on the tool bar, see "Using the Treatment Simulation Toolbar" Error! Bookmark not 
defined.. 
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To superimpose a patient’s lateral photograph with the patient’s tracing: 

1. Click and drag the lower box to the Subnasale. 

Refer to the zoomed window on the palette to see a close-up view of the area. 

2. Click and drag the upper box to size and rotate the tracing to fit it as closely as possible over the patient’s profile 
image, paying special attention to the nasal area. 

3. If necessary, click and drag the lower box again to position it at the Subnasale. 

4. Click and drag the other landmarks to align the soft tissue profile and lip outlines in the tracing to the image. 

Or, 

Hold down the CTRL key while clicking and dragging a landmark to move only that landmark and leave nearby 
landmarks unchanged. 

On the patient’s image, manually digitized landmarks appear in red. Landmarks automatically calculated by the Dolphin 
Imaging program are gray. In addition, a calculated landmark has an asterisk (*) in its tooltip. 

Again, you can refer to the zoomed window on the palette to see a close-up view of the area when moving the 
landmarks. 

Before moving on to Treatment planning, we recommend that you save the results of overlaying the tracing on the 
profile image (see below). 

To align the patient’s image to a reference plane: 

1. On the Image Border Trim dialog box shown below, select the reference plane to use in aligning the image. 

If the Image Border Trim dialog box does not open automatically and you want to align the patient’s image, click  
on the tool bar to open the dialog box. 

Depending on the orientation of your image, the alignment procedure may produce jagged edges on the photograph, 
which may not be visually pleasing when used in a presentation. For this reason, Dolphin Imaging gives you the option 
to choose the best option for trimming the borders of the newly-oriented image. You may also choose a default border 
fill that best suits your image.  

2. Select either a black or white border to use for the image after trimming. 

3. Select an option for fixing the image after rotation. Then, click OK. 

When you click OK, the Treatment Simulation palette appears with the patient’s superimposed profile photograph in 
the Treatment Planning dialog box. For information on treatment simulation, see Chapter 16. 
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Reference 
Plane 

Select the reference plane to which you want to align this image from the following options: 
Original Orientation: Do not change the alignment of the image. 
Frankfort (Po-Or): Align a lateral image using the Frankfort reference plane. 
Horizontal Plane: Align a lateral image to a horizontal reference plane. 
TVL/Natural Head Posture (Vertical Upper - Vertical Lower): Align a lateral image using the true vertical line 
reference plane. If you are planning to use the Arnett Soft Tissue Cephalometric Analysis (STCA) for this 
patient, you must align the image using this reference plane.  For more information, see Chapter 17. 
Crista Galli - A-Point: Align a frontal image using the Crista Galli - A-Point reference plane. 

Trimming 
Color 

Select either a black or white border to use for the image after trimming. 

Trimming 
Options 

Select one of the following options for trimming the patient’s image using the preview images. 
No trim: Make no changes to the image borders. 
All sides trimmed: Crop the image on all sides to create a rectangular image area. 
Top+bottom trim: Crop the image only on the top and bottom to straighten those sides. 
Left+Right trim: Crop the image only on the left and right to straighten those sides. 
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To save the superimposed image: 

1. Click  on the palette. 

The Save Image dialog box appears. 

2. Enter an image title. 

3. Select a slot from the Save As list box in which to save this image, and click OK. 

If you attempt to save this image into a slot that already contains an image, a dialog box appears asking for 
confirmation that you want to replace the existing image with the new image. 

. 

 

Image Title Enter a title for this image, up to 25 characters. 

New Notes Optionally enter any notes for this image. 

Into Slot Select one of the slots available for each timepoint in which to save this image.  
A message below this list box indicates whether the selected slot already contains an image. If you select a 
slot containing an image, the existing image is overwritten with the new image. 

Current Slot 
Notes 

If you select a slot that already contains an image, the notes previously entered for that slot appear in this text 
box. 
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To close the Link Tracing+Image dialog box and start treatment simulation: 

1. Click  on the palette to begin treatment simulation for this patient. 

If the patient’s image needs to be aligned to a reference plane, the Image Border Trim dialog box opens so that you 
can choose options for aligning the patient’s image. 

Tracings Over Tracings 
If you have two or more digitized images for a patient, you can superimpose the tracings for analysis and comparison. You might 
want to compare: 

• tracings from different timepoints to analyze and monitor before, during, and after treatment progress. 

• one or more simulated tracings (created using Treatment Simulation, Growth, or CO/CR) to the original tracing. 

To superimpose one tracing over another: 
1. Select a patient for whom you have two or more tracings using the Patient Charts or Patient Lookup dialog box (see 

Chapter 4). Then, click OK. 

2. On the Dolphin Imaging main screen, click  on the vertical tool bar. Then, select Tracing 
Superimpositions from the pop-up menu. 

The Tracing Superimpositions dialog box appears along with the Image/Record Chooser dialog box, as shown in the 
first figure below. 

3. Select the tracings you want to use in your superimposition. Then, click OK. 

The selected tracings are displayed using different colors in the Tracing Superimpositions dialog box, as shown in the 
second figure below. 
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Choose 
Tracings... 

Opens the Image/Record Chooser dialog box so that you can add another tracing to the superimposition. 
You can superimpose any number of tracings.  

Tracing Colors... Opens the Tracing Superimposition Colors dialog box so that you can set colors for the tracings in the 
superimposition. 

List box Lists the tracings in the superposition. 

Remove Growth Click this button to remove all growth tracings from the superimposition. 

Remove Selected Click this button to remove the tracing selected in the list box from the superimposition. 

 
Click this button to copy the superimposed tracings to the clipboard. 

 
Click this button to print the superimposed tracings. 
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Click this button to open the Tracing Differences Analysis dialog box. 

 
Click this button to refit so all tracings are in the view window. 

 
Click this button to set preferences for the selected tracing. 

 
Click this button to open the Growth Superimposition Options dialog box. 

 
Click this button to open the Bolton "Normal" Tracing Option dialog box. 

 
Click this button to replace the tracings in the Tracing Superimpositions dialog box with three new tracings: 
� a tracing created by averaging the tracings originally in the dialog box 
� a tracing that represents one standard deviation above the average 
� a tracing that represents one standard deviation below the average 

Superimposition Select options for this superimposition from this group box.  
� Select the Multi-View option and select one of the options from the drop-down list box to view 

one of the available multi-view superimpositions.  
� Select one of the listed superimpositions to align the tracings using the specified landmarks. 
� Select Other and select a superimposition from the drop-down list box to align the tracings at the 

selected landmarks. 
� Create a custom superimposition by selecting the Choose Alignment option and selecting 

landmarks from the drop-down list boxes. 
Note: The Max, Md, Profile Multi-View superimposition aligns the tracings as follows: 
� For the maxilla, the tracings are aligned to the (ANS, PNS) line, with the ANS points overlapping. 
� For the mandible, the tracings are aligned to the (MENTON, GONION) line, with the MENTON 

points overlapping. 
� For the profile, the tracings are aligned to the (SUBNASALE, ST_NASION) line, with the 

SUBNASALE points overlapping. 
You can check the Allow Freeform check box (see below) to adjust these alignments. 

Allow Freeform Check this box to allow repositioning and realignment of the superimposed tracings. 

Set As Default Saves your current tracing superimposition settings as defaults.  

Save Instance Click this button to save this tracing superimposition to a file. 

Restore Instance Click this button to restore a previously-saved tracing superimposition from a file. 

Tracing display Displays the selected tracings, aligned on the selected landmark.  
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To add another tracing to this superimposition: 
1. Click Choose Tracings.... 

2. Select another tracing from the Image/Record Chooser dialog box, and click OK. 

The selected tracing is displayed in another color. 

To remove a tracing from this superimposition: 
1. In the list box on the Tracing Superimpositions dialog box, click the tracing you want to remove from the 

superimposition. 

2. Click Remove Selected. 

The selected tracing is removed from the display. 

To add one or more growth forecast tracings to this superimposition: 

1. Click . 

The Growth Superimposition Options dialog box opens. 

2. Set options for the growth forecast tracings you want to add to this superimposition, and click OK. 

The specified tracings appear, each in a different color. 
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Method Select the growth method you want to use to simulate growth 
Bolton: Select this option to use the Bolton method for the growth forecast. 

• Patient skeletal age: Enter the skeletal age for this patient, as obtained from the patient’s wrist X-ray. 
Ricketts: Select this option to use the Ricketts method for the growth forecast. 

• Growth Constants (nominal): Specify the amount of change (in millimeters) that should occur each 
year for the following landmarks: Nasion, Basion, Condylar Axis, Corpus Axis, and Tip of Nose. 

• Save as Default: Click this button to save these constants as the defaults for the Ricketts growth 
method. 

At n-year 
increments 

Specify the increment (in years) to use between multiple growth forecast tracings. For example, if you are using 
the Bolton growth method for a 10-year-old patient and you specify two-year increments, growth forecast 
tracings will be created for the ages of 12, 14, 16, and 18. 

Create n 
tracings 

Specifying the number of growth forecast tracings to create.  For the Bolton growth method, growth stops at the 
age of 18. For example, suppose you are using the Bolton growth method for a 10-year-old patient and you 
specify two-year increments and you specify that you want to create six tracings.  Although six growth forecast 
tracings will be created (for the ages of 12, 14, 16, 18, and 20), the last two tracings (ages 18 and 20) will be 
identical. 
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To add a single Bolton "normal" growth forecast tracing to this superimposition: 

1. Click . 

The Bolton "Normal" Tracing Option dialog box opens. 

2. Enter the patient age (between 6 and 18) for the growth forecast tracing you want to add to this superimposition, and 
click OK. 

The specified tracing appears in a different color. 

To remove a single growth forecast tracing from this superimposition: 
1. In the list box on the Tracing Superimpositions dialog box, click the tracing you want to remove from the 

superimposition. 

2. Click Remove Selected. 

The selected tracing is removed from the display. 

To remove all growth forecast tracings from this superimposition: 
1. Click Remove Growth. 

2. Click Yes on the confirmation dialog box that appears. 

All growth forecast tracings are removed from the display. 

The averaged tracing feature replaces the tracings in the Tracing Superimpositions dialog box with three new tracings.  
� a tracing created by averaging the tracings originally in the window. 

• a tracing that represents one standard deviation above the average 

• a tracing that represents one standard deviation below the average 

Dolphin Imaging then creates a new timepoint and saves these three tracings in it. You can use the tracings in research projects 
and to visually demonstrate average norms and values.  

To create the averaged tracings: 

1. Superimpose the tracings you want to use to create the average. 

For example, you can: 

� Generate averaged tracings from a single patient by superimposing tracings from that patient's record. 

� Generate averaged tracings from multiple patients by creating a new patient record to be used as a study record. 
Then, you can copy and paste the timepoints containing the tracings you want to use as the source data from 
several patients to the study patient record. Finally, superimpose the tracings that constitute your source data. 

For information on superimposing tracings, see “To superimpose one tracing over another” on page 364. For 
information on copying and pasting timepoints, see pages 93 and 112. 

2. Click . 

Dolphin Imaging creates the three new tracings and displays them in the dialog box: 
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When you close the Tracing Superimpositions dialog box, you see the new Averaged Tracing timepoint on the Dolphin 
Imaging main screen: 
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To set tracing colors: 

1. Click Tracing Colors... 

The Tracing Superimposition Colors dialog box opens. 

2. Click the color sample for a tracing to set the color for it. 

3. Select the color you want to use for this tracing from the Color dialog box. Then, click OK. 

4. Optionally, check the Make Permanent for Future Sessions box to use these colors from now on. 

5. Click OK. 
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color samples Click a color sample to open the Color dialog box and select a color for the associated 

tracing. 

Make Permanent for Future 
Sessions 

Check this box to use these colors from now on. 

To set tracing display preferences: 

1. Click . 

The Tracing Display Preferences dialog box is displayed. 

2. Select the analysis for which you want to specify preferences from the Analysis drop-down list box. 

3. Select all the items that you want to display on the tracing. 

If you want to set preferences for another analysis, repeat these steps for that analysis. 

4. Click OK. 

Note: The settings you make on this dialog box apply to all patient images with the selected analysis. In addition, these 
settings are retained when you exit and restart Dolphin. 
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Analysis drop-down list 
box 

Select the analysis for which you want to set tracing preferences.  

Lines/Curves Check this box to display the tracing as defined in the patient’s cephalometric analysis. 

Tooth Templates Check this box to display the templates for the patient’s teeth. 

Add’l Ceph Structures Check this box to display or hide the cephalometric structures. 

Meas Numbers Check this box to display measurement numbers as defined in the patient’s cephalometric analysis. 
Decimal: Enter the number of digits you want to display to the right of the decimal point. 
Font...: Click this button to specify the font to use.  

Landmarks Markers Check this box to display the digitized landmarks. 
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To use different landmarks for the superimposition: 
1. Select one of the radio buttons listed in the Superimpositions group box. 

2. If you selected Multi-View, select the multi-view superimposition you want to view in the list box. 

Or, 

If you selected Other, select a tracing superimposition from the drop-down list box. 

Or, 

If you selected Choose Alignment, select landmarks in the two drop-down list boxes to create a custom 
superimposition. 

The tracings are superimposed according to the option you selected. 

To adjust the superimposition using the freeform feature: 

1. Check the Allow Freeform check box. 

Two movement controls appear on the currently-selected tracing: 

� One movement control enables you to move the tracing. When you place the mouse pointer over this control, it 
turns into a hand. 

� One movement control enables you to rotate the tracing. When you place the mouse pointer over this control, it 
turns into a circular arrow. 

2. Click and drag the movement controls to adjust the alignment of the tracings. 

3. If necessary, select another tracing in the list box and move or rotate it to adjust the superimposition. 
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To view the tracing differences analysis: 

1. Click . 

The Tracing Differences Analysis dialog box opens. 

2. Optionally, click a column heading to re-sort the analysis using that column. 

Click the column heading again to switch between descending and ascending order. 

3. Click Done to return to the Tracing Superimpositions. 
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Selected Tracings Lists the tracings for this analysis. 

Coordinates 
Center 

Select the landmark to use as the coordinates center of the first tracing listed in the Selected Tracings list. 

Show 
Coordinates in 

Select one of the following options to determine how you want to list the coordinates in the table: 
� Relative (Dx,Dy): Select this option to view the differences table using relative distances 

measured from the first tracing listed in the Selected Tracings list. 
� Absolute (X,Y): Select this option to view the differences table using absolute coordinates. 

Distances arevmeasured from the first tracing listed in the Selected Tracings list. 

Hide All 
Calculated Points 

Check this box to list only digitized points in the analysis. 

 
Click this button to copy the analysis to the clipboard. In the analysis copied to the clipboard, tabs are used 
to separate the values into columns. You can then paste the analysis into another program such as 
Microsoft Excel. 

Landmark Name Names of the landmarks present in the analyzed tracings. 
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ID The identifier for the specified landmark. 

#1, #2, etc. Indicates the tracing to which the following values relate. For example, #1 refers to the first tracing listed in 
the Selected Tracings list, #2 refers to the second tracing listed in the Selected Tracings list, and so on. 

X The horizontal distance in millimeters between this landmark and the landmark identified in the Coordinates 
Center drop-down list box. 

Y The vertical distance in millimeters between this landmark and the landmark identified in the Coordinates 
Center drop-down list box. 

Dx The horizontal distance in millimeters between this landmark and the corresponding landmark in the first 
tracing listed in the Selected Tracings list. This column appears only if you have selected the Relative (Dx, 
Dy) option. 

Dy The vertical distance in millimeters between this landmark and the corresponding landmark in the first 
tracing listed in the Selected Tracings list. This column appears only if you have selected the Relative (Dx, 
Dy) option. 

Dist The distance in millimeters (taking both horizontal and vertical differences into account) between this 
landmark and the corresponding landmark in the first tracing listed in the Selected Tracings list. 

To save your current tracing superimposition settings as defaults: 

1. On the Tracing Superimpositions dialog box, click Set as Default. 

These default settings will be loaded automatically whenever you open the Tracing Superimpositions dialog box. 

To save the tracing superimposition to a file: 

1. Click Save Instance. 

The Save As dialog box appears. 

2. Specify the directory and file name in which you want to save this tracing superimposition instance.  

3. Click Save. 
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To restore a saved tracing superimposition from a file: 

1. Click Restore Instance. 

The Open dialog box appears. 

2. Specify the directory and file name containing the saved tracing superimposition instance you want to restore.  

3. Click Open. 
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To exit the Tracing Superimpositions dialog box: 

1. Click OK. 

If you opened the Tracing Superimpositions dialog box from the Dolphin Imaging main screen, you return to the 
Dolphin Imaging main screen. If you opened the Tracing Superimpositions dialog box from Treatment Simulation, you 
return to Treatment Simulation. 

Images Over Images 
If you have two or more images for a patient, you can superimpose the images for analysis and comparison. You might want to 
compare: 

• images from different timepoints to analyze and monitor before, during, and after treatment progress. 

• images from the same timepoint, such as the patient’s facial profile and lateral x-ray. 

To superimpose one image over another: 
1. Select a patient for whom you have two or more images using the Patient Charts or Patient Lookup dialog box (see 

Chapter 4). Then, click OK. 

2. On the Dolphin Imaging main screen, click  on the vertical tool bar. Then, select Image 
Superimpositions from the pop-up menu. 
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The Image Superimpositions dialog box appears along with the Image/Record Chooser dialog box, as shown in the 
first figure below. 

3. Select the images you want to use in your superimposition. Then, click OK. 

You can superimpose any number of images. The selected images are displayed in the Image Superimpositions dialog 
box, as shown in the second figure below. 
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Add Patient 
Images(s) 

Opens the Image/Record Chooser dialog box so that you can select another of this patient's images to 
add to the superimposition. 

Add Image File Opens the Select an Image File dialog box so that you can select an image stored in a file to add to the 
superimposition. 

List box Lists the images in the superposition. Images that have been calibrated, such as digitized X-ray images, 
are identified with an asterisk (*). 

 
Copies the image superimposition to the clipboard so that you can paste it into another application such 
as Microsoft Word. 

Bring to Top  Click this button to move the selected image toward the front of the superimposition. 

Resize Click this button to resize the selected image. 

Remove Click this button to remove the selected image from the superimposition. 

Slider Move the slider to adjust the transparency of the images in the superimposition. 
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Preview 
window 

Provides a preview of your changes when Fast Preview is enabled (see below). 

Fast Preview Check this box to display a preview of the changes you make in the main window. Changes appear in the 
preview window more quickly than in the main window. 

To add another Dolphin image to this superimposition: 
1. Click Add Patient Images. 

2. Select another patient image from the Image/Record Chooser dialog box dialog box, and click OK. 

The selected image is added to the superimposition. 

To add an image from a file to this superimposition: 

1. Click Add Image File. 

The Select Image File dialog box is displayed, as shown below. 

2. Select the file containing the image, and click OK. 

The selected image is added to the superimposition. 
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To remove one of the images from this superimposition: 

1. Select the image you want to remove. 

2. Click Remove. 

A dialog box opens asking you to confirm the removal. 

3. Click Yes to remove the image. 

Or, 

Click No to cancel the removal. 

To move, resize, or rotate one of the images: 

1. Optionally, check the Fast Preview box to preview your changes. 

2. Select the image you want to move, resize, or rotate. 

Eight black sizing handles and four red rotation handles appear around the edges.  

3. Click and drag the image to move it. 

Or, 

Click and drag one of the black sizing handles to resize the image. 

Or, 

Click and drag one of the red rotation handles to rotate the image. 

Note: For best results when rotating the image, keep the mouse down, rotate the image back and forth until you see 
the desired result, then release the mouse button. If you rotate the image using several, separate rotation operations, 
the image quality can degrade, especially on lower resolution images. 

To resize an image using another image's calibration: 

1. Select the image you want to resize. 

2. Click Resize. 

The image is resized using the calibration specified for the image listed directly above it in the image list. In the 
example below, the facial profile image will be resized using the calibration for the digitized lateral ceph image listed 
above it in the image list. 



13 Superimposition Part V: Cephalometric Tracing and Analysis 

DI_USER_GUIDE-11.5   Rev. 1.01 385 

 

To change the order of the images in a superimposition: 

1. Select one of the images that is not on top in the superimposition. 

2. Click Bring to Top to move that image to the top of the superimposition. 

To change the transparency of the pictures: 

1. Optionally, check the Fast Preview box to preview your changes. 

2. Move the transparency slider so that you can see all the images in the superimposition. 

To return to the Dolphin Imaging Main Screen: 

1. Click OK. 
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Part VI: Treatment Simulation 
This part of the Dolphin Imaging User’s Guide provides detailed information on using the Treatment Simulation Dolphin Imaging 
module. This module enables you to accurately plan, diagnose, and present cases. It’s also the perfect tool for interdisciplinary 
clinicians to work in concert. 
This part of the Dolphin Imaging User’s Guide Help describes the operations for: 

• CO/CR conversion 

• Growth forecast 

• Orthodontic and surgical treatment simulation 

Note: This part does not include information on the Dolphin Arnett/McLaughlin treatment analysis. For more information on this 
module, refer to "Part VII: Arnett/McLaughlin Interactive Treatment Analysis." 
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14 CO/CR Conversion 
The CO/CR feature repositions a patient’s condyle from centric occlusion (CO) to centric relation (CR). For some patients, this 
step is necessary before performing any treatment simulation procedures. From the indicator values obtained from an articulated 
study model in centric occlusion, Dolphin calculates new cephalometric values with the mandible re-positioned in centric relation. 
As a result, the patient’s cephalometric values are updated from the appropriate amount of condylar adjustment. The indicator 
value can be either the Condylar Position Indicator value (CPI) for Panadent Articulator systems or Mandibular Position Indicator 
values (MPI) for SAM Articulator systems. 
The head of condyle is repositioned by "fulcruming" (pivoting) about the indicated first tooth contact (as seen on the mounted 
model). This pivot point is usually (but not necessarily) the most distal tooth (i.e., second molars).  
To use CO/CR, you typically need the following: 

• a lateral X-ray digitized with the Roth-Williams AEO (recommended), Roth-Jarabak, or Jarabak analyses and with 
traced skeletal structures. 

• a lateral photograph of the patient (optional). 

Although you can use CO/CR with just a digitized lateral X-ray, it is more difficult to demonstrate the effect of the treatment to the 
patient without using the profile photograph superimposed with the tracing. For patient consultations, we recommend performing 
CO/CR and other treatment simulations with the patient’s profile photograph. 
To verify that the pictures you need are available, select the - Everything - layout from the Layout drop-down list box on the 
Dolphin Imaging System main screen. This layout  contains all patient images for the selected timepoint. If the digitized lateral X-
ray and lateral photograph are available for this patient and timepoint, the images will be available from this image layout. 
Once you have verified that these images are available, you may choose to superimpose the tracings over the patient’s profile 
photograph. For more information on creating a superimposed image, see Chapter 13. 

To access CO/CR conversion: 

1. Select the superimposed or digitized lateral ceph image from the Dolphin Imaging main screen, if it is not already 
selected. 

Or, 

Select the saved image for a previously-performed CO-CR conversion operation. 

If you do not have a superimposed image, you can create one using the superimpose feature (see Chapter 13). If you 
already have a superimposed image, you can select it by selecting the Treatment Forecast layout from the Layout 
drop-down list box on the Dolphin Imaging main screen. 

If you have already performed CO-CR conversion for this patient, you can find the saved image for that operation in the 
Treatment Forecast layout on the Dolphin Imaging main screen. For more information, see "To choose another layout" 
on page 53. 

2. Click  on the Dolphin Imaging main screen. 

Or,  

Select Treatment Simulation from the Tools menu on the Dolphin Imaging main screen. 

Or, 

Select Start Treatment from the Link Tracing+Image dialog box. 
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3. Click the CO-CR tab on the Treatment Simulation palette. 

If you have not performed CO-CR conversion for this patient, the CPI Graphs dialog box opens when you select the 
CO-CR tab. For more information, see "Entering Values on the CPI Graphs" on page 392. 

Otherwise, the CO-CR tab summarizes the values for the previously-performed CO-CR conversion operation (see 
below). 

Using the CO-CR Tab 
The CO-CR tab offers options for CO/CR Conversion and summarizes the values for any previously-performed CO-CR 
conversion operation, as shown below. 
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CO-CR Tab Specify information about the CO/CR operation you want to perform on this tab.  
CPI Graphs...: Click this button to open the CPI Graphs dialog box and enter values on the Condylar Position 
Indicator (CPI) graphs for the CO/CR operation you want to perform. 
Average: Use these text boxes to set the average values for the deviation. Distal (x) indicates the average 
lateral value, also referred to as Delta x. Vertical (z) indicates the average vertical value, also referred to as 
Delta z. 
Rotate Md @ Hinge Axis: You can specify a number of degrees to rotate the patient’s mandible about the 
hinge axis. This operation does not take tooth contact into consideration. 
For information about the Growth tab, see Chapter 15. For information about the TxPlan tab, see Chapter 16.  

Soft Tissue 
Profile 

Use these options to make changes to the patient’s soft tissue profile. For more information, see Chapter 16. 
Note: This option is not available when the CO-CR tab is selected. 

Superimpose... Click this button and select one of the listed superimpositions to align the original and treatment simulation 
tracings using the specified landmarks. For more information on using landmarks to align tracings, see "To 
use different landmarks for the superimposition" on page 374. Click Advanced.. to open the Tracing 
Superimpositions dialog box with the original and treatment simulation tracings. For more information about 
the Tracing Superimpositions dialog box, see "Tracings over Tracings" on page 364. 

Procedures... Click this button and select the type of procedures you want to simulate.  
Ortho and Surgical: Enables features for simulating both orthodontic and surgical procedures. 
Ortho only: Enables features for simulating orthodontic procedures only. Features for simulating surgical 
procedures are disabled. 
Surgical only: Enables features for simulating surgical procedures only. Features for simulating orthodontic 
procedures are disabled. 

Undo List Select this tab to list treatment simulation operations that you have performed since you last saved. You can 
easily return to any point in your treatment planning session by clicking one of the operations in this list. To 
return to the beginning of your treatment simulation session, click Original.  

Prev Notes Select this tab to view operations and other notes from previously-saved operations. You cannot delete or 
jump to any of these operations.  

Delete Rest Available only when one of the operations on the Undo List tab is selected. Click this button to delete all 
operations in the Undo List below the selected operation.  

To set average CPI values: 

1. Enter the average lateral value, also referred to as Delta x, in the Distal (x) text box. 

2. Enter the average vertical value, also referred to as Delta z, in the Vertical (z)  text box. 

The Dolphin imaging program remembers these values the next time you open the CO-CR tab. 



14 CO/CR Conversion Part VI: Treatment Simulation 

DI_USER_GUIDE-11.5   Rev. 1.01 391 

Using the Treatment Simulation Tool Bar 
The Treatment Simulation Tool Bar contains the following buttons: 

 
Opens the Treatment Simulation module. 

 
Opens the Morph tool. For more information, see "The Morph Palette" on page 277. 

 
Opens the Brushes tool. For more information, see "The Brushes Palette" on page 281. 

 
Sets the display option for the image. For more information, see "To set the display mode for the patient's image" 
on page 407. 

 
Displays the modified image side-by-side with the original image. For more information, see "Viewing Two Images 
Side by Side" on page 272. 

 
Toggles display of the original tracing. For more information, see "To overlay the patient’s original tracing over the 
tracing you are modifying with Treatment Simulation” on page 410. 

 
Toggles the display of the patient’s tracing. 

 
Opens the Enhance tool. For more information, see "To enhance a picture” on page 164. 

 
Sets display preferences. For more information, see "To set display preferences" on page 408. 

 
Opens the original records window. For more information, see “Using the Original Records Window” on page 412. 

 
Opens the measurements table. For more information, see Chapter 12.. 

 
Starts the Arnett Wizard. For more information, see Chapter 17. 

 
Opens the McLaughlin Dental VTO Analysis. For more information, see Chapter 18. 

 
Aligns the image to a reference plane. For more information, see "To align the patient's image to a reference plane" 
on page 361. 

 
Opens the Ricketts VTO/Roth-Williams VTO Wizard. For more information, see Chapter 19. 

 
Undoes the previous operation. 

 
Opens the Link Tracing+Image window. For more information, see "Tracing+Image" on page 358. 

 
Saves the image. For more information, see "Saving the Treatment Simulation" on page 427. 

 
Prints the image. For more information, see "To print the treatment simulation" on page 410. 

 
Copies the image and/or its tracings to the clipboard. 

 
Returns to the Dolphin Imaging main screen. For more information, see Chapter 3. 
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Entering Values on the CPI Graphs 
The goal of CO/CR Conversion is to create a corrected lateral cephalogram that matches the articulator mounting. To do this, 
you enter the indicator values obtained from an articulated study model in centric occlusion (CO) on the CPI graphs. Then, 
Dolphin calculates new cephalometric values with the mandible re-positioned in centric relation (CR). 

To enter values on the CPI graphs: 

1. Click CPI Graphs... if the CPI Graphs dialog box is not already open. 

The CPI Graphs dialog box opens. 

2. Enter the values from the articulated, mounted study model CPI graphs. 

To enter the values, first click and drag the black dot from the center of the graph to the location indicated on the 
corresponding graph for the articulated, mounted study model.  Next, click and drag the red dot. 

Alternatively, you can enter values in the Distal (x) and Vertical (z) fields below the graphs. 

When you enter these values, Dolphin calculates and displays the average for each direction.  

3. Click OK. 

Dolphin moves the head of condyle based on the average values, creating a new CR  tracing in red superimposed over 
the original CO tracing, which appears in black. 
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RIGHT Move the black and red dots on the graph to the positions indicated on the articulated, mounted study model CPI 
graphs for the right side. Initially, both the black and red dots are in the center of the right graph. 
Alternatively, you can enter values in the fields below the graph: 
Distal (x): The head of condyle moves by the horizontal reading (repositioning of condyle).  Values greater than 
zero result in anterior movement.  Values less than zero result in posterior movement. For example, if the value 
is 2.5mm, the head of condyle is moved anteriorly 2.5mm at the condylar axis. 
Vertical (z): The head of condyle moves by the vertical reading (repositioning of condyle). Values greater than 
zero result in upward movement.  Values less than zero result in downward movement. For example, if value is 
2.5mm, the head of condyle is moved superiorly 2.5mm at the condylar axis. 

LEFT Move the black and red dots on the graph to the positions indicated on the articulated, mounted study model CPI 
graphs for the left side. Initially, both the black and red dots are in the center of the left graph. 
Alternatively, you can enter values in the fields below the graph: 
Distal (x): The head of condyle moves by the horizontal reading (repositioning of condyle).  Values greater than 
zero result in anterior movement.  Values less than zero result in posterior movement. For example, if the value 
is 2.5mm, the head of condyle is moved anteriorly 2.5mm at the condylar axis. 
Vertical (z): The head of condyle moves by the vertical reading (repositioning of condyle). Values greater than 
zero result in upward movement.  Values less than zero result in downward movement. For example, if value is 
2.5mm, the head of condyle is moved superiorly 2.5mm at the condylar axis. 

Average Averages of right and left values. 
Distal (x): The head of condyle (thus the entire mandible) moves by the average horizontal reading 
(repositioning the condyle).  Values greater than zero result in anterior movement.  Values less than zero result 
in posterior movement. For example, if the average value is 2.5mm, the mandible is moved anteriorly 2.5mm at 
the condylar axis. 
Vertical (z): The head of condyle (thus the entire mandible) moves by the average vertical reading (repositioning 
the condyle). Values greater than zero result in upward movement.  Values less than zero result in downward 
movement. For example, if the average value is 2.5mm, the mandible is moved superiorly 2.5mm at the condylar 
axis. 

Reset Click this button to move the black and red dots on both graphs back to the center. 
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Fine-tuning the Tracing 
After you enter values on the CPI graphs, Dolphin creates a new CR  tracing in red superimposed over the original CO tracing, 
which appears in black (see below). You can use the blue movement controls and the Rotate Md .@ Hinge Axis field on the CO-
CR palette to fine-tune the CR tracing. 

 

To fine-tune the tracing: 

1. Optionally, click and drag the movement control at the hinge axis point to correct its location. 

In most analyses, the hinge axis point is a calculated point.  Moving this movement control enables you to ensure that 
the hinge axis point is correctly identified on the tracing. 

2. Optionally, click and drag the movement control at the DC point to correct its location. 

Based on your changes, Dolphin updates the patient’s cephalometric tracings and associated image. In addition, the 

operations you performed are added to the Undo List box. You can click   on the tool bar to view measurements 
updated to reflect the operation you performed.  For more information on measurements, see Chapter 12. 
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3. Click and drag the movement control on the mandible to auto-rotate it. 

Or, 

Enter a value in the Rotate Md .@ Hinge Axis field. 

At this point, you can proceed to Treatment Simulation by clicking the TxPlan tab on the palette. For more information 
on Treatment Simulation, see Chapter 16. 

To return the image to any point in the history list: 
1. Select the Undo List tab if it isn't already selected. 

2. Select the operation that you want to return to in the Undo List box. 

3. Click Delete Rest to delete all operations performed after the selected operation. 

Saving the CO/CR Conversion Operation 
When you save the CO/CR conversion operation, Dolphin always saves both of the following: 

• the image and data that reflect the CO/CR conversion operation 

• the original image and data, for your reference or further treatment simulation 

To save the treatment image after you have finished the CO/CR conversion operation: 

1. Click . 

The Save Image dialog box is displayed. 

2. Optionally, modify the image title. 

Dolphin automatically provides an appropriate image title, "Treatment Simulation" in most cases. However, you may 
wish to enter a more specific name (for example, "CO/CR"), as appropriate for this image and data. 

3. Select a slot from the Save As list box in which to save this image, and click OK. 

For each patient and timepoint, you can save up to eight different treatment simulations. 

Note: If you are viewing two images side by side when you save, the side-by-side view of the two images is saved as a 
single image. 
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Image Title Enter a title for this image, up to 25 characters. 

New Notes Notes for this image. This text box is automatically completed with a summary of the operations you performed. 
However, you can freely modify the content of these notes. When you view this treatment simulation again later, 
you can access these notes using the Previous Notes tab on the Treatment Simulation palette. 

Into Slot Select one of the eight slots available for each timepoint in which to save this image.  
The field below this list box indicates whether the selected slot already contains an image. If you select a slot 
containing an image, the existing image is overwritten with the new image. 

Current 
Slot Notes 

If you select a slot that already contains an image, the notes previously entered for that slot appear in this text 
box. 
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15 Growth 
The Growth feature provides a lateral profile growth forecast. The Growth feature forecasts growth on the patient’s lateral 
photograph and cephalometric tracings. The data used for the growth prediction is either the Bolton or Ricketts norms. 
Before using the growth feature, you need: 

• a lateral photograph of the patient. 

• a lateral X-ray digitized with the @Treatment Plan analysis. 

To verify that the pictures you need are available, select the - Everything - layout from the Layout drop-down list box on the 
Dolphin Imaging System main screen. This layout  contains all patient images for the selected timepoint. If the digitized lateral X-
ray and lateral photograph are available for this patient and timepoint, the images will be available from this image layout. 
Once you have verified that these images are available, you need to superimpose the tracings over the patient’s lateral 
photograph.  For more information on creating a superimposed image, see Chapter 13. 

To access the Growth Forecast: 

1. Select the superimposed image from the Dolphin Imaging main screen, if it is not already selected. 

If you do not have a superimposed image, you can create one using the superimpose feature (see Chapter 13). If you 
already have a superimposed image, you can select it by selecting the Forecast layout from the Layout drop-down list 
box on the Dolphin Imaging main screen. 

2. Click  on the Dolphin Imaging main screen. 

Or,  

Select Treatment Simulation from the Tools menu on the Dolphin Imaging main screen. 

Or, 

Select Start Treatment from the Link Tracing+Image dialog box. 

When you enter the Treatment Simulation module, the digitized lateral X-ray with traced skeletal structures or the 
superimposed image appears in the Edit dialog box along with the Treatment Simulation palette. 

3. Click the Growth tab on the Treatment Simulation palette. 

When you select the Growth tab, the Growth Forecast options appear as shown below. 
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Growth 
Tab 

Specify information about the growth operation you want to perform on this tab.  
Method: Select the growth method you want to use to simulate growth 

Bolton: Select this option to use the Bolton method for the growth forecast. This method can simulate 
growth up to age 18. 

� Patient skeletal age: Enter the skeletal age for this patient, as obtained from the patient’s 
wrist X-ray. 

Ricketts: Select this option to use the Ricketts method for the growth forecast. 
Growth (years): Enter the number of years you want to add to this patient's age for this simulation. 
Grow Now: Click this button to begin the growth forecast.  
For information about the TxPlan tab, see Chapter 16.  For information about the CO-CR tab, see Chapter 14. 
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Soft Tissue 
Profile 

Use these options to make changes to the patient’s soft tissue profile. For more information, see Chapter 16. 
Note: This option is not available when the Growth tab is selected. 

Superimpose... Click this button and select one of the listed superimpositions to align the original and treatment simulation 
tracings using the specified landmarks. For more information on using landmarks to align tracings, see "To 
use different landmarks for the superimposition" on page 374. Click Advanced.. to open the Tracing 
Superimpositions dialog box with the original and treatment simulation tracings. For more information about 
the Tracing Superimpositions dialog box, see "Tracings over Tracings" on page 364. 

Procedures... Click this button and select the type of procedures you want to simulate.  
Ortho and Surgical: Enables features for simulating both orthodontic and surgical procedures. 
Ortho only: Enables features for simulating orthodontic procedures only. Features for simulating surgical 
procedures are disabled. 
Surgical only: Enables features for simulating surgical procedures only. Features for simulating orthodontic 
procedures are disabled. 

Undo List Select this tab to list treatment simulation operations that you have performed since you last saved. You can 
easily return to any point in your treatment planning session by clicking one of the operations in this list. To 
return to the beginning of your treatment simulation session, click Original.  

Prev Notes Select this tab to view operations and other notes from previously-saved operations. You cannot delete or 
jump to any of these operations.  

Delete Rest Available only when one of the operations on the Undo List tab is selected. Click this button to delete all 
operations in the Undo List below the selected operation.  

Using the Treatment Simulation Tool Bar 
The Treatment Simulation Tool Bar contains the following buttons: 

 
Opens the Treatment Simulation module. 

 
Opens the Morph tool. For more information, see "The Morph Palette" on page 277. 

 
Opens the Brushes tool. For more information, see "The Brushes Palette" on page 281. 

 
Sets the display option for the image. For more information, see "To set the display mode for the patient's image" 
on page 407. 

 
Displays the modified image side-by-side with the original image. For more information, see "Viewing Two Images 
Side by Side" on page 272. 

 
Toggles display of the original tracing. For more information, see "To overlay the patient’s original tracing over the 
tracing you are modifying with Treatment Simulation” on page 410. 

 
Toggles the display of the patient’s tracing. 

 
Opens the Enhance tool. For more information, see "To enhance a picture” on page 164. 

 
Sets display preferences. For more information, see "To set display preferences" on page 408. 
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Opens the original records window. For more information, see “Using the Original Records Window” on page 412. 

 
Opens the measurements table. For more information, see Chapter 12.. 

 
Starts the Arnett Wizard. For more information, see Chapter 17. 

 
Opens the McLaughlin Dental VTO Analysis. For more information, see Chapter 18. 

 
Aligns the image to a reference plane. For more information, see "To align the patient's image to a reference plane" 
on page 361. 

 
Opens the Ricketts VTO/Roth-Williams VTO Wizard. For more information, see Chapter 19. 

 
Undoes the previous operation. 

 
Opens the Link Tracing+Image window. For more information, see "Tracing+Image" on page 358. 

 
Saves the image. For more information, see "Saving the Treatment Simulation" on page 427. 

 
Prints the image. For more information, see "To print the treatment simulation" on page 410. 

 
Copies the image and/or its tracings to the clipboard. 

 
Returns to the Dolphin Imaging main screen. For more information, see Chapter 3. 

Forecasting the Patient's Growth 

To forecast the patient’s growth: 

1. Select the method you want to use to simulate growth (either Bolton or Ricketts). 

2. If you are using the Bolton growth method, enter or correct the patient’s skeletal age. 

The patient’s skeletal age is typically determined from a wrist X-ray. The default value for skeletal age is the patient’s 
chronological age, determined from the patient’s birth date entered on the Patient Charts or Patient Lookup dialog box. 

3. Enter the number of years that you want to add to the patient's age in this growth forecast. 

4. Click Grow Now. 

The patient’s image updates to simulate growth. 

To return the image to any point in the history list: 
1. Select the Undo List tab if it isn't already selected. 

2. Select the operation that you want to return to in the Undo List box. 

3. Click Delete Rest to delete all operations performed after the selected operation. 
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Saving the Growth Prediction 
When you save the growth prediction, Dolphin always saves both of the following: 

• the image and data that comprise the growth prediction 

• the original image and data, for your reference or further treatment simulation 

To save the growth prediction: 

1. Click . 

The Save Image dialog box is displayed. 

2. Optionally, modify the image title. 

Dolphin automatically provides an appropriate image title, "Treatment Simulation" in most cases. However, you may 
wish to enter a more specific name (for example, "Growth Prediction"). 

3. Select a slot from the Save As list box in which to save this image, and click OK. 

For each patient and timepoint, you can save up to eight different treatment simulations. 

Note: If you are viewing two images side by side when you save, the side-by-side view of the two images is saved as a 
single image. 
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Image 
Title 

Enter a title for this image, up to 25 characters. 

New 
Notes 

Notes for this image. This text box is automatically completed with a summary of the operations you performed. 
However, you can freely modify the content of these notes. When you view this treatment simulation again later, 
you can access these notes using the Previous Notes tab on the Treatment Simulation palette (see "Using the 
Treatment Simulation Palette" on page 406). 

Into Slot Select one of the eight slots available for each timepoint in which to save this image.  
The field below this list box indicates whether the selected slot already contains an image. If you select a slot 
containing an image, the existing image is overwritten with the new image. 

Current 
Slot Notes 

If you select a slot that already contains an image, the notes previously entered for that slot appear in this text box. 
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16 Treatment Simulation 
The Treatment Simulation feature provides a scientifically-based orthodontic and surgical treatment simulation and prediction 
tool. When you enter treatment planning information, the Treatment Simulation program simulates the treatment results on the 
patient’s lateral cephalometric tracings, with the option of updating the patient’s soft tissue image. The Treatment Simulation 
program works only in the lateral view. 
Using the Treatment Simulation feature, you can simulate: 

• tooth and skeletal movement based on orthodontic treatment. 

• skeletal and soft tissue changes as a result of oral maxillo-facial surgery. 

If you have purchased the Consultation and Image Library module, you may find that using use the Morph tool on the Image Edit 
dialog box is adequate for patient presentation purposes, which provides a fast and more artistic method for communicating 
treatment options. The Treatment Simulation feature, of course, provides more consistent results, but this level of accuracy may 
not be necessary for merely communicating treatment options to the patient. You also may want to augment the images resulting 
from treatment simulation using the Morph and Brush tools. For more information, see Chapter 8. 

To use treatment simulation, you typically need the following: 

• a lateral X-ray digitized with the @Treatment Plan analysis. 

• a lateral photograph of the patient (optional). 

You can use treatment simulation with only a digitized lateral X-ray. However, for treatment presentations, we highly recommend 
that you perform treatment simulation operations using a digitized X-ray overlaid with the patient’s profile image.  
To verify that the pictures you need are available, select the - Everything - layout from the Layout drop-down list box on the 
Dolphin Imaging System main screen. This layout contains all patient images for the selected timepoint. If the digitized lateral X-
ray and lateral photograph are available for this patient and timepoint, the images will be available from this image layout. 
Once you have verified that these images are available, you need to superimpose the tracings over the patient’s lateral 
photograph if you wish to perform treatment simulation using the patient’s image. For more information on creating a 
superimposed image, see Chapter 13. 

To access Treatment Simulation: 

1. On the Dolphin Imaging main screen, select a layout containing either a lateral X-ray digitized with the @Treatment 
Plan analysis or a profile photograph of the patient superimposed with the patient’s tracing. 

The - Everything - layout contains all patient images for the selected timepoint. If either of these images is available for 
this patient and timepoint, it will be available from this image layout. 

For more information on superimposing the patient’s profile photograph and tracing, see Chapter 13. 

2. Click  on the Dolphin Imaging main screen. 

Or,  

Select Treatment Simulation from the Tools menu on the Dolphin Imaging main screen. 

Or, 

Select Start Treatment from the Link Tracing+Image dialog box. 
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When you enter the Treatment Simulation module, the digitized lateral X-ray or the superimposed image appears in the 
Edit dialog box along with the Treatment Simulation palette as shown below. The image (X-ray or profile image) 
appears in "draft mode" by default, which enables Dolphin to apply the treatment operations quickly, so that you do not 
need to wait for the computer to process any image morphing.  

Note: If you previously performed CO/CR or Growth operations for this patient, the results of those operations are 
taken as the starting point for your treatment simulation.  For this reason, all values on the Treatment Simulation 
palette are zero. 

 

Treatment 
Simulation palette 

Provides tools that you use to enter information about the treatment you want to simulate. This palette is 
described in more detail below. 

image or X-ray The image or X-ray you selected on the Dolphin Imaging main screen. When you enter Treatment 
Simulation, the image or X-ray is in draft mode. For more information, see "To set the display mode for 
the patient's image" on page 407. 

Movement  
Controls 

Click and drag these squares to graphically specify movement to simulate orthodontic or surgical 
treatment. You can also type values in the Treatment Simulation palette. For more information, see "To 
use the movement controls to simulate treatment" and "To enter movement values to simulate treatment" 
on page 417. 
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Using the Treatment Simulation Tool Bar 
The Treatment Simulation Tool Bar contains the following buttons: 

 
Opens the Treatment Simulation module. 

 
Opens the Morph tool. For more information, see "The Morph Palette" on page 277. 

 
Opens the Brushes tool. For more information, see "The Brushes Palette" on page 281. 

 
Sets the display option for the image. For more information, see "To set the display mode for the patient's image" 
on page 407. 

 
Displays the modified image side-by-side with the original image. For more information, see "Viewing Two Images 
Side by Side" on page 272. 

 
Toggles display of the original tracing. For more information, see "To overlay the patient’s original tracing over the 
tracing you are modifying with Treatment Simulation” on page 410. 

 
Toggles the display of the patient’s tracing. 

 
Opens the Enhance tool. For more information, see "To enhance a picture” on page 164. 

 
Sets display preferences. For more information, see "To set display preferences" on page 408. 

 
Opens the original records window. For more information, see “Using the Original Records Window” on page 412. 

 
Opens the measurements table. For more information, see Chapter 12.. 

 
Starts the Arnett Wizard. For more information, see Chapter 17. 

 
Opens the McLaughlin Dental VTO Analysis. For more information, see Chapter 18. 

 
Aligns the image to a reference plane. For more information, see "To align the patient's image to a reference plane" 
on page 361. 

 
Opens the Ricketts VTO/Roth-Williams VTO Wizard. For more information, see Chapter 19. 

 
Undoes the previous operation. 

 
Opens the Link Tracing+Image window. For more information, see "Tracing+Image" on page 358. 

 
Saves the image. For more information, see "Saving the Treatment Simulation" on page 427. 

 
Prints the image. For more information, see "To print the treatment simulation" on page 410. 

 
Copies the image and/or its tracings to the clipboard. 

 
Returns to the Dolphin Imaging main screen. For more information, see Chapter 3. 
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Using the Treatment Simulation Palette 
The following figure illustrates the tools available on the Treatment Planning palette. In this figure, the palette has been 
expanded by clicking the More>> button. 

 

More>> or 
<<Less 

Click this button to open or close the expanded version of the Treatment Simulation palette, which includes 
text boxes in which you can enter exact values or increment values of treatment operations. When the 
palette is expanded, click this button to hide the expanded view. 

Treatment 
Simulation Tabs 

Select these tabs to use the treatment simulation operations. 
CO-CR: Select this tab to reposition a patient’s condyle and bite from centric occlusion to centric relation. 
For some patients, this step is necessary before performing any treatment simulation procedures. For 
more information, see Chapter 14. 
Growth: Select this tab to forecast the patient’s growth. For more information, see Chapter 15. 
TxPlan: Select this tab to perform treatment simulation.  
Model Block Surgery: Check this box to perform treatment simulation based on the physical occlusal 
model of the patient. For more information, see "Simulating Model Block Surgery" on page 420. 
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Goals: Select this tab to set the desired orthodontic values to specific common orthodontic cephalometric 
measurements. Dolphin automatically alters the appropriate skeletal structures and soft-tissue profile to get 
the closest value specified. Please contact Dolphin if you want to see other values listed here. For more 
information, see "Using the Goals Feature" on page 416. 

Soft Tissue 
Profile 

Use these options to fine-tune the patient’s soft tissue profile after the other treatment simulation 
processes.  
Profile touch-up: Select this option to fine-tune the patient’s profile outline and soft tissue. For more 
information, see "To touch up the patient's profile" on page 421. 
Lip reposturing: Select this option to quickly reposition the patient’s lip area.  For more information, see 
"To touch up the patient's profile" on page 421. 
Auto Adjust Lips: Use these sliders to make automated, idealized adjustments in both anterior/posterior 
and vertical directions to the appearance of the patient’s lip outline. 

Superimpose... Click this button and select one of the listed superimpositions to align the original and treatment simulation 
tracings using the specified landmarks. For more information on using landmarks to align tracings, see "To 
use different landmarks for the superimposition" on page 374. Click Advanced.. to open the Tracing 
Superimpositions dialog box with the original and treatment simulation tracings. For more information 
about the Tracing Superimpositions dialog box, see "Tracings over Tracings" on page 364. 

Procedures... Click this button and select the type of procedures you want to simulate.  
Ortho and Surgical: Enables features for simulating both orthodontic and surgical procedures. 
Ortho only: Displays structures in orthodontic style and enables features for simulating orthodontic 
procedures only. Features for simulating surgical procedures are disabled. 
Surgical only: Displays structures in surgical style and enables features for simulating surgical procedures 
only. Features for simulating orthodontic procedures are disabled. 

Undo List Select this tab to list treatment simulation operations that you have performed since you last saved. You 
can easily return to any point in your treatment planning session by clicking one of the operations in this 
list. To return to the beginning of your treatment simulation session, click Original.  

Prev Notes Select this tab to view operations and other notes from previously-saved operations. You cannot delete or 
jump to any of these operations.  

Delete Rest Available only when one of the operations on the Undo List tab is selected. Click this button to delete all 
operations in the Undo List below the selected operation.  
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To set the display mode for the patient’s image: 
Note: When you open the Treatment Simulation dialog box, the patient’s image or X-ray is in draft mode. 

1. Click   on the tool bar. 

A pop-up menu displays the following options: 

Presentation 
Mode 

Provides the highest resolution image, but slower performance in display. If your images have a 
resolution greater than 1000x1000 pixels, we recommend that you switch to this mode when you 
finish treatment simulation operations. 

Draft Mode Displays a slightly lower resolution image that is faded by 50% for faster performance in display. 
This option is the default and recommended option, because it provides a quick display of the 
tracings and image while updating the soft tissue image. 

Hide Image Hides the image entirely, showing only the profile tracing. This option provides the fastest 
performance in display since no image re-calculation is necessary. 

2. Select a display mode option. 

To set display preferences: 

1. Click   on the tool bar. 

2. Select the analysis for which you want to specify tracing preferences from the Analysis drop-down list box. 

3. In the Main Display group box, select all the items that you want to display on the tracing. 

4. To change the color for any of the items listed in the Main Display group box, click the color sample and select a new 
color. 

If you want to set preferences for another analysis, repeat these steps for that analysis. 

Note: The settings you make on this dialog box apply to all patient images with the selected analysis. In addition, these 
settings are retained when you exit and restart Dolphin. 
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Analysis drop-down list box Select the analysis for which you want to set tracing preferences.  

Tracing Lines/Curves Check this box to display the tracing as defined in the patient’s cephalometric analysis. 

Tooth Templates Check this box to display the templates for the patient’s teeth. 

Meas Numbers Check this box to display measurement numbers as defined in the patient’s cephalometric 
analysis. 
Decimal: Enter the number of digits you want to display to the right of the decimal point. 
Fonts: Click this button to select the font in which to display the measurement numbers. 
Use the Same Color: Check this box to use the same color for all measurement numbers. 
By default, the color of each measurement number is determined by that measurement’s 
deviation from the norm. 

Add’l Ceph Structures Check this box to display the cephalometric structures. 

Landmarks Markers Check this box to display the digitized landmarks. 

Movement Controls Check this box to display the movement controls. 

Original Tracing Lines Check this box to display the original tracing lines. 

Color Samples Check these boxes to change the color in which the associated element is displayed. 

To return the image to any point in the history list: 
1. Select the Undo List tab if it isn't already selected. 

2. Select the operation that you want to return to in the Undo List box. 

3. Click Delete Rest to delete all operations performed after the selected operation. 
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To overlay the patient’s original tracing over the tracing you are modifying with Treatment Simulation: 

1. Click  on the tool bar. 

The original tracing appears over the current tracing. The following figure illustrates an original tracing in black 
overlaying a treatment simulation tracing in red. You can choose the color of the current and original tracings. For more 
information, see "To set tracing preferences" on page 78. 
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To print the treatment simulation: 

1. Click   on the tool bar. 

A pop-up menu displays the following options: 

With Operation History 
List 

Prints the patient image, the treatment simulation information, and the operation history 
list (listed on the Undo List). 

Without Operation 
History List 

Prints only the patient image and treatment simulation information. The history list is not 
included. 

Close This Menu Closes the menu without making a selection. 

2. Select a printing option. 

The Print dialog box appears. 

3. Select any printing options you want and click OK. 

 

Printer Indicates the printer to which the print job will be sent. You set the printer for the image layout using the file menu 
Printer Setup option, as described on "To set up your printer." If you have not specified the printer setup, Dolphin 
uses the default printer settings for your computer. 
Note: Dolphin does not retain printer settings when you exit the program. To retain printer settings, set them using 
the Microsoft Windows Printers Control Panel. 

Properties Click this button to set advanced properties for the selected printer. 
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Print 
Range 

Allows you to select what you want to print. Your options are: 
All: print an entire document. From the main screen, you would typically use this option. 
Pages: print only pages in the specified range. 
Selection: print just what you have selected. 

Copies Enter the number of copies you want to print. 

Print 1:1 Click this check box to print an image with cephalometric tracings using the 1:1 option. This setting has no effect if 
you are not printing an image with cephalometric tracings. 

Preview Click this check box to preview your print job on the computer screen. You can use this option to preview the 
location of your practice logo and the information about your practice. 

Using the Original Records Window 
This feature is extremely helpful in comparing and contrasting your current results with the original records, or to simply examine 
another image while performing a treatment plan. 

To view the patient’s other images in an Original Records Window: 

1. Click  on the tool bar. 

The patient’s original tracing appears in a separate window.  

To view a different image in the Original Records Window: 

1. Right-click the Original Records Window. 

A pop-up menu displays the following options: 

Original  Displays the patient’s original photograph. 

Original X-ray Displays the patient’s original X-ray. 

Find/display another image Displays a list of images for this patient and timepoint. 

Show image Toggles display of the patient's image. 

Show tracing Toggles display of the patient's tracing. 

Close This Menu Closes the menu without making a selection. 
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2. Pick an option from the pop-up menu. 

3. If you selected Find/Display Another Image, select the image from the dialog box that appears listing patient images. 
Then, click OK. 

To toggle display of the image and tracing in the Original Records Window: 

1. Right-click the Original Records Window, and pick Show image or Show tracing from the pop-up menu to toggle the 
display. 

If you close the Original Records Window, the last selection you chose is retained. 

Simulating Treatment 
The following procedures describe how to: 

• use movement controls to simulate treatment 

• stimulate airway treatment 

• use the Goals feature to simulate treatment 

• enter movement values to simulate treatment 

• simulate model block surgery 
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Using the Movement Controls 
The following figure illustrates the movement controls: 

 
When you place the cursor over one of the movement controls, a pop-up tooltip appears indicating the movement that you can 
perform using that control, as shown below. 
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If the movement control is for lateral and vertical movement, red triangles appear around the control (as shown above). If the 
movement control is rotational, a circular arrow appears around the control, as shown below. 

 
Some movement controls enable you to perform both positional and rotational movement. Click and drag the mouse for linear 
movement. Press the CTRL key while dragging the mouse for rotational movement. When you click a movement control for 
rotation, a circle appears on the image depicting the radius. 
As you make changes, the patient’s soft tissue and cephalometric data are updated automatically to simulate the effect of 
treatment.  
Note: The amount and ratio of hard tissue to soft tissue movement can be customized. For more information, see "Customizing 
Soft Tissue Rules" on page 429. 
After treatment simulation and soft tissue profile operations (see "To touch up a patient's profile" on page 421), it may still be 
necessary to further touch-up the profile. Use the image editing tools such as Morph and Brush to perform those operations. In 
addition, you might want to display the before and after pictures side-by-side to compare the patient’s appearance before and 
after treatment. For more information on editing images and viewing them side-by-side, see "Viewing Two Images Side by Side" 
on page 272. 

You can click   on the tool bar to view measurements updated to reflect the operation you performed.  For more information 
on measurements, see Chapter 12. 

To use the movement controls to simulate treatment: 

1. Click and drag one or more of the movement controls. 



Dolphin Imaging User's Guide April 2011 

416 DI_USER_GUIDE-11.5   Rev. 1.01 

Simulating Airway Treatment 
If you digitized one of the analyses that includes the patient's airway, such as the Arnett/Gunson FAB Ortho or Arnett/Gunson 
FAB Surgery analysis, you can perform treatment simulation for the patient's airway. The following figure illustrates how the 
patient's airway can change on the tracing during treatment simulation. For the purposes of this example, the mandible and 
maxilla were advanced, which resulted in widening the airway. 

 

Using the Goals Feature 
Using the Goals feature, you specify the goals of the treatment plan in terms of common orthodontic cephalometric 
measurements.  

To use the Goals feature: 

1. Click the Goals tab on the Treatment Simulation palette. 

The figure below illustrates the Goals tab.  

2. Enter the desired values in the text box. 

Dolphin automatically alters the appropriate skeletal structures and soft-tissue profile to get the closest value specified. 
As you make changes, the patient’s soft tissue and cephalometric data are updated to simulate the effect of the 
treatment.  

After treatment simulation and soft tissue profile operations, it may still be necessary to further touch-up the profile. 
Use the image editing tools such as Morph and Brush to perform those operations. In addition, you might want to 
display the before and after pictures side-by-side to compare the patient’s appearance before and after treatment. For 
more information on editing images and viewing them side-by-side, see "Viewing Two Images Side by Side" on page 
272. 

You can click   on the tool bar to view measurements updated to reflect the operation you performed.  For more 
information on measurements, see Chapter 12. 
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U1-APo 
(mm) 

Enter the distance in millimeters desired between the upper incisor and the A-Point-Pogonion (APo) plane. This 
operation will move the upper incisor in the anterior-posterior direction. 

U1-APo° Enter the angle desired between the upper incisor and the A-Point-Pogonion (APo) plane. This operation will rotate 
the upper incisor to achieve the goal value. 

U1-SN° Enter the angle desired for the upper incisor to Sella-Nasion (SN) plane. This operation will rotate the upper incisor 
to achieve the goal value. 

U1-L1° Enter the angle desired between the upper and lower incisors. This operation will rotate the upper incisor to achieve 
the goal value. 

L1-APo 
(mm) 

Enter the distance in millimeters desired between the lower incisor and the A-Point-Pogonion (APo) plane. This 
operation will move the lower incisor in the anterior-posterior direction. 

L1-APo° Enter the angle desired between the lower incisor and the A-Point-Pogonion (APo) plane. This operation will rotate 
the lower incisor to achieve the goal value. 

L1-Mp° Enter the angle desired between the lower incisor and the Mandibular plane (Gonion-Menton). This operation will 
rotate the lower incisor to achieve the goal value. 

Entering Movement Values 
On the expanded Treatment Simulation palette, you can enter values for horizontal, vertical, and rotational movement. As you 
make changes, the patient’s soft tissue and cephalometric data are updated to simulate the effect of the treatment. 

To enter movement values to simulate treatment: 

1. On the Treatment Planning palette, click More>>. 

The Treatment Simulation palette expands to provide you with more options for simulating treatment, as shown below. 

2. Enter new values in the text boxes to simulate movement of the patient’s teeth based on orthodontic or dentofacial 
surgical treatment.  
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Or, 

Click Auto Rotate to automatically rotate the mandible about Hinge Axis to assure a proper bite. 

In the first column of text boxes, you can enter values for horizontal movement. In the second column, you can enter 
values for vertical movement. In the third column, you can enter values for rotational movement (if appropriate). 

You may want use the image editing tools such as Morph and Brush to touch up the patient’s profile after the changes 
for an even better appearance. In addition, you might want to display the before and after pictures side-by-side to 
compare the patient’s appearance before and after treatment. For more information on editing images and viewing 
them side-by-side, see "Viewing Two Images Side by Side" on page 272. 

You can click   on the tool bar to view measurements updated to reflect the operation you performed.  For more 
information on measurements, see Chapter 12. 
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Upper 1 Enter values for movement of the patient’s upper incisors. 

Lower 1 Enter values for movement of the patient’s lower incisors. 

Upper 6 Enter values for movement of the patient’s upper molar.  

Lower 6 Enter values for movement of the patient’s lower molar. 

A point Enter values to simulate movement from a reverse headgear. 

B point Enter values for movement of the patient's B point. 

Mx (LeFort) Enter values for movement of the patient’s entire maxilla. This operation simulates a Le Fort Osteotemy. In 
a rotational movement, the maxilla and the upper incisor are rotated about the upper incisal tip.  

Ant. Mx. Enter values for movement of the anterior segment of the patient’s maxilla. In a rotational movement, the 
maxilla and the upper incisor are rotated about the upper incisal tip.  

Post. Mx. Enter values for movement of the posterior segment of the maxilla and the upper first molar. In a rotational 
movement, the posterior segment of maxilla and the upper first molar are rotated about the lower incisal tip. 

Mx+Md Enter values for movement of the maxilla and mandible simultaneously (a "double-jaw surgery"). This 
operation moves the maxilla, the corpus of the mandible, and the upper and lower dentition. In a rotational 
movement, the maxilla, the corpus mandible, and the dentition are rotated about the lower incisal tip. 

Md (BSSO) Enter movement to simulate a bilateral sagittal split osteotomy. This operation moves the distal segment of 
the mandible and the lower incisor. In a rotational movement, the distal mandibular segment and the lower 
incisor are rotated about the lower incisal tip. 

Rotate Md @ 
Hinge Axis 

Enter rotation amount for the mandible. This operation pivots the entire mandible and lower dentition about 
the hinge axis. 

Rotate Mx+Md @ 
Hinge Axis 

Enter rotation amount for the maxilla and mandible. This operation pivots the both the maxilla and mandible 
simultaneously about the hinge axis. 

Genioplasty Enter the amount of chin augmentation. This operation simulates a genioplasty and segments the patient’s 
chin. 
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Others Select other treatment simulation operations to apply from this drop-down list box.  
(S) Post Md Rotate@Hinge: A surgical procedure that rotates the posterior portion of the mandible about 
the hinge axis. 
(O) Occ. Plane Rotate: An orthodontic procedure that rotates the occlusal plane. 
(O) Facial Axis Change: An orthodontic procedure that rotates the facial axis. 
(OS) TLV Rotate: An orthodontic or surgical procedure that rotates the true vertical line. 

Autorotate 
Mandible 

Click this button to automatically rotate and close the mandible about Hinge Axis to the patient’s occlusal 
plane. 

Arch Length 
Discrepancy 

Contains options for entering the patient's arch length discrepancy and for simulating extractions, arch 
expansion, and arch stripping. For information on the options in this group box, see "Arch Length 
Discrepancy" on page 424. 

Simulating Model Block Surgery 
When you check the Model Block Surgery box on the Treatment Simulation palette, the signed offset value in the Vert column for 
a landmark on the maxilla is positive if it is moved towards the mandible (downward). When this check box is not checked (the 
default), the signed offset value of a landmark in the Vert column is positive if it is moved upward and negative if it is moved 
downward regardless of whether the landmark is on the maxilla or mandible. 
You can use one of the following coordinate systems for surgery simulation: 

• If you are simulating a surgery using a tracing, you use a coordinate system in which up is negative and down is 
positive, regardless of whether you are moving the maxilla or the mandible.  In this system, up is always negative. In 
this case, the model block surgery box should be unchecked. 

• If you are simulating a surgery using a plaster model (see below), you use a coordinate system in which positive is 
always toward the occlusal plane. In this coordinate system, a positive number indicates a downward movement of the 
maxilla and an upward movement of the mandible.  A negative number is away from the occlusal plane.  A negative 
number indicates upward movement of the maxilla and downward movement of the mandible. In this case, the model 
block surgery box should be checked. 

Horizontal movement is always the same in both coordinate systems, with positive numbers for anterior movement and negative 
numbers for posterior movement. 
With the Model Block Surgery box checked, the vertical coordinates of any mandibular movement are reversed.  Maxillary 
vertical movement is the same in both coordinate systems.   
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Soft Tissue Profile 
The profile touch-up and lip reposturing functions provide powerful tools to "finish" your treatment simulation process. With these 
features, you can perform manual adjustments to the patient’s profile to take into account changes that were not automatically 
predicted by the treatment simulation process. For example, you might want to indicate slight variations in a patient’s lip profile 
based on specific lip therapy needed for the case. 
Note: We recommend that you use these features after completing all orthodontic and surgical operations. 

To touch up the patient’s profile: 

1. Select the Profile Touch-up option on the Treatment Simulation palette to change the patient’s profile outline. 

When you select this option, detailed points appear along the patient’s profile identifying key landmarks that describe 
the profile.  
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When you move these points, Dolphin changes the location for the associated soft tissue profile. When you move 
points, the profile curve changes in different ways depending on the color of the point: 

� When you click and drag a red point (a manually-digitized landmark), the curve and all the grey points (calculated 
landmarks) between it and the next red point (but not including the adjacent red point) move to accommodate the 
new location of the red point you are moving. 

 
� When you hold down the CTRL key while clicking and dragging a red point, only the red point moves. The adjacent 

grey points do not move. 

 
� When you move a grey point, only that point moves. The adjacent grey and red points do not move. 

2. Click and drag the points to re-contour the patient’s profile. 
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To reposture the lips: 
1. Select the Lip Reposturing option on the Treatment Simulation palette to re-contour the patient’s lips. 

Points appear on the patient’s lips so that you can re-contour them, as shown below.  

 
2. Click and drag the points to re-contour the patient’s lips. 

Or, 

Drag the Auto Lip Adjustment sliders to re-contour the patient's lips. 
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Arch Length Discrepancy 
The following figure illustrates the group box on the Treatment Simulation palette used for arch length discrepancy operations. In 
this group box, values greater than zero indicate crowded teeth, and values less than zero indicate spaced teeth.  

 

Mx Indicates the ALD for the patient’s upper teeth in the current simulation.  

Md Indicates the ALD for the patient’s lower teeth in the current simulation.  

Edit... Click this button to enter initial ALD values for this patient.  

Extract... Click this button to simulate tooth extraction. 
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Expand... Click this button to simulate an arch expansion. 

Strip... Click this button to simulate an arch stripping. 

 

To set the patient’s initial arch length discrepancy (ALD): 

1. Click Edit... on the Treatment Simulation palette. 

The dialog box shown below is displayed. 

2. Enter initial ALD and leeway values for this patient, and click OK. 

Values greater than zero indicate crowded teeth. Values less than zero indicate spaced teeth. 

 

Upper 
Arch 

Enter values for the current ALD and leeway for the upper arch in this group box. Dolphin Imaging calculates and 
displays the total ALD for the upper arch. 

Lower 
Arch 

Enter values for the current ALD and leeway for the lower arch in this group box. Dolphin Imaging calculates and 
displays the total ALD for the lower arch. 
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To simulate tooth extraction: 

1. Click Extract... on the Treatment Simulation palette. 

The VTO Tooth Extraction dialog box is displayed. Dolphin simulates tooth extraction to the ALD using average tooth 
width. 

2. Click the teeth that you want to extract, and click OK. 

The Treatment Simulation palette indicates the new ALD values. However, the Treatment Simulation program does not 
move any of the patient’s teeth for you. You need to enter the appropriate values in the text boxes on the Treatment 
Simulation palette to indicate how you want to move the patient’s teeth after the extraction. 

 

Tooth Diagram Click the teeth you want to extract on this diagram. The inner diagram is for baby teeth. 

To simulate arch expansion: 

1. Click Expand... on the Treatment Simulation palette. 

The Arch Expansion dialog box is displayed. 

2. Enter values for arch expansion, either at the cuspids or molars, for the upper or lower arch. Then, click OK. 

The Treatment Simulation palette indicates the new ALD values. However, the Treatment Simulation program does not 
move any of the patient’s teeth. You need to enter the appropriate values in the text boxes on the Treatment 
Simulation palette to indicate how you want to move the patient’s teeth after the arch expansion. 
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Upper  Enter values in millimeters for upper arch expansion at the cuspids and molars. 

Lower  Enter values in millimeters for lower arch expansion at the cuspids and molars. 

To simulate arch stripping: 

1. Click Strip... on the Treatment Simulation palette. 

The Arch Stripping dialog box is displayed. 

2. Enter values for arch stripping for the upper or lower arch. Then, click OK. 

The Treatment Simulation palette indicates the new ALD values. However, the Treatment Simulation program does not 
move any of the patient’s teeth. You need to enter the appropriate values in the text boxes on the Treatment 
Simulation palette to indicate how you want to move the patient’s teeth after the arch stripping. 

 
  

Upper  Enter values in millimeters for upper arch stripping. Check Incisors Only to apply the arch stripping value only to 
the patient’s upper incisors. 

Lower  Enter values in millimeters for lower arch stripping. Check Incisors Only to apply the arch stripping value only to the 
patient’s lower incisors. 

Saving the Treatment Simulation 
When you save the treatment simulation, Dolphin always saves both of the following: 

• the image and data that comprise the treatment simulation 

• the original image and data, for your reference or further treatment simulation 

To save the treatment image after you have finished the treatment simulation operations: 

1. Click . 

The Save Image dialog box is displayed. 

2. Optionally, modify the image title. 

Dolphin automatically provides an appropriate image title, "Treatment Simulation" in most cases. However, you may 
wish to enter a more specific name (for example, "orth only", "mx only", or "mx+md"), as appropriate for your treatment 
simulation. 
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3. Select a slot from the Save As list box in which to save this image, and click OK. 

For each patient and timepoint, you can save up to eight different treatment simulations. 

Note: If you are viewing two images side by side when you save, the side-by-side view of the two images is saved as a 
single image. 

 
  

Image 
Title 

Enter a title for this image, up to 25 characters. 

New 
Notes 

Notes for this image. This text box is automatically completed with a summary of the operations you performed. 
However, you can freely modify the content of these notes. When you view this treatment plan again later, you can 
access these notes using the Previous Notes tab on the Treatment Simulation palette (see "Using the Treatment 
Simulation Palette" on page 406). 

Into Slot Select one of the eight slots available for each timepoint in which to save this image.  
The field below this list box indicates whether the selected slot already contains an image. If you select a slot 
containing an image, the existing image is overwritten with the new image. 

Current 
Slot Notes 

If you select a slot that already contains an image, the notes previously entered for that slot appear in this text box. 
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Customizing Soft Tissue Rules 
The Dolphin Treatment Simulation module calculates changes to the patient’s soft tissue image based rules that translate 
changes in the cephalometric data to soft tissue movement. As delivered, the Dolphin program uses a set of default rules to 
calculate soft tissue movement. However, you can change the soft tissue rules to customize soft tissue movement that Dolphin 
calculates. 

Creating and Editing Soft Tissue Rules 

To open the Soft Tissue Movement Rules dialog box: 

1. Select Edit/Create Soft Tissue Rules from the Tools menu. 

The Soft Tissue Rules dialog box opens and displays the rules currently being used for Treatment Simulation. 
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Tx Operation Select the treatment simulation operation for which you want to set soft tissue movement rules from this 
drop-down list box. 

Movement Type 
Tabs  

Select one of these tabs to set soft tissue rules for the various types of movement relating to the selected 
treatment simulation operation. 
AP: Select this tab to set soft tissue rules for horizontal movement. 
Vertical: Select this tab to set soft tissue rules for vertical movement. 
Rotate: Select this tab to set soft tissue rules for rotational movement. 

Use Same Rules 
As 

Select a treatment simulation operation to use its rules for this operation. These options are only available 
for some treatment simulation operations. 
Mx: Select a treatment simulation operation from this drop-down list box to duplicate the soft tissue 
movement rules for the patient’s maxilla. 
Md: Select a treatment simulation operation from this drop-down list box to duplicate the soft tissue 
movement rules for the patient’s mandible. 

Link Directional 
Rules/Tabs 

Check this box to use the same soft tissue movement percentage settings for both directional tabs (see 
below). 

Directional Tabs Select one of these tabs to indicate the movement direction for the treatment simulation operation. The 
labels on these tabs change based on the movement type tab selected. 
Advance and Retract: When the AP movement type tab is selected, select one of these tabs to set soft 
tissue movement rules for horizontal movements relating to the selected treatment simulation operation. 
Upward and Downward: When the Vertical movement type tab is selected, select one of these tabs to set 
soft tissue movement rules for vertical movements relating to the selected treatment simulation operation. 
Rotate + and Rotate -: When the Rotate movement type tab is selected, select one of these tabs to set 
soft tissue movement rules for rotational movements relating to the selected treatment simulation operation. 

Tip of Nose Specify the soft tissue movement for the tip of nose as percentages of the horizontal, vertical, and rotational 
movement for the selected treatment simulation operation. If you specify rotational movement, select the 
landmark around which to rotate the tip of nose. 

SubNasale Specify the soft tissue movement for the subnasale as percentages of the horizontal, vertical, and rotational 
movement for the selected treatment simulation operation. If you specify rotational movement, select the 
landmark around which to rotate the subnasale. 

ST A-Point Specify the soft tissue movement for the soft tissue A-point as percentages of the horizontal, vertical, and 
rotational movement for the selected treatment simulation operation. If you specify rotational movement, 
select the landmark around which to rotate the soft tissue A-point. 

Upper Lip Specify the soft tissue movement for the upper lip as percentages of the horizontal, vertical, and rotational 
movement for the selected treatment simulation operation. If you specify rotational movement, select the 
landmark around which to rotate the upper lip. 
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Stom Sup Specify the soft tissue movement for the stomion superius as percentages of the horizontal, vertical, and 
rotational movement for the selected treatment simulation operation. If you specify rotational movement, select 
the landmark around which to rotate the stomion superius. 

UL Inside Specify the soft tissue movement for the inside of the upper lip as percentages of the horizontal, vertical, and 
rotational movement for the selected treatment simulation operation. If you specify rotational movement, select 
the landmark around which to rotate the inside of the upper lip. 

LL Inside Specify the soft tissue movement for the inside of the lower lip as percentages of the horizontal, vertical, and 
rotational movement for the selected treatment simulation operation. If you specify rotational movement, select 
the landmark around which to rotate the inside of the lower lip. 

Stom Inf Specify the soft tissue movement for the stomion inferius as percentages of the horizontal, vertical, and 
rotational movement for the selected treatment simulation operation. If you specify rotational movement, select 
the landmark around which to rotate the stomion inferius. 

Lower Lip Specify the soft tissue movement for the lower lip as percentages of the horizontal, vertical, and rotational 
movement for the selected treatment simulation operation. If you specify rotational movement, select the 
landmark around which to rotate the lower lip. 

St B-Point Specify the soft tissue movement for the soft tissue B-point as percentages of the horizontal, vertical, and 
rotational movement for the selected treatment simulation operation. If you specify rotational movement, select 
the landmark around which to rotate the soft tissue B-point. 

St Pog Specify the soft tissue movement for the soft tissue pogonion as percentages of the horizontal, vertical, and 
rotational movement for the selected treatment simulation operation. If you specify rotational movement, select 
the landmark around which to rotate the soft tissue pogonion. 

St Gnathion Specify the soft tissue movement for the soft tissue gnathion as percentages of the horizontal, vertical, and 
rotational movement for the selected treatment simulation operation. If you specify rotational movement, select 
the landmark around which to rotate the soft tissue gnathion. 

St Menton Specify the soft tissue movement for the soft tissue menton as percentages of the horizontal, vertical, and 
rotational movement for the selected treatment simulation operation. If you specify rotational movement, select 
the landmark around which to rotate the soft tissue menton. 

Throat Point Specify the soft tissue movement for the throat point as percentages of the horizontal, vertical, and rotational 
movement for the selected treatment simulation operation. If you specify rotational movement, select the 
landmark around which to rotate the throat point. 

Horizontal 
Slider 

Move this slider to simulate horizontal movement for the selected treatment simulation operation on the preview 
image and see how your selected soft tissue movement rules are applied. 

Vertical 
Slider 

Move this slider to simulate vertical movement for the selected treatment simulation operation on the preview 
image and see how your selected soft tissue movement rules are applied. 
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Rotation 
Knob 

Move this knob to simulate rotational movement for the selected treatment simulation operation on the preview 
image and see how your selected soft tissue movement rules are applied. 

Apply Click this button to apply your selected soft tissue movement rules so that they are used in Treatment 
Simulation. 

Reset Click this button to reset the preview image to its initial state (before any treatment and soft tissue movement 
simulation). 

Preview 
Image 

Displays a patient tracing (the currently-selected patient’s cephalometric tracing by default) so that you can 
simulate treatment operations and see the result of your selected soft tissue movement rules. 

  

Using the Menu Bar 
At the top of the Soft Tissue Movement Rules dialog box, there are several menus that you can use to access program features.  

• File Menu 

• Edit Menu 

• View Menu 

This section describes each of these menus  
  

The File Menu 
The following figure illustrates the File menu: 

 
The File menu contains the following choices: 

Open Open a previously-saved set of soft tissue movement rules. For more information, see "To open a set of previously-
saved soft tissue rules" on page 439. 

Save Saves the current set of soft tissue movement rules. For more information, see "To save your soft tissue movement 
rules" on page 438. 

Save 
As... 

Saves the current set of soft tissue movement rules using a new file name. For more information, see 
15vto_to_save_your_soft_tissue_m_3973  "To save your soft tissue movement rules" on page 438. 
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Print Ratio 
Summary to File... 

Prints the current set of soft tissue movement rules to a file so that you can easily review them. For 
more information, see "To print a summary of the soft tissue rules" on page 440. 

Exit Closes the Soft Tissue Movement Rules dialog box. 

The Edit Menu 
The following figure illustrates the Edit menu: 

 
The Edit menu contains the following choices: 

Refresh with Dolphin 
Installed Rules 

Return the current set of soft tissue movement rules to the factory default settings. For more 
information, see "To revert to the Dolphin-installed soft tissue movement rules" on page 440. 

Check/Set All 
Directional Links  

Checks the Link Directional Rules/Tabs box on all three movement type tabs (AP, Vertical, and 
Rotate) for all treatment planning operations. For more information, see "To link or unlink soft tissue 
movement rules for the directional tabs" on page 437. 

Uncheck/Clear All 
Directional Links  

Unchecks (clears) the Link Directional Rules/Tabs box on all three movement type tabs (AP, Vertical, 
and Rotate) for all treatment simulation operations. For more information, see "To link or unlink soft 
tissue movement rules for the directional tabs"  on page 437.  

Break All Links 
Between Tx 
Operations 

Sets both the Mx: and Md: drop-down list boxes under the Use Same Rule As: heading to <None> on 
all three movement type tabs (AP, Vertical, and Rotate) for all treatment planning operations. For 
more information, see "To unlink soft tissue movement rules between treatment planning operations" 
on page 437. 
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The View Menu 
The following figure illustrates the View menu: 

 
The View menu contains the following choices: 

Ceph from Current 
Patient 

Select this option to simulate treatment operations and soft tissue movement rules using the current 
patient’s cephalometric tracing. 

Class 1 Ceph 
Template 

Select this option to simulate treatment operations and soft tissue movement rules using a class 1 
cephalometric template. This option is currently unavailable. 

Ceph 2 Ceph 
Template 

Select this option to simulate treatment operations and soft tissue movement rules using a class 2 
cephalometric template. This option is currently unavailable. 

Ceph 3 Ceph 
Template 

Select this option to simulate treatment operations and soft tissue movement rules using a class 3 
cephalometric template. This option is currently unavailable. 

 

Setting Soft Tissue Movement Rules 
This section describes how to set soft tissue movement rules and simulate treatment operations to view the effect of the soft 
tissue movement rule settings. In addition, this section describes other features relating to soft tissue movement rules, such as 
saving your soft tissue movement rules, opening previously-saved soft tissue movement rule settings, and printing a soft tissue 
movement rules summary. 

To set soft tissue movement rules: 

1. Select the treatment simulation operation for which you want to set soft tissue movement rules from the Tx Operation 
drop-down list box. 

For example, if you want to set soft tissue movement rules for treatment simulation operations that involve the patient’s 
lower incisor, select Lower Incisor from the Tx Operation drop-down list box. 

2. Select the movement type tab (AP, Vertical, or Rotate) for the type of movement for which you want to set soft tissue 
movement rules. 

For example, to set soft tissue movement rules to apply when the patient’s lower incisor is moved horizontally, you 
would select Lower Incisor from the Tx Operation drop-down list box. Then, you would select the AP tab. 

3. Optionally, check the Link Directional Rules/Tabs box to use the same soft tissue movement rules for both movement 
directions. 
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For example, suppose you selected lower incisor from the Tx Operation drop-down list box, selected the AP tab, and 
checked the Link Directional Rules/Tabs box. Then, you entered 50 in the Horiz % field for the Lower Lip on the 
Advance tab. Dolphin would automatically enter 50 in the Horiz % field for the Lower Lip on the Retract tab. Using this 
example, moving the patient’s lower incisor would cause the patient’s lower lip to move half as quickly, whether you 
advance or retract the incisor.  

4. Select the directional tab for the movement direction for which you want to set soft tissue movement rules. 

The labels on the directional tabs change based on the Movement Type tab selected. For example, if you selected AP 
(horizontal) as the movement type, you can select either advance or retract as the horizontal movement direction. As 
described above, you can set both directions at once by checking the Link Directional Rules/Tabs box. 

5. Enter movement rules for any of the listed soft tissue landmarks as percentages of the horizontal, vertical, and 
rotational movement for the selected treatment simulation operation. 

For example, suppose you selected lower incisor from the Tx Operation drop-down list box, and selected the AP tab. 
Then, you entered 50 in the Horiz % field for the Lower Lip on the Advance tab. Using this example, advancing the 
patient’s lower incisor would cause the patient’s lower lip to move half as quickly. If you entered 33 in the Horiz % field 
for the Lower Lip, advancing the patient’s lower incisor would cause the patient’s lower lip to move one-third as quickly. 

6. If you specified a percentage for soft tissue rotational movement in the Rot % column for any soft tissue landmark, 
select the landmark around which to rotate the soft tissue landmark. 

To check your soft tissue movement rules: 

1. Use the horizontal slider, the vertical slider, and the rotation knob to simulate movement relating to the selected 
treatment simulation operation. 

For example, suppose Lower Incisor is selected from the Tx Operation drop-down list box. You can move the 
horizontal slider to simulate advancing and retracting the lower incisor. You can move the vertical slider to simulate 
moving the lower incisor up and down. You can move the rotation knob to simulate rotating the lower incisor. 

When you simulate the selected treatment operation, a red outline on the preview image indicates both hard tissue and 
soft tissue movement (as specified by your soft tissue movement rules), as shown below. 
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2. To return the preview image to its initial state, click Reset. 

The sliders and rotation knobs return to their initial positions. 
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To link or unlink soft tissue movement rules for the directional tabs: 

1. Check the Link Directional Rules/Tabs box. 

Or,  

Select Check/Set All Directional Links from the Edit menu to check the Link Directional Rules/Tabs box on all three 
movement type tabs (AP, Vertical, and Rotate) for all treatment simulation operations. 

Or, 

Select Uncheck/Clear All Directional Links from the Edit menu to uncheck (clear) the Link Directional Rules/Tabs box 
on all three movement type tabs (AP, Vertical, and Rotate) for all treatment planning operations.  

By checking the Link Directional Rules/Tabs box, you can set the same values for soft tissue movement rules for both 
directional tabs at the same time. For example, suppose you selected lower incisor from the Tx Operation drop-down 
list box, selected the AP tab, and checked the Link Directional Rules/Tabs box. Then, you entered 50 in the Horiz % 
field for the Lower Lip on the Advance tab. Dolphin would automatically enter 50 in the Horiz % field for the Lower Lip 
on the Retract tab. Using this example, moving the patient’s lower incisor would cause the patient’s lower lip to move 
half as quickly, whether you advance or retract the incisor. 

To use the same soft tissue movement rules for two treatment simulation operations: 

1. Select the treatment simulation operation for which you want to set soft tissue movement rules from the Tx Operation 
drop-down list box. 

If there is another treatment simulation operation whose rules would be appropriate for the selected treatment 
simulation operation, one or both of the drop-down list boxes under Use the Same Rules As: becomes active.  

For example, if you select Mx+Md from the Tx Operation drop-down list box, both of the drop-down list boxes under 
Use the Same Rules As: become active. The Mx drop-down list box contains Mx (LeFort), and the Md drop-down list 
box contains Md (BSSO). Using these two selections, you can automatically set the soft tissue movement rules for the 
Mx+Md operation as follows: 

� Soft tissue movement rules for the patient’s maxilla will be set to the rules specified for the Mx (LeFort) operation. 
Therefore, the soft tissue landmarks in the Mx group box are all disabled. 

� Soft tissue movement rules for the patient’s mandible will be set to the rules specified for the Md (BSSO) 
operation. Therefore, the soft tissue landmarks in the Md group box are all disabled. 

If both the Mx and Md drop-down list boxes are active, you can select an operation in only one of them. Then, you can 
manually set soft tissue movement rules for the group box relating to the other drop-down list box. 

2. If more than one operation appears in either of the Use the Same Rules As: drop-down list boxes, select the treatment 
simulation operation whose soft treatment simulation rules you want to use for this operation. 

For example, if you select Rotate Mx+ Md @ Hinge Axis, the Md drop-down list box under Use the Same Rules As: 
lists several treatment simulation operations. In this case, you should choose one of these treatment simulation 
operations to use its mandible soft tissue movement settings for the Rotate Mx+ Md @ Hinge Axis operation. 
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To unlink soft tissue movement rules between treatment planning operations: 

1. In one or both of the Use the Same Rules As: drop-down list boxes, select <None>. 

Or,  

Select Break All Links Between Tx Operations from the Edit menu to remove all links between treatment simulation 
operations. 

If you select <None> from one of the Use the Same Rules As: drop-down list boxes, the soft tissue landmarks in the 
group box relating to that option (Mx or Md) are all enabled. Then, you can manually set soft tissue movement rules in 
that group box. 

If you select Break All Links Between Tx Operations from the Edit menu, the Mx and Md group boxes on all tabs for all 
treatment simulation operations are enabled so that you can manually set all the soft tissue movement rules. 

To save your soft tissue movement rules: 

1. Select Save or Save As... from the File Menu. 

If you have not previously saved these soft tissue movement rules or if you selected Save As..., the Save As dialog box 
opens so that you can specify a file name for these rules. By default, soft tissue movement rules are saved with the file 
extension .TxS. 

2. Specify the directory and file in which you want to save the soft tissue movement rules, and click Save. 

Note: You must apply the soft tissue movement rules in order to use them in Treatment Simulation. Simply setting or saving the 
rules will not automatically apply them. For more information, see "To apply a set of soft tissue movement rules" on page 439. 
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To open a previously-saved set of soft tissue movement rules: 

1. Select Open from the File Menu. 

The Open dialog box shown below appears. 

2. Select the file containing the soft tissue rules you want to use. 

3. Optionally, check the Open as Read Only box. 

Use this option if you just want to apply the soft tissue movement rules in the file, not change them. Opening the file as 
read only will prevent accidental changes to the rules in the file. 

4. Click Open. 

 

To apply a set of soft tissue movement rules: 

1. On the Soft Tissue Movement Rules dialog box, click Apply. 

Note: You must apply the soft tissue movement rules in order to use them in Treatment Simulation. Simply setting or 
saving the rules will not automatically apply them. 

To close the Soft Tissue Movement Rules dialog box without applying the rules: 

1. Select Exit from the File menu. 

If you have changed the soft tissue movement rules, a dialog box appears asking whether you would like to use the 
new rules. 

2. If you do not wish to use the new rules, click No. 
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To revert to the Dolphin-installed soft tissue movement rules: 

1. Select Refresh with Dolphin Installed Rules from the Edit menu. 

If you have changed the soft tissue movement rules, a dialog box appears asking you whether you would like to revert 
back to the Dolphin-installed rules. Reverting to the Dolphin-installed rules will discard any changes that you have 
made to the soft tissue movement rules that you have not already saved. 

2. Click Yes to discard your changes and revert to the Dolphin-installed rules. 

Or, 

Click No to keep any changes you have made to the soft tissue movement rules and return to the Soft Tissue 
Movement Rules dialog box. 

To print a summary of the soft tissue movement rules to a file: 

1. Select Print Ratio Summary to File... from the File menu. 

A Save As dialog box appears. The summary file is created with a .txt extension by default. 

2. Enter a file name for the summary file. Then, click Save. 

The summary file is saved. The following figure illustrates format of the soft tissue movement rules summary file. This 
figure contains only a small part of the file. 

You may wish to print this file to review the soft tissue movement rules. 
Rules for Upper Incisor movement: 

AP-Advance         Horiz% Vert% Rot% Rot About Landmark 

Tip of Nose 10 0 0 N/A 

ST A-Point 50 0 0 N/A 

Upper Lip 50 0 0 N/A 

Stomion superius 50 0 0 N/A 

Upper Lip Inside 50 0 0 N/A 

AP-Retract Horiz% Vert% Rot% Rot About Landmark 

Tip of Nose <Same as AP-Advance> 

ST A-Point <Same as AP-Advance> 

Upper Lip <Same as AP-Advance> 

Stomion superius <Same as AP-Advance> 

Upper Lip Inside <Same as AP-Advance> 

Rotate (+) Horiz% Vert% Rot% Rot About Landmark 

ST A-Point 0 0 13 <Default> 

Upper Lip 0 0 13 <Default> 

Stomion superius    0 0 13 <Default> 

Upper Lip Inside 0 0 13 <Default> 

 Rotate (-) Horiz% Vert% Rot% Rot About Landmark 

 ST A-Point <Same as Rotate (+)> 
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 Upper Lip <Same as Rotate (+)> 

 Stomion superius <Same as Rotate (+)> 

 Upper Lip Inside <Same as Rotate (+)> 

  

Loading Saved Soft Tissue Rules 
When you are using Treatment Simulation, you can load a previously-saved set of soft tissue rules or load the Dolphin-installed 
soft tissue rules. 

To load a previously-saved set of soft tissue rules: 

1. Select Load Saved Soft Tissue Rules... from the Tools menu. 

2. Select the file containing the soft tissue rules you want to use. Then, click Open. 

To load the Dolphin-installed soft tissue rules: 

1. Select Load Dolphin Installed Soft Tissue Rules from the Tools menu. 

A dialog box appears asking you to confirm that you want to revert to the Dolphin-installed rules. 

2. Click Yes. 
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Part VII: Interactive Treatment Analyses 
This part of the Dolphin Imaging User’s Guide describes the Dolphin Interactive Analysis modules. These modules consist of the 
following add-on programs under the Dolphin Treatment Simulation module:  

• The Arnett Soft Tissue Cephalometric Analysis (STCA): provides a gender norm-based, simple-to-use, comprehensive 
orthodontic and surgical treatment simulation tool. The analysis utilizes key skeletal and soft tissue measurements. 

• The McLaughlin Dental VTO Analysis: provides a comprehensive system for a clinician to analyze and experiment with 
positions and treatment options dentally. 

• Ricketts VTO/Roth-Williams AEO VTO Analysis: simulates the combination of changes taking place with growth and 
the outcome of the orthodontic treatment, thus enabling the clinician to quickly predict, plan, and visualize the 
sequence of treatment to be performed. 

The Arnett STCA and McLaughlin Dental VTO Analysis are interrelated. The clinician should use the Arnett analysis to both 
analyze (via the soft tissue cephalometric analysis or STCA) and plan (via the cephalometric treatment simulation or CTP) 
dental, skeletal, and soft tissue changes. Then, the clinician should use the McLaughlin Dental VTO Analysis to determine the 
details of dental movement. Together, these modules provide more information for improved diagnosis and treatment. 
Note: To use the features described in this part of the Dolphin Imaging User’s Guide Help, you must have purchased both the 
Treatment Simulation and one or more of the Interactive Analysis modules.  
This part of the Dolphin Imaging User’s Guide only describes treatment planning using the Interactive Analysis modules. You 
should be familiar with the treatment simulation features of the Dolphin Imaging program before using the Interactive Analysis 
modules. For information on using the other Dolphin Imaging treatment simulation features, see Chapter 16. 
  



Dolphin Imaging User's Guide April 2011 

444 DI_USER_GUIDE-11.5   Rev. 1.01 

17 Arnett STCA 
The purpose of the Dolphin Arnett Soft Tissue Cephalometric Analysis (STCA) is to facilitate diagnosis and treatment of occlusal 
and facial problems. The Arnett STCA is based on the published works of G. William Arnett, DDS, FACD (G. W. Arnett, R.T. 
Bergman. AJODO 1993;103:299-312 and 395-411, Arnett et. al., AJODO 1999;116:239-53) and has been designed under the 
direction of Dr. G. William Arnett. Appendix D. lists articles regarding the theory and usage of the Arnett Analysis.  
Note: The following instructions give practical steps on how to prepare and utilize the Arnett STCA with the Dolphin Imaging 
software. These instructions are sufficient to teach the basic treatment philosophies of the Arnett STCA. However, they do not 
teach the importance of combining clinical examination and STCA information to maximize diagnosis and treatment simulation. 
For more complete and detailed information, please refer to the AJODO articles listed in Appendix D. For certified hands-on 
courses and self-paced CD-ROM teaching aids, contact: 
The Center for Corrective Jaw Surgery 
Santa Barbara, CA  
Phone: (805) 569-1889 
Fax: (805) 687-5651 
We highly recommend that you attend the comprehensive orthodontic and surgical treatment simulation courses offered by the 
Center for Corrective Jaw Surgery, including hands-on tutorials in utilizing the Dolphin Arnett STCA. 
To use the Arnett STCA features, the following materials are necessary: 

• A lateral x-ray digitized with the Arnett/McLaughlin, Arnett/Gunson FAB Ortho, or Arnett/Gunson FAB Surgical analysis. 

Note: The Arnett SCTA requires that you digitize landmarks on the lateral cephalometric film with properly placed 
markers (SPEE-D-MARKS) affixed to the patient’s face. For more information, see "Placing the Mid-Face Soft Tissue 
Facial Markers" on page 446. 

• A lateral photograph of the patient in the natural head position as described in:  

� Moorrees, Am J Phys Anthropol 1958; 16:213-34  

� Cooke. AJODO 1988; 93:213-33  

� Lundstrom and Lundstrom. AJODO 1992; 101:2447 

� G.W. Arnett, R.T. Bergman. AJODO 1993; 103:299-312 and 395-411 

� Arnett et.al., AJODO 1999; 116:239-53 

For patient presentations and doctor conferences, we recommend treatment planning using a digitized cephalometric radiograph 
overlaid with the patient’s profile photograph. For surgical planning, however, we recommend using only the digitized 
cephalometric radiograph to maximize the accuracy of the result.  
To verify that the images you need are available, select the - Everything - layout from the Layout drop-down list box on the 
Dolphin Imaging System main screen. This layout  contains all patient images for the selected timepoint. If the digitized lateral X-
ray and lateral photograph are available for this patient and timepoint, the images will be available from this image layout. 
Once you have verified that these images are available, you need to superimpose the tracings over the patient’s lateral 
photograph if you wish to perform treatment simulation using the patient’s image. For more information on creating a 
superimposed image, see Chapter 13. 
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Cephalometric X-Ray and Photograph 
Take the patient’s profile photograph from the same angle as the lateral head film. This maximizes the accuracy of 
superimposing the tracing over the profile photograph and minimizes the adjustments necessary to align the tracing to the soft 
tissue image.  
When creating the photographic and radiographic records, keep the following tips in mind: 

• Place the patient’s head in a natural head posture. This is done by having the patient look into their pupils in a mirror 
(fixed to a wall in front of them) during profile photographs and before taking the cephalometric x-ray. Refer to: 

Moorrees, Am J Phys Anthropol 1958; 16:213-34,  

Lundstrom and Lundstrom. AJODO 1992; 1011:244-7,  

Arnett et.al., AJODO 1999; 116:239-53 

• Have the condyles in a consistent seated position for the photographs and radiographs. This is done by using the 
same waxbite for both records. 

• Make sure the patient’s lips are relaxed and not in the closed lip position. 

• Place the mid-face soft tissue markers (SPEE-D-MARKS) before taking the lateral head film (see below). 

The Arnett STCA requires proper registration of soft tissue landmarks on the patient’s lateral cephalometric radiograph. 
To do this, you use metallic soft tissue markers called SPEE-D-MARKS. These facial markers are placed to indicate 
cephalometric soft tissue landmarks that cannot be seen on standard cephalometric radiographs. 

The SPEE-D-MARKS are available from: 

The St. John Companies, Inc. 
web site: www.stjohninc.com 
email (preferred): Rhenderson@stjohninc.com 
US and Canada: 1-800-435-4242    international: +1-661-257-0233 
Part reference: SPD-MAX 

Note: The SPEE-D-MARKS are required for lateral cephalometric radiographs, but not required for facial photographs.  
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Placing the Mid-Face Soft Tissue Facial Markers 

To place the mid-face soft tissue facial markers (all markers are placed on the patient’s right side): 

1. Look at the patient from a three-quarter view, and determine the most convex point of the cheek. Mark this point with a 
pen, as illustrated below 

 
2. Looking at the patient from the front, mark with your pen a point directly inferior to the Lateral Canthus. 

The cheek bone mark is located where these two marks cross, as illustrated below. 
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3. With your pen, mark the Orbital Rim, Subpupil, and Alar Base as follows: 

Orbital 
Rim 

Place this mark on a vertical line through the pupil in a straight-ahead gaze, directly over the 
infraorbital rim. 

Subpupil Place this mark on a vertical line through the pupil in a straight-ahead gaze, one-half the vertical 
distance from the Orbital Rim to the Alar Base Point. 

Alar Base Place this mark at the depth of the Alar depression. 

The following figure illustrates marking these points: 

 
4. Place the SPEE-D-MARKS on the pen marks. 

The following figure illustrates these SPEE-D-MARKS taped to the patient’s face. 
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5. With the patient’s head in the postural horizontal plane, tape another SPEE-D-MARK on the Neck-Throat point.  

The following figure illustrates the placement of this SPEE-D-MARK.  

Note: In the figure below, the patient’s head is up for illustrative purposes only. When placing this SPEE-D-MARK, the 
patient’s head should be in the postural horizontal plane. It will be difficult to find the Neck-Throat point if the patient’s 
head is up. 
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At this point, you can take the cephalometric radiograph. 

6. Gently place the waxbite registration in the patient’s mouth, and ask the patient to relax the upper and lower lips. 

You should take the cephalometric radiograph with the patient’s lips in a reposed position.  

 
7. Ask the patient to look straight into a mirror, which positions the patient’s head in the postural horizontal plane, as 

shown below. 

 

8. Take the cephalometric radiograph. 

The following figure illustrates the final cephalometric radiograph. The white dots on the radiograph are the SPEE-D-
MARKS. 
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In summary, the five soft tissue marks are: Cheek Bone, Orbital Rim, Subpupil, Alar Base, and Neck-Throat Point. The figure 
below illustrates these points: 
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Digitizing the Radiograph 
Once you have taken the radiograph with the soft tissue marks, you must digitize it. To digitize a radiograph for use with the 
Arnett STCA, you must make the following selections on the Digitize Setup dialog box: 

• You must choose the Arnett/McLaughlin, Arnett/Gunson FAB Ortho, or Arnett/Gunson FAB Surgical analysis.  

• You must select the following auto-drawn structures: Arnett True Vertical Line (TVL), Maxilla, Mandible, Condyle, 
Symphasis, Upper Profile, Lower Profile, and Neck Line. 

After you have specified the landmarks on the Digitize dialog box, align the digitized tracing to the True Vertical Line and save 
the digitized radiograph. For more information on digitizing radiographs, refer to Chapter 10. 
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Treatment Planning with the Arnett Analysis 
Before using the Dolphin Arnett analysis, an organized, thorough clinical facial examination is necessary (Arnett, Bergman. 
AJODO April and May 1993). The clinical facial examination provides a subjective lateral evaluation (profile, mid-face contours) 
and frontal diagnosis (midlines, levels, outline). The Arnett STCA then quantifies the subjective clinical lateral examination. 
The combination of clinical examination and computerized soft tissue cephalometric analysis is vital to producing a 
comprehensive diagnosis and treatment plan. One without the other is not as effective. 
In summary, the purpose of the Arnett STCA is to: 

• Plan occlusal correction. 

• Plan profile balance (A-P, vertical). 

• Maintain normal profile measurements. 

• Correct abnormal profile measurements. 

• Modify essential dento-skeletal factors, which correct the profile and occlusion. 

• Change dental, skeletal, and facial factors relative to natural head position and not Frankfort or Sella-Nasion. 

Treatment is achieved with the Arnett CTP technique. The advantage of the CTP is its simplicity. Diagnosis is achieved with the 
Arnett STCA, and then a seven-step CTP is used to correct the occlusion while maximizing facial balance.  

7-Step Arnett CTP 
The CTP steps are described in sequence below. Generally, you complete each step to one standard deviation (a black number) 
or two standard deviations (a green number). After achieving the desired range for each step, proceed to the next step, 
completing all seven steps in order.  
Note: All steps are not necessary for every patient. If a particular step already has a black or green value, you may skip it based 
on your clinical judgment. Simply click Next without performing any action. 
For more information on the Arnett CTP, refer to Arnett et.al., "Soft tissue cephalometric analysis: Diagnosis and treatment 
simulation of facial deformity". AJODO 1999; 116:239-53 or call the Center for Corrective Jaw Surgery at (805) 569-1889. 

Step 1: Mx Incisor Inclination  
This orthodontic step corrects the maxillary incisor inclination to the maxillary occlusal plane. This step produces ideal incisor 
inclination to the upper posterior teeth and alveolar bone.  

• Measurement: Mx1 to Mx occlusal plane (Mx1-MxOP) 

• Norm: f:64.3+3.2, m:64.0 +4.0 

Click Auto Treat to incline the maxillary incisor to the norm. 
Note: Depending on the case, you may also want to intrude or extrude the maxillary incisor to bring the value to the normal 
range. 
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Step 2: Md Incisor Inclination 
This orthodontic step corrects mandibular incisor inclination to the mandibular occlusal plane. This step produces ideal incisor 
inclination to the lower posterior teeth and alveolar bone. Additionally, this step reveals the true overjet without dental 
compensations. If the overjet is corrected with this step, steps 3-7 (upper and lower jaw surgery) are unnecessary unless there 
are transverse or vertical problems needing correction. 

• Measurement: Md1 to Md occlusal plane (Md1-MdOP) 

• Norm: f:56.8+2.5, m:57.8+3.0 

Click Auto Treat to incline the mandibular incisor to the norm. 
Note: Depending on the case, you may also want to intrude or extrude the mandibular incisor to bring the value to the normal 
range. 

Step 3: Overbite 
Auto-rotate the mandible to a 3mm overbite. During this step, disregard any molar overbite unless auto-rotation corrects the 
overjet to class I. 

• �Measurement: overbite (Mx1-Md1) 

• �Norm: f:3.0, m:3.0 

Click Auto Treat to auto-rotate the mandible to the norm. 

Step 4: Overjet  
This is an optional surgical operation. Indications are class II or class III overjet after step 4, mandibular midline deviation and/or 
an inappropriate occlusal plane that adversely affects nasal base and chin projections. When indicated, perform a bilateral 
sagittal split osteotomy (BSSO) to a class 1 overjet and 1.5mm of molar overbite. 

• Measurement: overjet (Mx1-Md1) 

• Norm: f:3.0, m:3.0 

Click Auto Treat to perform the BSSO based on incisor overjet norms and to establish the molar overbite. 

Step 4a: Reposture the Lower Lip 
This step is necessary after step 4. 
This step is performed by rotating the lower lip inward, touching the maxillary incisors, while maintaining the original lip thickness. 
At this point, move chin and lip handles as necessary to produce a smooth chin contour. During this procedure, do not change 
the Pog projection. 
Auto Treat is not available for this step. 
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Step 5: Mx Incisor Position 
This is an optional, but very important, total maxillary osteotomy (Le Fort I or LFI) procedure. Indications for this step are 
maxillary midline deviation, transverse deficiency, 2 plane maxilla, archform mismatch, class II, or class III, and aesthetic 
imbalances. When the LFI is indicated, it is aesthetically positioned based on clinical and STCA findings.  
Clinical Findings: 

• Nasal projection: long, normal, short 

• Contours: orbital rim, cheek bone, subpupil, alar base: depressed, flat, normal, prominent 

• Upper lip support: weak, normal, strong 

• Mx 1 exposure in relaxed lip: 2-5 

STCA Findings: 

• Upper lip thickness (Mx1 labial-ULA)-thick lip indicates need for advancement 

• Upper lip anterior (ULA) to TVL 

• Upper lip angle (ULA-Sn’-TVL) 

• Mx1 exposure (ULI-Mx1): make sure that the cephalometric measurement matches the clinical measurement. The 
clinical measurement is more accurate.  

Click Auto Treat to reposition the maxilla in the A-P direction based on the normal value of the upper lip anterior (ULA) 
measurement and in the vertical direction based on the normal value of the Mx1 exposure (ULI-Mx1). 
Warning: This automatic calculation merely serves as an initial suggestion for the position of the maxilla. Again, results from the 
clinical findings and other STCA findings should be considered in this step before moving on to the next step. 

Step 6: Occlusal Plane 
This is an optional surgical procedure. The indication for step 6 is when both jaws have been operated on in steps 3 and 5. 
The maxilla and mandible are rotated using the maxillary central incisor tip as the center of rotation. The occlusal plane is 
changed with the following goals: 

• Aesthetic chin position to TVL 

• Aesthetic nasal base projection 

As a part of step 6, when aesthetically necessary, you can advance or retract the bimaxillary complex. As a rule, the ANS (nasal 
base) should not be retracted from its original projection. 

• Measurement: Mx Posterior Height (MxOP-TVL) 

• Norm: f:95.6+1.8, m:94.2+1.4 

Auto Treat is not available for this step. 

Step 7: Chin Projection 
This is an optional surgical operation. 

• Measurement: soft tissue Pogonion (Pog’) 

• Norm: f:-2.6+1.9, m:3.5+1.8 

Auto Treat is not available for this step. 
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Note: When the occlusion is corrected at any of steps 2-6, a genioplasty can be done to optimize the chin projection (i.e. bite 
corrected at step 2), when indicated. 
After completing the seven steps of the Arnett CTP, fine-tune the patient’s image using the morph tool (see "Using the Morph 
Palette" on page 277) and brush tools (see "Using the Brushes Palette" on page 281). In addition, you may view the results in a 
side-by side fashion (see "Viewing Two Images Side by Side" on page 272), save your results (see "Saving the Treatment 
Simulation" on page 427), or print your results (see "To print the treatment simulation" on page 410). 

Accessing Treatment Simulation 

To access Treatment Simulation from the Dolphin Imaging main screen: 
1. On the Dolphin Imaging main screen, select a layout containing either a lateral X-ray digitized with the 

Arnett/McLaughlin, Arnett/Gunson FAB Ortho, or Arnett/Gunson FAB Surgical analysis and with traced skeletal 
structures or a lateral photograph of the patient superimposed with the patient’s tracing. 

The - Everything - layout contains all patient images for the selected timepoint. If either of these images is available for 
this patient and timepoint, the images will be available from this image layout. 

2. Click  on the Dolphin Imaging main screen. 

Or,  

Select Treatment Simulation from the Tools menu on the Dolphin Imaging main screen. 

Or, 

Select Start Treatment from the Link Tracing+Image dialog box (see Chapter 13). 

When you enter the Treatment Simulation module, the digitized lateral X-ray with traced skeletal structures or the 
superimposed image appears in the Edit dialog box along with the Treatment Simulation palette as shown below. 

To insure the patient record is properly oriented, both the Dolphin Digitize module and the Treatment Simulation 
module contains tools to assist you in re-aligning the image and tracings to a calculated true vertical line (TVL). The 
calculated TVL is constructed using a plane 8.5 mm in front of soft tissue glabella through the subnasale. Depending 
on the slope of the patient’s forehead and subnasale position, you may need to adjust the orientation of this calculated 
TVL. 

Note: You must align the image to the true vertical line before planning treatment using the Arnett Treatment 
Simulation module. For more information on aligning the true vertical line, see Aligning to the True Vertical Line on 
page 457. 
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Using the Treatment Simulation Tool Bar 
The Treatment Simulation Tool Bar contains the following buttons: 

 
Opens the Treatment Simulation module. 

 
Opens the Morph tool. For more information, see "The Morph Palette" on page 277. 

 
Opens the Brushes tool. For more information, see "The Brushes Palette" on page 281. 

 
Sets the display option for the image. For more information, see "To set the display mode for the patient's image" 
on page 407. 

 
Displays the modified image side-by-side with the original image. For more information, see "Viewing Two Images 
Side by Side" on page 272. 

 
Toggles display of the original tracing. For more information, see "To overlay the patient’s original tracing over the 
tracing you are modifying with Treatment Simulation” on page 410. 
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Toggles the display of the patient’s tracing. 

 
Opens the Enhance tool. For more information, see "To enhance a picture” on page 164. 

 
Sets display preferences. For more information, see "To set display preferences" on page 408. 

 
Opens the original records window. For more information, see “Using the Original Records Window” on page 412. 

 
Opens the measurements table. For more information, see Chapter 12.. 

 
Starts the Arnett Wizard. For more information, see Chapter 17. 

 
Opens the McLaughlin Dental VTO Analysis. For more information, see Chapter 18. 

 
Aligns the image to a reference plane. For more information, see "To align the patient's image to a reference plane" 
on page 361. 

 
Opens the Ricketts VTO/Roth-Williams VTO Wizard. For more information, see Chapter 19. 

 
Undoes the previous operation. 

 
Opens the Link Tracing+Image window. For more information, see "Tracing+Image" on page 358. 

 
Saves the image. For more information, see "Saving the Treatment Simulation" on page 427. 

 
Prints the image. For more information, see "To print the treatment simulation" on page 410. 

 
Copies the image and/or its tracings to the clipboard. 

 
Returns to the Dolphin Imaging main screen. For more information, see Chapter 3. 

Aligning to the True Vertical Line 
With the STCA, the X-ray or profile photograph superimposed with the patient’s tracing must be oriented to the true vertical line 
(TVL) before creating measurements. Typically, this step is performed as part of digitizing or superimposing the tracing over the 
profile photograph. However, you can also perform this step now. 

To align the image to the true vertical line: 

1. Click on the tool bar. 

The results are aligned to your choice of reference planes. The patient’s X-ray or profile photograph appears in the 
Image Border Trim dialog box, as shown below. 

Depending on the orientation of your image, the alignment procedure may produce jagged edges on the photograph, 
which may not be visually pleasing when used in a presentation. For this reason, Dolphin Imaging allows you to 
choose the best option for trimming the borders of the newly-oriented image. You may also choose a default border fill 
that best suits your image.  

2. Select an option for fixing the image after rotation. 

3. Select either a black or white border. Then, click OK. 
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Reference 
Plane 

Select the reference plane to which you want to align this image from the following options: 
Original Orientation (No reference plane): Do not change the alignment of the image. 
Frankfort (Po-Or): Align this image using the Frankfort reference plane. 
Horizontal Plane (SN -7 deg): Align this image to a horizontal reference plane. 
TVL/Natural Head Posture (Vertical Upper - Vertical Lower): Align this image using the true vertical line 
reference plane. To use the Arnett STCA for this patient, you must align the image using this reference plane.  
Crista Galli - A-Point: Align a frontal image using the Crista Galli - A-Point reference plane.  

Trimming 
Color 

Select either a black or white border to use for the image after trimming. 
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Trimming Options Select one of the following options for trimming the patient’s image using the preview images. 
No trim: Make no changes to the image borders. 
All sides trimmed: Crop the image on all sides to create a rectangular image area. 
Top+bottom trim: Crop the image only on the top and bottom to straighten those sides. 
Left+Right trim: Crop the image only on the left and right to straighten those sides. 

Using the Arnett Wizard 
The Arnett Wizard is a special Dolphin Imaging feature that guides you through the seven steps of the Arnett CTP. For each 
measurement, the Dolphin Imaging program provides the patient’s current measurement and the normal range of measurement 
values. You simply move the Dolphin movement controls so that the patient’s measurements are within the acceptable range. 
Note: You can perform the seven steps of the Arnett CTP manually, without using the Arnett Wizard. To perform this process 
manually, you simply move the movement controls on the patient’s tracing as appropriate. You may wish to perform this process 
manually for the following reasons: 

• You are familiar with the Arnett CTP and do not wish to perform the steps in the order presented by the Arnett Wizard.  

• The particular case you are treating is not addressed by the Arnett Wizard. Although the Arnett Wizard addresses most 
treatment simulation cases, some cases may require the additional flexibility provided by performing the steps 
manually. 

Before you begin using the Arnett Wizard, Dolphin recommends that you set your display resolution to at least 1024 by 768 
pixels (higher resolution recommended). 

To set your display resolution (Windows XP Pro/SP2 or Windows 2003 Server): 
1. From the Start Menu, select Settings. Then, select Control Panel from the cascade menu. 

2. Double-click Display to open the Display Properties dialog box. Then, select the Settings tab. 

3. In the Display Area group box, move the slider to select a resolution of at least 1024 by 768 pixels. 

4. Follow the prompts to finish setting your display resolution. 

To set your display resolution (Windows Vista): 
1. From the Start Menu, select Control Panel. 

2. Click Appearance and Personalization. 

3. Under Personalization, click Adjust screen resolution. 

4. Under Resolution, move the slider to select a resolution of at least 1024 by 768 pixels, and click OK. 

5. To keep the new resolution setting, click Yes. 
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To start the Arnett Wizard: 

1. Optionally, click Show-Hide Image on the tool bar to hide the patient’s image. 

Depending on the speed of your computer, hiding the patient’s image may make the treatment simulation process 
quicker. At any time during the treatment simulation process, you can click Show-Hide Image again to see the changes 
to the patient’s soft tissue. 

2. Click  on the tool bar to open the Tracing Preferences dialog box. 

3. In the Tracing Preferences dialog box, select the analysis you are using (Arnett/McLaughlin, Arnett/Gunson FAB Ortho, 
or Arnett/Gunson FAB Surgical) from the drop-down list box. 

4. Make sure that the following check boxes are checked in the Main Display group box: Tracing Lines & Curves, Tooth 
Templates, Meas Numbers, Add’l Ceph Structures, and Movement Controls. 

For information on how to set Tracing preferences, see "To set tracing preferences" on page 78. 

5. Click OK to close the Tracing Preferences dialog box. 

6. Click on the tool bar to start the Arnett Wizard. 

The Arnett Wizard dialog box opens next to the Treatment Planning palette and displays the first step, as shown below. 

Note: To view the patient’s tracing and the Arnett Wizard dialog box at the same time, you may need to reposition 
some of the windows on your screen. 

� To reposition the Arnett Wizard dialog box and the Treatment Simulation palette, click and drag them. 

� To reposition the patient’s tracing in the Edit dialog box, hold down the SHIFT key. Then, click and drag the tracing. 
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Treatment Simulation 
palette 

Contains tools for performing treatment simulation. For more information, see “Using the 
Treatment Simulation Palette” on page 406. 

Arnett Wizard Dialog Box Describes the current step in the Arnett CTP.  
Auto Treat: When present, click this button to automatically move the movement controls so that 
the measurements for this step are at the mean (middle of the normal range). 

Patient’s image overlaid 
with the tracing 

Displays the patient’s tracing and the movement controls that you can move to perform the 
current step in the Arnett Treatment Simulation process. 
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To complete the Arnett Wizard Treatment Simulation steps: 

1. For each step in the Arnett Wizard, move the movement controls so that the patient’s measurements are within the 
acceptable range. 

Or, 

Click Auto Treat (if available) to automatically move the patient’s measurements to the mean (middle of the normal 
range). 

The colors of the measurement numbers indicate the following: 

Black 1 standard deviation (normal) 

Green 2 standard deviations 

Blue 3 Standard deviations 

Red greater than 3 standard deviations 

To complete a step, move the movement controls until the measurement is within the normal range (black) or within 
two standard deviations (green). For information on how to use the movement controls, see "Using the Movement 
Controls" on page 414. 

To view the normal range for a particular measurement, place the mouse over that number. A tooltip appears with a 
description of the measurement, the patient’s current measurement, and the normal range for the measurement. 

2. Optionally, touch up the patient's profile or reposture the lips as described below. 

Each CPT step offers options for touching up the patient's profile and reposturing the lips.  

3. When all numbers on the patient’s tracing are black or green (indicating that they are within the acceptable range), 
click Next to go on to the next step in the Arnett CTP. 

Note: Following Step 2 in the Arnett Wizard, you may wish to print the patient’s tracing and provide the information to 
the patient’s orthodontist to direct desired incisor inclination changes. 

4. When you finish step 7, click Finish to save the changes and exit from the Arnett Wizard. 

To touch up the patient's profile or reposture the lips: 

1. Select Touch-up to touch up the patient's profile. 
Or, 
Select Lips to reposture the patient's lips. 

Depending on the option you selected, points appear identifying key landmarks that describe the profile or lips. 

2. Click and drag the points to re-contour the patient’s profile or reposture the lips. 

For more information, see "Soft Tissue Profile" on page 421. 
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Saving the Treatment Prediction 
When you save the treatment prediction, Dolphin always saves both of the following: 

• the image and data that comprise the treatment simulation 

• the original image and data, for your reference or further treatment simulation 

To save the treatment image after you have finished the treatment operations: 

1. Click . 

The Save Image dialog box is displayed. 

2. Optionally, modify the image title. 

Dolphin automatically provides an appropriate image title, "Treatment Simulation" in most cases. However, you may 
wish to enter a more specific name (for example, "arnett"), as appropriate for your treatment plan. 

3. Select a slot from the Save As list box in which to save this image, and click OK. 

For each patient and timepoint, you can save up to eight different treatment simulations. 

Note: If you are viewing two images side by side when you save, the side-by-side view of the two images is saved as a 
single image. 
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Image Title Enter a title for this image, up to 25 characters. 

New Notes Notes for this image. This text box is automatically completed with a summary of the operations you performed. 
However, you can freely modify the content of these notes. When you view this treatment simulation again later, 
you can access these notes using the Previous Notes tab on the Treatment Simulation palette. 

Into Slot Select one of the eight slots available for each timepoint in which to save this image.  
The field below this list box indicates whether the selected slot already contains an image. If you select a slot 
containing an image, the existing image is overwritten with the new image. 

Current 
Slot Notes 

If you select a slot that already contains an image, the notes previously entered for that slot appear in this text 
box. 
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18 McLaughlin Dental VTO Analysis 
The McLaughlin Dental VTO Analysis enables clinicians to plan precise, quantifiable movement of dentition based on clinical 
examinations and treatment simulation values entered into the worksheet. The McLaughlin Dental VTO Analysis provides 
specific information concerning the movement of midlines, cupids, and molars once the desired incisor position has been 
established using the cephalometric analysis. The program gives a visual result of the treatment simulation and can be used for 
both orthodontic and surgical-orthodontic cases.  
To use the McLaughlin Dental VTO Analysis, you must have a patient and a timepoint. In addition, you can optionally use the 
following: 

• photographs of the patient’s intraoral and occlusal views are highly recommended. 

• a lateral cephalometric tracing digitized with the McLaughlin analysis or the Arnett-McLaughlin analysis 

Note: The Arnett/McLaughlin analysis requires that you digitize landmarks located with metal beads affixed to the 
patient’s face when the X-ray was taken. For more information, see "Cephalometric X-Ray and Photograph." on page 
445. 

To determine whether you have these images, check the Layout drop-down list box on the Dolphin Imaging main screen (see 
Chapter 3).  
To verify that the pictures you need are available, select the - Everything - layout from the Layout drop-down list box on the 
Dolphin Imaging System main screen. This layout contains all patient images for the selected timepoint. If the digitized lateral X-
ray and lateral, intraoral, and occlusal photographs are available for this patient and timepoint, the images will be available from 
this image layout. 

To open the McLaughlin Dental VTO Analysis without photographs: 

1. On the Dolphin Imaging main screen, select the patient and timepoint. 

2. Select McLaughlin Dental VTO from the Tools menu. 

The McLaughlin Dental VTO Analysis dialog box opens. The McLaughlin Dental VTO analysis creates timepoint 
default values used for subsequent McLaughlin Dental VTO analysis treatment simulation sessions.  If you access 
McLaughlin Dental VTO from the Tools menu for this timepoint in future, you will access the treatment simulation 
information without photographs. 

To open the McLaughlin Dental VTO Analysis with photographs: 

1. On the Dolphin Imaging main screen, select a layout containing a lateral photograph of the patient superimposed with 
the patient’s tracing. 

The Records/Timepoint layout contains all patient images for the selected timepoint. If this image is available for this 
patient and timepoint, it will be available from this image layout. 

2. Click  on the Dolphin Imaging main screen. 

Or,  

Select Treatment Simulation from the Tools menu on the Dolphin Imaging main screen. 

Or, 
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Select Start Treatment from the Link Tracing+Image dialog box. 

When you enter the Treatment Simulation module, the digitized lateral X-ray with traced skeletal structures or the 
superimposed image appears in the Edit dialog box along with the Treatment Simulation palette (see below). 

2. Click  on the tool bar to open the Tracing Preferences dialog box. 

3. In the Tracing Preferences dialog box, select the Arnett/McLaughlin analysis from the drop-down list box. 

4. Make sure that the following check boxes are checked in the Main Display group box: Tracing Lines & Curves, Tooth 
Templates, Meas Numbers, Add’l Ceph Structures, and Movement Controls. 

For information on how to set Tracing preferences, see "To set tracing preferences" on page 78. 

5. Click OK to close the Tracing Preferences dialog box. 
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6. Click  on the tool bar to open the McLaughlin Dental VTO Analysis. 

The McLaughlin Dental VTO Analysis dialog box opens, as shown below. 

 

 Ortho Use this tab to perform orthodontic treatment simulation. 

Surgical  Use this tab to perform dental surgical treatment simulation. 

Set Default Click this button to set the default values for this timepoint to the values entered on the chart. 

Print Click this button to print a report of the McLaughlin Dental VTO Analysis for this patient. 

Done Click this button to exit the McLaughlin Dental VTO Analysis. 

< Back Click this button to return to the previous chart. 

Next >  Click this button to go to the next chart. 
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If you access McLaughlin Dental VTO from Treatment Simulation for this timepoint in future, you will access the treatment 
simulation information with photographs. 

Using the Treatment Simulation Tool Bar 
The Treatment Simulation Tool Bar contains the following buttons: 

 
Opens the Treatment Simulation module. 

 
Opens the Morph tool. For more information, see "The Morph Palette" on page 277. 

 
Opens the Brushes tool. For more information, see "The Brushes Palette" on page 281. 

 
Sets the display option for the image. For more information, see "To set the display mode for the patient's image" 
on page 407. 

 
Displays the modified image side-by-side with the original image. For more information, see "Viewing Two Images 
Side by Side" on page 272. 

 
Toggles display of the original tracing. For more information, see "To overlay the patient’s original tracing over the 
tracing you are modifying with Treatment Simulation” on page 410. 

 
Toggles the display of the patient’s tracing. 

 
Opens the Enhance tool. For more information, see "To enhance a picture” on page 164. 

 
Sets display preferences. For more information, see "To set display preferences" on page 408. 

 
Opens the original records window. For more information, see “Using the Original Records Window” on page 412. 

 
Opens the measurements table. For more information, see Chapter 12.. 

 
Starts the Arnett Wizard. For more information, see Chapter 17. 

 
Opens the McLaughlin Dental VTO Analysis. For more information, see Chapter 18. 

 
Aligns the image to a reference plane. For more information, see "To align the patient's image to a reference plane" 
on page 361. 

 
Opens the Ricketts VTO/Roth-Williams VTO Wizard. For more information, see Chapter 19. 

 
Undoes the previous operation. 

 
Opens the Link Tracing+Image window. For more information, see "Tracing+Image" on page 358. 

 
Saves the image. For more information, see "Saving the Treatment Simulation" on page 427. 

 
Prints the image. For more information, see "To print the treatment simulation" on page 410. 

 
Copies the image and/or its tracings to the clipboard. 

 
Returns to the Dolphin Imaging main screen. For more information, see Chapter 3. 
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Orthodontic Dental VTO 
The Ortho tab includes three charts: Initial Position, Lower Arch Discrepancy, and Dental VTO (Proposed Dental Movement). 
This section describes each of these charts. 

Initial Position 
You use the Initial Position chart to record midline and molar relationships in millimeters. It is essential that these numbers be 
recorded with the mandible in centric relation. The following figure illustrates this chart: 
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R6 Enter measurement values in millimeters for the upper R6 molar. 

Midline Enter measurement values in millimeters for the upper midline. 

L6 Enter measurement values in millimeters for the upper L6 molar. 

D Enter dental measurement values in millimeters for the lower arch 

S Enter skeletal measurement values in millimeters for the lower arch 

Move Both 
Sides (R+L) 

Check this box to use the same values for both the left and right sides. When you enter a value for one side, 
Dolphin automatically enters the same value for the other side. 

Reset Click this button to reset all values on this chart to their initial values. 

Notes Click this button to enter notes. 

 

To record the initial position: 

1. Click the up or down arrows to change the values in the text boxes to record measurements in millimeters. 

Or, 

Type new values in the text boxes to record measurements in millimeters. 

When you enter values in the text boxes, arrows appear on the chart in the direction of Class II or Class III for the 
molar relationships and left and right for the midline relationships, as shown below.  

In the lower arch, midline relationships can be recorded as dental and/or skeletal. 
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To enter notes on this step: 

1. Click Notes. 

2. Enter any notes in the resulting dialog box. Then, click Close. 

To go on to the next step: 

1. Click Next>. 
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Lower Arch Discrepancy 
You use the Lower Arch Discrepancy chart to record lower arch discrepancies from both cuspid to cuspid and second molar to 
second molar. This breakdown is required to provide specific information concerning movement of the canines and the molars. 
This chart contains two columns, as illustrated below. 
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Move Both 
Sides (R+L) 

Check this box to use the same values for both the left and right sides. When you enter a value for one 
side, Dolphin automatically enters the same value for the other side. 

Reset Click this button to reset all values on this chart to their initial values. 

Notes Click this button to enter notes. 

3 to 3 column Record factors occurring from cuspid to cuspid in this column. 
R: Record factors relating to the right side. 
L: Record factors relating to the left side. 

7 to 7 column Record factors related to the entire lower arch in this column. 
R: Record factors relating to the right side. 
L: Record factors relating to the left side. 

The following factors are recorded on this chart: 

Crowding/ 
Spacing  

Record crowding or spacing in the anterior segment. In the 3 to 3 column, enter a negative number for 
crowding or a positive number for spacing.  

C/S Bicusp/E Record crowding or spacing in the bicuspid region. In the 7 to 7 column, enter a negative number for 
crowding or a positive number for spacing.  

C/S Molars Record crowding or spacing in the molar area. In the 7 to 7 column, enter a negative number for crowding 
or a positive number for spacing.  

Curve of Spee Determine this value by placing a ruler from the most distal molar to the incisor, the deepest point of the 
Curve of Spee (usually in the bicuspid region). Divide the measurement in millimeters in half. Record the 
result in both the left and right side of the 3 to 3 column, and the measurements are automatically recorded 
in the 7 to 7 column. The curve of Spee may be different on the left and right side.  

Midline Negative and positive figures are automatically recorded in both the 3 to 3 and 7 to 7 columns.  

Incisor 
Position 

Record the number of millimeters required or gained relative to incisor position. This figure is based on the 
cephalometric evaluation.  

Initial 
Discrepancy 

Represents the total of the information gathered at this point in the lower arch analysis. 

Stripping  If interproximal reduction is determined to be necessary, record this figure as positive values in the 3 to 3 
and 7 to 7 columns.  

Expansion  If expansion can be used in a particular case, enter positive values in the 3 to 3 and 7 to 7 columns.  
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Distalizing 6-6 If an attempt will be made to upright or distalize the lower first molars, record positive numbers in the 7 to 7 
column only. 

Extraction  If a lower incisor is to be extracted, record the number of millimeters gained in the left and right sides of the 
3 to 3 column. If bicuspids will be extracted, record positive numbers in the 7 to 7 column. 

Remaining 
Discrepancy  

Records the initial discrepancy as well as the treatment methods used in the lower half of the chart.  

To record the lower arch discrepancy: 

1. Click the up or down arrows to change the values in the text boxes to record measurements. 

Or, 

Type new values in the text boxes to record measurements. 

Initially, the Dental VTO (Preview) shows the values that you entered on the Initial Position chart. When you enter 
values in the text boxes on this chart, both the tooth diagram and the Dental VTO (Preview) group box are updated to 
reflect those values.  

 

To record tooth extractions: 

1. On the tooth chart, click the extracted tooth. 

The tooth is removed from the tooth chart, and a green representation of it appears above the chart. If you make a 
mistake, you can click the green tooth representation to return it to the tooth chart. 



18 McLaughlin Dental VTO Analysis Part VII: Interactive Treatment Analyses 

DI_USER_GUIDE-11.5   Rev. 1.01 475 

 

To enter notes on this step: 

1. Click Notes. 

2. Enter any notes in the resulting dialog box. Then, click Close. 

To go on to the next step: 

1. Click Next>. 

Dental VTO (Proposed Dental Movements) 
The Dental VTO (Proposed Dental Movements) chart provides specific information on the movement of the midlines, canines, 
and molars. On this chart, you enter some figures manually, and some figures are automatically entered based on the values 
entered on the other two charts. The values on this chart are listed below: 

• The amount and direction of movement of the lower canines is automatically recorded based on the total discrepancy 
in the 3 to 3 column of the Lower Arch Discrepancy chart.  

• The number just behind the recorded lower canine movement represents the potential space gain in the bicuspid 
region as a result of spacings and extractions.  

• The movement of the molars is recorded based on the available space in the bicuspid region and necessary movement 
of the canines.  

• The lower midline movement is recorded based on the initial position of the midline.  

• Movement of the upper molar is determined based on the original molar relationship and the movement determined for 
the lower molar.  

• The number just in front of upper molar movement relates to the available space in the bicuspid region in the upper 
arch.  

• Upper canine movement needed is then determined by the space available in the bicuspid region and the necessary 
movement of the upper molar.  

• The upper midline is corrected based on the original midline position. 

The following figure illustrates this chart: 
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 Move Both Sides 
(R+L) 

Check this box to use the same values for both the left and right sides. When you enter a value for one 
side, Dolphin automatically enters the same value for the other side. 

Override 
Calculated Values 

Check this box to override the values calculated based on the values entered in the Lower Arch 
Discrepancy chart. When you check this box, the calculated values are replaced by entry fields. 

Treat To: Select Class I, Class II, or Class III for the right and left side.  

Reset Click this button to reset all values on this chart to their initial values. 

Notes Click this button to enter notes. 
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To record values on this chart: 
1. Select Class I, Class II, or Class III for the right and left side in the Treat To: group box. 

2. Click the up or down arrows to change the values in the text boxes to record measurements. 

Or, 

Type new values in the text boxes to record measurements. 

To enter notes for this step: 

1. Click Notes. 

2. Enter any notes in the resulting dialog box. Then, click Close. 

To finish Orthodontic Dental VTO: 

1. Save your treatment simulation. 

For more information, see “Saving the Treatment Simulation” on page 427. 

2. Click Done. 
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Surgical Dental VTO 
The Surgical Dental VTO tab includes three charts: Initial Position, Lower Arch Discrepancy, and Upper Arch Discrepancy. This 
section describes each of these charts. 

Initial Position 
You use the Initial Position chart to record midline and molar relationships in millimeters. It is essential that these numbers be 
recorded with the mandible in centric relation. The following figure illustrates this chart: 

 

R6 Enter measurement values in millimeters for the upper R6 molar. 

Midline Enter measurement values in millimeters for the upper midline. 

L6 Enter measurement values in millimeters for the upper L6 molar. 

D Enter dental measurement values in millimeters for the lower arch 



18 McLaughlin Dental VTO Analysis Part VII: Interactive Treatment Analyses 

DI_USER_GUIDE-11.5   Rev. 1.01 479 

S Enter skeletal measurement values in millimeters for the lower arch 

Move Both 
Sides (R+L) 

Check this box to use the same values for both the left and right sides. When you enter a value for one side, 
Dolphin automatically enters the same value for the other side. 

Reset Click this button to reset all values on this chart to their initial values. 

Notes Click this button to enter notes. 

To record the initial position: 

1. Click the up or down arrows to change the values in the text boxes to record measurements in millimeters. 

Or, 

Type new values in the text boxes to record measurements in millimeters. 

When you enter values in the text boxes, arrows appear on the chart in the direction of Class II or Class III for the 
molar relationships and left and right for the midline relationships, as shown below.  

In the lower arch, midline relationships can be recorded as dental and/or skeletal. 

 

To enter notes on this step: 

1. Click Notes. 

2. Enter any notes in the resulting dialog box. Then, click Close. 
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To go on to the next step: 

1. Click Next>. 

Lower Arch Discrepancy 
You use the Lower Arch Discrepancy chart to record lower arch discrepancies from both cuspid to cuspid and second molar to 
second molar. This breakdown is required to provide specific information concerning movement of the canines and the molars. 
This chart contains two columns, as illustrated below. 
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3 to 3 column Record factors occurring from cuspid to cuspid in this column.  
R: Record factors relating to the right side. 
L: Record factors relating to the left side. 

7 to 7 column Record factors related to the entire lower arch in this column.  
R: Record factors relating to the right side.  
L: Record factors relating to the left side. 

Move Both 
Sides (L+R) 

Check this box to apply the same movement values to both the left and right sides. When you enter a value 
for one side, Dolphin automatically enters the same value for the other side. 

Reset Click this button to reset all values on this chart to their initial values. 

Notes Click this button to enter notes. 

The following factors are recorded on this chart: 

Crowding/Spacing Record crowding or spacing in the anterior segment. In the 3 to 3 column, enter a negative number for 
crowding or a positive number for spacing. 

C/S Bicusp/E  Record crowding or spacing in the bicuspid region. In the 7 to 7 column, enter a negative number for 
crowding or a positive number for spacing. 

C/S Molars Record crowding or spacing in the molar area. In the 7 to 7 column, enter a negative number for 
crowding or a positive number for spacing. 

Curve of Spee Determine this value by placing a ruler from the most distal molar to the incisor, the deepest point of 
the Curve of Spee (usually in the bicuspid region). Divide the measurement in millimeters in half. 
Record the result in both the left and right side of the 3 to 3 column, and the measurements are 
automatically recorded in the 7 to 7 column. The curve of Spee may be different on the left and right 
side. 

Midlines  Negative and positive figures are automatically recorded in both the 3 to 3 and 7 to 7 columns. 

Incisor Position Record the number of millimeters required or gained relative to incisor position. This figure is based on 
the cephalometric evaluation. 

Initial discrepancy  Represents the total of the information gathered at this point in the lower arch analysis. 

Stripping If interproximal reduction is determined to be necessary, record this figure as positive values in the 3 to 
3 and 7 to 7 columns. 

Expansion If expansion can be used in a particular case, enter positive values in the 3 to 3 and 7 to 7 columns. 
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Distalizing 6-6 If an attempt will be made to upright or distalize the lower first molars, record positive numbers in the 7 
to 7 column only. 

Extraction  If a lower incisor is to be extracted, record the number of millimeters gained in the left and right sides of 
the 3 to 3 column. If bicuspids will be extracted, record positive numbers in the 7 to 7 column. 

Remaining 
Discrepancy 

Records the initial discrepancy as well as the treatment methods used in the lower half of the chart. 

To record the lower arch discrepancy: 

1. Click the up or down arrows to change the values in the text boxes to record measurements. 

Or, 

Type new values in the text boxes to record measurements. 

Initially, the Dental Pre-Surgical VTO Lower Arch group box shows the values that you entered on the Initial Position 
chart. When you enter values in the text boxes on this chart, both the tooth diagram and the Dental Pre-Surgical VTO 
Lower Arch group box are updated to reflect those values.  
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To record tooth extractions: 

1. On the tooth chart, click the extracted tooth. 

The tooth is removed from the tooth chart, and a green representation of it appears above the chart. If you make a 
mistake, you can click the green tooth representation to return it to the tooth chart. 

 

To enter notes on this step: 

1. Click Notes. 

2. Enter any notes in the resulting dialog box. Then, click Close. 

To go on to the next step: 

1. Click Next>. 
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Upper Arch Discrepancy 
You complete this chart using the same procedure as the Lower Arch Discrepancy chart, except that you record values for the 
upper arch only. Inter-arch movements are then carried out by the surgeon. 

 

To record the upper arch discrepancy: 

1. Click the up or down arrows to change the values in the text boxes to record measurements. 

Or, 

Type new values in the text boxes to record measurements. 

Initially, the Dental Pre-Surgical VTO Upper Arch group box shows the values that you entered on the Initial Position 
chart. When you enter values in the text boxes on this chart, both the tooth diagram and the Dental Pre-Surgical VTO 
Upper Arch group box are updated to reflect those values.  
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To record tooth extractions: 

1. On the tooth chart, click the extracted tooth. 

The tooth is removed from the tooth chart, and a green representation of it appears above the chart. If you make a 
mistake, you can click the green tooth representation to return it to the tooth chart. 

 

To enter notes on this step: 

1. Click Notes. 

2. Enter any notes in the resulting dialog box. Then, click Close. 
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To finish Surgical Dental VTO: 

1. Save your treatment simulation. 

For more information, see "Saving the Treatment Simulation” on page 427. 

2. Click Done. 

Printing the Treatment Prediction 
When you print the treatment prediction, Dolphin prints a report of the treatment work-up, cephalometric data, tooth chart, and 
any notes.  

To print the treatment prediction: 

1. Click Print. 

The Print dialog box is displayed. 

2. Select any printing options you want, and click OK. 

 

Printer Indicates the printer to which the print job will be sent. You set the printer for the image layout using the File menu 
Printer Setup option, as described on "To set up your printer." If you have not specified the printer setup, Dolphin 
uses the default printer settings for your computer. 
Note: Dolphin does not retain printer settings when you exit the program. To retain printer settings, set them using 
the Microsoft Windows Printers Control Panel. 

Properties Click this button to set advanced properties for the selected printer. 
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Print 
Range 

Select what you want to print. Your options are: 
All: Print an entire document. You would typically use this option. 
Pages: Print only pages in the specified range. 
Selection: Print just what you have selected. 

Copies Enter the number of copies you want to print. 

Print 1:1 Click this check box to print an image using the 1:1 option, which scales an image according to the calibration 
specified for it. 

Preview Click this check box to preview your print job on the computer screen.  

The following figure illustrates an example printed treatment prediction. 

 

Saving the Treatment Prediction 
When you save the treatment prediction, Dolphin always saves both of the following: 

• the image and data that comprise the treatment simulation 

• the original image and data, for your reference or further treatment simulation 

Each Dental VTO (both orthodontic and surgical) is saved with the treatment work-up, the image (facial or radiograph), and the 
cephalometric data.  

To save the treatment image after you have finished the treatment operations: 

1. Click   on the Treatment Simulation Tool Bar. 

The Save Image dialog box shown below is displayed. 

2. Optionally, modify the image title. 
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Dolphin automatically provides an appropriate image title, "Treatment Simulation" in most cases. However, you may 
wish to enter a more specific name (for example, "dental VTO"), as appropriate for your treatment simulation. 

3. Select a slot from the Save As list box in which to save this image, and click OK. 

For each patient and timepoint, you can save up to eight different treatment simulations. 

Note: If you are viewing two images side by side when you save, the side-by-side view of the two images is saved as a 
single image. 

 

Image Title Enter a title for this image, up to 25 characters. 

New Notes Notes for this image. This text box is automatically completed with a summary of the operations you performed. 
However, you can freely modify the content of these notes. When you view this treatment simulation again later, 
you can access these notes using the Previous Notes tab on the Treatment Planning palette. 

Into Slot Select one of the eight slots available for each timepoint in which to save this image.  
The field below this list box indicates whether the selected slot already contains an image. If you select a slot 
containing an image, the existing image is overwritten with the new image. 

Current 
Slot Notes 

If you select a slot that already contains an image, the notes previously entered for that slot appear in this text 
box. 
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19 Ricketts VTO/Roth-Williams AEO VTO 
The Ricketts VTO and Roth-Williams AEO VTO are constructed using tracing sequences performed on various superimpositions 
that simulate the combination of changes taking place with growth and the outcome of orthodontic treatment.  These simulations 
enable the clinician to quickly predict, plan, and visualize the sequence of treatment to be performed. 
The Ricketts VTO/Roth-Williams AEO VTO Interactive Analysis consists of a wizard that greatly simplifies construction of the 
necessary superimpositions and tracing sequences. The wizard only stops at steps that require your input. The wizard 
automatically performs all steps that do not require your input, such as the growth steps.  
The Ricketts VTO and the Roth-Williams AEO VTO methods are very similar, but the Roth-Williams AEO VTO provides more 
flexibility. For illustration purposes, the figures in this section illustrate the Roth-Williams AEO VTO method. 

To start the Ricketts VTO/Roth-Williams AEO VTO wizard: 

1. Click  on the Treatment Simulation tool bar. 

The wizard starts and displays its Setup step. In the Treatment Simulation window, the patient's image is hidden and 
the tracing is set to the Ricketts analysis.  

 
The Ricketts VTO/Roth-Williams AEO VTO Interactive Analysis consists of many steps, only some of which require your input. 
When you use the wizard, Dolphin automatically performs all steps that do not require input, such as the growth steps. The 
Wizard groups the steps that require your interaction into a Setup step and five main treatment steps. Each treatment step 
includes: 

• sub-steps in the form of list items, each of which has an associated superimposition 

• other relevant superimpositions, which are part of the current step, but are rendered unnecessary by Dolphin Imaging's 
growth automation 
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To navigate among the Setup step and the five main treatment steps: 

1. Click Next > to go to the next step. 

Or, 

Click < Back to return to the previous step. 

Or, 

Click Restart (if available) to return to the Setup step. 

Or, 

Click Finish to close the Wizard, applying growth without treatment for all the subsequent steps you skipped. 

To navigate among the sub-steps within a treatment step: 

1. Click the list item for a sub-step. 

 The patient's tracings are automatically superimposed as appropriate for that sub-step. 

To view one of the other relevant superimpositions for verification purposes: 

1. Click the superimposition you want to view in the list of other relevant superimpositions. 

Wizard Setup 
When you start the wizard, it opens its Setup step. This step consists of two tabs: 
Setup Constants Use this tab to set values for the growth operation, set ideal incisal measurements, and choose 

the VTO method (Classic Ricketts or Roth-Williams AEO).  

View Initial 
Measurements 

Use this tab to view a measurement table for this patient with initial values. 

Setup Constants Tab 
On this tab, you can set values for the growth operation, set ideal incisal measurements, and choose the VTO method (Classic 
Ricketts or Roth-Williams AEO). Except for the number of years for the growth operation, all of the values on this tab are initially 
set to defaults. 

To enter set-up constants: 

1. Enter the number of years that you want to use for the growth operation. 

2. Optionally, select either Classic Ricketts or Roth-Williams AEO as your VTO method. 

3. Optionally, change any of the Growth constants. 

4. Optionally, set any ideal incisal measurements. 

5. Optionally, click Save as Default to use your modified values (except the years of growth) as the default values 
whenever you use this wizard in the future. 



19 Ricketts VTO/Roth-Williams AEO VTO Part VII: Interactive Treatment Analyses 

DI_USER_GUIDE-11.5   Rev. 1.01 491 

6. Click Next > to go to the next step of the wizard. 

Or, 

Click View Initial Measurements to view a table of initial measurements for this patient. 

 
Growth Constants 
(nominal) 

Enter the number of millimeters that you want each of these measurements to change each year during 
a growth operation. The default values appear in parentheses. 
� Nasion: Enter the amount of change for the Nasion in millimeters. 
� Basion: Enter the amount of change for the Basion in millimeters. 
� Condylar Axis: Enter the amount of change for the Condylar Axis in millimeters. 
� Corpus Axis: Enter the amount of change for the Corpus Axis in millimeters. 
� Tip of Nose: Enter the amount of change for the Nasion in millimeters. 

Ideal (nominal) Enter the ideal incisal measurements. The default values appear in parentheses. 
� Lower Incisal Angle: Enter the number of degrees for the ideal lower incisal angle. 
� Interincisal Angle: Enter the number of degrees for the ideal interincisal angle. 
� Overjet: Enter the ideal overjet amount in millimeters. 
� Overbite: Enter the ideal overbite amount in millimeters. 

VTO Method Select the VTO method you want to use, either Classic Ricketts or Roth-Williams AEO. 

Save as Default Click this button to use your modified values (except the years of growth) as the default values whenever 
you use this wizard in the future. 

Patient Current Age 
(Years) 

Indicates this patient's current age. The Classic Rickets method can be used to stimulate growth only for 
patients under 18 years of age. 

Growth Enter the number of years for which you want to stimulate growth for this patient. 
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View Initial Measurements Tab 
On this tab, you can view a table of the initial measurements for this patient. 

To view initial measurements: 

1. Click the View Initial Measurements tab, if it isn't already selected. 

2. Optionally, select an analysis from the drop-down list box. 

3. Optionally, enter the number of years that you want to use for the growth operation. 

4. Click Next > to go to the next step of the wizard. 

Or, 

Click Setup Constants to return to the Setup Constants tab 

 

drop-down 
list box 

Select the analysis for which you want to view the measurements table. 

Name Name of the measurement. 

Value The value for each measurement is listed in this column. 

Norm The norm for the patient’s gender and racial classification is listed in this column. This value is considered 
normal or average for this measurement. 

Std Dev The standard deviation for this measurement is listed in this column. Standard deviation is a statistical term that 
indicates the expected variation of data from the norm. For instance, if a measurement has a small standard 
deviation, the measurements for most patients are expected to be close to the norm. If a measurement has a 
large standard deviation, it is not expected that most patient's measurement will be close to the norm. 
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Dev Norm The patient’s deviation from the norm is listed in this column. This value is calculated as follows: 
Dev Norm = ( Value - Norm ) / Std Dev. 
For example, suppose a patient's value for SNA is 84 degrees, the norm is 82 degrees, and the standard 
deviation is 3.5. The patient's deviation from the norm would be: 
( 84 - 82 ) / 3.5 = 0.6 
This means this customer is 2 degrees above norm (84 - 82 = 2) for this measurement. Every 3.5 degrees 
above normal is one standard deviation. So, the patient is 0.57 standard deviations above normal (2 / 3.5 = 
0.57) In the measurements table above, 0.57 is rounded up to 0.6.  

Scroll Bar Use the scroll bar to scroll through the list of measurements. 

Growth Enter the number of years for which you want to stimulate growth for this patient. 

Step 1: Evaluate Facial Axis Change 
When you enter this step, the growth you specified on the Setup step is applied automatically to the Nasion and Basion, and the 
tracing superimposition for this step is displayed. As illustrated in the figure below, the patient's tracing displays the Facial Axis 
measurement (91.3 degrees in this example) and the angle of Facial Axis change (initially zero). 

 

Steps/sub-steps Select a step or sub-step to perform the listed operation. This step has no sub-steps. 

Other Relevant 
Superimpositions 

Select a superimposition in this list to view it for verification purposes. 

 
Click this button to toggle the display of the patient's original tracing. 
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To change the Facial Axis: 

1. Click and drag the blue movement control. 

To go to the next step: 

1. Click Next >. 

To simulate growth without treatment: 

1. Without making any changes to the blue movement control, click Finish. 

The Wizard dialog box closes and the Treatment Simulation window shows the patient's tracing with the growth 
operation you specified on the Setup step applied. 

Step 2: Evaluate A-Point and Occlusal Plane 
When you enter this step, the growth you specified on the Setup step is applied automatically to the Condylar Axis and the 
Corpus Axis, and the Mandible and Maxilla are placed automatically. The tracing superimposition for the first sub-step is 
displayed. As illustrated in the figure below, the patient's tracing displays the Occlusal Plane/Facial Axis measurement (83.4 
degrees in this example), the A-Point Convexity measurement (4.7 mm in this example), and the angle of Occlusal Plane change 
(initially zero). 
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Steps/sub-steps Select a step or sub-step to perform the listed operation. This step has two sub-steps: 
� Step 2a) Evaluate A-Point: In this sub-step, you can modify the A-Point. 
� Step 2b) Evaluate Occ Plane @ Mark #2 (Classic Ricketts method) or Evaluate Occlusal 

Plane (Roth-Williams AEO method): In this sub-step, you can tilt the Occlusal Plane at the 
A1B1 Bisect.  

The superimpositions used for these two sub-steps depend on whether you are using the Classic Rickets or 
the Roth-Williams AEO method.  
Note: Although the Roth-Williams AEO method does not include tilting the Occlusal Plane, Dolphin includes 
this sub-step to offer you greater flexibility. 

Other Relevant 
Superimpositions 

Select a superimposition in this list to view it for verification purposes. 

 
Click this button to toggle the display of the patient's original tracing. 

To modify the A-Point: 

1. Click Step 2a) Evaluate A-Point. 

2. Click and drag the blue movement control at the A-Point. 

To tilt the Occlusal Plane: 

1. Click Step 2b) Evaluate Occ Plane @ Mark #2 if you are using the Classic Ricketts method. 

Or, 

Click Step 2b) Evaluate Occlusal Plane if you are using the Roth-Williams AEO method. 

2. Click and drag the blue movement control at the Occlusal Plane. 

To go to the next step: 

1. Click Next >. 
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Step 3: Evaluate Incisors and Molars 
When you enter this step, the growth you specified on the Setup step is applied automatically, and the teeth are placed in their 
natural position (growth without treatment). The tracing superimposition for the first sub-step is displayed. As illustrated in the 
figure below, the patient's tracing displays the Interincisal Angle measurement (133.2 degrees in this example), L1 Protrusion 
distance (2.2 mm in this example), L1/Facial Plane Angle measurement  (19.2 degrees in this example), Overbite measurement 
(5.4 mm in this example), and Overjet measurement (4.9 mm in this example). 

 

Steps/sub-steps Select a step or sub-step to perform the listed operation. This step has four sub-steps: 
� Step 3a) Evaluate Lower Incisor: In this sub-step, you can modify the lower incisor location. 
� Step 3b) Evaluate Lower Molar: In this sub-step, you can modify the lower molar location.  
� Step 3c) Evaluate Upper Molar: In this sub-step, you can modify the upper molar location. 
� Step 3d) Evaluate Upper Incisor: In this sub-step, you can modify the upper incisor location. 

Other Relevant 
Superimpositions 

Select a superimposition in this list to view it for verification purposes. 

 
Click this button to toggle the display of the patient's original tracing. 

Arch Length 
Discrepancy 

Indicates the Arch Length Discrepancy values for your current operation. 
� Mx: Indicates the ALD for the patient’s upper teeth in the current simulation.  
� Md: Indicates the ALD for the patient’s lower teeth in the current simulation.  
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Ideal Automatically applies the following movements: 
� The lower incisor is placed with the tip at its ideal position and the tooth at its ideal inclination. 
� The upper incisor is placed at the ideal interincisal angle with respect to the lower incisor, with 

ideal overbite and overjet. 
� The molars are repositioned so that they are upright and pushed up/down against the Occlusal 

Plane. 
This operation uses the ideal values you specified on the Setup step. 

To reposition the teeth: 

1. Click the sub-step for the tooth you want to move. 

2. Click and drag the blue movement control at a tooth's root to rotate the tooth. 

Or, 

Click and drag the blue movement control at a tooth's crown to move the tooth laterally. 

Or, 

Click the Ideal button to automatically move the teeth to their ideal positions based on the values you entered on the 
Setup step. 

The tracings also display the “1mm-1mm" ideal position marker for the lower incisor tip. You may need to zoom in on 
the tracing to see this marker.  
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To go to the next step: 

1. Click Next >. 

Step 4: Evaluate Soft Tissue Profile 
When you enter this step, the growth you specified on the Setup step is applied automatically, and the soft tissue is placed in its 
natural position. The tracing superimposition for the first sub-step is displayed. 

 

Steps/sub-steps Select a step or sub-step to perform the listed operation. For the Classic Ricketts method, this step has the 
following sub-steps: 
� Step 4a) Evaluate Nasion/Bridge of Nose Area: In this sub-step, you can modify the soft tissue 

profile points in the area of the Nasion and bridge of the nose. 
� Step 4b) Evaluate Tip of the Nose/APoint Area: In this sub-step, you can modify the soft tissue 

profile points in the area of the tip of the nose and the A-Point. 
� Step 4c) Evaluate Upper Lip (if advancing): In this sub-step, you can modify the soft tissue 

profile points to advance the upper lip. This superimposition uses 100% of the upper lip 
movement. 

� Step 4d) Evaluate Upper Lip (if retracting): In this sub-step, you can modify the soft tissue 
profile points to retract the upper lip. This superimposition uses 2/3 of the upper lip movement. 

� Step 4e) Evaluate Lower Lip: In this sub-step, you can modify the soft tissue profile points for 
the lower lip. 

� Step 4f) Evaluate Chin/Neck Area: In this sub-step, you can modify the soft tissue profile points 
in the chin and neck area. 
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For the Roth-Williams AEO method, this step has the following sub-steps: 
� Step 4a) Evaluate Nasion Area: In this sub-step, you can modify the soft tissue profile points in 

the area of the Nasion. 
� Step 4b) Evaluate Bridge of Nose Area: In this sub-step, you can modify the soft tissue profile 

points in the area of the bridge of the nose. 
� Step 4c) Evaluate Tip of the Nose/A Point Area: In this sub-step, you can modify the soft tissue 

profile points in the area of the tip of the nose and the A-Point. 
� Step 4d) Evaluate Upper Lip (if advancing): In this sub-step, you can modify the soft tissue 

profile points to advance the upper lip. This superimposition uses 100% of the upper lip 
movement. 

� Step 4e) Evaluate Upper Lip (if retracting): In this sub-step, you can modify the soft tissue 
profile points to retract the upper lip. This superimposition uses 2/3 of the upper lip movement. 

� Step 4f) Evaluate Lower Lip: In this sub-step, you can modify the soft tissue profile points for the 
lower lip. 

� Step 4g) Evaluate Chin/Neck Area: In this sub-step, you can modify the soft tissue profile points 
in the chin and neck area. 

Other Relevant 
Superimpositions 

Select a superimposition in this list to view it for verification purposes. 

 
Click this button to toggle the display of the patient's original tracing. 

Profile Select the option for the part of the profile you want to work on. 
� Touch-up: Select this option to touch up areas of the profile other than the lips.  
� Lips: Select this option to touch up the lips.  

To touch up areas of the profile other than the lips: 

1. Click the sub-step for the area you want to touch up. 

2. Select the Touch-up option for the profile. 

3. Click and drag the red and grey movement controls to touch up the profile. 

To touch up the lips: 

1. Click the sub-step for the touch-up option you want to perform. 

2. Select the Lips option for the profile. 

Points for touching up the patient's lips appear, as illustrated in the figure below.  In this illustration, the original tracing 
is not displayed so that you can easily see the touch-up movement controls for the patient's lips. 
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3. Click and drag the red and grey movement controls to touch up the lips. 

If you zoom in, you can see 1/3 and 2/3 markers on the Occlusal Plane. If you retracted the upper incisor and select 
Step 4d (Classic Ricketts method) or Step 4e (Roth-Williams AEO method), which superimposes on the 2/3 marker, 
you should see the new and old upper lip tracings superimposed perfectly, as illustrated below.   
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Similarly, if you advanced the upper incisor and selected Step 4c (Classic Ricketts method) or Step 4d (Roth-Williams 
AEO method) (superimposing on 100% lip movement), the upper lip tracings would match exactly. 

To go to the next step: 

1. Click Next >. 
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Step 5: Evaluate Superimpositions 
When you enter this step, the results of your treatment simulation up to this point appear. The Ricketts analysis is shown by 
default, but you can change the analysis if you wish to view a different one. 

 

Steps/sub-steps Select a step or sub-step to perform the listed operation. For the Classic Ricketts method, this step has the 
following sub-steps: 
� Step 5a) Evaluate Ricketts Superimposition 1: In this sub-step, you verify the planned 

outcome by viewing a superimposition on Ba-Na @ CC. 
� Step 5b) Evaluate Ricketts Superimposition 2: In this sub-step, you verify the planned 

outcome by viewing a superimposition on Na-Ba @ Na. 
� Step 5c) Evaluate Ricketts Superimposition 3: In this sub-step, you verify the planned 

outcome by viewing a superimposition on Xi-PM @ PM. 
� Step 5d) Evaluate Ricketts Superimposition 4: In this sub-step, you verify the planned 

outcome by viewing a superimposition on ANS-PNS @ ANS. 
� Step 5e) Evaluate Ricketts Superimposition 5: In this sub-step, you verify the planned 

outcome by viewing a superimposition on E-Plane @ Occ. Plane. 
For the Roth-Williams AEO method, this step has the following sub-steps: 
� Step 5a) Adjust TLV line if applicable: In this sub-step, you can adjust the true vertical line. 
� Step 5b) Evaluate Ricketts Superimposition 1: In this sub-step, you verify the planned 

outcome by viewing a superimposition on Ba-Na @ CC. 
� Step 5c) Evaluate Ricketts Superimposition 2: In this sub-step, you verify the planned 

outcome by viewing a superimposition on Na-Ba @ Na. 
� Step 5d) Evaluate Ricketts Superimposition 3: In this sub-step, you verify the planned 

outcome by viewing a superimposition on Xi-PM @ PM. 
� Step 5e) Evaluate Ricketts Superimposition 4: In this sub-step, you verify the planned 

outcome by viewing a superimposition on ANS-PNS @ ANS. 
 St  5f) E l t  Ri k tt  S i iti  5  I  thi  b t   if  th  l d t  
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by viewing a superimposition on E-Plane @ Occ. Plane. 

Other Relevant 
Superimpositions 

Select a superimposition in this list to view it for verification purposes. 

 
Click this button to toggle the display of the patient's original tracing. 

Adv... Click this button to open the Tracing Superimpositions dialog box and view the Rickets 5 superimpositions. 
For more information, see "Tracings over Tracings" on page 364. 

Show Analysis Check this box and select an analysis from the drop-down list box to view a different analysis. 

To adjust the true vertical line (Roth-Williams AEO method only): 

1. Click and drag the blue movement control. 

To view the five Ricketts superimpositions: 

1. Click the sub-step for each Ricketts superimposition. 

2. Verify the planned outcome. 

Finishing the Wizard 
When you exit the wizard, the Treatment Simulation window returns to the settings that were in effect before you started the 
wizard.  For example, if the patient's image was displayed before you started the wizard, the patient's image returns when you 
exit. In addition, the patient's tracing reverts back to the analysis that was selected when you started the wizard. The only 
difference is that the patient's image and tracing reflect the treatments and growth operations that you applied using the wizard.  
Note: If you exit the wizard before completing all the steps, Dolphin applies the treatments for the steps that you completed and 
applies growth without treatment for all the steps that you skipped. 

To exit the wizard: 

1. Click Finish. 

The Wizard dialog box closes, and the Treatment Simulation window shows the final tracing. At this point, you may 
wish to re-display the patient's image or save this treatment simulation. For more information, see "To set the display 
mode for the patient's image" on page 407 and "Saving the Treatment Simulation" on page 427. 

The following figure illustrates the patient's image and tracings before and after Roth-Williams AEO: 



Dolphin Imaging User's Guide April 2011 

504 DI_USER_GUIDE-11.5   Rev. 1.01 

 



 

DI_USER_GUIDE-11.5   Rev. 1.01 505 

Part VIII: Dolphin Letters System (DLS) 
This part of the Dolphin Imaging User’s Guide describes how to use the Dolphin Letter System (DLS) module. This module 
simplifies and automates generation of referral and patient letters. Every letter can include your patient’s digital pictures. You can 
choose from dozens of pre-defined, professionally written correspondence templates or easily customize your own. DLS can be 
fully integrated with all your Dolphin Imaging software modules.  
This module includes the following features: 

• Extensive letter template library 

• Patient exam questionnaire 

• Presentation 

• Letter wizard 

• Support for customizing letters 
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20 Questionnaires and Presentations 
Using questionnaires, you can define the information that you want to store in the database for later use with the Dolphin Letters 
System. This feature is only available with Dolphin Premium. 
With this feature, you can define any number of questionnaires, each with a unique name. Once you have defined a 
questionnaire, you can use it to enter the information for a specific patient and timepoint (for instance, during the initial 
consultation).  
For example, you may decide to run a questionnaire during patient treatment to store the treatment findings. Later, you could 
start the Dolphin Letter System, and the information needed for the patient letter would already be stored in the database.  
If you have Dolphin Premium Security Utilities installed, you can also generate PowerPoint Presentations from your customized 
questionnaires. You can link related media, such as graphics, video, or other animation, and the linked media becomes part of 
the presentation based on the patient's answers to the questionnaire.  

Setting Up a Questionnaire 

To set up or view questionnaires: 
1. Select Questionnaire Setup from the Edit menu. 

 
Or, 

Select Edit Diagnostic Lists from the Dolphin Letter System (DLS) Letters menu.  

The Questionnaire Setup dialog box appears. 
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Questionnaire group 
box 

Select an existing questionnaire from this drop-down list box to view, modify, or delete it. 
New...: Click to add a new questionnaire. For more information, see "Adding a New Questionnaire" on 
page 509. 
Save...: Click to save the current questionnaire.  
Delete: Click to mark the selected questionnaire as deleted. Deleted questionnaires are not removed 
from your database, so you can recover them. For more information, see "Deleting or Recovering a 
Questionnaire" on page 512. 
Recover: Click to recover a questionnaire that has been marked as deleted. For more information, see 
"Deleting or Recovering a Questionnaire" on page 512. 
Export...: Click to save the questionnaire on disk as a .qst file. For more information, see "Importing 
and Exporting Questionnaires" on page 512. 
Import...: Click to import a .qst file into the questionnaire dialog box. For more information, see 
"Importing and Exporting Questionnaires" on page 512. 

Selected Questions 
group box 

Lists the questions chosen for the questionnaire. 

Custom Tokens... Opens the Custom Tokens dialog box where you can define custom tokens for questionnaires. For 
more information, see "Adding, Removing, and Reordering Custom Tokens" on page 510. 

Available Questions 
group box 

Lists the questions available to add to this questionnaire. 
New: Click this button to add a new question to the list. For more information, see "Adding, Removing, 
and Reordering Questions" on page 510. 
Copy: Click this button to make a copy of the selected question. For more information, see "Copying a 
Question" on page 514. 
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Rename: Click this button to rename a question. For more information, see "Adding, Removing, and 
Reordering Questions" on page 510. 
Remove: Click this button to remove the selected question from the list. For more information, see 
"Adding, Removing, and Reordering Questions" on page 510. 

< or > Click these buttons to move questions between the Available Questions list box and the Selected 
Questions list box. 

Available Answers 
group box 

Lists the answers available for the selected question (for example, if the question is crowding, the 
answer would be the type of crowding). 
Language Style: Select from Clinical, Dentist, or Layman. 
Add: Click to add a code and phrase specific to your practice. For more information, see "Adding a 
Code to an Answer Item" on page 519. 
Modify: Click to modify the existing codes and/or phrases as you require. For more information, see 
"Modifying an Answer Item" on page 517. 
Remove: Click to remove codes and/or phrases that are not applicable to your practice. For more 
information, see "Removing an Answer Item" on page 518. 
This group box contains the following tabs: 
Settings: Check the appropriate boxes to categorize answer items. For more information, see 
"Categorizing an Answer Item" on page 517. 
Codes: Use this tab to add and maintain the codes associated with answer items. For more 
information, see "Using Codes" on page 518. 
Presentation Media: Use this tab to associate presentation media with answer items. For more 
information, see "Associating Media with an Answer Item" on page 533. 
Presentation Groups: Use this tab to associate answer items with presentation groups. For more 
information, see "Setting Up Presentation Groups" on page 531. 

 

Adding and Editing Questionnaires 
The following procedures describe how to: 

• Add a new questionnaire 

• Modify an existing questionnaire 

• Add, remove, and reorder questions in a questionnaire 

• Add, remove, and reorder custom tokens in a questionnaire 

• Delete and recover questionnaires 

• Import and export questionnaires 
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Adding a New Questionnaire 

To add a new questionnaire: 

1. From the Questionnaire Setup dialog box, click New. 

A dialog box appears where you enter a name for the questionnaire. 

2. Enter a descriptive name for the questionnaire. Then, click OK. 

For example, you might enter "Initial Exam Questions." 

3. Add, remove, or reorder the questions in the questionnaire. 

For more information, see "Adding, Removing, and Reordering Questions" on page 510. 

4. Add, remove, or reorder the custom tokens in the questionnaire. 

For more information, see "Adding, Removing, and Reordering Custom Tokens" on page 510. 

5. Click Save... to save the questionnaire. 

6. Optionally, enter a new name for this questionnaire. 

7. Click OK. 

If a questionnaire already exists with the same name as this questionnaire, a dialog box opens asking whether you 
would like to overwrite it. 

8. Click Yes to overwrite the existing questionnaire. 

Or, 

Click No if you do not want to overwrite the existing questionnaire. 

Modifying an Existing Questionnaire 

To modify an existing questionnaire: 

1. From the Questionnaire Setup dialog box, select the questionnaire you want to modify from the Questionnaire drop-
down list box. 

2. Add, remove, or reorder the questions in the questionnaire. 

For more information, see "Adding, Removing, and Reordering Questions" on page 510. 

3. Add, remove, or reorder the custom tokens in the questionnaire. 

For more information, see "Adding, Removing, and Reordering Custom Tokens" on page 510. 

4. Click Save... to save the questionnaire and close the Questionnaire Setup dialog box. 

5. Optionally, enter a new name for this questionnaire. 

6. Click OK. 

If a questionnaire already exists with the same name as this questionnaire, a dialog box opens asking whether you 
would like to overwrite it. 
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7. Click Yes to overwrite the existing questionnaire. 

Or, 

Click No if you do not want to overwrite the existing questionnaire. 

Adding, Removing, and Reordering Questions 

To add a question to a questionnaire: 

1. In the Available Questions list box, select a question, and click the button labeled <. 

The selected question moves to the Selected Questions list box. 

To remove a question from a questionnaire: 

1. In the Selected Questions list box, select a question, and click the button labeled >. 

The selected question moves to the Available Questions list box. 

To change the order of questions in a questionnaire: 

1. Click and drag questions in the Selected Questions list box. 

The questions are reordered. 

Adding, Removing, and Reordering Custom Tokens 

To add a new custom token: 

1. On the Questionnaires tab of the Questionnaire Setup dialog box, click Custom Tokens... 

The Customs Tokens dialog box opens. 

2. Type the new custom token in the text box. 

3. If you want to keep this token for future use, click Keep. 

If you do not keep the custom token, it will be available for this questionnaire only. 

4. To add this custom token to the questionnaire, click the button labeled >. 

The selected custom token moves to the Selected list box. 
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To remove a custom token from the questionnaire: 

1. On the Questionnaires tab of the Questionnaire Setup dialog box, click Custom Tokens... 

The Customs Tokens dialog box opens. 

2. Select the token you want to remove from the questionnaire from the Selected list box. 

3. To remove this custom token from the questionnaire, click the button labeled <. 

The selected custom token moves to the Available list box. 

To reorder the custom tokens: 

1. Click and drag tokens in the Selected list box into the desired order. 

 

Available text box Enter a new custom token in this text box to use it in this questionnaire. 

Keep Click this button to keep the new custom token for use with other questionnaires. 

Available list box Lists the custom tokens available for use in this questionnaire. 

> or < Click these buttons to move custom tokens between the Available and Selected list boxes. 

Selected list box Lists the custom tokens selected for use in this questionnaire. 
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Deleting or Recovering a Questionnaire 
Deleting a questionnaire does not actually remove it from your database.  It simply marks the questionnaire as deleted.  Later, 
you can recover the questionnaire. 

To delete a questionnaire: 

1. From the Questionnaire Setup dialog box, select the questionnaire you want to delete from the Questionnaire drop-
down list box. 

2. Click Delete.... 

3. Click Yes to confirm the deletion. 

To recover a deleted questionnaire: 

1. Click Recover... 

A dialog box appears listing all the questionnaires in your database that are marked as deleted. 

2. Select the questionnaire you want to recover.  Then, click OK. 

Importing and Exporting Questionnaires 

To import a questionnaire: 

1. From the Questionnaire Setup dialog box, click Import.... 

A dialog box opens so that you can browse to the file containing the questionnaire. 

2. Browse to the file containing the questionnaire, and click Open. 

Questionnaire files have a .qst extension. 

If a questionnaire already exists with the same name as the questionnaire you are importing, a dialog box opens 
asking you to enter a new name for the imported questionnaire. 

3. Enter a new name if necessary, and click OK. 

To export a questionnaire: 

1. From the Questionnaire Setup dialog box, click Export.... 

A dialog box opens so that you can specify the file in which to save the questionnaire. 

2. Specify the file in which you save the questionnaire, and click Save. 
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Setting up Questions 
The following procedures describe how to: 

• Create a new question 
• Copy a question 
• Rename a question 
• Remove a question 

Once you have your questions set up, you can use them to create questionnaires.  For more information, see "Adding, 
Removing, and Reordering Questions" on page 510. 

Creating a New Question 

To create a new question and add it to the Available Questions group box: 

1. Click New in the Available Questions group box.  

The Add Question dialog box appears. 

2. Enter the text for the question in the Question Name text box. 

3. Check Answer this question with a Tooth Chart If you want the ability to select from a tooth chart when answering this 
question. 

4. Use the Language Style drop-down list box to select from Clinical, Layman, or Dentist as the language style to use for 
the answer to this question. 

For more information, see "Adding and Removing Language Styles" on page 520. 

5. Use the Numbering System drop-down list box to select the type of numbering system you want to use on the tooth 
chart. 

6. Click OK. 
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Question Name Enter a name of up to 40 characters for this question in the text box. 

Check box Check this box to enable the person running the questionnaire to select from a tooth chart when answering 
this question. 

Language Style Use this drop-down list box to select a language style. For more information, see "Adding and Removing 
Language Styles" on page 520. 

Numbering 
System Use this drop-down list box to select a numbering style for the tooth chart. 

 

Copying a Question 

To copy a question in Available Questions group box: 

1. Click the question you want to copy. 

2. Click Copy.  

A dialog box appears containing a default name for the new question in a text box.  

3. Enter a name for the new question in the text box. Then, click OK.  

Renaming a Question 

To rename a question in Available Questions group box: 

1. Click the question you want to change. 

2. Click Rename.  

A dialog box appears containing the current name in a text box.  

3. Enter the new name for this question in the text box. Then, click OK.  

Removing a Question 

To remove a question: 

1. Click the question you want to remove. 

2. Click Remove.  

A dialog box appears asking for confirmation.  

3. Click Yes to delete the question.  
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Setting up Answers 
The procedures in this section describe how to: 

• Add an answer item 

• Use different phrases for different language styles 

• Categorize and answer item 

• Modify an answer item 

• Remove an answer item 

Adding an Answer Item 

To add an answer item: 

1. In the Available Questions group box, select the question for which you want to add an answer item. 

2. Click the Add button next to the Available Answers list box. 

The Add Choice dialog box appears. 

3. Enter a diagnosis code in the Code text box. 

4. Enter a phrase describing this answer item in the Phrase text box. Then, click OK. 

This phrase appears in DLS letters when this answer item is selected. For each answer item, you must have a clinical 
phrase. If you wish to use additional language styles, you can then select the clinical phrase and modify it to add a 
phrase in another language style as described in "To add a phrase in a language style other than clinical" below. By 
using different language styles, you can tailor the phrasing of your letters appropriately for different recipients. 

When adding a phrase, you can include any DLS reserved tokens. These tokens are replaced by the corresponding 
information from the Dolphin database. To use a token in the phrase, type the token name enclosed in curly braces ({ 
}) in the Clinical Phrase text box. For example, you could enter the following: 

{PatientFirstName} {PatientLastName} does not need treatment at this time. 

Then, whenever you used this answer item in a questionnaire or DLS letter, Dolphin would insert the patient’s first and 
last name. For example, if the patient’s name is John Smith, this phrase appears in questionnaires and letters as 
follows: 

John Smith does not need treatment at this time. 

For more information on DLS reserved tokens, see "DLS Reserved Tokens" on page 991. 
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Code Enter a diagnosis code of up to 12 alphanumeric characters in this text box. 

Phrase Enter a phrase for this answer item of up to 120 characters in this text box.  

Using Different Phrases for Different Language Styles 
Language styles enable you to tailor the phrasing of your letters appropriately for different recipients. For each language style, 
you define phrases for questionnaire answer items. When an answer item is used in a letter, the phrase from the appropriate 
language style is inserted. 
For example, suppose you want to send a letter outlining a treatment plan to a patient and to the patient's dentist. You could use 
the Layman language style for the letter to the patient, and that letter would use layman phrases to describe treatments. You 
could use the Dentist language style for the letter to the patient's dentist, and that letter would use phrases appropriate for 
describing treatments to a dentist. 

To add a phrase in a language style other than clinical: 

1. In the Available Questions group box, select the question for which you want to add a different language style phrase. 

2. Use the Language Style drop-down list box to select the language style you want to associate with the new phrase. 

3. Select the answer item for which you want to add a different language style phrase. 

4. Click Modify.  

The Modify Choice dialog box appears showing the clinical phrase for this item. 

5. Type a different phrase in the text box and click OK. 

This phrase appears in DLS letters when this answer item is selected. When adding a phrase, you can include any 
DLS reserved tokens. These tokens are replaced by the corresponding information from the Dolphin database. To use 
a token in the phrase, type the token name enclosed in curly braces ({ }) in the text box. For example, you could enter 
the following: 

{PatientFirstName} {PatientLastName} does not need treatment at this time. 
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Then, whenever you used this answer item in a questionnaire or DLS letter, Dolphin would insert the patient’s first and 
last name. For example, if the patient’s name is John Smith, this phrase appears in questionnaires and letters as 
follows: 

John Smith does not need treatment at this time. 

For more information on DLS reserved tokens, see "DLS Reserved Tokens" on page 991. 

Categorizing an Answer Item 

To categorize an answer item: 

1. Select an answer item from the Available Answers list box on the Questionnaires Setup dialog box. 

2. On the Settings tab, check the appropriate boxes for this answer item. 

You can categorize the answer item as follows: 

� Diagnosis - check if the answer pertains to diagnosis. 

� Treatment - check if the answer pertains to treatment. 

� Treatment Card - check to include this answer on the patient's treatment card. 

� Insurance - check to include this answer on insurance correspondence. 

� Exclude From Correspondence - check to exclude this answer from letters. 

Modifying an Answer Item 

To modify an answer item: 

1. In the Available Questions group box, select the question for which you want to modify an answer item. 

2. Click the Modify button next to the Available Answers list box. 

The Modify Choice dialog appears, and the Code and Clinical Phrase text boxes contain the code and phrase 
associated with the question you selected in the first step. 

3. Optionally, change the diagnosis code or phrase. Then, click OK. 

This phrase appears in DLS letters when this answer item is selected. For each answer item, you must have a clinical 
phrase. If you wish to use additional language styles, you can then select the clinical phrase and modify it to add a 
phrase in another language style as described in "To add a phrase in a language style other than clinical" below. By 
using different language styles, you can tailor the phrasing of your letters appropriately for different recipients. 

When adding a phrase, you can include any DLS reserved tokens. These tokens are replaced by the corresponding 
information from the Dolphin database. To use a token in the phrase, type the token name enclosed in curly braces ({ 
}) in the Clinical Phrase text box. For example, you could enter the following: 

{PatientFirstName} {PatientLastName} does not need treatment at this time. 

Then, whenever you used this answer item in a questionnaire or DLS letter, Dolphin would insert the patient’s first and 
last name. For example, if the patient’s name is John Smith, this phrase appears in questionnaires and letters as 
follows: 

John Smith does not need treatment at this time. 
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For more information on DLS reserved tokens, see "DLS Reserved Tokens" on page 991. 

 

Code Enter a diagnosis code of up to 12 alphanumeric characters in this text box. 

Phrase Enter a phrase for this answer item of up to 120 characters in this text box.  

Removing an Answer Item 

To remove an answer item for a diagnostic question: 

1. In the Available Questions group box on the Questionnaire Setup dialog box, select the diagnostic question for which 
you want to remove an answer item. 

2. Select the answer item you want to remove, and click Remove.  

A dialog box appears asking for confirmation.  

3. Click Yes to delete the answer item.  

Using Codes 
On the Codes tab, you can: 

• add a code type 

• remove a code type 

• associate a code with an answer item 

• remove a code from an answer item 
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To access the Codes tab 
1. Select an answer from the Available Answers list box on the Questionnaires Setup dialog box. 

 

Removing a Code Type 

To remove a code type: 

1. On the Codes tab, select the code type you want to remove from the Type drop-down list box. 

2. Click Remove in the Type group box.  

A dialog box appears asking for confirmation.  

3. Click Yes to delete the code type.  

Adding a Code to an Answer Item 

To add a code to an answer item:  

1. In the Available Answers group box, select the answer item to which you want to add a code. 

2. Click the Codes tab. 

3. Click the Add... button next to the codes list box. 

The Codes dialog box appears. 

4. Select the code that you want to add to this answer item. Then, click OK. 
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Removing a Code From an Answer Item 

To remove a code from an answer item: 
1. In the Available Questions group box, select the answer item from which you want to remove a code. 

2. Click the Codes tab. 

3. Select the code you want to remove, and click the Remove button next to the code list box.  

A dialog box appears asking for confirmation.  

4. Click Yes to delete the code.  

Adding and Removing Language Styles 
Language styles enable you to tailor the phrasing of your letters appropriately for different recipients. For each language style, 
you define phrases for questionnaire answer items. When an answer item is used in a letter, the phrase from the appropriate 
language style is inserted. 
For example, suppose you want to send a letter outlining a treatment plan to a patient and to the patient's dentist. You could use 
the Layman language style for the letter to the patient, and that letter would use layman phrases to describe treatments. You 
could use the Dentist language style for the letter to the patient's dentist, and that letter would use phrases appropriate for 
describing treatments to a dentist. 
For information on adding phrases for different language styles, see "Using Different Phrases for Different Language Styles" on 
page 516. 
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To add a language style: 

1. Click the Language Styles tab in the Questionnaire Setup dialog.  

 
2. In the text box, enter a name for this language style. 

3. Click Add. 

To remove a language style: 

1. On the Language Styles tab, select the language style you want to remove. 

2. Click Remove. 

Running a Questionnaire 

Multi-page Questionnaire 
The multi-page questionnaire is the standard questionnaire interface. It is available on all Dolphin Premium installations. 

To run a multi-page questionnaire: 

1. Select the patient and timepoint for which you want to enter information. 

2. Select Questionnaire from the Tools menu. 

A dialog box appears where you select the questionnaire you want to run. 

3. Select the questionnaire you want to run, and click OK. 

The questionnaire starts. The dialog boxes displayed for the questionnaire depend on the questions and tokens you 
selected when you set up the questionnaire. The figure below shows an example of a questionnaire dialog box. 

Note: Diagnostic information is stored for each timepoint for each patient. For this reason, the diagnostic information 
that you enter in this dialog box applies only to the timepoint you selected in step 1. In this way, you can store 
diagnostic information for each timepoint. 
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4. Enter the information for each dialog box for the questionnaire.  

You can move an answer item from the upper list box to the lower list box in any of the following ways: 

� Select the item, and click Insert. 

� Double-click the item in the upper list box to insert it into the lower list box.  

� Type the code for the item in the Code Entry text box, and press Enter. 

To remove an answer item from the lower list box, select it, and click Remove.  

5. When you finish entering information on each dialog box, click Next> to move to the next dialog box in the 
questionnaire. 

6. On the last dialog box for the questionnaire, click Finish to finish the questionnaire. 

 
Code Lists the diagnosis code for an answer item. 

Description Lists the description for an answer item. 

Insert Click this button to move the selected answer item from the upper list box to the lower list box. 

Remove Click this button to remove the selected answer item from the lower list box. 

Code Entry Enter the diagnosis code for an answer item in this text box, and press Enter to select that item. 

<Back Click this button to return to the previous dialog box for this questionnaire. 

Next> Click this button to move to the next dialog box for this questionnaire. 

Finish Click this button to finish entering information for this questionnaire. 
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One-Page Questionnaire 
Note: The one-page questionnaire is bundled with the Dolphin Imaging security utilities. It is only available if you have the 
security utilities installed. 

To use the one-page questionnaire: 

1. Select the patient and timepoint for which you want to enter information. 

2. Select One Page Questionnaire from the Tools menu. 

A dialog box appears where you select the questionnaire you want to run and enter information for the questionnaire. 

3. Select a questionnaire from the Questionnaire drop-down list box. 

The dialog box lists the questions and tokens you selected when you set up the questionnaire. The figure below shows 
the Run Questionnaire dialog box after a questionnaire has been selected. 

Note: Diagnostic information is stored for each timepoint for each patient. For this reason, the diagnostic information 
that you enter in this dialog box applies only to the selected timepoint. In this way, you can store diagnostic information 
for each timepoint. 

4. Optionally, select another timepoint for this patient from the Timepoint drop-down list box to enter information for a 
different timepoint. 

5. Check the boxes to identify the answer items or values for tokens for each question in this questionnaire. 

� If display of the Summary is enabled (see below), it displays a tree diagram of answer items/codes and 
tokens/values. 

� To enter information for all the answer items and tokens, you probably will need to scroll both horizontally and 
vertically using the scroll bar in the middle of the dialog box. 

If an answer item allows additional text, a dialog box opens when you check the box for that item. 

6. Optionally, enter additional text for any answer item set up to allow it. 

7. When you finish entering information for the questionnaire, click OK. 
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Copies the answers for this questionnaire from the previous timepoint into the currently-selected timepoint. This 
enables you to save time by just answering the questions for which the information has changed. 

 

Click this button to use one of the following printing options: 
Print Questionnaire (with answers): Select this option to print this questionnaire with answers. 
Print Questionnaire (without answers): Select this option to print the questionnaire with no answers. 

 

Click this button to bring up the Tooth Chart dialog box for the selected patient. 

 

Opens Dolphin Imaging if you are using the one-page questionnaire from within Dolphin Management. 

 

Click this button to toggle the following options: 
Show Diagnostic Item Codes: Select this option to list the codes for the answer items on the questionnaire 
Show Summary: Select this option to view a summary of the information for this questionnaire on the right side 
of the window. 
Enable Dragging and Sizing: Select this option to enable resizing of the list boxes for answer items on this 
questionnaire. 

Questionnaire Select the questionnaire for which you want to enter information from this drop-down list box. 

Timepoint Select another timepoint for this patient to enter information for that timepoint. 
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Answer Items/Codes or 
Tokens/Values 

Lists the answer items or tokens included in this questionnaire and the diagnosis codes or token 
values available for each item. Check the check box next to a code or value to add it to the 
information for this patient and timepoint. 
Note: The codes only appear if you have enabled the Show Diagnostic Codes option. For more 
information, see "To set options for the questionnaire" on page 526. 

Save & Present Click this button to save and run a presentation based on this questionnaire.  
Note: You must have already created presentations and linked them to the patient using the 
Questionnaire Setup dialog box. For more information, see "Setting Up Presentations" on page 527. 

Summary  Summarizes the codes and values selected for each answer item and token in the questionnaire. 

To copy the answers from the previous timepoint: 

1. Click . 

2. On the confirmation dialog box that appears, click Yes. 

Any answers entered for this questionnaire on the previous timepoint for this patient are copied to this timepoint. This 
enables you to save time by just answering the questions for which the information has changed. 

To print the questionnaire: 

1. Click . 

2. Select Print Questionnaire (with answers) to print the questionnaire, including the answers. 

Or, 

Select Print Questionnaire (without answers) to print the questionnaire with no answers. 

To use the Tooth Chart: 

1. Click . 
 
The Tooth Chart dialog box appears: 
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2. Use the Timepoint drop-down list box to select the desired timepoint. 

3. Use the Numbering drop-down list box to select the type of numbering:  Patient, Orthodontic Quadrant, Dentist, or 
Universal Quadrant. 

4. To specify a tooth as missing, select the tooth, then click the Missing button.  

5. Continue selecting any teeth you want to extract or uncover, and click the appropriate buttons. 

6. Click the Extraction Letter button to bring up the Add Letter dialog.   

Use this dialog to send a referral for extraction letter, if required. 

7. Click OK to associate your selections with this patient and timepoint. 

To set options for the questionnaire: 

1. Click . 

2. Select Show Diagnostic Item Codes to list the codes for the answer items on the questionnaire. 

Or, 

Select Show Summary to view a summary of the information for this questionnaire on the right side of the window. 

Or, 

Select Enable Dragging and Sizing to enable resizing of the list boxes for answer items on this questionnaire. 
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Setting up Presentations 
Using the Questionnaires dialog box, you can associate PowerPoint presentations and other media with your questionnaires. 
Then, when you run a questionnaire, you can also run a presentation that is tailored by the questionnaire answers for that 
patient. 
Before you can run presentations, however, you must create the PowerPoint slides and insert Dolphin Imaging tokens or custom 
tokens into the slides where you want patient-specific information or answers to appear.  
This feature is only available if you have either Dolphin Management or the Dolphin Premium Security Utilities. 

Preparing the Media 
The presentation can include a variety of media such as PowerPoint presentations, images, and movie files.  You can use this 
media in your presentation as follows: 

• You can create "generic" media that you want to appear in your presentation regardless of answers to the 
questionnaire's questions.  For example, you may want to include introduction slides, information about your practice, 
and so on. 

• You can create media that appears in your presentation only if certain answers are given for the questionnaire's 
questions. For example, you may want to include PowerPoint slides about oral hygiene for patients whose answers to 
questions about oral hygiene indicate problems in this area. 

The media that you create can include Dolphin or custom tokens to customize it to a particular patient or to a particular 
diagnostic question answer. This section assumes you are familiar with PowerPoint and with DLS tokens. For more information, 
see "DLS Reserved Tokens" on page 991.  

To prepare the media for your presentation: 

1. Create the media that you want to use in your presentation. 

For example, if you are using PowerPoint slides, you might create a set of introductory slides for the beginning of your 
presentation and slides to associate with each answer to the diagnostic questions in your questionnaire.  

You can insert Dolphin or custom tokens in PowerPoint slides to customize them for a specific patient or answer. For 
example, if you want a slide to list answer items associated with crowding, you would enter: 
 
<<Overbite|Layman>> 
<<OverJet (2)|Layman>> 
<<Crowding|Layman>> 
<<Crossbite|Layman>> 

2. After you have created your media, you can add them to your presentation script. 

Accessing the Presentations Tab 

To access the Presentation tab: 

1. Select Questionnaire Setup from the Edit menu. 
 
Or, 

Select Edit Diagnostic Lists from the Dolphin Letter System (DLS) Letters menu.  

2. Click the Presentations tab. 
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The Questionnaire Setup dialog box displays the Presentations tab. 

 
Presentation group 
box 

Select an existing presentation from this drop-down list box to view, modify, or delete it. 
New...: Click to add a new presentation. For more information, see "Adding a New Presentation" on page 529. 
Save...: Click to save the current presentation.  
Delete: Click to delete the selected presentation.  

Presentation Script 
group box 

Lists the media and presentation groups chosen for the presentation. 
Add Group...: Click to add a new presentation group to this presentation. For more information, see "Adding a 
Presentation Group to a Presentation" on page 535. 
Add Media...: Click to add a new media item to this presentation. For more information, see "Adding Media to a 
Presentation" on page 536. 
Remove: Click to remove the selected presentation group or media from this presentation. For more 
information, see "Removing Items from a Presentation" on page 536. 

Available Questions 
group box 

Lists the questions available to add to questionnaires. 
New: Click this button to add a new question to the list. For more information, see "Adding, Removing, and 
Reordering Questions" on page 510. 
Copy: Click this button to make a copy of the selected question. For more information, see "Copying a 
Question" on page 514. 
Rename: Click this button to rename a question. For more information, see "Adding, Removing, and Reordering 
Questions" on page 510. 
Remove: Click this button to remove the selected question from the list. For more information, see "Adding, 
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Removing, and Reordering Questions" on page 510. 

Available Answers 
group box 

Lists the answers available for the selected question (for example, if the question is crowding, the answer would 
be the type of crowding). 
Language Style: Select from Clinical, Dentist, or Layman. 
Add: Click to add a code and phrase specific to your practice. For more information, see "Adding a Code to an 
Answer Item" on page 519. 
Modify: Click to modify the existing codes and/or phrases as you require. For more information, see "Modifying 
an Answer Item" on page 517. 
Remove: Click to remove codes and/or phrases that are not applicable to your practice. For more information, 
see "Removing an Answer Item" on page 518. 
This group box contains the following tabs: 
Settings: Check the appropriate boxes to categorize answer items. For more information, see "Categorizing an 
Answer Item" on page 517. 
Codes: Use this tab to add and maintain the codes associated with answer items. For more information, see 
"Using Codes" on page 518. 
Presentation Media: Use this tab to associate presentation media with answer items. For more information, see 
"Associating Media with an Answer Item" on page 533. 
Presentation Groups: Use this tab to associate answer items with presentation groups. For more information, 
see "Setting Up Presentation Groups" on page 531. 

 

Adding or Modifying a Presentation 
The following sections describe how to: 

• add a new presentation 

• modify an existing presentation 

Adding a New Presentation 

To add a new presentation: 

1. On the Presentations tab on the Questionnaire Setup dialog box, click New... to add a new presentation. 

2. Enter a name for the presentation. 

For example, you might enter "Initial Exam Presentation." 

3. Enter a description for this presentation. 

4. Click OK. 

5. Set up your presentation script by adding and arranging static media, questions, and/or presentation groups. 
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For more information, see "Setting a Up the Presentation Script" on page 534. 

6. Click Save... to save the presentation. 

7. Optionally, enter a new name for this presentation. 

8. Optionally, enter a new description for this presentation. 
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9. Click OK. 

If a presentation already exists with the same name as this presentation, a dialog box opens asking whether you would 
like to overwrite it. 

10. Click Yes to overwrite the existing presentation. 

Or, 

Click No if you do not want to overwrite the existing presentation. 

Modifying an Existing Presentation 

To modify an existing presentation: 

1. On the Presentations tab on the Questionnaire Setup dialog box, select an existing presentation from the drop-down 
list box. 

2. Make any changes to the presentation script by adding, removing, or reordering static media, questions, and/or 
presentation groups. 

For more information, see "Setting a Up the Presentation Script" on page 534. 

3. Click Save... to save the presentation. 

4. Optionally, enter a new name for this presentation. 

5. Optionally, enter a new description for this presentation. 

6. Click OK. 

If a presentation already exists with the same name as this presentation, a dialog box opens asking whether you would 
like to overwrite it. 

7. Click Yes to overwrite the existing presentation. 

Or, 

Click No if you do not want to overwrite the existing presentation. 

Setting Up Presentation Groups 
A presentation group is a package of questionnaire answer items and their associated media. You can use presentation groups 
to construct your presentation script, which determines the display of slides and/or other media in your presentation. You can set 
up presentation groups either on the Questionnaires or Presentations tab of the Questionnaire Setup dialog box. 
Presentation groups provide a convenient way to group your answer items and media. However, it is not required that you 
associate answer items with groups in order to display media during the presentation. Two common ways of organizing 
presentation groups are: 

• You can create a single presentation group for a particular questionnaire. In this case, you might set up your 
presentation groups on the Questionnaires tab of the Questionnaire Setup dialog box. For each question in the 
questionnaire, you could associate media with each possible answer item. Then, you could add this presentation group 
to a presentation script that applies only to that particular questionnaire. 

• You can create presentation groups that group together the answer items for similar questions. In this case, you might 
set up your presentation groups on the Presentations tab of the Questionnaire Setup dialog box. Then, you could use 
these presentation groups as building blocks to create presentation scripts for different questionnaires. 

For more information, see "Setting a Up the Presentation Script" on page 534. 
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To set up a presentation group:  

1. On the Questionnaires or Presentations tab of the Questionnaire Setup dialog box, select a question in the Available 
Questions list box. 

2. Select the answer item in the Available Answers list box. 

3. On the Presentation Groups tab, specify the presentation group for this answer item as described below.  

4. On the Presentation Media tab, specify the media that you want to associate with this answer item as described below.  

Specifying the Presentation Group for an Answer Item 

To specify an existing presentation group for an answer item:  

1. On the Questionnaires or Presentations tab of the Questionnaire Setup dialog box, select a question in the Available 
Questions list box. 

2. Select the answer item in the Available Answers list box. 

3. On the Presentation Groups tab, check the box for the presentation group to which you want to add this answer item. 

If the presentation group to which you want to add this answer item does not exist, you can add a new presentation 
group as described below. 

4.  Optionally, click Apply To All Items to add all the answer items in the Available Answers list to the selected 
presentation group. 

To add an answer item to a new presentation group: 

1. Select a question in the Available Questions list box. 

2. Select the answer item in the Available Answers list box. 

3. On the Presentation Groups tab, click Add Group. 

The Add Item dialog box opens so that you can add a new presentation group. 

4. Enter a name for this presentation group. 

5. Enter a description for this presentation group. Then, click OK. 

6. Check the box for the new presentation group to add the selected answer item to it. 
7. Optionally, click Apply To All Items to add all the answer items in the Available Answers list to the new presentation 

group. 
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Use 
Existing 

Select this option, and select a presentation group from the drop-down list box to use an existing presentation 
group. 

Add New Select this option, and enter a name and description to add a new presentation group. 

Associating Media with an Answer Item 
Once you have specified the presentation group for an answer item, you can associate media with it using the Presentation 
Media tab. 

To associate media with an answer item: 

1. On the Questionnaires or Presentations tab of the Questionnaire Setup dialog box, select a question in the Available 
Questions list box. 

2. Select the answer item in the Available Answers list box. 

3. Click the Presentation media tab. 

4. Click Add.... 

A dialog box opens so that you can browse to the file containing the media that you want to associate with this answer 
item. 

3. Select the type of media that you want to associate with this answer item from the Files of type drop-down list. 

You can associate PowerPoint files, video files, or images. 

4. Select the file containing the media that you want to associate with this answer item.  Then, click Open. 

The media file that you added appears in the list box on the Presentation Media tab. 
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Deleting a Presentation Group 

To delete a presentation group: 

1. On the Presentation Groups tab, check the box for the presentation group you want to delete. 

2. Click Delete Group. 

A dialog box appears asking you to confirm the deletion. 

3. Click Yes to delete the presentation group. 

Or, 

Click No to cancel the deletion. 

Removing Media 
Removing media removes it from your presentation.  It does not remove the media file from your computer. 

To remove presentation media: 

1. On the Presentation Media tab, select the media file that you want to remove from your presentation. 

2. Click Remove. 

The media file is removed from the list box on the Presentation Media tab. 

Setting Up the Presentation Script 
Your presentation script determines when the media for your presentation plays.  You can set up your presentation script as 
follows: 

• You can add "generic" media to your presentation script that you want to appear in your presentation regardless of 
answers to the questionnaire's questions.  For example, you may want to include introduction slides, information about 
your practice, and so on. 

• You can add presentation groups that associate media particular answer items. In this way, certain media items appear 
in your presentation only a certain answers are given for the questionnaire's questions. For example, you may want to 
include PowerPoint slides about oral hygiene for patients whose answers to questions about oral hygiene indicate 
problems in this area.   

To set up your presentation script: 

1. Select the Presentations tab on the Questionnaire Setup dialog box. 

2. In the Presentation group box, select a presentation from the drop-down menu. 

3. Optionally, add one or more presentation groups to your presentation script. 

For more information, see "Adding a Presentation Group to a Presentation" on page 535. 

4. Optionally, at one or more media items to your presentation script. 

For more information, see "Adding Media to a Presentation" on page 536. 
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5. Click Save... to save the presentation. 

6. Optionally, enter a new name for this presentation. 

7. Optionally, enter a new description for this presentation. 

8. Click OK. 

If a presentation already exists with the same name as this presentation, a dialog box opens asking whether you would 
like to overwrite it. 

9. Click Yes to overwrite the existing presentation. 

Or, 

Click No if you do not want to overwrite the existing presentation. 

See "Running a Presentation" on page 536 for more information on running the presentations you have created. 

Adding a Presentation Group to a Presentation 

To add a presentation group to a presentation: 

1. Click Add Group... in the Presentation Script group box. 

The Add Item dialog box opens so that you can select an existing presentation group or add a new one. 

2. Select Use Existing, and select an existing presentation group from the drop-down list box. 

Or, 

Select Add New, and enter a name and description for a new presentation group. 

For information on adding a new presentation group, see "Setting Up Presentation Groups" on page 531. 

3. Click OK. 
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Use 
Existing 

Select this option, and select a presentation group from the drop-down list box to use an existing presentation 
group. 

Add New Select this option, and enter a name and description to add a new presentation group. For more information, see 
"Setting Up Presentation Groups" on page 531. 

Removing Items from a Presentation 

To remove presentation groups or media from a presentation: 

1. Select the presentation group or media that you want to remove from the presentation script. 

2. Click Remove in the Presentation Script group box to remove the selected item. 

Adding Media to a Presentation 
You can add media items to your presentation that are not associated with any particular answer item. These media items play 
during the presentation regardless of the answers to questionnaire questions. 

To add media to your presentation script: 

1. Click Add Media... in the Presentation Script group box. 

A dialog box opens so that you can browse to the file containing the media that you want to add. 

2. Select the type of media that you want to add to your presentation from the Files of type drop-down list. 

You can add PowerPoint files, video files, or images. 

3. Select the file containing the media that you want to add to your presentation. Then, click Open. 

The media file that you added appears in the Presentation Script list box. 

Running a Presentation 

To run a presentation: 

1. Select One-Page Questionnaire from the Tools menu. 

The Run Questionnaire dialog box appears. 

2. Select the questionnaire for the presentation you want to run. 

3. If you have not yet answered this questionnaire's questions for the current patient and timepoint, do so now. 

The media that plays during the presentation may depend on the answers to the questionnaire's questions, so you 
need to provide those answers before running the presentation. For more information, see "One-Page Questionnaire" 
on page 523. 

4. Click Save & Present. 
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The Run Presentation dialog box is displayed. It lists the media items (such as PowerPoint presentations, movies, or 
images) defined for this presentation. For more information, see "Setting Up the Presentation Script" on page 534. 

4. Optionally, uncheck the box for any media item you want to skip. 

5. Click Present... to run the presentation. 

 
Present... Click to run the presentation 

Save... Click to save the presentation. 

Select All Click to check all presentation media shown in the list box. 

Select None Click to uncheck all presentation media shown in the list box. 

list box Lists the presentation media for this presentation. Uncheck the box for any media item you want to skip. 
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21 The Dolphin Letter System (DLS) 
The Dolphin Letter System (DLS) provides a fast and easy way to create letters that include the patient's images. 
DLS contains letter templates that simplify creating everyday letters to referrals, patients, and doctors. For example, you can use 
DLS to send a thank-you letter to a dentist that referred a patient or to send parents a letter showing how their son's dental 
hygiene needs to be improved. In addition, you can create new templates for custom letters. You can then use your custom letter 
templates just like any of the templates that were included with the software. 
DLS is a highly-customized program based on Microsoft Word. You can perform most of DLS’s functions based on the 
instructions in this chapter and in other Dolphin supplemental documents. However, to take full advantage of the powerful 
features of Microsoft Word, we recommend that you refer to the Microsoft Word documentation and familiarize yourself with 
Microsoft Word. 

Creating a Letter 
  
Before you start DLS, you need to select a patient whose pictures you want to use in the letter and the timepoint for that patient. 
You can select a patient and timepoint using the Patient Charts or Patient Lookup dialog box.  

Then, you can access DLS by clicking on the Dolphin Imaging main screen. 
This section describes the dialog boxes you use to create a letter from a template that already exists. 

Selecting the Type of Letter 
When you click the Letters button on the Dolphin Imaging main screen, the Select Letter dialog box appears. This dialog box lists 
all the templates that you can use to create letters.  
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Template List Select the template for the type of letter you want to create. For more information about the available 
templates, see Chapter 22. 

Use this Image 
Resolution 

Select the image resolution you want to use in the letter to be generated from this drop-down list box. 
Typically, the default setting of 640 x 480 is sufficient for normal laser and inkjet printers. However, you can 
pick a higher resolution. 

Queue Click this button to add this letter to the queue for later printing. 

To select the type of letter you want to create: 

1. Select a template from the template list, and click OK. 

DLS uses any information that you have entered into the database for the patient to construct the letter. If any 
information required to construct the letter has not been entered into the database for the patient, DLS may prompt you 
to enter the information now. The following sections describe the information that you may need to enter. 

Selecting a Doctor 
If the template you are using for this letter requires a doctor, a dialog box listing the doctors that you have entered in the 
database appears, similar to the figure below. 

 

Doctor List Lists the names and addresses of all the doctors in your database. 

Set as Default Click this button to set the selected doctor as the default doctor for this patient. 
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To select a doctor: 
1. Select a doctor from the list, and click Next>. 

If the doctor does not appear on the list, simply click Next> on this dialog box. Then, you can manually enter the doctor 
after the letter has been created.  

Selecting Diagnoses 
If the template you are using for this letter requires a diagnosis, a dialog box listing diagnoses and codes appears. For more 
information on diagnosis lists and codes, see "DLS Diagnostic Lists and Codes" on page 995. 

 

Diagnosis List 
Title 

Indicates the types of diagnoses on this list. 

Code Diagnosis code. 

Description Text description for this diagnosis. If you select a diagnosis, the description is inserted into the letter. 

Insert Click this button to insert the description for the selected diagnosis into the letter. When you click this button, 
the selected diagnosis appears in the lower list box. 

Remove Remove this diagnosis from the diagnosis list. 

Code Entry You can type the diagnosis code in this text box to select a diagnosis rather than picking it from the diagnosis 
list. To select more than one diagnosis using this text box, separate the diagnosis codes using either commas 
or spaces. 
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List of diagnoses to 
insert into the letter 

Lists the diagnoses you have selected to insert into the letter. If you have previously gone through 
the Dolphin Letter Wizard for this patient, any diagnoses that you selected appear automatically in 
this list. 

<Back Click this button to go to the previous dialog box. 

Next> Click this button when you have finished selecting diagnoses and want to go to the next diagnosis 
list defined for this letter. 

Finish Click this button when you have finished selecting diagnoses and want to skip any remaining 
diagnosis lists. 

To select one or more diagnoses: 

1. Click a diagnosis from the Diagnosis List. 

Or, 

Type a diagnosis code in the Code Entry text box. 

Some diagnosis lists are meant for selecting a single diagnosis to insert into the letter. Other lists are set up for 
selecting multiple diagnoses. You can create documents that use either method.  

Some letters are designed to accept a diagnosis from more than one diagnosis list. If this is the case, the diagnosis list 
box appears for each diagnosis list from which the letter template expects a diagnosis. 

Any items on the diagnosis list that have curly braces ({}) act as placeholders for user input. When you insert one of 
these items into your letter, DLS prompts you for a value to use for that placeholder. 

2. Click Insert. 

The diagnosis you selected appears in the lower list box, which lists the diagnoses to insert into the letter. 

Note: Diagnostic information is stored for each timepoint for each patient. For this reason, the diagnostic information 
that you enter in this dialog box applies only to the timepoint you selected in on the Patient Lookup dialog box, before 
you started DLS. In this way, you can store diagnostic information for each timepoint. 

3. When you finish selecting diagnoses, click Next>. 
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Entering Information for Custom Tokens 
If the template you are using for this letter uses custom tokens, a dialog box that you use to enter values for the tokens appears. 
This dialog box is similar to the figure below. Custom tokens are placeholders for text that you supply. For example, Date of Last 
Dental could be replaced with June 27, 2000.  

 

Custom 
Tokens Text 
Boxes 

Enter the indicated information in these text boxes. The text boxes that appear on this dialog box depend on 
the letter template you selected. If you have previously gone through the Dolphin Letter Wizard for this patient, 
any custom tokens for which you already provided values are automatically filled in. 

<Back Click this button to go to the previous dialog box. 

Next> Click this button to move to the next dialog box. 

Finish Click this button to finish entering information into DLS. 

To enter information for the custom tokens: 

1. Type values in each of the text boxes on the Custom Tokens dialog box. 

You can either click with the mouse or press TAB to move from one text box to the next.  

2. When you finish entering information for the custom tokens, press Next> or Finish. 
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Completing the Letter 
After you have completed all the dialog boxes, DLS compiles the information you entered and displays the completed letter along 
with the Dolphin assistant. At this point, you can print the letter, send the letter to the print queue (temporary storage for print 
jobs) for later printing, or edit the assembled letter and make changes to it. 

 
Before you print the letter or send it to the print queue, check the following: 

• Are any tokens referring to the patient's gender correct? If not, correct the patient's gender in the Patient Charts or 
Patient Lookup dialog box as described in Chapter 4. 

• Are there any fields that were left blank causing the sentences to look fragmented? 

• Are there any placeholders in the letter? Placeholders look like this: <FILL IN>. They represent information needed to 
complete the letter that has not been entered either in the Dolphin database or in the Dolphin Letter Wizard. 

• Do you want to add a paragraph or resize the image? Resize the image by clicking on it and then dragging one of the 
square boxes on the border. 
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To print to the default printer and save the document: 

1. Select Print and Close from the Dolphin assistant. 

DLS sends the letter to your print manager and asks whether you would like to save the document.  

2. Select Yes to save the document. 

3. Enter a name for the document and click OK.  

To send the letter to the print queue for later printing: 

1. Select Send to the Queue from the Dolphin assistant. 

Or, 

Select Queue from the Letters Menu. 

To edit the letter and make changes to it: 

1. Select Edit It from the Dolphin assistant. 

After you select Edit It, you can make changes to the assembled letter such as adding paragraphs, changing words, 
adding clip art, replacing any <<FILL IN>> placeholders with the appropriate information, and so on. You can use any 
of the functions of Microsoft Word to edit the document. For more information on editing using Microsoft Word, refer to 
the Microsoft Word User Manual. 

To print the letter after editing it: 

1. Click Print on the tool bar.  

Or, 

Select Print from the File menu.  

The Print dialog box appears. 

2. Specify any print options, and click OK. 
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Printer Indicates the printer to which this print job will go. 

Properties Click this button to set advanced properties for the selected printer. 

Print to file Click this check box to send the print job to a file rather than to the printer. 

Print Range Allows you to select what you want to print. Your options are: 
All: print an entire document. From the main screen, you would typically use this option. 
Current Page: print the currently-displayed page. 
Selection: print just what you have selected. 
Pages: print only pages in the specified range. 

Copies Enter the number of copies you want to print. 

Collate  Click this check box to collate the copies, if you are printing multiple copies. 

Print What Select what you want to print from this drop-down list box. 

Print Select the pages you want to print from this drop-down list box. 

Options... Click this button to set up printer options. 

For more information about printing documents, refer to the Microsoft Word User Manual. 
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To save the letter after editing it: 

1. Click Save on the tool bar. 

Or, 

Select Save from the File menu.  

The Save As dialog box is displayed. 

2. Specify the directory and file in which you want to save the letter, and click Save. 

Do not save the letter in the directory containing the templates, or it will appear in the Template List every time you 
create a letter. Dolphin Letter System templates are typically saved in the C:\dolphin\letters\templates 
folder. 

For more information about saving documents, refer to the Microsoft Word User Manual. 

To close the letter when you are finished with it: 

1. Select Close from the File menu. 

If you have not already saved the letter, a message appears whether you want to save the letter.  

2. Click Yes to access the Save As... dialog box to save the letter.  

Or, 

Click No to close the letter without saving it. 

Or, 

Click Cancel to return to the letter. 

For more information on saving the letter, see "To save the letter after editing it" above. 

The Letters Menu 
DLS adds a menu called Letters to the Microsoft Word menu bar. The following figure illustrates this menu. 

 
The Letters menu contains the following choices: 

Create Letter Build a letter from one of the existing letter templates. You don’t need to use this menu option to create a 
letter if you started DLS by clicking the Letters button on the Dolphin Imaging main screen. 

Edit Diagnostic 
Lists 

Add, delete, or modify diagnostic lists. 

Image Removal Removes all image files exported from Dolphin Imaging. 
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Template Leads to a cascade menu that offers the following options: 
Modify Existing...: Modify an existing template. 
Create New...: Create a new template. 

Queue Add, remove, or print letters in the DLS queue.  

Insert Image 
Control 

Inserts an image control into the letter. 

The options on this menu are described below. 

Template 
With DLS, you can modify existing templates or create your own custom templates.  

To modify an existing template: 

1. Select Template from the Letters menu. Then, select Modify Existing... from the cascade menu. 

The Open Template dialog box shown below is displayed. The Open Template dialog box automatically shows all 
templates in DLS Template directory.  

Note: Only templates created as Dolphin Letter System templates work correctly to create Dolphin Letter System 
letters.  

2. Select the template you want to modify and click OK. 

The template you selected is displayed in DLS window. 
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To create a new template: 

1. Select Template from the Letters menu. Then, select Create New... from the cascade menu. 

The Create New Template dialog box is displayed: 

 
2. Select the type of template you want to create. Then, click OK. 

After you click OK, a skeleton template appears. You can begin editing the template to add the text and tokens used to 
create your template. 
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Template Editing 
After you have answered the inquiries for creating or modifying a template, either a skeleton template or the template you 
selected to modify appears in DLS window as below. 

 

Template Editing 
Tool Bar 

Provides buttons that you use to save the template or to insert document tokens. Document tokens are 
placeholders for patient or diagnostic information that will be filled in when a letter is created using the 
template.  

Image Frame Indicates the size and position of the patient image that will be used in letters created from this template. 

Template Shows the text and tokens used to create letters based on this template. 

You can make changes to the template such as adding paragraphs and changing formatting using any of the functions of 
Microsoft Word. For more information on editing using Microsoft Word, refer to the Microsoft Word User Manual.  
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You can also make the following changes, which are described below: 

• change the size and position of the patient’s image that will be used in this letter. 

• add document tokens, which insert information as defined in the patient’s chart in Dolphin Imaging or diagnoses from 
the diagnostic lists into the letter. 

• add custom tokens, which prompt the person creating the letter based on this template to supply information. 

• add additional images. 

To change an image’s size or position: 

• Click and drag one of the corner knobs on the image frame to change the image size.  

• Click and drag the image frame to a new position to change the image position. 

• Double-click in the center of the image frame and press the Delete key on your keyboard to delete the image frame. If 
you delete the image frame, no patient image will appear on letters created with this template. 

For more information on working with image frames, refer to your Microsoft Word User’s Guide. 

To insert a document token: 

1. Place the cursor at the point in your letter where you want to insert a document token. 

For example, you would use a document token any place that you want to refer to the name of the patient, make a 
reference to the patient's gender (for instance, his/her or he/she), or refer to a diagnosis on one of your diagnostic lists.  

2. Click the right button on the Template Editing tool bar. 

The Document Tokens dialog box appears. 

3. Select one of the tokens under the Reserved tab and click Insert to insert that token into the document. 

Or,  

Select the Lists tab. Then, select one of the diagnosis groups and click Insert to insert a token for that diagnosis group 
into the document. 

When you click Insert, the Document Tokens dialog box closes, and the selected token appears in your template. 
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Reserved 
Tab 

Select this tab to see a list of reserved document tokens. See Appendix A for a list of reserved tokens. When 
someone creates a letter using a template containing these tokens, the appropriate information as defined in the 
patient’s chart in Dolphin Imaging is inserted into the letter. 

Lists Tab Select this tab to see a list of the diagnosis groups defined in DLS. When someone creates a letter using this 
template containing these tokens, the specified diagnosis list is presented so that a diagnosis can be inserted 
into the letter. 

Token list Select the document tokens you want to insert into the letter template. 

Insert Click this button to insert the selected token into the template. 

To insert custom tokens: 

1. Type two less-than signs (<<), followed by the token name (for example, Amount owed), and then two greater-than 
signs(>>).  

For example, to prompt the person creating a letter based on this template to enter the amount owed, you might type 
the following: <<Amount owed>>. When the Custom Tokens dialog box for this letter appeared, it would list Amount 
Owed as one of the fields requiring information. 

To save the template: 

1. Click the left button on the Template Editing tool bar to save the template. 

The Save Template dialog box appears.  

2. Enter a descriptive name for this template in the Save As text box and click OK. 

The templates included with DLS usually begin with "Doctor - ", "Patient - ", or "Parent - ", so it's easy to identify and 
group the letter types. If you have edited an existing template, you may want to save it under a different name.  
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The Letter System checks the document for errors. If none were found, a message box confirms that the template has 
no errors. Otherwise, the message box indicates the location of any errors found and returns you to the template so 
you can correct them. 

 

Once you have completed your template, you should test it to make sure it works as expected. 

To test the template: 
1. Select Create Letter from the Letters menu.  

2. Select your template from the Open DLS Template dialog box. 

3. Complete all the steps to create a letter using your new template. 

4. When you have finished the new letter, review it and make sure that it looks correct.  

If you see something that needs to be changed, modify the template, as described in  "To modify an existing template," 
and make any changes needed to fix it. Then, retest the template. 

Queue 
When you select Queue from the Letters menu, the Queue Manager dialog box appears. You use the Queue Manager to print 
documents or to add and remove documents from the print queue.  
When you finish creating a letter using DLS, the Word Assistant asks you if you want to print it, send it to the queue, or edit it. If 
you select Send to the Queue, the document is saved in the Queue Manager.  
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Queued 
Items 

Lists documents that were sent to the print queue and are waiting to be printed. Select one or more documents 
listed to print only those documents or to remove them from the print queue. 

Print All Click this button to print all the documents listed. 

Remove All Removes all the documents listed from the print queue. 

Add Adds the document currently active in DLS to the print queue. 

Print 
Selected 

Prints only the selected documents. 

Remove 
Selected 

Removes only the selected documents from the print queue. 

Close Closes the Queue Manager dialog box. 

To send the letter to the print queue: 
1. Select the Queue from the Letters menu. 

2. Click Add. 

To print selected documents: 
1. Select the documents you want to print from the queue. 

2. Click Print Selected. 
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To remove selected documents: 
1. Select the documents you want to remove from the queue. 

2. Click Remove Selected. 

A dialog appears asking you to confirm that you want to remove the selected documents from the queue.  

3. Click Yes. 

Insert Image Control 
An image control is a placeholder for an image. You can insert image controls in any letter or letter template.  

To insert an image control: 

1. Select Insert Image Control from the Letters menu: 

An image control containing the Dolphin logo is inserted into your template. 

2. Click anywhere in the letter template except within the image control. 

To specify a patient’s image to use in place of an image control: 

1. Right-click the image control. 

A pop-up menu appears, as shown below. On this pop-up menu, all the options except Dolphin Image Control Object 
are standard Microsoft Word options. For more information on these options, refer to your Microsoft Windows 
documentation. 
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2. Select Dolphin Image Control Object from the pop-up menu. Then, select Properties from the cascade menu. 

The Image Control Properties dialog box is displayed. In this dialog box, leave the Patient ID text box blank. When you 
create a letter using this template, DLS will automatically complete this field with the Patient ID of the currently-selected 
patient. 

3. Select the timepoint containing the image you want to use from the Timepoint drop-down list box. 

4. Select the type of image you want to use from the Image Type drop-down list box. 

5. Click Apply to see the selected image in your letter. 

6. Click OK to set the properties and close the dialog box. 

If you want to change the image you selected, you can simply repeat this procedure, selecting a different image in the 
dialog box. 

 

Patient ID The ID of the patient whose picture you want to use for this image control. If you leave this field blank, DLS 
automatically enters the ID of the currently-selected patient when you use this template to create a letter. 

Timepoint Select the timepoint containing the image you want to use from this drop-down list box. 

Image 
Type 

Select the type of image you want to use from this drop-down list box. 

Apply Click this button to see the selected image in the letter. 
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Working Between DLS and Dolphin Imaging 
If you are planning to generate more than one letter, we recommend that you keep DLS running in the background while running 
Dolphin Imaging. This way, you can quickly switch between the two programs. 

To switch between DLS and Dolphin Imaging when both are running: 

1. Press ALT+TAB to access the dialog box that lists active tasks. Continue pressing ALT+TAB until the selection rectangle 
is around the program you want to access (either DLS or Dolphin Imaging). 

Or, 

Click the button for the program you want to access from the task bar at the bottom of the screen. 

The following figure illustrates the Dolphin Imaging main screen with the task bar. 
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Exiting from DLS 
When you finish using DLS, you can exit back to Dolphin Imaging. If you have any unsaved changes, DLS will prompt you to 
save them. 

To exit from DLS: 

1. Select Exit from the File menu. 

DLS closes Microsoft Word and prompts you to save any modified or unsaved documents. 
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22 Letter Templates 
This chapter describes the letter templates included with the Dolphin Letter System (DLS). You can use these templates to 
create new letters, or modify them to create your own letter templates. For more information on using DLS, see Chapter 21. 
In the sections that follow, a description, list of tokens, and sample letter are provided for each letter template. The section titles 
indicate the name of the template. 

Templates for Individual Letters 

Doctor – Deband 
Description 
Letter to referring dentist that the patient has just completed treatment. This letter informs the referring dentist of any post 
treatment concerns and includes the patient’s debanding panorex. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 

DoctorTitle  
DoctorZip 
her_him 
PatientFirstName 
PatientLastName 
UserName 

Date Appliance removed 
Type of Retainer 
Post Treatment Concerns 

  

  

7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
RE: <<PatientFirstName>> <<PatientLastName>> 
Dear <<DoctorNickName>>, 
<<PatientFirstName>> <<PatientLastName>> has completed the active phase of orthodontic treatment. Appliances were 
removed on <<Date Appliance removed>> and impressions were taken for <<Type of Retainer>> retainers. I have asked 
<<PatientFirstName>> to schedule an appointment with you in the next month or so for a recall exam, prophylaxis, topical 
fluoride treatment and bitewing radiographs, if indicated. 
I will continue to supervise <<PatientFirstName>> in retention for the next 24-36 months. Specific post treatment concerns for 
<<her_him>> include:  
<<Post Treatment Concerns>> 
Please feel free to call me if you have other specific questions or concerns. I have included <<PatientFirstName>>’s debanding 
panorex for your examination. 
It has been a pleasure to work with <<PatientFirstName>> thus far. Thanks again for the referral and for the opportunity to 
participate in the care of your patients. Your continued support and confidence are greatly appreciated. 
Sincerely, 
<<UserName>> 
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Doctor – Need Dental Records 
Description 
This basic letter that first thanks a referring dentist for their support and then requests that they make a set of full mouth X-rays 
available for further diagnostics. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 

DoctorTitle  
DoctorZip 
He_She 
her_him 
PatientFirstName 
PatientLastName 
UserName 

    

  

7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>> <<DoctorZip>> 
Dear <<DoctorNickName>>,  
Thank your for referring <<PatientFirstName>> <<PatientLastName>> to our practice. We completed our 
standard orthodontic analysis and diagnostics records on <<her_him>>, which included digital imaging. <<He_She>> will be 
starting treatment with us shortly. 
If it is possible, please provide a set of <<PatientFirstName>>’s full mouth X-rays to us. Our office has instructed <<her_him>> to 
contact you about obtaining these records. 
We appreciate your support. 
Sincerely, 
<<UserName>> 
  

Doctor - Need Prophylaxis before Treatment 
Description 
Thanks a referring dentist for their support and then requests that they make meet with the patient and conduct a dental exam 
and prophylaxis. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 

DoctorTitle  
DoctorZip 
He_She 
PatientFirstName 
PatientLastName 
UserName 
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7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
Dear <<DoctorNickName>>,  
We truly appreciate you referring <<PatientFirstName>> <<PatientLastName>> to our practice. We have 
completed an orthodontic diagnostic analysis and standard orthodontic records on <<PatientFirstName>>, which includes digital 
imaging. <<He_she>> will be starting treatment shortly. 
Prior to initiation of treatment, I have recommended that <<PatientFirstName>> visit your office for a dental exam and 
prophylaxis. <<He_she>> should be contacting your office soon. 
Thank you again for recommending our practice. 
Sincerely, 
<<UserName>> 
  

Doctor – Patient not Committed 
Description 
During the exam, it was found that the patient needed treatment. The patient hasn’t committed yet, however. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 

DoctorTitle  
DoctorZip 
PatientFirstName 
PatientLastName 
UserName 

    

  

7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
Dear <<DoctorNickName>>,  
We truly appreciate your referring <<PatientFirstName>> <<PatientLastName>> to our practice. I have 
performed a thorough analysis of this patient including digital imaging. Orthodontic treatment is definitely indicated. However, the 
patient has not yet committed to treatment. My office will stay in touch with this patient, and we will let you know of any change in 
the situation. 
We appreciate your support of our practice. 
Sincerely, 
<<UserName>> 
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Doctor – Referral, Diagnostics to be Done 
Description 
Thanks a referring dentist for referring the patient. Informs the referring dentist that diagnostic records will be sent as soon as 
they are finished. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 

DoctorTitle  
DoctorZip 
PatientFirstName 
PatientLastName 
UserName 

    

  

7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
Dear <<DoctorNickName>>,  
Thank you for referring <<PatientFirstName>> <<PatientLastName>> to me for orthodontic consultation 
and treatment. Your expression of confidence is greatly appreciated. 
After complete diagnostic records have been prepared and analyzed, I will send you a full report. 
Thanks again. 
Sincerely, 
<<UserName>> 

Doctor – Referral for Extractions 
Description 
Indicates the extractions that the patient needs. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorState  
DoctorStreet 
DoctorTitle  
DoctorZip 

PatientBirthDate 
PatientFirstName 
PatientHomePhone 
PatientLastName 
UserAddress1 
UserAddress2 
UserName 
UserPhone 
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7/10/03  
Patient: <<PatientFirstName>> 

<<PatientLastName>> 
Birthdate:  <<PatientBirthday>> 

Phone: <<PatientHomePhone>> 
Referral To: 
<<DoctorTitle>> <<DoctorFirstName>> 
<<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  
<<DoctorZip>> 
From: 
<<UserName>> 
<<UserAddress1>> 
<<UserAddress2>> 
<<UserPhone>> 
RX – <<PatientFirstName>> requires the following extractions: 

 
Remarks 
  
Thank you, 
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Doctor – Referral Summary of Exam 
Description 
This letter gives a summary of the diagnostic findings during a referred patient’s visit.  
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 

DoctorTitle  
DoctorZip 
PatientFirstName 
PatientLastName 
UserName 

Anterior Bite Depth 
Dental Class 
Overjet 
Maxillary arch length 
Mandibular arch length 

Posterior Crossbites 
Dentition developmental stage 
Extracted & Congenitally absent teeth 
Impacted teeth evident clinically 
TMJ Clinically evident or reported 
TMJ Pain 

  

7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
Dear <<DoctorNickName>>, 
I recently saw your patient, <<PatientFirstName>> <<PatientLastName>>, for an orthodontic consultation. 
We enjoyed meeting <<PatientFirstName>>. Thank you for referring <<her_him>> to our office. A summary of the more pertinent 
findings from our clinical examination is included for your review. 
 
• <<Dental Class>> 
• <<Overjet>> 
• <<Anterior Bite Depth>> 
• <<Maxillary arch length>> 
• <<Mandibular arch length>> 
• <<Posterior Crossbites>> 
• <<Dentition developmental stage>> 
• <<Extracted & Congenitally absent teeth>> 
• <<Impacted teeth evident clinically>> 
• <<TMJ Clinically evident or reported>> 
• <<TMJ Pain>> 
 
We made orthodontic records and will let you know of our treatment plans soon. Thank you again for referring 
<<PatientFirstName>> and please call if you have any questions or comments. 
Sincerely, 
<<UserName>> 



Dolphin Imaging User's Guide April 2011 

564 DI_USER_GUIDE-11.5   Rev. 1.01 

Doctor – Referral Summary of Exam #2 
Description 
Thanks a dentist for referring their patient to you and informs them of the results of the examination. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorState  
DoctorStreet 
DoctorTitle  

DoctorZip 
PatientFirstName 
PatientLastName 
Date patient seen 
UserName 

Anatomic Structures Affected 
Chief Concerns 
Disposition 
Functional Analysis 
History 

Orthodontic Diagnosis 
Radiographic Interpretations 
TM Joint Diagnosis 
TMJ Symptoms 
Treatment Recommendations 

  

7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
Re: <<PatientFirstName>> <<PatientLastName>> 
Dear <<DoctorFirstName>>,  
Thank you for referring <<PatientFirstName>> <<PatientLastName>> to our office for an orthodontic/TM joint evaluation. Your 
patient was seen on <<Date patient seen>> and a comprehensive clinical examination has revealed the following: 
 
Chief Concern 
• <<Chief Concerns>> 
 
History 
• <<History>> 
 
Functional Analysis 
• <<Functional Analysis>> 
 
TMJ Symptoms 
• <<TMJ Symptoms>> 
 
Anatomic Structures Affected 
• <<Anatomic Structures Affected>> 
 
Radiographic Interpretations 
• <<Radiographic Interpretations>> 
 
Orthodontic Diagnosis 
• <<Orthodontic Diagnosis>> 
 
TM Joint Diagnosis 
• <<TM Joint Diagnosis>> 
 
Treatment Recommendations 
• <<Treatment Recommendations>> 
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Disposition 
• <<Disposition>> 
 
Thank you again for referring <<PatientFirstName>> <<PatientLastName>> to our office. It is our goal to provide a comfortable, 
pleasant experience here, while offering the highest standards of care. Please call if you have any questions or concerns about 
<<PatientFirstName>>. 
Sincerely, 
<<UserName>> 

Doctor – Referral Summary of Exam #3 
Description 
Thanks a dentist for referring their patient to you and informs them of the results of the examination. 
Tokens 

DoctorLastName 
DoctorTitle  
PatientFirstName 
PatientLastName 

UserAddress1 
UserAddress2 
UserAddress3 
UserName 
UserPhone 

Crossbite 
Crowding 
Dental Class 
Habits 
Impacted Teeth 

Missing Teeth 
Overbite 
Overjet 
Treatment Recommendations 
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<<UserName>> 
<<UserAddress1>> 
<<UserAddress2>> 
<<UserAddress3>> 

<<UserPhone>> 
PRACTICE LIMITED TO ORTHODONTICS   DIPLOMATE OF THE AMERICAN BOARD OF ORTHODONTICS 

 June 20, 2000 

 
Dear <<DoctorTitle>> <<DoctorLastName>>: 
Thank you for referring <<PatientFirstName>> <<PatientLastName>> for an orthodontic consultation. Enclosed are my initial 
findings and recommendations: 
Molars              Overjet                Overbite                Profile 

<<Dental Class>>  <<Overjet>> <<Overbite>   <<Facial Balance>> 

        

Crossbite            Crowding         Midline Off  

<<Crossbite>>  <<Crowding>>   <<Midlines>> 

        

Habits Missing Teeth Impacted Teeth   

<<Habits>> <<Missing Teeth>> <<Impacted Teeth>>    
I have recommended the following treatment: 
• <<Treatment Recommendations>> 
 
Feel free to contact me if you have questions or comments. 

_____________________ 
<<UserName>> 
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Doctor – Referral to Oral Surgeon 
Description 
This letter refers the patient to an oral surgeon and provides the patient’s panoramic X-ray. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 

DoctorTitle  
DoctorZip 
her_him 
PatientFirstName 
PatientLastName 
UserName 

Reason for visit   

  

7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
Dear <<DoctorNickName>>,  
In conjunction with <<PatientFirstName>> <<PatientLastName>>’s orthodontic treatment, I am referring 
<<her_him>> to your office for <<Reason for visit>>. Below is <<PatientFirstName>>’s panoramic x-ray for your examination. If 
you have any questions regarding this procedure please feel free to call me. 
Sincerely, 
<<UserName>> 

Doctor – Treatment Completed 
Description 
Letter to referring dentist that the patient has just completed treatment and has entered the passive phase of orthodontics. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 
DoctorTitle  

DoctorZip 
her_him 
her_his 
PatientFirstName 
PatientLastName 
she_he 
UserName 

Mo. For Retainer   
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7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
RE: <<PatientFirstName>> <<PatientLastName>> 
Dear <<DoctorNickName>>,  
We have just completed <<PatientFirstName>> <<PatientLastName>>’s orthodontic treatment. In our office, this is always an 
occasion for celebration! <<PatientFirstName>>’s results are just what we have worked toward, and <<she_he>> is now 
healthier and happier. 
<<PatientFirstName>> is now in the passive phase of orthodontic care. During this period, we’ve recommended a retainer and 
advised <<her_him>> in its use for a period of <<Mo. For Retainer>> months. We hope that <<PatientFirstName>> is committed 
to wearing the retainer at all times to maintain a corrected bite. 
I have attached <<PatientFirstName>>’s final orthodontic records for your examination. We also asked <<her_him>> to schedule 
an examination with you soon for continuing care.  
Thank you for your trust in us as part of <<her_his>> dental team. We treasure our relationships. They are the heart of our 
practice. 
Sincerely, 
<<UserName>> 

Doctor – Treatment not Necessary 
Description 
Letter to the dentist, thanking them for the referral. Notes that treatment is not required at this time. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 

DoctorTitle  
DoctorZip 
PatientFirstName 
PatientLastName 
UserName 

    

 7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
Dear <<DoctorNickName>>,  
I truly appreciate your referring <<PatientFirstName>> <<PatientLastName>> to our practice. After a 
careful orthodontic examination, I have determined that treatment is not necessary at this time. I’ve explained this fully to 
<<PatientFirstName>>. 
Thank you for your support and referral. 
Sincerely, 
<<UserName>> 

Doctor – Wait for Treatment 
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Description 
Thanks the dentist for the referral. Treatment is necessary but it would be best to wait until permanent dentition has erupted. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 

DoctorTitle  
DoctorZip 
PatientFirstName 
PatientLastName 
UserName 

    

  

7/10/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
Dear <<DoctorNickName>>,  
We truly appreciate your referring <<PatientFirstName>> <<PatientLastName>> to our practice. While 
orthodontic treatment is indicated on <<PatientFirstName>>, it would be most beneficial to wait until more of the permanent 
dentition has erupted. 
I am placing this patient on recall and will keep you abreast of any developments. 
Sincerely, 
<<UserName>> 

Form – Initial Treatment Diagnosis 
Description 
Provides a form for recording the initial treatment diagnosis. 
Tokens 

PatientFirstName 
PatientLastName 
PatientBirthDate 

Airway evaluation 
Canine Classification 
Chief Concerns 
Crossbite 
Dental Class 
Dentition developmental stage 

Enamel Defects 
Functional Shift 
Hygiene/Periodontic Health 
Lips Evaluation 
Lips at Rest 
Mandibular Position 

Maxilla Position 
Midlines 
Overbite 
Overjet 
Treatment Fee 
Tx length (mos) 
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Date: 7/10/03 
Patient: <<PatientFirstName>> <<PatientLastName>> 
Birth: <<PatientBirthday>> 
Chief Complaint 
• <<Chief Concerns>> 

 
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

  
  
   
Dx: 
Tx: 
ETT: <<Tx length (mos)>> months 
Fees: <<Treatment Fee>> 

Maxilla:  <<Maxilla Position>> 

Mandible: <<Mandibular Position>> 

Lips  <<Lips Evaluation>> 

Airway  <<Airway evaluation>> 

Caries   

Crossbites  <<Crossbite>> 

Functional Shift <<Functional Shift>> 

Missing Teeth   

Trauma/endo    

TMJ    

Molar Class  L: <<Dental Class>> 

         R: 

Canine Class L: <<Canine Classification>> 

  R: 

Overbite  <<Overbite>> 

Overjet  <<Overjet>> 

Midline <<Midlines>> 

Hygiene/Perio <<Hygiene/Periodontic Health>> 

Enamel Defects <<Enamel Defects>> 

Dentition Stage <<Dentition developmental stage>> 

Additional Notes    
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Parent – Cooperation Needed to Treat 
Description 
Letter to parent stating that treatment is needed but can’t begin until the patient decides to cooperate. 
Tokens 

GuardianCity 
GuardianFirstName 
GuardianLastName 
GuardianState  
GuardianStreet 

GuardianTitle 
GuardianZip 
PatientFirstName 
son_daughter 
UserName 
UserPhone 

  

7/15/03 
<<GuardianTitle>> <<GuardianFirstName>> <<GuardianLastName>> 
<<GuardianStreet>> 
<<GuardianCity>>, <<GuardianState>> <<GuardianZip>> 
Dear <<GuardianTitle>> <<GuardianLastName>>, 
We enjoyed meeting you and discussing your <<son_daughter>>’s need for orthodontic treatment. As I 
mentioned during our visit, treatment is necessary. However, before deciding whether to make this commitment, we would like 
you to give it careful consideration. 
Patient cooperation is the most important aspect of successful orthodontic treatment. If <<PatientFirstName>> is not yet ready to 
make the necessary commitments, it may be best to postpone treatment. 
Please give this some real thought and call us if you believe <<PatientFirstName>> is ready to begin treatment. Until then, 
please don’t hesitate to call <<UserPhone>> if you have any questions. 
Sincerely, 
<<UserName>> 

Parent – Fed Truth in Lending & Disclosure 
Description 
Cover letter for sending the parent a copy of the Federal Truth in Lending Disclosure Statement. 
Tokens 

GuardianCity 
GuardianFirstName 
GuardianLastName 
GuardianState  

GuardianStreet 
GuardianTitle 
GuardianZip 
UserName 
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7/15/03 
<<GuardianTitle>> <<GuardianFirstName>> <<GuardianLastName>> 
<<GuardianStreet>> 
<<GuardianCity>>, <<GuardianState>>  <<GuardianZip>> 
Dear <<GuardianTitle>> <<GuardianLastName>>, 
I am enclosing a copy of the Federal Truth in Lending Disclosure Statement, which we are required to 
send you. Please read carefully, sign and return to our office as soon as possible. 
Sincerely, 
Financial Coordinator 
<<UserName>> 

Parent – First Appointment Thank You 
Description 
After the patient has already come in for initial records and before their consultation. Thanks them for their visit and reminds 
them when their next appointment is. 
Tokens 

GuardianCity 
GuardianFirstName 
GuardianLastName 
GuardianState  

GuardianStreet 
GuardianTitle 
GuardianZip 
UserName 

Appt. Time 
Appt. Date 

  

7/15/03 
<<GuardianTitle>> <<GuardianFirstName>> <<GuardianLastName>> 
<<GuardianStreet>> 
<<GuardianCity>>, <<GuardianState>>  <<GuardianZip>> 
Dear <<GuardianTitle>> <<GuardianLastName>>, 
We appreciate your scheduling an appointment with our office. At this appointment, we will be evaluating 
your need for orthodontic treatment and discussing with you what to expect should you decide to proceed with treatment. 
All of us at the office look forward to meeting you. We'll see you at <<Appt. Time>> on <<Appt. Date>>. 
Sincerely, 
<<UserName>> 
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Parent – First Appointment Welcome 
Description 
Thanks the parent for bringing their son/daughter in for an examination and then summarizes the patient’s chief concerns, 
diagnostic findings, and treatment recommendations.  
Tokens 

GuardianCity 
GuardianFirstName 
GuardianLastName 
GuardianState  
GuardianStreet 
GuardianTitle 

GuardianZip 
PatientFirstName 
her_him 
UserName 
UserPhone 

Chief Concerns 
Next appointment 
Orthodontic Diagnosis 
Treatment Recommendations 

  

7/15/03 
<<GuardianTitle>> <<GuardianFirstName>> <<GuardianLastName>> 
<<GuardianStreet>> 
<<GuardianCity>>, <<GuardianState>>  <<GuardianZip>> 
Dear <<GuardianTitle>> <<GuardianLastName>>, 
It was a pleasure meeting you and <<PatientFirstName>> during your first appointment. Our staff eagerly 
welcomes <<PatientFirstName>> to our practice and looks forward to seeing <<her_him>> again for <<her_him>> next 
appointment on <<Next appointment>>. Following is a recap of your initial examination: 
Your Chief Concerns 
• <<Chief Concerns|Layman>> 
 
Our Diagnostic Findings 
• <<Orthodontic Diagnosis|Layman>> 
 
Treatment Recommendations 
• <<Treatment Recommendations|Layman>> 
If you have any questions or require any further information prior to your next appointment, please feel free to call us at 
<<UserPhone>>. 
Sincerely, 
<<UserName>> 
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Parent – Payment Past Due 
Description 
Letter to parent, informing them that they have past due payments. 
Tokens 

GuardianCity 
GuardianFirstName 
GuardianLastName 
GuardianState  
GuardianStreet 

GuardianTitle 
GuardianZip 
PatientFirstName 
UserName 
UserPhone 

$ Amount due 

  

7/15/03 
<<GuardianTitle>> <<GuardianFirstName>> <<GuardianLastName>> 
<<GuardianStreet>> 
<<GuardianCity>>, <<GuardianState>>  <<GuardianZip>> 
Dear <<GuardianTitle>> <<GuardianLastName>>, 
Our records show that you are past due on your payments for <<PatientFirstName>>’s orthodontic care. 
We need to receive <<$ Amount due>> to bring this account up to date. For your convenience, overdue accounts can be 
charged on Visa, Mastercard, or American Express. 
Please remit this amount immediately or call us at <<UserPhone>> to have the <<$ Amount due>> charged to your credit card. 
We appreciate your cooperation and expect to hear from you soon. 
Sincerely, 
Financial Coordinator 
<<UserName>> 

Parent – Treatment Not Required 
Description 
Thanks the parent for bringing in their son/daughter and then informs them that treatment is not required at this time. 
Tokens 

GuardianCity 
GuardianFirstName 
GuardianLastName 
GuardianState  
GuardianStreet 

GuardianTitle 
GuardianZip 
PatientFirstName 
UserName 
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7/15/03 
<<GuardianTitle>> <<GuardianFirstName>> <<GuardianLastName>> 
<<GuardianStreet>> 
<<GuardianCity>>, <<GuardianState>>  <<GuardianZip>> 
Dear <<GuardianTitle>> <<GuardianLastName>>, 
It was a pleasure to meet you and <<PatientFirstName>> to discuss possible orthodontic treatment. As I 
mentioned during our visit, <<PatientFirstName>> is not required to have orthodontic treatment at this time. 
We are pleased that you chose our office. Please let us know if there is any way in which we can be of help in the future. 
Sincerely, 
<<UserName>> 

Patient – Certificate - Finished  
Description 
A certificate that can be given to the patient when they finish treatment. 
Tokens 

PatientFirstName 
PatientLastName 
UserName 

DateTreatmentFinished   

  

The office of <<UserName>> 
congratulates 

<<PatientFirstName>> <<PatientLastName>> 
  

 
for completing treatment on <<Date Treatmnt finished>> 

_______________________________ 
<<UserName>>             7/15/03 
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Patient – Certificate - Finished Child 
Description 
A certificate that can be given to the patient when they finish treatment. 
Tokens 

PatientFirstName 
PatientLastName 
UserName 

DateTreatmentFinished   

  

The office of <<UserName>> 
congratulates 

<<PatientFirstName>> <<PatientLastName>> 
  

 

for completing treatment on <<Date Treatmnt finished>>  
_______________________________ 

<<UserName>>             7/15/03  
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Patient – Cooperation Needed to Treat 
Description 
Letter to patient stating that treatment is needed but can’t begin until they are willing to cooperate. 
Tokens 

PatientCity 
PatientFirstName 
PatientLastName 
PatientNickName 
PatientState  
PatientStreet 

PatientTitle 
PatientZip 
UserName 
UserPhone 

  

7/15/03 
<<PatientFirstName>> <<PatientLastName>> 
<<PatientStreet>> 
<<PatientCity>>, <<PatientState>> <<PatientZip>> 
Dear <<PatientNickName>>, 
We enjoyed meeting you and discussing your need for orthodontic treatment. As I mentioned during our 
visit, treatment is necessary. However, before deciding whether to make this commitment, we would like you to give it careful 
consideration. 
Patient cooperation is the most important aspect of successful orthodontic treatment. If the patient is not yet ready to make the 
necessary commitments, it may be best to postpone treatment. 
Please give this some real thought and call us if you are ready to begin treatment. Until then, please don’t hesitate to call 
<<UserPhone>> if you have any questions. 
Sincerely, 
<<UserName>>  

Patient – Fed Truth in Lending & Disclosure 
Description 
Cover letter for sending the patient a copy of the Federal Truth in Lending Disclosure Statement. 
Tokens 

PatientCity 
PatientFirstName 
PatientLastName 
PatientNickName 
PatientState  

PatientStreet 
PatientTitle 
PatientZip 
UserName 
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7/15/03 
<<PatientFirstName>> <<PatientLastName>> 
<<PatientStreet>> 
<<PatientCity>>, <<PatientState>> <<PatientZip>> 
Dear <<PatientNickName>>, 
I am enclosing a copy of the Federal Truth in Lending Disclosure Statement, which we are required to 
send you. Please read carefully, sign and return to our office as soon as possible. 
Sincerely, 
Financial Coordinator 
<<UserName>> 

Patient – Finished Photos 
Description 
A certificate with patient photos can be given to the patient when they finish treatment. 
Tokens 

PatientFirstName 
PatientLastName 
UserName 

Date braces off   

  

The office of <<UserName>> congratulates 
<<PatientFirstName>> <<PatientLastName>> 

 
Braces Removed <<Date Braces off>> 
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Patient – First Appointment Welcome 
Description 
Thanks the patient for coming in for an examination and then summarizes the patient’s chief concerns, diagnostic findings, and 
treatment recommendations. 
Tokens 

GuardianCity 
GuardianFirstName 
GuardianLastName 
GuardianState  
GuardianStreet 
GuardianTitle 

GuardianZip 
PatientFirstName 
her_him 
UserName 
UserPhone 

Chief Concerns 
Next appointment 
Orthodontic Diagnosis 
Treatment Recommendations 

  

7/15/03 
<<GuardianTitle>> <<GuardianFirstName>> <<GuardianLastName>> 
<<GuardianStreet>> 
<<GuardianCity>>, <<GuardianState>>  <<GuardianZip>> 
Dear <<GuardianTitle>> <<GuardianLastName>>, 
It was a pleasure meeting you and <<PatientFirstName>> during your first appointment. Our staff eagerly 
welcomes <<PatientFirstName>> to our practice and looks forward to seeing <<her_him>> again for <<her_him>> next 
appointment on <<Next appointment>>. Following is a recap of your initial examination: 
Your Chief Concerns 
• <<Chief Concerns|Layman>> 
 
Our Diagnostic Findings 
• <<Orthodontic Diagnosis|Layman>> 
 
Treatment Recommendations 
• <<Treatment Recommendations|Layman>> 
If you have any questions or require any further information prior to your next appointment, please feel free to call us at 
<<UserPhone>>. 
Sincerely, 
<<UserName>> 

Patient – Payment Past Due 
Description 
Letter to patient, informing them that they have past due payments. 
Tokens 

PatientCity 
PatientFirstName 
PatientLastName 
PatientNickName 
PatientState  

PatientStreet 
PatientTitle 
PatientZip 
UserName 
UserPhone 

$ Amount due 
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7/15/03 
<<PatientTitle>> <<PatientFirstName>> <<PatientLastName>> 
<<PatientStreet>> 
<<PatientCity>>, <<PatientState>>  <<PatientZip>> 
Dear <<PatientNickName>>, 
Our records show that you are past due on your payments for orthodontic care. We need to receive <<$ 
Amount due>> to bring this account up to date. For your convenience, overdue accounts can be charged on Visa, Mastercard, or 
American Express. 
Please remit this amount immediately or call us at <<UserPhone>> to have the <<$ Amount due>> charged to your credit card. 
We appreciate your cooperation and expect to hear from you soon. 
Sincerely, 
Financial Coordinator 
<<UserName>> 

Patient – Thanks for Referring Another Patient 
Description 
This letter is to thank one patient for referring another. When using this letter, select the patient that was referred on the image 
list so that the person that referred them can see their photo. 
Tokens 

City, State Zip 
PatientFirstName 
PatientLastName 
He_She 

Ref. patient full name 
Referral Address 
Referral Name 
she_he 
UserName 

  

7/15/03 
<<Ref. patient full name>> 
<<Referral Address>> 
<<City, State Zip>> 
Dear <<Referral Name>>, 
Recently, <<PatientFirstName>> <<PatientLastName>> visited our office regarding orthodontic treatment. 
<<He_She>> mentioned that <<she_he>> had heard of us from you. On behalf of our entire staff, I would like to thank you for 
thinking of us. We really appreciate the recommendation. 
Sincerely, 
<<UserName>> 
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Patient – Treatment not Required 
Description 
Thanks the patient for coming in and then informs them that treatment is not required at this time. 
Tokens 

PatientCity 
PatientFirstName 
PatientLastName 
PatientNickName 
PatientState  

PatientStreet 
PatientTitle 
PatientZip 
UserName 
  

  

  

7/15/03 
<<PatientTitle>> <<PatientFirstName>> <<PatientLastName>> 
<<PatientStreet>> 
<<PatientCity>>, <<PatientState>>  <<PatientZip>> 
Dear <<PatientNickName>>, 
It was a pleasure to meet you and discuss possible orthodontic treatment. As I mentioned during our visit, 
you are not required to have orthodontic treatment at this time. 
We are pleased that you chose our office. Please let us know if there is any way in which we can be of help in the future. 
Sincerely, 
<<UserName>> 

Patient – Treatment Outline 
Description 
Outlines the treatment plan for the patient. 
Tokens 

UserName 
UserAddress1 
UserAddress2 
PatientFirstName 
PatientLastName 

Add'l Charges 
Cost of Rec & Init exam 
Date of Last Dental Exam 
Est. Treat time (mo.)  
Insurance Company 

Payment in Full 
Signed Insur. Form 
Treatment Fee 
Treatment Recommendations 
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<<UserName>> 
<<UserAddress1>> 
<<UserAddress2>>

 
7/15/03 

Treatment outline for <<PatientFirstName>> <<PatientLastName>> 
  

  
  
  
  
  
  
  
  
  
  
Financial Arrangements 

Date of Last Dental Exam Estimated Treatment Time 
<<Date of Last Dental Exam>>  <<Est. Treat time (mo.)>> months 
    
Recommended Treatment Plan Insurance Coverage 
<<Treatment Recommendations>> <<Insurance Company>> 
    
Patient Responsibility Signed Insurance Form 
Excellent Brushing <<Signed Insur. Form>> 
Avoid hard or sticky foods.  Loose appliances can   
extend treatment time. Orthodontic Charges 
Wear elastics full time. Records and Initial Exam: <<Cost of Rec & Init exam>> 
Keep appointments faithfully. Treatment Fee: <<Treatment Fee>> 
Wear retainers as instructed. Payment in Full: <<Payment in Full>> 
  Additional Charges: <<Add’tl Charges>> 
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Patient – Treatment Outline with Fee Schedule 
Description 
Outlines the treatment plan for the patient. 
Tokens 

UserName 
UserAddress1 
UserAddress2 
PatientFirstName 
PatientLastName 

Add'l Charges 
Cost of Rec & Init exam 
Date of Last Dental Exam 
Est. Treat time (mo.)  
Insurance Company 

Payment in Full 
Signed Insur. Form 
Treatment Fee 
Treatment Recommendations 

  

<<UserName>> 
<<UserAddress1>> 
<<UserAddress2>>

 
7/15/03 

Treatment outline for <<PatientFirstName>> <<PatientLastName>> 
  

Date of Last Dental Exam Estimated Treatment Time 
<<Date of Last Dental Exam>> <<Est. Treat time (mo.)>> months 
    
Recommended Treatment Plan Insurance Coverage 
<<Treatment Recommendations>> <<Insurance Company>> 
    
Patient Responsibility Signed Insurance Form 
Excellent Brushing <<Signed Insur. Form>> 
Avoid hard or sticky foods. Loose appliances can   
extend treatment time. Orthodontic Charges 
Wear elastics full time. Records and Initial Exam: <<Cost of Rec & Init exam>> 
Keep appointments faithfully. Treatment Fee: <<Treatment Fee>> 
Wear retainers as instructed. Payment in Full: <<Payment in Full>> 
  Additional Charges: <<Add'l Charges>> 

 Fees and Financial Arrangements 
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Letter Set Templates 

Letter Set - First Appointment Evaluation #1 
Description 
Creates two letters, one to the referring doctor and one to the patient’s guardian, reviewing the diagnosis and treatment plan. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorState  
DoctorStreet 
DoctorTitle  
DoctorZip 
GuardianCity 
GuardianFirstName 
GuardianLastName 

GuardianState  
GuardianStreet 
GuardianTitle 
GuardianZip 
He_She 
her_his 
Name 
PatientFirstName 
PatientLastName 
Status at Appointment 

Add’l Notes for Patient 
Add’l Tx Notes 
Chief Concerns 
Crowding 
Crossbite 
Dental Class (2) 
Dentition developmental stage (2) 

Overbite 
Overjet (2) 
Patient's Next Step 
Skeletal Evaluation|  
Treatment Plan 
Tx length (mos) 

  

7/15/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
Dear <<DoctorNickName>>, 
Thank you for referring <<PatientFirstName>> <<PatientLastName>>. I recently saw 
<<PatientFirstName>> for <<Status at Appointment>> appointment. <<He_She>> presents with the following findings.  
 
Chief concerns: 
• <<Chief Concerns>> 
 
Dental evaluation 
• <<Dental Class (2)|Dentist>> 
• <<Dentition developmental stage (2)|Dentist>> 
• <<Overbite|Dentist >> 
• <<Overjet (2)|Dentist >> 
• <<Crowding|Dentist >> 
• <<Crossbite|Dentist >> 
 
Skeletal evaluation 
• <<Skeletal Evaluation|Dentist >> 
 
I recommended the following treatment plan for <<PatientFirstName>>: 
 
<<Treatment Plan>>: 
• <<Add’l Tx Notes>> 
 
<<PatientFirstName>>’s next step: 
• <<Patient's Next Step>> 



22 Letter Templates Part VIII: Dolphin Letters System (DLS) 

DI_USER_GUIDE-11.5   Rev. 1.01 585 

 
I estimate <<PatientFirstName>>’s treatment time at approximately <<Tx length (mos)>> months. I have reminded 
<<PatientFirstName>> to maintain <<her_his>> 6-month recalls with you throughout the course of <<her_his>> orthodontic 
treatment. Please feel free to call if you have any additional questions or suggestions regarding <<PatientFirstName>>. 
Sincerely, 
<<Name>> 

  

7/15/03 
<<GuardianTitle>> <<GuardianFirstName>> <<GuardianLastName>> 
<<GuardianStreet>> 
<<GuardianCity>>, <<GuardianState>>  <<GuardianZip>> 
Dear <<GuardianTitle>> <<GuardianLastName>>, 
This letter is a review of the diagnosis and treatment plan we discussed at  
<<PatientFirstName>>’s recent orthodontic consultation. 
My evaluation of <<her_his>> teeth reveals: 
• <<Dental Class (2)|Layman>> 
• <<Dentition developmental stage (2)|Layman>> 
• <<Overbite|Layman>> 
• <<Overjet (2)|Layman>> 
• <<Crowding|Layman>> 
• <<Crossbite|Layman>> 
 
My evaluation of <<her_his>> jaw relationships reveals: 
• <<Skeletal Evaluation|Layman>> 
 
I recommend the following treatment plan: 
 
<<Treatment Plan|Layman>>: 
• <<Add’l Notes for Patient>> 
 
I estimate that <<PatientFirstName>>’s orthodontic treatment to be approximately <<Tx length (mos)>> months. The actual 
treatment time will be largely dependent upon <<her_his>> cooperation, such as keeping teeth and appliances clean, avoiding 
hard or chewy foods, and keeping all appointments. Many appointments can be arranged in the "after-school" hours; however, 
we will require longer appointments to be scheduled during "school hours" on occasion. It is important for <<PatientFirstName>> 
to see <<her_his>> family dentist prior to orthodontic treatment, and to continue regular visits for cavity checks and cleanings. 
I hope this letter answers any questions you may have regarding <<PatientFirstName>>’s proposed orthodontic treatment. 
Please feel free to call if you have any additional questions. We look forward to working with <<PatientFirstName>> in the future. 
Sincerely, 
<<Name>> 
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Letter Set - First Appointment Evaluation #2 
Description 
Creates two letters, one to the referring doctor and one to the patient’s guardian, reviewing the diagnosis and treatment plan. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 
DoctorTitle  
DoctorZip 
GuardianCity 
GuardianFirstName 
GuardianLastName 

GuardianState  
GuardianStreet 
GuardianTitle 
GuardianZip 
her_him 
her_his 
Name 
PFirstName 
PLastName 
PatientNickname 
she_he 

Abnormalities or Special Problems 
Crossbite 
Dental Class (2) 
Extractions 
Fixed Appliances 
Functional Appliance 
Maxillary Arch Length II 
Mandibular Arch Length II 

Overbite II 
Overjet II 
Removable Appliance 
Skeletal Profile 
Skeletal Vertical 
TMJ Clicking 
TMJ Pain II 
Treatment Duration 

  

7/15/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
RE: <<PFirstName>> <<PLastName>>’s orthodontic consultation 
Dear <<DoctorNickName>>,  
Your patient, <<PFirstName>> <<PLastName>>, recently visited our office and will be undergoing orthodontic treatment. 
We completed a Full Phase orthodontic consultation for <<PFirstName>> that presented the following findings: 
Classification:  <<Dental Class (2)>> 
Arch Discrepancy:  <<Maxillary Arch Length II>> 
  <<Mandibular Arch Length II>> 
Overbite: <<Overbite II>> 
Overjet:  <<Overjet II>> 
Crossbite:  <<Crossbite>> 
Skeletal Problems:  <<Skeletal Profile>> 
  <<Skeletal Vertical>> 
TMD Signs/Symptoms: <<TMJ Clicking>> 
  <<TMJ Pain II>> 
Special Problems: <<Abnormalities or Special Problems>> 

After completing and evaluating <<PFirstName>>’s diagnosis, I developed the plan for <<her_him>>, outlined below: 
Extractions: <<Extractions>> 
Removable Appliances: <<Removable Appliance>> 
Functional Appliance: <<Functional Appliance>> 
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Fixed Appliances: <<Fixed Appliances>> 

<<PFirstName>> has been told the importance of keeping regular visits with you. If <<she_he>> fails to come in for an 
appointment, please call our office and we’ll be glad to reinforce the importance of periodic checkups. If you should have any 
questions or comments about <<PFirstName>>’s orthodontic treatment, please don’t hesitate to call. 
Sincerely, 
<<Name>> 

  

7/15/03 
<<GuardianTitle>> <<GuardianFirstName>> <<GuardianLastName>> 
<<GuardianStreet>> 
<<GuardianCity>>, <<GuardianState>>  <<GuardianZip>> 
RE: <<PFirstName>> <<PLastName>>’s orthodontic consultation 
Dear <<GuardianFirstName>>,  
We are very happy to welcome you and <<PFirstName>> to our practice. We are excited to have your company for the next few 
years. 
This letter is a review of a diagnosis and treatment plan we discussed at our recent orthodontic consultation appointment. As you 
are aware, the diagnosis included the following: 
Classification: <<Dental Class (2)|Layman>> 
Arch Discrepancy: <<Maxillary Arch Length II|Layman>> 
  <<Mandibular Arch Length II|Layman>> 
Overbite: <<Overbite II|Layman>> 
Overjet: <<Overjet II|Layman>> 
Crossbite:  <<Crossbite|Layman>> 
Skeletal Problems: <<Skeletal Profile|Layman>> 
  <<Skeletal Vertical|Layman>> 
TMD Signs/Symptoms: <<TMJ Clicking|Layman >> 
  <<TMJ Pain II|Layman >> 
Special Problems: <<Abnormalities or Special Problems|Layman >> 

After completing and evaluating <<PatientNickname>>’s diagnosis, I developed the plan for <<her_him>>, outlined below: 
Extractions: <<Extractions|Layman >> 
Removable Appliances: <<Removable Appliance|Layman >> 
Functional Appliance: <<Functional Appliance|Layman >> 
Fixed Appliances: <<Fixed Appliances|Layman >> 

I anticipate active treatment time at approximately <<Treatment Duration>> months with up to a 2 year retention treatment after 
the braces have been removed. However, the actual treatment time will be largely dependent upon <<PFirstName>>’s 
cooperation, such as keeping teeth and appliances clean, avoiding hard or chewy food, and keeping all <<her_his>> orthodontic 
appointments. 
Many appointments can be arranged for after-school hours; however, we will require appointments to be scheduled during 
school on occasion. Understanding that your time is valuable, we will do everything possible to start and complete all of your 
appointments on time. Please advise of any loose or broken braces. A longer (or separate) appointment can then be scheduled 
for your convenience and to help us stay on schedule. Please keep in mind that broken or missed appointments, regardless of 
the reason, usually result in a longer active treatment. 
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As we mentioned, it is important to see your family dentist prior to orthodontic treatment, and to continue regular 3-6 month visits 
for cavity checks and cleanings. 
I hope this letter answer any questions you may have regarding orthodontic treatment. If you any questions in the future, please 
do not hesitate to call on me any time. It has been a pleasure meeting with you and I look forward to a pleasant relationship in 
the future, as well as an excellent result! 
Sincerely, 
<<Name>> 

 

Letter Set - First Appointment Evaluation #3 
Description 
Creates two letters, one to the referring doctor and one to the patient’s guardian, reviewing the diagnosis and treatment plan. 
Tokens 

DoctorCity 
DoctorFirstName  
DoctorLastName 
DoctorNickName 
DoctorState  
DoctorStreet 
DoctorTitle  
DoctorZip 
GuardianCity 
GuardianFirstName 
GuardianLastName 

GuardianState  
GuardianStreet 
GuardianTitle 
GuardianZip 
her_him 
her_his 
PatientFirstName 
PatientLastName 
PatientNickname 
she_he 
UserName 

Abnormalities or Special Problems 
Crossbite 
Dental Class (2) 
Extractions 
Fixed Appliances 
Functional Appliance 
Maxillary Arch Length II 
Mandibular Arch Length II 

Overbite  
Overjet (2) 
Removable Appliance 
Skeletal Profile 
Skeletal Vertical 
TMJ Clicking 
TMJ Pain  
Treatment Duration 
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7/15/03 
<<DoctorTitle>> <<DoctorFirstName>> <<DoctorLastName>> 
<<DoctorStreet>> 
<<DoctorCity>>, <<DoctorState>>  <<DoctorZip>> 
RE: <<PatientFirstName>> <<PatientLastName>>’s  
orthodontic consultation 
Dear <<DoctorNickName>>,  
Your patient, <<PatientFirstName>> <<PatientLastName>>, recently visited our office and will be undergoing orthodontic 
treatment. 
We completed a Full Phase orthodontic consultation for <<PFirstName>> that presented the following findings: 

Classification  <<Dental Class (2)>> 
Arch Discrepancy <<Maxillary arch length>> 

  <<Mandibular arch length>> 
verbite  <<Overbite>> 
Overjet <<Overjet (2)>> 

Crossbite  <<Crossbite>> 
Skeletal Problems <<Skeletal Profile>> 

  <<Skeletal Vertical>> 
TMD Signs/Symptoms <<TMJ Clicking>> 

  <<TMJ Pain II>> 
Special Problems <<Abnormalities or Special Problems>> 

After completing and evaluating <<PatientFirstName>>’s diagnosis, I developed the plan for <<her_him>>, outlined below: 
Extractions <<Extractions>> 

Removable Appliances <<Removable Appliance>> 
Functional Appliance <<Functional Appliance>> 

Fixed Appliances <<Fixed Appliances>> 

<<PatientFirstName>> has been told the importance of keeping regular visits with you. If <<she_he>> fails to come in for an 
appointment, please contact our office and we’ll glad to reinforce the importance of periodic checkups. If you should have any 
questions or comments, please don’t hesitate to call. 
Sincerely, 
<<UserName>> 
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7/15/03 
<<GuardianTitle>> <<GuardianFirstName>> <<GuardianLastName>> 
<<GuardianStreet>> 
<<GuardianCity>>, <<GuardianState>>  <<GuardianZip>> 
RE: <<PatientFirstName>> <<PatientLastName>>’s orthodontic consultation 
Dear <<GuardianFirstName>>,  
We are very happy to welcome you and <<PatientFirstName>> to our practice. We are excited to have your company for the 
next few years. 
This letter is a review of a diagnosis and treatment plan we discussed at our recent orthodontic consultation appointment. As you 
are aware, the diagnosis included the following: 

Classification <<Dental Class (2)|Layman>> 
Arch Discrepancy <<Maxillary Arch Length II|Layman>> 

  <<Mandibular Arch Length II|Layman>> 
Overbite <<Overbite|Layman>> 

Overjet <<Overjet (2)|Layman>> 
Crossbite <<Crossbite|Layman>> 

Skeletal Problems <<Skeletal Profile|Layman>> 
  <<Skeletal Vertical|Layman>> 

TMD Signs/Symptoms <<TMJ Clicking|Layman >> 
  <<TMJ Pain|Layman >> 

Special Problems <<Abnormalities or Special Problems|Layman >> 

After completing and evaluating <<PatientNickname>>’s diagnosis, I developed the plan for <<her_him>>, outlined below: 
Extractions <<Extractions|Layman >> 

Removable Appliances <<Removable Appliance|Layman >> 
Functional Appliance <<Functional Appliance|Layman >> 

Fixed Appliances <<Fixed Appliances|Layman >> 

I anticipate active treatment time at approximately <<Treatment Duration>> months with up to a 2-year retention treatment after 
the braces have been removed. However, the actual treatment time will be largely dependent upon <<PatientFirstName>>’s 
cooperation, such as keeping teeth and appliances clean, avoiding hard or chewy food, and keeping all <<her_his>> orthodontic 
appointments. 
Many appointments can be arranged for after-school hours; however, we will require appointments to be scheduled during 
school on occasion. Understanding that your time is valuable, we will do everything possible to start and complete all of your 
appointments on time. Please advise of any loose or broken braces. A longer (or separate) appointment can then be scheduled 
for your convenience and to help us stay on schedule. Please keep in mind that broken or missed appointments, regardless of 
the reason, usually result in a longer active treatment. 
As we mentioned, it is important to see your family dentist prior to orthodontic treatment, and to continue regular 3-6 month visits 
for cavity checks and cleanings. 
I hope this letter answer any questions you may have regarding orthodontic treatment. If you any questions in the future, please 
do not hesitate to call on me any time. It has been a pleasure meeting with you and I look forward to a pleasant relationship in 
the future, as well as an excellent result! 
Sincerely, 
<<UserName>> 
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Part IX: ImPlanner 
This part of the Dolphin Imaging User’s Guide describes how to use the Dolphin Imaging ImPlanner(TM) module. Dolphin 
ImPlanner is a powerful and easy-to-use module for planning implant procedures. This module can assist you in case evaluation, 
creation of individualized treatment plans, patient education, and creation of precise documentation.  
Dolphin ImPlanner performs implant placement and related procedures using the patient’s radiograph. Within minutes, patients 
and referring doctors can fully understand your treatment process. 
This module includes the following features: 

• Radiograph enhancement tools 

• High-quality implant image library 

• Implant placement simulation 

• On-screen measuring tool 

• Enhancement of bone grafts, sinus grafts, and anatomical structures 

• Image magnification 
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23 ImPlanner 
You can use the Dolphin ImPlanner to assist you in implant case evaluation, creating individualized treatment simulations, and 
patient presentation. The ImPlanner facilitates patient education, generates precise documentation, and streamlines 
communication. It performs implant placement and related procedures on a patient's radiograph. Within minutes, your patients 
and referring doctors can fully understand your treatment process.  
The Dolphin ImPlanner provides the following tools: 

• A library of high-quality implant images for a variety of manufacturers, types, and dimensions. 

• Simulation of implant placement. 

• A tool to draw bone grafts, sinus grafts, and anatomical structures on the radiographic image to aid you when placing 
the implants. 

• Tools to calibrate the size of the implant images appropriately for the scale of the patient’s image and to take other 
measurements on the patient’s image. 

• Support for printing and emailing detailed treatment simulation reports. 

To use ImPlanner, you typically use an intraoral X-ray image. To verify that an intraoral X-ray image is available, select the - 
Everything - layout from the Layout drop-down list box on the Dolphin Imaging System main screen. This layout contains all 
patient images for the selected timepoint. If an intraoral X-ray image is available for this patient and timepoint, the image will be 
available from this image layout. 

To access ImPlanner: 
1. Select a patient image on the Dolphin Imaging main screen. 

2. Click  on the Dolphin Imaging main screen. 

Or,  

Click  on the Edit dialog box (see Chapter 8). 

If this is the first time you are using this patient image with ImPlanner (if you have not yet calibrated it), the Calibration 
palette opens. At this point, you should enter calibration settings as described in "Calibration." 

If the patient image has already been calibrated, the patient’s image appears with the ImPlanner palette, as shown 
below. 
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tool bar Provides buttons for accessing image editing tools (see below). 

Implant Click this tab to add implants to the patient’s image. For more information, see "Adding Implants" on page 
598. 

Markers Click this tab to draw specific anatomical structures to indicate treatment operations and to emphasize various 
areas of the patient’s image. For more information, see "Using Markers" on page 603. 

Measure Click this tab to measure distances on the patient’s image. For more information, see "Taking Measurements" 
on page 606. 

Add... Click this button to add a new implant from the library. For more information, see "To add an implant" on page 
598. 

Change... Click this button to change the selected implant to a different implant from the library. For more information, 
see "To change an implant" on page 600. 

Delete Click this button to delete the selected implant. For more information, see "To delete an implant" on page 601. 

Copy Click this button to copy the selected implant. The duplicate of the implant appears immediately on the screen. 
For more information, see "To copy an implant" on page 600. 

Translucent Check this box to make the implants translucent so that you can see the underlying image. 

Tooth Type Select the type of tooth to add to the selected implant. For more information, see "To add a tooth to an 
implant" on page 601. 
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Reposition Once you have added an implant, you can click these buttons to move it.  

Flip Button Click this button to rotate the selected implant 180 degrees. For example, you can move the implant from a 
maxillary to a mandibular position.  

Rotation Buttons Click these buttons to rotate the selected implant by 1 degree.  

Selected Implant Displays detailed information about the currently-selected implant. 

Undo Click this button to undo changes to the image. This button undoes operations in the reverse of the order in 
which they were performed. 

Calibrate Click this button to calibrate the actual size and magnification of the radiographic image so that the implants 
are properly scaled. For more information, see "Calibration" below. 

Using the Edit Tool Bar 
The Edit Tool Bar contains the following buttons: 

 
Opens the Cut tool. For more information, see "Using the Cut Palette" on page 274. 

 
Opens the Morph tool. For more information, see "Using the Morph Palette" on page 277. 

 
Opens the Brushes tool. For more information, see "Using the Brushes Palette" on page 281. 

 
Opens the Image Library. For more information, see "Using the Image Library" on page 283. 

 
Opens the ImPlanner feature. For more information, see Chapter 23.. 

 
Displays the modified image side-by-side with the original image. For more information, see "Viewing Two Images 
Side by Side" on page 272. 

 
Opens the original records window. For more information, see "To view the patient's other images in an Original 
Records Window" on page 412. 

 
Toggles the display of the patient’s tracing. 

 
Opens the Enhance tool. For more information, see "To enhance a picture" on page 164. 

 
Sets display preferences. For more information, see "To set general preferences" on page 75. 

 
Opens the measurements table. For more information, see Chapter 12. 

 
Undoes the previous operation. 

 
Saves the image. For more information, see "Saving a Modified Image," below. 

 
Prints the image. For more information, see "Printing" on page 224. 

 Copies the image and/or its tracings to the clipboard. 
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Calibration 
The first time you use a particular patient image with ImPlanner (if you have not yet calibrated it), the Implant Calibration palette 
opens automatically. You can also open it at any time as described below. 
Using the calibration feature, you specify information that Dolphin ImPlanner uses to size the implant objects appropriately to the 
scale of the patient’s image. You can even create calibration settings, save them, and reuse them later. This is especially useful 
if you routinely receive radiographs from multiple sources, such as different referring doctors or laboratories. 
Note: The accuracy of your treatment simulation depends upon the accuracy of the calibration process. It is very 
important that you enter accurate calibration information. 
Calibration is necessary, because X-ray systems magnify their output. For instance, suppose you tape a 100mm ruler with lead 
beads at each end to a patient's face. Then, you take an X-ray using an X-ray system that magnifies by 25%. If you measure the 
lead-bead ruler on the X-ray film output, you will find that it measures 125mm, or 25% longer than the actual ruler you used when 
taking the X-ray. Then, suppose you tape a 100mm Dolphin calibration ruler to the X-ray film and scan it using a flat-bed 
scanner. In Dolphin, you will see two rulers on the X-ray image labeled 100mm, but the two rulers are different lengths on 
screen. The ruler taped to the patient's face when the X-ray was taken appears 25% longer than the one taped to the X-ray film 
when it was scanned. 

To open the Calibration palette: 

1. Click  on the ImPlanner palette. 

The Calibration palette opens, and a line appears on the patient’s image, as shown below.  
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Choose... Click this button to select calibration settings that you have previously saved. For more information, see 
"To use previously-saved calibration settings," below. 

Save As... Click this button to save your current calibration settings. For more information, see "To save your current 
calibration settings so that you can re-use them in the future" on page 597. 

Line Length 
(mm) 

Enter the length in millimeters (mm) of the calibration ruler. 

Magnification 
(%) 

If the calibration ruler was placed next to the X-ray when it was scanned, enter the magnification factor of 
the X-ray system used for the radiographic image. 

Start ImPlanner Click this button when you finish calibration to start ImPlanner. 

To use previously-saved calibration settings: 

1. On the Calibration palette, click Choose. 

The Select Saved Calibration Settings dialog box is displayed listing the saved settings. 

2. Select one of the saved settings. Then, click OK. 

To calibrate the size of implants to the scale of the radiographic image: 

1. On the patient’s image, click and drag each of the calibration line’s boxes to the ends of the calibration ruler.  

When the mouse is over one of the boxes, triangles appear around that box, and the box turns red. 

If you used a "before magnification" ruler (i.e., a ruler is on the image of the radiograph), position the calibration points 
at the ends of that ruler. 

If you used an "after magnification" ruler (i.e., you laid a "Dolphin 100mm ruler" on the scanner when you scanned the 
X-ray), position the calibration points at the ends of that "scanned-in" ruler. 

2. Enter the length of the calibration ruler in the Line Length text box, without taking into account any magnification by the 
X-ray system. 

3. Enter the magnification factor of the X-ray system used for the radiographic image. 

If you used a "before magnification" ruler, enter 100% (no magnification correction) in the Magnification (%) text box. 
This is because the length entered in step 3 is the length of that ruler, and the ruler and the patient’s X-ray were 
magnified by the same factor by the X-ray system. 

If you used an "after magnification" ruler, enter a magnification percentage in the Magnification (%) text box. For 
example, if the X-ray machine magnifies by 25%, enter 125% in the Magnification (%) text box. This is because the 
length entered in step 3 is the length of a ruler that was not magnified by the X-ray system. 
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For instance, a 100mm Dolphin ruler placed next to the X-ray during scanning actually represents 100mm divided by 
125%, or 80mm, on the patient's skull. In other words, an 80mm length on patient’s skull was magnified by the X-ray 
machine to 100mm on the X-ray film, as measured by the 100mm Dolphin ruler.  

If you enter a magnification factor other than 100%, the length reported by the calibration line’s label is adjusted for the 
magnification factor. For instance, a calibration line measured against the 100mm Dolphin ruler with a magnification 
factor of 125% is labeled 80mm. 

To save your current calibration settings so that you can re-use them in the future: 

1. Click Save As. 

The Save Calibration As dialog box is displayed. 

2. Enter a name to identify these saved calibration settings. 

3. Select one of the available ten slots in which to save these calibration settings. Then, click OK. 

If a slot has a name assigned, it already contains saved calibration settings. If you select a slot containing saved 
settings, the existing settings are overwritten with the new settings. 

 

Name Enter a name to identify these calibration settings. 

Save As Select one of the available ten slots in which to save these calibration settings. If a slot has a name assigned, it 
already contains saved calibration settings. If you select a slot containing saved settings, the existing settings are 
overwritten with the new settings. 

To complete the calibration and start ImPlanner: 

1. Click Start ImPlanner. 
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Adding Implants 
Once you have calibrated the image, you can begin adding implants. You use the Implant tab of the ImPlanner palette to add 
implants. 
Note: Before you add implants, you may wish to add markers to the image to identify sinuses, nerves, bone grafts, extractions, 
and bridges. For more information, see "Using Markers" on page 603. 

To add an implant: 

1. With the Implant tab selected on the ImPlanner palette, click . 

Or, 

Right-click an existing implant on the patient’s image, and select Add New Screw from the pop-up menu. 

The Select Implant palette opens.  

 
If this is the first time you have used the ImPlanner, loading the implant library may take a moment, and this dialog box 
may not appear immediately. 

2. Click the plus signs (+) to expand the categories in the list box. 

Whenever you open the Select Implant palette, it remembers the categories that were open when you last used it. This 
way, your most commonly-used implants are always quickly accessible.  

In addition, you can click and drag the corners of the Select Implant palette to resize it. The next time you open the 
Select Implants palette, it remembers the size you selected. 
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The implants are arranged in a hierarchy. They are grouped first by manufacturer, then by model, then type of implant, 
then implant diameter, and finally implant length. You must expand all these levels and select an implant at the bottom 
level (length) before your selection is valid.  

3. When you see the implant you want to add, select it and click OK. 

Or, 

Double-click the implant you want to add. 

The implant image you picked appears on the patient’s image.  

 
4. Reposition the implant by clicking and dragging it with the mouse, by using the arrow keys, by using the arrow buttons 

on the palette. 

Whenever you select an implant, the ImPlanner palette displays information about it. You can select the information 
about the implant from the ImPlanner palette, copy it to the clipboard, and paste it into another application. 

5. Flip or rotate the implant using the flip or rotate buttons on the palette. 

Using the Flip button, you rotate an implant 180 degrees. For example, you can move the implant from a maxillary to a 
mandibular position. Using the rotate buttons, you can rotate the implant any number of degrees. Each time you click a 
rotate button, the implant rotates one degree. 

At this point, you can perform any other Dolphin ImPlanner functions, such as adding more implants, copying this 
implant, adding more markers, and so on. When you finish using the Dolphin ImPlanner, you can save the image to 
save the implants you have added. For more information on saving images, see "Saving the Image" on page 607. 
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To change an implant: 

1. On the patient’s image, select the implant you want change. Then, click  on the ImPlanner palette. 

Or, 

Right-click the implant you want to change, and select Change This Screw from the pop-up menu. 

The Select Implant palette is displayed.  

2. Select the name of the implant image you want to use from the Name list box. 

The newly-selected implant replaces the existing implant on the patient’s image.  

3. Click OK to close the Select Implant dialog box. 

To copy an implant: 

1. On the patient’s image, select the implant you want to copy. Then, click   on the ImPlanner palette. 

Or, 

Right-click the implant you want to copy, and select Copy This Screw from the pop-up menu. 

A second copy of the implant appears on the patient’s image, as shown below. 
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To delete an implant: 

1. Select the implant you want to delete. Then, click  on the ImPlanner palette. 

Or, 

Right-click the implant you want to delete, and select Delete This Screw from the pop-up menu. 

The implant is removed from the patient’s image. 

To add a tooth to an implant: 

1. Select the implant to which you want to add a tooth. Then, select the type of tooth you want to add from the Tooth Type 
drop-down list box on the ImPlanner palette. 

Or, 

Right-click the implant to which you want to add a tooth. Then, select Change Tooth Type from the pop-up menu, and 
select the type of tooth you want to add from the cascade menu. 

The tooth appears on top of the implant on the patient’s image. 

To set properties for the tooth: 

1. Select the tooth for which you want to set properties. Then, click the color box next to the Tooth Type drop-down list 
box on the ImPlanner palette. 

Or,  

Right-click the tooth for which you want to set properties. Then, select Change Tooth Properties from the pop-up menu. 

The Tooth Marker Properties dialog box is displayed. 

2. Set any properties for the tooth, and click OK. 

 

Color Click the button next to the color sample to select the color that you want to use for the tooth.  

Thickness Select the thickness of the line defining the tooth shape from this drop-down list box. 
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Fill with solid 
color 

Check this box to fill the tooth shape with a solid color. Otherwise, the tooth shape is filled with a cross-
hatched design. 

Straight border 
lines 

Check this box to use straight lines rather than curves to define the tooth shape. 

To move the tooth in relation to the implant: 
1. Click the tooth you want to move. 

2. Move the cursor over the tooth until the cursor turns into a hand.  

3. Click and drag the tooth until its location is correct in relation to the implant. 

To stretch the tooth: 
1. Click the tooth you want to stretch. 

2. Move the cursor over the tooth until the cursor turns into a double-headed arrow.  

3. Click and drag the tooth’s outline to stretch the tooth. 

To move a point on the tooth’s outline: 
1. Click the tooth you want to change. 

2. Move the mouse over one of the points on the tooth’s outline. 

When the mouse is over one of the points, triangles appear around that point, and the point turns red. 

3. Click and drag the point to a new location. 

The tooth’s outline changes shape to accommodate the point’s new location. 



23 ImPlanner Part IX: ImPlanner 

DI_USER_GUIDE-11.5   Rev. 1.01 603 

Using Markers 
Using the Markers tab on the ImPlanner palette, you can draw anatomical structures and indicate some surgical procedures on 
the patient’s image to aid you when placing the implants and when presenting your treatment simulations to patients or other 
clinicians. 

To access the Implant Markers palette: 

1. Click the Markers tab on the ImPlanner palette. 

The Implant Marker tab opens, as shown below. 

Marker Type Select the type of marker you want to add to the 
radiographic image. You can add sinuses and nerves, 
or indicate bone grafts, extractions, or bridges. 

Color Sample Click the color sample to specify the color that you 
want to use for this marker and to set other marker 
options. For more information, see "To change 
properties for a marker" on page 604. 

Delete Select this option to remove a marker. For more 
information, see "To remove a marker" on page 605. 

Undo Click this button to undo changes to the image. This 
button undoes operations in the reverse of the order in 
which they were performed. 

Calibrate Click this button to calibrate the actual size and 
magnification of the radiographic image so that the 
implants are properly scaled. For more information, 
see "Calibration" on page 595. 
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To add markers to the radiographic image: 

1. Select the type of marker that you want to add. 

Or, 

Right-click an existing marker on the patient’s image, and select one of the options for adding a marker from the pop-
up menu. 

2. Draw the marker on the patient’s radiographic image. 

To draw the marker, click the left mouse button on a point where you want to begin drawing. Release the mouse button 
and move the mouse to begin drawing the marker. As you move the mouse, you’ll see a line extending from the point 
to the current mouse position. Click the mouse button whenever you want to place a point and change the direction of 
the line. If you make a mistake, click the right mouse button to undo the line to the last point you placed. 

You can draw either open lines or closed polygons. To complete a closed polygon, click the left mouse button again on 
the first point. The line or polygon appears in the color next to that marker type on the ImPlanner palette. When you 
draw a closed polygon, ImPlanner fills in the polygon with the color you chose. By default, the fill is cross-hatched 
instead of a solid color. The figure below illustrates a marker drawn on a patient’s radiographic image. 

 
At this point, you might want to save the image to save the markers you have drawn. For more information on saving 
images, see "Saving the Image" on page 607. 

To change properties for a marker: 

1. Click the color box next to the marker type for which you want to set properties. 

Or, 

Right-click a marker of the type for which you want to set properties. Then, select Change Properties of This Marker 
from the pop-up menu. 

The Marker Properties dialog box opens. 

2. Click the button next to the color sample to select the color that you want to use for this marker. 

When you print or export an image layout with markers, a color legend indicates the color used for each type of 
marker. 

3. Select any other options, and click OK. 
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Color Select the color that you want to use for this type of marker. 

Thickness Select the line thickness that you want to use for this type of marker from this drop-down list box. 

Fill with Solid 
Color 

Check this box to fill the marker shape with a solid color. Otherwise, the marker shape is filled with a 
cross-hatched design. 

Straight Border 
Lines 

Check this box to use lines rather than a curve to draw this type of marker.  
Note: Splines create smoother curves than lines. Using lines is more appropriate for marker shapes that 
do not have many curves. 

To remove a marker: 

1. Select the marker you want to delete. Then, click  on the ImPlanner palette. 

Or, 

Right-click the marker you want to delete. Then, select Delete This Marker from the pop-up menu. 

To move a point on a marker: 
1. Select the Marker you want to change. 

2. Move the mouse over one of the points on the marker. 

When the mouse is over one of the points, triangles appear around that point, and the point turns red. 

3. Click and drag the point to a new location. 

The line changes shape to accommodate the point’s new location. 

Note: Moving a point on a marker is extremely useful in depicting a sinus lift procedure. You can draw the sinus on the patient’s 
radiographic image as it currently exists and save that image. Then, you can move some of the points on the sinus marker to 
show the sinus after the sinus lift. The following figure illustrates moving points to depict a sinus lift procedure. 
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Taking Measurements 
Using the measure feature, you can add calipers to the patient’s radiographic image to measure any distances on it. You use the 
Measure tab on the ImPlanner palette to add calipers. 

To add a caliper to the radiographic image to take measurements 
1. Click the Measure tab on the ImPlanner palette. 

2. Click and drag to draw the caliper on the patient’s radiographic image. 

Or, 

Click . Then, click and drag each of the caliper’s boxes so that it spans the distance you want to measure.  

Or, 

Right-click an existing caliper on the patient’s image, and select Add New Caliper from the pop-up menu. Then, click 
and drag each of the new caliper’s boxes so that it spans the distance you want to measure.  

The caliper appears as a line on the patient’s radiographic image. When a caliper is selected, it has a box at each end, 
which you use to reposition it. When the mouse is over one of the boxes, triangles appear around that box, and the box 
turns red.  

When a caliper is not selected, arrow heads appear at the end of the caliper instead of boxes. 

The caliper indicates the measurement, as shown below. 
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At this point, you might want to save the image to save the measurements. For more information on saving edited images, see 
"Saving the Image" below. 

To delete a caliper from the patient’s radiographic image: 

1. Select the caliper you want to delete. Then, click . 

Or, 

Right-click the caliper you want to delete. Then, select Delete This Caliper from the pop-up menu.  

   

Saving the Image 
When you save the image, Dolphin always saves both of the following: 

• the image and data that comprise the ImPlanner simulation 

• the original image and data, for your reference or further treatment simulation 

To save the image: 

1. Click . 

The Save Image dialog box is displayed. 

2. Optionally, modify the image title. 

Dolphin automatically provides an appropriate image title, "Treatment Simulation" in most cases. However, you may 
wish to enter a more specific name (such as "implants") as appropriate, for your ImPlanner image. 
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3. Select a slot from the Save As list box in which to save this image, and click OK. 

For each patient and timepoint, you can save up to eight different ImPlanner images. 

Note: If you are viewing two images side by side when you save, the side-by-side view of the two images is saved as a 
single image. 

 

Image Title Enter a title for this image, up to 25 characters. 

New Notes Notes for this image. This text box is automatically completed with a summary of the operations you 
performed. However, you can freely modify the content of these notes.  

Into Slot Select one of the eight slots available for each timepoint in which to save this image.  
The field below this list box indicates whether the selected slot already contains an image. If you select a slot 
containing an image, the existing image is overwritten with the new image. 

Current Slot 
Notes 

If you select a slot that already contains an image, the notes previously entered for that slot appear in this 
text box. 

Printing or Emailing Radiographic Images with Implants 
Once you have added implants or markers to a radiographic image, you can print it for your records or to send to the patient or 
referring doctor. In addition, you can email the radiographic image with implants and markers. 
When you print or email an radiographic image with implants and markers, the printed or emailed image includes a legend that 
indicates the types of implants and the colors used for markers, as shown below: 
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Exiting ImPlanner 

To exit ImPlanner and return to the Dolphin Imaging main screen: 

1. Click . 

If you have not saved your ImPlanner simulation, a dialog box appears asking whether you want to save the modified 
image. 

2. Click Yes to save the image. 

Or, 

Click No if you do not want to save the image. 

For more information, see "Saving the Image" on page 607. 
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Part X: 3D 
This part of the Dolphin Imaging User’s Guide describes how to use Dolphin 3D to capture, view, and manipulate 3D images 
created from most cone-beam computed tomography (CBCT), MRI, Medical CT, and 3D facial camera systems. Dolphin 3D 
offers powerful yet intuitive tools for processing 3D image data. There are no complicated commands or scripting language to 
learn. Using the Dolphin 3D feature, you can: 

• import new 3D volumetric images and photographs from a variety of sources 

• view or edit existing 3D volumetric images and photographs 

• precisely orient the volume 

• detect impacted teeth 

• assess facial and skeletal asymmetry 

• visualize and analyze the airway 

• view any cross-section of the volume  

• digitize landmarks on 3D volumetric images to establish 2D and 3D measurements 

• build accurate x-rays from 3D volumetric images 

• create movies for case presentation 

• export the image data to standard file formats or to the Microsoft Windows clipboard 

• plan implant placement using 3D volumetric images 

• create reports that incorporate images from Dolphin 3D  

If you have not purchased the Dolphin 3D module, you can view and manipulate 3D volumetric images and photographs, but you 
cannot save any changes. For example, if another doctor sends you a Dolphin patient archive containing 3D data, you can view 
the data even if you have not purchased the Dolphin 3D module. However, you must purchase the Dolphin 3D module to import 
3D volumetric images (such as DICOM volume sets) and 3D photographs, edit them, digitize them, build x-rays from them, and 
so on. 
If you have purchased a limited number of licenses for the Dolphin 3D module, that number of workstations in your office can 
simultaneously import 3D images, edit them, digitize them, build x-rays, and so on. The remaining workstations in your office can 
only view the 3D images. For more information, please consult your Dolphin representative. 
The Dolphin web site (www.dolphinimaging.com) provides documentation on the hardware requirements for Dolphin 3D. Actual 
memory requirements depend on the data size of volumes you are viewing and editing. The advanced 3D rendering modes 
("translucent" modes) are only enabled if your computer is equipped with a video graphics card that supports them. If you see the 
following message on the Dolphin 3D window, click Why? for a detailed description of why your computer is not fully compatible.  
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24 Getting Started With Dolphin 3D 
This chapter describes basic procedures for getting started with Dolphin 3D, including: 

• Adding, editing, and deleting 3D volumes 

• Understanding the Dolphin 3D window 

• Orienting a new 3D image 

• Adding and editing 2D and 3D photographs 

Adding, Editing, and Deleting 3D Volumes 
The following procedures describe how to: 

• Add new volume to Dolphin 3D 

• Delete an existing volume 

• View an existing volume 

• Edit an existing volume 

Adding a New 3D Image 
Before you can add a new 3D image for a patient, you must add the patient to Dolphin Imaging and create a timepoint for the 
patient. For more information on adding patients and timepoints, see Chapter 4.  
Once you have selected the patient and timepoint, you can add a 3D image from a DICOM data set. The data set can be: 

• A single DICOM file containing all images that comprise the 3D volume.   

• A set of DICOM image files, each containing one image that is part of the 3D volume. In this case, all image files that 
comprise the data set must be in the same directory.  In addition, the directory cannot contain any DICOM image files 
unrelated to the current data set. 

• A set of DICOM image files, each containing one image that is part of the 3D volume, along with a DICOM directory file 
(usually named DICOMDIR) that identifies the DICOM image files for the data set. In this case, all the image files and 
the DICOM directory file must be in the same directory.  

To add a 3D image for a patient: 

1. On the Dolphin Imaging main screen, select the timepoint. 

2. Optionally, select the layout to which you want to add the 3D image.  

You can only select a different layout if other images already exist for this patient. 

3. Click  on the Dolphin Imaging main screen. 

4. Select Import New DICOM... from the pop-up menu. 

The Open dialog box appears so that you can select the directory containing a valid 3D DICOM volume data set. 
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5. Navigate to the folder containing the 3D DICOM volume data set.  

6. If the data set is comprised of a single file, select that file.  

Or, 

If the data set is comprised of several files but has no DICOM directory file, select any file in the data set. 

Or, 

If the data set is comprised of several files and has a DICOM directory file, select the DICOM directory file. 

7. Click Open to load the data set. 

The 3D image appears in the Dolphin 3D window. Depending on the source of the image, it may not appear 
recognizable initially. Before you begin to analyze the 3D image, you may need to: 

� Segment the image: You may need to identify or fine-tune the segments of the 3D image to use for the soft tissue 
and hard tissue views. For more information, see "Segmenting the Image" on page 641. 

� Orient the image: You may need to change the image orientation so that it properly correlates to the requirements 
for your analysis. For more information, see "Orienting the Image” on page 675. 

These two activities are fundamental to your proper use of the 3D volume. 

Deleting the 3D Volume 
Deleting the 3D volume deletes the entire 3D image data set stored in the Dolphin database for the patient.  Deleting the 3D 
volume from within Dolphin Imaging does not delete any 3D volume data set files stored outside your Dolphin database. 

To delete a 3D image for a patient: 

1. On the Dolphin Imaging main screen, select the timepoint. 

2. Click  on the Dolphin Imaging main screen. 

A pop-up menu appears with options for accessing the 3D features. If this patient does not have any 3D images 
already, only Import New... is active, and the other options are disabled (greyed out). 

3. Select Delete Volume... from the pop-up menu. 

If you have more than one 3D volume stored for this patient and timepoint, a list of images representing the 3D 
volumes appears. 

4. If you have more than one 3D volume stored for this patient and timepoint, select the volume you want to delete. 

The Deleting Volume dialog box appears and asks you to confirm the deletion. 

5. Click Yes to delete the volume 

Or, 

Click No to cancel the deletion.  



Dolphin Imaging User's Guide April 2011 

614 DI_USER_GUIDE-11.5   Rev. 1.01 

Viewing or Editing an Existing 3D Image 
If you have an existing 3D image for a patient, you can view or edit it. The following figure shows a patient's 3D images as they 
appear on the Dolphin Imaging main screen. 

 

To view an existing 3D image: 

1. On the Dolphin Imaging main screen, select the timepoint and layout that contains a 3D image. 

2. Select the patient's 3D image in the image layout. 

3. Click  on the Dolphin Imaging main screen. 

A pop-up menu appears with options for accessing the 3D features. If this patient does not have any 3D images 
already, only Import New... is active, and the other options are disabled (greyed out). 
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4. Select View Only... from the pop-up menu to view the selected 3D image only. 

Or, 

Select Edit... from the pop-up menu to edit the selected 3D image. 

If you have more than one 3D volume stored for this patient and timepoint, a list of images representing the 3D 
volumes appears. 

5. If you have more than one 3D volume stored for this patient and timepoint, select the volume you want to view or edit. 

The 3D image appears in the Dolphin 3D window. The features available to you depend on whether you are viewing or 
editing the image: 

� If you selected View Only..., you can view and manipulate 3D volumetric images and photographs, but you cannot 
save any changes.  

� If you selected Edit..., you can edit 3D volumetric images and photographs, re-orient them, digitize them, build x-
rays from them, and so on. Then, you can save your changes. 

Alternatively, you can right-click the patient's 3D image in the image layout on the Dolphin Imaging main screen. Then, you can 
select 3D View... or 3D Edit... from the pop-up menu to view or edit the patient's 3D volumetric images and photographs. 

Understanding the 3D Window 
After you load an image, it appears in the Dolphin 3D main window as shown below. Using this window, you can: 

• View the hard tissue, the soft tissue, or both. Depending on your computer's graphics capabilities, you can use a 
translucent view that enables you to see features such as impacted teeth and implants. You can also set the color for 
the hard and soft tissue, which may enable you to distinguish various details of the image more easily. 

• Rotate the 3D volume. You can select one of the pre-defined views, or you can click and drag the image to rotate it for 
any viewing angle. 

• Change the magnification of the image to zoom in on areas of interest. 

• Display slices of the 3D volume representing the following standard planes on the 3D volume: 

� Sagittal plane: This vertical plane exactly divides the left and right sides. 

� Coronal plane: This vertical plane is orthogonal to the anterior-posterior axis. In the brain, it shows left and right, 
the top of the head and the neck. 

� Axial plane: This horizontal plane is orthogonal to the superior-inferior axis. In the brain, it shows left and right, 
face and back of the head.   

• Customize your view of the 3D volume by changing the angle and thickness of the slice you are viewing. 

• Define your own viewing slices using either a clipping slice or clipping box. The clipping slice cuts the 3D volume and 
displays a cross section. A clipping box is like a 3-dimensional clipping slice. With a clipping box, you define a cube 
within the volume, and only the image data within the clipping box is displayed. For more information, see "Using 
Clipping Slices and Boxes" on page 869. 

• Use volume sculpting to remove parts of the volume. 

From this window, you can also access features that enable you to segment the 3D volume, orient it, add 3D photographs, build 
x-rays from the volume data, digitize landmarks and create measurements, create a script or movie of the 3D volume, analyze 
the patient's airway, perform volume mirroring, and superimpose two volumes.  
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Soft Tissue 

Click this radio button to show the patient’s soft tissue image in the window. Use the following options to 
configure the soft tissue view: 
� Solid: Click this radio button to view a solid representation of the patient's soft tissue. 

� Drop-down list box: Select the multi-color solid rendering template to use from the 
drop-down list box. For more information, see "Segmenting Solid Hard and Soft Tissues" 
on page 641. 

� Seg...: Use this slider to set the segment of the 3D image to use for the soft tissue view.  
� Edit...: Click this button to open the Segmentation window and set the segment of the 

3D image to use for the soft tissue view. For more information, see "Segmenting the 
Image" on page 641. 

� Translucent: Click this radio button to view a translucent representation of the patient's soft tissue. 
This option is only available if your computer graphics card supports advanced 3D rendering. 
� Seg: Use this slider to select the density segment of the 3D image to use for the soft 

tissue view in this window.  
� Photo: 2D/3D: Click this radio button to use the patient's 3D or 2D photograph (if available) for the 

soft tissue view. 
� Mesh: Check this box to show only a mesh representation of the patient’s photograph in 

the window.  
� Type: Choose the photograph to display from this drop-down list box. You can store two 

photographs for each 3D volume. 
� Add.. or Edit...: Click this button to add or edit the patient's photograph. 

These configuration options are saved for each 3D image. For more information on these options, see 
"Viewing the Soft Tissue" on page 635. 

Hard Tissue 

Click this radio button to show the patient’s hard tissue image in the window. Use the following options to 
configure the hard tissue view: 
� Solid: Click this radio button to view a solid representation of the patient's hard tissue. 

� Drop-down list box: Select the multi-color solid rendering template to use from the 
drop-down list box. For more information, see "Segmenting Solid Hard and Soft Tissues" 
on page 641. 

� Seg...: Use this slider to set the segment of the 3D image to use for the hard tissue view. 
� Edit...: Click this button to open the Segmentation window and set the segment of the 

3D image to use for the hard tissue view.  For more information, see "Segmenting the 
Image" on page 641. 

� Translucent: Click this radio button to view a translucent representation of the patient's hard 
tissue. This option is enabled only if your computer graphics card supports advanced 3D 
rendering. If it does, the following sub-options are available: 
� Drop-down list box: Set the color scheme to use for the translucent view from the drop-

down list box. 
� Seg: Use this slider to select the density segment of the 3D image to use for the hard 

tissue view in this window. 
� Trans: Use this slider to set the level of transparency in the hard tissue image. 

These configuration options are saved for each 3D image. For more information on these options, see 
"Viewing the Hard Tissue" on page 637. 
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Combined Soft 
Tissue + Hard 
Tissue 

Click this radio button to show both the patient’s soft and hard tissue images in the window. The settings in 
the Soft Tissue and Hard Tissue group boxes are used to construct the combined view. For more 
information, see "Viewing Both the Soft and Hard Tissue" on page 639. 
Trans: Use this slider to set the overall transparency of the combined image. 

 
Click this button to orient the image so that it appears properly in the window. For more information, see 
"Orienting the Image" on page 675. 

 
Click this button to create x-rays from the 3D image data. For more information, see Chapter 25. 

 
Click this button to open the Digitize/Measurement palette so that you can digitize landmarks and take 
measurements on the 3D image. For more information, see Chapter 26. 

 
Click this button to open the 3D Script Editor, which enables you to create videos based on the 3D image. 
For more information, see Chapter 27. 

 

Opens the Sinus/Airway Analysis dialog box so that you can mark and analyze the patient's airway. For more 
information, see Chapter 28. 
Note: The Airway Analysis feature is available only on computers that support advanced 3D rendering 
modes ("translucent" modes). 

 

Opens the Mirroring Tool dialog box so that you can perform volume mirroring operations.  For more 
information, see "Volume Mirroring" on page 822. 
Note: The Mirroring Tool is available only on computers that support advanced 3D rendering modes 
("translucent" modes). 

 
Opens the Superimposition dialog box so that you can superimpose two volumes. For more information, see 
"Superimposing Volumes" on page 829. 

 
Opens the 3D Implant Simulation dialog box so that you can simulate the placement of implants using the 3D 
volume. For more information, see Chapter 30. 

Use Clipping Slice 

Check this box to define and view a cross-section of the image. For more information, see "Using a Clipping 
Slice" on page 869. 
slider: Move the slider to set the location of the slice used for this cross section. 

: Click this icon to set the clipping slice at the mid-sagittal plane. 

: Click this icon to set the clipping slice at the axial plane. 

: Click this icon to set the clipping slice at the coronal plane. 

: Click this icon to use a pie-shaped clipping slice that includes the patient's arch. 

: Click this icon to orient the clipping slice in the direction of the viewer. 
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Use Volume 
Clipping Box 

Check this box to view the image using a clipping box. For more information, see "Using a Clipping Box" on 
page 871. 
Edit...: Click this button to define the boundaries of a 3D clipping box. 

Use Volume 
Sculpting 

Check this box to view the image using volume sculpting. For more information, see "Sculpting the Volume" 
on page 877. 
Edit...: Click this button to perform volume sculpting. 

Send Snapshot... 

Opens a pop-up menu with the following options: 
Close This Menu: Choose this option to close the pop-up menu. 
Save To Dolphin Layout/Database: Choose this option to save the 3D image to a slot in a Dolphin image 
layout and store it in your database. For more information, see "Saving an Image" on page 661. 
Send To Report: Choose this option to use this image in a Dolphin 3D report. For more information, see 
Chapter 32. 
Copy To Clipboard: Choose this option to copy the 3D image to the clipboard. Then, you can paste the 
image into another application. For more information, see "Copying the Image to the Clipboard" on page 
663. 
Print: Choose this option to print the image. For more information, see "Printing an Image" on page 664. 
Export To File: Choose this option to export the 3D image to a file. For more information, see "Exporting an 
Image" on page 663. 

 

This layout renders the slice and volume with color based on Hounsfield Units. Color rendering using 
Hounsfield Units gives you better control in highlighting anatomies with known Hounsfield Unit ranges.  
This button opens a pop-up menu from which you can select an existing Hounsfield Unit color scheme or edit 
the color mapping to create a new color scheme. 
Note: This layout is only available for scans imported using Dolphin Imaging version 11 or later. 
For more information, see "Using the Hounsfield Unit View" on page 649. 

Use these buttons to select the layout of the window. For more information, see "Layouts and Slices" on 
page 652. 

: 
Click this button to use the volume layout. In this layout, only the 3D volume or photograph 
appears in the window. 

: 
Click this button to use the 4 volume layout. In this layout, four views of the same volume 
appear in the window. 

: 

Click this button to use the 3+1 layout. In this layout, the window has four panes: three small 
panes on the left containing the sagittal, coronal, and axial slices, and one large pane on the 
right containing the 3D volume or photograph. 

Layout buttons 

: 
Click this button to use the 2x2 layout. In this layout, the window has four equal panes 
containing the sagittal slice, the coronal slice, the axial slice, and the 3D volume or photograph. 
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Use these buttons to view a standard slice rather than the 3D image in the window. For more information, 
see "Standard Slice Views" on page 657. 

: 
Click this button to view the sagittal slice. 

: 
Click this button to view the coronal slice. 

Slice buttons 

: 
Click this button to view the axial slice. 

 

Click this button to toggle the display of the slice location lines (cross-hairs) on the sagittal, coronal, and axial 
slices. This button is only available when you are using one of the standard slice views, the 3+1 layout, or 
the 2x2 layout. 

 
Click this button to select an x-ray to view in this window. This option is available only after you have built at 
least one x-ray type.  For more information, see Chapter 25. 

Show/Hide Slice 
buttons 

Use these buttons to show or hide planes indicating the standard slice locations on the 3D volume or 
photograph. For more information, see "Volume Layout" on page 653. 

  : Click this button to show or hide a plane indicating the location of the sagittal slice. 

  : Click this button to show or hide a plane indicating the location of the coronal slice. 

  : Click this button to show or hide a plane indicating the location of the axial slice. 

 
Click this button to return the sagittal, coronal, and axial slices to their standard locations after you have 
customized them. For more information, see "Changing the Angle of the Slice Views" on page 658 and 
"Changing the Slice Locations" on page 659. 

Rotation Sliders 

Use these sliders to rotate the image around the indicated axis: 
: Use this slider to rotate the 3D image horizontally. 
: Use this slider to rotate the 3D image circularly. 
: Use this slider to rotate the 3D image vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

Predefined Views Click one of these buttons to orient the 3D image in one of the predefined views. For more information, see 
"Moving or Reorienting the Image" on page 640. 
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: Click this button to orient the 3D image for a right view. 

  : Click this button to orient the 3D image for a right oblique view. 

  : Click this button to orient the 3D image for a front view. 

  : Click this button to orient the 3D image for a left oblique view. 

  : Click this button to orient the 3D image for a left view. 

  : Click this button to orient the 3D image for a back view. 

  : Click this button to orient the 3D image for a top view. 

  : Click this button to orient the 3D image for a bottom view. 

  : Click this button to orient the 3D image for an isometric view. 

  : Click this button to orient the 3D image for an isometric view. 

 
Click these arrow buttons to move the 3D image in the window in the indicated direction. For more 
information, see "Moving or Reorienting the Image" on page 640. 

  
Click this button to zoom in on the 3D image. For more information, see "Changing the Magnification" on 
page 640. 

  
Click this button to zoom out on the 3D image. For more information, see "Changing the Magnification" on 
page 640. 

  
Click this button to fit the 3D image in the window. For more information, see "Changing the Magnification" 
on page 640. 

The Menu Bar 
At the top of the Dolphin 3D window, there are several menus that you can use to access program features. This section 
describes each of these menus. 
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Some of the program features accessible from the menus are also accessible from buttons on Dolphin 3D window. 

The File Menu 
The following figure illustrates the File menu: 

 
The File menu contains the following choices: 

Save... Saves the 3D volume data. For more information, see "Saving an Image" on page 661. 
The data is saved either to your Dolphin database or to your external DICOM storage location, depending 
on your DICOM volume storage options. For more information, see "Setting DICOM Volume Storage 
Options" on page 670. 

Print... Prints your current view of the 3D volume data. For more information, see "Printing an Image" on page 664. 

Export DICOM... Saves the 3D volume data to your computer as one or more DICOM files. For more information, see "To 
export the 3D volume to one or more DICOM files" below. 

Export Volume 
as Surface... 

Creates an isosurface from the volume and exports it to a file for use with applications that can import and 
process an isosurface. For more information, see "Creating and Exporting an Isosurface" on page 666. 

Exit Exits from Dolphin 3D and returns you to the Dolphin Imaging main screen. 
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To export the 3D volume to one or more DICOM files: 

1. Select Export DICOM... from the File menu. 

Or, 

Click Export to DICOM on the Analysis/Verify Result tab of the Superimposition dialog box to export two superimposed 
volumes to a single DICOM data set. 

The DICOM Export dialog box opens. 

2. Specify any export options on this dialog box. 

3. Click Export Now. 

The export may take a few moments, and a progress bar appears that indicates the progress of the export. 

4. Click OK when the export completes. 

 

Compression Level Select the level of compression that you want use when saving these files from the drop-down list box. 

Location/File Prefix Enter the location where you want to save the files and the filename prefix you want to use in the text 
box. When the files are created, sequential numbering and a .DCM extension will be appended to the 
filename prefix you specify. By default, the patient's name is used as the filename prefix. 

Browse... Click this button to browse to the location where you want to save the files. 

Create DICOMDIR 
final in addition 

Check this box to create a DICOM directory file (DICOMDIR) that identifies the DICOM image files for 
the data set in addition to creating the DICOM image files.  
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Anonymize-Remove 
the name 

Check this box to remove the patient's name when saving the volume. 

Put Volume Into 
Single DICOM File 

Check this box to create a single DICOM file. 

Include Sculpting Check this box to save the files with any sculpting that you have applied to the volume. For more 
information, see "Sculpting the Volume" on page 877. 

Apply Orientation Check this box to save the files using your applied volume orientation. For more information, see 
"Orienting the Image" on page 675. 

The Edit Menu 
The following figure illustrates the Edit menu: 

 
The Edit menu contains the following choices: 

Copy to 
Clipboard 

Copies the image in the Dolphin 3D window to the clipboard. You can then paste the image into another 
program. For more information, see "Copying the Image to the Clipboard" on page 663. 

Export to 
File... 

Exports the image in the Dolphin 3D window to a file on your computer's file system. For more information, see 
"Exporting an Image" on page 663. 

Add to Script Adds the image in the Dolphin 3D window as a key frame in a movie script. For more information, see "Adding 
a Frame" on page 793. 
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The View Menu 
The following figure illustrates the View menu: 

 
The View menu contains the following choices: 

DICOM Header 
Information... 

Displays scan information for this 3D image, such as the patient name, scan source, and scan size. For 
more information, see below. 

Orientation 

Select the orientation that you want to use for the 3D volume from the cascade menu: 
� Right View: Orients the 3D image for a right view. 
� Right Oblique View: Orients the 3D image for a right oblique view. 
� Front View: Orients the 3D image for a front view. 
� Left Oblique View: Orients the 3D image for a left oblique view. 
� Left View: Orients the 3D image for a left view. 
� Back View: Orients the 3D image for a back view. 
� Top View: Orients the 3D image for a top view. 
� Bottom View: Orients the 3D image for a bottom view. 
� Right Isometric View: Orients the 3D image for a right isometric view. 
� Left Isometric View: Orients the 3D image for a left isometric view. 

For more information, see "Moving or Reorienting the Image" on page 640. 
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Zoom In Zooms in on the image. For more information, see "Changing the Magnification" on page 640. 

Zoom Out Zooms out from the image. For more information, see "Changing the Magnification" on page 640. 

Zoom volume to fit 
in window 

Changes the image magnification so that it fits in the Dolphin 3D window. For more information, see 
"Changing the Magnification" on page 640. 

Show/Hide Sagittal 
Plane Toggles the display of the sagittal plane. For more information, see "Volume Layout" on page 653. 

Show/Hide Coronal 
Plane Toggles the display of the coronal plane. For more information, see "Volume Layout" on page 653. 

Show/Hide Axial 
Plane Toggles the display of the axial plane. For more information, see "Volume Layout" on page 653. 

Restore View Plane 
Positions 

Returns all view planes (sagittal, coronal, and axial) to their default positions. For more information, see 
"Changing the Slice Locations" on page 659. 

Show All View 
Planes 

Displays all three view planes (sagittal, coronal, and axial) on the image. For more information, see 
"Volume Layout" on page 653. 

Hide All View Planes Suppresses the display of all three view planes (sagittal, coronal, and axial) on the image. For more 
information, see "Volume Layout" on page 653. 

Volume Views 

Select a view of the 3D image from the cascade menu: 
� Soft Tissue - Solid: The solid view of the patient's soft tissue. 
� Soft Tissue - Translucent: The translucent view of the patient's soft tissue. 
� Soft Tissue - 3D Photo: The 3D photo view of the patient's soft tissue. 
� Hard Tissue - Solid: The solid view of the patient's hard tissue. 
� Hard Tissue - Translucent: The translucent view of the patient's hard tissue. 
� Combined - Solid/Solid: The solid view of the patient's soft tissue combined with the solid 

view of the patient's hard tissue. 
� Combined - Solid/Translucent: The translucent view of the patient's soft tissue combined 

with the solid view of the patient's hard tissue. 
� Combined - Translucent/Translucent: The translucent view of the patient's soft tissue 

combined with the translucent view of the patient's hard tissue. 
� Combined - 3D Photo/Solid: The 3D photo view of the patient's soft tissue combined with 

the solid view of the patient's hard tissue. 
� Combined - 3D Photo/Translucent: The 3D photo view of the patient's soft tissue combined 

with the translucent view of the patient's hard tissue. 
For more information, see "Viewing the Soft Tissue" on page 635, "Viewing the Hard Tissue" on page 
637, and "Viewing Both the Soft and Hard Tissue" on page 639. 

Sh /Hid  T l  th  di l  f th  t  li  F   i f ti   "U i  th  S t  C li " 
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Symmetry Caliper on page 660. 

Show/Hide Nerve 
Canals on Hard 
Tissue 

Toggles the display of nerve canals on the patient's hard tissue image. For more information on viewing 
nerve canals, see "To view nerve canals on the patient's hard tissue image" on page 628. For 
information on marking the nerve canals, see "Building a Nerve Canals X-Ray View" on page 738. 

Volume Layout Changes the view to the volume layout. For more information, see "Volume Layout" on page 653. 

3+1 Layout Changes the view to the 3+1 layout. For more information, see "3+1 Layout" on page 655. 

2x2 Layout Changes the view to the 2x2 layout. For more information, see "2x2 Layout" on page 656 

Sagittal Slice Changes the view to the sagittal slice. For more information, see "Standard Slice Views" on page 657. 

Coronal Slice Changes the view to the coronal slice. For more information, see "Standard Slice Views" on page 657. 

Axial Slice Changes the view to the axial slice. For more information, see "Standard Slice Views" on page 657. 

To view DICOM header information for the image: 

1. Select DICOM Header Information... from the View menu. 

The Scan Information dialog box opens. 

2. Click OK to close the dialog box. 
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Name The name of the patient for this 3D image. 

Scan Source The source from which this 3D image was captured. 

Volume Size (Voxels) The size of this 3D image in voxels. 

Voxel Size (mm^3) The size of a voxel expressed in cubic millimeters. 

Original Scan Location The location where the originally-scanned DICOM file or set of files is stored.  

Copied to Dolphin 
Database 

Information on whether the volume was copied to the Dolphin database, the options used to copy it, 
and the size of the file.  

To view nerve canals on the patient's hard tissue image: 

1. Select Show/Hide Nerve Canals on Hard Tissue from the View menu. 

Or, 

Right-click the image, and select Show/Hide Nerve Canals on Hard Tissue. 

This menu item is only enabled if you have marked the patient's nerve canals. For more information, see "Building a 
Nerve Canals X-Ray View" on page 738. 
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The Options Menu 
The following figure illustrates the Options menu: 

 
The Options menu contains the following choices: 

Background Color... Sets the color used for the background in the window. For more information, see "Setting 
Colors" on page 649. 

Color: Soft Tissue - 3D 
Photo Mesh... 

Sets the color used for the mesh representation of the patient's 3D photograph. For more 
information, see "Setting Colors" on page 649. 

General Options... Sets general options for Dolphin 3D. For more information, see "Setting General Options" on 
page 673. 

The Tools Menu 
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The following figure illustrates the Tools menu: 

 
The Tools menu contains the following choices: 

Set Orientation... Sets the orientation of the 3D volume. For more information, see "Orienting the Image" on page 675. 

Build X-Rays... Builds radiographs based on the 3D volume. For more information, see Chapter 25. 

Digitize/Measure... Opens a window where you can digitize landmarks and take measurements on the 3D volume. For more 
information, see Chapter 26. 

Create/Use Script Opens a window where you can create and use a script to make Dolphin 3D movies For more 
information, see Chapter 27. 

Edit/Merge 3D 
Photo... 

Opens the Surface/Volume Superimposition dialog box so that you can superimpose the patient's 
photograph over the volume. For more information, see "Superimposing the Photo and the Volume" on 
page 690. 

Sinus/Airway  Opens the Sinus/Airway dialog box so that you can mark and analyze the patient's airway. For more 
information, see Chapter 28. 

Mirroring Opens the Mirroring Tool dialog box so that you can perform volume mirroring operations.  For more 
information, see "Volume Mirroring" on page 822. 

Superimposition Opens the Superimposition dialog box so that you can superimpose two volumes. For more information, 
see "Superimposing Volumes" on page 829. 

Implants Opens the 3D Implant Simulation dialog box so that you can superimpose two volumes. For more 
information, see Chapter 30, 

DICOM Volume 
Storage 

Opens a window where you can specify where you want to store the volume data for your patients. You 
can set this location for all future patients or for the current patient. For more information, see "Setting 
DICOM Volume Storage Options" on page 670. 
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The Help Menu 
The following figure illustrates the Help menu: 

 
The Help menu contains the following choices: 

Contents Opens the Table of Contents for the online help. 

Index Opens the Index for the online help. 

Using Help Accesses help on using the online help. 

Graphics Card 
Capabilities... 

Opens a window that provides detailed information about the graphics card installed on your 
computer. 

 

The Pop-up Menu 
The pop-up menu provides shortcuts to commonly-used Dolphin 3D features. 

To access the pop-up menu: 

1. Right-click the image in the Dolphin 3D window. 

The pop-up menu is displayed.  
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The pop-up menu contains the following choices: 

Close this Menu Closes the pop-up menu. 

Orientation 

Select the orientation that you want to use for the 3D volume from the cascade menu: 
� Right View: Orients the 3D image for a right view. 
� Right Oblique View: Orients the 3D image for a right oblique view. 
� Front View: Orients the 3D image for a front view. 
� Left Oblique View: Orients the 3D image for a left oblique view. 
� Left View: Orients the 3D image for a left view. 
� Back View: Orients the 3D image for a back view. 
� Top View: Orients the 3D image for a top view. 
� Bottom View: Orients the 3D image for a bottom view. 
� Right Isometric View: Orients the 3D image for a right isometric view. 
� Left Isometric View: Orients the 3D image for a left isometric view. 

For more information, see "Moving or Reorienting the Image" on page 640. 
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Zoom volume to fit 
window 

Changes the image magnification so that it fits in the Dolphin 3D window. For more information, see 
"Changing the Magnification" on page 640. 

Show All View Planes Displays all three view planes (sagittal, coronal, and axial) on the image. For more information, see 
"Volume Layout" on page 653. 

Hide All View Planes Hides all three view planes (sagittal, coronal, and axial) on the image. For more information, see 
"Volume Layout" on page 653. 

Show/Hide Symmetry 
Caliper 

Toggles the display of the symmetry caliper. For more information, see "Using the Symmetry Caliper" 
on page 660. 

Volume Views 

Select a view of the 3D image from the cascade menu: 
� Soft Tissue - Solid: The solid view of the patient's soft tissue. 
� Soft Tissue - Translucent: The translucent view of the patient's soft tissue. 
� Soft Tissue - 3D Photo: The 3D photo view of the patient's soft tissue. 
� Hard Tissue - Solid: The solid view of the patient's hard tissue. 
� Hard Tissue - Translucent: The translucent view of the patient's hard tissue. 
� Combined - Solid/Solid: The solid view of the patient's soft tissue combined with the solid 

view of the patient's hard tissue. 
� Combined - Solid/Translucent: The translucent view of the patient's soft tissue combined 

with the solid view of the patient's hard tissue. 
� Combined - Translucent/Translucent: The translucent view of the patient's soft tissue 

combined with the translucent view of the patient's hard tissue. 
� Combined - 3D Photo/Solid: The 3D photo view of the patient's soft tissue combined with 

the solid view of the patient's hard tissue. 
� Combined - 3D Photo/Translucent: The 3D photo view of the patient's soft tissue 

combined with the translucent view of the patient's hard tissue. 
For more information, see "Viewing the Soft Tissue" on page 635, "Viewing the Hard Tissue" on page 
637, and "Viewing Both the Soft and Hard Tissue" on page 639. 

Show/Hide Nerve 
Canals on Hard Tissue 

Toggles the display of nerve canals on the patient's hard tissue image. For more information on 
viewing nerve canals, see "To view nerve canals on the patient’s hard tissue image" on page 628. 
For information on marking the nerve canals, see "Building a Nerve Canals X-Ray View" on page 
738. 

Add to End of Script Adds the image in the Dolphin 3D window as a key frame at the end of a movie script. For more 
information, see "Adding a Frame" on page 793. 

Replace Highlighted 
Script Frame 

Replaces the selected frame in your script with a new frame. For more information, see "Adding a 
Frame" on page 793. 

Copy to Clipboard Copies the image in the Dolphin 3D window to the clipboard. You can then paste the image into 
another program. For more information, see "Copying the Image to the Clipboard" on page 663. 
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Export to File... Exports the image in the Dolphin 3D window to a file on your computer's file system. For more 
information, see "Exporting an Image" on page 663. 

Print... Prints your current view of the 3D volume data. For more information, see "Printing an Image" on 
page 664. 

Save... Saves the 3D volume data. For more information, see "Saving an Image" on page 661. 
The data is saved either to your Dolphin database or to your external DICOM storage location, 
depending on your DICOM volume storage options. For more information, see "Setting DICOM 
Volume Storage Options" on page 670. 

Full Window Maximizes the image so that it takes up your entire computer screen. Select this option again to 
return the image to its initial size. For more information, see "Changing the Magnification" on page 
640. 

Set Volume Orientation 
to Current Slice 
Orientations 

Sets the volume orientation to match the orientation of the slice you are currently viewing. For more 
information, see "Moving or Reorienting the Image" on page 640. 

Save Volume 
Orientation... 

Saves the current volume orientation so that you can restore it later. For more information, see 
"Moving or Reorienting the Image" on page 640. 

Restore Volume 
Orientation... 

Restores a previously-saved volume orientation. For more information, see "Moving or Reorienting 
the Image" on page 640. 

Configuring the View 
The Dolphin 3D window offers several features that you can use to configure your view of the 3D image and/or photograph (if 
available). You can: 

• view the soft tissue, hard tissue, or both 

• move and reorient the image in the window 

• change the colors of the background or soft tissue mesh view 

• identify the segment of the volume data to use for the soft tissue and hard tissue views 

• change the magnification 

• view various window layouts and volume slices 

These features are described in detail below. 
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Viewing the Soft Tissue 

To use the solid soft tissue view: 

1. Select the Soft Tissue radio button. Then, select the Solid radio button. 

Or, 

Select Volume Views from the View menu. Then, select Soft Tissue - Solid from the cascade menu. 

Or, 

Right-click the image and select Volume Views from the pop-up menu. Then, select Soft Tissue - Solid from the 
cascade menu. 

2. Optionally, select the multi-color solid rendering template to use from the drop-down list box. 

For more information on multi-color solid rendering templates, see "Segmenting Solid Hard and Soft Tissues" on page 
641. 

3. Optionally, adjust the Seg slider to set the segmentation for the soft tissue view. 

Or, 

Click Edit... to open the Solid Volume Segmentation window and set the segmentation for the soft tissue view. 

By segmenting the 3D image, you identify the parts of the 3D image data to use for the soft tissue view. 

Using the slider, you identify the range of tissue densities for the patient's soft tissue. As you adjust the slider, the 
image in the main window changes to reflect the currently-selected image segment. 

 
When segmenting soft tissue, you identify the lower and upper density values in the range you want to use. For 
example, the lower boundary may identify the transition between the air and the patient's soft tissue. The upper 
boundary may identify the transition between the patient's soft tissue and hard tissue. 

The Solid Volume Segmentation window offers advanced options for segmenting the image. For information on using 
these options, see "Segmenting the Image" on page 641. 

To use the photo soft tissue view: 

1. Select the Soft Tissue radio button. Then, select the Photo: 2D/3D radio button. 

Or, 

Select Volume Views from the View menu. Then, select Soft Tissue - 3D Photo from the cascade menu. 

Or, 

Right-click the image and select Volume Views from the pop-up menu. Then, select Soft Tissue - 3D Photo from the 
cascade menu. 
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2. Optionally, select the photo that you want to use from the Type drop-down list box. 

You can have up to two photos for each volume. 

3. Optionally, check the Mesh box to use a mesh representation based on the patient's photo instead of the actual photo. 

If you use the mesh representation, you can also set the color for it. For more information, see "Setting Colors" on 
page 649. 

To use the translucent soft tissue view (available only on computers that support advanced 3D rendering): 

1. Select the Translucent radio button in the Soft-Tissue group box to view a translucent representation of the soft tissue. 

Or, 

Select Volume Views from the View menu. Then, select Soft Tissue - Translucent from the cascade menu. 

Or, 

Right-click the image and select Volume Views from the pop-up menu. Then, select Soft Tissue - Translucent  from the 
cascade menu. 

2. Optionally, adjust the Seg slider to set the segmentation for this translucent soft tissue view. 

Using the slider, you identify the range of tissue densities for the patient's soft tissue for this translucent soft tissue 
view. As you adjust the slider, the image in the main window changes to reflect the currently-selected image segment. 

 
When segmenting soft tissue, you identify the lower and upper density values in the range you want to use. For 
example, the lower boundary may identify the transition between the air and the patient's soft tissue. The upper 
boundary may identify the transition between the patient's soft tissue and hard tissue.  

The translucent view can enable you to see structures that might otherwise be difficult to see. The following figure illustrates the 
same patient image in the solid soft-tissue view and in the translucent soft-tissue view. 
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Viewing the Hard Tissue 

To use the solid hard tissue view: 

1. Select the Hard Tissue radio button. Then, select the Solid radio button. 

Or, 

Select Volume Views from the View menu. Then, select Hard Tissue - Solid from the cascade menu. 

Or, 

Right-click the image and select Volume Views from the pop-up menu. Then, select Hard Tissue - Solid from the 
cascade menu. 

2. Optionally, select the multi-color solid rendering template to use from the drop-down list box. 

For more information on multi-color solid rendering templates, see "Segmenting Solid Hard and Soft Tissues" on page 
641. 

3. Optionally, adjust the Seg slider to set the segmentation for the hard tissue view. 

Or, 

Click Edit... to open the Solid Volume Segmentation window and set the segmentation for the hard tissue view. 

By segmenting the 3D image, you identify the parts of the 3D image data to use for the hard tissue view. 

Using the slider, you identify the range of tissue densities for the patient's hard tissue. As you adjust the slider, the 
image in the main window changes to reflect the currently-selected image segment. 
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When segmenting hard tissue, you identify the lower and upper density values in the range you want to use. For 
example, the lower boundary may identify the transition between the patient's soft tissue and hard tissue. 

The Solid Volume Segmentation window offers advanced options for segmenting the image. For on using these 
options, see "Segmenting the Image" on page 641. 

To use the translucent-hard tissue view (available only on computers that support advanced 3D rendering): 

1. Select the Hard Tissue radio button. Then, select the Translucent radio button. 

Or, 

Select Volume Views from the View menu. Then, select Hard Tissue - Translucent from the cascade menu. 

Or, 

Right-click the image and select Volume Views from the pop-up menu. Then, select Hard Tissue - Translucent from the 
cascade menu. 

2. Optionally, adjust the Seg slider to set the segmentation for this translucent hard tissue view. 

3. Optionally, adjust the Trans slider to adjust the transparency of the translucent hard tissue view. 

The translucent view can enable you to see structures that might otherwise be difficult to see, such as impacted teeth or 
implants. The following figure illustrates the same patient image in the solid hard-tissue view and in the translucent hard-tissue 
view. 
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Viewing Both the Soft and Hard Tissue 

To view both the soft and hard tissue: 

1. Select the Combined Soft Tissue + Hard Tissue radio button. 

Or, 

Select Volume Views from the View menu. Then, select Combined - Solid/Solid to view the soft tissue solid view with 
the hard tissue solid view. 

Or, 

Select Volume Views from the View menu.  Then, select Combined - Solid/Translucent to view the soft tissue 
translucent view with the hard tissue solid view. 

Or, 

Select Volume Views from the View menu.  Then, select Combined - Translucent/Translucent to view the soft tissue 
translucent view with the hard tissue translucent view. 

Or, 

Select Volume Views from the View menu.  Then, select Combined - 3D Photo/Solid to view the soft tissue photo view 
with the hard tissue solid view. 

Or, 

Select Volume Views from the View menu.  Then, select Combined - 3D Photo/Translucent to view the soft tissue 
photo view with the hard tissue translucent view. 

Or, 

Right-click the image and select Volume Views from the pop-up menu. Then, select Combined - Solid/Solid to view the 
soft tissue solid view with the hard tissue solid view. 

Or, 

Right-click the image and select Volume Views from the pop-up menu. Then, select Combined - Solid/Translucent to 
view the soft tissue translucent view with the hard tissue solid view. 

Or, 

Right-click the image and select Volume Views from the pop-up menu. Then, select Combined - 
Translucent/Translucent to view the soft tissue translucent view with the hard tissue translucent view. 

Or, 

Right-click the image and select Volume Views from the pop-up menu. Then, select Combined - 3D Photo/Solid to view 
the soft tissue photo view with the hard tissue solid view. 

Or, 

Right-click the image and select Volume Views from the pop-up menu. Then, select Combined - 3D Photo/Translucent 
to view the soft tissue photo view with the hard tissue translucent view. 

2. Optionally, adjust the Trans slider to adjust the overall transparency of the image. 

3. Optionally, set options for the hard tissue view in the Hard-Tissue group box. 

For more information, see "Viewing the Hard Tissue" on page 637. 
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4. Optionally, set options for the soft tissue view in the Soft-Tissue group box. 

For more information, see "Viewing the Soft Tissue" on page 635. 

Changing the Magnification 

To change the magnification: 

1. Click   or press F2 to zoom in. 

Or, 

Click  or press F3 to zoom out. 

Or, 

Click  or press F4 to fit the image to the window. 

Or, 

Select Zoom In from the View menu to zoom in. 

Or, 

Select Zoom Out from the View menu to zoom out. 

Or, 

Select Zoom Volume to Fit in Window from the View menu to fit the image to the window. 

Or, 

Right-click the image, and select Zoom volume to fit window from the pop-up menu. 

Or,  

Hold down the CTRL key while clicking and dragging the mouse to change the magnification. 

To maximize the image so that it takes up your entire computer screen: 

1. Right-click the image, and select Full Window from the pop-up menu. 

Select this option again to return the image to its initial size. 

Moving or Reorienting the Image 

To move the image in the window: 

1. Click one of the arrow buttons to move the image in the indicated direction. 

Or, 

Hold down the SHIFT key while clicking and dragging the image within the window. 
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To change the orientation of the image: 

1. Click the button for one of the predefined views to orient the image for that view. 

Or, 

Select one of the predefined views from the View menu. 

Or, 

Right-click the image, and select Orientation from the pop-up menu. Then, select one of the predefined views from the 
cascade menu. 

Or, 

Click and drag one of the sliders to rotate the image around the indicated axis. 

Or, 

Click and drag the image to rotate it. 

If you are currently viewing the sagittal, coronal, or axial slice, you can set the volume's orientation to match the orientation of the 
slice you are viewing.  

To set the volume orientation to match the slice orientation:  

1. Right-click the slice view, and select Set Volume Orientation to Current Slice Orientations from the pop-up menu. 

Segmenting the Image 

Segmenting Solid Hard and Soft Tissues 
Using the advanced multi-color solid rendering feature, you can display the 3D volume with different colors representing different 
tissue densities. Dolphin 3D includes several tissue segmentation templates that you can modify as needed to create your own 
custom view. 

To access the tissue segmentation templates: 

1. In the Soft Tissue group box, click Solid, and select <Templates. . .> from the drop-down menu. 
 
Or, 
 
In the Hard Tissue group box, click Solid and select <Templates..> from the drop-down menu. 

The Solid Tissue Segmentation Templates dialog box opens: 
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2. Click the template you want to use, and click OK. 

The image is displayed in the main 3D window using the template you selected. You can now accept the current view 
or modify it, using the advanced multi-color solid rendering feature. 

Segmenting the Image 
By segmenting the 3D image, you identify the parts of the 3D image data to use for the soft tissue and hard tissue views. 
Circumstances in which you may want to segment the image include: 

• The first time you load a new 3D image, you may want to segment the image differently than Dolphin 3D does using 
automatic segmentation. 

• When you are using a clipping box, you may want to segment the image to suppress the display of some of the soft 
tissue or hard tissue image so that you can see interior structures. For more information on clipping boxes, see "Using 
a Clipping Box" on page 871. 

• When you want to display the 3D volume with different colors representing different tissue densities (advanced). 

To segment the image using the default setting: 

1. Click Edit... in the Soft-Tissue group box on the Dolphin 3D main window to identify the soft tissue image segment. 

Or, 

Click Edit... in the Hard-Tissue group box on the Dolphin 3D main window to identify the hard tissue image segment. 

The Solid Volume Segmentation dialog box opens. 

2. Move the arrow on the left of the slider to identify the lowest density level for tissue in this image segment. 
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To move the arrow, you can: 

� Click and drag the arrow. 

� Click the up- or down-arrow at the end of the slider to move the arrow along the slider by a small, predefined 
increment. 

� Hold down the CTRL key while clicking the up- or down-arrow at the end of the slider to move the arrow along the 
slider by a larger predefined increment. 

When segmenting soft tissue, the arrow on the left of the slider identifies the boundary between the air and the 
patient's soft tissue. When segmenting hard tissue, this arrow identifies the boundary between the patient's soft tissue 
and hard tissue. As you move the arrow along the slider, the image in the main window changes to reflect the 
currently-selected image segment. 

3. Move the arrow on the right of the slider to identify the highest density level for tissue in this image segment. 

When segmenting soft tissue, the arrow on the right of the slider identifies the boundary between the soft tissue and 
hard tissue. When segmenting hard tissue, you may want to include all densities greater than the patient's soft tissue 
(so that implants appear on the patient's hard tissue image, for example).  

4. When the image in the main window accurately reflects the segment you are identifying (the soft tissue segment looks 
like the patient’s face or the hard tissue segment looks like the patient’s bone structure), click OK to save the 
segmentation data. 

Or, 

Click Save to save these segmentation settings as your defaults. 

 
 

Slider (Default setting only) Move the arrows on the left and right to change the boundaries of the selected segment. 
Click the up and down arrows at the ends of the slider to fine-tune the selection. 
The label above the slider identifies the range and percentage of the 3D image currently selected for the 
segment. 

Numbered 
Tabs 

The Default setting provides one tab only. This tab shows the density histogram and the predefined area of 
interest. When using multi-color solid rendering (advanced) you can add more sections, which adds more tabs. 
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ALL 1-x  
Tab 

Click to view all sections simultaneously. This tab is not available if you are using the default setting. 

Lighting Click this tab to set the lighting options for this image. See "Setting Solid Volume Lighting Options" on page 648 
for more information. 

Add Click to add a new section. 

Remove Click to remove a section 

Save Click to save these rendering settings so they are available for you to use on other patient images. 

Select Click to select a previously-saved rendering setting. 

Default 
Color 

Click the color sample to set the color for the default soft tissue view.  

Log(y) Check this box to re-display the density distribution using a logarithmic scale for the y-axis. Used for cases 
where the density distribution has some large spikes, which cause the rest of the distribution to appear very flat.  
For example, suppose the density distribution of your image consisted mostly of values between 1 and 100, but 
it also had value spikes of 4050 and 4080. In a density distribution graph using the default linear scaling for the 
y-axis, the chart would appear very flat. Changing to a logarithmic scale for the y-axis would have the effect of 
placing more visual emphasis on the lower values (1-100) than on the higher values (3000-4000), lessening the 
impact of the value spikes on the shape of the graph. 
This option affects the display of the density distribution only. It does not make any changes to the actual 
volume. 

 Zoom in on the density histogram. 

 Zoom out on the density histogram. 

 View the full density histogram. 

Smoothness Choose a volume from this drop-down list box to set the smoothness of the volume rendering. Choosing a high 
smoothness setting gives the volume rendering a smooth, metallic look. This setting can greatly improve the 
rendering appearance for noisy scans. 
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To segment the image using multi-color solid rendering (advanced) 

1. In either the Soft Tissue group box or the Hard Tissue group box, select a template other than Default from the drop-
down list box. 
 
Or, 
 
In either the Soft Tissue group box or the Hard Tissue group box, select <Templates..> from the drop-down list box to 
see thumbnails of the available templates. Then select the template you want to use and click OK. 

2. Click Edit... in the Soft-Tissue group box on the Dolphin 3D main window to identify the soft tissue image segment. 

Or, 

Click Edit... in the Hard-Tissue group box on the Dolphin 3D main window to identify the hard tissue image segment. 

The Solid Volume Segmentation dialog box opens (the Hard Tissue Solid Volume Segmentation dialog box is shown in 
the figure below): 

 
You can enlarge the window or zoom in or out until you get the desired view of the density histogram. The density 
histogram graphically represents the data density within the 3D image. 

The area of interest lies within the predefined section as shown in the figure above. The section includes points and 
color points. You can move the points to change the section of interest, and you can add, remove, or change the color 
points until you achieve the desired results on your image.  You can also move the lines to section off an area of more 
or less density. 
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To add a new image section: 

1. Click Add. 
 
A new tab opens on the dialog box, and the image changes to reflect the default color.  You can now customize that 
section using the lines, points, and color points. Once you add additional tabs, the ALL tab appears. 
 

 

To view all sections simultaneously: 
1. Click the ALL tab. 

To remove an image section: 

1. Click the tab for the image section you want to remove. Then, click Remove. 

Or, 

Right-click a line for the image section you want to remove, either on the tab for that image section or on the ALL tab. 
 Then, select Remove the Whole Section from the pop-up menu. 

2. On the confirmation dialog box that appears, click Yes to remove the image section. 

Or, 

Click No to cancel the removal. 

To change the opacity of an image section: 

1. Click and drag the horizontal line up to increase the opacity of the image section. 

Or, 

Click and drag the horizontal line down decrease the opacity of the image section. 

To change the area defined by this section 

1. Click and drag the left and/or right vertical line. 

To change the color of an image section: 

1. Right-click a line for the image section you want to change, either on the tab for that image section or on the ALL tab. 
 Then, select Change Color for the Whole Section from the pop-up menu. 

2. On the Color dialog box that appears, select the color that you want to use. 
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To change the area of interest: 
1. Click and drag one of the points on the line. 

The angle of the line changes, thus changing the area of interest. 

To change the color of a point: 

1. Right-click the point you want to change. 

2. Select Change Color for the Selected Point from the pop-up menu. 

Or, 

Select Change Color for the Selected Color Point from the pop-up menu. 

3. On the Color dialog box that appears, select the color that you want to use. 

To change the Hounsfield Units (HU) value for a point (applies only to volumes imported with Dolphin Imaging version 
11 or later):  

1. Right-click the point you want to change. 

2. Select Change HU Value for the Selected Curve Point from the pop-up menu. 

Or, 

Select Change HU Value for the Selected Color Point from the pop-up menu. 

3. Enter the HU value between -1000 and 18809, and click OK.   

The selected point moves to the specified HU value on the x-axis of the histogram.   

To add a color point: 

1. Right-click the location on a line where you want to add a color point. 

2. Select Add a Color Point from the pop-up menu. 

3. On the Color dialog box that appears, select the color that you want to use. 

To remove a color point: 

1. Right-click the color point you want to remove. 

2.  Select Remove the Selected Color Point from the pop-up menu. 
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Setting Solid Volume Lighting Options 

To set solid volume lighting options for a specific image: 

1. Select the Lighting... tab from the Hard or Soft Tissue Solid Volume Segmentation dialog box. 

2. Set any options, and click OK to use those options in your current session. 

 

Ambient Move this slider to adjust the level of ambient lighting used in the image. 

Diffuse Move this slider to adjust the level of diffuse lighting used in the image. 

Specular Move this slider to adjust the level of specular lighting used in the image. Specular lighting gives the image a 
reflective or mirror-like appearance.  

Shininess Move this slider to adjust the level of shininess of the image surface.  

Brightness Move this slider to adjust the level of brightness of the image. 

Use Depth 
Cueing 

Check this box to use depth cueing, and move this slider to adjust the depth cueing level. Depth cueing affects 
the shading used to give the image a three-dimensional appearance. 

Reset Click this button to reset all options to the factory defaults. 
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Setting Colors 

To set the color for the mesh view: 

1. Click the color sample next to Mesh in the Soft Tissue group box to set the color to use for the mesh representation of 
the patient's photograph. 

Or, 

Select Color: Soft Tissue - 3D Photo Mesh... from the Options menu to set the color to use for the mesh representation 
of the patient's photograph. 

The Color dialog box opens. 

2. Select the color you want to use. Then, click OK. 

To set the background color: 

1. Select Background Color... from the Options menu. 

The Color dialog box opens. 

2. Select the color you want to use. Then, click OK. 

Using the Hounsfield Unit View 
This layout renders the slice and volume with color based on Hounsfield Units. Color rendering using Hounsfield Units gives you 
better control in highlighting anatomies with known Hounsfield Unit ranges. You can define and save several Hounsfield Unit 
color mappings as described below. 
Note: This layout is only available for scans imported using Dolphin Imaging version 11 or later. 

To toggle the Hounsfield Unit rendering: 

1. Click . 

When you enable Hounsfield Unit rendering with this button, Dolphin 3D uses the color mapping you used last. If you 
have defined more than one mapping, you can select the mapping you want to use. 

To select a Hounsfield Unit color mapping to use: 
1. Click the arrow below the Show/Hide Hounsfield Rendering button, as illustrated below: 

 
2. Select a previously-saved Hounsfield Unit color mapping from the pop-up menu. 
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To edit the Hounsfield Unit color mapping: 
1. Click the arrow below the Show/Hide Hounsfield Rendering button, as illustrated below: 

 
2. Select Edit Current Hounsfield Unit Colors... from the pop-up menu. 

The Hounsfield Unit Color Mapping dialog box opens. As shown in the figure below, the Hounsfield Unit distribution 
includes color points that define the colors to use on the volume rendering for specific Hounsfield Unit values. You can 
add, remove, or change the color points until you achieve the desired results on your image. 

 

Smooth 
Transition Check this box to use a smooth gradient transition between the colors used in the mapping. 

Log(y) 

Check this box to re-display the Hounsfield Unit distribution using a logarithmic scale for the y-axis. Used for 
cases where the Hounsfield Unit distribution has some large spikes, which cause the rest of the distribution to 
appear very flat.  
For example, suppose the Hounsfield Unit distribution of your image consisted mostly of values between 1 and 
100, but it also had value spikes of 4050 and 4080. In a Hounsfield Unit distribution graph using the default linear 
scaling for the y-axis, the chart would appear very flat. Changing to a logarithmic scale for the y-axis would have 
the effect of placing more visual emphasis on the lower values (1-100) than on the higher values (3000-4000), 
lessening the impact of the value spikes on the shape of the graph. 
This option affects the display of the Hounsfield Unit distribution only. It does not make any changes to the actual 
volume. 

Save... Click this button to save this color mapping to your database. 

Remove... Click this button to remove this color mapping from your database. 

HU Displays the Hounsfield Unit value represented by the location on the distribution to which the mouse is currently 
pointing. 
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To set Hounsfield Unit values for a color point: 

1. Right-click a point on the line at the top of the Hounsfield Unit distribution, and select Change HU value from the pop-
up menu. 

2. Enter a Hounsfield Unit value on the dialog box that appears, and click OK. 

Alternatively, you can click and drag points on the line at the top of the Hounsfield Unit distribution to define the colors to use for 
specific Hounsfield Unit values. 

To change the color of a point: 

1. Right-click the point you want to change. 

2. Select Change Color from the pop-up menu. 

3. On the Color dialog box that appears, select the color that you want to use. 

To add a color point: 

1. Right-click the location on a line where you want to add a color point. 

2.  Select Add New HU Color Point from the pop-up menu. 

To remove a color point: 

1. Right-click the color point you want to remove. 

2.  Select Delete HU Color Point from the pop-up menu. 

To save the current mapping in your database: 

1. Click Save.... 

The Hounsfield Unit Color Mapping Name dialog box opens. 

2. Select one of the previously-saved mappings from the list box to replace it with your new mapping. 

Or, 

Enter a name in the text box to save your mapping with a new name. 

3. Click OK. 

To remove a mapping from your database: 

1. Click Remove.... 

The Hounsfield Unit Color Mapping Name dialog box opens. 

2. Select the mapping you want to remove from the list box, and click Remove. 
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3. Click Yes on the confirmation dialog box that appears. 

4. Click OK. 

Layouts and Slices 
The Dolphin 3D main window offers the following layouts: 
volume layout Only the 3D volume or photograph appears in the window.  

4 volume layout The window has four equal panes containing four views of the same volume. 

3+1 layout The window has four panes: three small panes on the left containing the sagittal, coronal, and axial 
slices, and one large pane on the right containing the 3D volume or photograph. 

2x2 layout The window has four equal panes containing the sagittal slice, the coronal slice, the axial slice, and 
the 3D volume or photograph. 

The Dolphin 3D main window also offers views of the three standard slices (sagittal, coronal, and axial). 

To use a different layout: 

1. Click  to use the volume layout. 

Or, 

Select Volume Layout from the View menu to use this layout. 

Or, 

Click  to use the 4 volume layout. 

Or, 

Click  to use the 3+1 layout. 

Or, 

Select 3+1 Layout from the View menu to use this layout. 

Or, 

Click  to use the 2x2 layout. 

Or, 

Select 2x2 Layout from the View menu to use this layout. 
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Volume Layout 
In this layout, only the 3D volume or photograph appears in the window. You also can view planes representing the three 
standard slices on the volume. 

To toggle display of planes representing the slices: 

1. Click  to show or hide a plane representing the sagittal slice. 

Or, 

Click  to show or hide a plane representing the coronal slice. 

Or, 

Click  to show or hide a plane representing the axial slice. 

Or, 

Select Show/Hide Sagittal Plane from the View menu to show or hide a plane representing the sagittal slice. 

Or, 

Select Show/Hide Coronal Plane from the View menu to show or hide a plane representing the coronal slice. 

Or 

Select Show/Hide Axial Plane from the View menu to show or hide a plane representing the axial slice. 

Or, 

Right-click the image and select Show All View Planes to show planes representing the sagittal, coronal, and axial 
slices. 

Or, 

Right-click the image and select Hide All View Planes to hide the planes representing the sagittal, coronal, and axial 
slices. 

The following figure illustrates an image with all three slices displayed. The planes are color coded as follows: 

Red Sagittal slice 

Green Coronal slice 

Blue Axial slice 

Note: Depending on the orientation of the image, the slices may appear as lines rather than three-dimensional planes. 
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4 Volume Layout 
In this layout, the window has four panes containing different views of the same volume so all the segmentation, clipping slice, 
sculpting, rendering scheme, and other settings will be applied to all volume views. Initially, the four volume views are oriented as 
depicted on the button.  However, you can change the orientation of each volume view independently.   
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3+1 Layout 
In this layout, the window has four panes: three small panes on the left containing the sagittal, coronal, and axial slices, and one 
large pane on the right containing the 3D volume, photograph, or two superimposed volumes. 

 
slice 
location 
lines 

The slice images use lines with the following color coding to identify the location of the three standard 
slices: 
Red: Sagittal slice 
Green: Coronal slice 
Blue: Axial slice 
You can click and drag these lines to change the location of the slices. For more information, see 
"Changing the Slice Locations" on page 659. 

slider Move the slider to change the location of the slice shown in this pane. For more information, see "Changing 
the Slice Locations" on page 659. 

drop-down 
list box 

Select the thickness of the slice from this drop-down list box. 

WL Adjusts the window leveling, which affects the apparent brightness and contrast of the image display. 
Changing the window leveling does not change any image files. For more information on window leveling, 
see "Setting Window Leveling" on page 768. 

--> Click this button to move the image in this pane to the large pane. 
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To move an image from a small pane to the large pane: 

1. Click --> under the image that you want to view in the large pane. 

The image in the large pane is swapped with the image you moved. 

To toggle the display of the slice location lines (cross-hairs) on the sagittal, coronal, and axial slices: 

1. Click . 

2x2 Layout 
In this layout, the window has four equal panes containing the sagittal slice, the corona slice, the axial slice, and the 3D volume, 
photograph, or two superimposed volumes. 

 
slice 
location 
lines 

The slice images use lines with the following color coding to identify the location of the three standard 
slices: 
Red: Sagittal slice 
Green: Coronal slice 
Blue: Axial slice 
You can click and drag these lines to change the location of the slices. For more information, see 
"Changing the Slice Locations" on page 659. 

slider Move the slider to change the location of the slice shown in this pane. For more information, see "Changing 
the Slice Locations" on page 659. 
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drop-down 
list box 

Select the thickness of the slice from this drop-down list box. 

WL Adjusts the window leveling, which affects the apparent brightness and contrast of the image display. 
Changing the window leveling does not change any image files. For more information on window leveling, 
see "Setting Window Leveling" on page 768. 

To toggle the display of the slice location lines (cross-hairs) on the sagittal, coronal, and axial slices: 

1. Click . 

Standard Slice Views 
In the Dolphin 3D main window, you can view radiograph representations of the sagittal, coronal, and axial slices. You can also 
customize these slices to change the cross-section of the volume that they display. 

To view one of the standard slices: 

1. Click  to view the sagittal slice. 

Or, 

Click  to view the coronal slice. 

Or, 

Click  to view the axial slice. 

The slice you selected appears in the window. The following figure illustrates the sagittal slice. 
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slice 
location 
lines 

The slice images use lines with the following color coding to identify the location of the three standard 
slices: 
Red: Sagittal slice 
Green: Coronal slice 
Blue: Axial slice 
You can click and drag these lines to change the location of the slices. For more information, see 
"Changing the Slice Locations" on page 659. 

slider Move the slider to change the location of the slice shown in this pane. For more information, see "Changing 
the Slice Locations" on page 659. 

WL Adjusts the window leveling, which affects the apparent brightness and contrast of the image display. 
Changing the window leveling does not change any image files. For more information on window leveling, 
see "Setting Window Leveling" on page 768. 

To toggle the display of the slice location lines (cross-hairs) on the sagittal, coronal, and axial slices: 

1. Click . 

Changing the Angle of the Slice Views 

To change the slice angle and thickness: 
1. Click any of the layout or slice buttons: 

        

2. Click the Show/Hide Slice buttons  to show the three planes on the 3D volume or photograph. 

The sagittal slice view is shown below, and all three planes are shown on the 3D volume on the right. 
 

  

3. Move the mouse into the upper-right corner of the view you selected.  

A small white circular arrow appears. 
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4. Click and move the mouse, and the image moves, thus enabling you to select the angle of the slice. 

5. Use the drop-down list box to the right of the slider to change the slice thickness. 

To reset the slices to their default angles: 

1. Click . 

Or, 

Select Restore View Plane Positions from the View menu. 

Changing the Slice Locations 
Changing the slice locations enables you to quickly and easily view a radiograph image for a different cross-section of the 
volume. 

To change the location of the slice you are viewing: 

1. Move the slider under the slice image. 

The image for that slice changes to reflect new location of the slice. In addition, the color-coded lines indicating the 
location of that slice on the other two slice images change to reflect its new location. 

For example, if you move the slider under the sagittal slice image, that image changes to show a different cross-
section of the volume. In the Coronal and Axial Slice images, the red line also changes to indicate the new location of 
the sagittal slice. 

To change the location of a slice other than the one you are viewing: 

1. Click and drag the line representing that slice on the image you're viewing. 

Click and drag when your mouse pointer turns into a double-headed arrow. 

For example, on the sagittal slice image, click and drag the green line to change the coronal slice location or the blue 
line to change the axial slice location. 

To reset the slices to their default locations: 

1. Click . 

Or, 

Select Restore View Plane Positions from the View menu. 
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Viewing X-rays 
After you have built at least one x-ray type, you can easily view the available x-rays (except the slice montage views) without 
opening the Build X-Rays tool window. This layout also enables you to include x-rays in movie scripts (see Chapter 27). 

To view an x-ray: 

1. Click . 

2. Select the x-ray type you want to view. 

The selected x-ray appears. 

If an x-ray type is disabled on the menu, that x-ray has not been built yet. For more information, see Chapter 25. 

To return to the volume view: 

1. Click . 

Using the Symmetry Caliper 
The symmetry caliper can help you assess facial and skeletal asymmetry. When displayed, the symmetry caliper appears 
centered on the line representing a vertical plane on the current view. For example, in the front, back, top, and bottom views, the 
symmetry caliper is centered on the mid-sagittal plane. In the lateral views, the symmetry caliper is centered on the coronal 
plane. You can position the symmetry caliper at various locations on the patient's image so you can see whether the patient's 
image is symmetrical relative to the vertical plane in the current view. 

To toggle display of the symmetry caliper: 

1. Select Show/Hide Symmetry Caliper from the View menu on the Dolphin 3D window. 

Or, 

Right-click the image on the Dolphin 3D window and select Show/Hide Symmetry Caliper from the pop-up menu. 

Or, 

Check the Show Symmetry Caliper box on the Orientation Calibration dialog box. 

Or, 

Check the Show Caliper box on the Superimposition dialog box.  

For information on the Orientation Calibration dialog box, see "Orienting the Image" on page 675. For information on 
the Volume/Volume Superimposition dialog box, see "Superimposing Volumes" on page 829. 
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To resize the symmetry caliper: 

1. Click and drag one end of the symmetry caliper to resize it. 

Or, 

If you are using the symmetry caliper on the Orientation Calibration dialog box, select the length of the symmetry 
caliper from the drop-down list box. 

A label next to the symmetry caliper indicates its length. 

To relocate the symmetry caliper: 

1. Click and drag the symmetry caliper to change its location on the patient's image. 

Click and drag when your mouse pointer turns into a double-headed arrow.  

Saving an Image 
When you finish working with an image, you should save the 3D volume data. You may also want to save the 3D volume data 
periodically when working with it to make sure your changes are not lost in case of a system failure. 
The data is saved either to your Dolphin database or to your external DICOM storage location, depending on your DICOM 
volume storage options. For more information, see "Setting DICOM Volume Storage Options" on page 670. 

To save an image to the database: 

1. Click Send Snapshot.... Then, select Save To Dolphin Layout/Database. 

Or, 

Select Save... from the File menu. 

Or, 

Right-click the image and select Save... from the pop-up menu. 

2. Optionally, change to a different image layout as described below. 

3. Click a slot in the image layout to save the image in that slot. 

4. Optionally, enter a new image slot title to use for the 3D image in the Image Title text box. 

5. Click Save... 
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Image Layout Displays the currently-selected image layout. Click a slot in the layout to save the 3D image in that slot. 

Image Title Enter an image title to use for the 3D image. Initially, this field contains the title defined in the image layout for 
the selected image slot. 

Change 
Layout... Click this button to select a different image layout. 

Save... Click this button to save the 3D image in the selected image slot in the selected layout. 

To choose a different image layout: 

1. Click Change Layout.... 

Or, 

Right-click the currently-displayed image layout.  

2. Select the image layout in which you want to save this 3D image from the drop-down list box. Then, click OK. 
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Copying an Image to the Clipboard 
You can copy the image currently displayed in the window to the clipboard. Then, you can paste it into another application such 
as Microsoft Word. 

To copy the image to the clipboard: 

1. Click Send Snapshot.... Then, select Copy To Clipboard. 

Or, 

Select Copy to Clipboard from the Edit menu. 

Or, 

Right-click the image, and select Copy to Clipboard. 

Exporting an Image 
You can easily export an image to a file on your computer's file system. 

To export the image to a file: 

1. Click Send Snapshot.... Then, select Export to File. 

Or, 

Right-click the image, and select Export to File... from the pop-up menu. 

Or, 

Select Export to File... from the Edit menu. 

The Save As dialog box appears, as shown below. 

2. Specify the directory and file in which you want to save the image. 

3. Optionally, select any other options from the drop-down list boxes.  

Depending on the image type you select in the Save As Type drop-down list box, additional options may be available in 
the other drop-down list boxes.  

Note: If you select one of the JPEG 2000 file types, an additional button appears on the Save As dialog box that 
enables you to set advanced options.  

4. Click Save. 
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Most options on this dialog box are described in the Microsoft Windows documentation.  
You can use the Save As Type drop-down list box to select the graphics file type that you want to use when saving this image. 
JPEG 24-bit is recommended for producing high quality images with a small file size and maximum compatibility between 
imaging programs. Typically, you should use the default selections for all other options. Only modify these options if you are very 
familiar with graphics files types. 

Printing an Image 

To print your current view of the 3D image: 

1. Click Send Snapshot.... Then, select Print. 

Or, 

Select Print... from the File menu. 

Or, 

Right-click the image, and select Print... from the pop-up menu. 

The Print dialog box is displayed. 

2. Select any printing options you want and click OK. 
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Printer Indicates the printer to which the print job will be sent. You set the printer for the image using Dolphin Printer Setup 
option, as described on "To set up your printer." If you have not specified the printer setup, Dolphin uses the 
default printer settings for your computer. 
Note: Dolphin does not retain printer settings when you exit the program. To retain printer settings, set them using 
the Microsoft Windows Printers Control Panel. 

Properties Click this button to set advanced properties for the selected printer. 

Print 
Range 

Select what you want to print. Your options are: 
All: print an entire document. From the main screen, you would typically use this option. 
Pages: print only pages in the specified range. 
Selection: print just what you have selected. 

Copies Enter the number of copies you want to print. 

Print 1:1 Click this check box to print an image using the 1:1 option.  

Preview Click this check box to preview your print job on the computer screen.  
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Creating and Exporting an Isosurface 
You can convert the sculpted and segmented volume to an isosurface at the selected resolution. Then, you can export the 
surface to a file for use with applications that can import and process an isosurface.  

To open the Create Surface and Export to File window:  

1. On the Dolphin 3D main window, select Export Volume as Surface... from the File menu. 

Or,  

On the 3D Implant Simulation window, click Other Options…. Then, select Create Surface and Export to File… from 
the pop-up menu. 

 

Seg: Use this slider to select the density segment of the volume to use for the isosurface you want to create. For 
more information, see "Segmenting the Image" on page 641. 

Use Volume 
Sculpting if 
Exists 

Check this box to use volume sculpting, if the volume has been sculpted, when creating the isosurface. For 
more information, see "Sculpting the Volume" on page 877. 
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Surface Creation 

Use the options in this group box to create the isosurface. 
Create Preview at ->: Select this option to create a preview of the isosurface. Choose the quality of the 
preview you want to create from the drop-down list box. 
Create High Resolution at ->: Select this option to create a high resolution isosurface. Choose the quality 
of the surface you want to create from the drop-down list box.  
Create Surface Now!: Click this button to create the isosurface and display it in the lower left of the 
Segmented Volume for Construction tab and on the Verify Constructed Surface tab. 
Color: Click the color sample to choose the color of the isosurface. For more information, see "To change 
the color of the isosurface" on page 669, 
Display Mesh: Click this button to display a mesh representation of the isosurface. 
For more information on these options, see "To create the isosurface" on page 669. 

Saving Surface to 
File 

Use the options in this group box to save the isosurface. 
Format: Choose one of the following file formats to use for the exported file: STL Text, STL Binary, OBJ 
Text, PLY Text, or PLY Binary. 
Save to File...: Click this button to save the isosurface. 
For more information on these options, see "To export the isosurface to a file" on page 666. 

Constructed 
Surface Displays a preview the constructed isosurface. 

Segmented 
Volume for 
Construction tab 

Click this tab to view the volume you are using to create the isosurface.  

Verify 
Constructed 
Surface tab 

Click this tab to view the constructed isosurface.  

Rotation Sliders 

Use these sliders to rotate the image around the indicated axis: 
: Use this slider to rotate the 3D image horizontally. 
: Use this slider to rotate the 3D image circularly. 
: Use this slider to rotate the 3D image vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 
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Click one of these buttons to orient the image in one of the predefined views. For more information, see 
"Moving or Reorienting the Image" on page 640. 

Predefined Views 

: Click this button to orient the image for a right view. 

 : Click this button to orient the image for a right oblique view. 

 : Click this button to orient the image for a front view. 

 : Click this button to orient the image for a left oblique view. 

 : Click this button to orient the image for a left view. 

 : Click this button to orient the image for a back view. 

 : Click this button to orient the image for a top view. 

 : Click this button to orient the image for a bottom view. 

 : Click this button to orient the image for an isometric view. 

 : Click this button to orient the image for an isometric view. 

 
Click these arrow buttons to move the image in the window in the indicated direction. For more information, 
see "Moving or Reorienting the Image" on page 640. 

  
Click this button to zoom in on the image. For more information, see "Changing the Magnification" on page 
640. 

  
Click this button to zoom out on the image. For more information, see "Changing the Magnification" on page 
640. 

  
Click this button to fit the image in the window. For more information, see "Changing the Magnification" on 
page 640. 
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To create the isosurface: 

1. On the Create Surface and Export to File window, select the Segmented Volume for Construction tab. 

2. Use the Seg slider to select the density segment of the volume to use to create the isosurface. 

For more information, see "Segmenting the Image" on page 641. 

2. Optionally, check the Use Volume Sculpting if Exists box to use volume sculpting, if the volume has been sculpted, 
when creating the isosurface. 

For more information, see "Sculpting the Volume" on page 877. 

4. Select Create Preview at -> to create a preview of the isosurface. 

Or,  

Select Create High Resolution at -> to create a high resolution isosurface. 

5. Choose the quality of the preview or high resolution isosurface from the appropriate drop-down list box. 

6. Set any other options for the isosurface. 

7. Click Create Surface Now! 

The isosurface appears in the lower left of the Segmented Volume for Construction tab and on the Verify Constructed 
Surface tab. 

To change the color of the isosurface: 

1. Click the color sample. 

The Color dialog box is displayed. 

2. Select the color you want to use for the isosurface, and click OK. 
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To export the isosurface to a file: 

1. On the Create Surface and Export to File window, select the Verify Constructed Surface tab to verify the isosurface. 

2. Select the file format you want to use from the Format drop-down list box. 

3. Click Save to File... 

4. Specify the directory and file in which you want to save the isosurface. 

5. Click Save. 

Setting Options 
You can set the following types of Dolphin 3D options: 

• DICOM volume storage options: These options specify where you want to store the volume data for your patients.  

• General options: These options determine the appearance and behavior of 3D images in the Dolphin 3D window.  

Setting DICOM Volume Storage Options 
Using these options, you specify whether you want to save 3D volume data for your patients in your Dolphin database or in your 
external DICOM storage location. You can set the storage location for all future patients and for the current patient. 

To set default DICOM volume storage options: 

1. On the Dolphin Imaging main screen, click . Then, select DICOM Storage Options... from the 
pop-up menu. 

Or, 

On the Dolphin Imaging main screen, select DICOM Storage Options... from the Edit menu. 

The DICOM Volume Storage dialog box opens. 

2. Select the storage options that you want to use as your defaults. 

3. Click OK to save your DICOM volume storage settings. 
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DICOM Import 
Default Location 

Specify the folder that you want to use as your default location for importing volumes into Dolphin 3D. Click 
Browse... to browse to the folder. 

Dolphin Internal 
Storage for 
Future Imported 
DICOM 

Select the storage option that you want to use for all future Dolphin 3D patients. 
Copy internally to Dolphin Database: Click this radio button to store the volume data for all future Dolphin 
3D patients in your Dolphin database. This option consolidates all your patient data in your database, and it 
enables you to create patient archives that include the 3D volume data. However, depending upon the level 
of compression you select, it uses more disk space and results in larger patient archive files. 
� Compression Level: Use this drop-down list box to select the compression level you want to 

use. The default compression, No Loss 3:1, allows the exact original data to be reconstructed 
from the compressed data. You can also choose from several lossy compression options.  Lossy 
compression compresses and retrieves data that are different from the original, but these 
differences are not generally visible to the human eye. The recommended lossy compression is 
50:1. 

Note: Dolphin 3D only stores a single copy of the volume data, even if you save several images from the 
volume in different image layouts or different image slots within a single layout. Dolphin 3D also performs a 
lossless compression of the DICOM data, which may load into Dolphin 3D more quickly than uncompressed 
data from your external DICOM storage location. 
Refer to external DICOM storage: Select this option to store the volume data for all future Dolphin 3D 
patients in your external DICOM storage. This option uses less disk space and results in smaller patient 
archive files. However, it also means that Dolphin 3D must be able to access your external DICOM storage 
for the patient volume data. In addition, your patient archive files will not be self-contained; they will also 
reference your external DICOM storage. 
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To set the DICOM volume storage options for a patient: 

1. Select DICOM Volume Storage... from the Tools menu. 

The DICOM Volume Storage dialog box opens. 

2. Select the storage option that you want to use for the current patient. 

3. Click OK to save your DICOM volume storage settings. 

 

DICOM Storage 
for current 
patient 

Click the storage option that you want to use for the current Dolphin 3D patient. 
No change: Select this option if you do not want to change the storage for the current patient. 
Clicking here will copy DICOM data into central Dolphin Database: Select this option to copy the 
volume data for the current patient from your external DICOM storage and into your Dolphin database.  
Clicking here will remove data from Dolphin database, and instead point to external DICOM storage: 
Select this option to remove the volume data for the current patient from your Dolphin database. Instead, the 
patient's database record will reference your external DICOM storage. 
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Setting General Options 
These options determine the appearance and behavior of 3D images in the Dolphin 3D window.  

To set general options: 

1. Select General Options... from the Options menu. 

2. Set any options, and click OK. 

 

Volume Preview group 
box 

Set the following options related to the display of the volume: 
Resolution: Select the resolution you want to use when previewing changes. Bear in mind that 
higher resolutions result in slower response times. 
Rotation Speed: Select the speed that you want to use when clicking and dragging the image. 
Show Grid Lines: Check this box to show grid lines when rotating the image in the main Dolphin 
3D window 
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Show Ruler Tickmarks 
in Volume Window Check this box to show rules or tick marks on the main Dolphin 3D window. 

Nerve Canals Color 
Click the color sample to change the color used to display nerve canal markers on the patient's hard 
tissue image. For more information, see "To view nerve canals on the patient’s hard tissue image" 
on page 628. 

Disable fastest and 
highest-quality 
rendering modes 

Check this box to disable the advanced 3D rendering modes. 

Turn on GPU Debug 
Mode 

Check this box if requested by a Dolphin support technician trying to determine why translucent 
display modes are not working on your computer. 

Slice/Section Rendering 
Options group box 

Set the following options related to displaying slices of the volume: 
Method: Select the rendering method to use when viewing volume slices. 
� Linear (Per HU): The slice rendering is colored linearly based on the Hounsfield Units 

(HU) specified in the DICOM files. With this method, Dolphin Imaging displays the HU at 
the mouse pointer location when viewing a volume slice.  
Note: This option only works for volumes imported into Dolphin Imaging Version 11 or 
later. For those volumes, this method is used by default. 

� High Contrast: This method analyses the volume to find the optimal coloration to 
produce a higher contrast slice image. This option is recommended for volumes with 
minimal "noise." For volumes imported into Dolphin Imaging versions earlier than 11, this 
method is used by default. 

� Averaged: This method analyses the volume to find the optimal coloration to produce a 
smoother, more monotone slice image. This option is recommended for volumes with 
"noise." 

Sharpening: Select the percentage of sharpening that you want to apply automatically when 
viewing volume slices. 
Preview Resolution: Select the resolution to use for slice rendering. High resolution is the default, 
but can result in slower response times. If slices are being rendered too slowly, set this option to 
Low. 

Measurement Display 
Decimal 

Select the number of decimal places you want to use in measurement displays from this drop-down 
list box. 

Landmark Display 
Radius 

Select the size in the millimeters for landmarks. This setting affects the landmark dot size, line 
thickness, and font size used for digitized landmarks. 

Exported Bitmap 
Maximum Size Select the maximum size (up to 2048) for images exported from Dolphin 3D.  
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Orienting the Image 
The first time you load a new image into Dolphin 3D, you may need to change its horizontal/vertical orientation so that it properly 
correlates to the requirements for your analysis. 
Although proper orientation of the 3D volume is subjective, it is also critical to your use of the Dolphin 3D features. For example, 
if the image is not oriented correctly, the sagittal, coronal, or axial slice views will not display the cross-sections that you expect. 
It is highly recommended that you use consistent orientation for all your patients. 

To begin orienting the image: 

1. Click  on the Dolphin 3D main window. 

Or, 

Select Set Orientation... from the Tools menu. 

Or, 

Click Other Options... on the 3D Implant Simulation window, then select Define Local Orientation... to set the volume 
orientation for a specific 3D implant simulation. 

The Orientation Calibration window opens. The window provides guidelines at the mid-sagittal and axial planes to 
assist you in orienting the image correctly. 

2. Click the Soft Tissue, Hard Tissue, or 3D Photo radio button to use that image to orient the 3D volume. 

You do not set the orientation separately for the soft tissue, hard tissue, and photograph. Instead, you set the 
orientation for the entire 3D volume. However, you may find it easier to correct the image orientation when viewing the 
soft tissue, hard tissue, or photograph. 
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Volume 

Set your view preferences: 
Soft Tissue (Solid): Click this radio button to show the patient’s solid soft-tissue image in the window.  
Hard Tissue (Solid): Click this radio button to show the patient’s solid hard-tissue image in the window.  
Translucent: Click this radio button to show the patient’s translucent hard-tissue image in the window (for 
computers that support advanced 3D rendering only). Then, select the translucent view (Soft Tissue, Hard 
Tissue, or Both) from the drop-down list box. 
3D Photo/Surface: Click this radio button to show the patient’s photograph or isosurface in the window.  
Use Clipping Slice: Check this box to define and view a cross-section of the image. For more information, 
see "Using a Clipping Slice" on page 869. 
slider: Move the slider to set the location of the slice used for this cross section. 

: Click this icon to set the clipping slice at the mid-sagittal plane. 

: Click this icon to set the clipping slice at the axial plane. 

: Click this icon to set the clipping slice at the coronal plane. 

: Click this icon to use a pie-shaped clipping slice that includes the patient's arch. 

: Click this icon to orient the clipping slice in the direction of the viewer. 
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Rotate Volume at 
Planes' Origin 

Check this box to use the origins of the displayed planes (mid-sagittal, coronal, and/or axial) as the point 
around which to rotate the volume. For more information, see page 681. 

Show Symmetry 
Caliper 

Check this box to display a symmetry caliper on the patient's image. Then, select the length of the caliper 
from the drop-down list box. For more information, see "Using the Symmetry Caliper" on page 660. 

Show Angular 
Caliper 

Check this box to use an angular caliper to assist you in orienting the volume based on an angle, such as the 
Frankfort plane. For more information, see "To use an angular measurement to orient the volume" on page 
681. 
Set: Click this button to display the caliper. 
Deg: Enter the number of degrees for the angle in this text box. 

Auto Alignment 
Tool 

Specify whether you want to use an automatic alignment tool to assist you in orienting the image. 
None: Click this radio button if you do not want to use an automatic alignment tool. 
Using 3-Point Plane: Click this radio button to use a three-points plane to assist you in orienting the image. 
This automatic alignment tool is recommended for use with the patient's photo in the frontal view. For more 
information, see "To use the 3-point plane automatic alignment tool to orient the image" on page 680. 
Using Line: Click this radio button to use a line to assist you in orienting the image. This automatic alignment 
tool is recommended for use in one of the lateral views (either left or right). For more information, see "To use 
the line automatic alignment tool to orient the image" on page 680. 
Make Vertical: Click this button to rotate the image so that the 3-point plane or line is vertical. 
Make Horizontal: Click this button to rotate the image so that the line is horizontal. 

Undo Last Move Click this button to undo your last operation on the image. 

Reset 
Orientation Click this button to revert to the last saved orientation for this image. 

Save... Click this button to save the current orientation to your Dolphin database. For more information, see "To save 
your current volume orientation" on page 683. 

Restore... Click this button to restore a previously-saved orientation from your Dolphin database. For more information, 
see "To save your current volume orientation" on page 683. 

Orientation 

Click these tabs to view the 3D image from various angles. 
Front: Click this tab for a frontal view. 
Right: Click this tab for a right lateral view. 
Left: Click this tab for a left lateral view. 
Bottom (Facing Up): Click this tab to view the 3D image from the bottom with the patient's face toward the 
top of the window. 
Top (Facing Down): Click this tab to view the 3D image from the top with the patient's face toward the 
bottom of the window. 
Back: Click this tab for a back view. 
Planes of Section (View Only): Click this tab for a view-only display of the 3D image and 3D 
representations of the mid-sagittal, axial, and coronal planes. 



Dolphin Imaging User's Guide April 2011 

678 DI_USER_GUIDE-11.5   Rev. 1.01 

Rotation Sliders 

Use these sliders to rotate the image around the indicated axis: 
: Use this slider to rotate the 3D image horizontally. 
: Use this slider to rotate the 3D image circularly. 
: Use this slider to rotate the 3D image vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

 
Click these arrow buttons to move the 3D image in the window in the indicated direction. For more 
information, see "Moving or Reorienting the Image" on page 640. 

  
Click this button to zoom in on the 3D image. For more information, see "Changing the Magnification" on 
page 640. 

  
Click this button to zoom out on the 3D image. For more information, see "Changing the Magnification" on 
page 640. 

  
Click this button to fit the 3D image in the window. For more information, see "Changing the Magnification" on 
page 640. 

The Planes of Section (View Only) tab includes the following additional options: 

 Click this button to orient the 3D image for a right view. 

 Click this button to orient the 3D image for a right oblique view. 

 Click this button to orient the 3D image for a front view. 

 Click this button to orient the 3D image for a left oblique view. 

 Click this button to orient the 3D image for a left view. 

 Click this button to orient the 3D image for a back view. 

 Click this button to orient the 3D image for a top view. 

 Click this button to orient the 3D image for a bottom view. 
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 Click this button to orient the 3D image for a right isometric view. 

 Click this button to orient the 3D image for a left isometric view. 

For more information on these options, see "Moving or Reorienting the Image" on page 640. 

To use the orientation tabs: 

1. Click one of the orientation tabs to use that view to orient the image. 

Lines representing the mid-sagittal, axial, and coronal planes appear on the various views, as summarized below: 

 Mid-Sagittal Plane Axial Plane Coronal Plane 

Front X X  

Right  X X 

Left  X X 

Bottom (Facing Up) X  X 

Top (Facing Down) X  X 

Back X X  

Planes of Section (View Only) X X X 

The Planes of Section tab provides a view-only 3D representation of the patient's image and the three planes to help 
you check your work when orienting the image. 

To correct the orientation without using one of the auto alignment tools: 

1. Click one of the orientation tabs to use that view to orient the image. 

While correcting the orientation, you should check each of these tabs to make sure the image is oriented correctly 
when viewed from every angle. 

2. Using the mid-sagittal, axial, and coronal planes as guides, rotate the image to orient it correctly in the window. 

If necessary, click and drag the lines for the mid-sagittal, axial, and coronal planes to relocate them on the patient's 
image. 

The Planes of Section tab provides a view-only 3D representation of the patient's image and the three planes to help 
you check your work. 

3. Optionally, use the symmetry caliper to check the symmetry of the patient's image in the window. 

The symmetry caliper is most useful on the Front, Bottom, or Top orientation tabs. 

4. Click OK to save the image orientation. 
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To use the 3-point plane automatic alignment tool to orient the image: 

1. Select 3D Photo if you have a photograph for this patient. 

2. Select the Front orientation tab. 

The 3-point plane automatic alignment tool is recommended for use with a photograph in the frontal view. 

3. Select the Using 3-Point Plane radio button. 

A triangle appears on the patient's image.  

4. Click and drag each of the three points to locations on the patient's image. 

When the mouse is over one of the points, triangles appear around that point. 

5. Click Make Vertical to rotate the image so that the plane defined by the three points is aligned with the vertical plane on 
the current view. 

The following figure illustrates one possible use of the 3-point plane automatic alignment tool.  

 

To use the line automatic alignment tool to orient the image: 

1. Select the Right or Left orientation tab. 

The line automatic alignment tool is recommended for the lateral views. 

2. Select the Using Line radio button. 

A line appears on the patient's image.  

3. Click and drag the end points of the line to locations on the patient's image. 

When the mouse is over one of the end points, triangles appear around that end point. 
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4. Click Make Vertical to rotate the image so that the line is aligned with the vertical plane on the current view. 

Or, 

Click Make Horizontal to rotate the image so that the line is aligned with the horizontal plane on the current view. 

The following figure illustrates one possible use of the line automatic alignment tool.  

 
In addition to the usual features for rotating a volume, you can rotate the sculpted volume about a point defined by the 
intersection of the two planes displayed as red lines on the image. This enables you to rotate the volume about a point other than 
the center of the volume. 

To rotate the volume about the intersection of the two planes: 

1. Check the Rotate Volume at Planes' Origin box.  

2. Click and drag the two planes to any locations on the volume.   

3. Rotate the volume as described in "Moving or Reorienting the Image" on page 640. 

The volume rotation is centered about the intersection of the two planes. 

You can use an angular caliper to assist you in orienting the volume based on an angle, such as the Frankfort plane. 

To use an angular measurement to orient the volume: 

1. Check the Show Angular Caliper box. 

An angular caliper appears on the image. Depending on the orientation tab currently selected, the caliper's vertex is 
placed at the intersection of the mid-sagittal and axial planes or the coronal and axial planes. 

2. Enter the number of degrees for the angle. Then, click Set. 

Or, 

Click and drag the rotation handle (pink square) that appears on one end of the caliper to set the angle. 
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To use the rotation handle to set the angle, click and drag when a rotation icon appears around the handle. 

3. Optionally, click and drag the planes to reposition the caliper. 

The following figures illustrate two uses of the angular caliper. 

 
Once you have oriented a volume, you can save the orientation in your Dolphin database and restore it later.  
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To save your current volume orientation: 

1. Click Save... on the Orientation Calibration window. 

Or, 

Right-click the image on the Dolphin 3D main window, and select Save Volume Orientation... from the pop-up menu. 

The Save Orientation dialog box opens (see below). 

 
2. Select the slot in which you want to save this orientation. Then, click OK. 

To restore a previously-saved volume orientation: 

1. Click Restore... on the Orientation Calibration window. 

Or, 

Right-click the image on the Dolphin 3D main window, and select Restore Volume Orientation... from the pop-up menu. 

The Restore Orientation dialog box opens. 

2. Select the slot containing the orientation you want to restore. Then, click OK. 



Dolphin Imaging User's Guide April 2011 

684 DI_USER_GUIDE-11.5   Rev. 1.01 

To delete a previously-saved volume orientation: 

1. Click Save... on the Orientation Calibration window. 

Or, 

Right-click the image on the Dolphin 3D main window, and select Save Volume Orientation... from the pop-up menu. 

The Save Orientation dialog box opens (see above). 

2. Select the slot containing the orientation you want to delete. Then, click Remove. 

3. Click OK. 

To rename an orientation slot: 

1. Double-click the slot you want to rename. 

2. Enter a new name for the slot. 

3. Optionally, check the Make Name Changes Available to Other Scans box to make the name change visible when you 
save the orientations for other volumes. 

4. Click OK. 

Adding and Editing Photographs 
On the Photo and Volume Alignment/Superimposition dialog box, you can import 3D or 2D photographs into Dolphin 3D and 
superimpose them over the 3D volume. This enables you to obtain a complete 3D view of the patient. You can store up to two 
photographs for each volume, labeled Photo 1 and Photo 2 in the Type drop-down list box on the Dolphin 3D window. 

To open the Photo and Volume Alignment/Superimposition dialog box: 

1. In the Soft-Tissue group box on the Dolphin 3D window, select Photo: 2D/3D if it isn't already selected. 

2. From the Type drop-down list box, select the photograph you want to superimpose over the volume. 

You can store up to two photographs for each volume, labeled Photo 1 and Photo 2 in the Type drop-down list box. 

3. Click Edit.... 

Or, 

Select Edit/Merge 3D Photo... from the Tools menu. 

The Photo and Volume Alignment/Superimposition dialog box opens. 
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Import/Replace 
Photo...  

Import a new photograph for this patient or replace the existing photo. When you click this button, a pop-
up menu appears with the following options: 
Close This Menu: Select this option to close the pop-up menu. 
Import 3D Photo (OBJ+Bitmap): Select this option to import a 3D photo. 
Import 2D Bitmap: Select this option to import a 2D photo. 

Volume group box 

Set options for the volume in this group box: 
Seg: Use this slider to set the segmentation to use for the volume.  
Solid: Select this option to view a solid representation of the volume. 
Color sample: Click the color sample to set the color to use for the solid representation of the volume. 
Translucent: Select this option to view a translucent representation of the volume. 
Slider: Use this slider to set the transparency of the volume. 
For more information on these options, see "Viewing the Soft Tissue" on page 635. 
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3D Photo group box 

Set options for the photo in this group box: 
Photo: Select this option to display the photo as a 3D photographic image. 
Mesh: Select this option to show only a mesh representation of the patient’s photograph in the window. 
For more information, see "Viewing the Soft Tissue" on page 635. 
Trans: Use this slider to set the transparency of the photo. This option is available only for use with 3D 
photos. 
Photo Always in Front of Volume: Check this box to specify that the photo should always appear in 
front of the volume. This option is available only for use with 3D photos. 

Method: Side-by-
Side 
Superimposition tab 

Use this tab to view the photograph and the volume side by side and align them by identifying 
corresponding points. You can use this method to superimpose a 3D or a 2D photo over the volume. 
For more information, see "Using Side-by-Side Superimposition" on page 833 and "Superimposing a 
2D Photo Over the Volume" on page 696. 

Method: Overlay 
Superimposition tab 

Use this method to align the photograph and the volume by manipulating a preview of the 
superimposition. This method is available only for use with 3D photos. For more information, see "Using 
Overlay Superimposition" on page 835. 

Sculpting tab Used this tab to "sculpt" or crop the photograph. For more information, see "Sculpting the 3D 
Photograph" on page 693 and "Sculpting the 2D Photograph" on page 697. 

Verify Results 
Use this tab to verify the results of your superimposition and photograph sculpting operations. This tab 
is only available for use with 3D photographs. For more information, see "Verifying the Result" on page 
865. 

Alignment Points 
Select the number of alignment points you want to use to superimpose the volume and photograph. 
This drop-down list box is only available when using the side-by-side superimposition method to 
superimpose a 3D photo over the volume. For more information, see "Using Side-by-Side 
Superimposition" on page 833. 

Reset 
Click this button to return the alignment points to their initial number and positions. This button is only 
available when using the side-by-side superimposition method to superimpose a 3D photo over the 
volume. For more information, see "Using Side-by-Side Superimposition" on page 833. 

Show Guide Lines 
Check this box to show alignment guidelines to aid you in superimposing the photograph and volume. 
This check box is only available when using the side-by-side superimposition method to superimpose a 
2D photo over the volume. For more information, see "Superimposing a 2D Photo Over the Volume" on 
page 696. 

Use Volume 
Sculpting if Exists 

Check this box to consider volume sculpting when superimposing a 2D photograph onto the volume. 
For more information on volume sculpting, see "Sculpting the Volume" on page 877. 

Match Nasion-
Stomion 

Click this button to move the volume and photograph so that the nasion and stomion are at the same 
level in the window. This button is only available when using the side-by-side superimposition method 
to superimpose a 2D photo over the volume. For more information, see "Superimposing a 2D Photo 
Over the Volume" on page 696. 
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Superimpose Now! 
Click this button to superimpose the photograph over the volume and display the result in the Test 
Superimposition window. This button is only available when using the side-by-side superimposition 
method. For more information, see  "Using Side-by-Side Superimposition" on page 833 and 
"Superimposing a 2D Photo Over the Volume" on page 696. 

Auto Apply 
Check this box to preview the results of the superimposition in real time. This button is only available 
when using the side-by-side superimposition method to superimpose a 2D photo over the volume. For 
more information, see "Superimposing a 2D Photo Over the Volume" on page 696. 

Undo Last Move 
Click this button to undo the last operation. This button is only available when using the overlay 
superimposition method. For more information, see "Using Overlay Superimposition" on page 835. 

Rotate Volume 
About Red Dot 

Check this box to rotate the superimposed volumes about a user-defined point. This button is only 
available when using the overlay superimposition method. For more information, see "Rotating the 
Volume" on page 839 and  "Using Overlay Superimposition" on page 835. 

Border group box 

Select an option to use when drawing the cropping border for sculpting the photograph.  
Lines: Select this option to use lines when drawing the cropping border 
Curves: Select this option to use curves when drawing the cropping border. 
This group box is only available when using the Sculpting tab. For more information, see "Sculpting the 
3D Photograph" on page 693 and "Sculpting the 2D Photograph" on page 697. 

Remove Border 
Check this box to remove the cropping border you have drawn for sculpting the photograph. This button 
is only available when using the Sculpting tab. For more information, see "Sculpting the 3D Photographv" 
on page 693 and "Sculpting the 2D Photograph" on page 697. 

Undo Last  
Click this button to undo the last sculpting operation. This button is only available on the Sculpting tab. 
For more information, see "Sculpting the 3D Photograph" on page 693 and "Sculpting the 2D 
Photograph" on page 697. 

Undo All 

Click this button to undo all sculpting operations. When you click this button, a pop-up menu opens with 
the following options: 
Close this menu: Click this option to close the pop-up menu. 
Undo All - Current Session: Click this option to undo all sculpting operations that you performed in this 
session. 
Undo All - Completely: Click this option to undo all the sculpting operations performed on this 
photograph. 
This button is only available on the Sculpting tab. For more information, see "Sculpting the 3D 
Photograph" on page 693 and "Sculpting the 2D Photograph" on page 697. 

Result 
Shows a preview of the results of your superimposition and sculpting operations. This preview does not 
appear when the Verifying Results tab is selected. When aligning a 2D photo over of a volume, the 
preview only appears if the Auto Apply box is checked (see above). 



Dolphin Imaging User's Guide April 2011 

688 DI_USER_GUIDE-11.5   Rev. 1.01 

 

Predefined Views 

Click one of these buttons to orient the image in one of the predefined views. For more information, see 
"Moving or Reorienting the Image" on page 640. 

: Click this button to orient the image for a right view. 

: Click this button to orient the image for a right oblique view. 

: Click this button to orient the image for a front view. 

: Click this button to orient the image for a left oblique view. 

: Click this button to orient the image for a left view. 

: Click this button to orient the image for a back view. 

: Click this button to orient the image for a top view. 

: Click this button to orient the image for a bottom view. 

: Click this button to orient the image for a right isometric view. 

: Click this button to orient the image for a left isometric view. 

 
Click this button to fit the image in the window. For more information, see "Changing the Magnification" 
on page 640. 

 
Click these arrow buttons to move the image in the window in the indicated direction. For more 
information, see "Moving or Reorienting the Image" on page 640. 
 

  
Click this button to zoom in on the image. For more information, see "Changing the Magnification" on 
page 640. 

  
Click this button to zoom out on the image. For more information, see "Changing the Magnification" on 
page 640. 

Rotation Sliders 

Use these sliders to rotate the image around the indicated axis: 
: Use this slider to rotate the image horizontally. 
: Use this slider to rotate the image circularly. 
: Use this slider to rotate the image vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

Lock Orientation Check this box to lock the orientation of the volume. When the orientation is locked, the rotation sliders 
no longer work. This option only appears when you are superimposing a 2D photo over the volume. 

Rotate 90° Click this button to rotate a 2D photo 90°  This option only appears when you are superimposing a 2D 
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photo over the volume. 

Rotate/Offset 
applies to 

Select an option to apply your changes to that part of the superimposition. These options are only 
available when using the overlay superimposition method. 
Photo Only: Select this option to apply your changes only to the photograph. 
Photo and Volume: Select this option to apply your changes to both the photograph and the volume. 

  

Working with 3D Photographs 

Importing a 3D Photograph 
To add a new 3D photograph for a patient, you import it from an image file. You can import the photo either from the Dolphin 3D 
window or from the Photo and Volume Alignment/Superimpositions dialog box (see below). Once you have imported the 
photograph, you can superimpose it over the 3D volume. 

To import a 3D photograph from the Dolphin 3D window: 

1. In the Soft Tissue group box, select 3D Photo if it isn't already selected. 

2. From the Type drop-down list box, select the photograph you want to add. 

You can store up to two photographs for each volume, labeled Photo 1 and Photo 2 in the Type drop-down list box. 

3. Click Add.... 

4. Select Import 3D Photo (OBJ + Bitmap) from the pop-up menu that appears.  

The Open dialog box appears so that you can select the folder containing the image file. 

5. Navigate to the folder containing the image file for the photo.  

6. Select the appropriate file. Then, click Open to load the photo. 

The photo and the volume appear in the Photo and Volume Alignment/Superimposition dialog box. 

To import the image file for a 3D photograph from the Photo and Volume Alignment/Superimposition dialog box: 

1. Click Import/Replace Photo.... 

2. Click Import 3D Photo (OBJ + Bitmap) from the pop-up menu that appears.  

The Open dialog box appears so that you can select the directory containing the image file. 

3. Navigate to the folder containing the image file for the photo.  

4. Select the appropriate file. Then, click Open to load the photo. 
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To import a 3D photograph for a patient for whom you don't have volume data: 

1. On the Dolphin Imaging main screen, select the timepoint and layout to which you want to add the 3D photo.  

2. Click  on the Dolphin Imaging main screen. 

3. Select Import New DICOM from the pop-up menu. 

The Open dialog box appears so that you can select the directory containing the image files for the 3D volume. 

4. Click Cancel. 

5. In the Soft-Tissue group box on the Dolphin 3D window, select 3D Photo if it isn't already selected. 

6. From the Type drop-down list box, select the photograph you want to add. 

You can store up to two photographs for each volume, labeled Photo 1 and Photo 2 in the Type drop-down list box. 

7. Click Add.... 

The Open dialog box appears so that you can select the directory containing the image file. 

8. Navigate to the folder containing the image file for the 3D image.  

9. Select the appropriate file. Then, click Open to load the image. 

Superimposing the Photo and the Volume 
Once you have imported a photograph, you can superimpose it over the 3D volume. There are two methods for superimposing a 
3D photo over the volume: 

• Side-by-Side Superimposition: Use this method to view the photograph and the volume side by side and align them 
by identifying corresponding points.  

• Overlay Superimposition: Use this method to align the photograph and the volume by manipulating a preview of the 
superimposition.  

Fine-tuning the superimposition may involve using both these methods. For example, you may use the side-by-side 
superimposition method initially, then fine-tune the superimposition with the overlay superimposition method. In addition, this 
dialog box offers the 3D photo sculpting feature, which you can use to fine tune the 3D photograph. Finally, you can verify the 
superimposition on the Verify Result tab. 

Using Side-by-Side Superimposition 
With this method, you align the photograph and the volume by identifying corresponding points on them. After you superimpose 
a 3D photograph over the volume, you can preview the superimposition before saving it. 

To superimpose the photograph over the volume: 

1. Select the Method: Side-by-Side Superimpositions tab. 

The volume and photograph for this patient appear in the dialog box. Points appear on the images so that you can 
align them.   

2. Zoom in on the volume and photo, if necessary. 
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3. Orient both the photo and volume to the frontal view so that they match. 

4. Click and drag the points on the both the photo and volume so that they identify corresponding locations. 

5. Click Superimpose Now! 

The result of your superimposition appears in the results box in the lower left corner of the window.  

7. Rotate the image in the results box in the lower left corner of the window to verify the superimposition. 

The following figure illustrates superimposing a 3D photo over a volume. 

 

To use additional points to align a 3D photo over the volume: 

1. Select a number of points you want to use from the Alignment Points drop-down list box. 

Additional alignment points appear on both volume and the 3D photo. 

To reset the alignment points to their initial number and locations: 

1. Click Reset. 

The initial number of alignment points appears in the original positions on both the volume and the 3D photo. 
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Using Overlay Superimposition 
With this method, you align a 3D photograph and the volume by manipulating a preview the superimposition. 

To align the image: 

1. Select the Method: Overlay Superimpositions tab. 

The volume and 3D photograph for this patient are superimposed in the dialog box. 

 

To reorient the superimposition: 

1. Select Photo Only to reorient the photograph. 

Or, 

Select Photo and Volume to reorient both the photograph and the volume. 

2. Click the button for one of the predefined views to change to that orientation. 

To adjust the superimposition: 

1. Select Photo Only to change the position of the photograph. 

Or, 

Select Photo and Volume to change the position of both the photograph and the volume. 

2. Click one of the arrow buttons to move the selection (either the photograph or both the photograph and the volume) in 
the indicated direction. 

Or, 

Hold down the SHIFT key while clicking and dragging the selection within the window. 

Or, 

Click and drag one of the sliders to rotate the selection around the indicated axis. 

Or, 

Click and drag the selection to rotate it. 
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Sculpting the 3D Photograph 
Sculpting a photograph enables you to crop or remove portions of it. For example, some 3D photographs have jagged edges that 
you can smooth out using this feature. 

To sculpt a 3D photograph: 

1. Select the Sculpt tab. 

The photograph for this patient appears in the dialog box. 

2. Optionally, click the button for one of the predefined views to change to that orientation. 

Or, 

Click and drag the photograph to rotate it. 

3. Select Curves in the Border group box to use curves to create the cropping polygon. 

Or, 

Select Lines in the Border group box to use lines to create the cropping polygon. 

The figure below illustrates cropping polygons created using lines and curves. 

4. Click the left mouse button on a point where you want to begin drawing the cropping polygon. 

Click a point that is not on the photograph to begin your polygon. 

5. Release the mouse button and move the mouse to begin drawing the polygon. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position. 

6. Click the mouse button whenever you want to place a point and change the direction of the line. 

If you make a mistake and want to start over, click Remove Cropping Border. 

7. Click the left mouse button again on the first point to close the polygon. 

When you close the polygon, the mouse pointer changes to a pair of scissors. 

8. Click the left mouse button inside the polygon to remove the part of the photograph that is inside the polygon. 

Or, 

Click the left mouse button outside the polygon to remove the part of the photograph that is outside the polygon. 
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Verifying the Result 
Before saving your superimposition, you can verify it by viewing it from different angles to see it the 3D photograph and volume 
are aligned correctly.  

To verify your superimposition: 

1. Click the Verify Result tab. 

The dialog box displays the current superimposition.  

2. Click the button for one of the predefined views to orient the superimposed image for that view. 

Or, 

Click and drag one of the sliders to rotate the superimposed image around the indicated axis. 

Or, 

Click and drag the superimposed image to rotate it. 

To save your superimposition and close this dialog box: 

1. Click OK. 
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Working with 2D Photographs 

Importing a 2D Photograph 
To add a 2D photograph for a patient, you can select a photograph available for this patient in Dolphin Imaging, or you can 
import an image from a file. You can import the photo either from the Dolphin 3D window or from the Photo and Volume 
Alignment/Superimpositions dialog box (see below).  
Note: For best results, make sure the photo is taken with the nostril openings shown. 
Once you have imported the photograph, you can superimpose it over the 3D volume. 

To import a 2D photograph from the Dolphin 3D window: 

1. In the Soft-Tissue group box, select 3D Photo if it isn't already selected. 

2. From the Type drop-down list box, select the photograph you want to add. 

You can store up to two photographs for each volume, labeled Photo 1 and Photo 2 in the Type drop-down list box. 

3. Click Add.... 

4. Click Import 2D Bitmap from the pop-up menu that appears. 

The Image Chooser dialog box opens. 

5. Select the image you want to import into Dolphin 3D.  

Or, 

Click Browse... and browse to the image file you want to import into Dolphin 3D. 

6. Click OK. 

The photo and the volume appear in the Photo and Volume Alignment/Superimposition dialog box. 

To import a 2D photograph from the Photo and Volume Alignment/Superimposition dialog box: 

1. Click Import/Replace Photo.... 

2. Click Import 2D Bitmap from the pop-up menu that appears. 

The Image Chooser dialog box opens. 

3. Select the image you want to import into Dolphin 3D.  

Or, 

Click Browse... and browse to the image file you want to import into Dolphin 3D. 

4. Click OK. 

The photo and the volume appear in the Photo and Volume Alignment/Superimposition dialog box. 
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list box Select an image from this list box to import a 2D photograph from Dolphin imaging. In this list box, the 
images for the current patient are grouped by timepoint. 

Browse... Click this button to import a 2D photograph from an image file. 

Superimposing a 2D Photo Over the Volume 
To superimpose a 2D photo over the volume, you identify corresponding points on both the photo and the volume. After you 
superimpose a 2D photograph over the volume, you can preview the superimposition before saving it. 

To superimpose the 2D photograph over the volume: 

1. On the Photo and Volume Alignment/Superimpositions dialog box, select the Method: Side-by-Side Superimpositions 
tab. 

The volume and photograph for this patient appear in the dialog box. Points appear on the images so that you can 
align them, as shown below. 

2. Zoom in on the volume and photo, if necessary. 

3. Orient both the photo and volume to the frontal view so that they match. 

4. Click and drag the red vertical line to the midline on both the photo and volume. 

5. Click and drag the points on the both the photo and volume so that they identify corresponding locations. 

Or, 

Click and drag the lines on the both the photo and volume so that they identify corresponding locations. 

Dolphin recommends landmarks on which to place the points on the volume and the photograph. However, you can 
place the points on different locations as long as the points on the photo correspond to the points on the volume. 
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6. Optionally, click Match Nasion-Stomion to magnify both the volume and the 2D photograph to the same level.  

Using the same magnification on both views may make it easier to place the points in corresponding locations. 

Note: Sometimes it is not possible to match up the points exactly. 

7. Optionally, check the Show Guide Lines box to see and move the guide lines that you can use as visual aids for 
placing the points. 

8. Click Superimpose Now! 

The result of your superimposition appears in the results box in the lower left corner of the window.  

9. Rotate the image in the results box in the lower left corner of the window to verify the superimposition. 

The following figure illustrates superimposing a 2D photo over a volume. 

 

Sculpting the 2D Photograph 
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Sculpting a photograph enables you to crop or remove portions of it. For example, when you superimpose a 2D photograph over 
a volume, the photograph may have jagged edges that you can smooth out using this feature. 
Note: You must superimpose a 2D photograph over the 3D volume before you can use photograph sculpting on it.  

To sculpt a 2D photograph: 

1. Select the Sculpt tab. 

The photograph for this patient appears in the dialog box. 

2. Optionally, click the button for one of the predefined views to change to that orientation. 

Or, 

Click and drag the photograph to rotate it. 

3. Select Curves in the Border group box to use curves to create the cropping polygon. 

Or, 

Select Lines in the Border group box to use lines to create the cropping polygon. 

The figure below illustrates cropping polygons created using lines and curves. 

4. Click the left mouse button on a point where you want to begin drawing the cropping polygon. 

Click a point that is not on the photograph to begin your polygon. 

5. Release the mouse button and move the mouse to begin drawing the polygon. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position. 

6. Click the mouse button whenever you want to place a point and change the direction of the line. 

If you make a mistake and want to start over, click Remove Cropping Border. 

7. Click the left mouse button again on the first point to close the polygon. 

When you close the polygon, the mouse pointer changes to a pair of scissors. 

8. Click the left mouse button inside the polygon to remove the part of the photograph that is inside the polygon. 

Or, 

Click the left mouse button outside the polygon to remove the part of the photograph that is outside the polygon. 
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Verifying and Correcting the Result 
When you superimpose a 2D photo over a 3D volume, the result of your superimposition appears in the results box in the lower 
left corner of the window. Before saving your superimposition, you can verify it by viewing it from different angles to see it the 2D 
photograph and volume are aligned correctly.  

To verify your superimposition: 

1. Select the Method: Side-by-Side Superimpositions tab, if it isn't already selected. 

2. Rotate the image in the results box in the lower left corner of the window to verify the superimposition. 

The dialog box displays the current superimposition.  

3. Click the button for one of the predefined views to orient the superimposed image for that view. 

Or, 

Click and drag one of the sliders to rotate the superimposed image around the indicated axis. 

Or, 

Click and drag the superimposed image to rotate it. 

Sometimes, you’ll see that the nostril area is not superimposed correctly.  
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To fine tune the superimposition in the nostril area: 

1. Make sure the points and midline on the volume are located correctly.  

2. Optionally, move the  Nostril/Top point on the volume up or down until the nostrils are superimposed correctly.  

Note: You can check the Auto Apply box so you don’t need to click Superimpose Now! for every adjustment.  

To save your superimposition and close this dialog box: 

1. Click OK. 
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25 Building X-Rays 
Using Dolphin 3D, you can build the following types of 2D x-rays from the 3D volume: 

• Lateral: Set up and view a lateral x-ray. For more information, see "Building a Lateral X-Ray" on page 708. 

• Panoramic: Set up and view a panoramic x-ray. For information, see "Building a Panoramic X-Ray" on page 714. 

• TMJ: Set up a TMJ view. For more information, see "Building an X-Ray View of the TMJ Area" on page 722. 

• Cross Sections, Cross Sections Upper, and Cross Sections Lower: Set up cross section views. For more 
information, see "Building a Cross-Section X-Ray View" on page 729. 

• Nerve Canals: Locate and isolate the nerve canals on a panoramic view. For more information, see "Building a Nerve 
Canals X-Ray View" on page 738. 

• Frontal: Set up and view a frontal x-ray. For more information, see "Building a Frontal X-Ray" on page 754. 

• SMV: Set up and view a submentovertex (SMV) x-ray. For information, see "Building an SMV X-Ray" on page 760. 

To help emphasize different structures of interest, Dolphin 3D creates radiographs using several rendering filters, which appear 
as tabs on the Build X-Rays Tool window:  
Dolphin 1, 2, and 3 These filters mimic traditional film x-ray images. They balance the clarity of anatomical structures for 

orthodontic and orthognathic surgery applications. 

Ray-Sum This filter creates x-rays with the Ray-sum (the academic standard) technique. 

Emboss This filter creates x-rays with an embossing effect, which throws the hard-tissue structures into relief. 

Maximum Intensity 
Projection (MIP) 

This filter creates x-rays with a volume rendering technique specially designed to emphasize high-
intensity structures within the volumetric data.  

Traced This filter creates x-rays that focus on the outlines of anatomical structures. Since creating x-rays with 
this filter is computing-intensive, this filter is not enabled by default. 

To build and view an x-ray: 

1. Click  on the Dolphin 3D main window.  

Or, 

Select Build X-Rays... from the Tools menu. 

The Build X-Rays Tool window opens along with a radiograph setup palette on the left side of the window.  

The view that displays depends on the x-ray view you built last.  

2. To create a different x-ray view, select the view you want to create from the View drop-down list box. 

The radiograph setup palette changes to reflect the view you select. 

3. Set options for the x-ray view you want to create on the radiograph setup palette. 

4. Click Apply. 

Dolphin 3D generates the x-ray using several filters (displayed as tabs). Then, the x-ray appears in the right side of the 
Build X-Rays Tool window. The figure below illustrates the Lateral view. 
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To display this radiograph view created with a different filter: 

1. If you want to display an x-ray created using the Traced filter, check the Enable "Traced" method box. 

2. Click the tab for the filter you want to view. 

 

View Use this drop-down list box to select the type of x-ray you want to view and to set options for all x-ray 
types. 
Lateral: Select this option to set up and view a lateral x-ray. For more information, see "Building a 
Lateral X-Ray" on page 708. 
Panoramic: Select this option to set up and view a panoramic x-ray. For more information, see "Building 
a Panoramic X-Ray" on page 714. 
TMJ: Select this option to set up a TMJ view. For more information, see "Building an X-Ray View of the 
TMJ Area" on page 722. 
Cross Sections, Cross Sections Upper, and Cross Sections Lower: Set up cross section views. 
For more information, see "Building a Cross-Section X-Ray View" on page 729. 
Nerve Canals: Select this option to locate and isolate the nerve canals on a panoramic view. For more 
information, see "Building a Nerve Canals X-Ray View" on page 738. 
Frontal: Select this option to set up and view a frontal x-ray. For more information, see "Building a 
Frontal X-Ray" on page 754. 
SMV: Select this option to set up and view a submentovertex (SMV) x-ray. For more information, see 
"Building an SMV X-Ray" on page 760. 
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Auto Apply Check this box to apply the radiograph setup options without clicking the Apply button. 

Send Snapshot... 

Opens a pop-up menu with the following options: 
Close This Menu: Choose this option to close the pop-up menu. 
Save To Dolphin Layout/Database: Choose this option to save the x-ray to a slot in a Dolphin image 
layout and store it in your database.  For more information, see "To save the x-ray" on page 769. 
Send To Report: Choose this option to use this x-ray in a Dolphin 3D report. For more information, see 
Chapter 32. 
Copy To Clipboard: Choose this option to copy the x-ray to the clipboard. Then, you can paste the 
image into another application. For more information, see "To copy the x-ray to the clipboard" on page 
771. 
Print: Choose this option to print the x-ray. For more information, see "To print the current x-ray view" on 
page 773. 
Export To File: Choose this option to export the x-ray to a file. For more information, see "To export the 
x-ray to a file" on page 772. 

Enhance...  Click this button to open the Enhancement dialog box, which enables you to enhance the image after 
you create it. For more information see "Enhancing an X-Ray" on page 767. 

Seg... Click this button to open the Quick Solids Segmentation dialog box and set the segmentation to use for 
radiograph building. For more information, see "Setting the Segmentation" on page 706. 

Prefs... 
Click this button to set projection preferences for lateral, frontal, and SMV x-rays. You can create 
orthogonal (non-distorted) x-rays, or you can create perspective x-rays, which mimic the measured 
distortion and warping effects of a traditional x-ray. For more information, see "Setting Projection 
Preferences" on page 705. 

Measure 

Check this box to measure distances and angles on generated x-rays. When this box is checked, the 
following features become active: 
2 Pt Line: Select this option to measure the distance between two points. 
3 Pt Angle: Select this option to measure the angle between two lines. 
Remove All: Click this button to remove measurements from generated x-rays. 
For more information, see "Adding Measurements to an X-Ray." 

Show Landmarks If you digitized 3D landmarks for the volume, check this box to project and show these 3D points onto 
generated lateral, frontal, and SMV images. For more information, see Chapter 26. 
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Filters Click these tabs to see x-rays generated using different filters. The filters employ different algorithms to 
create the x-ray from the 3D volume data, resulting in x-ray images that emphasize different anatomical 
structures.  
Dolphin 1, 2, and 3: These filters mimic traditional film x-ray images. They balance the clarity of 
anatomical structures for orthodontic and orthognathic surgery applications. 
Ray-Sum: Click this tab to view an x-ray created with the Ray-sum (the academic standard) technique. 
Emboss: Click this tab to view an x-ray with an embossing effect. 
MIP: Click this tab to view an x-ray created with maximum intensity projection (MIP). 
Traced: Click this tab to view an x-ray that focuses on the outlines of anatomical structures. This tab 
only appears when the Enable Traced Filter box is checked (see below). When viewing x-ray images 
created with the traced method, adjusting the window leveling to lower the brightness of the display may 
make the traced outlines more visible.  

Include "Traced" 
Filter  

Check this box to add the Traced filter for creating x-rays. Since creating an x-ray using the traced filter 
requires intensive use of computing resources, this method is disabled by default. 

 
Click these arrow buttons to move the x-ray image in the window in the indicated direction. For more 
information, see "Moving or Reorienting the Image" on page 640. 

 
Click this button to zoom in on the x-ray image. For more information, see "Changing the Magnification" 
on page 640. 

 
Click this button to zoom out on the x-ray image. For more information, see "Changing the Magnification" 
on page 640. 

 
Click this button to fit the x-ray image in the window. For more information, see "Changing the 
Magnification" on page 640. 

Dolphin 1 Level 
Use this drop-down list box to set the transparency of the x-ray on the Dolphin 1 filter tab. The default is 
zero for maximum transparency in the image. Increase this number if the patient’s hard tissue is less 
dense to increase the opacity of the hard tissue for optimal x-ray visualization. 

Sharpen Adjust this slider to sharpen the image. 

Reset WL Click this button to reset the window leveling to the default setting.  For more information, see "Setting 
Window Leveling" on page 768. 
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Setting Projection Preferences 
You can construct lateral, frontal, and SMV x-rays from the 3D volume data in either of the following ways: 

• Orthogonal: Creates a non-distorted x-ray. 

• Perspective: Creates an x-ray with the measured distortion and warping effects of a traditional X-ray. You can set 
preferences so that your resulting x-rays are consistent with those produced by your existing film-based X-ray 
machine. 

To set projection preferences: 

1. Click Prefs... on the Build X-Rays Tool window. 

The Build X-rays Preferences dialog box opens. 

2. Set any preferences, and click OK. 

 

Fictitious 
Magnification Factor 

Set the magnification factor to use when generating x-rays using orthogonal projection. By default, this 
option is set to 0.0%, which indicates no magnification. If you are using Bolton-Broadbent dimensions, 
set this option to 9.7%. 

Emitter to Patient’s 
Mid Plane 

Set the distance in millimeters from the emitter to the patient’s mid-plane to use when generating x-rays 
using perspective. If you are using Bolton-Broadbent dimensions, set this option to 1550 mm. 

Mid-Plane to Film Set the distance in millimeters from patient’s mid-plane to the film to use when generating x-rays using 
perspective. If you are using Bolton-Broadbent dimensions, set this option to 150 mm. 
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Setting the Segmentation 
Before building x-rays, you should set the image segmentation that you want to use for all x-ray types. Using the Seg... button on 
the Build X-Rays Tool window, you can set soft and hard tissue segmentation specifically for generating x-rays. For example, for 
the purposes of generating x-rays, the condyles should be included in the hard-tissue segment, whereas this is not as important 
for other purposes.  
If you have not segmented the 3D image when you first open the Build X-Rays Tool window, the Quick Solids Segmentation 
dialog box opens automatically so that you can segment the image before building x-rays. Then, when you close the Build X-
Rays Tool window, your quick segmentation is used automatically as the default for the 3D image.  However, at any time, you 
can open the Solid Volume Segmentation dialog box to set the default segmentation for the 3D image.  
If you have previously set the segmentation of the 3D image on the Solid Volume Segmentation dialog box and change it on the 
Quick Solids Segmentation dialog box, Dolphin Imaging gives you the opportunity to replace your original image segmentation 
with your quick segmentation when you close the Build X-Rays Tool window. 

To set the segmentation: 

1. Click Seg... on the Build X-Rays Tool window. 

The Quick Solids Segmentation dialog box opens. 

2. Set the Soft Tissue Seg slider to identify the lower end of the density range that you want to use for the patient's soft 
tissue. 

3. Set the Hard Tissue Seg slider to identify the lower end of the density range that you want to use for the patient's hard 
tissue. 

4. Click OK. 
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Soft 
Tissue 
Seg 

Set this slider to identify the lower end of the density range that you want to use for soft tissue. For example, this 
slider would identify the boundary between the air and the patient's soft tissue. 

Hard 
Tissue 
Seg 

Set this slider to identify the lower end of the density range that you want to use for hard tissue. For example, this 
slider would identify the boundary between the patient's soft tissue and hard tissue. 

Rotation 
Sliders 

Use these sliders to rotate the image around the indicated axis: 
: Use this slider to rotate the 3D image horizontally. 
: Use this slider to rotate the 3D image circularly. 
: Use this slider to rotate the 3D image vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

Click one of these buttons to orient the 3D image in one of the predefined views. For more information, see "Moving 
or Reorienting the Image" on page 640. Predefined 

Views 

: Click this button to orient the 3D image for a right view. 

 : Click this button to orient the 3D image for a right oblique view. 

 : Click this button to orient the 3D image for a front view. 

 : Click this button to orient the 3D image for a left oblique view. 

 : Click this button to orient the 3D image for a left view. 

 : Click this button to orient the 3D image for a back view. 

 : Click this button to orient the 3D image for a top view. 

 : Click this button to orient the 3D image for a bottom view. 

 : Click this button to orient the 3D image for an isometric view. 

 : Click this button to orient the 3D image for an isometric view. 
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Click these arrow buttons to move the 3D image in the window in the indicated direction. For more information, see 
"Moving or Reorienting the Image" on page 640. 

  Click this button to zoom in on the 3D image.  For more information, see "Changing the Magnification" on page 640. 

  
Click this button to zoom out on the 3D image.  For more information, see "Changing the Magnification" on page 
640. 

  
Click this button to fit the 3D image in the window.  For more information, see "Changing the Magnification" on page 
640. 

 

Building a Lateral X-Ray 
To build a lateral x-ray, you first enter setup options on the lateral radiograph setup palette. These options determine how the x-
ray is created from the 3D volume.  

To build a lateral x-ray: 

1. Select Lateral from the View drop-down list box on the Build X-Rays Tool dialog box. 

The lateral radiograph setup palette (see below) appears on the left side of the dialog box.  

2. Set the x-ray orientation. 

For more information, see "Orienting a Lateral X-Ray" on page 710. 

3. Identify the part of the 3D volume that you want to use to create the x-ray. 

For more information, see "Selecting Part of the Volume for Lateral X-Ray Building" on page 711. 

4. Specify the type of x-ray you want to use as your default (either right lateral or left lateral). 

For more information, see "Selecting the Lateral X-Ray Type" on page 712. 

5. Configure the projection and ruler options to use when creating the x-ray. 

For more information, see "Selecting the Projection Type and Ruler Options" on page 712. 

6. Click Apply to create the x-ray using the specified options. 

The x-ray appears in the Build X-Rays Tool window. 
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Hard Tissue Click this radio button to show the 
patient’s hard tissue image on the 
palette.  

Soft Tissue Click this radio button to show the 
patient’s soft tissue image on the 
palette.  

Front tab Click this tab to show a frontal view on 
the palette.  

Left/Right tab Click this tab to show a right or left 
lateral view on the palette.  

Image Provides a preview of the current 
orientation. The red arrows indicate the 
direction from which the x-ray will be 
taken. 

Half Click this button to select the half of 
the volume typically used to create the 
selected x-ray type. For example, if 
you select Right Lateral as the x-ray 
type, this button selects the half of the 
volume on the patient's right.  

 

Other Half 
 

Click this button to select the other half of the volume to create the selected x-ray type. For example, if 
you select Right Lateral as the x-ray type, this button selects the half of the volume on the patient's left.  

Both Click this button to select both halves of the volume.  

Reset Orientation Click this button to return the orientation to the default. 

X-ray Type Select the type of x-ray (either Right Lateral or Left Lateral) that you want to create.  

Options... Click to bring up the Lateral Options dialog box, where you can select Projection Type and Ruler options.  

Apply Click this button to apply the settings specified on the palette to build the x-ray image. 

For more information on these controls, see "Orienting a Lateral X-Ray" below, "Selecting Part of the Volume for Lateral X-Ray 
Building" on page 711, "Selecting the Lateral X-Ray Type" on page 712, and "Selecting the Projection Type and Ruler Options" 
 on page 712. 
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Orienting a Lateral X-Ray 
Before building x-rays for this patient, you may need to change the image orientation of the 3D volume so that the x-rays are 
created correctly. To orient the 3D volume, you rotate the image until both the frontal and right views are oriented correctly, both 
horizontally and vertically. You may want to switch between the patient's hard tissue and soft tissue images to help you properly 
orient the x-ray. 

To change the view to hard or soft tissue: 

1. Select Hard Tissue to view the hard tissue image. 

Or, 

Select Soft Tissue to view the soft tissue image. 

To rotate the volume clockwise or counter-clockwise: 

1. Place your mouse cursor over the edge of the image on the palette. 

2. When your cursor turns into a rotation icon, click and drag to rotate the image clockwise or counter-clockwise (see 
below). 

 

To spin the volume around a horizontal or vertical axis: 

1. Click the hard or soft tissue image. 

2. When your cursor turns into a hand pointer, drag the mouse left or right to spin the image around a vertical axis. 

Or, 

When your cursor turns into a hand pointer, drag the mouse up or down to spin the image around a horizontal axis. 
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To check the orientation: 

1. Click the Front tab to check the orientation using the frontal view. 

2. Click the Right tab to check the orientation using the right lateral view. 

To return to the original orientation: 

1. Click Reset Orientation. 

Selecting Part of the Volume for Lateral X-Ray Building 
When you build x-rays, you can use the entire 3D volume or you can select only part of the volume. Selecting part of the volume 
enables you to focus on particular areas of interest. 

To select a part of the volume for x-ray building: 

1. Click the Front tab if it isn't already selected. 

2. Click Half to select the half of volume typically used to create the selected x-ray type. 

Or, 

Click Other Half to select the other half of volume. 

Or, 

Click Both to select both sides of the volume. 

For example, if you select Right Lateral as the x-ray type, clicking Half selects the half of the volume on the patient's 
right, and clicking Other Half selects the half of the volume on the patient's left.  

3. If you selected Half or Other Half, optionally click and drag the midline to identify one boundary of the part of the 
volume you want to select. 
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Click and drag when your mouse pointer turns into a double-headed arrow. 

4. Optionally, click and drag the edges of the image to identify boundaries of the part of the volume you want to select. 

Click and drag when your mouse pointer turns into a double-headed arrow. 

The following figure illustrates picking different parts of the volume for x-ray building. The highlighted part of the image 
indicates the selected area. 

 

Selecting the Lateral X-Ray Type 
You can create either a right lateral or left lateral x-ray. 

To set the type of lateral x-rays you want to create: 

1. Click Right Lateral to create lateral x-rays in which the patient's image faces right. 

Or, 

Click Left Lateral to create lateral x-rays in which the patient's image faces left. 

 

Selecting the Projection Type and Ruler Options 
You can construct x-rays from the 3D volume data in using one of the following projection types: 

• Orthogonal: Creates a non-distorted x-ray. 

• Perspective: Creates an x-ray with the measured distortion and warping effects of a traditional X-ray. You can also set 
projection preferences so that your resulting x-rays are consistent with those produced by your existing film-based X-
ray machine. 

You can set the projection center point to use when creating x-rays with either of these projection types. 
You can also set options for the type of ruler you want to display on the x-ray. 
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To specify the projection type to use: 

1. Click Options... 

The Options dialog box appears. 

 

2. In the Projection Type group box, select Orthogonal to create non-distorted x-rays. 

Or, 

Select Perspective to mimic x-rays created traditional, film-based X-ray equipment. 

If you selected Perspective, set the projection center point as described below. 

To set ruler options: 

1. In the Ruler group box, use the Type drop-down list box to specify the type of ruler to display on the x-ray: 

� Tickmarks: Displays the ruler. 
� 100 mm bar: Displays a solid bar 100 millimeters in length. 
� None: Suppresses display of the ruler. 

2. Use the Location drop-down list box to set the location for the ruler on the x-ray: either Left, Right, Top, or Bottom. 

To set the projection center point: 

1. Click Projection Center.... 

The Center of Perspective Projection dialog box opens. 

2. Select Hard Tissue to use the patient's hard tissue image when selecting the projection center point. 

Or, 

Select Soft Tissue to use the patient's soft tissue image. 

3. Using the frontal image, click and drag the vertical line to the mid-sagittal plane. 

4. Using the lateral image, click and drag the two lines until they cross at the mechanical porion. 

5. Click OK. 
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Midsagittal Plane on Frontal Click and drag the vertical line on this image to identify the mid-sagittal plane. 

Mechanical Porion Click and drag the two lines on this image until they cross at the mechanical porion. 

Hard Tissue Select this option to view the patient's hard tissue. 

Soft Tissue Select this option to view the patient's soft tissue. 

Building a Panoramic X-Ray 
To build a panoramic x-ray, you first enter setup options on the Panoramic Radiograph Setup palette. These options determine 
how the x-ray is created from the 3D volume.  

To build a panoramic x-ray: 

1. Select Panoramic from the View drop-down list box on the Build X-Rays Tool dialog box. 

The Panoramic Radiograph Setup palette opens (see below).  

2. Set the x-ray orientation. 

For more information, see "Orienting a Panoramic X-Ray" on page 716. 

3. Identify the part of the 3D volume that you want to use to create the x-ray. 

For more information, see "Selecting Part of the Volume for Panoramic X-Ray Building" on page 718. 

4. Configure the projection and ruler options to use when creating the x-ray.  
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For more information, see "To set panoramic advanced options" on page 721. 

5. Click Apply to create the x-ray using the specified options. 

The x-ray appears in the Build X-Rays Tool dialog box. 

Right tab Click this tab to show a right lateral 
view on the palette.  

Front tab Click this tab to show a frontal view on 
the palette.  

Left tab Click this tab to show a left lateral view 
on the palette.  

Collimate 
Image 

Provides a preview of the current 
orientation and the height of the 
panoramic x-ray. You can use the blue 
lines as guides in orienting the image. 
The red line identifies the volume slice 
shown in the Arch Path image.  
Note: The red line does not appear if 
you are using the translucent view for 
the arch path image (see below). In the 
translucent view, the arch path image 
is constructed from the entire volume. 

Reset 
Orientation 

Click this button to return the 
orientation to the default. 

Arch Path: 
Translucent 
View 

Check this box to use a translucent 
view in the arch path image (see 
below). 

Arch Path 
Image 

Shows the volume slice identified by 
the red line on the Collimate image. 
You use this image to specify a 
projection path and set the depth of the 
volume used to create the panoramic 
x-ray.  

Redo Path Click this button to erase your current 
projection path. 

Options... Click this button to set options for the 
ruler and projection path.  
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Apply Click this button to apply the settings specified on the palette to build the x-ray image. 

Anterior (Buccal) Use this slider to set the width of the area on the anterior side of the projection path to use when 
creating the x-ray image.  

Posterior (Lingual) Use this slider to set the width of the area on the posterior side of the projection path to use when 
creating the x-ray image.  

Uniform Thickness 
Select the total width (in millimeters) of the area surrounding the projection path to use when creating 
the x-ray image. Both the Anterior (Buccal) and Posterior (Lingual) sliders are set automatically to one-
half the selected width.  

For more information on these controls, see "Selecting Part of the Volume for Panoramic X-Ray Building" on page 718 and "To 
set panoramic advanced options" on page 721. 

Orienting a Panoramic X-Ray 
Before building x-rays for this patient, you may need to change the image orientation of the 3D volume so that the x-rays are 
created correctly. To orient the 3D volume, you rotate the image until the right, frontal, and left views are oriented correctly, both 
horizontally and vertically. You can use the dotted blue lines as guides when orienting the image. 
During this step, you also position the red horizontal guideline at the occlusal plane unless you are using the Translucent View of 
the Arch Path image. 

To move the blue midline: 

1. Click and drag the midline to a new location. 

Click and drag when your mouse pointer turns into a double-headed arrow.  For example, you can place the midline at 
the mid-sagittal plane and check the volume's orientation using both images on the palette, as shown below: 
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To move the red horizontal guideline (not applicable when using the Translucent View of the Arch Path image): 

1. Click and drag the guideline to a new location. 

Or, 

Place your mouse over the Collimate image, and use the wheel on your mouse to move the red guideline. 

Click and drag when your mouse pointer turns into a double-headed arrow.  

To zoom the arch path image on the palette: 

1. Place your mouse over the Arch Path image, and use the wheel on your mouse to change the magnification. 

To rotate the volume clockwise or counter-clockwise: 

1. Place your mouse cursor over the edge of the image. 

2. When your cursor turns into a rotation icon, click and drag to rotate the image clockwise or counter-clockwise (see 
below). 

 

To spin the volume around a horizontal or vertical axis: 

1. Click the image. 

2. When your cursor turns into a hand pointer, drag the mouse left or right to spin the image around a vertical axis. 

Or, 

When your cursor turns into a hand pointer, drag the mouse up or down to spin the image around a horizontal axis. 
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To check the orientation: 

1. Click the Right tab to check the orientation using the right lateral view. 

2. Click the Front tab to check the orientation using the frontal view. 

3. Click the Left tab to check the orientation using the left lateral view. 

To return to the original orientation: 

1. Click Reset Orientation. 

Selecting Part of the Volume for Panoramic X-Ray Building 
On the panoramic radiograph image palette, you identify the height of the panoramic x-ray and the projection path used to create 
it.  

To set the height of the x-ray: 

1. On the Collimate image, click and drag the edges of the highlighted portion of the image to identify the part of the 
volume you want to include in the panoramic x-ray. 

The x-ray radiograph will include the highlighted portions of the image, as illustrated below: 
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To set the projection path: 

1. Optionally, check the Arch Path: Translucent View box to use a translucent view when drawing the projection path. 

2. On the Collimate image, click and drag the red cross-section line so that the patient's teeth are clearly visible in the 
Arch Path image.  

Click and drag when your mouse pointer turns into a double-headed arrow. In most cases, you use the patient's upper 
arch as a guide to specify the projection path. 

Note: The red line does not appear if you are using the translucent view for the arch path image. In the translucent 
view, the arch path image is constructed from the entire volume. 

3. On the Arch Path image, click the left mouse button on the location where you want the projection path to begin.  

A red point appears on the image. 

4. Release the mouse button and move the mouse to begin drawing the path. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position.  

5. Click the mouse button whenever you want to place a point and change the direction of the line.  

6. To complete the projection path, double-click the left mouse button at the end of the path. 

A pink polygon appears on the image indicating a cross-section of the part of the volume that will be included in the 
panoramic x-ray. In the following figure, the image on the left illustrates the arch path with the Translucent View box 
unchecked. The image on the right illustrates the arch path with the Translucent View box checked. 
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You can adjust the thickness of this selected area as described below. 

Once you have drawn the protection path, you can move points along it to fine tune it. 

To fine tune the protection path: 

1. Click and drag one or more of the red points along the projection path. 

To erase your projection path and begin again: 

1. Click Redo Path to erase both the red projection path and the pink polygon. 
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To adjust the thickness of the volume used for the x-ray: 

1. Move the Anterior (Buccal) and Posterior (Lingual) sliders to set the width of the selected area on either side of the 
projection path. 

Or, 

Select a total width in millimeters from the Uniform Thickness drop-down list box to select an area of the same 
thickness on either side of the projection path. 

For example, if you select 14 mm from the Uniform Thickness drop-down list box, both the Anterior (Buccal) and 
Posterior (Lingual) sliders are set automatically to 7 mm. 

To set panoramic advanced options: 

1. Click Options.... 

The Panoramic Advanced Options dialog box opens.  

2. Use the Ruler Type drop-down list box to specify the type of ruler to display on the x-ray. 

3. Use the Ruler Location drop-down list box to set the location for the ruler on the x-ray. 

4. In the Arch Path Thickness Clamping group box, set the thickness of the volume used at the last and next to last points 
at either end of the projection path to create the volume.  

For example, you can use a narrower area to create the x-ray at the ends of the projection path. 

5. Click OK. 

 

Ruler Type 

Specify the type of ruler to display on the x-ray: 
� Tickmarks: Displays the ruler. 
� 100 mm bar: Displays a solid bar 100 millimeters in length. 
� None: Suppresses display of the ruler. 

Ruler Location Set the location for the ruler on the x-ray: either Left, Right, Top, or Bottom. 
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Last Points to Select the width in millimeters that you want to use on either side of the projection path at the points at either 
end of the path.  

2nd Last Points 
to 

Select the width in millimeters that you want to use on either side of the projection path at the next to last 
point at either end of the path. 

Building an X-Ray View of the TMJ Area 
The TMJ view is a series of x-ray images, each representing a slice of the volume in the temporomandibular joint area. To build 
an x-ray view of the TMJ area, you first enter setup options on the TMJ Setup palette. These options determine how the x-ray 
images are created from the 3D volume.  

To build an x-ray view of the TMJ area: 

1. Select TMJ from the View drop-down list box on the Build X-Rays Tool dialog box. 

The TMJ Radiograph Setup palette opens (see below).  

2. Set the x-ray orientation. 

For more information, see "Orienting the TMJ View X-Rays" on page 724. 

3. Identify the part of the 3D volume that you want to use to create the x-ray view. 

For more information, see "Selecting Part of the Volume for TMJ X-Ray Building" on page 726. 

4. Click Apply to create the TMJ view x-rays using the specified options. 

The TMJ view appears in the Build X-Rays Tool dialog box. 
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Right tab Click this tab to show a right lateral 
view on the palette.  

Front tab Click this tab to show a frontal view on 
the palette.  

Left tab Click this tab to show a left lateral view 
on the palette.  

Collimate Image 

Provides a preview of the current 
orientation and the height of the x-ray. 
You can use the blue lines as guides in 
orienting the image. The red line 
identifies the volume slice shown in the 
Arch Path image.  

Reset 
Orientation 

Click this button to return the 
orientation to the default. 

Arch Path 
Image 

Shows the volume slice identified by 
the red line on the Collimate image. 
You use this image to specify a 
projection path and set the depth of the 
volume used to create the x-ray.  

Apply 
Click this button to apply the settings 
specified on the palette to build the x-
ray image. 

Thickness Select the thickness for each slice in 
the TMJ view you want to create.  

Direction Select the direction of the slices 
(Coronal, Sagittal, or Circular). 

Width Select the width for each slice image in 
the TMJ view you want to create.  

 
 
 

Cuts Select the number of slices you want to create. Each cut results in one image for each temporomandibular joint. For 
example, selecting 8 from this drop-down list box creates 16 images--8 for the left side and 8 for the right side.  

Slice 
Layout Select the layout that you want to use to view the slice images in the Build X-Rays Tool dialog box.  
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For more information on these controls, see "Selecting Part of the Volume for TMJ X-Ray Building" on page 726. 

Orienting the TMJ View X-Rays 
Before building x-rays for this patient, you may need to change the image orientation of the 3D volume so that the x-rays are 
created correctly. To orient the 3D volume, you rotate the image until the right, frontal, and left views are oriented correctly, both 
horizontally and vertically. During this step, you also position the red horizontal guideline at the occlusal plane. 

To zoom the bottom image on the palette: 

1. Place your mouse over the bottom image, and use the wheel on your mouse to change the magnification. 

To rotate the volume clockwise or counter-clockwise: 

1. Place your mouse cursor over the edge of the image. 

2. When your cursor turns into a rotation icon, click and drag to rotate the image clockwise or counter-clockwise (see 
below). 

 

To spin the volume around a horizontal or vertical axis: 

1. Click the image. 

2. When your cursor turns into a hand pointer, drag the mouse left or right to spin the image around a vertical axis. 

Or, 

When your cursor turns into a hand pointer, drag the mouse up or down to spin the image around a horizontal axis. 
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To check the orientation: 

1. Click the Right tab to check the orientation using the right lateral view. 

2. Click the Front tab to check the orientation using the frontal view. 

3. Click the Left tab to check the orientation using the left lateral view. 

To return to the original orientation: 

1. Click Reset Orientation. 

To move the red horizontal guideline: 

1. Click and drag the guideline to a new location. 

Or, 

Place your mouse over the top image, and use the wheel on your mouse to move the red guideline. 

Click and drag when your mouse pointer turns into a double-headed arrow.  
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Selecting Part of the Volume for TMJ X-Ray Building 
On the TMJ radiograph image palette, you identify the height of the x-rays, and the projection path and slices used to create 
them. You also specify the layout you want to use to view them. 

To set the height of the x-ray: 

1. On the Collimate image, click and drag the edges of the highlighted portion of the image to identify the part of the 
volume you want to include in the x-rays. 

The x-ray radiographs will include the highlighted portions of the image, as illustrated below: 
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To set the projection path: 

1. On the Collimate image, click and drag the red cross-section line so that the patient's teeth are clearly visible in the 
Arch Path image.  

Click and drag when your mouse pointer turns into a double-headed arrow. In most cases, you use the patient's upper 
arch as a guide to specify the projection path. 

2. On the Projection Path image, click and drag the red points to identify the projection path.  

Click and drag when the mouse pointer turns into a black arrow, as shown below. 
 

 
3. In the Slice Dimensions group box, set the thickness, width, direction, and number of cuts for the slices you want to 

create. 

4. Optionally, select the layout that you want to use for viewing the slices from the Slice Layout drop-down list box. 

5. Click Apply to create the TMJ view. 
 
The right side of the Build X-Rays Tool window splits into two views. You can now examine the series of slices and 
analyze the temporomandibular joint. 
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Viewing a Slice Close-up 
Once you have created a slice montage, you can view a close-up of a single slice.  

To view a slice close-up: 

1. Right-click a slice in the montage. 

2. Select Show This Slice in a Large Window. 

The Slice View window opens.  

To view another slice in the Slice View window: 

1. Use the scrollbar or the middle mouse scroll wheel. 
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Sharpen Adjust this slider to sharpen the image. 

Reset WL Click this button to reset the window leveling to the default setting.  For more information, see "Setting 
Window Leveling" on page 768. 

Send Snapshot... 

Opens a pop-up menu with the following options: 
Close This Menu: Choose this option to close the pop-up menu. 
Save To Dolphin Layout/Database: Choose this option to save the 3D image to a slot in a Dolphin 
image layout and store it in your database. For more information, see "Saving an Image" on page 661. 
Send To Report: Choose this option to use this image in a Dolphin 3D report. For more information, see 
Chapter 32. 
Copy To Clipboard: Choose this option to copy the 3D image to the clipboard. Then, you can paste the 
image into another application. For more information, see "Copying the Image to the Clipboard" on page 
663. 
Print: Choose this option to print the image. For more information, see "Printing an Image" on page 664. 
Export To File: Choose this option to export the 3D image to a file. For more information, see "Exporting 
an Image" on page 663. 

Building a Cross-Sections X-Ray View 
A cross-sections view is a series of x-ray images, each representing a slice of the volume in a specific area. Dolphin 3D offers 
three cross-sections views, enabling you to generate three sets of cross-section images: 
Cross Sections Intended for cross-section images of both the upper and lower arches. 

Cross Sections 
Upper 

Intended for cross-section images of the upper arch. 

Cross Sections 
Lower 

Intended for cross-section images of the lower arch. 

You build these three views in the same way. The only difference is the part of the volume you select for x-ray building. 

To build a cross-sections x-ray view: 

1. Select Cross Sections, Cross Sections Upper, or Cross Sections Lower from the View drop-down list box on the Build 
X-Rays Tool dialog box. 

The Cross-Sections Radiograph Setup palette opens (see below).  

2. Set the x-ray orientation. 

For more information, see "Orienting the Cross-Section View X-Rays" on page 731. 

3. Identify the part of the 3D volume that you want to use to create the x-ray view. 

For more information, see "Selecting Part of the Volume for Cross-Section X-Ray Building" on page 726. 

4. Click Apply to create the cross-section view x-rays using the specified options. 

The cross-section view appears in the Build X-Rays Tool dialog box. 
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Right tab Click this tab to show a right lateral view 
on the palette.  

Front tab Click this tab to show a frontal view on 
the palette.  

Left tab Click this tab to show a left lateral view 
on the palette.  

Collimate 
Image 

Provides a preview of the current 
orientation and the height of the x-ray. 
You can use the blue lines as guides in 
orienting the image. The red line 
identifies the volume slice shown in the 
Arch Path image.  
Note: The red line does not appear if 
you are using the translucent view for 
the arch path image (see below). In the 
translucent view, the arch path image is 
constructed from the entire volume. 

Reset 
Orientation 

Click this button to return the orientation 
to the default. 

Arch Path: 
Translucent 
View 

Check this box to use a translucent view 
in the arch path image (see below). 

Arch Path 
Image 

Shows the volume slice identified by the 
red line on the Collimate image. You 
use this image to specify a projection 
path and set the depth of the volume 
used to create the x-ray images.  

Redo Path Click this button to erase your current 
projection path. 

Pano 
Thickness 

Use this drop-down list box to select the 
total width (in millimeters) of the area 
surrounding the projection path. 
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Apply Click this button to apply the settings specified on the palette to build the x-ray images. 

Thickness Select the thickness for each slice in the cross-section view you want to create. 

Spacing Specify the spacing for the slice group. Select <-Same As to use the same value for slice spacing and 
thickness. 

Width Select the width for each slice image in the cross-sections view you want to create. 

Cuts Select the number of slices you want to create if you specified uniform spacing. Select the number of degrees 
for each slice if you selected circular spacing. Each cut results in one image. 

Groups Specify how many slice groups you want to use. 

Slice Layout Select the layout that you want to use to view the slice images in the Build X-Rays Tool dialog box. 

For more information on these controls, see "Selecting Part of the Volume for Cross-Sections X-Ray Building" on page 733. 

Orienting the Cross-Sections View X-Rays 
Before building x-rays for this patient, you may need to change the image orientation of the 3D volume so that the x-rays are 
created correctly. To orient the 3D volume, you rotate the image until the right, frontal, and left views are oriented correctly, both 
horizontally and vertically.  
During this step, you also position the red horizontal guideline at the occlusal plane unless you are using the Translucent View of 
the Arch Path image. You can optionally display and position the midline. 

To zoom the bottom image on the palette: 

1. Place your mouse over the bottom image, and use the wheel on your mouse to change the magnification. 

To rotate the volume clockwise or counter-clockwise: 

1. Place your mouse cursor over the edge of the image. 

2. When your cursor turns into a rotation icon, click and drag to rotate the image clockwise or counter-clockwise (see 
below). 
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To spin the volume around a horizontal or vertical axis: 

1. Click the image. 

2. When your cursor turns into a hand pointer, drag the mouse left or right to spin the image around a vertical axis. 

Or, 

When your cursor turns into a hand pointer, drag the mouse up or down to spin the image around a horizontal axis. 

 

To check the orientation: 

1. Click the Right tab to check the orientation using the right lateral view. 

2. Click the Front tab to check the orientation using the frontal view. 

3. Click the Left tab to check the orientation using the left lateral view. 

To return to the original orientation: 

1. Click Reset Orientation. 
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To move the red horizontal guideline (not applicable when using the Translucent View of the Arch Path image): 

1. Click and drag the guideline to a new location. 

Or, 

Place your mouse over the top image, and use the wheel on your mouse to move the red guideline. 

Click and drag when your mouse pointer turns into a double-headed arrow.  

To move the blue midline: 

1. Check the Use Midline box to display the midline on the Arch Path image. 

2. Click and drag the midline to a new location. 

Click and drag when your mouse pointer turns into a double-headed arrow.  

The following figure illustrates the midline displayed on the Arch Path image. 

 

  

Selecting Part of the Volume for Cross-Section X-Ray Building 
On the Cross-Section radiograph image palette, you identify the height of the x-rays, and the projection path and slices used to 
create them. You also specify the layout you want to use to view them. 

To set the height of the x-ray: 

1. On the Collimate image, click and drag the edges of the highlighted portion of the image to identify the part of the 
volume you want to include in the x-rays. 

The x-ray radiographs will include the highlighted portions of the image, as illustrated below: 
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To set options for your custom cross-section: 

1. On the Collimate image, click and drag the red horizontal guideline so that the patient's arch appears in the Arch Path 
image.  

Click and drag when your mouse pointer turns into a double-headed arrow.  

Note: The red line does not appear if you are using the translucent view for the arch path image (see below). In the 
translucent view, the arch path image is constructed from the entire volume. 

2. From the Pan Thickness drop-down list box, select the total width (in millimeters) for the area surrounding the 
projection path. 

3. In the Slice Group Dimensions group box, specify the following options for creating slices for your custom cross-
sections of the volume. 

Thickness Select the thickness for each slice in the cross-section view you want to create. 

Spacing Specify uniform or circular spacing for the slice group. 

Width Select the width for each slice image in the cross-section view you want to create. 

Cuts Select the number of slices you want to create if you specified uniform spacing. Select the number of 
degrees for each slice if you selected circular spacing. Each cut results in one image. 

4. From the Groups drop-down list box, specify how many slice groups you want to use. 

Each slice group is created using the options specified in the Slice Group Dimensions group box. 

To draw the projection path: 

1. Optionally, check the Arch Path: Translucent View box to use a translucent view when drawing the projection path. 

Note: The red line does not appear on the Collimate image if you are using the translucent view for the arch path 
image. In the translucent view, the arch path image is constructed from the entire volume. 
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In most cases, you use the patient's upper arch as a guide to specify the projection path. 

2. On the Arch Path image, click the left mouse button on the location where you want the projection path to begin.  

A red point appears on the image. 

3. Release the mouse button and move the mouse to begin drawing the path. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position.  

4. Click the mouse button whenever you want to place a point and change the direction of the line.  

5. To complete the projection path, double-click the left mouse button at the end of the path. 

A pink polygon appears on the image indicating a cross-section of the part of the volume that will be included in the x-
rays. A yellow representation of the slices created using the options specified in the Slice Group Dimensions group box 
and the Groups drop-down list box also appears, as illustrated below. The following figure illustrates the arch path with 
the Translucent View box checked:  

 
Once you have drawn the protection path, you can move points along it to fine tune it. 



Dolphin Imaging User's Guide April 2011 

736 DI_USER_GUIDE-11.5   Rev. 1.01 

To fine tune the protection path: 

1. Click and drag one or more of the red points along the projection path. 

To erase your projection path and begin again: 

1. Click Redo Path to erase both the red projection path and the pink polygon. 

Initially, the slice groups are in default positions.  However, you can easily change the location of the slice groups to create a 
custom cross-section view. 

To move a slice group: 

1. Click and drag the red line for a slice group to a different location along the projection path. 

Click and drag when your mouse pointer turns into four triangles, as illustrated below. The following figure illustrates 
the Arch Path without the Translucent View box checked. 

 

To create your custom cross-section view: 

1. Optionally, select the layout that you want to use for viewing the slices from the Slice Layout drop-down list box. 

2. Click Apply. 

The image is displayed in the upper right portion of the Build X-Rays dialog box, and each numbered slice is displayed 
in the lower right portion of the dialog box. 
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Viewing a Slice Close-up 
Once you have created a slice montage, you can view a close-up of a single slice.  

To view a slice close-up: 

1. Right-click a slice in the montage. 

2. Select Show This Slice in a Large Window. 

The Slice View window opens.  

To view another slice in the Slice View window: 

1. Use the scrollbar or the middle mouse scroll wheel. 
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Sharpen Adjust this slider to sharpen the image. 

Reset WL Click this button to reset the window leveling to the default setting.  For more information, see "Setting 
Window Leveling" on page 768. 

Send Snapshot... 

Opens a pop-up menu with the following options: 
Close This Menu: Choose this option to close the pop-up menu. 
Save To Dolphin Layout/Database: Choose this option to save the 3D image to a slot in a Dolphin 
image layout and store it in your database. For more information, see "Saving an Image" on page 661. 
Send To Report: Choose this option to use this image in a Dolphin 3D report. For more information, see 
Chapter 32. 
Copy To Clipboard: Choose this option to copy the 3D image to the clipboard. Then, you can paste the 
image into another application. For more information, see "Copying the Image to the Clipboard" on page 
663. 
Print: Choose this option to print the image. For more information, see "Printing an Image" on page 664. 
Export To File: Choose this option to export the 3D image to a file. For more information, see "Exporting 
an Image" on page 663. 

Building a Nerve Canals X-Ray View 
A nerve canals view is a series of x-ray images, each representing a slice of the volume in a specific area, with the nerve canals 
marked.  
Note: Once you have marked the nerve canals, you can view them on the patient's hard tissue image in the main Dolphin 3D 
window. For more information, see "To view nerve canals on the patient’s hard tissue image" on page 628. 
To build a nerve canals view, you first enter setup options on the Nerve Canals palette. These options determine how the x-ray 
images are created from the 3D volume.  

To build a nerve canals x-ray view: 

1. Select Nerve Canals from the View drop-down list box on the Build X-Rays Tool dialog box. 

The Nerve Canals Radiograph Setup palette opens (see below).  

2. Set the x-ray orientation. 

For more information, see "Orienting a Nerve Canals View X-Ray" on page 740. 

3. Identify the part of the 3D volume that you want to use to create the x-ray view. 

For more information, see "Selecting Part of the Volume for Nerve Canals X-Ray Building" on page 747. 

4. Click Apply to create the nerve canals view x-rays using the specified options. 

The nerve canals view appears in the Build X-Rays Tool dialog box. 
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Right tab Click this tab to show a right lateral 
view on the palette.  

Front tab Click this tab to show a frontal view 
on the palette.  

Left tab Click this tab to show a left lateral 
view on the palette.  

Collimate Image 

Provides a preview of the current 
orientation and the height of the x-
ray. You can use the blue lines as 
guides in orienting the image. The 
red line identifies the volume slice 
shown in the Arch Path image.  
Note: The red line does not appear 
if you are using the translucent view 
for the arch path image (see below). 
In the translucent view, the arch 
path image is constructed from the 
entire volume. 

Arch Path: 
Translucent View 

Check this box to use a translucent 
view in the arch path image (see 
below). 

Reset Orientation Click this button to return the 
orientation to the default. 

Arch Path Image 

Shows the volume slice identified by 
the red line on the Collimate image. 
You use this image to specify a 
projection path and set the depth of 
the volume used to create the x-ray 
images.  

Redo Path Click this button to erase your 
current projection path. 

Pano Thickness 
Use this drop-down list box to select 
the total width (in millimeters) of the 
area surrounding the projection 
path. 
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Apply Click this button to apply the settings specified on the palette to build the x-ray images. 

Thickness Select the thickness for each slice in the nerve canals view you want to create. 

Spacing Specify the spacing for the slice group. Select <-Same As to use the same value for slice spacing and 
thickness. 

Width Select the width for each slice image in the nerve canals view you want to create. 

Cuts Select the number of slices you want to create. Each cut results in one image. 

Groups Specify how many slice groups you want to use. 

Show Canals Check this box to show the nerve canals on the Arch Path image. 

Edit... Opens the Nerve Canal Editing dialog box so that you can specify the width, color, and transparency of the 
nerve canal marker. You can also specify whether or not you want to mark the mental foramina. 

Slice Layout Select the layout that you want to use to view the slice images in the Build X-Rays Tool dialog box. 

For more information on these controls, see "Selecting Part of the Volume for Nerve Canals X-Ray Building" on page 747, 
"Marking the Mental Foramina" on page 742, and "Marking the Nerve Canal" on page 745. 

Orienting a Nerve Canals View X-Ray 
Before building x-rays for this patient, you may need to change the image orientation of the 3D volume so that the x-rays are 
created correctly. To orient the 3D volume, you rotate the image until the right, frontal, and left views are oriented correctly, both 
horizontally and vertically.  
During this step, you also can position the red horizontal guideline (unless you are using the Translucent View of the Arch Path 
image) and optionally display and position the midline. 

To zoom the bottom image on the palette: 

1. Place your mouse over the bottom image, and use the wheel on your mouse to change the magnification. 

To rotate the volume clockwise or counter-clockwise: 

1. Place your mouse cursor over the edge of the image. 

2. When your cursor turns into a rotation icon, click and drag to rotate the image clockwise or counter-clockwise (see 
below). 



25 Building X-Rays Part X: 3D 

DI_USER_GUIDE-11.5   Rev. 1.01 741 

 

To spin the volume around a horizontal or vertical axis: 

1. Click the image. 

2. When your cursor turns into a hand pointer, drag the mouse left or right to spin the image around a vertical axis. 

Or, 

When your cursor turns into a hand pointer, drag the mouse up or down to spin the image around a horizontal axis. 

 

To check the orientation: 

1. Click the Right tab to check the orientation using the right lateral view. 

2. Click the Front tab to check the orientation using the frontal view. 

3. Click the Left tab to check the orientation using the left lateral view. 

To return to the original orientation: 

1. Click Reset Orientation. 
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To move the red horizontal guideline (not applicable when using the Translucent View of the Arch Path image): 

1. Click and drag the guideline to a new location. 

Or, 

Place your mouse over the top image, and use the wheel on your mouse to move the red guideline. 

Click and drag when your mouse pointer turns into a double-headed arrow.  

To move the blue midline: 

1. Check the Use Midline box to display the midline on the Arch Path image. 

2. Click and drag the midline to a new location. 

Click and drag when your mouse pointer turns into a double-headed arrow.  

The following figure illustrates positioning the red horizontal guideline and the midline. 

 

Marking the Mental Foramina 
Before you mark the nerve canals on the patient's x-ray, you may want to mark the mental foramina. Once marked, the mental 
foramina appear as yellow dots on the panoramic image in the upper right portion of the Build X-Rays dialog box. 
You can delete these markers at any time using the Nerve Canal Editing dialog box. For more information, see "Editing a Nerve 
Canal Image" on page 753. 

To mark the mental foramina: 
1. On the Nerve Canals palette, click Edit. 

 
The Nerve Canal Editing dialog box is displayed. 

2. In the Mental Foramina group box, click Define. 
 
The Define Mental Foramina dialog box is displayed. 

3. Using the mouse, click and drag the red dots on the image to each foramen. 
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4. Click OK. 

 

Image Click and drag the red dots on the image to each foramen. 

Rotation 
Sliders 

Use these sliders to rotate the image around the indicated axis: 
: Use this slider to rotate the 3D image horizontally. 
: Use this slider to rotate the 3D image circularly. 
: Use this slider to rotate the 3D image vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

Click one of these buttons to orient the 3D image in one of the predefined views. For more information, 
see "Moving or Reorienting the Image" on page 640. Predefined 

Views 

: Click this button to orient the 3D image for a right view. 

 : Click this button to orient the 3D image for a right oblique view. 

 : Click this button to orient the 3D image for a front view. 
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 : Click this button to orient the 3D image for a left oblique view. 

 : Click this button to orient the 3D image for a left view. 

 : Click this button to orient the 3D image for a back view. 

 : Click this button to orient the 3D image for a top view. 

 : Click this button to orient the 3D image for a bottom view. 

 : Click this button to orient the 3D image for an isometric view. 

 : Click this button to orient the 3D image for an isometric view. 

 
Click these arrow buttons to move the 3D image in the window in the indicated direction. For more 
information, see "Moving or Reorienting the Image" on page 640. 

  
Click this button to zoom in on the 3D image. For more information, see "Changing the Magnification" on 
page 640. 

  
Click this button to zoom out on the 3D image. For more information, see "Changing the Magnification" 
on page 640. 

 
Click this button to fit the 3D image in the window. For more information, see "Changing the 
Magnification" on page 640. 

Show Hidden 
Points  

Check this to see the foramina points even if they are rotated behind the volume. 
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Marking the Nerve Canals 
Once you have marked the mental foramina (see above), they appear as yellow dots on a panoramic image in the upper right 
portion of the Build X-Rays dialog box, as shown below. You can use these markers as a guide when marking the nerve canals. 

 

To mark the nerve canals: 

1. On the panoramic image in the upper right portion of the Build X-Rays dialog box, click and drag the red dots as 
needed to reveal the nerve canals. 

Click and drag when the mouse pointer turns into four triangles surrounding the red dot. Clicking and dragging the red 
dots changes the arch path that appears in the Arch Path image. You can add or remove red dots, if necessary, as 
described below. 

Once you have a clear view of a nerve canal, you can mark it. 

2. On the panoramic image, click the left mouse button on the location where you want to begin drawing the nerve canal.  

A red point appears on the panoramic image. 

3. Release the mouse button and move the mouse to begin drawing the nerve canal. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position. By default, the line is 
green, but you can change its color on the Nerve Canal Editing dialog box.  For more information, see "Editing a Nerve 
Canal Image" on page 753. 

4. Click the mouse button whenever you want to place a point and change the direction of the line.  

5. To complete the nerve canal, double-click the left mouse button at the end of the line. 

As you draw the nerve canal, a dot appears on each slice to show the location of the nerve in that slice. By default, the 
dot is green, but you can change its color on the Nerve Canal Editing dialog box.  
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To add another red dot to the panoramic image: 

1. Right-click the location on the horizontal red line where you want to add a new dot. 

2. On the confirmation dialog box that appears, click Yes. 

To remove a red dot from the panoramic image: 

1. Right-click the red dot you want to remove. 

2. On the confirmation dialog box that appears, click Yes. 

To change the position of a point on the nerve canal drawing: 

1. Click and drag a point to change its position. 
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To modify the position of the nerve canal drawing using the slice images: 

1. Click and drag the dot that represents the nerve canal on a slice image. 

Click and drag when your mouse pointer turns into four triangles surrounding the dot. 

To remove a point on the nerve canal drawing: 

1. Right-click the point you want to remove. 

2. On the dialog box that appears, select Delete the Selected Point. Then, click OK. 

To remove a segment of the nerve canal drawing: 

1. Right-click a point on the segment that you want to remove. 

2. On the dialog box that appears, select Delete the Whole Segment. Then, click OK. 

You can delete all segments of the nerve canal drawing from the Nerve Canal Editing dialog box.  For more information, see 
"Editing a Nerve Canal Image" on page 753. 

Selecting Part of the Volume for Nerve Canals X-Ray Building 
On the Nerve Canals radiograph image palette, you identify the height of the x-rays, and the projection path and slices used to 
create them. You also specify the layout you want to use to view them. 

To set the height of the x-ray: 

1. On the Collimate image, click and drag the edges of the highlighted portion of the image to identify the part of the 
volume you want to include in the x-rays. 

The x-ray radiographs will include the highlighted portions of the image, as illustrated below: 
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To set options for your nerve canals view: 

1. On the Collimate image, click and drag the red horizontal guideline so that the nerve canals are in the Arch Path 
image.  

Click and drag when your mouse pointer turns into a double-headed arrow.  

Note: The red line does not appear if you are using the translucent view for the arch path image (see below). In the 
translucent view, the arch path image is constructed from the entire volume. 

2. From the Pan Thickness drop-down list box, select the total width (in millimeters) for the area surrounding the 
projection path. 

3. In the Slice Group Dimensions group box, specify the following options for creating slices for your nerve canals view of 
the volume. 

Thickness Select the thickness for each slice in the view you want to create. 

Spacing Specify uniform or circular spacing for the slice group. 

Width Select the width for each slice image in the view you want to create. 

Cuts Select the number of slices you want to create. Each cut results in one image. 

4. From the Groups drop-down list box, specify how many slice groups you want to use. 

Each slice group is created using the options specified in the Slice Group Dimensions group box. 

To draw the projection path: 

1. Optionally, check the Arch Path: Translucent View box to use a translucent view when drawing the projection path. 

Note: The red line does not appear on the Collimate image if you are using the translucent view for the arch path 
image. In the translucent view, the arch path image is constructed from the entire volume. 

In most cases, you use the patient's upper arch as a guide to specify the projection path. 

2. On the Arch Path image, click the left mouse button on the location where you want the projection path to begin.  

A red point appears on the image. 

3. Release the mouse button and move the mouse to begin drawing the path. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position.  

4. Click the mouse button whenever you want to place a point and change the direction of the line.  

5. To complete the projection path, double-click the left mouse button at the end of the path. 

A pink polygon appears on the image indicating a cross-section of the part of the volume that will be included in the x-
rays. A yellow representation of the slices created using the options specified in the Slice Group Dimensions group box 
and the Groups drop-down list box also appears, as illustrated below. The following figure illustrates the arch path with 
the Translucent View box checked. 
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Once you have drawn the protection path, you can move points along it to fine tune it. 

To fine tune the protection path: 

1. Click and drag one or more of the red points along the projection path. 

To erase your projection path and begin again: 

1. Click Redo Path to erase both the red projection path and the pink polygon. 

Initially, the slice groups are in default positions.  However, you can easily change the location of the slice groups to create a 
custom nerve canals view. 
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To move a slice group: 

1. Click and drag the red line for a slice group to a different location along the projection path. 

Click and drag when your mouse pointer turns into four triangles, as illustrated below. The following figure illustrates 
the arch path with the Translucent View box unchecked. 

 

To create your nerve canals view: 

1. Optionally, select the layout that you want to use for viewing the slices from the Slice Layout drop-down list box. 

2. Click Apply. 

A panoramic image is displayed in the upper right portion of the Build X-Rays dialog box, and each numbered slice is 
displayed in the lower right portion of the dialog box. 
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Viewing a Slice Close-up 
Once you have created a slice montage, you can view a close-up of a single slice.  

To view a slice close-up: 

1. Right-click a slice in the montage. 

2. Select Show This Slice in a Large Window. 

The Slice View window opens.  

To view another slice in the Slice View window: 

1. Use the scrollbar or the middle mouse scroll wheel. 
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Sharpen Adjust this slider to sharpen the image. 

Reset WL Click this button to reset the window leveling to the default setting.  For more information, see "Setting 
Window Leveling" on page 768. 

Send Snapshot... 

Opens a pop-up menu with the following options: 
Close This Menu: Choose this option to close the pop-up menu. 
Save To Dolphin Layout/Database: Choose this option to save the 3D image to a slot in a Dolphin 
image layout and store it in your database. For more information, see "Saving an Image" on page 661. 
Send To Report: Choose this option to use this image in a Dolphin 3D report. For more information, see 
Chapter 32. 
Copy To Clipboard: Choose this option to copy the 3D image to the clipboard. Then, you can paste the 
image into another application. For more information, see "Copying the Image to the Clipboard" on page 
663. 
Print: Choose this option to print the image. For more information, see "Printing an Image" on page 664. 
Export To File: Choose this option to export the 3D image to a file. For more information, see "Exporting 
an Image" on page 663. 

Editing a Nerve Canal Image 
You can specify the width, color, and transparency of the nerve canal marker either before or after you create it. You can also 
specify whether or not you want to mark the mental foramina, and you can delete the marker and start over. 

To edit the nerve canal marker: 
1. On the Nerve Canals palette, click Edit. 

 
The Nerve Canal Editing dialog box is displayed. 

2. Make any changes to the options specified on this dialog box. 

3. Click Done when you are finished editing. 

 



Dolphin Imaging User's Guide April 2011 

754 DI_USER_GUIDE-11.5   Rev. 1.01 

 

Canal Width Select the canal marker width in millimeters from this drop-down list box. 

Color Sample Click the color sample to change the canal marker's color. 

Trans Used this slider to set the transparency of the canal marker. 

Invert Bitmap 
Colors Check this box to reverse the foreground and background colors of the x-ray 

Define Click this button to define and mark the mental foramina. For more information, see "Marking the Mental 
Foramina" on page 742. 

Remove Click this button to remove the mental foramina marker. 

Delete All Click this button to delete all canal segments. 

Done Click this button when you are finished editing to close the Nerve Canal Editing dialog box. 

Building a Frontal X-Ray 
To build a frontal x-ray, you first enter setup options on the Frontal Radiograph Setup palette. These options determine how the 
x-ray is created from the 3D volume.  

To build a frontal x-ray: 

1. Select Frontal from the View drop-down list box on the Build X-Rays Tool dialog box. 

The Frontal Radiograph Setup palette opens.  

2. Set the x-ray orientation. 

For more information, see "Orienting a Frontal X-Ray" on page 755. 

3. Identify the part of the 3D volume that you want to use to create the x-ray. 

For more information, see "Selecting Part of the Volume for Frontal X-Ray Building" on page 757. 

4. Specify the type of x-ray you want to use as your default (either anterior-posterior or posterior-anterior). 

For more information, see "Selecting the Frontal X-Ray Type" on page 758. 

5. Configure the projection options to use when creating the x-ray. 

For more information, see "Setting Projection Preferences" on page 705. 

6. Configure the projection and ruler options to use when creating the x-ray. 

For more information, see “Selecting the Projection Type and Ruler Options” on page 758. 
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Hard 
Tissue 

Click this radio button to show the patient’s 
hard tissue image on the palette.  

Soft 
Tissue 

Click this radio button to show the patient’s 
soft tissue image on the palette.  

Right tab Click this tab to show a right lateral view on 
the palette.  

Front tab Click this tab to show a frontal view on the 
palette.  

Image 
Provides a preview of the current 
orientation. The red arrows indicate the 
direction from which the radiograph will be 
taken.  

Options... Click to bring up the Frontal Options dialog 
box, where you can select Projection Type 
and Ruler options. 

Reset 
Orientation 

Click this button to return the orientation to 
the default. 

 

X-ray Type 
 

Select the type of radiograph (either Anterior-Posterior or Posterior-Anterior) that you want to create.  

Apply Click this button to apply the settings specified on the palette to build the radiograph image. 

For more information on these controls, see "Orienting a Frontal X-Ray" below, "Selecting Part of the Volume for Frontal X-Ray 
Building" on page 757, "Selecting the Frontal X-Ray Type" on page 758, and "Selecting the Projection Type and Ruler Options" 
on page 758.   

Orienting a Frontal X-Ray 
Before building x-rays for this patient, you may need to change the image orientation of the 3D volume so that the x-rays are 
created correctly. To orient the 3D volume, you rotate the image until both the frontal and right views are oriented correctly, both 
horizontally and vertically. You may want to switch between the patient's hard tissue and soft tissue images to help you properly 
orient the x-ray. 

To change the view to hard or soft tissue: 

1. Select Hard Tissue to view the hard tissue image. 

Or, 

Select Soft Tissue to view the soft tissue image. 
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To rotate the volume clockwise or counter-clockwise: 

1. Place your mouse cursor over the edge of the image on the palette. 

2. When your cursor turns into a rotation icon, click and drag to rotate the image clockwise or counter-clockwise (see 
below). 

 

To spin the volume around a horizontal or vertical axis: 

1. Click the hard or soft tissue image. 

2. When your cursor turns into a hand pointer, drag the mouse left or right to spin the image around a vertical axis. 

Or, 

When your cursor turns into a hand pointer, drag the mouse up or down to spin the image around a horizontal axis. 
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To check the orientation: 

1. Click the Front tab to check the orientation using the frontal view. 

2. Click the Right tab to check the orientation using the right lateral view. 

To return to the original orientation: 

1. Click Reset Orientation. 

Selecting Part of the Volume for Frontal X-Ray Building 
When you build x-rays, you can use the entire 3D volume or you can select only part of the volume. Selecting part of the volume 
enables you to focus on particular areas of interest. 

To select a part of the volume for x-ray building: 

1. Click the Right tab if it isn't already selected. 

2. Click and drag the edges of the highlighted portion of the image to identify the part of the volume you want to include in 
the frontal x-ray. 

Click and drag when your mouse pointer turns into a double-headed arrow. 

The following figure illustrates picking different parts of the volume for x-ray building. The highlighted part of the image 
indicates the selected area. 
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Selecting the Frontal X-Ray Type 
You can create either an anterior-posterior or posterior-anterior x-ray. 

To set the type of x-ray you want to create: 

1. Click Anterior-Posterior to create frontal x-rays in which the direction of exposure is front to back. 

Or, 

Click Posterior-Anterior to create frontal x-rays in which the direction of exposure is back to front. 

 

Selecting the Projection Type and Ruler Options 
You can construct x-rays from the 3D volume data in using one of the following projection types: 

• Orthogonal: Creates a non-distorted x-ray. 

• Perspective: Creates an x-ray with the measured distortion and warping effects of a traditional X-ray. You can also set 
projection preferences so that your resulting x-rays are consistent with those produced by your existing film-based X-
ray machine. 

You can set the projection center point to use when creating x-rays with either of these projection types. 
You can also set options for the type of ruler you want to display on the x-ray. 

To specify the projection type to use: 

1. Click Options... 

The Options dialog box appears. 

 

2. In the Projection Type group box, select Orthogonal to create non-distorted x-rays. 

Or, 

Select Perspective to mimic x-rays created traditional, film-based X-ray equipment. 

If you selected Perspective, set the projection center point as described below. 
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To set ruler options: 

1. In the Ruler group box, use the Type drop-down list box to specify the type of ruler to display on the x-ray: 

� Tickmarks: Displays the ruler. 
� 100 mm bar: Displays a solid bar 100 millimeters in length. 
� None: Suppresses display of the ruler. 

2. Use the Location drop-down list box to set the location for the ruler on the x-ray: either Left, Right, Top, or Bottom. 

To set the projection center point: 

1. Click Projection Center.... 

The Center of Perspective Projection dialog box opens. 

2. Select Hard Tissue to use the patient's hard tissue image when selecting the projection center point. 

Or, 

Select Soft Tissue to use the patient's soft tissue image. 

3. Using the frontal image, click and drag the vertical line to the mid-sagittal plane. 

4. Using the lateral image, click and drag the two lines until they cross at the mechanical porion. 

5. Click OK. 
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Midsagittal Plane on Frontal Click and drag the vertical line on this image to identify the mid-sagittal plane. 

Mechanical Porion Click and drag the two lines on this image until they cross at the mechanical porion. 

Hard Tissue Select this option to view the patient's hard tissue. 

Soft Tissue Select this option to view the patient's soft tissue. 

Building an SMV X-Ray 
To build an SMV x-ray, you first enter options on the SMV Radiograph Setup palette. These options determine how the x-ray is 
created from the 3D volume.  

To build an SMV x-ray: 

1. Select SMV from the View drop-down list box on the Build X-Rays Tool dialog box. 

The SMV Radiograph Setup palette opens.  

2. Set the x-ray orientation. 

For more information, see "Orienting an SMV X-Ray" on page 761. 

3. Identify the part of the 3D volume that you want to use to create the x-ray. 

For more information, see "Selecting Part of the Volume for SMV X-Ray Building" on page 763. 

4. Configure the projection options to use when creating the x-ray. 

For more information, see "Selecting the Projection Type and Ruler Options" on page 764. 

5. Click Apply to create the x-ray using the specified options. 

The x-ray appears in the Build X-Rays Tool dialog box. 
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Hard Tissue Click this radio button to show the 
patient’s hard tissue image on the 
palette.  

Soft Tissue 
Click this radio button to show the 
patient’s soft tissue image on the 
palette.  

Right tab Click this tab to show a right lateral 
view on the palette.  

Bottom tab Click this tab to show a bottom view 
on the palette.  

Image 
Provides a preview of the current 
orientation. The red arrows indicate 
the direction from which the x-ray will 
be taken.  

Options 
Click to bring up the SMV Options 
dialog box, where you can select 
projection type and ruler options. 

 

Reset Orientation Click this button to return the orientation to the default. 

Apply Click this button to apply the settings specified on the palette to build the x-ray image. 

For more information on these controls, see "Orienting an SMV X-Ray" below, "Selecting Part of the Volume for SMV X-Ray 
Building" on page 763, and "Selecting the Projection Type and Ruler Options" on page 764.   

Orienting an SMV X-Ray 
Before building x-rays for this patient, you may need to change the image orientation of the 3D volume so that the x-rays are 
created correctly. To orient the 3D volume, you rotate the image until both the right and bottom views are oriented correctly, both 
horizontally and vertically. You may want to switch between the patient's hard tissue and soft tissue images to help you properly 
orient the x-ray. 

To change the view to hard or soft tissue: 

1. Select Hard Tissue to view the hard tissue image. 

Or, 

Select Soft Tissue to view the soft tissue image. 
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To rotate the volume clockwise or counter-clockwise: 

1. Place your mouse cursor over the edge of the image on the palette. 

2. When your cursor turns into a rotation icon, click and drag to rotate the image clockwise or counter-clockwise (see 
below). 

 

To spin the volume around a horizontal or vertical axis: 

1. Click the hard or soft tissue image. 

2. When your cursor turns into a hand pointer, drag the mouse left or right to spin the image around a vertical axis. 

Or, 

When your cursor turns into a hand pointer, drag the mouse up or down to spin the image around a horizontal axis. 
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To check the orientation: 

1. Click the Right tab to check the orientation using the right lateral view. 

2. Click the Bottom tab to check the orientation using the bottom view. 

To return to the original orientation: 

1. Click Reset Orientation. 

Selecting Part of the Volume for SMV X-Ray Building 
On the SMV Radiograph Setup, you identify the part of the volume to use for SMV x-ray building.  

To select a part of the volume for x-ray building: 

1. Click the Right tab if it isn't already selected. 

2. Click and drag the edges of the highlighted portion of the image to identify the part of the volume you want to include in 
the SMV x-ray. 

Click and drag when your mouse pointer turns into a double-headed arrow. 

The following figure illustrates picking part of the volume for SMV x-ray building. The highlighted part of the image 
indicates the selected area. 
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Selecting the Projection Type and Ruler Options 
You can construct x-rays from the 3D volume data in using one of the following projection types: 

• Orthogonal: Creates a non-distorted x-ray. 

• Perspective: Creates an x-ray with the measured distortion and warping effects of a traditional X-ray. You can also set 
projection preferences so that your resulting x-rays are consistent with those produced by your existing film-based X-
ray machine./ 

You can set the projection center point to use when creating x-rays with either of these projection types. 
You can also set options for the type of ruler you want to display on the x-ray. 

To specify the projection type to use: 

1. Click Options... 

The Options dialog box appears. 

 

2. In the Projection Type group box, select Orthogonal to create non-distorted x-rays. 

Or, 

Select Perspective to mimic x-rays created traditional, film-based X-ray equipment. 

If you selected Perspective, set the projection center point as described below. 

To set ruler options: 

1. In the Ruler group box, use the Type drop-down list box to specify the type of ruler to display on the x-ray: 

� Tickmarks: Displays the ruler. 
� 100 mm bar: Displays a solid bar 100 millimeters in length. 
� None: Suppresses display of the ruler. 

2. Use the Location drop-down list box to set the location for the ruler on the x-ray: either Left, Right, Top, or Bottom. 
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To set the projection center point: 

1. Click Projection Center.... 

The Center of Perspective Projection dialog box opens. 

2. Select Hard Tissue to use the patient's hard tissue image when selecting the projection center point. 

Or, 

Select Soft Tissue to use the patient's soft tissue image. 

3. Using the frontal image, click and drag the vertical line to the mid-sagittal plane. 

4. Using the lateral image, click and drag the two lines until they cross at the mechanical porion. 

5. Click OK. 

 

Midsagittal Plane on Frontal Click and drag the vertical line on this image to identify the mid-sagittal plane. 

Mechanical Porion Click and drag the two lines on this image until they cross at the mechanical porion. 

Hard Tissue Select this option to view the patient's hard tissue. 

Soft Tissue Select this option to view the patient's soft tissue. 
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Viewing Landmarks and Measurements 
After you generate the x-ray view you desire, you can: 

• view any landmarks you have digitized for the volume on the x-ray view 

• measure distances and angles directly on that view 

 
If you have digitized landmarks for the volume, you can view them on any x-ray views you generate. 

To toggle the display of landmarks on the image: 

1. Right-click the image. Then, select Show/Hide Digitized Landmarks from the pop-up menu. 

To add measurements and angles to an x-ray view: 

1. Check Measure in the Build-X-Rays Tool window. 

2. Generate the desired view (Lateral, Panoramic, TMJ, Cross Sections, Nerve Canals, Frontal, or SMV). 

3. Click 2 Pt Line to measure the distance between two points 
 
Or, 
 
Click 3 Pt Angle to measure the angle between two lines. 

4. Draw the line or angle you want to measure on the x-ray image. 

If you selected 2 Pt Line, click the two endpoints of the line. As you move your mouse from one endpoint to the other, a 
line appears with the distance in millimeters. 

If you selected 3 Pt. Angle, click three points to define the angle. Two lines appear joined by the apex. The number of 
degrees for the angle appears near the apex. 

Right-click to undo the point that you just placed. 

To remove all measurements from the x-ray: 

1. Click Remove All. 
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Enhancing an X-Ray 
The Build X-Rays Tool offers the image enhancement options to help you produce readable x-ray images: 

To enhance the image: 

1. Click Enhance.  

The Enhancements dialog box appears. 

2. Set any options on this dialog box to enhance the image. 

If you are enhancing the TMJ, Cross Sections, Cross Sections Upper, and Cross Sections Lower, or Nerve Canals 
view, this dialog box contains two tabs, Pano and Cross Sections, so that you can set enhancement options for the 
panoramic image separately from the cross section images. For the Lateral, Panoramic, Frontal, and SMV views, this 
dialog box does not have any tabs. 

Local 
Enhancement 
Options 

The settings in this group box apply to the current x-ray 
only. 
Window Leveling (WL): Affects the apparent brightness 
and contrast of the x-ray image on the screen.  Click 
Reset WL to reset the window leveling to the default 
setting. For more information, see below. 
Contrast: Move the slider to adjust the light/dark 
contrast of the image. 
Gamma:  Move the slider to adjust the light/dark 
contrast of the image. 
Brightness: Move the slider to adjust the brightness of 
the image. 
Sharpen: Move the slider to adjust the 
blurriness/sharpness of the image. 
Soft Tissue: Move the slider to adjust the transparency 
of the soft tissue on the image. This option does not 
appear on the Cross Sections tab. 
"Dolphin 1" Filter Level: Select the transparency of the 
x-ray on the Dolphin 1 filter tab from this drop-down list 
box. The default is zero for maximum transparency in 
the image. Increase this number if the patient’s hard 
tissue is less dense to increase the opacity of the hard 
tissue for optimal x-ray visualization. This option does 
not appear on the Cross Sections tab. 
Reset: Click this button to set all of the above options 
back to the defaults for this x-ray view. 

Global 
Enhancement 
Options 

Click Reset All to set the above options to the defaults 
for all x-ray views (Lateral, Panoramic, TMJ, Cross 
Sections, Nerve Canal, Frontal, and SMV). 
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Setting Window Leveling 
The Build X-Rays Tool creates x-rays as 12-bit greyscale images, but the computer screen displays an 8-bit greyscale image. By 
adjusting the window leveling, you chose the subset of greyscale intensities you want to display on the screen. Window leveling 
does not change the image data, however. 

To change the apparent brightness or contrast (window leveling): 

1. If you want to change the image brightness on the screen, click and drag the mouse from left to right. 

2. If you want to change the image contrast on the screen, click and drag the mouse up or down. 

A red legend (for example, W/L: Off) indicates whether you have set the window leveling. 

Note: These changes affect the way the x-ray image displays on the screen only; they do not change the image data. 
For more information, see "Enhancing an X-Ray" on page 767. 

To reset the window leveling to the default setting: 

1. Click Reset WL. 

Or, 

Click WL. 

The label on the button that resets the window leveling may be Reset WL or WL, depending on the dialog box you are 
currently viewing. 

Saving, Copying, Exporting, and Printing X-Rays 
Once you have created an x-ray for this patient, you can: 

• Save it: Stores the x-ray images created with all the enabled filters for the current view so that you can view them from 
within Dolphin Imaging. The x-ray image data is saved either to your Dolphin database or to your external DICOM 
storage location, depending on your DICOM volume storage options. For more information, see "Setting DICOM 
Volume Storage Options" on page 670. 

• Copy it to the clipboard: Copies the x-ray image you're currently viewing to the clipboard so that you can paste it into 
another application. 

• Export it: Saves the x-ray image you're currently viewing in a file on your computer. 

• Print it: Prints the x-ray image you're currently viewing. 
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To save the x-ray: 

1. Click Send Snapshot... on the Build X-Rays Tool window. Then, select Send to Dolphin Layout/Database from the pop-
up menu. 

Or, 

Right-click the image. Then, select Save this Image to Dolphin Layout... from the pop-up menu. 

Or, 

Right-click an image in the slice montage for the cross-sections, nerve canals, or TMJ x-ray view. Then, select Save 
Highlighted Slice to Dolphin Layout... from the pop-up menu. 

For more information, see "Building a Cross-Sections X-Ray View" on page 729, "Building a Nerve Canals X-Ray 
View" on page 738, and Building an X-Ray View of the TMJ Area" on page 722. 

2. Optionally, change to a different image layout as described below. 

3. Click a slot in the image layout to save the image in that slot. 

4. Optionally, enter a new image slot title to use for the 3D image in the Image Title text box. 

5. Click Save... 

Images created with all the x-ray filters (shown on the tabs in the Build X-Rays Tool window) are stored as part of this 
patient's record. The x-ray image data is saved either to your Dolphin database or to your external DICOM storage 
location, depending on your DICOM volume storage options. For more information, see "Setting DICOM Volume 
Storage Options" on page 670. 

Note: The traced filter image is not stored unless the Enable "Traced" Filter box is checked on the Build X-Rays Tool 
window. 
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Image Layout Displays the currently-selected image layout. Click a slot in the layout to save the image in that slot. 

Image Title Enter an image title to use for the image. Initially, this field contains the title defined in the image layout for the 
selected image slot. 

Change 
Layout... Click this button to select a different image layout. 

Save... Click this button to save the image in the selected image slot in the selected layout. 

To choose a different image layout: 

1. Click Change Layout.... 

2. Select the image layout in which you want to save this image from the drop-down list box. Then, click OK. 

Once saved, the x-rays are available on the Dolphin Imaging main screen. They are saved in a separate layout slot from the 3D 
volume and photograph, as shown below. 
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To copy the x-ray to the clipboard: 

1. Click Send Snapshot... on the Build X-Rays Tool window. Then, select Copy to Clipboard from the pop-up menu.. 

Or, 

Right-click the image. Then, select Copy this Image to Clipboard from the pop-up menu. 

Or, 

Right-click an image in the slice montage for the cross-sections, nerve canals, or TMJ x-ray view. Then, select Copy 
Highlighted Slice to Clipboard from the pop-up menu. 

For more information, see "Building a Cross-Sections X-Ray View" on page 729, "Building a Nerve Canals X-Ray 
View" on page 738, and "Building an X-Ray View of the TMJ Area" on page 722. 

The x-ray image or highlighted slice is copied to the clipboard. You can then paste it into another application such as 
Microsoft Word. 



Dolphin Imaging User's Guide April 2011 

772 DI_USER_GUIDE-11.5   Rev. 1.01 

To export the x-ray to a file: 

1. Click Send Snapshot... on the Build X-Rays Tool window. Then, select Export to File from the pop-up menu. 

Or, 

Right-click the image. Then, select Export this Image to File... from the pop-up menu. 

Or, 

Right-click an image in the slice montage for the cross-sections, nerve canals, or TMJ x-ray view. Then, select Export 
Highlighted Slice to File... from the pop-up menu. 

For more information, see "Building a Cross-Sections X-Ray View" on page 729, "Building a Nerve Canals X-Ray 
View" on page 738, and "Building an X-Ray View of the TMJ Area" on page 722. 

The Save As dialog box appears, as shown below. 

2. Specify the directory and file in which you want to save the image. 

3. Optionally, select any other options from the drop-down list boxes.  

Depending on the image type you select in the Save As Type drop-down list box, additional options may be available in 
the other drop-down list boxes.  

Note: If you select one of the JPEG 2000 file types, an additional button appears on the Save Dolphin Image As dialog 
box that enables you to set advanced options.  

4. Click Save. 

The x-ray image currently displayed in the Build X-Rays Tool window is exported and saved in the file you specified.  
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Most options on this dialog box are described in the Microsoft Windows documentation.  
You can use the Save As Type drop-down list box to select the graphics file type that you want to use when saving this image. 
JPEG 24-bit is recommended for producing high quality images with a small file size and maximum compatibility between 
imaging programs. Typically, you should use the default selections for all other options. Only modify these options if you are very 
familiar with graphics file types. 

To print the current x-ray view: 

1. Click Send Snapshot... on the Build X-Rays Tool window. Then, select Print from the pop-up menu.. 

Or, 

Right-click the image. Then, select Print this Image... from the pop-up menu. 

Or, 

Right-click an image in the slice montage for the cross-sections, nerve canals, or TMJ x-ray view. Then, select Print 
Highlighted Slice... from the pop-up menu. 

For more information, see "Building a Cross-Sections X-Ray View" on page 729, "Building a Nerve Canals X-Ray 
View" on page 738, and "Building an X-Ray View of the TMJ Area" on page 722. 

The Print dialog box is displayed. 

2. Select any printing options you want and click OK. 
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Printer Indicates the printer to which the print job will be sent.  

Properties Click this button to set advanced properties for the selected printer. 

Print Range Select what you want to print. Your options are: 
All: print an entire document.  
Pages: print only pages in the specified range. 
Selection: print just what you have selected. 

Copies Enter the number of copies you want to print. 

Print 1:1 Click this check box to print an image using the 1:1 option.  

Preview Click this check box to preview your print job on the computer screen. 
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26 Digitizing and Measuring 
In digitizing images, you specify landmarks on the image that are used for cephalometric analyses. Dolphin 3D enables you to 
digitize landmarks on a three dimensional representation of the patient's anatomy, thus achieving a greater degree of accuracy. 
 Using Dolphin 3D, you can: 

• digitize landmarks for new 3D analyses. 

• digitize landmarks for conventional 2D analyses in three dimensions.   

Depending on the analysis you choose, you have one of the following options after you have digitized landmarks: 

• for all analyses except <Dolphin>, you can view measurements calculated from your digitized landmarks. 

• for the <Dolphin> analysis, you can take measurements using lines, angles, or selected areas. 

You also can export the digitized landmarks or measurements to the clipboard so that you can paste them into another 
application, such as Microsoft Excel, for further analysis.  

To open the Digitize/Measurement palette: 

1. Click  on the Dolphin 3D window. 

Or, 

Select Digitize/Measure... from the Tools menu. 

The Digitize/Measurement palette opens. Depending on the analysis you pick, this palette contains two or more of the 
following tabs: 

Landmark Select this tab to digitize landmarks on the 3D image. This tab appears for all analyses. 

Measurements Select this tab to view measurements calculated from your digitized landmarks. This tab appears for 
all analyses except <Dolphin>. 

Line Select this tab to take measurements using lines. This tab appears only for the <Dolphin> analysis. 

Angle Select this tab to take measurements using angles. This tab appears only for the <Dolphin> analysis. 

Slice Area Select this tab to measure slice areas. This tab appears only for the <Dolphin> analysis. 

Path Select this tab to take measurements using paths. This tab appears only for the <Dolphin> analysis. 
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Adding, Changing, or Removing Landmarks 
You use the Landmarks tab of the Digitize/Measurements palette to add, change, or remove landmarks. When digitizing 
landmarks, you can use all the capabilities of Dolphin 3D. For example, you can digitize landmarks on the hard tissue, the soft 
tissue, or the patient's photograph (if available). You can rotate the 3D volume to obtain the best view for locating the landmarks. 
You also can use clipping slices or clipping boxes to locate landmarks within the 3D volume.  For more information, see "Moving 
or Reorienting the Image" on page 640, "Using a Clipping Slice" on page 869, and "Using a Clipping Box" on page 871. 
Once you have finished digitizing, you can build digitized x-rays from the digitized 3D volume. When building x-rays, Dolphin 3D 
represents the 3D digitized landmarks in two dimensions. You can then compare these digitized x-rays with conventional 
digitized x-rays created with Dolphin Imaging's Digitize feature. For more information on building x-rays from the 3D volume, see 
Chapter 25. For more information on Dolphin Imaging's Digitize feature, see Chapter 10.  

To open the Landmarks tab: 

1. Click the Landmark tab if it isn't already selected. 

View 

Select the view for the type of analysis that you want to 
digitize from this drop-down list box. The following 
options are available: 
3D: Digitize landmarks for 3D analyses. 
2D Lateral: Digitize landmarks for 2D lateral analyses. 
2D Frontal: Digitize landmarks for 2D frontal analyses. 
Note: For 2D analyses, measurements are calculated 
using orthogonal (rather than perspective) projection. 
However, if you build x-rays with perspective projection 
after digitizing landmarks, the measurements on that 
radiograph are calculated with the specified 
magnification. This feature is useful for comparison 
with older records. For more information, see 
"Selecting the Projection Type and Ruler Options" on 
page 712. 
The analyses available in the Analysis drop-down list 
box depend on your choice in this drop-down list box. 

Analysis 
Select the analysis for which you want to digitize 
landmarks. The available choices depend on your 
selection in the View drop-down list box. 

Next Move to the next landmark or measurement line in the 
list. 

Clear 
highlighted 
point  

Click this button to remove the point currently 
highlighted in the list from the image. 

Clear ALL 
points... 

Click this button to remove all the digitized points from 
the image. 
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Undo Last 
Digitization Click this button to undo your last digitize operation. 

 

Click this button to copy the landmark coordinate data to the clipboard. The exported data can be imported into 
another application such as Microsoft Excel. For more information, see "Copying Landmark and Measurement 
Data to the Clipboard" on page 789. 

Close Click this button to close the palette. 

To digitize landmarks: 

3. On the Digitize/Measurement palette, select the view for the type of analysis that you want to digitize from the View 
drop-down list box. 

4. Click the analysis that you want to digitize from the Analysis drop-down list box. 

5. Click the Landmark tab if it isn't already selected. 

The Landmark tab lists the landmarks for the currently-selected analysis. 

4. On the 3D volume, locate and right-click each landmark listed on the Landmark tab. 

To properly locate landmarks, you may need to switch your view to the hard tissue, the soft tissue, or the patient's 3D 
photograph (if available). If you are digitizing landmarks for a 3D analysis, Dolphin 3D automatically switches between 
the hard tissue and soft tissue views as appropriate for the landmark you are digitizing. You may also need to rotate 
the 3D volume, use clipping slices, or clipping boxes to locate landmarks within the 3D volume. For more information, 
see "Moving or Reorienting the Image" on page 640, "Using a Clipping Slice" on page 869, and "Using a Clipping Box" 
on page 871. 

As you go through the list of landmarks, the selection bar in the list box indicates the current landmark.  

Note: To skip a landmark when digitizing, click Next. 

To change the location of a digitized landmark: 

1. Click the landmark in the Landmark list box. 

Or, 

Press the UPARROW key until the selection bar in the list box is over the landmark name. 

A circle with intersecting lines appears on the digitized image to identify the landmark selected in the Landmark list 
box. 

2. Right-click the correct location for the landmark. 

Alternatively, you can simply click and drag the landmark: 
1. Move the mouse over the landmark you want to move. 

When the mouse is over one of the landmarks, the mouse pointer changes to small triangles surrounding the 
landmark.  

2. Click and drag the landmark to a new location. 
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To remove landmarks: 

1. Select the landmark you want to remove in the list box. Then, click Clear highlighted point. 

Or, 

Click Clear ALL digitized points... to remove all digitized landmarks. 

2. If you clicked Clear ALL digitized points..., click Yes in the confirmation dialog box that appears to remove all digitized 
landmarks. 

Viewing and Taking Measurements 
You use the following tabs on the Digitize/Measurement palette to view and take measurements: 

Measurements Select this tab to view measurements calculated from your digitized landmarks. This tab appears for all 
analyses except <Dolphin>. 

Line Select this tab to take measurements using lines. This tab appears only for the <Dolphin> analysis. 

Angle Select this tab to take measurements using angles. This tab appears only for the <Dolphin> analysis. 

Slice Areas Select this tab to measure slice areas. This tab appears only for the <Dolphin> analysis. 

Path Select this tab to take measurements using paths. This tab appears only for the <Dolphin> analysis. 

Viewing Measurements 
You use the Measurements tab of the Digitize/Measurements palette to view measurements. This tab is available for all analyses 
except <Dolphin>. 

To view the measurements: 

1. Click the Measurements tab on the Digitize/Measurements palette. 

The Measurements tab lists all the measurements for the currently-selected analysis. If you have digitized the 
landmarks necessary to calculate a particular measurement, the measurement value appears in the Value column. 

Note: For 2D analyses, measurements are calculated using orthogonal (rather than perspective) projection. However, 
if you build x-rays with perspective projection after digitizing landmarks, the measurements on that radiograph are 
calculated with the specified magnification. This feature is useful for comparison with older records. For more 
information, see Chapter 25 and "Selecting the Projection Type and Ruler Options" on page 712. 
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View Select the view for the type of analysis for 
which you want to view measurements 
from this drop-down list box. The 
following options are available: 
3D: View measurements for 3D analyses. 
2D Lateral: View measurements for 2D 
lateral analyses. 
2D Frontal: View measurements for 2D 
frontal analyses. 
The analyses available in the Analysis 
drop-down list box depend on your 
choice in this drop-down list box. 

Analysis 
Select the analysis for which you want to 
view measurements. The available 
choices depend on your selection in the 
View drop-down list box. 

Name Name of the measurement. 

Value Value for the measurement. 

Clear Highlighted 
Measurement 

Click this button to remove the 
measurement currently highlighted in the 
list from the image. 

Clear ALL 
Measurements... 

Click this button to remove all the 
measurements from the image. 

Undo Last 
Digitization 

Click this button to undo your last digitize 
operation. 

 

Click this button to copy the 
measurement data to the clipboard. The 
exported data can be imported into 
another application such as Microsoft 
Excel. For more information, see 
"Copying Landmark and Measurement 
Data to the Clipboard" on page 789. 

Close Click this button to close the palette. 
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To resize the columns in the measurement list: 

1. Move the mouse pointer to the dividing line between two column headings. 

2. When the mouse pointer changes to a two-headed arrow across a line, click and drag the mouse to resize the column 
headings. 

To remove measurements: 

1. Select the measurement you want to remove in the list box. Then, click Clear Highlighted Measurement. 

Or, 

Click Clear ALL Measurements... to remove all digitized measurements. 

2. If you clicked Clear ALL Measurements..., click Yes in the confirmation dialog box that appears to remove all 
measurements. 

Taking Measurements Using Lines 
You use the Line tab of the Digitize/Measurements palette to take measurements using lines. This tab is available only for the 
<Dolphin> analysis. 

To take a measurement using a line: 

1. Select 3D from the View drop-down list box. 

2. Select  <Dolphin> from the Analysis drop-down list box. 

3. Click the Line tab on the Digitize/Measurements palette. 

The Line tab opens (see below). 

4. Click two points on the image to identify the beginning and end of the line. 

Dolphin 3D draws a line between the two points you identified. On the palette, a name for the line is listed in the Name 
column and its length appears in the Value column. 

If you make a mistake, you can click and drag a point to reposition it or click Clear Highlighted Line to start over. 
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View Select the view for the type of analysis for 
which you want to view or take 
measurements from this drop-down list box. 
The following options are available: 
3D: View or take measurements for 3D 
analyses. The <Dolphin> analysis is 
available under this view. 
2D Lateral: View measurements for 2D 
lateral analyses. 
2D Frontal: View measurements for 2D 
frontal analyses. 
The analyses available in the Analysis 
drop-down list box depend on your choice 
in this drop-down list box. 

Analysis 
Select the analysis that you want to use to 
take measurements. The Lines tab is 
available only for the <Dolphin> analysis. 

Name 

Name of the line. Dolphin 3D numbers the 
lines sequentially and identifies the view on 
which you drew each line. For example, if 
you drew the third line on the sagittal slice 
view, Dolphin 3D names it Line 3 (Sagittal). 

Value The length of the line. 

Clear 
Highlighted Line 

Click this button to remove the line currently 
highlighted in the list from the image. 

Clear ALL 
Lines... 

Click this button to remove all the lines from 
the image. 

Clear ALL 
measurements... 

Click this button to remove all the 
measurements from the image. 

 

Undo Last Digitization Click this button to undo your last digitize operation. 

 

Click this button to copy the measurement data to the clipboard. The exported data can be imported 
into another application such as Microsoft Excel. For more information, see "Copying Landmark and 
Measurement Data to the Clipboard" on page 789. 

Close Click this button to close the palette. 



Dolphin Imaging User's Guide April 2011 

782 DI_USER_GUIDE-11.5   Rev. 1.01 

To resize the columns in the list: 

1. Move the mouse pointer to the dividing line between two column headings. 

2. When the mouse pointer changes to a two-headed arrow across a line, click and drag the mouse to resize the column 
headings. 

To remove lines and measurements: 

1. Select the line you want to remove in the list box. Then, click Clear Highlighted Line. 

Or, 

Click Clear ALL Lines... to remove all lines. 

Or, 

Click Clear ALL measurements... to remove all digitized measurements. 

2. If you clicked Clear ALL Lines..., click Yes in the confirmation dialog box that appears to remove all lines. 

Or, 

If you clicked Clear ALL measurements..., click Yes in the confirmation dialog box that appears to remove all 
measurements. 

Taking Measurements Using Angles 
You use the Angle tab of the Digitize/Measurements palette to take measurements using angles. This tab is available only for the 
<Dolphin> analysis. 

To take a measurement using an angle: 

1. Select 3D from the View drop-down list box. 

2. Select  <Dolphin> from the Analysis drop-down list box. 

3. Click the Angle tab on the Digitize/Measurements palette. 

The Angle tab opens (see below). 

4. Click three points on the image to identify the two lines and vertex of the angle. 

Dolphin 3D draws an angle using the three points you identified, with the second point as the vertex.  On the palette, a 
name for the angle is listed in the Name column and its measurement in degrees appears in the Value column. 

If you make a mistake, you can click and drag a point to reposition it or click Clear Highlighted Angle to start over. 
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View Select the view for the type of analysis for 
which you want to view or take 
measurements from this drop-down list 
box. The following options are available: 
3D: View or take measurements for 3D 
analyses. The <Dolphin> analysis is 
available under this view. 
2D Lateral: View measurements for 2D 
lateral analyses. 
2D Frontal: View measurements for 2D 
frontal analyses. 
The analyses available in the Analysis 
drop-down list box depend on your choice 
in this drop-down list box. 

Analysis 
Select the analysis that you want to use to 
take measurements. The Angle tab is 
available only for the <Dolphin> analysis. 

Name 

Name of the angle. Dolphin 3D numbers 
the angles sequentially and identifies the 
view on which you drew each angle. For 
example, if you drew the third angle on the 
sagittal slice view, Dolphin 3D names it 3-
Point Angle 3 (Sagittal). 

Value The measurement of the angle in degrees. 

Clear Highlighted 
3-Point Angle 

Click this button to remove the angle 
currently highlighted in the list from the 
image. 

Clear ALL 3-Point 
Angles... 

Click this button to remove all the angles 
from the image. 

 

Clear ALL measurements... Click this button to remove all the measurements from the image. 

Undo Last Digitization Click this button to undo your last digitize operation. 

 

Click this button to copy the measurement data to the clipboard. The exported data can be 
imported into another application such as Microsoft Excel. For more information, see "Copying 
Landmark and Measurement Data to the Clipboard" on page 789. 

Close Click this button to close the palette. 
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To resize the columns in the list: 

1. Move the mouse pointer to the dividing line between two column headings. 

2. When the mouse pointer changes to a two-headed arrow across a line, click and drag the mouse to resize the column 
headings. 

To remove angles and measurements: 

1. Select the angle you want to remove in the list box. Then, click Clear Highlighted 3-Point Angle. 

Or, 

Click Clear ALL 3-Point Angles... to remove all angles. 

Or, 

Click Clear ALL measurements... to remove all digitized measurements. 

2. If you clicked Clear ALL 3-Point Angles..., click Yes in the confirmation dialog box that appears to remove all angles. 

Or, 

If you clicked Clear ALL measurements..., click Yes in the confirmation dialog box that appears to remove all 
measurements. 

Measuring Slice Areas 
You use the Slice Area tab of the Digitize/Measurements palette to measure areas on slices. This tab is available only for the 
<Dolphin> analysis. 

To measure an area on a slice: 

1. Select 3D from the View drop-down list box. 

2. Select  <Dolphin> from the Analysis drop-down list box. 

3. Click the Slice Area tab on the Digitize/Measurements palette. 

The Slice Area stab opens (see below). 

4. Click  to use the 3+1 layout. 

Or, 

Click  to use the 2x2 layout. 

Or, 

Click  to view the sagittal slice. 

Or, 
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Click  to view the coronal slice. 

Or, 

Click  to view the axial slice. 

You can only define a slice area on one of the slice views. 

5. Click the left mouse button on a point where you want to begin drawing the slice area. 

6. Click the mouse button whenever you want to place a point and change the direction of the line. 

If you make a mistake, you can click and drag a point to reposition it or click Clear Highlighted Area to start over. 

7. Click the left mouse button again on the first point to close the slice area. 

When you close the slice area, Dolphin 3D fills it with crosshatching. 
On the palette, a name for the area is listed in the Name column and 
its area in square millimeters (mm2) appears in the Value column. 

View 

Select the view for the type of analysis for which you 
want to view or take measurements from this drop-
down list box. The following options are available: 
3D: View or take measurements for 3D analyses. The 
<Dolphin> analysis is available under this view. 
2D Lateral: View measurements for 2D lateral 
analyses. 
2D Frontal: View measurements for 2D frontal 
analyses. 
The analyses available in the Analysis drop-down list 
box depend on your choice in this drop-down list box. 

Analysis 
Select the analysis that you want to use to take 
measurements. The Slice Area tab is available only for 
the <Dolphin> analysis. 

Name 

Name of the slice area. Dolphin 3D numbers the slice 
areas sequentially and identifies the slice on which you 
drew each area. For example, if you drew the third 
area on the sagittal slice view, Dolphin 3-D names it 
Area on Slice 3 (Sagittal). 

Value The measurement of the slice area in square 
millimeters (mm2). 

Clear 
Highlighted 
Area 

Click this button to remove the slice area currently 
highlighted in the list from the image. 
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Clear ALL Areas... Click this button to remove all the slice areas from the image. 

Clear ALL measurements... Click this button to remove all the measurements from the image. 

Undo Last Digitization Click this button to undo your last digitize operation. 

 

Click this button to copy the measurement data to the clipboard. The exported data can be 
imported into another application such as Microsoft Excel. For more information, see "Copying 
Landmark and Measurement Data to the Clipboard" on page 789. 

Close Click this button to close the palette. 

To resize the columns in the list: 

1. Move the mouse pointer to the dividing line between two column headings. 

2. When the mouse pointer changes to a two-headed arrow across a line, click and drag the mouse to resize the column 
headings. 

To remove slice areas and measurements: 

1. Select the slice area you want to remove in the list box. Then, click Clear Highlighted Area. 

Or, 

Click Clear ALL Areas... to remove all slice areas. 

Or, 

Click Clear ALL measurements... to remove all digitized measurements. 

2. If you clicked Clear ALL Areas..., click Yes in the confirmation dialog box that appears to remove all slice areas. 

Or, 

If you clicked Clear ALL measurements..., click Yes in the confirmation dialog box that appears to remove all 
measurements. 
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Taking Measurements Using Paths 
You use the Path tab of the Digitize/Measurements palette to take measurements using paths. This tab is available only for the 
<Dolphin> analysis. 

To take a measurement using a path: 

1. Select 3D from the View drop-down list box. 

2. Select  <Dolphin> from the Analysis drop-down list box. 

3. Click the Path tab on the Digitize/Measurements palette. 

The Path tab opens (see below). 

4. Click points on the image to identify the path. 

Dolphin 3D draws a path using points you identified.  

5. Click the last point on the path twice to end the path. 

On the palette, a name for the path is listed in the Name column and its length appears in the Value column. 

If you make a mistake, you can click and drag a point to reposition it or click Clear Highlighted Path to start over. 
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View 

Select the view for the type of analysis for 
which you want to view or take 
measurements from this drop-down list box. 
The following options are available: 
3D: View or take measurements for 3D 
analyses. The <Dolphin> analysis is 
available under this view. 
2D Lateral: View measurements for 2D 
lateral analyses. 
2D Frontal: View measurements for 2D 
frontal analyses. 
The analyses available in the Analysis drop-
down list box depend on your choice in this 
drop-down list box. 

Analysis 
Select the analysis that you want to use to 
take measurements. The Path tab is 
available only for the <Dolphin> analysis. 

Name 

Name of the path. Dolphin 3D numbers the 
paths sequentially and identifies the view on 
which you drew each path. For example, if 
you drew the third path on the sagittal slice 
view, Dolphin 3D names it Path 3 (Sagittal). 

Value The length of the path. 

Clear Highlighted 
Path 

Click this button to remove the path currently 
highlighted in the list from the image. 

Clear ALL Paths... Click this button to remove all the paths from 
the image. 

Clear ALL 
measurements... 

Click this button to remove all the 
measurements from the image. 

Undo Last 
Digitization Click this button to undo your last digitize operation. 

 

Click this button to copy the measurement data to the clipboard. The exported data can be imported into 
another application such as Microsoft Excel. For more information, see "Copying Landmark and Measurement 
Data to the Clipboard" on page 789. 

Close Click this button to close the palette. 
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To resize the columns in the list: 
1. Move the mouse pointer to the dividing line between two column headings. 

2. When the mouse pointer changes to a two-headed arrow across a line, click and drag the mouse to resize the column 
headings. 

To remove paths and measurements: 
1. Select the path you want to remove in the list box. Then, click Clear Highlighted Path. 

Or, 

Click Clear ALL Paths... to remove all paths. 

Or, 

Click Clear ALL measurements... to remove all digitized measurements. 

2. If you clicked Clear ALL Paths..., click Yes in the confirmation dialog box that appears to remove all paths. 

Or, 

If you clicked Clear ALL measurements..., click Yes in the confirmation dialog box that appears to remove all 
measurements. 

Copying Landmark and Measurement Data to the Clipboard 

To copy the landmark and measurement data to the clipboard: 

1. Click  on the Digitize/Measurement palette. 

A message appears indicating that landmark coordinates and measurements have been copied to the clipboard.  

2. Click OK. 

You can paste the data from the clipboard into another application, such as Microsoft Excel, for further analysis. 
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27 Making Dolphin 3D Movies 
With the 3D Script Editor, you can create a smooth, animated movie with different views of the 3D volume and photograph (if 
available). To create a movie, you perform the following basic steps: 

1. You create a script that contains key frames (or snapshots) of the 3D volume and photograph (if available).  

Your key frames can include different viewing angles, zoom factors, translucency, clipping slices or boxes, and so on. 
The movie that you create from this script will display each of these key frames in order, smoothly transitioning from 
one frame to the next whenever possible. For more information, see "Creating a Script" on page 792. 

At any time, you can save the script so that you can load it and work on it more later. 

2. You generate and view a preview of the movie from your script to make sure that the movie will work as expected. 

Generating the preview takes much less time than generating the final movie file. By viewing the preview, you can get 
a good idea of how the final movie will look and decide whether you want to add more frames to the movie or delete 
some of the existing frames. For more information, see "Previewing a Movie" on page 797. 

3. You generate the final movie file in AVI format, which you can play using popular movie viewing programs such as 
Windows Media Player and QuickTime.  

Before generating the movie, you can specify options that control its speed, resolution, quality, and file size. Depending 
on the number of frames in your movie, generating it may take several minutes. For more information, see "Generating 
a Movie" on page 798. 

4. After you have generated the movie, you can save it as part of the patient's record in Dolphin Imaging. You can also 
export it to your computer's file system so that you can open it outside of Dolphin Imaging, email it to the patient or 
other professionals, and so on. 

Saving the movie in your Dolphin Imaging database stores it as part of the current timepoint. When saving the movie, 
you select the layout and image slot in which you want to store it. For more information, see "Saving the Movie" on 
page 800. 

In addition to saving the entire movie as part of the patient's Dolphin Imaging record, you can save the script's sequence of 
frames as individual Dolphin images. In this way, you can create a composite set of images for your 3D volume for later viewing 
or for transfer to referrals. 
Once you have created and saved a script, you can apply it to other patients to create movies containing the same views of their 
3D volume data. In this way, you can create standardized movie presentations of your patients. For more information, see 
"Refreshing Script Frames with the Current Patient's Data" on page 804. 

To open the 3D Script Editor: 

1. Click . 

Or, 

Select Create/Use Script... from the Tools menu. 

The 3D Script Editor window opens. 
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File 
menu 

Offers the following options: 
New Script: Offers an option to clear the current script from the 3D Script Editor window so you can begin creating a new 
script. If you have previously saved the script, clearing it does not delete the saved script file. For more information, see 
"Loading, Saving, and Clearing a Script" on page 796. 
Load Script...: Loads a previously-saved script so that you can edit it, preview it, or generate a movie from it. For more 
information, see "Loading, Saving, and Clearing a Script" on page 796. 
Save Script: Saves your current script in a file on your computer's file system. For more information, see "Loading, 
Saving, and Clearing a Script" on page 796. 
Save Script As...: Saves your current script in a file on your computer's file system with a new name. For more 
information, see "Loading, Saving, and Clearing a Script" on page 796. 
Make Movie...: Generates a movie from your script. Generating a movie may take several minutes, depending on the 
length of the movie. Once generated, the movie appears in your default movie player (such as Windows Media Player or 
QuickTime). For more information, see "Generating a Movie" on page 798. 
Save frames as individual images...: Saves the script's sequence of frames as individual images in a Dolphin Imaging 
layout. For more information, see "Saving the Frames as Dolphin Images" on page 802. 
Save Movie...: Saves the movie you have generated as part of the patient's record in Dolphin Imaging. This option is only 
available after you have generated a movie from the script. For more information, see "Saving the Movie" on page 800. 
Export Movie...: Exports the movie you have generated to a file on your computer's file system. This option is only 
available after you have generated a movie from the script. For more information, see "To export a movie to your 
computer's file system" on page 802. 
Hide Dialog: Hides the 3D Script Editor window. 

Edit 
menu 

Offers the following options: 
Insert New Frame at End: Adds a new frame to the end of your script. For more information, see "Adding a Frame" on 
page 793. 
Insert New Frame After Highlighted Frame: Adds a new frame to your script after the selected frame. For more 
information, see "Adding a Frame on page 793. 
Insert New Frame Before Highlighted Frame: Adds a new frame to your script before the selected frame. For more 
information, see "Adding a Frame on page 793. 
Replace Highlighted Frame: Replaces the selected frame in your script with a new frame. For more information, see 
"Adding a Frame on page 793. 
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Delete Highlighted Frame: Deletes the selected frame from your script. For more information, see "Deleting a Frame" on 
page 795. 
Refresh Script Preview: Refreshes the frames in the current script using the current patient. For more information, see 
"Refreshing Script Frames with the Current Patient's Data" on page 804. 
Preview Movie: Generates a preview of your movie from your script. The generated preview is a low-resolution version 
of your movie that generates much faster than the final movie. Once generated, the preview appears in your default 
movie player (such as Windows Media Player or QuickTime). For more information, see "Previewing a Movie" on page 
797. 
Movie Generation Properties...: Opens the AVI Generation Properties dialog box so that you can set options for 
generating movies. For more information, see "To set movie generation properties" on page 798. 

 
Click this button to add a new frame to the end of your script. For more information, see "Adding a Frame on page 793. 

 

Click this button to preview the movie that you can make from your script. The generated preview is a low-resolution 
version of your movie that generates much faster than the final movie. Once generated, the preview appears in your 
default movie player (such as Windows Media Player or QuickTime). For more information, see "Previewing a Movie" on 
page 797. 

 

Click this button to generate a movie from your script. Generating a movie may take several minutes, depending on the 
length of the movie. Once generated, the movie appears in your default movie player (such as Windows Media Player or 
QuickTime). For more information, see "Generating a Movie" on page 798. 

 
Click this button to delete the selected frame from your script. For more information, see "Deleting a Frame” on page 795. 

 
Click this button to refresh the frames in the current script using the current patient. For more information, see 
"Refreshing Script Frames with the Current Patient's Data" on page 804. 

 

Click this button to export the script's sequence of frames as individual images in a Dolphin Imaging layout. For more 
information, see "Saving the Frames as Dolphin Images" on page 802. 

 

Click this button to save a movie you have generated as part of the patient's record in Dolphin Imaging. This button only 
appears after you have generated a movie from the script. For more information, see "Saving the Movie" on page 800. 

Creating a Script 
Creating a script involves adding and arranging a sequence of frames that will be used to create the movie. You can also set 
properties for the frames to control how long each frame remains on the screen in the final movie. By default, transitioning from 
one movie frame to the next takes one second, and the last frame in the movie displays statically on the screen for one second. 
When you generate a preview or the final movie file, your default movie viewer opens and shows a preview or final movie that 
transitions through the frames in your script in the order they appear in the 3D Script Editor window.  
Note: When creating your script, it is important to insert enough frames so that there is no ambiguity in the way that the movie 
should transition from one frame to the next. To make sure that your movie will be generated as you expect, you can preview it. 
After the preview, you can make any corrections to your script, such as inserting additional frames, reordering the frames, or 
deleting frames. 
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Adding a Frame 

To add the first key frame to your script: 

1. In the Dolphin 3D Window, manipulate the 3D volume as necessary to create the view that you want to use for this 
frame. 

2. On the Dolphin 3D Window, select Add to Script from the Edit menu. 

Or, 

On the Dolphin 3D Window, right-click the image and select Add to End of Script from the pop-up menu. 

Or, 

On the 3D Script Editor window, click . 

Or, 

On the 3D Script Editor window, select Insert New Frame at End from the Edit menu. 

Or, 

Press Ins on your keyboard. 

The frame you added appears in the 3D Script Editor window. 

To add an additional key frame to the end of your script: 

1. In the Dolphin 3D Window, manipulate the 3D volume as necessary to create the view that you want to use for this 
frame. 

2. On the Dolphin 3D Window, select Add to Script from the Edit menu. 

Or, 

On the Dolphin 3D Window, right-click the image and select Add to End of Script from the pop-up menu. 

Or, 

On the 3D Script Editor window, click . 

Or, 

On the 3D Script Editor window, right-click one of the frames. Then, select Insert at End from the pop-up menu. 

Or, 

On the 3D Script Editor window, select Insert New Frame at End from the Edit menu. 

Or, 

Press Ins on your keyboard to add the new frame at the end of the script. 
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To add an additional key frame in the middle of your script: 

1. In the Dolphin 3D Window, manipulate the 3D volume as necessary to create the view that you want to use for this 
frame. 

2. On the 3D Script Editor window, select a frame in the script.  

3. On the 3D Script Editor window, select Insert New Frame After Highlighted Frame from the Edit menu to add the new 
frame after the selected frame.  

Or, 

On the 3D Script Editor window, right-click one of the frames. Then, select Insert After Highlighted Frame from the pop-
up menu to add the new frame after the selected frame. 

Or,  

On the 3D Script Editor window, select Insert New Frame Before Highlighted Frame from the Edit menu to add the new 
frame before the selected frame.  

Or, 

On the 3D Script Editor window, right-click one of the frames. Then, select Insert Before Highlighted Frame from the 
pop-up to add the new frame before the selected frame. 

To replace a key frame in your script: 

1. In the Dolphin 3D Window, manipulate the 3D volume as necessary to create the view that you want to use for this 
frame. 

2. On the 3D Script Editor window, select a frame in the script. 

3. On the Dolphin 3D Window, right-click the image and select Replace Highlighted Script Frame from the pop-up menu. 

Or, 

On the 3D Script Editor window, select Replace Highlighted Frame from the Edit menu. 

Or, 

On the 3D Script Editor window, click right-click one of the frames. Then, select Replace Highlighted Frame from the 
pop-up menu. 
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Deleting a Frame 

To delete a key frame from your script: 

1. In the 3D Script Editor window, click the frame you want to delete from your script, and click . 

Or, 

Click the frame you want to delete from your script, and select Delete Highlighted Frame from the Edit menu. 

Or, 

Right-click the frame you want to delete from your script, and select Delete Highlighted Frame. 

A dialog box appears asking you to confirm the deletion. 

2. Click Yes to delete the frame. 

Rearranging Frames 

To rearrange key frames in your script: 

1. Drag and drop a frame to a different location in the script. 

As you drag the frame, a vertical bar indicates the position to which the frame will be moved if you drop it. 

Setting Frame Properties 

To set properties for a key frame: 

1. Right-click the frame, and select Highlighted Frame Properties... from the pop-up menu. 

The Movie Frame Properties dialog box opens.  

2. Set any properties for this frame, and click OK. 
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Position The position of this frame within your script. To change the position of a frame, see "Rearranging Frames" on 
page 795. 

Frame 
Description A description for this frame. 

Number of 
images to 
generate  
Or 
This is the last 
image... 

For all frames except the last frame in the movie, enter the number of movie frames that you want to use to 
transition between this key frame and the next key frame. Typically, this value is set to the same number as 
the frames per second (F.P.S), but you can change it if you want to dedicate more or fewer movie frames for 
this key frame relative to other key frames in the movie. 
For the last frame in the movie, enter the number of still frames to generate for this key frame. Since the last 
movie frame doesn't transition to another key frame, it remains as a static image on the screen for the 
number of frames you specify. 

F.P.S The number of frames per second for this script. To change the frames per second, see "To set movie 
generation properties" on page 798. 

 

Loading, Saving, and Clearing a Script 

To load a previously-saved script: 

1. Select Load Script... from the File menu. 

The Open dialog box appears. 

2. Navigate to the folder containing the script you want to open. 

3. Select the script. 

4. Optionally, check the Open as Read Only box. 
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If you open the script as read-only, you will not be able to save the script using the same name. In this way, you can 
avoid accidentally writing over a script to which you don't want to make any changes. 

5. Click Open. 

To save a script: 

1. Select Save Script from the File menu. 

Or, 

Select Save Script As... from the File menu to save this script with a new name. 

If this is the first time you have saved the script or if you selected Save Script As..., the Save As dialog box appears. 

2. Navigate to the folder in which you want to save the script. 

3. Enter the file name that you want to use for the script. Then, click Save. 

To clear a script from the 3D Script Editor window: 

1. Select New Script from the File menu. 

A dialog box appears asking you to confirm that you want to clear the script currently open in the 3D Script Editor 
window.  

Note: Clearing a script removes it from the 3D Script Editor window. Any work you have done on the script since you 
last saved it will be lost. If you have saved the script, the saved script file will not be deleted. 

2. Click Yes to clear the script. 

Previewing a Movie 
Once you have created your script, you can preview the movie it will generate to make sure that the script works as expected. 
The generated preview is a low-resolution version of your movie that generates much faster than the final movie. Once the 
preview is generated, it opens in your default movie viewer (such as Microsoft Media Player or QuickTime) and begins playing so 
that you can see how it looks. 
Once you are happy with the movie's appearance, you can generate the final movie. 

To preview a movie generated from your script: 

1. Click . 

Or, 

Select Preview Movie from the Edit menu. 

A progress bar appears at the bottom of the 3D Script Editor window as the preview generates.  
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Generating a Movie 
Note: Depending on the number of key frames in your movie, generating it may take several minutes. Once the movie is 
generated, it opens in your default movie viewer (such as Microsoft Media Player or QuickTime) and begins playing so that you 
can see how it looks. 

To generate a movie from your script: 

1. Click . 

Or, 

Select Make Movie... from the 3D Script Editor's File menu. 

A progress bar appears at the bottom of the Dolphin 3D Movie Maker window as the movie generates.  

To set movie generation properties: 

1. Select Movie Generation Properties... from the Edit menu. 

The AVI Generation Properties dialog box opens so that you can specify options for the movie. 

2. Enter options for the movie.  

3. Click OK. 
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Resolution 
Enter a resolution value (from 100 to 10000) for your movie. This value determines the size of the movie 
window on the screen. For example, a value of 400 creates a movie that is 400 pixels wide by 400 pixels high, 
which typically is sufficient resolution for a computer screen. If the movie includes frames that use the 3+1 or 
2x2 layout, you may want to increase this value to 700. 

F.P.S. Enter the number of frames per second that you want to use for your movie. 

Restore all 
the defaults Click this button to restore the default values for all the movie generation options. 

Change 
Codec 

Click this button to change the codec to use to create the movie. The codec is the program that compresses 
and decompresses the movie data. Changing the codec is an advanced operation. In most cases, you can 
simply use the default codec selection. For more information, see below. 

To use a different codec to generate the movie: 

1. Click Change Codec. 

The Dolphin Codecs dialog box opens. On this dialog box, you can select the codec you want to use to generate the 
movie and enter options for it. 

2. Select a codec from the Compressor drop-down list box. 

Note: The computer or other device that you use to play the resulting movie must support the codec that you select. 

3. Set any other options for the codec, and click OK. 

 

Compressor Select the codec you want to use from this drop-down list box. Some codecs may not be supported by your 
computer, depending on your computer's hardware and software configuration. 

Compression 
Quality 

Use this slider to set the quality value to use when compressing the movie. A lower value results in a lower 
quality movie and a smaller file size (due to higher compression). If you change this option, the corresponding 
field on the AVI Generation Properties dialog box is set automatically to match. This option is not available for 
all codecs. 
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Key Frame 
Every n frames 

Check this box and enter the number of frames that the movie will take to transition from one frame in your 
script to the next. If you change this option, the corresponding field on the AVI Generation Properties dialog 
box is set automatically to match. This option is not available for all codecs. 

Configure Click this button enter additional configuration options for the selected codec. These configurable options 
depend on the codec you selected. In addition, this button is not available for all codecs. 

Saving a Movie 
After you generate a movie, you can save it in the following ways:  

• Save it to Dolphin Imaging: Saving a movie makes it part of the patient's record in Dolphin Imaging. For example, if you 
archive this patient and send the archive file to a referral, the movie will be included in the archive file and the referral 
will be able to view it. 

• Export it to your computer's file system: Exporting the movie creates a file on your computer's file system. You can 
then view the movie without starting Dolphin Imaging. You can also share it with the patient or other professionals by 
emailing them the movie file or writing it on a CD or DVD. 

To save a movie to Dolphin Imaging: 

1. Click . 

Or, 

Select Save Movie... from the File menu. 

The Export to Dolphin window opens so that you can select the image layout and slot in which you want to store the 
movie. The movie will be saved in the current timepoint for this patient. 

2. Optionally, change to a different image layout as described below. 

3. Click a slot in the image layout to save the movie in that slot. 

4. Optionally, enter a new image slot title to use for the movie in the Image Title text box. 

5. Click Save.... 
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Image Layout Displays the currently-selected image layout. Click a slot in the layout to save the movie in that slot. 

Image Title Enter an image title to use for the movie. Initially, this field contains the title defined in the image layout for the 
selected image slot. 

Change 
Layout... Click this button to select a different image layout. 

Save... Click this button to save the movie in the selected image slot in the selected layout. 

To choose a different image layout: 

1. Click Change Layout.... 

2. Select the image layout in which you want to save this movie from the drop-down list box. Then, click OK. 
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To export a movie to your computer's file system: 

1. Select Export Movie... from the File menu. 

The Save As dialog box appears. 

2. Specify the directory and file in which you want to save the movie. 

3. Click Save to save the movie.  

 

Saving the Frames as Dolphin Images 
Once you have created a script, you can export the sequence of frames in your script as individual images to the patient's current 
timepoint in Dolphin Imaging. You can store the images in any image layout. The first frame in your script will be saved in the first 
slot in the selected image layout and subsequent frames will be saved in the subsequent slots until all key frames in your script 
have been saved. 
Note: When you save the frames to an image layout, images currently stored in the selected image layout can be overwritten. 
For this reason, you may want to export the images into an empty image layout. 
For example, suppose the Misc. Photos layout for the current timepoint already has images stored in the first, second, and third 
image slots. If you save the frames from a script containing two frames to the Misc. Photos layout, the existing images in the first 
two slots of the layout will be overwritten.  
If you routinely save the frames from a particular script as Dolphin Images, you may wish to create an image layout for this 
purpose. For more information, see Chapter 7. 
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To save the script's frames to a Dolphin Imaging layout: 

1. Click . 

Or, 

Select Save Frames as Individual Images... from the File menu. 

The Export to Dolphin dialog box opens. 

2. Optionally, select the image layout to which you want to export the frames. 

The images will be exported to patient's current timepoint and the selected image layout.  

3. Click Save.... 

A dialog box appears warning you that saving to an image layout that already contains images may overwrite the 
existing images. 

4. Click Yes to save the key frames to the image layout. 

Or, 

Click No to return to the 3D Script Editor window without saving. 

 

Image Layout Displays the currently-selected image layout.  

Select Sequence Select an image layout from this drop-down list box to save the key images in your script to that layout. 

Save... Click this button to save the key frames in the script to the selected layout. 
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Once you have saved the images to Dolphin Imaging, you can save them as individual image files on your computer for sharing 
with others.  

To save the script's frames as individual image files on your computer: 

1. On the Dolphin Imaging main screen, right-click one of the images in the image layout to which you saved the script's 
frames. 

2. Select Save Layout As... from the pop-up menu. 

3. Specify the directory and file in which you want to save the images. 

4. Check the Save Individually box to create separate image files for each image in the layout. 

5. Click Save. 

An image file is created in the directory you specified for each image in the layout. 

Refreshing Script Frames with the Current Patient's Data 
Once you have created and saved a script, you can use it over and over again to create movies using the 3D image data from a 
variety of patients. To do this, you load the saved script and refresh its frames with data from the current patient. For information 
on loading a script, see "Loading, Saving, and Clearing a Script" on page 796. 

To refresh the script's frames with the current patient's data: 

1. Click . 

Or, 

Select Refresh Script Preview from the Edit menu. 

The frames in the 3D Script Editor window update to reflect the new data. 
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28 Analyzing the Patient's Airway 
Using the Airway Analysis feature, you can mark a patient's airway, view it in three dimensions, calculate its volume, and locate 
the cross-section where its area is the smallest. You can also save up to five work-ups for each patient. 
Note: The Airway Analysis feature is available only on computers that support advanced 3D rendering modes ("translucent" 
modes). 

To open the Airway Analysis dialog box: 

1. Click  on the Dolphin 3D main window. 

Or, 

Select Airway Analysis from the Tools menu. 

The Airway Analysis dialog box opens. This dialog box is divided into two halves: 

Draft 
Half 

On the left side of the dialog box, you identify the patient's airway by viewing slices of the volume and 
placing seed points in the voids on the image that are part of the patient's airway. Starting at these seed 
points, Dolphin 3D selects adjacent empty areas. 

Result 
Half 

On the right side of the dialog box, you view the results of your airway analysis using both a slice view 
and a translucent volume view. 
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Lock Orientation Check this box to lock the orientation of the image in this window. 

Click one of these buttons to view a standard slice in the window. For more information, see "Standard 
Slice Views" on page 657. 

: 
Click this button to view the sagittal slice. 

: 
Click this button to view the coronal slice. 

: Click this button to view the axial slice. 

Slice buttons 

: Click this button to view all three standard slices. 
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Click one of these buttons to view the volume in one of the predefined views. For more information, 
see "Moving or Reorienting the Image" on page 640. 

Predefined Views 

: Click this button to orient the volume for a right view. 

 : Click this button to orient the volume for a right oblique view. 

 : Click this button to orient the volume for a front view. 

 : Click this button to orient the volume for a left oblique view. 

 : Click this button to orient the volume for a left view. 

 : Click this button to orient the volume for a back view. 

 : Click this button to orient the volume for a top view. 

 : Click this button to orient the volume for a bottom view. 

 : Click this button to orient the volume for a right isometric view. 

 : Click this button to orient the volume for a left isometric view. 

 
: Click this button to view the volume in the three views pictured. 

Click one of these buttons to specify two views you want to see in the result half of the window. 

: 
Click this button to view the sagittal slice and the volume. 

: 
Click this button to view the coronal slice and the volume. 

Result Half Views 

: 
Click this button to view the axial slice and the volume. 
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Click this button to return the sagittal, coronal, and axial slices to their standard locations after you 
have customized them. For more information, see "To select a slice to view on the Draft Half of the 
Airway Analysis window" on page 811. 

Enable "Minimum 
Axial Area" 

Check this box to enable the "Minimal Axial Area" feature, which enables you to find the axial cross-
section of the volume where the airway area is the smallest. For more information, see "Analyzing 
Your Results" on page 819. 

Find Click this button to find the minimal axial area (see above). For more information, see "Analyzing Your 
Results" on page 819. 

 
Click these arrow buttons to move the image in the window in the indicated direction. For more 
information, see "Moving or Reorienting the Image" on page 640. 

 
Click this button to zoom in on the image. For more information, see "Changing the Magnification" on 
page 640. 

 
Click this button to zoom out on the image. For more information, see "Changing the Magnification" on 
page 640. 

 
Click this button to fit the image in the window. For more information, see "Changing the Magnification" 
on page 640. 

 
Use this slider to rotate the image around the indicated axis. For more information, see "Moving or 
Reorienting the Image" on page 640. 

Remove Click this button to remove the boundaries from the current slice. 

<-Same Click this button to set the location of the slice shown in the Draft Half of the dialog box to the location 
set in slice view in the Results Half of the dialog box. 

Show 3D Plane Check this box to show planes indicating the locations of the sagittal, coronal, and axial slices on the 
volume view in the lower right corner of the dialog box.  

Slider Adjust the slider to change the location of the slice currently being displayed. For more information, 
see "To select a slice to view on the Draft Half of the Airway Analysis window" on page 811. 

WL Click this button to reset the window leveling to the default values. For more information, see "Setting 
Window Leveling" on page 768. 
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Remove... 

Click this button to open a pop-up menu with the following choices: 
Remove Sagittal/Coronal/Axial Boundary: Select this option to remove the boundary you have 
placed for this slice. 
Remove ALL Boundaries: Select this option to remove all the boundaries for all the slices. 
Remove ALL Seed Points: Select this option to remove all the seed points you have placed. 
Remove ALL Boundaries and Seed Points:  Select this option to remove all the boundaries and 
all the seed points for all the slices. 
Close This Menu:  Select this option to close this menu. 
For more information, see "Restricting the Airway Analysis Area" on page 816 and "Placing Seed 
Points" on page 817. 

<Prev 
Click this button to view the previous seed point placed. Dolphin 3D changes the slice view to show 
the previous seed point. By repeatedly clicking this button, you can view the seed points you placed 
in reverse order of placement. 

Add Click this button to add a seed point. For more information, see "Placing Seed Points" on page 817. 

Next> 
Click this button to view the next seed point placed. Dolphin 3D changes the slice view to show the 
next seed point. By repeatedly clicking this button, you can view the seed points in the order you 
placed them. 

Show Hidden Seeds Check this box to show seed points that would ordinarily be obscured within the volume. For more 
information, see "Placing Seed Points" on page 817. 

Adjust slice airway 
sensitivity 

Adjust this slider to set the sensitivity that Dolphin 3D uses when expanding from a seed point to fill 
the empty areas. For more information, see "Placing Seed Points" on page 817. 

Update Volume Click this button to update the images on the Result Half of the dialog box with the changes you 
have made to the patient's airway. For more information, see "Verifying Your Results” on page 818. 

 
Click this button to open the 3D Script Editor, which enables you to create videos based on the 
image or images in the result half of the window. For more information, see Chapter 27. 

 
Click this button to open the Digitize/Measurement palette so that you can take measurements on 
the volume view in the result half of the window. For more information, see Chapter 26. 

Save... Click this button to save the present state of the airway analysis to one of five work-up slots. For 
more information, see "Saving and Restoring the Airway Analysis" on page 821. 

Restore... Click this button to restore one of the previously-saved work-ups. For more information, see "Saving 
and Restoring the Airway Analysis" on page 821. 
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Volume 
Rendering 
Options 

Use these options to specify how to render the volume view in the lower right corner of the dialog box. 
Show Airway As: Set options for rendering the airway. 
Surface: Select this option to render the airway as an surface, which is sharper than the solid rendering. 
Solid: Select this option to render the airway as a solid. 
Color Sample: Click the color sample to set the color for the airway. For more information, see "Setting 
Colors" on page 649. 
Soft Tissue:  Check this box view the patient's soft tissue in the lower right corner of the dialog box. Use 
the slider to select the density segment for the soft tissue view. For more information, see "Viewing the Soft 
Tissue" on page 635. 
Hard Tissue:  Check this box view the patient's hard tissue in the lower right corner of the dialog box. Use 
the slider to select the density segment for the hard tissue view. For more information, see "Viewing the 
Hard Tissue" on page 637. 
Note: Uncheck both boxes to show the airway only, hiding the patient's image. For more information, see 
"Analyzing Your Results" on page 819. 

Send Snapshot... 

Opens a pop-up menu with the following options: 
Close This Menu: Choose this option to close the pop-up menu. 
Save To Dolphin Layout/Database: Choose this option to save the 3D image to a slot in a Dolphin image 
layout and store it in your database. For more information, see "Saving an Image" on page 661. 
Send To Report: Choose this option to use this image in a Dolphin 3D report. For more information, see 
Chapter 32. 
Copy To Clipboard: Choose this option to copy the 3D image to the clipboard. Then, you can paste the 
image into another application. For more information, see "Copying the Image to the Clipboard" on page 
663. 
Print: Choose this option to print the image. For more information, see "Printing an Image" on page 664. 
Export To File: Choose this option to export the 3D image to a file. For more information, see "Exporting 
an Image" on page 663. 

Selecting a Slice or Volume View 
To identify the patient's airway, you select a slice or volume on the Draft Half of the window and place seed points in the voids on 
the image. Dolphin 3D expands the seed points to fill adjacent empty areas. Then, you check your work using the various slice 
and volume views offered on the Result Half of the window. 
The following figure summarizes the views offered on the Airway Analysis window. 
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To select a slice to view on the Draft Half of the Airway Analysis window: 

1. Click  to view the sagittal slice. 

Or, 

Click   to view the coronal slice. 

Or, 

Click   to view the axial slice. 

Or, 

Click   to view all three slices. 

2. Adjust the slider below the slice view to move the slice through the volume. 
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To reset the slices to their default locations: 

1. Click . 

To select a slice to view on the Result Half of the Airway Analysis window: 

1. Click  to view the sagittal slice above the volume. 

Or, 

Click  to view the coronal slice above the volume. 

Or, 

Click  to view the axial slice above the volume. 

Or, 

Click  to view only the sagittal slice. 

Or, 

Click  to view only the coronal slice. 

Or, 

Click  to view only the axial slice. 

2. Adjust the slider below the slice view to move the slice through the volume. 
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To select a volume view on the Draft Half of the Airway Analysis window: 

1. Click  for a right view. 

Or, 

Click  for a front view. 

Or, 

Click  for a bottom view. 

Or, 

Click  for all three views. 
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To select a volume view on the Result Half of the Airway Analysis window: 

1. Click  to view the sagittal slice above the volume. 

Or, 

Click  to view the coronal slice above the volume. 

Or, 

Click  to view the axial slice above the volume. 

Or, 

Click  to view only the volume. 
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Restricting the Airway Analysis Area 
Before you begin your airway analysis on a particular slice or volume view, you can restrict the area for that analysis by creating 
a polygon on it. Then, when you place seed points, Dolphin 3D selects adjacent empty areas as part of the airway only up to the 
boundary defined by the polygon. 

To restrict the airway analysis area for a particular slice or volume view: 

1. On the Draft Half of the Airway Analysis dialog box, click the button for the slice or volume view on which you want to 
create a boundary. 

2. Click the left mouse button on a point where you want to begin drawing the boundary polygon. 

3. Release the mouse button and move the mouse to begin drawing the polygon. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position. 

4. Click the mouse button whenever you want to place a point and change the direction of the line. 

5. Click the left mouse button again on the first point to close the boundary polygon. 

To remove a boundary from a single slice view: 

1. On the Draft Half of the dialog box, click the button for the slice view from which you want to remove the boundary. 

2. Click Remove. 

To remove the boundaries from all slice and volume views: 

1. Click Remove ALL.... 

2. Select Remove ALL Boundaries from the pop-up menu to remove all the boundaries you have placed for all slice and 
volume views. 

3. Click Yes on the confirmation dialog box that appears to remove all the boundaries. 

To remove the boundaries and seed points from all slice and volume views: 

1. Click Remove ALL.... 

2. Select Remove ALL Boundaries and Seed Points from the pop-up menu to remove all the boundaries and all the seed 
points you have placed for all slice and volume views. 

3. Click Yes on the confirmation dialog box that appears to remove all the boundaries and seed points. 
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Placing Seed Points 

To place a seed point: 

1. Click Add. 

 A yellow point appears on the slice image. 

2. Click and drag the yellow point to a void in the image that is part of the patient's airway. 

Click and drag when four triangles appear surrounding the yellow point. When you place the seed point, magenta 
shading fills the adjacent empty areas, identifying them as part of the patient's airway. 

3. Adjust the slider labeled "Step two: Adjust slice airway sensitivity:" to set the sensitivity for expanding the seed point to 
adjacent empty areas. 

As you adjust the slider, the magenta shading expands or contracts slightly. Set the slider so that the magenta shading 
fills this part of the patient's airway. 

 

 

To remove all seed points and start your airway analysis again: 

1. Click Remove ALL.... 

2. Select Remove ALL Seed Points from the pop-up menu. 

3. Click Yes on the confirmation dialog box that appears to remove all the seed points. 



Dolphin Imaging User's Guide April 2011 

818 DI_USER_GUIDE-11.5   Rev. 1.01 

To remove the boundaries and seed points from all viewing slices: 

1. Click Remove ALL.... 

2. Select Remove ALL Boundaries and Seed Points from the pop-up menu to remove all the boundaries and all the seed 
points you have placed for all slices. 

3. Click Yes on the confirmation dialog box that appears to remove all the boundaries and seed points. 

To view hidden seed points: 

1. Check Show Hidden Seeds. 

Any seed points that you have placed that would not ordinarily be visible on the current slice view appear. 

 

Verifying Your Results 

To verify the airway analysis results: 

1. When you finish placing seed points, click Update Volume. 

Dolphin 3D calculates the airway volume based on the seed points you have placed and updates both images in the 
Result Half of the dialog box.  

2. Verify the results in the Result Half of the dialog box. 

If necessary, you can place additional seed points to identify parts of the patient's airway that you have missed. Then, 
you can click Update Volume again to verify your results. 
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Analyzing Your Results 

To find the axial cross-section of the volume where the airway area is the smallest: 

1. On the Result Half of the Airway Analysis dialog box, select the Sagittal tab. 

2. Check the Enable "Minimum Axial Area" box. 

3. Click and drag the dotted red lines to identify the area of the volume that you want to search. 

Click and drag when your mouse pointer turns into a double-headed arrow. 

4. Click Find. 

Dolphin 3D searches the identified area of the volume to find the axial cross-section where the area of the airway is the 
smallest. It displays location of this cross-section and the minimum area on the volume view in the lower right of the 
Result Half of the dialog box. 

5. Click the Axial tab to view the axial cross-section with the smallest airway area. 
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To view only the airway in the volume view: 

1. Under Volume Rendering Options, uncheck both the Soft Tissue and the Hard Tissue boxes. 

The volume view in the lower right of the Result Half of the dialog box shows the patient's airway only. 
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Saving and Restoring the Airway Analysis 
When you close the Airway Analysis dialog box, all your seed points and boundaries are automatically saved. The next time you 
open this dialog box, this information is restored automatically.  In addition, you can save up to five versions of the airway 
analysis work-up. Later, you can restore any saved work-up. 

To save an airway analysis work-up: 

1. Click Save... 

 A pop-up menu appears offering five slots for saving your work-up. 

2. Click a work-up slot to save your work in that slot. 

To restore a previously saved work-up: 

1. Click Restore... 

A pop-up menu appears listing the work-up slots. Empty slots are grayed out. 

2. Click the slot containing the work-up that you want to restore. 
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29 Mirroring and Superimposing 
This chapter describes the following Dolphin 3D features: 

• Volume mirroring enables you to mirror one side of a patient over to the other side, and either overlay the original or 
replace it.  This is useful for analyzing asymmetries and for working with trauma patients who are missing some 
anatomy on one side. 

• Volume superimposition enables you to load two separate CBCT volume sets, to align them in three dimensions, and 
then compare them in any of the soft tissue or hard tissue rendering views. You can, for example, view a patient’s 
changes in hard tissue, soft tissue profile, and airway, between a pre-treatment and a post-treatment scan. 

Volume Mirroring 
To create a mirror image, you first select the volume view you want to use.  For example, you can select: 

• the soft or hard tissue in a frontal or bottom view 

• a radiograph coronal or axial slice view 

Then, you create the mirror image. 
Note: The Mirroring Tool is available only on computers that support advanced 3D rendering modes ("translucent" modes). 

To open in the Mirroring Tool dialog box: 

1. Click  on the Dolphin 3D main window. 

Or, 

Select Mirroring from the Tools menu. 

The Mirroring Tool dialog box opens. 
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Front/Coronal tab 
Click this tab for the following views: 
a frontal view of the volume if the Slice View box is not checked (see below) 
the coronal slice if the Slice View box is checked 

Bottom/Axial tab 
Click this tab for the following views: 

a bottom view of the volume if the Slice View box is not checked (see below) 
the axial slice if the Slice View box is checked 

Slice View Check this box to view the coronal and axial slices on the Front/Coronal and Bottom/Axial tabs, 
respectively, rather than the front and bottom volume views. 

 
Click these arrow buttons to move the volume in the window in the indicated direction. For more 
information, see "Moving or Reorienting the Image" on page 640. 

 
Click this button to zoom in on the volume. For more information, see "Changing the Magnification" on 
page 640. 

 
Click this button to zoom out on the volume. For more information, see "Changing the Magnification" on 
page 640. 
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Click this button to fit the volume in the window. For more information, see "Changing the Magnification" 
on page 640. 

Rotation Sliders 

Use these sliders to rotate the volume around the indicated axis: 
: Use this slider to rotate the volume horizontally. 
: Use this slider to rotate the volume circularly. 
: Use this slider to rotate the volume vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

Reset Orientation Click this button to return the image on the Front/Coronal and Bottom/Axial tabs to the default 
orientation. 

slider 
Adjust this slider to change the location of the slice currently being displayed. This slider is active only 
when the Slice View box is checked. For more information, see "Using a Slice View for the Mirror Image" 
on page 828. 

 
Click this button to return the coronal and axial slices to their standard locations after you have 
customized them. This button is active only when the Slice View box is checked. For more information, 
see "Using a Slice View for the Mirror Image" on page 828. 

WL Click this button to reset the window leveling to the default values. This button is active only when the 
Slice View box is checked. For more information, see "Setting Window Leveling" on page 768. 

Soft Tissue 

Click this radio button to view the patient's soft tissue.  
Translucent: Click this radio button to view a translucent representation of the patient's soft tissue.  
Seg: Use this slider to select the density segment of the 3D volume to use for the soft tissue view in this 
window.  
3D Photo: Click this radio button to view use the patient's photograph (if available) for the soft tissue 
view. Choose the photograph to display from the drop-down list box. You can store two photographs for 
each 3D volume. 
For more information, see "Using the Soft Tissue for the Mirror Image" on page 826. 

Hard Tissue 

Click this radio button to view a translucent representation of the patient's hard tissue.  
Seg: Use this slider to select the density segment of the 3D image to use for the hard tissue view in this 
window. 
Trans: Use this slider to set the level of transparency in the hard tissue image.  
For more information, see "Using the Hard Tissue for the Mirror Image" on page 827. 

Combined Soft 
Tissue + Hard Tissue 

Click this radio button to show both the patient’s soft and hard tissue images in the window. The settings 
in the Soft Tissue and Hard Tissue group boxes are used to construct the combined view. For more 
information, see "Using the Soft and Hard Tissue for the Mirror Image" on page 828. 

Mirror Facial Left -> 
Right Select this option to create the left side of the image by mirroring the right side of the volume. 
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Mirror Facial Right -> 
Left Select this option to create the right side of the image by mirroring the left side of the volume. 

Show Superimposition 
Check this box to view the mirror image superimposed over the volume. 
Trans: Use this slider to set the level of transparency in the superimposition. 

Show Caliper Check this box to display a symmetry caliper on the image. For more information, see "Using the 
Symmetry Caliper” on page 660. 

Use Clipping Slice 

Check this box to define and view a cross-section of the volume.  
slider: Move the slider to set the location of the slice used for this cross section. 

: Click this icon to set the clipping slice at the mid-sagittal plane. 

: Click this icon to set the clipping slice at the axial plane. 

: Click this icon to set the clipping slice at the coronal plane. 

: Click this icon to use a pie-shaped clipping slice that includes the patient's arch. 

: Click this icon to orient the clipping slice in the direction of the viewer. 
For more information, see "Using a Clipping Slice" on page 869. 

Use Volume Sculpting 
if Exists 

Check this box to use the sculpted volume for the mirror image view, if you have performed sculpting 
operations on this volume. For more information, see "Sculpting the Volume" on page 877. 

Send Snapshot... 

Opens a pop-up menu with the following options: 
Close This Menu: Choose this option to close the pop-up menu. 
Save To Dolphin Layout/Database: Choose this option to save the 3D image to a slot in a Dolphin 
image layout and store it in your database. For more information, see "Saving an Image" on page 661. 
Send To Report: Choose this option to use this image in a Dolphin 3D report. For more information, 
see Chapter 32. 
Copy To Clipboard: Choose this option to copy the 3D image to the clipboard. Then, you can paste 
the image into another application. For more information, see "Copying the Image to the Clipboard" on 
page 663. 
Print: Choose this option to print the image. For more information, see "Printing an Image" on page 
664. 
Export To File: Choose this option to export the 3D image to a file. For more information, see 
"Exporting an Image" on page 663. 

Disable Mirroring Check this box to view the whole volume rather than the volume constructed with the mirroring feature. 
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Click one of these buttons to orient the volume in one of the predefined views. For more information, see "Moving or 
Reorienting the Image" on page 640. Predefined 

Views 

: Click this button to orient the volume for a right view. 

 : Click this button to orient the volume for a right oblique view. 

 : Click this button to orient the volume for a front view. 

 : Click this button to orient the volume for a left oblique view. 

 : Click this button to orient the volume for a left view. 

 : Click this button to orient the volume for a back view. 

 : Click this button to orient the volume for a top view. 

 : Click this button to orient the volume for a bottom view. 

 : Click this button to orient the volume for a right isometric view. 

 : Click this button to orient the volume for a left isometric view. 

Identifying the View for the Mirror Image 
You can create your mirror image view using: 

• the patient's soft tissue or photograph 

• the patient's hard tissue 

• a combined soft tissue/hard tissue view 

• a slice view 

Each of these options is described below. 
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Using the Soft Tissue for the Mirror Image 

To identify a soft tissue view for the mirror image: 

1. Select the Soft Tissue radio button.  

2. Select Translucent to use a translucent soft tissue view. 

Or, 

Select 3D Photo to use the patient's photo for the mirror image. 

3. If you selected Translucent in the previous step, optionally adjust the Seg slider to set the segmentation for the soft 
tissue translucent view. 

Or, 

If you selected 3D Photo in the previous step, optionally select the photograph you want to use from the drop-down list 
box. 

To segment the soft tissue translucent view, you use the slider to identify the range of tissue densities for the patient's 
soft tissue. As you adjust the slider, the soft tissue translucent image changes to reflect the currently-selected image 
segment. 

 
When segmenting soft tissue, you identify the lower and upper density values in the range you want to use. For 
example, the lower boundary may identify the transition between the air and the patient's soft tissue. The upper 
boundary may identify the transition between the patient's soft tissue and hard tissue. 

4. Select the Front/Coronal tab to create a mirror image using a frontal view. 

Or,  

Select the Bottom/Axial tab to create a mirror image using a bottom view. 

Using the Hard Tissue for the Mirror Image 

To identify a hard tissue view for the mirror image: 

1. Select the Hard Tissue radio button.  

2. Adjust the Seg slider to set the segmentation for the hard tissue view. 

To segment the hard tissue view, you use the slider to identify the lower tissue density boundary for the patient's hard 
tissue—that is, the transition between the patient's soft and hard tissue. As you adjust the slider, the hard tissue image 
changes to reflect the currently-selected image segment. 
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3. Adjust the Trans slider to set the transparency of the hard tissue view. 

4. Select the Front/Coronal tab to create a mirror image using a frontal view. 

Or,  

Select the Bottom/Axial tab to create a mirror image using a bottom view. 

Using the Soft and Hard Tissue for the Mirror Image 

To use the combined soft tissue and hard tissue view for the mirror image: 

1. Select the Combined Soft Tissue + Hard Tissue radio button. 

2. Set options for the soft tissue and hard tissue views as described above. 

Using a Slice View for the Mirror Image 

To identify a slice view for the mirror image: 

1. Check the Slice View box. 

The images on the two tabs changed to the coronal and axial slices. 

2. Select the Front/Coronal tab to create a mirror image using a coronal slice. 

Or,  

Select the Bottom/Axial tab to create a mirror image using an axial slice. 

3. Optionally, adjust the slider to set the location of the coronal or axial slice. 

Or, 

Click  to return the coronal and axial slices to the default positions. 

Creating the Mirror Image 

To create the mirror image: 

1. Optionally, check the Mirror Facial Left -> Right box to create the left side of the image by mirroring the right side of the 
volume. 

Or, 

Check the Mirror Facial Right -> Left box to create the right side of the image by mirroring the last side of the volume. 
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2. Optionally, check the Show Superimposition box to view the mirror image superimposed over the volume. 

3. If you checked the Show Superimposition box, optionally adjust the Trans slider to set the transparency of the 
superimposed mirror image. 

4. Optionally, check the Show Caliper box to show a symmetry caliper on the image. 

For more information, see "Using the Symmetry Caliper" on page 660. 

5. On the Front/Coronal or Bottom/Axial tab, click and drag the pink line to set the location of the center line for the mirror 
image. 

Click and drag when your mouse pointer turns into a double-headed arrow. 

Once you have created the mirror image, you can rotate it to view it from any angle or you can use clipping slices to 
view the interior structures. For more information, see "Moving or Reorienting the Image" on page 640 and "Using a 
Clipping Slice" on page 869. 

Superimposing Volumes 
If you have two volumes that you want to compare, you can superimpose them. There are two methods for performing the 
superimposition: 

• Side-by-Side Superimposition: Use this method to view both volumes side by side and align them by identifying 
corresponding points.  

• Overlay Superimposition: Use this method to align the volumes by manipulating a preview of the superimposition.  

Fine-tuning the superimposition may involve using both these methods. For example, you may use the side-by-side 
superimposition method initially, then fine-tune the superimposition with the overlay superimposition method. Then, you can 
verify the superimposition on the Analysis/Verify Result tab. 

To open in the Superimposition dialog box: 

1. Click  on the Dolphin 3D main window. 

Or, 

Select Superimposition from the Tools menu. 

The Volume Chooser dialog box opens (see below). 

2. Select the second volume that you want to use in this superimposition.  

Or, 

Click Browse... and browse to the file containing the second of volume. 

3. Click OK. 

The two volumes appear in the Superimposition dialog box (see the second figure below). 
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list box Select an image from this list box to import a second volume from Dolphin imaging. In this list box, the 
volumes for the current patient are grouped by timepoint. 

Browse... Click this button to import a second volume from a file. 
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The following options are common to all tabs on this dialog box. For information on options specific to a particular tab, see "Using 
Side-by-Side Superimposition" on page 833, "Using Overlay Superimposition" on page 835, and "Analyzing and Verifying the 
Result" on page 840. 

Import/Replace 2nd 
Volume... Click this button import a new volume to replace the second volume. 

Base Volume tab 

Set viewing options for the base volume in this superimposition. 
Soft Tissue: Click this radio button to show the patient’s soft tissue image in the window.  

Seg...: Use this slider to set the segment of the 3D image to use for the soft tissue view. 
Hard Tissue: Click this radio button to show the patient’s hard tissue image in the window. 

Seg...: Use this slider to set the segment of the 3D image to use for the hard tissue view. 
Solid: Click this radio button to view a solid representation of the patient's hard tissue. 
Color Sample: Click the color sample to set the color for the solid hard tissue view.  
Translucent: Click this radio button to view a translucent representation of the patient's hard 

tissue. This option is enabled only if your computer graphics card supports advanced 3D 
rendering. If it does, the following sub-option is available: 

Slider: Use this slider to set the level of transparency in the hard tissue image. 
For more information, see "Viewing the Soft Tissue" on page 635 and "Viewing the Hard Tissue" on 
page 637. 

2nd Volume tab 

Set viewing options for the second volume in this superimposition. 
Soft Tissue: Click this radio button to show the patient’s soft tissue image in the window.  

Seg...: Use this slider to set the segment of the 3D image to use for the soft tissue view. 
Hard Tissue: Click this radio button to show the patient’s hard tissue image in the window. 
Seg...: Use this slider to set the segment of the 3D image to use for the hard tissue view. 
Solid: Click this radio button to view a solid representation of the patient's hard tissue. 
Color Sample: Click the color sample to set the color for the solid hard tissue view.  
Translucent: Click this radio button to view a translucent representation of the patient's hard tissue. 
This option is enabled only if your computer graphics card supports advanced 3D rendering. If it does, 
the following sub-option is available: 

Slider: Use this slider to set the level of transparency in the hard tissue image. 
Always in Front of Base Volume: Check this box if you want the second volume to always be in front 
of the base volume. 
For more information, see "Viewing the Soft Tissue" on page 635 and "Viewing the Hard Tissue" on 
page 637. 

Method: Side-by-Side 
Superimposition tab 

Use this tab to view the two volumes side by side and align them by identifying corresponding points. 
For more information, see "Using Side-by-Side Superimposition" on page 833. 

Method: Overlay 
Superimposition tab 

Use this method to align the two volumes by manipulating a preview of the superimposition. For more 
information, see "Using Overlay Superimposition" on page 835. 

Analysis/Verify 
Results tab 

Use this tab to verify the results of your superimposition. For more information, see "Analyzing and 
Verifying the Result" on page 840. 



Dolphin Imaging User's Guide April 2011 

832 DI_USER_GUIDE-11.5   Rev. 1.01 

Result Shows a preview of the results of your superimposition. This preview does not appear when the 
Analysis/Verify Result tab is selected.  

Rotation Sliders 

Use these sliders to rotate the volume around the indicated axis: 
: Use this slider to rotate the volume horizontally. 
: Use this slider to rotate the volume circularly. 
: Use this slider to rotate the volume vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

Click one of these buttons to orient the volume in one of the predefined views. For more information, 
see "Moving or Reorienting the Image" on page 640. 

Predefined Views 

: Click this button to orient the volume for a right view. 

 : Click this button to orient the volume for a right oblique view. 

 : Click this button to orient the volume for a front view. 

 : Click this button to orient the volume for a left oblique view. 

 : Click this button to orient the volume for a left view. 

 : Click this button to orient the volume for a back view. 

 : Click this button to orient the volume for a top view. 

 : Click this button to orient the volume for a bottom view. 

 : Click this button to orient the volume for a right isometric view. 

 : Click this button to orient the volume for a left isometric view. 

 
Click these arrow buttons to move the volume in the window in the indicated direction. For more 
information, see "Moving or Reorienting the Image" on page 640. 

  
Click this button to zoom in on the volume. For more information, see "Changing the Magnification" on 
page 640. 
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Click this button to zoom out on the volume. For more information, see "Changing the Magnification" on 
page 640. 

  
Click this button to fit the volume in the window. For more information, see "Changing the Magnification" 
on page 640. 

Using Side-by-Side Superimposition 
With the side-by-side superimposition method, you align two volumes by identifying corresponding points on them. Then, you 
can preview the superimposition before saving it. 

To use side-by-side superimposition: 

1. Select the Method: Side-by-Side Superimposition tab on the Superimpositions dialog box. 

The two volumes appear in the dialog box. Points appear on the volumes so that you can align them.  
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The following options are specific to the Method: Side-by Side Superimposition tab. For information on options common to all 
tabs on this dialog box, see "Superimposing Volumes," above. 

Alignment Points Select the number of alignment points you want to use to superimpose the volumes.  For more 
information, see "Adding and Resetting Points" on page 835. 

Reset  Click this button to return the alignment points to their initial number and positions.  For more information, 
see "Adding and Resetting Points" on page 835. 

Superimpose Now! Click this button to superimpose the two volumes and display the result in the Result window.   

Superimposing the Two Volumes 

To superimpose the two volumes: 

1. Click and drag the points on the volumes so that they identify corresponding locations. 
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To superimpose the volumes: 

1. Click Superimpose Now! 

The result of your superimposition appears in the results box in the lower left corner of the window.  

Adding and Resetting Points 

To use additional points to align the volumes: 

1. Select a number of points you want to use from the Alignment Points drop-down list box. 

Additional alignment points appear on both volumes. 

To reset the alignment points to their initial number and locations: 

1. Click Reset. 

The initial number of alignment points appears in the original positions on both volumes. 

Using Overlay Superimposition 
With the overlay superimposition method, you align the two volumes by manipulating a preview of the superimposition. 

To use overlay superimposition: 

1. Select the Method: Overlay Superimposition tab. 

The volumes are superimposed in the dialog box. You adjust the superimposition to align the volumes. 
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The following options are specific to the Method: Overlay Superimposition tab. For information on options common to all tabs on 
this dialog box, see "Superimposing Volumes," above. 

Use Clipping Slice 

Check this box to define and view a cross-section of the superimposition. For more information, see 
"Using a Clipping Slice" on page 869. 
slider: Move the slider to set the location of the slice used for this cross section. 

: Click this icon to set the clipping slice at the mid-sagittal plane. 

: Click this icon to set the clipping slice at the axial plane. 

: Click this icon to set the clipping slice at the coronal plane. 

: Click this icon to use a pie-shaped clipping slice that includes the patient's arch. 

: Click this icon to orient the clipping slice in the direction of the viewer. 

Show Symmetry 
Caliper 

Check this box to display a symmetry caliper on the superimposition. For more information, see "Using the 
Symmetry Caliper" on page 660. 

Slice Overlay 
Transparency 

Move this slider to set the transparency of the superimposition in the slice views. For more information, 
see "Standard Slice Views" on page 657. 
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Undo Last Move Click this button to undo the last operation.  

Rotate Volume 
About Red Dot 

Check this box to rotate the superimposed volumes about a user-defined point. For more information, see 
"Rotating the Volume" on page 839. 

Stitch Mode Check this box to perform the superimposition using stitching. For more information, see "Using Stitching" 
on page 839. 

Rotate/Offset 
Applies to 

Select an option to apply your changes to that part of the superimposition.  
2nd Volume Only: Select this option to apply your changes only to the second volume. 
Both Volumes: Select this option to apply your changes to both volumes. 

Use these buttons to select the layout of the window. For more information, see "Layouts and Slices" on 
page 652. 

: 
Click this button to use the volume layout. In this layout, only the superimposed volumes appear 
in the window. 

: 
Click this button to use the 4 volume layout. In this layout, four views of the same superimposition 
appear in the window. 

: 

Click this button to use the 3+1 layout. In this layout, the window has four panes: three small 
panes on the left containing the sagittal, coronal, and axial slices, and one large pane on the right 
containing the superimposed volumes. 

Layout buttons 

: 
Click this button to use the 2x2 layout. In this layout, the window has four equal panes containing 
the sagittal slice, the coronal slice, the axial slice, and the superimposed volumes. 

Use these buttons to view a standard slice rather than the 3D image in the window. For more information, 
see "Standard Slice Views" on page 657. 

: 
Click this button to view the sagittal slice. 

: 
Click this button to view the coronal slice. 

Slice buttons 

: 
Click this button to view the axial slice. 
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Show/Hide Slice 
buttons 

Use these buttons to show or hide planes indicating the standard slice locations on the superimposed 
volumes. For more information, see "Volume Layout" on page 653. 

 : Click this button to show or hide a plane indicating the location of the sagittal slice. 

 : Click this button to show or hide a plane indicating the location of the coronal slice. 

 : Click this button to show or hide a plane indicating the location of the axial slice. 

 
Click this button to return the sagittal, coronal, and axial slices to their standard locations after you have 
customized them. For more information, see "Changing the Angle of the Slice Views" on page 658 and 
"Changing the Slice Locations" on page 659. 

To adjust the superimposition: 

1. Select 2nd Volume Only to change the position of the second volume. 

Or, 

Select Both Volumes to change the position of both volumes. 

2. Click one of the arrow buttons to move the selection (either the second volume or both volumes) in the indicated 
direction. 

Or, 

Hold down the SHIFT key while clicking and dragging the selection within the window. 

Or, 

Click and drag one of the sliders to rotate the selection around the indicated axis. 

Or, 

Click and drag the selection to rotate it. 

To reorient the superimposition: 

1. Select 2nd Volume Only to reorient the second volume. 

Or, 

Select Both Volumes to reorient both volumes. 

2. Click the button for one of the predefined views to change to that orientation. 
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To adjust the superimposition using slice views: 

1. Click  or   to view the superimposition using slice views.  

2. Adjust the superimposition as described above using internal anatomy.  

For example, you can perform the superimposition by registering on internal anatomies such as maxilla (ANS-PNS) 
cross-section or sella-nasion cross-section.  Superimposition on the slice views can also be used to validate the 
accuracy of the internal structure alignments after superimposition is done on the outer surface of the skull.    

Rotating the Volume 
In addition to the usual features for rotating a volume, you can rotate the superimposition about a user-defined point. This is 
useful when you want to align at an anatomy point, such as the upper incisor tip, and rotate one of the volumes relative to that 
point in space. 

To rotate the volume about a user-defined point: 

1. Check the Rotate Volume About Red Dot box.  

2. Move the red dot that appears to any location on the volume.   

3. Rotate the volume as described in "Moving or Reorienting the Image" on page 640. 

The volume rotation is centered about the red dot. 

Using Stitching 
The stitching feature enables you to "stitch" two volumes together. Typically, you would use two scans of different isolated areas 
of the patient (for example, left condyle scan and right condyle scan). This feature is very useful for CBCT systems that can 
capture only very small field-of-view.  

To perform 3D superimposition using stitching: 

1. Open in the Superimposition dialog box, selecting the two volumes you want to "stitch" together.      

2. Check the Stitch Mode box.  

A cutting plane appears, and each volume is “cut” by the plane on its respective side. 

3. Adjust the cutting plane by clicking and dragging the yellow dot.  

You can export the resulting stitched volume to external DICOM files as one data set. For more information, see "To 
export the 3D volume to one or more DICOM files" on page 622. 
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Analyzing and Verifying the Result 
Before saving your superimposition, you can verify it by viewing it from different angles,  using different clipping slices, or using a 
symmetry caliper to see that the volumes are aligned correctly.  

To verify your superimposition: 

1. Click the Analysis/Verify Result tab. 

The dialog box displays the current superimposition.  

2. Click the button for one of the predefined views to orient the superimposed volumes for that view. 

Or, 

Click and drag one of the sliders to rotate the superimposed volumes around the indicated axis. 

Or, 

Click and drag the superimposed volumes to rotate them. 

To save your superimposition and close this dialog box: 

1. Click OK. 
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The following options are specific to the Analysis/Verify Result tab. For information on options common to all tabs on this dialog 
box, see "Superimposing Volumes," above. 

Use Clipping Slice 

Check this box to define and view a cross-section of the superimposition.  
slider: Move the slider to set the location of the slice used for this cross section. 

: Click this icon to set the clipping slice at the mid-sagittal plane. 

: Click this icon to set the clipping slice at the axial plane. 

: Click this icon to set the clipping slice at the coronal plane. 

: Click this icon to use a pie-shaped clipping slice that includes the patient's arch. 

: Click this icon to orient the clipping slice in the direction of the viewer. 
For more information, see "Using a Clipping Slice" on page 869.  

Show Symmetry Caliper Check this box to display a symmetry caliper on the superimposition. For more information, see 
"Using the Symmetry Caliper" on page 660. 

Slice Overlay 
Transparency 

Adjust this slider to set the transparency of the overlay slice (slice of the second volume) when 
viewing the superimposition in the 3+1 layout, the 2x2 layout., or one of the standard slice views 
(see below). 

 
Opens a window where you can take measurements on the superimposed volume. For more 
information, see "Viewing and Taking Measurements" on page 778. 

Export to DICOM Click this button to export the two superimposed volumes to a single DICOM data set. For more 
information see "To export the 3D volume to one or more DICOM files” on page 622. 

Export Orientation to 2nd 
Volume... 

Click this button to set the second volume's orientation to match the base volume's orientation. For 
more information see "To match up the orientation of the two volumes" on page 843. 

Send Snapshot... 

Opens a pop-up menu with the following options: 
Close This Menu: Choose this option to close the pop-up menu. 
Save To Dolphin Layout/Database: Choose this option to save the 3D image to a slot in a 
Dolphin image layout and store it in your database. For more information, see "Saving an Image" 
on page 661. 
Send To Report: Choose this option to use this image in a Dolphin 3D report. For more 
information, see Chapter 32. 
Copy To Clipboard: Choose this option to copy the 3D image to the clipboard. Then, you can 
paste the image into another application. For more information, see "Copying the Image to the 
Clipboard” on page 663. 
Print: Choose this option to print the image. For more information, see "Printing an Image" on page 
664. 
Export To File: Choose this option to export the 3D image to a file. For more information, see 
"Exporting an Image" on page 663. 



Dolphin Imaging User's Guide April 2011 

842 DI_USER_GUIDE-11.5   Rev. 1.01 

 

Use these buttons to select the layout of the window. For more information, see "Layouts and Slices" on page 652. 

: 
Click this button to use the volume layout. In this layout, only the superimposed volumes appear in 
the window. 

: 
Click this button to use the 4 volume layout. In this layout, four views of the same superimposed 
volumes appear in the window. 

: 

Click this button to use the 3+1 layout. In this layout, the window has four panes: three small panes 
on the left containing the sagittal, coronal, and axial slices of the superimposed volumes, and one 
large pane on the right containing the superimposed volumes. 

Layout 
buttons 

: 

Click this button to use the 2x2 layout. In this layout, the window has four equal panes containing the 
sagittal slice, the coronal slice, the axial slice of the superimposed volumes, and the superimposed 
volumes. 

Use these buttons to view a standard slice rather than the superimposed volumes in the window. For more 
information, see "Standard Slice Views" on page 657. 

: 
Click this button to view the sagittal slice. 

: 
Click this button to view the coronal slice. 

Slice 
buttons 

: 
Click this button to view the axial slice. 

Use these buttons to show or hide planes indicating the standard slice locations on the superimposed volumes. For 
more information, see "Volume Layout" on page 653. 

: Click this button to show or hide a plane indicating the location of the sagittal slice. 

: Click this button to show or hide a plane indicating the location of the coronal slice. 

Show/Hide 
Slice 
buttons 

: Click this button to show or hide a plane indicating the location of the axial slice. 

 
Click this button to return the sagittal, coronal, and axial slices to their standard locations after you have customized 
them. For more information, see "Changing the Angle of the Slice Views" on page 658 and "Changing the Slice 
Locations" on page 659. 
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To match up the orientation of the two volumes: 

1. On the Analysis/Verify Result tab, click Export Orientation to 2nd Volume.... 

2. On the confirmation dialog box that appears, click Yes to change the second volume's orientation to match the base 
volume's orientation. 

When you click Yes, the second volume's new orientation is saved to your Dolphin database. 
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30 Simulating Implants 
You can use the 3D Implant Simulation module to assist you in implant case evaluation, creating individualized treatment 
simulations, and patient presentation. This module performs implant placement and related procedures on a patient's 3D volume. 
Within minutes, your patients and referring doctors can fully understand your treatment process.  
3D Implant Simulation enables you to: 

• place, move, and rotate implants on the volume, slice, or panoramic views, or using a surface representing a study 
model 

• select implant types from a generic implant template library and specify each implant’s size   

• zoom in and out on an implant 

• define a “safety zone” about each implant to avoid proximity collisions 

• segment and sculpt the volume, use clipping slices and automatic clipping around the implant, and set the image 
transparency for better implant placement 

• measure distances and angles 

• convert the segmented volume, as a solid, to an isosurface and export it to an industry standard file format in addition 
to the geometric placement information of the implants on the surface 

• define and show the nerve canals on the volume views so that you can avoid placing implants close to the nerves 

• adjust and show coloring of the sectional views according to Hounsfield Units   

To access the 3D Implant Simulation module: 

1. Click  on the Dolphin 3D main window.  

Or, 

Select Implants... from the Tools menu. 

The 3D Implant Simulation window opens.  
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Volume 

Select this option to use the volume to plan implant placement. 
Seg: Use this slider to select the density segment of the 3D image to use for the hard tissue view 
in this window. 
Trans: Use this slider to set the level of transparency in the hard tissue image. 

Study Model Overlay 
(Surface) 

Select this option to use a surface representation of a study model to plan implant placement. 
Select...: Click this button to load a study model surface from a file. 
Color sample: Click the color sample to set the color to use for the surface. 

Combine Volume + Study 
Model 

Select this option to use both the volume and a surface representation of a study model to plan 
implant placement. 
Trans: Use this slider to set the level of transparency in the combined image. 
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Use Clipping Slice 

Check this box to define and view a cross-section of the image. For more information, see "Using a 
Clipping Slice" on page 869. 
slider: Move the slider to set the location of the slice used for this cross section. 

: Click this icon to set the clipping slice at the mid-sagittal plane. 

: Click this icon to set the clipping slice at the axial plane. 

: Click this icon to set the clipping slice at the coronal plane. 

: Click this icon to use a pie-shaped clipping slice that includes the patient's arch. 

: Click this icon to orient the clipping slice in the direction of the viewer. 

Use Volume 
Sculpting 

Check this box to view the image using volume sculpting. For more information, see "Sculpting the 
Volume" on page 877. 
Edit...: Click this button to perform volume sculpting. 

Automatic Clipping 
Around Implant 

Check this box to use clipping around the implant to see cut-away views of the implant within the volume. 
For more information, see "To use clipping around the implant " on page 854. 

Do Not Clip Nerves Check this box if you do not want to clip nerves when using clipping around the implant. For more 
information, see "To disable clipping of the nerves" on page 855. 

Implants 

Use the options in this group box to add and remove implants. 
Add Implant: Click this button to add a new implant from the library. For more information, see "Adding an 
Implant" on page 850. 
Safety Zone: Choose the size (in millimeters) from this drop-down list box to define a safety zone about 
each implant to avoid proximity collisions. Choose None if you don't want a safety zone. For more 
information, see "To add a safety zone" on page 852. 
Implant List: Lists the diameter, length, manufacturer, and type of each implant added for this patient. 
Delete Implant: Click this button to delete the selected implant. For more information, see "Deleting an 
Implant" on page 858. 
Show Single Implant Only: Check this box show only the implant selected in the implant list. 
Undo Last Implant Move: Click this button to undo an implant move. This button undoes operations in 
the reverse of the order in which they were performed. For more information, see page 851. 
Zoom Out: Click this button to zoom out after zooming in on an implant. For more information, see page 
852. 
Zoom In on Implant: Click this button to zoom in on the selected implant. For more information, see page 
852. 
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Other Options... 

Click this button to open a pop-up menu with the following options: 
Preferences: Choose this option to set colors for implants, safety zones, and nerves or to edit the 
diameter, length, manufacturer, and type for implants in the library.  For more information, see "Setting 
Preferences" on page 866. 
Set Implant Group Alignments: Not yet available. 
Define Local Orientation...: Opens the Orientation Calibration window so you can set the volume 
orientation for this implant simulation. For more information, see "Orienting the Image" on page 675. 
Export Surface: Choose this option to export the study model surface to a file. For more information, see 
"Exporting a Study Model Surface" on page 866. 
Create Surface from Volume and Export to File: Choose this option to create an isosurface from the 
volume and export it to a file for use with applications that can import and process an isosurface. For 
more information, see "Creating and Exporting an Isosurface" on page 666. 

 
Click this button to create x-rays from the 3D image data. For more information, see Chapter 25. 

 
Click this button to open the Digitize/Measurement palette so that you can take measurements on the 3D 
image. For more information, see "Viewing and Taking Measurements" on page 778. 

Send Snapshot... 

Opens a pop-up menu with the following options: 
Close This Menu: Choose this option to close the pop-up menu. 
Save To Dolphin Layout/Database: Choose this option to save the 3D image to a slot in a Dolphin 
image layout and store it in your database. For more information, see "Saving an Image" on page 661. 
Send To Report: Choose this option to use this image in a Dolphin 3D report. For more information, see 
Chapter 32. 
Copy To Clipboard: Choose this option to copy the 3D image to the clipboard. Then, you can paste the 
image into another application. For more information, see "Copying the Image to the Clipboard" on page 
663. 
Print: Choose this option to print the image. For more information, see "Printing an Image" on page 664. 
Export To File: Choose this option to export the 3D image to a file. For more information, see "Exporting 
an Image" on page 663. 

 

This layout renders the image with color based on Hounsfield Units. Color rendering using Hounsfield 
Units gives you better control in highlighting anatomies with known Hounsfield Unit ranges.  
This button opens a pop-up menu from which you can select an existing Hounsfield Unit color scheme or 
edit the color mapping to create a new color scheme. 
Note: This layout is only available for scans imported using Dolphin Imaging version 11 or later. 
For more information, see "Using the Hounsfield Unit View" on page 649. 
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Use these buttons to select the layout of the window. For more information, see "Layouts and Slices" on page 652. 

: 
Click this button to use the volume layout. In this layout, only the 3D volume or photograph appears 
in the window. 

: 
Click this button to use the 4 volume layout. In this layout, four views of the same volume appear in 
the window. 

: 

Click this button to use the 3+1 layout. In this layout, the window has four panes: three small panes 
on the left containing the sagittal, coronal, and axial slices, and one large pane on the right 
containing the 3D volume or photograph. 

Layout 
buttons 

: 
Click this button to use the 2x2 layout. In this layout, the window has four equal panes containing the 
sagittal slice, the coronal slice, the axial slice, and the 3D volume or photograph. 

Use these buttons to view a standard slice rather than the 3D image in the window. For more information, see 
"Standard Slice Views" on page 657. 

: 
Click this button to view the sagittal slice. 

: 
Click this button to view the coronal slice. 

Slice 
buttons 

: 
Click this button to view the axial slice. 

 
Click this button to toggle the display of the slice location lines (cross-hairs) on the sagittal, coronal, and axial slices. 
This button is only available when you are using one of the standard slice views, the 3+1 layout, or the 2x2 layout. 

 
Click this button to select an x-ray to view in this window. You must have built at least one x-ray view to open the 
pop-up menu of available x-ray views.  For more information, see "Adding an Implant" on page 850 and Chapter 25. 

Use these buttons to show or hide planes indicating the standard slice locations on the 3D volume or photograph. 
For more information, see "Volume Layout" on page 653. 

: Click this button to show or hide a plane indicating the location of the sagittal slice. 

: Click this button to show or hide a plane indicating the location of the coronal slice. 

Show/Hide 
Slice 
buttons 

: Click this button to show or hide a plane indicating the location of the axial slice. 
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Click this button to return the sagittal, coronal, and axial slices to their standard locations after you have customized 
them. For more information, see "Changing the Angle of the Slice Views" on page 658 and "Changing the Slice 
Locations" on page 659. 

Rotation 
Sliders 

Use these sliders to rotate the image around the indicated axis: 
: Use this slider to rotate the 3D image horizontally. 
: Use this slider to rotate the 3D image circularly. 
: Use this slider to rotate the 3D image vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

Click one of these buttons to orient the 3D image in one of the predefined views. For more information, see "Moving 
or Reorienting the Image" on page 640. Predefined 

Views 

: Click this button to orient the 3D image for a right view. 

 : Click this button to orient the 3D image for a right oblique view. 

 : Click this button to orient the 3D image for a front view. 

 : Click this button to orient the 3D image for a left oblique view. 

 : Click this button to orient the 3D image for a left view. 

 : Click this button to orient the 3D image for a back view. 

 : Click this button to orient the 3D image for a top view. 

 : Click this button to orient the 3D image for a bottom view. 

 : Click this button to orient the 3D image for an isometric view. 

 : Click this button to orient the 3D image for an isometric view. 

 
Click these arrow buttons to move the 3D image in the window in the indicated direction. For more information, see 
"Moving or Reorienting the Image" on page 640. 
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  Click this button to zoom in on the 3D image. For more information, see "Changing the Magnification" on page 640. 

  Click this button to zoom out on the 3D image. For more information, see "Changing the Magnification" on page 640. 

  
Click this button to fit the 3D image in the window. For more information, see "Changing the Magnification" on page 
640. 

 

Adding an Implant 

To add an implant: 

1. On the 3D Implant Simulation window, select the view that you want to use initially when positioning the implant. 

For example, if you have built a nerve canals x-ray view for this patient, you can select it by clicking  and 
then selecting Panoramic (Nerve Canals) from the pop-up menu. Then, you can use this x-ray view to position the 
implant initially. 

2. Click Add Implant. 

3. Select the implant you want to add from the pop-up menu. 

The selected implant appears on the patient's image and information about it appears in the Implants table. At this 
point, you can position the implant on the volume. 

 

Positioning the Implant 
The 3D Implants module offers several features to help you position the implant correctly within the volume. To verify correct 
implant placement in three dimensions, you can: 

• move and rotate the implant 

• add a safety zone around implants 

• use different volume views, including zooming in on the implant 

• use automatic clipping around the implant 

• enable and disable clipping of nerves 

Each of these features is described below. 
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To move the implant: 

1. Place the cursor over the implant outline. 

Four triangles appear at the cursor position, as shown below: 

 

2. Click and drag the implant to move it. 

To rotate the implant: 

1. Place the cursor over the implant's red rotation handle. 

A rotation icon appears at the cursor position, as shown below: 

 

2. Click and drag the rotation handle to rotate the implant. 

To rotate the implant to be parallel or perpendicular to the viewing plane: 

1. Right-click the implant. 

2. Select Make Implant Parallel to Viewing Plane from the pop-up menu 

Or. 

Select Make Implant Perpendicular to Viewing Plane from the pop-up menu. 

Note: The pop-up menu is not available if the implant is currently perpendicular to the viewing plane. 

To undo the last move: 

1. Click Undo Last Implant Move. 
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You can add a visual safety zone around implants to help you avoid placing them too close to each other. 

To add a safety zone: 

1. Select the size (in millimeters) from the Safety Zone drop-down list box 

Or, 

Select None if you don't want a safety zone. 

The following example illustrates an implant without and with a safety zone on the x-ray and volume views. 

 
As illustrated in these examples, you can use different views of the volume to verify and correct placement of implants.  
The following example illustrates using the nerve canals x-ray view to place the implant initially. Assuming you have built a nerve 

canals x-ray view for this patient, you can select it by clicking  and then selecting Panoramic (Nerve Canals) from the 
pop-up menu.  
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Once you have placed the implant initially, you might select the 4 Volume layout to view the implant in three dimensions. 

 

To get a better view of the implant 

1. Click Zoom In on Implant.  
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At this point, you can move or rotate the implant as necessary to fine-tune its placement. You also may want to use 
clipping around the implant to see cut-away views to further verify and correct its placement. 

To return to the previous magnification: 

1. Click Zoom Out. 

To use clipping around the implant: 

1. Check the Automatic Clipping Around Implant box. 

The volume is clipped around the implant so that you can see cut-away views of the implant within the volume. For 
more information on volume clipping, see "Using Clipping Slices and Boxes" on page 869. 

The following figure illustrates clipping around the implant in the 4 Volume layout. Note that in three of the four views, 
the volume is clipped lengthwise along the implant. In the lower left view, however, the volume is clipped across the 
implant at one end of it. 
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If you rotate the view, the volume is automatically clipped to show a cut-away of the implant in the new orientation. The following 
example illustrates clipped around the implant before and after rotating the volume in the upper left of the 4 Volume layout. 

 
At this point, you can move or rotate the implant as necessary to fine-tune its placement.  
If you have built a nerve canals x-ray view for this patient and the implant is near the nerves, you may want to enable and disable 
clipping of the nerves while positioning the implant. By default, nerve clipping is enabled when you enable clipping around the 
implant. 

To disable clipping of the nerves: 

1. Check the Do Not Clip Nerves box. 

The following example illustrates nerve clipping enabled and disabled. 
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Modifying an Implant 
You can modify the type, length, or diameter of a single implant or of all implants you have added to the patient's volume. 

To modify an implant: 

1. In the Implants list, double-click one of the cells for the implant you want to change. 

The Select Implant window opens. 

2. Select the type, diameter, and length for the implant. 

3. Optionally, check the Apply to ALL Implants box to set all implants you have added to the volume to the selected type, 
diameter, and length. 

4. Click OK. 
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Alternatively, a pop-up menu provides shortcuts for changing an implant's length and diameter. 

To change an implant's length: 

1. Right-click the implant, and select Change Implant Length from the pop-up menu. 

2. Select the new length from the cascade menu. 

To change an implant's diameter: 

1. Right-click the implant, and select Change Implant Diameter from the pop-up menu. 

2. Select the new diameter from the cascade menu. 
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Deleting an Implant 

To delete an implant: 

1. In the Implants table, click the implant you want to delete. 

2. Click Delete Implant.  

3. Click Yes on the confirmation dialog box that appears to delete the implant. 

Or, 

Click No to cancel the deletion. 

Alternatively, a pop-up menu provides an option for deleting an implant. 

To use the pop-up menu to delete an implant: 

1. Right-click the implant, and select Delete Implant from the pop-up menu. 

2. Click Yes on the confirmation dialog box that appears to delete the implant. 

Or, 

Click No to cancel the deletion. 

Using a Study Model Surface 
You can use a surface representing a study model to assist you in planning implant placement. To use a study model surface, 
you first load it from a file into Dolphin 3D and superimpose it over the volume. Then, you can view the study model surface 
alone or in combination with the volume. 

Loading a Study Model Surface 
Before you can use a study model surface to plan implant placement, you need to load it into Dolphin 3D from a file. 

To load a study model surface from a file: 

1. Click Select... 

A dialog box opens so that you can select the file containing the study model surface. Files containing surfaces 
typically have .STL or .OBJ file name extensions. 

2. Browse to the file, and, click Open. 

The Surface and Volume Alignment/Superimposition dialog box opens. 
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Import/Replace 
Surface...  Import a new study model surface for this patient or replace the existing surface.  

Volume 

Set options for the volume: 
Seg: Use this slider to set the segmentation to use for the volume.  
Solid: Select this option to view a solid representation of the volume. 
Color sample: Click the color sample to set the color to use for the solid representation of the volume. 
Translucent: Select this option to view a translucent representation of the volume. 
Slider: Use this slider to set the transparency of the volume. 
For more information on these options, see "Viewing the Soft Tissue" on page 635. 

Surface 
Set options for the surface: 
Color sample: Click the color sample to set the color to use for the surface. 
Trans: Use this slider to set the transparency of the surface.  
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Method: Side-by-Side 
Superimposition tab 

Use this tab to view the surface and the volume side by side and align them by identifying 
corresponding points.  For more information, see "Using Side-by-Side Superimposition" on page 862. 

Method: Overlay 
Superimposition tab 

Use this method to align the surface and the volume by manipulating a preview of the superimposition. 
 For more information, see "Using Overlay Superimposition" on page 863. 

Verify Results Use this tab to verify the results of your superimposition. For more information, see "Verifying the 
Result" on page 864. 

Use Clipping Slice 

Check this box to define and view a cross-section of the image. For more information, see "Using a 
Clipping Slice" on page 869. 
slider: Move the slider to set the location of the slice used for this cross section. 

: Click this icon to set the clipping slice at the mid-sagittal plane. 

: Click this icon to set the clipping slice at the axial plane. 

: Click this icon to set the clipping slice at the coronal plane. 

: Click this icon to use a pie-shaped clipping slice that includes the patient's arch. 

: Click this icon to orient the clipping slice in the direction of the viewer. 

Alignment Points 
Select the number of alignment points you want to use to superimpose the volume and surface. This 
drop-down list box is only available when using the side-by-side superimposition method to 
superimpose a 3D photo over the volume. For more information, see "Using Side-by-Side 
Superimposition" on page 862. 

Reset 
Click this button to return the alignment points to their initial number and positions. This button is only 
available when using the side-by-side superimposition method to superimpose a 3D photo over the 
volume. For more information, see "Using Side-by-Side Superimposition" on page 862. 

Superimpose Now! 
Click this button to superimpose the surface over the volume and display the result in the Result 
window. This button is only available when using the side-by-side superimposition method. For more 
information, see "Using Side-by-Side Superimposition" on page 862. 

Undo Last Move 
Click this button to undo the last operation. This button is only available when using the overlay 
superimposition method. For more information, see "Using Overlay Superimposition" on page 863. 

Rotate Volume About 
Red Dot 

Check this box to rotate the superimposed volumes about a user-defined point. This button is only 
available when using the overlay superimposition method. For more information, see "Rotating the 
Volume" and  "Using Overlay Superimposition" on page 863. 

Result 
Shows a preview of the results of your superimposition. This preview does not appear when the 
Verifying Results tab is selected.  
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Predefined Views 

Click one of these buttons to orient the image in one of the predefined views. For more information, 
see "Moving or Reorienting the Image" on page 640. 

: Click this button to orient the image for a right view. 

: Click this button to orient the image for a right oblique view. 

: Click this button to orient the image for a front view. 

: Click this button to orient the image for a left oblique view. 

: Click this button to orient the image for a left view. 

: Click this button to orient the image for a back view. 

: Click this button to orient the image for a top view. 

: Click this button to orient the image for a bottom view. 

: Click this button to orient the image for a right isometric view. 

: Click this button to orient the image for a left isometric view. 

 
Click this button to fit the image in the window. For more information, see "Changing the Magnification" 
on page 640. 

 
Click these arrow buttons to move the image in the window in the indicated direction. For more 
information, see "Moving or Reorienting the Image" on page 640. 

  
Click this button to zoom in on the image. For more information, see "Changing the Magnification" on 
page 640. 

  
Click this button to zoom out on the image. For more information, see "Changing the Magnification" on 
page 640. 

Rotation Sliders 

Use these sliders to rotate the image around the indicated axis: 
: Use this slider to rotate the image horizontally. 
: Use this slider to rotate the image circularly. 
: Use this slider to rotate the image vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

Rotate/Offset applies 
to 

Select an option to apply your changes to that part of the superimposition. These options are only 
available when using the overlay superimposition method. 
Surface Only: Select this option to apply your changes only to the surface. 
Surface and Volume: Select this option to apply your changes to both the surface and the volume. 
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Superimposing the Surface and the Volume 
Once you have imported a study model surface, you can superimpose it over the 3D volume. There are two methods for 
superimposing the surface over the volume: 

• Side-by-Side Superimposition: Use this method to view the surface and the volume side by side and align them by 
identifying corresponding points.  

• Overlay Superimposition: Use this method to align the surface and the volume by manipulating a preview of the 
superimposition.  

Fine-tuning the superimposition may involve using both these methods. For example, you may use the side-by-side 
superimposition method initially, then fine-tune the superimposition with the overlay superimposition method.  Finally, you can 
verify the superimposition on the Verify Result tab. 

Using Side-by-Side Superimposition 
With this method, you align the surface and the volume by identifying corresponding points on them. After you superimpose a 
surface over the volume, you can preview the superimposition before saving it. 

To superimpose the surface over the volume: 

1. Select the Method: Side-by-Side Superimpositions tab. 

The volume and surface for this patient appear in the dialog box. Points appear on the images so that you can align 
them.   

2. Zoom in on the volume and surface, if necessary. 

3. Orient both the surface and volume so that they match. 

You may want to use a clipping slice, as illustrated below, to assist you in aligning the volume and surface. For more 
information, see "Using a Clipping Slice" on page 869. 

4. Click and drag the points on the both the surface and volume so that they identify corresponding locations. 

5. Click Superimpose Now! 

The result of your superimposition appears in the results box in the lower left corner of the window.  

6. Rotate the image in the results box in the lower left corner of the window to verify the superimposition. 

The following figure illustrates superimposing a study model over a volume. 
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To use additional points to align a surface over the volume: 

1. Select a number of points you want to use from the Alignment Points drop-down list box. 

Additional alignment points appear on both volume and the surface. 

To reset the alignment points to their initial number and locations: 

1. Click Reset. 

The initial number of alignment points appears in the original positions on both the volume and the surface. 

Using Overlay Superimposition 
With this method, you align a surface and the volume by manipulating a preview the superimposition. 

To align the image: 

1. Select the Method: Overlay Superimpositions tab. 

The volume and surface for this patient are superimposed in the dialog box. 
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To reorient the superimposition: 

1. Select Surface Only to reorient the surface. 

Or, 

Select Surface and Volume to reorient both the surface and the volume. 

2. Click the button for one of the predefined views to change to that orientation. 

To adjust the superimposition: 

1. Select Surface Only to change the position of the surface. 

Or, 

Select Surface and Volume to change the position of both the surface and the volume. 

2. Click one of the arrow buttons to move the selection (either the surface or both the surface and the volume) in the 
indicated direction. 

Or, 

Hold down the SHIFT key while clicking and dragging the selection within the window. 

Or, 

Click and drag one of the sliders to rotate the selection around the indicated axis. 

Or, 

Click and drag the selection to rotate it. 
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Verifying the Result 
Before saving your superimposition, you can verify it by viewing it from different angles to see it the surface and volume are 
aligned correctly.  

To verify your superimposition: 

1. Click the Verify Result tab. 

The dialog box displays the current superimposition.  

2. Click the button for one of the predefined views to orient the superimposed image for that view. 

Or, 

Click and drag one of the sliders to rotate the superimposed image around the indicated axis. 

Or, 

Click and drag the superimposed image to rotate it. 

To save your superimposition and close this dialog box: 

1. Click OK. 

Viewing the Surface 
Once you have loaded a study model surface from a file into Dolphin 3D and superimposed it over the volume, you can view it 
either alone or in combination with the volume. 

To view just the study model surface: 

1. Select Study Model Overlay (Surface). 

The study model surface appears by itself in the window. 

To view both the study model surface and the volume: 

1. Select Combine Volume + Study Model. 

The study model surface appears superimposed with the volume in the window. 

2. Optionally, move the Trans slider to set the transparency of the study model surface. 

To set the color of the study model surface: 

1. Click the color sample. 

2. Select the color you want to use. Then, click OK. 
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Exporting a Study Model Surface 
After loading a study model surface and superimposing it with the volume, you can export it to a file. For more information, see 
"Loading a Study Model Surface" on page 858 and “Superimposing the Surface and the Volume" on page 862. 

To export the isosurface to a file: 

1. On the 3D Implant Simulation window, click Other Options…. Then, select Export Surface… from the pop-up menu. 

2. Select the file format you want to use from the cascade menu. 

3. Specify the directory and file in which you want to save the isosurface. 

4. Click Save. 

Setting Preferences 
On the 3D Implant Preferences dialog box, you can set the following: 

• the colors used on the 3D Implants window to represent implants, safety zones, and nerves 

• the specifications of the default implant types in your implant library 

To set preferences for 3D implants:  

1. On the 3D Implant Simulation window, click Other Options…. Then, select Preferences… from the pop-up menu. 

The 3D Implant Preferences dialog box opens. 

2. Optionally, change any settings on this dialog box. 

3. Click OK. 
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Implants Click the color sample to set the color to use for implants. 

Safety Zone Click the color sample to set the color to use for safety zones around implants. 

Nerves Click the color sample to set the color to use for nerves. 

Default Implant 
Types 

Lists the diameter, length, manufacturer, and type of each default implant type in your implant library and 
enables you to change these settings. 

To change the color settings for implants, safety zones, or nerves: 

1. Click the color sample for the element for which you want to set the color. 

The Color dialog box opens. 

2. Select the color you want to use. Then, click OK. 
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To modify a default implant type: 

1. In the Default Implant Types table, double-click one of the cells for the implant type you want to change. 

The Select Implant window opens. 

2. Select the type, diameter, and length for the implant type. 

3. Optionally, check the Apply to ALL Implants box to apply the new settings to all implant types. 

4. Click OK. 
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31 Clipping and Sculpting 
Dolphin 3D offers clipping slices so that you can create your own custom cross-section views of the 3D volume. A clipping box is 
like a 3-dimensional clipping slice. With a clipping box, you define a cube within the volume, and only the image data within the 
clipping box is displayed. You can use these features simultaneously to view a cross-section of the volume contained within the 
clipping box. 
With the volume sculpting feature, you can sculpt out any arbitrarily-shaped section of the scan, such as isolating the 
mandible. Once you have sculpted out a portion of interest, you can export it as a DICOM file that can be read by other 3D 
programs. 

Using Clipping Slices and Boxes 
Clipping slices and boxes enable you to view slices or cut-away views of the 3D volume. You can view slices along the three 
standard planes (the sagittal, coronal, and axial slices), or you can define your own views. The clipping slice cuts the 3D volume 
and displays a cross section. A clipping box is like a 3-dimensional clipping slice. With a clipping box, you define a cube within 
the volume, and only the image data within the clipping box is displayed. You can use these features simultaneously to view a 
cross-section of the volume contained within the clipping box. 

Using a Clipping Slice 
Using a clipping slice enables you to see a cross-section of the 3D volume and view interior image details (such as the patient's 
airway). Dolphin 3D provides several pre-defined settings to view various cross-sections of the image, or you can define a 
custom location for the clipping slice. 
Dolphin 3D remembers the last location you set for a clipping slice. For instance, if you set the clipping slice to half-way through 
the 3D volume, the clipping slice is initially set at half-way through the volume relative to the current view the next time you use a 
clipping slice.  

To use a clipping slice: 

1. Check Use Clipping Slice. 

2. Move the slider to identify the location of the clipping slice. 

Or, 

Click  to set the clipping slice at the mid-sagittal plane. 

Or, 

Click  to set the clipping slice at the axial plane. 

Or, 

Click  to set the clipping slice at the coronal plane. 

Or, 
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Click  to use a pie-shaped clipping slice that includes the patient's arch. 

Or, 

Click  to orient the clipping slice in the direction of the viewer. 

When you rotate an image while using a clipping slice, the clipping slice remains fixed. For example, suppose you are 
using the clipping slice shown below. 

 
If you rotate the image to the lateral view, the clipping slice remains fixed, as shown below: 
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Using a Clipping Box 
A clipping box is like a 3-dimensional clipping slice. With a clipping box, you define a cube within the volume, and only the image 
data within the clipping box is displayed. Using a clipping box, you can view interior structures from several angles. You can 
define a clipping box using the patient's soft tissue, hard tissue, or translucent view (if your computer supports the advanced 3D 
rendering modes). Once you have a clipping box defined using one of these views, it applies to the other views. 

To open the Volume Clipping Box Editor window: 

1. Check the Use Volume Clipping Box box on the Dolphin 3D window. 

2. Click Edit.... 

The Volume Clipping Box Editor window opens. 

Note: The clipping box uses the 3D volume's original orientation (as taken by the 3D scanner). It does not take into 
account any changes in the orientation that you made on the Orientation Calibration window. For information on 
orienting the 3D image, see "Orienting the Image" on page 675. 

 



Dolphin Imaging User's Guide April 2011 

872 DI_USER_GUIDE-11.5   Rev. 1.01 

Clipping Box: 
Front View Click and drag the box on this image to define the clipping box using the frontal view. 

Clipping Box: 
Right View Click and drag the box on this image to define the clipping box using the right lateral view. 

Clipping Box: 
Bottom View Click and drag the box on this image to define the clipping box using the bottom view. 

Soft Tissue 
Solid Select this option to define the clipping box for the solid soft tissue view. 

Hard Tissue 
Solid Select this option to define the clipping box for the solid hard tissue view. 

Translucent 
Select this option to define the clipping box for the translucent view. Select the translucent view (Soft Tissue, 
Hard Tissue, or Both) that you want to use for this clipping box from the drop-down list box. 
This option is only available if your computer supports the advanced 3D rendering modes. 

Unclip Returns the boxes on the Front, Right, and Bottom images to their initial position, so that the entire image is 
selected within the clipping box. 

Verify 
Clipping Box The image in the lower half of the Clipping Box Editor window shows a preview of your clipping box. 

Rotation 
Sliders 

Use these sliders to rotate the image around the indicated axis: 
: Use this slider to rotate the 3D image horizontally. 
: Use this slider to rotate the 3D image circularly. 
: Use this slider to rotate the 3D image vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

Click one of these buttons to orient the 3D image in one of the predefined views. For more information, see 
"Moving or Reorienting the Image" on page 640. Predefined 

Views 

: Click this button to orient the 3D image for a right view. 

 : Click this button to orient the 3D image for a right oblique view. 

 : Click this button to orient the 3D image for a front view. 

 : Click this button to orient the 3D image for a left oblique view. 
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 : Click this button to orient the 3D image for a left view. 

 : Click this button to orient the 3D image for a back view. 

 : Click this button to orient the 3D image for a top view. 

 : Click this button to orient the 3D image for a bottom view. 

 : Click this button to orient the 3D image for a right isometric view. 

 : Click this button to orient the 3D image for a left isometric view. 

 
Click these arrow buttons to move the 3D image in the window in the indicated direction. For more information, 
see "Moving or Reorienting the Image" on page 640. 

  
Click this button to zoom in on the 3D image. For more information, see "Changing the Magnification" on page 
640. 

  
Click this button to zoom out on the 3D image.  For more information, see "Changing the Magnification" on page 
640. 

  
Click this button to fit the 3D image in the window.  For more information, see "Changing the Magnification" on 
page 640. 

To define a clipping box: 

1. On the Volume Clipping Box Editor window, select the view for which you want to define a clipping box. 

You can select the Soft Tissue Solid, Hard Tissue Solid, or Translucent view. The Translucent view is only available if 
your computer supports the advanced 3D rendering modes. 

2. If you selected the Translucent view, select an option from the Translucent View drop-down list box. 

In the Translucent view, you can view the soft tissue, hard tissue, or both. 

3. In the Front, Right, and Bottom images, click and drag the edges of the boxes to define the clipping box. 

Click and drag when your mouse pointer turns into a double-headed arrow. 

When you change the size of the box on one of these images, the boxes on the other images change to reflect your 
new clipping box selection. In addition, the Verify Clipping Box image provides a preview of your clipping box. 

4. Optionally, use the controls below the Verify Clipping Box image to rotate it and view a preview of your clipping box 
from several angles. 
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5. When you finish selecting the area of the volume you want to use for the clipping box, click OK. 

The image appears in the Dolphin 3D window using the clipping box you defined.  

Dolphin 3D remembers your clipping box definition. The next time that you check the Use Volume Clipping Box box, 
your last clipping box definition is applied. 

Clipping Example 
The following example illustrates one possible use of a clipping box and clipping slice. It defines a clipping box so that you can 
view the structure of the patient's airway in three dimensions. Then, it defines a clipping slice so that you can view a cross-
section of the patient's airway. 

To define this example clipping box: 

1. On the Dolphin 3D main window, select the solid soft tissue view. 

2. Select the Skin+Airway multi-color solid rendering template from the drop-down list box. 

The following example illustrates these selections on the Dolphin 3D main window. 

 
 For more information on multi-color solid rendering templates, see "Segmenting Solid Hard and Soft Tissues" on page 
641. 

3. Check the Use Volume Clipping Box box on the Dolphin 3D window. 

4. Click Edit.... 

5. On the Volume Clipping Box Editor window, select the Soft Tissue Solid view. 

6. In the Front, Right, and Bottom images, click and drag the edges of the boxes to define the clipping box. 

Click and drag when your mouse pointer turns into a double-headed arrow. The figure below illustrates the clipping box 
boundaries needed to view an example patient's airway. 
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7. Click OK. 

The image appears in the Dolphin 3D window using the clipping box you defined.  

To use this clipping box in conjunction with a clipping slice: 

1. On the Dolphin 3D main window, check the Use Volume Clipping Slice box. 

2. Click   to set the clipping slice at the mid-sagittal plane. 

3. Click   to rotate the image to the lateral view. 

A cross section of the patient's airway appears in the Dolphin 3D main window, as shown below. 
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Sculpting the Volume 
Sculpting the volume enables you to crop or remove portions of it. For example, some volumes have noise that you can remove 
using this feature. 

To open the Sculpting Tool dialog box: 

1. Check the Use Volume sculpting box on the Dolphin 3D window. 

2. Click Edit.... 

The Sculpting Tool dialog box opens. 
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Tool 

Select the sculpting tool shape from this drop-down list box. 
Free Form: Select this option to define your own sculpting tool shape. 
Circle: Select this option to use a circular sculpting tool. 
Square: Select this option to use a square sculpting tool. 
Diamond: Select this option to use a diamond-shaped sculpting tool. 
For more information, see "Free-Form Sculpting" on page 882 and "Sculpting with Standard Tool Shapes." 

Remove 
Boundary 

Click this button to remove a defined sculpting boundary. This button only appears when the Free Form tool is 
selected.  For more information, see "Free-Form Sculpting"" on page 882. 

Size Select the sculpting tool size from this drop-down list box. This button only appears when the Circle, Square, 
or Diamond tool is selected. For more information, see "Sculpting with Standard Tool Shapes" on page 882. 

Sculpt Interior 
Immediately 

Check this box to sculpt the parts of the volume inside the sculpting boundary as soon as the boundary is 
defined. This box only appears when the Free Form tool is selected.  For more information, see "Free-Form 
Sculpting"" on page 882. 

Sculpt Out All 
Not Shown 

Click this button to remove all parts of the volume not shown in the current view. For more information, see 
"Sculpting Out All Not Shown" on page 883. 
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Inverse Click this button to select all parts of the volume that are outside your current sculpting boundary. For more 
information, see "Using the Inverse Feature" on page 883. 

Undo Last Click this button to undo your last sculpting operation. 

Redo Last Click this button to redo your last "undone" sculpting operation. 

Undo All... 

Click this button to undo all sculpting operations. When you click this button, a pop-up menu opens with the 
following options: 
Close this menu: Click this option to close the pop-up menu. 
Undo All - Current Session: Click this option to undo all sculpting operations that you performed in this 
session. 
Undo All - Completely: Click this option to undo all the sculpting operations performed on this volume. 

Restrict to 
Within 
Viewing Slice 

Check this box to restrict your sculpting operations to the areas within the selected cross-section of the 
volume. 
slider: Move the slider to set the location of the slice used for this cross section. 

: Click this icon to set the clipping slice at the mid-sagittal plane. 

: Click this icon to set the clipping slice at the axial plane. 

: Click this icon to set the clipping slice at the coronal plane. 

: Click this icon to use a pie-shaped clipping slice that includes the patient's arch. 

: Click this icon to orient the clipping slice in the direction of the viewer. 
For more information, see "Restricting the Sculpting Area" on page 881. 

Restrict to 
Within 
Segmentation 

Check this box to restrict your sculpting operations to the areas within the selected volume segmentation. For 
more information, see "Restricting the Sculpting Area" on page 881. 

Volume group 
box 

Use this group box to set the segmentation and view for the volume. 
Seg: Use this slider to set the segment of the 3D image to use for the selected view. 
Solid: Click this radio button to view a solid representation of the volume. 
Translucent: Click this radio button to view a translucent representation of the volume. This option is enabled 
only if your computer graphics card supports advanced 3D rendering. 
For more information on these options, see "Viewing the Soft Tissue" on page 635. 

Rotate Volume 
About Red Dot 

Check this box to rotate the volume about a user-defined point. For more information, see "Rotating the 
Volume" on page 884. 

Save/Identify... Click this button to save the sculpted volume and identify it as either the maxilla or the mandible. For more 
information, see "Saving/Identifying and Restoring the Sculpted Volume" on page 885. 
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Restore... Click this button to restore a previously-saved sculpted volume. For more information, see "Saving/Identifying 
and Restoring the Sculpted Volume" on page 885. 

Exporting 

Use this group box to export the volume to a file. 
Create Sculpted DICOM Files: Click this button to export the sculpted volume as one or more DICOM files. 
For more information, see "To export the 3D volume to one or more DICOM files" on page 622. 
Export Volume as Surface...: Click this button to create an isosurface from the volume and export it to a file 
 for use with applications that can import and process an isosurfacei. For more information, see "Creating and 
Exporting an Isosurface" on page 666. 

Measurement 
Calculation 

Use this group box to calculate measurements for the volume. 
Volume: Click this button to calculate the volume in cubic millimeters (mm3) and cubic centimeters (cm3), 
taking the current sculpting, segmentation, and viewing slice into consideration. 
Average Hounsfield Unit: Click this button to calculate average hounsfield unit for the volume. This option is 
only available for scans imported using Dolphin Imaging version 11 or later. 
For more information, see "Performing Calculations" on page 884. 

Rotation 
Sliders 

Use these sliders to rotate the image around the indicated axis: 
: Use this slider to rotate the 3D image horizontally. 
: Use this slider to rotate the 3D image circularly. 
: Use this slider to rotate the 3D image vertically. 

For more information, see "Moving or Reorienting the Image" on page 640. 

Click one of these buttons to orient the 3D image in one of the predefined views. For more information, see 
"Moving or Reorienting the Image" on page 640. Predefined 

Views 

: Click this button to orient the 3D image for a right view. 

 : Click this button to orient the 3D image for a right oblique view. 

 : Click this button to orient the 3D image for a front view. 

 : Click this button to orient the 3D image for a left oblique view. 

 : Click this button to orient the 3D image for a left view. 

 : Click this button to orient the 3D image for a back view. 

 : Click this button to orient the 3D image for a top view. 
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 : Click this button to orient the 3D image for a bottom view. 

 : Click this button to orient the 3D image for a right isometric view. 

 : Click this button to orient the 3D image for a left isometric view. 

 
Click these arrow buttons to move the 3D image in the window in the indicated direction. For more 
information, see "Moving or Reorienting the Image" on page 640. 

  
Click this button to zoom in on the 3D image. For more information, see "Changing the Magnification" on page 
640. 

  
Click this button to zoom out on the 3D image. For more information, see "Changing the Magnification" on 
page 640. 

  
Click this button to fit the 3D image in the window. For more information, see "Changing the Magnification" on 
page 640. 

 

Restricting the Sculpting Area 

To restrict sculpting to a particular viewing slice: 

1. Check the Restrict to Within Viewing Slice box. 

2. Move the slider to identify the location of the viewing slice. 

Or, 

Click  to set the viewing slice at the mid-sagittal plane. 

Or, 

Click  to set the viewing slice at the axial plane. 

Or, 

Click  to set the viewing slice at the coronal plane. 

Or, 

Click  to use a pie-shaped viewing slice that includes the patient's arch. 

Or, 

Click  to orient the viewing slice in the direction of the viewer. 
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The image appears with the viewing slice you selected. Any sculpting operations that you perform will apply only to the 
visible part of the volume. 

To restrict sculpting to a particular volume segment: 

1. Check the Restrict to Within Segmentation box. 

2. Adjust the Seg slider to set the segmentation that you want to use for this sculpting operation. 

The image appears with the segmentation you selected. Any sculpting operations that you perform will apply only to 
the visible part of the volume. 

Free-Form Sculpting 
With free-form sculpting, you define a cropping polygon to use as your sculpting tool. In this way, you can sculpt using free-form 
shapes. 

To use free-form sculpting: 

1. Optionally, click the button for one of the predefined views to change to that orientation. 

Or, 

Click and drag the volume to rotate it. 

2. Optionally, check the Sculpt Interior Immediately box to remove the part of the volume within your cropping polygon as 
soon as the polygon is defined. 

3. Click the left mouse button on a point where you want to begin drawing the cropping polygon. 

Click a point that is not on the volume to begin your polygon. 

4. Release the mouse button and move the mouse to begin drawing the polygon. 

As you move the mouse, you’ll see a line extending from the point to the current mouse position. 

5. Click the mouse button whenever you want to place a point and change the direction of the line. 

If you make a mistake and want to start over, click Remove Cropping Border. 

6. Click the left mouse button again on the first point to close the polygon. 

If you checked the Sculpt Interior Immediately box, the part of the volume within your cropping polygon is removed 
when you close the polygon. Otherwise, the mouse pointer changes to a pair of scissors. 

7. Click the left mouse button inside the polygon to remove the part of the photograph that is inside the polygon. 

Or, 

Click the left mouse button outside the polygon to remove the part of the photograph that is outside the polygon. 

Sculpting with Standard Tool Shapes 
For your convenience, Dolphin 3D offers three standard tool shapes (circle, square, and diamond) that you can use to sculpt the 
volume. 
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To sculpt with the standard tool shapes: 

1. Optionally, click the button for one of the predefined views to change to that orientation. 

Or, 

Click and drag the volume to rotate it. 

2. Select the tool shape you want to use from the Tool drop-down list box. 

3. Select the tool size you want to use from the Size drop-down list box. 

The mouse pointer changes to indicate the shape and size of the sculpting tool that you have selected. 

4. Click the volume to remove parts of it in the shape and size of the selected sculpting tool. 

Sculpting Out All Not Shown 
Using this feature, you can remove all parts of the volume not shown in the current view.  For example, you can remove all parts 
of the volume that are not within a particular viewing slice or volume segment. 

To sculpt out all not shown: 

1. Optionally, check the Restrict to Within Viewing Slice box and select a viewing slice to sculpt out parts of the volume 
that are not in that slice. 

2. Optionally, check the Restrict to Within Segmentation box and adjust the Seg slider to set the segmentation to sculpt 
out parts of the volume that are not in that segment. 

For more information, see "Restricting the Sculpting Area" on page 881. 

3. Click Sculpt Out All Not Shown. 

Using the Inverse Feature 
With the Inverse feature, you can sculpt away the inverse of the selected part of the volume. 

To use the Inverse feature: 

1. Sculpt away part of the volume. 

2. Click Inverse. 

The following figure illustrates this feature. In this example, part of the volume is sculpted away using the free-form the 
sculpting tool. Clicking Inverse sculpts away the inverse of the original selection. 
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Rotating the Volume 
In addition to the usual features for rotating a volume, you can rotate the sculpted volume about a user-defined point. This useful 
when you want to work in an area of interest (a condyle, for example) and want that area to stay in the window instead of getting 
rotated out of view, because the rotation is based on the center of the volume. 

To rotate the volume about a user-defined point: 

1. Check the Rotate Volume About Red Dot box.  

2. Move the red dot that appears to any location on the volume.   

3. Rotate the volume as described in "Moving or Reorienting the Image" on page 640. 

The volume rotation is centered about the red dot. 

Performing Calculations 

To calculate the volume measurement of a sculpted volume: 

1. On the Sculpting Tool dialog box, click Volume.  

The volume measurement based on the current segmentation and sculpting in cubic millimeters (mm3) and cubic 
centimeters (cm3) is displayed.   

To calculate the average Hounsfield Unit of a sculpted volume: 

1. On the Sculpting Tool dialog box, click Average Hounsfield Unit.  

The average Hounsfield Unit of the segmented and sculpted volume is calculated and displayed. 

Note: This calculation can be done only on scans imported using Dolphin Imaging version 11 or later. 
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Saving/Identifying and Restoring the Sculpted Volume 
When you exit Volume Sculpting, you can save the sculpted volume. It is restored the next time you enter Volume Sculpting. In 
addition, you can save two versions of the sculpted volume, identifying them as the maxilla and the mandible. Later, you can 
restore one or both of these sculpted volumes. 
These volumes that you store and identify as maxilla and mandible cannot contain overlapping parts of the volume.  For 
example, the sculpted volume identified as the maxilla cannot include parts of the volume saved and identified as the mandible. If 
the second sculpted volume you save overlaps with the first, the overlapping parts are removed from the first saved sculpted 
volume. 

To save and identify the sculpted volume: 

1. Click Save/Identify... 

 A pop-up menu appears offering options to identify the volume as either the maxilla or the mandible. 

2. Click Identify As Maxilla to save and identify the sculpted volume as the maxilla. 

Or, 

Click Identify As Mandible to save and identify the sculpted volume as the mandible. 

To restore a previously saved and identified volume: 

1. Click Restore... 

A pop-up menu appears offering options to restore volumes previously saved and identified. 

2. Click Restore Maxilla to restore a volume previously saved and identified as the maxilla. 

Or, 

Click Restore Mandible to restore a volume previously saved and identified as the mandible. 

Or, 

Click Restore Maxilla+Mandible to restore volumes previously saved and identified as the maxilla and the mandible. 

Exiting from Volume Sculpting 

To save your sculpted volume and exit: 

1. Click OK to save your sculpted volume. 

 Your sculpted volume saved. It will be restored the next time you enter Volume Sculpting. 
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To exit without saving: 

1. Click Cancel to exit without saving. 

If you have saved and identified parts of the sculpted volume as the maxilla and/or mandible, the Sculpting Canceling 
dialog box opens. 

2. Select an option on this dialog box.  Then, click OK. 

 

Cancel all sculpting but keep 
maxilla/or mandible identified 
during this sculpting session 

Select this option if you want to keep the sculpted volumes that you have saved 
and identified as the maxilla and/or mandible.  All other work from this sculpting 
session is discarded. 

Cancel all Select this option to discard all the work you have done in this sculpting session. 
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32 Designing and Printing Reports 
With the Dolphin 3D Report Editor, you can design and print reports from Dolphin 3D. This editor is true WYSIWYG (what you 
see is what you get), and automatically shares page layouts between all your computers. 
Using this full-featured design environment, you can freely place images, labels, and other layout components on the report 
pages. Once you have created a report, you can: 

• add annotations (text, arrows, and so on) prior to printing 

• print it 

• view it on your computer screen 

• generate image snapshots of the report pages either on the Windows clipboard or as image files 

• save it as part of a patient’s record 

• send it to a referral 

• save your design as a template for later report generation 

Using the Dolphin 3D Report Editor, you can create and edit the reports that use images and series of cross sections from 
Dolphin 3D as well as 2D images from Dolphin image layouts.  

To open the Dolphin 3D Report Editor: 

1. Click Send Snapshot... on the main Dolphin 3D window. 

2. Select Send To Report from the pop-up menu. 

The Dolphin 3D Report Editor window opens and displays the image you just sent to it in the Image Gallery on the left. 
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Menu Bar Contains menus that you can use to access program features.  

Tool Bar Contains buttons that you use to access program features. 

Image 
Gallery 

Displays thumbnails of the images and cross sections that you have sent to the Dolphin 3D Report Editor for use 
in your reports. 

Preview Shows a preview of the report. 

Page Gallery Displays thumbnails of the pages in this report template. 

To minimize the Dolphin 3D Report Editor: 

1. Select Exit from the File menu. 

The Dolphin 3D Report Editor is minimized to your tray and remains available there until you exit Dolphin 3D. You can 
click the Dolphin Imaging icon in your tray to restore the window. 
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Using the Tool Bar 
The Dolphin 3D Report Editor tool bar contains the following buttons: 

 Click this button to open and edit an existing report template. For more information, see "Opening a Report 
Template" on page 903. 

  Click this button to save the current report template. For more information, see "Saving the Report Template" 
on page 904. 

 

Click this button to print the current report. For more information, see "Printing Reports" on page 956. 

 

Click this button to add a new page to this report. For more information, see "Working With Report Pages" on 
page 907. 

 

Click this button to add a new text label to this report. For more information, see "Using Text Labels" on page 
935. 

 
Click this button to add a new image to this report. For more information, see "Adding an Image to a Report 
Template" on page 910. 

 

Click this button to add cross sections to this report. For more information, see "Adding Cross Sections to a 
Report Template" on page 922. 

 

Click this button to open a pop-up menu that you can use to add the following types of annotations to this 
report: text, line, arrow, ellipse, or rectangle. For more information, see "Using Annotations" on page 939. 

 

Click this button to assign images or cross sections from the Image Gallery to any empty image and cross 
sections objects based on the image type assigned to those objects. For more information, see "Adding an 
Image to a Report Template" on page 910 and "Adding Cross Sections to a Report Template" on page 922. 

 

Click this button to toggle Locked mode for any selected objects. When an object is locked it cannot be moved 
or resized, avoiding accidental misalignment of images. You can still drag images or cross sections from the 
Image Gallery to a locked placeholder or change a locked object's properties. For more information, see 
"Locking and Unlocking Objects" on page 952. 

 Click this button to delete the selected objects or pages from the report. For more information, see "Deleting 
Objects" on page 948 and "Deleting Pages" on page 909. 

 

When two or more objects are selected, click this button to align them with the left side of the first object 
selected. For more information, see "Aligning Objects" on page 944. 
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When two or more objects are selected, click this button to align them with the right side of the first object 
selected. For more information, see "Aligning Objects" on page 944. 

 

When two or more objects are selected, click this button to align them with the top of the first object selected. 
For more information, see "Aligning Objects" on page 944. 

 

When two or more objects are selected, click this button to align them with the bottom of the first object 
selected. For more information, see "Aligning Objects" on page 944. 

 

When two or more objects are selected, click this button to resize them to be the same width as the first object 
selected. For more information, see "Making Several Objects the Same Size" on page 943. 

 

When two or more objects are selected, click this button to resize them to be the same height as the first object 
selected. For more information, see "Making Several Objects the Same Size" on page 943. 

 When two or more objects are selected, click this button to resize them to be the same width and height as the 
first object selected. For more information, see "Making Several Objects the Same Size" on page 943. 

 

Select a magnification percentage from this drop-down list box to change the magnification.  For more 
information, see page 242. 

 

Click this button to zoom in on the report. For more information, see page 242. 

 

Click this button to zoom out from the report. For more information, see page 242. 

 

Click this button to change the magnification so that the report fits in the window. For more information, see 
page 242. 
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Using the Menu Bar 
At the top of the Dolphin 3D Report Editor window, there are menus that you can use to access program features.  

• File Menu 

• Edit Menu 

• View Menu 

• Insert Menu 

• Format Menu 

• Tools Menu 

• Image Gallery Menu 

• Groups Menu 

This section describes each of these menus. 

The File Menu 
The following figure illustrates the File menu: 

 
The File menu contains the following choices: 

New Template Creates a new report template. For more information, see "Creating a New Report Template" on page 903. 

Open Template... Opens an existing report template for editing. For more information, see "Opening a Report Template" on 
page 903. 

Save Template Saves the current report template. For more information, see "Saving the Report Template" on page 904. 

Save Template 
As... 

Saves the current report template under a new name. For more information, see "Saving the Report 
Template" on page 904. 
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Save Report to 
Dolphin 2D... 

Saves the current report, including all images and patient information, into an image layout slot viewable on 
the Dolphin Imaging main screen. For multi-page reports, Dolphin Imaging saves all the report pages into the 
image slot.  For more information, see below. 

Export Page to 
Image... 

Exports the currently-selected page in the report to an image file on your computer.  For more information, 
see below. 

Page Setup... Opens the Page Setup dialog box so that you can adjust the paper size, background color, margins, page 
orientation, and preset printer for the currently-selected page.  For more information, see "Setting Up the 
Page" on page 905. 

Print... Prints the current report. For more information, see "Printing Reports" on page 956. 

Print to preset 
printer(s) 

Prints the current report, directing any pages with preset printer settings (see Page Setup... above) to the 
appropriate printers. For more information, see "Printing Reports" on page 956. 

Exit Minimizes the Dolphin 3D Report Editor to your tray, where it remains available until you exit Dolphin 3D. 

To save the current report into an image layout: 

1. Select Save Report to Dolphin 2D... from the File menu. 

A dialog box opens where you can select the image layout and slot in which you want to save the report. 

2. Select the tab for the image layout to which you want to save the report. 

3. Select the image slot in which you want to save the report. 

4. Enter a title for the report in the Report Title text box. 

5. Specify any other options. Then, click OK. 

The current report, including all images and patient information, is saved into the selected image slot.  
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Tabs Select a tab to save the report into a slot on that layout. 

Image 
Layout 

Select a slot in the layout to save the report into it. Depending on whether the Show Images box is checked (see 
below), image slots that are already in use are pink or display the images stored in them. 

Show 
Images 

Check this box to show the images stored in slots that are already in use. Otherwise, used slots appear in pink. 

Report Title Enter the title for this report. 

DPI Select the resolution for this report as a number of Dots Per Inch (DPI). 
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To export a page to an image file: 

1. Select Export Page to Image... from the File menu. 

The Save Page to Image File dialog box opens. 

2. Click the button labeled .... 

The Save As dialog box opens. 

3. Specify the image file in which you want to save the current page.  

4. Optionally, select the type of image (JPEG, PNG, or bitmap) from the Save As Type drop-down list box. Then, click 
Save. 

5. Set any other options on the Save Page to Image File dialog box. Then, click Save. 

 

Save Path The image file in which you want to save the current page. Click the button labeled ... to browse 
to the file. 

Color Select this option to save this page as a color image. 

Greyscale Select this option to save this page as a greyscale image. 

Resolution (dots per inch)  Select the resolution for this page as a number of Dots Per Inch (DPI). 

Preview Displays a preview of the page you are exporting. 
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The Edit Menu 
The following figure illustrates the Edit menu: 

 
The Edit menu contains the following choices: 

Undo Undoes previous operations in order. You can undo any number of operations. 

Redo Redoes undone operations. You can redo any number of operations as long as you did not make any 
changes to the report template after the undo operation. 

Copy page to 
Clipboard 

Copies the current page and places it on the clipboard as an image. 

Cut Cuts one or more selected objects and places it on the clipboard. For more information, see "Cutting, 
Copying, and Pasting Objects" on page 949. 

Copy Copies one or more selected objects to the clipboard. For more information, see "Cutting, Copying, and 
Pasting Objects" on page 949. 

Paste Pastes one or more previously cut or copied objects from the clipboard. For more information, see 
"Cutting, Copying, and Pasting Objects" on page 949. 

Delete Deletes one or more selected objects. For more information, see "Deleting Objects" on page 948. 

Select All Selects all objects on the report. 

Enhance Selected 
Image(s)... 

Opens the Enhance Image dialog box so you can adjust the brightness, contrast, saturation, gamma and 
sharpening of one or more selected images. For more information, see "Enhancing Images." 

Load from Image 
Gallery 

Assigns images and cross sections from the Image Gallery to any empty image and cross sections 
objects based on the image type assigned to those objects. For more information, see "Adding an Image 
to a Report Template" on page 910 and "Adding Cross Sections to a Report Template" on page 922. 
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The View Menu 
The following figure illustrates the View menu: 

 
The View menu contains the following choices: 

Margins Toggles the display of the green margin lines. For more information, see "To toggle display of the green margin 
lines" on page 907. 

Printable 
Area 

Toggles the display of the red "printable area" guidelines. For more information, see "To toggle display of the red 
"printable area" guidelines" on page 907. 

Image Titles Opens a cascade menu that you can use to show or hide the title labels for all images. For more information, see 
"Displaying Image Titles" on page 912. 

Image 
Borders 

Opens a cascade menu that you can use to show or hide the borders around all images. For more information, 
see "Displaying Image Borders" on page 911. 

Image 
Gallery 

Toggles the display of the image gallery. For more information, see "Using the Image Gallery" on page 900. 

Page Gallery Toggles the display of the page gallery. For more information, see "Using the Page Gallery" on page 902. 

Hide Labels Toggles the display of the all the labels in a report. For more information, see "To toggle display of all text labels" 
on page 252. 
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The Insert Menu 
The following figure illustrates the Insert menu: 

 
The Insert menu contains the following choices: 

Page Adds a page at the end of the report template using the page settings of the previous page. For more 
information, see "Adding Pages" on page 908. 

Label Places a label on a page. For more information, see "Using Text Labels" on page 935. 

Image Places an image on a page. For more information, see "Adding an Image to a Report Template" on 
page 910. 

Cross Sections Places an cross sections for a montage on a page. For more information, see "Adding Cross Sections to 
a Report Template" on page 922. 

Group Displays a list of previously-saved groups of objects so that you can choose one to insert into the report. 
For more information, see "To insert a previously-saved object group into your design" on page 951. 

Page(s) from 
existing template... 

Appends a previously-saved report template to the end of the current report. For more information, see 
"Adding Pages" on page 908. 

The Format Menu 
The following figure illustrates the Format menu: 
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The Format menu contains the following choices: 

Background 
Color... 

Sets the background color of the currently-selected page. 

Image Corner 
Rounding... 

Toggles rounded corners on the images 

Align Opens a cascade menu that you can use to align the selected objects on the left, right, top, or bottom. For 
more information, see "Aligning Objects" on page 944. 

Make Same Size Opens a cascade menu that you can use to resize the selected objects to be the same height, same width, 
or both the same height and width. For more information, see "Making Several Objects the Same Size" on 
page 943. 

Center Opens a cascade menu that you can use to center the selected objects horizontally or vertically on the 
page. For more information, see "Centering Objects" on page 946. 

Horizontal 
Spacing 

Opens a cascade menu that you can use to adjust the horizontal spacing of the selected objects as 
follows: 
Make Equal: Space the selected objects evenly. 
Increase: Increase the space between the selected objects. 
Decrease: Decrease the space between the selected objects. 
Remove: Remove the space between the selected objects, making them flush with each other. 
For more information, see "Changing Object Spacing" on page 946. 

Vertical Spacing Opens a cascade menu that you can use to adjust the vertical spacing of the selected objects as follows: 
Make Equal: Space the selected objects evenly. 
Increase: Increase the space between the selected objects. 
Decrease: Decrease the space between the selected objects. 
Remove: Remove the space between the selected objects, making them flush with each other. 
For more information, see "Changing Object Spacing" on page 946. 

Order Opens a cascade menu that you can use to adjust the ordering of the selected objects as follows: 
Bring to Front: Place the selected object in front of other objects. 
Send to Back: Place the selected object behind other objects. 
For more information, see "Changing Object Layering" on page 948. 

Snap To Opens a cascade menu that you can use to align the selected objects as follows: 
Margin: Opens a further cascade menu that you can use to align the selected objects along the left, right, 
top, or bottom page margin. 
Printer Hard Margin: Opens a further cascade menu that you can use to align the selected objects along 
the left, right, top, or bottom hard margin.  
If you have specified a printer on the page setup dialog box, the hard margins specify how close to the 
paper edge the specified printer can print. Otherwise, the hard margins are at the paper edges. 
For more information, see "Aligning Objects" on page 944. 
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The Tools Menu 
The following figure illustrates the Tools menu: 

 
The Tools menu contains the following choices: 

Link Labels to 
Image 

Establishes a link between the selected labels and image so that data tokens such as the image title, 
timepoint information, and so on can be read from that image when rendering the label text. For more 
information, see "Linking Labels to an Image" on page 938. 

Unlink Labels 
from Image 

Break the linkage between labels and an image. For more information, see "Linking Labels to an Image" on 
page 938. 

Options... Opens a dialog box where you can set options for editor. For more information, see "Setting Options" on page 
953. 

 

The Image Gallery Menu 
The following figure illustrates the Image Gallery menu: 

 
The Image Gallery menu contains the following choices: 

Hide/Show Toggles display of the Image Gallery. For more information. see "Using the Image Gallery" on page 900. 

Fill Template 
from Gallery 

Assigns images from the Image Gallery to any empty image and cross sections objects based on the image 
type assigned to those objects. For more information. see "Adding an Image to a Report Template" on page 
910 and "Adding Cross Sections to a Report Template" on page 922. 

Fill from 
Dolphin 
Timepoint 

Opens a cascade menu listing timepoints for the current patient. Select a timepoint to import all images from 
it into the Image Gallery for use in the report. For more information, see "To add a Dolphin 3D image or cross 
sections to the gallery" on page 901. 

Clear Clears all images from the Image Gallery. For more information, see "Using the Image Gallery" on page 900. 
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The Groups Menu 
The following figure illustrates the Groups menu: 

 
The Groups menu contains the following choices: 

Group 
Objects 

Group the selected objects into a single object. For more information, see "To group several objects" on page 
950. 

Ungroup 
Objects 

Split the selected object group into individual objects.  For more information, see " To ungroup the objects in an 
object group” on page 950. 

Save Group 
As... 

Store a group of objects for later reuse.  For more information, see "To save an object group for later reuse" on 
page 950. 

Insert Group Insert a previously-stored object group on the current design.  For more information, see "To insert a 
previously-saved object group into your design" on page 951. 

Using the Image Gallery 
The image gallery displays thumbnails of the images and cross sections you have sent to it for use in your reports. You can click 
and drag any of these images or cross sections to report pages to add them to your report template. For more information, see 
"3dreports_adding_an_image_group__5868Adding an Image to a Report Template" on page 910 and 
"3dreports_adding_an_image_group__5868Adding Cross Sections to a Report Template" on page 922. 

To scroll through the images and cross sections in the gallery: 

1. Click and drag the scroll bar to the right of the image gallery. 

To clear all images from the gallery: 

1. Select Clear from the Image Gallery menu. 
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To toggle display of the image gallery: 

1. Select Image Gallery from the View menu. 

Or, 

Select Hide from the Image Gallery menu to hide the image gallery if it is showing. 

Or, 

Select Show from the Image Gallery menu to show the image gallery if it is hidden. 

Or, 

Right-click the Image Gallery pane in a place not occupied by an image, and select Hide Image Gallery from the pop-
up menu to hide the image gallery. 

To add a Dolphin 3D image or cross sections to the gallery: 

1. In Dolphin 3D, navigate to the window where you can view the image or cross sections that you want to use in your 
report template. 

For example, for a lateral soft tissue view, you could navigate to the main Dolphin 3D window (see "Understanding the 
Dolphin 3D Window" on page 615). For a cross-sections x-ray view, you would navigate to the Build X-Rays Tool 
window (see Chapter 25). 

2. Set up the image or cross sections that you want to use in your report template. 

For example, for a lateral soft tissue view, you would select the button for the lateral view you want the main Dolphin 
3D window (see "Viewing the Soft Tissue" on page 635. and "Moving or Reorienting the Image" on page 640). For a 
cross-sections x-ray view, you would generate the cross-sections view you want in the Build X-Rays Tool window (see 
*Building a Cross-Sections X-Ray View" on page 729). 

3. Click Generate Snapshot. 

4. Select Send To Report from the pop-up menu. 

If this is the first image you have sent to the Dolphin 3D Report Editor, it opens in a new window and displays the 
image or cross sections you just sent to it in the Image Gallery on the left. 

If you close the Dolphin 3D Report Editor window, it is minimized to your tray and remains available there until you exit 
Dolphin 3D. Depending on the options you have set for the Dolphin 3D Report Editor, it may open whenever you send 
another image or cross sections to the gallery, or the image or cross sections you sent may appear briefly above the 
tray. For more information, see "Setting Options" on page 953. 
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To add the images from a timepoint to the gallery: 

1. Select Fill from Dolphin Timepoint from the Image Gallery menu. 

Or, 

Right-click the Image Gallery pane in a place not occupied by an image, and select Fill from Timepoint from the pop-up 
menu.   

2. Select a timepoint from the cascade menu. 

All the images for the selected timepoint appear in the image gallery. 

To preview an image or cross sections in the image gallery: 

1. Right-click the image or cross sections you want to preview. 

A close-up view appears. 

Using the Page Gallery 
The page gallery displays thumbnails of the report template's pages.  

To scroll through the pages in the gallery: 

1. Click and drag the scroll bar to the left of the page gallery. 

To view a page from the gallery: 

1. Double-click a page in the gallery to display it in the center pane in the window. 

To toggle display of the page gallery: 

1. Select Page Gallery from the View menu. 

Or, 

Right-click the page gallery. Then select Hide Page Previews from the pop-up menu to hide the page gallery. 
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Managing Report Templates 
This section describes how to create a new report template, open an existing report template, save a report template, and delete 
a report template. 

Creating a New Report Template 

To create a new report template: 

1. Select New Template from the File menu. 

The Page Setup dialog box opens. 

2. Enter page setup options for the new template.  

For information on setting these options, see "Setting up the Page" on page 905. 

3. Click OK. 

The new template appears in the Dolphin 3D Report Editor window. 

Opening a Report Template 

To open an existing report template: 

1. Click . 

Or, 

Select Open Template... from the File menu. 

A dialog box appears where you can select the template that you want to open. 

2. Select a template from the list box, and click Open. 



Dolphin Imaging User's Guide April 2011 

904 DI_USER_GUIDE-11.5   Rev. 1.01 

Saving the Report Template 
Saving your report template automatically shares your layout design among all Dolphin stations on your network. 

To save the report template: 

1. Click . 

Or, 

Select Save Template or Save Template As... from the File Menu. 

If you had previously saved this template and you did not select Save Template As..., the template is saved, 
overwriting the old version. 

If you have not previously saved this template or if you selected Save Template As..., a dialog box opens where you 
can specify a name for this template.  

2. Select an existing template name that you want to use for this template from the list box.  

Or, 

Type the name that you want to use for this template in the text box.  

3. Click Save. 

If you selected an existing template name, your new template is written over the existing template.  

Report templates are saved in the Dolphin\Working folder on your server, so that saved templates are 
available to all computers on your network, and they are backed up along with the rest of your Dolphin Imaging data. 

Deleting a Report Template 

To delete a report template: 

1. Click . 

Or, 

Select Open Template... from the File menu. 

A dialog box appears where you can select a template that you want to open. This dialog box also offers the option to 
delete a template. 

2. Select the template you want to delete from the list box. Then, click Delete. 

A dialog box appears asking you to confirm the deletion. 

3. Click Yes to delete the template.  
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Editing Report Templates 
This section describes how to edit a report template. It describes: 

• setting up and working with report pages 

• using text labels, images, cross sections, and annotations 

• resizing and repositioning objects 

• deleting objects 

• cutting, copying, and pasting objects 

• using object groups 

• locking and unlocking objects 

• setting options 

Setting Up the Page 
You use the Page Setup dialog box to set basic properties of each report page. The first step in creating a new template is to 
enter page setup options. After creating the template initially, you can change these options at any time. 

To set up the page: 

1. Select Page Setup... from the File Menu to set options for the report on which you are currently working. 

Or, 

Select New Template from the File menu to create a new report template. 

Or, 

Right-click a report page. Then, select Page Setup... from the pop-up menu. 

Page Setup dialog box opens. 

2. Enter page setup options. Then, click OK. 
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Paper group box Use these options to set the paper size. 

drop-down list box: Select from a list of standard paper sizes. 
Custom: Check this box to enter a custom paper size. 
Width: Enter the width for a custom paper size. The units for this measurement depend on the 
Measurement Units selection (see below). 
Height: Enter the height for a custom paper size. The units for this measurement depend on 
the Measurement Units selection (see below). 

Margins group box Use these options to set the right, left, top, and bottom margins. The units for these 
measurements depend on the Measurement Units selection (see below). 
Margins act as guidelines. You can place objects outside the margins. 

Orientation group box Select the page orientation. 
Portrait: Prints so that the short edges of the page are at the top and bottom. 
Landscape: Prints so that the long edges of the page are at the top and bottom. 

Background Color Click the color sample to set the background color for the report pages. 

Measurement Units 
group box 

Select the units, either inches or millimeters (mm), that you want to use when entering 
measurements such as margin dimensions for this report template. 

Preset Printer Select the printer that you want to use by default when printing this report page. You can 
change to a different printer when printing a report. 

Use these settings as 
defaults 

Check this box to use these settings as defaults for all report templates. 
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Working With Report Pages 

To view a different page in a multi-page report template: 

1. Click and drag the scroll bar to the right of the page gallery until the page you want to view appears in the center part of 
the window.  

To zoom in: 

1. Click . 

To zoom out after zooming in: 

1. Click . 

To fit the design in the window: 

1. Click . 

To select a magnification factor: 

1. Select a magnification percentage from the drop-down list on the tool bar. 

To toggle display of the green margin lines: 

1. Select Margins from the View menu. 

To toggle display of the red "printable area" guidelines: 

1. Select Printable Area from the View menu. 
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Adding Pages 

To add a blank page to the report template: 

1. Click ' 

Or, 

Select Page from the Insert menu. 

The Dolphin 3D Report Editor adds a page to the end of the report template using the page settings of the previous 
page. 

To add pages from an existing report template or a Dolphin Imaging layout: 

1. Select Page(s) from existing template... from the Insert menu. 

The Select Layout dialog box opens.  

2. Select the Report Layouts tab to add all the pages from an existing report template to the end of this report template. 

Or, 

Select the Dolphin Layouts tab to add a page containing a Dolphin Imaging layout to the end of this report template. 

3. Select the existing report template or Dolphin Imaging layout that you want to add to this report template. 

4. Click Insert. 

One or more new pages appear at the end of the report template. This enables you to combine several templates into 
a single report.  
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Report Layouts Click this tab and select an existing report template to add all of its pages to the end of this report template. 

Dolphin 
Layouts 

Click this tab and select a Dolphin Imaging layout to add a page containing that layout to the end of this report 
template. 

Insert Click this button to add the selected existing report template or Dolphin Imaging layout to this report template 

Deleting Pages 

To delete a page from the report template: 

1. Click and drag the scroll bar to the right of the page gallery until the page you want to delete appears in the center part 
of the window.  

2. Click the page to select it. 

A red outline appears around the page. 

3. Click . 

Or, 

Select Delete from the Edit menu. 

A dialog box appears asking you to confirm the deletion. 

4. Click Yes to delete the page. 

Reordering Pages 

To change the order of the pages in a multi-page report template: 

1. Right-click the page you want to move in the page gallery. 

2. Select Move Page to Number from the pop-up menu. 

3. Select the new page number for the selected page from the cascade menu. 
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Using Images and Cross Sections 
An image can be a patient image from Dolphin 3D or Dolphin 2D, or it can be any image imported from your computer (such as a 
logo). Cross sections are meant for including montages such as cross-section, TMJ, or nerve canal views.  
The Image Gallery contains thumbnails of the images and cross sections you plan to use in your report template.  

Adding an Image to a Report Template 

To drag and drop an image from the gallery to your report template: 

1. Navigate to the page in your report template where you want the image to appear. 

2. Click and drag the scroll bar to the right of the image gallery until the image you want to add to your report template 
appears.  

3. Drag the image from the gallery and drop it onto the page. 

Or, 

Drag the image from the gallery and drop it into an existing image placeholder on the page. 

To use the tool bar or menus to add an image to your report template: 

1. Navigate to the page in your report template where you want the image to appear. 

2. Click . 

Or, 

Select Image from the Insert menu. 

Or, 

Right-click the report page and select Add Image from the pop-up menu. 

Your cursor changes to a placeholder-drawing icon ( ). 

3. Click and drag to draw an image placeholder of the size you want for this image. 

4. Right-click the image placeholder. 

5. Select 3D Image Type from the pop-up menu to add a Dolphin 3D image to this report template. Then, select the type 
of 3D image you want to use from the cascade menu. 

Or, 

Select 2D Image Type from the pop-up menu to add a Dolphin 2D image to this report template. Then, select the type 
of 2D image you want to use from the cascade menu. 

You can also set the image type for a placeholder by setting its properties. You would do this, for example, to add a 
logo or other image file from your computer to a report template. For more information, see "Setting Image Properties" 
on page 915. 



32 Designing and Printing Reports Part X: 3D 

DI_USER_GUIDE-11.5   Rev. 1.01 911 

To replace image placeholders with images from the image gallery: 

1. Click . 

Or, 

Select Load from Image Gallery from the Edit menu. 

Or,  

Select Fill Template from Gallery from the Image Gallery menu. 

If an image of the specified type is in the Image Gallery, it appears in the placeholder. If the gallery contains more than 
one image of the appropriate type for an empty placeholder, the most recently-added image is used. Initially, the image 
appears using the Draw 1:1 sizing option, which may make it too big for the placeholder. In this case, you can resize it 
so that it fits properly. For more information, see "Sizing Images Within Placeholders" below. 

If no image of the specified type is in the Image Gallery, the placeholder remains empty. Later, you can add an image 

of that type to the gallery and click  to place it in the placeholder. 

To toggle rounded corners for the images: 

1. Select Image Corner Rounding... from the Format menu. 

Sizing Images Within Placeholders 
Two options determine how to size images within placeholders: 
Draw 1:1 This option scales the image according its resolution. Depending on the placeholder size, the image may 

be too large or small for the placeholder. 

Show Whole 
Image 

This option scales the image so that it is as large as possible and still fit entirely within the placeholder. 

To change the sizing option: 

1. Right-click the image. 

2. Select the sizing option from the pop-up menu. 

To change the placeholder size to match the image size: 

1. Right-click the image. 

2. Select Snap to Image Size from the pop-up menu. 

Displaying Image Borders 
You can display an image border that is the same size and shape as the image placeholder. 
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To toggle display of an image's borders: 

1. Right-click the image. 

2. Select Show Border from the pop-up menu. 

3. Deselect the image by clicking somewhere else on the page. 

When you deselect the image, the placeholder boundary disappears, and you can see whether the image border 
displays. 

Note: You can specify whether you want to display the borders for an image and set the image border's color and width by 
setting image properties. For more information, see "Setting Image Properties" on page 915 and "Layout Tab" on page 916. 

To toggle display of all image borders: 

1. Select Image Borders from the View menu. 

2. Select Show All from the cascade menu to show the borders on all the images. 

Or, 

Select Hide All from the cascade menu to hide the borders on all the images. 

Displaying Image Titles 
You can display an image title for each of the images. 
On the properties for an image, you can specify whether you want to display its title. For more information, see "Setting Image 
Properties" on page 915. 

To toggle display of all image titles: 

1. Select Image Titles from the View menu. 

2. Select Show All from the cascade menu to show the titles for all the images. 

Or, 

Select Hide All from the cascade menu to hide the titles for all the images. 

Displaying a Cross-Section Ruler 
The panoramic image for a cross-sections or nerve canals x-ray view can include a ruler that indicates the size and locations of 
the slice images. 
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To toggle display of the cross-sections ruler: 

1. Right-click the panoramic image. 

2. Select Show Cross Sections Ruler from the pop-up menu. 

To set properties for the cross-sections ruler: 

1. Right-click the panoramic image. 

2. Select Cross Sections Ruler Properties from the pop-up menu. 

3. Set any properties for the ruler. Then, click Close. 

Show Ruler Check this box to show the ruler on 
the panoramic image. 

Position Use this slider to specify the vertical 
location of the ruler on the 
panoramic image. 

Show base line Check this box to show the ruler's 
horizontal base line. 

Draw only visible 
cross sections 

Check this box to limit the cross 
sections indicated on the ruler to 
those appearing in the report. For 
example, if the report only includes 
the first five out of ten cross-section 
images, the ruler on the panoramic 
image only shows those first five 
cross sections. For more 
information, see "Displaying a 
Series of Slices" on page 924 and 
"Displaying a Collection of Slices" on 
page 924. 

Flip vertically Check this box to flip the ruler 180 
degrees vertically. 

Numbers rotated 
vertically 

Check this box to rotate the 
numbers on the ruler by 90 degrees. 

Ruler Color Click the color sample to select a 
color for the ruler. 

Line width (mm) Select the width of ruler's base line 
and tick marks. 

Draw large tick 
every n slices 

Specify the number of slices 
between large tick marks on the 
ruler. 
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Small tick length (mm) Specify the length of the small tick marks in millimeters (mm). 

Large tick length (mm) Specify the length of the large tick marks in millimeters (mm). 

Font Color Click the color sample to select a color for the numbers on the ruler. 

Font Displays the font selected for the numbers on the ruler. Click the button labeled ... to open 
the Font dialog box and change the font (see below). 

Font Size Select the font size for the numbers on the ruler. 

Group number 
indicator position 

Specify the location in relation to the ruler for the number that identifies the cross-section 
group when there is more than one. 

Show Background Check this box to use a background color to set off the ruler. 

Background Color Click the color sample to select a color for the background. 

To set font options: 

1. Click the button labeled ... next to the Font field. 

The Font dialog box opens. 

2. Set any font options. 

3. Click OK. 
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Font Select the font face. 

Font Style Select the font style. 

Size Select the font size. 

Strikeout Check this box to apply the strikeout effect. 

Underline Check this box to underline the text. 

Sample Displays a preview of your chosen settings. 

Script Select the script type. 

 

Setting Image Properties 
By setting image properties, you can specify the following information: 

• Layout options for formatting the image 

• Image source and title 

• Options for displaying a tracing on the image 

To set image properties: 

1. Right-click the image, and select Properties from the pop-up menu. 

Or, 

Double-click the image. 

2. Click a tab, and set any options on that tab. 

3. When you finish setting properties, click Close. 
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Layout Tab 
On this tab, you can view and set options that determine the formatting of the image on the report template. 
 

Dimensions 
group box 

Indicates the current position, height, and width 
of the image. 
X: The horizontal distance, in inches, from the 
left side of the image to the left side of the page. 
Y: The vertical distance, in inches, from the top 
of the image to the top of the page. 
Width: The width of the image in inches. 
Height: The height of the image in inches. 

Display 
group box 

Specify the following options for displaying this 
image: 
Print 1:1: Check this box to display the image 
according to its resolution. 
Show Border: Check this box to display a border 
around the image. 
Border Color: Click the color sample to select 
the color of the image border. 
Width: Specify the width of the border in 
millimeters (mm). 
Show Image Title: Check this box to display the 
title of the image. You can customize this title on 
the Image tab (see below). 
Show “image (not) to scale” label: Check this 
box to display "Image drawn to size" on images 
using the Print 1:1 option and "Image not drawn 
to size" on images that don't use the Print 1:1 
option. 
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Image Tab 
On this tab, you can set the image source and customize the image title. 
 

Image Source 
group box 

Specify the source of the image. 
Dolphin 2D: Select this option and choose an 
image from the drop-down list box to load that 
image from Dolphin 2D into this image 
placeholder. 
Show All: Check this box to include all 
Dolphin 2D image slots in the drop-down list 
box. Otherwise, the drop-down list box only 
includes the 2D images that are actually 
available for this patient.  
Dolphin 3D: Select this option and choose an 
image from the drop-down list box to load an 
image from Dolphin 3D into this image 
placeholder. 
From File: Select this option and click 
Browse... to choose an image file from your 
computer (such as a logo) to load into this 
image placeholder.  

Image Title Enter a custom title to use instead of the title 
embedded in the image. 
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Rulers Tab 
On this tab, you can set options displaying rulers on the image. 
 

Rulers Use these options to toggle the display of rulers on 
the image and set options for the appearance of 
those rulers. 
Left, Right, Top, and Bottom: Check these boxes 
to enable the display of a ruler along the specified 
edge of the image. 
Settings...: Click these buttons to set options for the 
appearance of the rulers (see below). 

To set ruler options: 

1. Check the box for the ruler you want to display on the image or cross 
sections. 

2. Click Settings... to specify the appearance of the ruler. 

The Ruler Settings dialog box opens. 

3. Set any options for the appearance of the ruler. 

4. Click Close. 
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Tickmarks 
group box 

Set options for the appearance of tick 
marks on the ruler. 
Draw small tick every: Specify the space, 
in millimeters (mm), between small tick 
marks on the ruler. 
Draw large tick every: Specify the space, 
in millimeters (mm), between large tick 
marks on the ruler. 
Small tick length (mm): Specify the 
length of the small tick marks in millimeters 
(mm). 
Large tick length (mm): Specify the 
length of the large tick marks in millimeters 
(mm). 
Draw Inside: Select this option to draw the 
rulers inside the image or cross sections 
boundary. With this option, the ruler may 
hide some anatomy. 
Draw Outside: Select this option to draw 
the rulers outside the image or cross 
sections boundary. With this option, the 
ruler will not to hide any anatomy, but it 
may appear off the paper or be hidden by 
other objects. 

Lines group 
box 

Set  the color and width of the tick mark 
lines on the ruler. 
Line Color: Click the color sample to 
select a color for the tick mark lines on the 
ruler. 
Line Thickness (mm): Specify the 
thickness of the tick mark lines in 
millimeters (mm). 

 
 
 

Numbering 
group box 

Set options for the appearance of numbers on the ruler. 
Draw numbers every n large ticks: Specify how often to place numbers on the ruler. 
Color: Click the color sample to select a color for the numbers on the ruler. 
Font: Displays the font selected for the numbers on the ruler. Click the button labeled ... to open the 
Font dialog box and change the font (see below). 
Font Size: Select the font size for the numbers on the ruler. 

Apply settings 
to all rulers for 
this image 

Check this box to use these ruler settings for all rulers on this image or cross sections. This makes 
all rulers on the image or cross sections look identical. 

Make these 
settings the 
program default 

Check this box to use these ruler settings as the defaults for all rulers on all new images or cross 
sections. You can override these default settings for individual rulers. 
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To set font options: 

1. Click the button labeled ... next to the Font field. 

The Font dialog box opens. 

2. Set any font options. 

3. Click OK. 

 
Font Select the font face. 

Font Style Select the font style. 

Size Select the font size. 

Strikeout Check this box to apply the strikeout effect. 

Underline Check this box to underline the text. 

Sample Displays a preview of your chosen settings. 

Script Select the script type. 
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Tracing Tab 
On this tab, you can set options for displaying a tracing on the image. 
 

Analysis 
group box 

Select the analysis for which you want to set tracing 
preferences from the Selected Analysis drop-down list 
box.  

Display group 
box 

Set options for each item you want to display on the 
tracing. 
Show Image: Check this box to display the image 
along with the tracing. 
Show Lines/Curves: Check this box to display the 
tracing as defined in the patient’s cephalometric 
analysis. 
Show Tooth Templates: Check this box to display 
the templates for the patient’s teeth. 
Show Add’l Ceph Structures: Check this box to 
display the cephalometric structures. 
Color Samples: Click these boxes to change the 
color in which the associated element is displayed.  
Tracing Line Width (mm): Enter the width in 
millimeters (mm) for the tracing lines. 

Measurements 
group box 

Set options for displaying measurements on the 
tracing: 
Show Measurements: Check this box to display 
measurement numbers as defined in the patient’s 
cephalometric analysis. 
Font: Displays the font selected for the measurement 
numbers. Click the button labeled ... to open the Font 
dialog box and change the font (see below). 
Font Size: Select the font size for the measurement 
numbers. 

To set font options: 

1. Click the button labeled ... next to the Font field. 

The Font dialog box opens. 

2. Set any font options. 

3. Click OK. 
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Font Select the font face. 

Font Style Select the font style. 

Size Select the font size. 

Strikeout Check this box to apply the strikeout effect. 

Underline Check this box to underline the text. 

Sample Displays a preview of your chosen settings. 

Script Select the script type. 

Adding Cross Sections to a Report Template 

To drag and drop cross sections from the gallery to your report template: 

1. Navigate to the page in your report template where you want the cross sections to appear. 

2. Click and drag the scroll bar to the right of the image gallery until the cross sections you want to add to your report 
template appears.  

3. Drag the cross sections from the gallery and drop it onto the page. 

Or, 

Drag the cross sections from the gallery and drop it into an existing cross sections placeholder on the page. 
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To use the tool bar or menus to add cross sections to your report template: 

1. Navigate to the page in your report template where you want the cross sections to appear. 

2. Click . 

Or, 

Select Cross Sections from the Insert menu. 

Or, 

Right-click the report page and select Add Image Group from the pop-up menu. 

Your cursor changes to a placeholder-drawing icon ( ). 

3. Click and drag to draw a cross sections placeholder of the size you want for these cross sections. 

4. Right-click the cross sections placeholder. 

5. Select Image Type from the pop-up menu. Then, select the type of cross sections (Cross Sections, Left Cross 
Sections, or Right Cross Sections) you want to use from the cascade menu. 

You can also set the image type for a placeholder by setting its properties. For more information, see "Setting Image 
Properties” on page 915. 

6. Click . 

Or, 

Select Load from Image Gallery from the Edit menu 

If cross sections of the specified type are in the Image Gallery, they appear in the placeholder.  If the gallery contains 
more than one set of cross sections of the appropriate type for an empty placeholder, the most recently-added set is 
used. Slice images are always rendered 1:1 according to the image resolution. 

If no cross sections of the specified type are in the Image Gallery, the placeholder remains empty. Later, you can add 

cross sections of that type to the gallery and click  to place them in the placeholder. 
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Displaying a Series of Slices 
The Dolphin 3D Report Editor enables you to display a series of slices by selecting the starting slice and specifying the number 
of slices to display. 

To specify a series of slices to display: 

1. Right-click the cross sections on the report page, and select Pick Starting Slice from the pop-up menu. 

2. From the cascade menu, select the number of the first slice in the series you want to display. 

The slice you picked appears in the upper left of the cross sections series followed by as many of the remaining slices 
from the series as can fit within the cross sections placeholder's current dimensions without cropping any slice. To limit 
the number of slices to display or format them differently, see "Formatting the Slices" on page 925. 

Displaying a Collection of Slices 
The Dolphin 3D Report Editor enables you to select individual slices from a cross sections series to display as a collection. 

To pick the slices to display: 

1. Right-click the cross sections on the report page, and select Pick Slice... from the pop-up menu. 

A dialog box opens where you can pick the slices you want.  

2. Pick the slices you want to display.  

Click individual slices to toggle whether they are selected or deselected. Selected slices are outlined in blue. 
Deselected slices are outlined in red. 

3. Click OK. 

The cross sections placeholder displays as many selected slices as can fit within its current dimensions without 
cropping any slice. To format the display differently, see "Formatting the Slices" on page 925. 
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+ Click this button to zoom in on the slice images. 

- Click this button to zoom out on the slice images. 

Select All Click this button to select all the slices in the series, 

Deselect All Click this button to deselect all the slices in the cross sections series. 

Toggle 
Selected 

Click this button to change the selection status for all the slices in the cross sections series, selecting 
those that were deselected and deselecting those that were selected. 

Formatting the Slices 

To set formatting options for cross sections: 

1. Right-click the cross sections on the report page, and select Properties from the pop-up menu. 

Or, 

Double-click the cross sections. 

The Properties dialog box opens. For more information on the properties you can set, see "Setting Cross Sections 
Properties" on page 927. 
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To show as many slices as possible within the cross sections placeholder's current dimensions without cropping any 
slice:  

1. In the Layout group box on the General tab, select the No cropping option. 

To specify the number of rows and columns: 

1. In the Layout group box on the General tab, select the Define rows and columns option. 

2. Set the number of rows and columns for the cross sections so that the placeholder can accommodate only the slices 
that you want to appear. 

Setting the number of rows and columns may cause the slices to be cropped. 

3. If the slices are cropped, resize the placeholder to display more of the slice images (see "Resizing Objects" on page 
942). 

Or, 

Hold down the Shift key, then click and drag a slice to select the part of each slice to display.  

To toggle the slices between ascending and descending order: 

1. Right-click the cross sections on the report page, and select Reverse Slice Order from the pop-up menu. 

Splitting a Cross Sections Series 
You can easily split a cross sections series across two pages in your report template. The Dolphin 3D Report Editor creates a 
new page to contain the second half of the series of cross sections. 

To split a cross sections series: 

1. Right-click the cross sections on the report page, and select Split from the pop-up menu. 

2. Select Copy entire page layout from the cascade menu to create a new page with the second half of the cross sections 
series, along with copies of all the objects on the page. 

Or, 

Select Exclude non-group images from the cascade menu to create a new page with the second half of the cross 
sections series, along with any labels and logos on the page. 

For a particular text label, you can specify whether to include it during a split. 

To omit a text label during a cross sections split: 

1. Right-click the text label placeholder, and select Can delete during group split from the pop-up menu. 



32 Designing and Printing Reports Part X: 3D 

DI_USER_GUIDE-11.5   Rev. 1.01 927 

Setting Cross Sections Properties 
By setting cross sections properties, you can specify the following information: 

• General options for formatting the cross sections 

• Options for image labels 

• Options displaying rulers on the cross sections 

To set cross sections properties: 

1. Right-click the cross sections on the report page, and select Properties from the pop-up menu. 

Or, 

Double-click the cross sections. 

2. Click a tab, and set any options on that tab. 

3. When you finish setting properties, click Close. 
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General Tab 
On this tab, you can view and set general options that determine the formatting of cross sections on the report template. 
 

Dimensions 
group box 

Indicates the current position, height, and width 
of the cross sections. 
X: The horizontal distance, in inches, from the 
left side of the cross sections to the left side of 
the page. 
Y: The vertical distance, in inches, from the top 
of the cross sections to the top of the page. 
Width: The width of the cross sections in 
inches. 
Height: The height of the cross sections in 
inches. 

3D Image Type 
group box 

Select the type of cross sections from the drop-
down list box to load them into this placeholder. 

Layout group 
box 

Specify the following options for displaying 
these cross sections: 
No cropping: Select this option to display as 
many slices as possible within the placeholder's 
current dimensions without cropping any slice. 
Define rows and columns: Select this option 
to display the cross sections in the specified 
number of rows and columns. Some slices may 
be cropped if the space allotted for each slice is 
less than its actual size. If the space allotted for 
each slice is larger than its actual size, there will 
be blank space between the slices. 
If selecting this option causes the slices to be 
cropped, hold down the Shift key, then click and 
drag a slice to select the part of each slice to 
display. This may enable you to fit more slices 
on a page while still displaying the relevant 
anatomy. 
Rows: The number of rows to allot for the cross 
sections. 
Columns: The number of columns to allot for 
the cross sections. 

Background 
group box 

Background Color: Click the color sample to 
select the color of the cross sections' 
background. 
Border Size: Specify the width in millimeters 
(mm) of the border of background color that you 
want to appear around the cross sections. 
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Labels Tab 
On this tab, you can set options for the labeling slices. 
 

Image 
Number 
Display 
group box 

Specify the following options for slice number labels. 
Color: Click the color sample to select the color of the 
slice numbers. 
Size: Select the font size for the slice numbers. 
Font: Displays the font selected for the slice numbers. 
Click the button labeled ... to open the Font dialog box 
and change the font (see below). 
Label Background: Check this box to use a 
background color to set off the slice numbers. Click 
the color sample to select the color to use. 
Location: Click the button for the location in which 
you want the slice numbers to appear. 

Image 
Orientation 
Info group 
box 

Specify the following options for displaying image 
orientation information labels (usually "L"’ for lingual or 
"B"’ for buccal). 
Show: Check this box to display image orientation 
information labels. 
Color: Click the color sample to select the color of the 
labels. 
Font: Displays the font selected for the labels. Click 
the button labeled ... to open the Font dialog box and 
change the font (see below). 
Label Background: Check this box to use a 
background color to set off the labels. Click the color 
sample to select the color to use. 
Top: Select this option to place the labels at the top of 
the slice images. 
Center: Select this option to place the labels at the 
center of the slice images. 
Bottom: Select this option to place the labels at the 
bottom of the slice images. 

 

To set font options: 

1. Click the button labeled ... next to the Font field. 

The Font dialog box opens. 

2. Set any font options. 

3. Click OK. 
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Font Select the font face. 

Font Style Select the font style. 

Size Select the font size. 

Strikeout Check this box to apply the strikeout effect. 

Underline Check this box to underline the text. 

Sample Displays a preview of your chosen settings. 

Script Select the script type. 
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Rulers Tab 
On this tab, you can set options for displaying rulers on the cross sections. 
 

Rulers Use these options to toggle the display of rulers and set 
options for the appearance of those rulers. 
Left, Right, Top, and Bottom: Check these boxes to 
enable the display of a ruler along the specified edge of 
the cross sections. 
Settings...: Click these buttons to set options for the 
appearance of the rulers (see below). 
Each Slice: Select this option to display rulers on each 
slice. 
Whole group: Select this option to display rulers on the 
cross sections series as a whole. 

To set ruler options: 

1. Check the box for the ruler you want to display on the image or cross 
sections. 

2. Click Settings... to specify the appearance of the ruler. 

The Ruler Settings dialog box opens. 

3. Set any options for the appearance of the ruler. 

4. Click Close. 
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Tickmarks 
group box 

Set options for the appearance of tick 
marks on the ruler. 
Draw small tick every: Specify the space, 
in millimeters (mm), between small tick 
marks on the ruler. 
Draw large tick every: Specify the space, 
in millimeters (mm), between large tick 
marks on the ruler. 
Small tick length (mm): Specify the 
length of the small tick marks in millimeters 
(mm). 
Large tick length (mm): Specify the 
length of the large tick marks in millimeters 
(mm). 
Draw Inside: Select this option to draw the 
rulers inside the image or cross sections 
boundary. With this option, the ruler may 
hide some anatomy. 
Draw Outside: Select this option to draw 
the rulers outside the image or cross 
sections boundary. With this option, the 
ruler will not to hide any anatomy, but it 
may appear off the paper or be hidden by 
other objects. 

Lines group 
box 

Set  the color and width of the tick mark 
lines on the ruler. 
Line Color: Click the color sample to 
select a color for the tick mark lines on the 
ruler. 
Line Thickness (mm): Specify the 
thickness of the tick mark lines in 
millimeters (mm). 

 
 
 

Numbering 
group box 

Set options for the appearance of numbers on the ruler. 
Draw numbers every n large ticks: Specify how often to place numbers on the ruler. 
Color: Click the color sample to select a color for the numbers on the ruler. 
Font: Displays the font selected for the numbers on the ruler. Click the button labeled ... to open the 
Font dialog box and change the font (see below). 
Font Size: Select the font size for the numbers on the ruler. 

Apply settings 
to all rulers for 
this image 

Check this box to use these ruler settings for all rulers on this image or cross sections. This makes 
all rulers on the image or cross sections look identical. 

Make these 
settings the 
program default 

Check this box to use these ruler settings as the defaults for all rulers on all new images or cross 
sections. You can override these default settings for individual rulers. 
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To set font options: 

1. Click the button labeled ... next to the Font field. 

The Font dialog box opens. 

2. Set any font options. 

3. Click OK. 

 
Font Select the font face. 

Font Style Select the font style. 

Size Select the font size. 

Strikeout Check this box to apply the strikeout effect. 

Underline Check this box to underline the text. 

Sample Displays a preview of your chosen settings. 

Script Select the script type. 
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Enhancing Images 
After adding images or cross sections to a report template, you can enhance them, if needed. If you enhance cross sections, the 
enhancements are applied to all images in the series. 

To enhance an image or cross sections: 

1. Enhance Selected Image(s)... from the Edit menu. 

Or, 

Right-click the image or cross sections. Then, select Enhance... from the pop-up menu. 

The Enhance Image dialog box opens. 

2. Set enhancement options. Then, click Done. 

Brightness Move the slider to adjust the brightness of the image. 

Contrast Move the slider to adjust the light/dark contrast of the image. 

Saturation Move the slider to adjust the color saturation of the image.  

Gamma Move the slider to adjust the light/dark contrast of the image. 

Sharpen Click + to increase the sharpness of the image. Click - to 
decrease it. 

Reset to 
Original 

Click this button to undo all enhancement operations. 

 



32 Designing and Printing Reports Part X: 3D 

DI_USER_GUIDE-11.5   Rev. 1.01 935 

Using Text Labels 
With text labels, you can add static text to your report templates and you can pull in data from the current patient's record, such 
as the patient's name and age. You can also add other variable information such as the page number or print date. 

To add a text label: 

1. Navigate to the page in your report template where you want the text label to appear. 

2. Click . 

Or, 

Click . Then, select Text from the pop-up menu. 

Or, 

Select Label from the Insert menu. 

Or, 

Right-click the report page, and select Add Label from the pop-up menu. 

Your cursor changes to a label-drawing icon ( ). 

3. Click and drag to draw a text label placeholder of the size you want. 

4. Double-click the text label placeholder. 

Or, 

Right-click the text label placeholder, and select Properties from the pop-up menu. 

The Properties dialog box opens. 

5. (Optional) Enter any static text you want to appear for this label in the Edit Text box. 

6. (Optional) In the Edit Text box, place the cursor where you want to insert data from the patient record or other variable 
information (such as the date). Then, select a data field from the Data Field drop-down list box, and click Insert at 
cursor to insert that data field at the current cursor location. 

The Preview box shows the text that will appear for this text label when the selected data fields are replaced with the 
appropriate data. 

Note: If one or more data fields in a label reference data in a patient's record (such as the patient's name, age, or 
doctor) or data specific to a particular image (such as the image title or analysis), you need to link the label to a patient 
image so that the data fields can be replaced by the appropriate information. For more information, see “Linking Labels 
to an Image” on page 938. 

7. Set any other properties for the text label. Then, click Close. 



Dolphin Imaging User's Guide April 2011 

936 DI_USER_GUIDE-11.5   Rev. 1.01 

 
Dimensions 
group box 

Indicates the current position, 
height, and width of the text 
label. 
X: Enter the horizontal distance, 
in inches, from the left side of 
the text label to the left side of 
the page. 
Y: Enter the vertical distance, in 
inches, from the top of the text 
label to the top of the page. 
Width: Enter the width of the 
text label in inches. 
Height: Enter the height of the 
text label in inches. 

Alignment 
group box 

Click the button for the location 
that you want the text label to 
appear within its placeholder. 

Font group 
box 

Specify the font for the text 
label. 
Text box: Displays the font 
selected for the text label. 
...: Click this button to open the 
Font dialog box and change the 
font (see below). 
spinner: Select the font size. 
Color: Click the color sample to 
select the color of the text. 
Bold: Check this box to use 
boldface for the text label. 
Italic: Check this box to use 
italics for the text label. 
Underline: Check this box to 
use underlining for the text 
label. 
Strikeout: Check this box to 
use a strikeout effect for the text 
label. 

 
Border 
group box 

Specify options for placing a border around the text label. 
Show Border: Check this box to display a border around the text label. 
Border Color: Click the color sample to select the color of the text label border. 
Width: Specify the width of the border in millimeters (mm). 

Background 
group box 

Specify options for using a background color to set off the label.  
Show Background: Check this box to use a background color.  
Color: Click the color sample to select the color to use. 
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Edit Text 
group box 

Specify the text you want for this text label. 
Text Box: Enter the text for this label. 
Data Field: Select a data field from this drop-down list box to insert data from the patient record or other 
variable data. 
Insert at cursor: Click this button to insert the selected data field at the current cursor location in the text 
box. 
Preview: Shows a preview of the text that will appear for this text label when the data fields are replaced 
with the appropriate data. 

To toggle display of all text labels: 

1. Select Show Labels from the View menu to show all the text labels. 

Or, 

Select Hide Labels from the View menu to hide all the text labels. 

Hiding labels is useful, for example, to hide patient information for privacy reasons. 

To set the horizontal alignment of the text in a label placeholder: 

1. Right-click the text label. 

2. Select Horizontal Alignment from the pop-up menu. 

3. Select Left from the cascade menu to align the text to the left. 

Or, 

Select Center from the cascade menu to align the text in the center. 

Or, 

Select Right from the cascade menu to align the text to the right. 

To set the vertical alignment of the text in a label placeholder: 

1. Right-click the text label. 

2. Select Vertical Alignment from the pop-up menu. 

3. Select Top from the cascade menu to align the text on the top. 

Or, 

Select Center from the cascade menu to align the text in the center. 

Or, 

Select Bottom from the cascade menu to align the text on the bottom. 
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Linking Labels to an Image 
If one or more data fields in a label reference data in a patient's record (such as the patient's name, age, or doctor) or data 
specific to a particular image (such as the image title or analysis), you need to link the label to a patient image so that the data 
fields can be replaced by the appropriate information. You can link more than one text label to a particular image in a single step.  

To link one or more text labels to an image: 

1. Click an object that you want to link. Then, hold down the CTRL key while clicking other objects to select them as well. 

You can select several text labels, but only one image. 

Note: If you select a label that is already linked to an image, the existing link will be replaced by the new link you are 
creating.  

2. Select Link Labels to Image from the Tools menu. 

A line appears between each text label and the image. 

 

To remove the link between one or more text labels and an image: 

1. Click a text label that you want to unlink.  

2. Optionally, hold down the CTRL key while clicking other text labels to select them as well. 

3. Select Unlink Labels from Image from the Tools menu. 
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Using Annotations 
With annotations, you can add lines, arrows, ellipses, and rectangles to your report templates. You can also add text labels as 
described in "Using Text Labels." 

To add a line: 

1. Click . Then, select Line from the pop-up menu. 

Your cursor changes to a drawing icon ( ). 

2. Click and drag to draw the line. 

You can set the line's color, thickness, or style (solid, dashed, or dashed-dotted) by setting its properties. For more 
information, see "Setting Image Properties" on page 915. 

To make the line horizontal or vertical and lock it that way: 

1. Right-click the line, and select Lock Orientation from the pop-up menu. 

2. Select Horizontal from the cascade menu to lock the line in a horizontal orientation. 

Or, 

Select Vertical from the cascade menu to lock the line in a vertical orientation. 

At this point, you can move the line and it will stay in its locked orientation. 

To add an arrow: 

1. Click . Then, select Arrow from the pop-up menu. 

Your cursor changes to a drawing icon ( ). 

2. Click and drag to draw the arrow. 

You can set the arrow's color, thickness, style (solid, dashed, or dashed-dotted), and arrowhead characteristics by 
setting its properties. For more information, see "Setting Image Properties" on page 915. 
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To make the arrow horizontal or vertical and lock it that way: 

1. Right-click the arrow, and select Lock Orientation from the pop-up menu. 

2. Select Horizontal from the cascade menu to lock the arrow in a horizontal orientation. 

Or, 

Select Vertical from the cascade menu to lock the arrow in a vertical orientation. 

At this point, you can move the arrow and it will stay in its locked orientation. 

To add an ellipse: 

1. Click . Then, select Ellipse from the pop-up menu. 

Your cursor changes to a drawing icon ( ). 

2. Click and drag to draw the ellipse. 

You can set the ellipse's line color, thickness, or style (solid, dashed, or dashed-dotted) by setting its properties. For 
more information, see "Setting Image Properties" on page 915. 

To add a rectangle: 

1. Click . Then, select Rectangle from the pop-up menu. 

Your cursor changes to a drawing icon ( ). 

2. Click and drag to draw the rectangle. 

You can set the rectangle's line color, thickness, or style (solid, dashed, or dashed-dotted) by setting its properties. For 
more information, see "Setting Image Properties" on page 915. 

To change the shape of an annotation: 

1. Right-click the annotation. 

2. Select Shape from the pop-up menu. Then, select the shape you want from the cascade menu. 

You can also change an annotation's shape by setting its properties (see below). 
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Setting Annotation Properties 
Once you have drawn a line, arrow, ellipse, or rectangle, you can set its properties to specify the line color, thickness, or style 
(solid, dashed, or dashed-dotted). In the case of arrows, you also can set the arrowhead characteristics. 

To set annotation properties: 

1. Double-click the annotation. 

The Properties dialog box opens. 

2. Set any properties for the annotation. Then, click Close. 

Shape group 
box 

Specify the annotation shape (line, arrow, ellipse, or 
rectangle). 

Line Settings 
group box 

Specify options for the line or lines used to draw the 
annotation. 
Color: Click the color sample to select the color. 
Thickness: Specify the width of the line or lines in 
millimeters (mm). 
Line Style: Specify the line style (solid, dashed, or 
dashed-dotted). 

Arrow 
Settings 
group box 

Specify arrowhead characteristics. These options 
are only available for arrows. 
Head Width: Specify the width of the arrowhead in 
millimeters (mm). 
Head Length: Specify the length of the arrowhead 
in millimeters (mm). 
Filled: Select this option for a solid arrowhead. 
Outline: Select this option for an arrowhead outline. 
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Resizing Objects 
To resize a single object, you can click and drag its resizing handles as described below, or you can set its properties (see 
"Using Text Labels" on page 935, "Setting Image Properties" " on page 915, "Setting Cross Sections Properties" on page 927, 
and "Setting Annotation Properties" on page 941).  You also can set several objects to be the same size. 

Using the Resizing Handles 

To resize an object using the resizing handles: 

1. Click and drag one of the resizing handles to resize the object. 

When you place your mouse pointer over a resizing handle, the pointer turns into a double-headed arrow. The figure 
below illustrates the resizing handles.  

 
Note: You can also use the object properties to specify the size of an object. For more information, see"Using Text Labels" on 
page 935, "Setting Image Properties" " on page 915, "Setting Cross Sections Properties" on page 927, and "Setting Annotation 
Properties" on page 941. 
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Making Several Objects the Same Size 

To make several objects the same size: 

1. Click one of the objects that you want to resize.  

2. Hold down the CTRL key while clicking the other objects that you want to resize. 

Select the object to which you want to resize the other objects first. The objects you subsequently select will be resized 
to match the object you selected first. 

3. Click  to make the objects the same width. 

Or, 

Select Make Same Size from the Format menu. Then, select Width from the cascade menu to make the objects the 
same width.  

Or, 

Click  to make the objects the same height. 

Or, 

Select Make Same Size from the Format menu. Then, select Height from the cascade menu to make the objects the 
same height.  

Or, 

Click  to make the objects the same width and height. 

Or, 

Select Make Same Size from the Format menu. Then, select Both from the cascade menu to make the objects the 
same width and height.  
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Repositioning Objects 
To reposition objects, you can click and drag them, align them with each other, or center them on the page. You can reposition a 
single object by clicking and dragging or by setting its properties ("Using Text Labels" on page 935, "Setting Image Properties" " 
on page 915, "Setting Cross Sections Properties" on page 927, and "Setting Annotation Properties" on page 941).  
You also can change the layering of objects to control how they overlap. 

Clicking and Dragging Objects 

To move a single object: 

1. Click and drag the object to a new position in the report template. 

Note: You can also use the object properties to specify the location of an object. For more information, see "Using Text Labels" 
on page 935, "Setting Image Properties" " on page 915, "Setting Cross Sections Properties" on page 927, and "Setting 
Annotation Properties" on page 941. 

To move several objects: 

1. Click one of the objects that you want to move. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects in this report template. 

2. Click and drag the objects to a new position in the report template. 

Aligning Objects 
You can align several objects with each other or with the page margins. 

To align two or more objects: 

1. Click one of the objects that you want to align.  

2. Hold down the CTRL key while clicking the other objects that you want to align. 

Select the object to which you want to align the other objects first.  

3. Click  to align the left sides of the objects. 

Or, 

Select Align from the Format menu. Then, select Left from the cascade menu to align the left sides of the objects.  

Or, 

Click  to align the right sides of the objects. 
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Or, 

Select Align from the Format menu. Then, select Right from the cascade menu to align the right sides of the objects.  

Or, 

Click  to align the tops of the objects. 

Or, 

Select Align from the Format menu. Then, select Top from the cascade menu to align the tops of the objects.   

Or, 

Click  to align the bottoms of the objects. 

Or, 

Select Align from the Format menu. Then, select Bottom from the cascade menu to align the bottoms of the objects.   

To align the objects to that page margin: 

1. Click the object that you want to align to the page margin.  

2. Optionally, hold down the CTRL key while clicking the other objects that you want move when aligning the first-
selected object to the page margin. 

If you select more than one object, the objects retain their placement relative to each other when the object selected 
first is aligned to the margin.  

3. Select Snap To from the Format menu.  

4. Select Margin, then select Left, Right, Top, or Bottom to align to that page margin.   

Or, 

Select Printer Hard Margin. Then, select Left, Right, Top, or Bottom to align to that printer hard margin.   

If you have specified a printer on the page setup dialog box, the hard margins specify how close to the paper edge the 
specified printer can print. Otherwise, the hard margins are at the paper edges. 
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Centering Objects 
You can center one or more objects horizontally or vertically. 

To center objects: 

1. Click an object that you want to center. 

Or, 

Click an object that you want to center. Then, hold down the CTRL key while clicking other objects to select them as 
well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Select Center from the Format menu. 

3. Select Horizontally from the cascade menu to center horizontally. 

Or, 

Select Vertically from the cascade menu to center vertically. 

Changing Object Spacing 
You can change the spacing of objects either horizontally or vertically. 

To change the horizontal spacing of several objects: 

1. Click and drag to select several adjacent objects. 

Or, 

Click one of the objects that you want to select. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Select Horizontal Spacing from the Format menu. 



32 Designing and Printing Reports Part X: 3D 

DI_USER_GUIDE-11.5   Rev. 1.01 947 

3. Select Make Equal to space the selected objects evenly. 

Or, 

Select Increase to increase the space between the selected objects. 

Or, 

Select Decrease to decrease the space between the selected objects. 

Or, 

Select Remove to remove the space between the selected objects, making them flush with each other. 

To change the vertical spacing of several objects: 

1. Click and drag to select several adjacent objects. 

Or, 

Click one of the objects that you want to select. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Select Vertical Spacing from the Format menu. 

3. Select Make Equal to space the selected objects evenly. 

Or, 

Select Increase to increase the space between the selected objects. 

Or, 

Select Decrease to decrease the space between the selected objects. 

Or, 

Select Remove to remove the space between the selected objects, making them flush with each other. 
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Changing Object Layering 
You can change the layering of objects to control how they overlap. 

To change the layering of objects: 

1. Click the object that you want to move to the front or back. 

2. Select Order from the Format menu. 

3. Select Bring to Front from the cascade menu to bring the selected object to the front. 

Or, 

Select Send to Back to send the selected object to the back. 

Deleting Objects 
You can delete a single object, or you can delete several objects simultaneously. 

To delete a single object: 

1. Click an object, and click . 

Or, 

Right-click an object, and select Delete from the pop-up menu to delete it. 

Or, 

Click an object to select it. Then, press DEL on your keyboard. 

Or, 

Click an object to select it. Then, select Delete from the Edit menu. 

A dialog box opens asking you to confirm the deletion. 

2. Click Yes to delete the object. 
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To delete several objects: 

1. Click and drag to select several adjacent objects. 

Or, 

Click one of the objects that you want to select. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Click . 

Or, 

Select Delete from the Edit menu.. 

Or, 

Press DEL on your keyboard. 

A dialog box opens asking you to confirm the deletion. 

3. Click Yes to delete the selected objects. 

Cutting, Copying, and Pasting Objects 
You can cut or copy one or more objects to the clipboard. Then, you can paste them elsewhere in your design. 

To cut or copy objects to the clipboard: 

1. Click an object to select it. 

Or, 

Click and drag to select several adjacent objects. 

Or, 

Click one of the objects that you want to select. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Select Cut from the Edit menu to cut the objects to the clipboard, removing them from their present locations. 

Or, 

Select Copy from the Edit menu to copy the objects to the clipboard, leaving them in their present locations. 
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To paste objects from the clipboard: 

1. Select Paste from the Edit menu to paste the objects from the clipboard into the current location. 

Using Object Groups 
Grouping objects enables you to combine several objects into a single object. Then, you can use the objects in the group as a 
unit, or save the object group for later reuse. 

To group several objects: 

1. Click and drag to select several adjacent objects. 

Or, 

Click one of the objects that you want to select. Then, hold down the CTRL key while clicking other objects to select 
them as well. 

Or, 

Select Select All from the Edit menu to select all objects. 

2. Select Group Objects from the Group menu. 

To ungroup the objects in an object group: 

1. Click one of the objects in the object group to select the group. 

2. Select Ungroup Objects from the Group menu. 

To save an object group for later reuse: 

1. Click one of the objects in the object group to select the group. 

2. Select Save Group As... from the Group menu. 

The Save Group As dialog box opens. 

3. Enter a name for this object group in the Group name text box. 

Or, 

Select an object group from the Existing Groups list box to overwrite an existing object group. 

4. Click Save. 

5. If you are overwriting an existing group, click Yes on the confirmation dialog box that appears. 
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Existing Groups Select an object group from this list box to overwrite or delete an existing object group. 

Delete Click this button to delete the object group selected in the Existing Groups list box. 

Group name Enter a name in this text box to save this object group under a new name. 

Save Click this button to save the object group. 

To insert a previously-saved object group into your design: 

1. Select Insert Group from the Groups menu.  

Or, 

Select Group from the Insert menu. 

2. Select the object group you want to insert from the cascade menu. 

To delete a previously-saved object group: 

1. Click an object group. 

2. Select Save Group As... from the Group menu. 

The Save Group As dialog box opens. 

3. Select the object group you want to delete from the Existing Groups list box. 

4. Click Delete. 
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Locking and Unlocking Objects 
Locking objects prevents them from being moved or resized, avoiding accidental misalignment of images. You can still drag 
images or cross sections from the Image Gallery to a locked placeholder or change a locked object's properties.  

To lock one or more objects: 

1. Click an unlocked object to select it. 

Or, 

Click and drag to select several adjacent unlocked objects. 

Or, 

Click one of the unlocked objects that you want to select. Then, hold down the CTRL key while clicking other unlocked 
objects to select them as well. 

2. Click . 

Or, 

Right-click and select Locked from the pop-up menu. 

To unlock one or more objects: 

1. Click a locked object to select it. 

Or, 

Click and drag to select several adjacent locked objects. 

Or, 

Click one of the locked objects that you want to select. Then, hold down the CTRL key while clicking other locked 
objects to select them as well. 

When you select a locked object, the tool bar button has a blue outline as follows: . 

2. Click . 

Or, 

Right-click and select Locked from the pop-up menu. 
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Setting Options 
You can set options for all your report templates and for the Dolphin 3D Report Editor itself.  

To set options: 

1. Select Options... from the Tools menu. 

The Options dialog box opens. This dialog box offers the following tabs: 

General Specifies general options for the behavior of the Dolphin 3D Report Editor and sets image and page 
options for all reports. 

Fonts Specifies default fonts used on all reports. 

2. Click any tab to set options on it. 

3. Close the dialog box when you finish setting options.  

General Tab 
On this tab, you can specify general options for the behavior of the Dolphin 3D Report Editor and set image and page options for 
all reports. 

 

Bring report 
dialog to front 
when adding 
images 

Check this box to open the Dolphin 3D 
Report Editor window or restore it from the 
system tray every time you send an image 
to it. 

Save report 
window state 
when exiting 
3D 

Check this box to save the state of the 
Dolphin 3D Report Editor window when you 
exit Dolphin 3D so that it returns to that state 
the next time you use it.  
Include Image cache ribbon: Check this 
box to save the Dolphin 3D images in the 
Image Gallery when saving the Dolphin 3D 
Report Editor window's state. 
Include 2D Dolphin images: Check this 
box to save the Dolphin 2D images in the 
Image Gallery when saving the Dolphin 3D 
Report Editor window's state. 

Show Image 
Titles by 
default 

Check this box to display image titles on all 
images by default. You also can toggle the 
display of image titles for all images in a 
report by selecting Image Titles from the 
View menu (see "Displaying Image Titles"on 
page 912) or for a single image by setting its 
properties (see "Setting Image Properties" 
on page 915). 
 
 
 



Dolphin Imaging User's Guide April 2011 

954 DI_USER_GUIDE-11.5   Rev. 1.01 

 

Fonts Tab 
On this tab, you can specify default fonts. 

 

To set font options: 

1. Click the button labeled ... next to the Font field. 

The Font dialog box opens. 

2. Set any font options. 

3. Click OK. 

Show "Drawn to Scale" 
by default 

Check this box to display "Image drawn to size" on images using the Print 1:1 option and 
"Image not drawn to size" on images that don't use the Print 1:1 option by default on all 
images. You can specify whether to show these labels for individual images by setting their 
properties (see "Setting Image Properties" on page 915). 

Show page number on 
single-page reports 

Check this box to display a page number even if a report is only one page long. 

Image Titles 
group box 

Use this group box to set font options for the 
titles that can appear on images. 
Color: Click the color sample to select a color 
for the image titles. 
Size: Select the font size for the image titles. 
Offset Color: Check this box to use a 
background color to set off the image titles. 
Click the color sample to select a background 
color. 
Font: Displays the font selected for the image 
titles. Click the button labeled ... to open the 
Font dialog box and change the font (see 
below). 

Drawn to 
scale label 
group box 

Use this group box to set font options for the 
"Image drawn to size" and "Image not drawn to 
size" labels that can appear on images. 
Color: Click the color sample to select a color 
for these labels. 
Size: Select the font size for these labels. 
Offset Color: Check this box to use a 
background color to set off these labels. Click 
the color sample to select a background color. 
Font: Displays the font selected for these 
labels. Click the button labeled ... to open the 
Font dialog box and change the font (see 
below). 
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Font Select the font face. 

Font Style Select the font style. 

Size Select the font size. 

Strikeout Check this box to apply the strikeout effect. 

Underline Check this box to underline the text. 

Sample Displays a preview of your chosen settings. 

Script Select the script type. 
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Printing Reports 

To print a report: 

1. Click . 

Or, 

Select Print from the File menu.  

The Print dialog box is displayed. 

2. Select any printing options you want, and click OK. 

You can preset printers for individual report pages, so that different pages in a single report can be sent to different printers. For 
example, you can send pages with x-rays to one type of printer and pages with photographs and images of the volume to 
another while still maintaining the numbering of the pages. For information on presetting printers for report pages, see "Setting 
Up the Page" on page 905. 

To print a report, directing pages to preset printers if appropriate: 

1. Select Print to preset printer(s) from the File menu. 

To suppress printing of a page: 

1. Click the page you want to suppress in the page gallery. 

The  icon appears on the page to indicate that the page will not print when you print the report. 

To remove printing suppression for a page: 

1. Click a page with the  icon that you want to print when you print the report. 

Or, 

Right-click a page with a  icon. Then, select Include Page in Printout from the pop-up menu. 
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Part XI: Security 
This part of the Dolphin Imaging User’s Guide describes how to set up Dolphin Imaging security utilities. Using these utilities, you 
can create employee types that group employees with similar job functions. Then, you can enter information about each 
employee in your practice, setting up a Dolphin Imaging login ID, specifying the areas of the system that the employee can 
access, and so on.  
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33 Security Setup 
If you have purchased the Dolphin Imaging security utilities, you can explicitly mandate that each user log in to Dolphin Imaging 
by entering an assigned unique ID and password. Alternatively, you can specify that Dolphin Imaging users log in using a 
fingerprint ID. 
You can assign (and require) specific access rights to use any aspect the Dolphin Imaging software and data. In this way, you 
can limit access to patient data only to those staff members with a need to know. 
This section describes how to set up security for your Dolphin Imaging system. It describes: 

• Setting up locations 

• Setting up employee types, which group employees based on their job function 

• Setting up individual employee accounts 

Setting Up Password Requirements 
By establishing password requirements, you can ensure that your employees pick passwords that are hard to guess, thus 
increasing the security of your Dolphin Imaging data. 

To set up password requirements: 

1. Select Password Setup... from the Edit menu. 

2. Enter any password requirements that you want to establish. Then, click OK. 

As you enter values, the Example Password text box displays an example of a password that meets the specified 
requirements. In addition, other fields may change as you enter requirements. For example, if you enter 2 in the 
Minumum # of alphabetic characters text box, the Minumum password length text box also changes to 2. 
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Minumum # of alphabetic 
characters 

Enter the minimum number of letters that user passwords must contain. 

Minumum # of  upper-case 
alphabetic characters 

Enter the minimum number of capital letters that user passwords must contain. 

Minumum # of  lower-case 
alphabetic characters 

Enter the minimum number of lower-case letters that user passwords must contain. 

Minumum # of numeric digits Enter the minimum number of numbers (digits) that user passwords must contain. 

Minumum # of non-alphanumeric 
characters 

Enter the minimum number of special characters (not letters or numbers) that user 
passwords must contain. 

Minumum password length Enter the minimum number of characters that user passwords must contain. 

Maximum password age (days) Enter the number of days before a password expires and the user is forced to 
change it. Enter 0 if you do not want passwords to expire. 

Example Password Displays an example of a password that meets the specified requirements. 

Setting Employee Rights 
Using this feature, you can grant access to various areas of the Dolphin Imaging system to several employees at once. This 
feature is only available if you have the Dolphin Premium Security Utilities. 
Note: You can also grant access to individual employees one at a time. For more information, see "Setting Up Employees" on 
page 969 and "Security Tab" on page 975. 

To grant permissions: 

1. Select Edit Employee Rights... from the Edit menu. 

The Employee Rights window appears. 

2. Optionally, select an employee type from the drop-down list box to grant rights only to employees of that type. 

A column appears for each employee of the selected type. With the default selection, <ALL>, columns appear for all 
employees. For more information, see "Setting Up Employee Types" on page 967. 

3. For each employee, check the box for each area of the system that you want the employee to be able to access. 
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To print the employee rights table: 

1. Click . 

The Print dialog box is displayed. 

2. Select any printing options you want, and click OK. 



33 Security Setup Part XI: Security 

DI_USER_GUIDE-11.5   Rev. 1.01 961 

 

Setting Up Locations 
As part of configuring Dolphin Imaging's security utilities, you enter information about your practice locations, or the various 
offices that make up your practice. For each location, you specify: 

• Address information 

• Model box setup information, which specifies how your patient models are numbered for in-house and archival storage. 

If you are using Dolphin Imaging with Dolphin Management, you will see additional tabs and options for setting up locations. For 
more information, refer to the Dolphin Management online help. 

Adding a Location 

To open the Add a Location dialog box: 

1. Select Locations from the Edit menu. 

A dialog box opens that you can use to look up an existing location or add a new location. 

2. Click New to add a new location. 

The Add a Location dialog box opens. At the top of this dialog box, you enter basic information about this location. The 
bottom of this dialog box contains tabs that you can use to enter address information and information about your model 
box numbering schemes. 

Note: If you are using Dolphin Imaging with Dolphin Management, you will see additional tabs and options for setting 
up locations. For more information, refer to the Dolphin Management online help. 

3. Enter the name that you use for this practice location. 

4. Enter a short code to identify this practice location. 



Dolphin Imaging User's Guide April 2011 

962 DI_USER_GUIDE-11.5   Rev. 1.01 

5. Optionally, select a color to use for the header of this location's Schedule. 

The Schedule header color is only applicable if you are using Dolphin Imaging with Dolphin Management. For more 
information, see the Dolphin Management online help. 

6. Click one or more of the tabs to enter information for this location. 

 

Name The name of the location. 

Code A code assigned to this location. 

Header Color The color to use for the header of the Schedule for this location. This option only applies if you are using 
Dolphin Imaging with Dolphin Management. For more information, see the Dolphin Management online 
help. 

Address tab Enter addressing information for this practice location. 

Model Box 
Setup tab 

Enter information about how your patient models are numbered for in-house and archival storage. 
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Address Tab 
On this tab, you enter address information for this location. 

To open the Address tab: 

1. Click the Address tab if it is not already selected. 

The Address tab appears. 

2. Enter any addressing information for this location. 

 
Street Street address for this location. 

City The city for the address, up to 52 characters. 

State The state or province for the mailing address. 

Zip The zip or postal code for the address. This can be any combination of letters and numbers up to 52 characters 
long. 
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Phone 
#s 

An optional list of phone numbers for the location. You can enter a number and extension in any of the following 
formats: 
nnnnnnnnnnxnn 
nnn-nnn-nnnnxnn 
(nnn)nnn-nnnnxnn 
Dolphin resolves the number into the format (nnn) nnn-nnnn xnn. For example, 4045551212x12 or 404-555-
1212 x12 resolves to (404) 555-1212 x12. If you enter a number in a non-standard format, a prompt appears 
asking whether you want to use it anyway. Click Yes to use the non-standard number format.   
Each phone number is associated with a type, which is one of the following: Cell, Fax. Home, Mobile, Office, 
Other, Pager, Unknown, or Work. 
For more information, see below. 

To add or change a phone number: 

1. Click Add under the Phone #s list to add a new phone number. 

Or, 

Select an existing number, and click Edit to change it. 

2. Enter the number. 

You can enter a number and extension in any of the following formats: 

nnnnnnnnnnxnn 
nnn-nnn-nnnnxnn 
(nnn)nnn-nnnnxnn 

Dolphin resolves the number into the format (nnn) nnn-nnnn xnn. For example, 4045551212x12 or 404-555-1212 x12 
resolves to (404) 555-1212 x12.  

If you enter a number in a non-standard format, a prompt appears asking whether you want to use it anyway. Click Yes 
to use the non-standard number format.  

3. Select the phone number type (Home, Work, Mobile, and so on) from the drop-down list.  

The telephone number is added. For numbers with an extension, an ellipsis (...) appears after the number, indicating 
that there is more information. Select the number and click Edit to see the full number.  

To remove a phone number: 

4. Select an existing number, and click Delete. 
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Model Box Setup Tab 
On this tab, you enter information about the numbering schemes used for model boxes.  

To open the Model Box Setup tab: 

1. Click the Model Box Setup tab. 

The Model Box Setup tab appears. This tab provides two sub-tabs: 

In-House Specify the model box numbering scheme for in-house storage. 

Archive Specify the model box numbering scheme for archival storage. 

2. Select the sub-tab for the model box numbering scheme you want to configure. 

3. Select the numbering scheme to use from the drop-down list. 

Numbering 
Scheme 

Description 

Grid  This method is defined by a matrix made up of rows and columns, like a spreadsheet.  Each 
position within the matrix (analogous to a "cell") is occupied by a fixed number of slots. 
Automatic numbers are generated based upon the first available slot in the matrix. The number 
is composed of a row number, a column number, and a slot number. For example, 0102.03 
designates row 1, column 2, slot 3. If you select this option, the following fields appear: 

Number of Rows: The number of rows in the matrix. 
Number of Columns: The number of columns in the matrix. 
Number of Slots per Cell: The number of slots in each cell in the matrix. 
First Row to Assign: The first row to use when automatically assigning model box 

numbers. 

Year-Serial This method generates model box numbers as follows: the last two digits of the current year, a 
dash, and a serial number that is incremented by one each time a number is generated (for 
example, 04-00043, 04-00044, and so on).  If you select this option, the following field appears: 
Next Auto-Number (including leading zeros): The next serial number to use. This number is 
incremented by one each time a model box number is assigned. 

Freeform  This option requires you to manually assign model box numbers; they are not automatically 
assigned.  

4. Enter any required information to configure the numbering scheme. 
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Editing or Deleting a Location 

To edit or delete a location: 

1. Select Locations from the Edit menu. 

A dialog box opens that you can use to look up an existing location or add a new location. 

2. Enter the name of the location, and click OK. 

Or, 

Click All, and select from a list of locations currently entered on your system. 

The Edit a Location dialog box opens.  

3. Make any changes to the information for that location, and click OK. 

Or, 

Click Delete to delete this location's information. 

For information on the fields on this dialog box, see "Add a Location" on page 961, "Address Tab" on page 963, and 
"Model Box Setup Tab" on page 965. 
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Setting Up Employee Types 
Employee types are used to categorize the types of employees who work at your practice. For example, you might set up an 
employee type for each of the job titles that your practice uses. The employees configured for your system are associated with 
employee types.  
This feature is only available if you have the Dolphin Premium Security Utilities. 

Add an Employee Type 

To add an employee type: 

1. Select Employee Types... from the Edit menu. 

A dialog box opens that you can use to look up an existing employee type or add a new employee type. 

2. Click New to add a new employee type. 

The Add an Employee Type dialog box opens.  

3. Enter a unique code of up to 12 characters to identify this employee type in the database. 

4. Enter a description for this employee type, and click OK. 

A message appears asking whether you would like to add another employee type at this time. 

5. Click Yes to add another employee type. 

Or, 

Click No if you do not want to add another employee type. 

 
Code A unique code of up to 12 characters used to identify this employee type in the database. You cannot 

change the code after the employee type has been saved. 

Description A description of this employee type. 
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Edit or Delete an Employee Type 

To edit or delete an employee type: 

1. Select Employee Types... from the Edit menu. 

A dialog box opens that you can use to look up an existing employee type or add a new employee type. 

2. Enter the description of the employee type that you want to edit or delete. 

Or, 

Click All, and select from the resulting list of existing employee types. 

The Edit an Employee Type dialog box opens.  

3. Change the description of this employee type, and click OK. 

Or, 

Click Delete to delete this employee type. 
 
If you clicked Delete, a message appears asking you to confirm the deletion. 

4. If you clicked Delete, click Yes to delete the employee type. 

Or, 

Click No to cancel the deletion. 

 
Code A unique code of up to 12 characters used to identify this employee type in the database. You cannot 

change the code after the employee type has been saved. 

Description A description of this employee type. 
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Setting Up Employees 
As part of configuring Dolphin Imaging, you enter information about the employees who work at your practice. Each employee is 
associated with an employee type that identifies that employee's primary job function. 
This feature is only available if you have the Dolphin Premium Security Utilities. 
If you are using Dolphin Imaging with Dolphin Management, you will see additional options for setting up employees. For more 
information, refer to the Dolphin Management online help. 
 

Adding an Employee 

To open the Add an Employee dialog box: 

1. Select Employees... from the Edit menu. 

A dialog box opens that you can use to look up an existing employee or add a new employee. 

2. Click New to add a new employee. 

The Add an Employee dialog box opens. This dialog box contains the following tabs that you use to specify employee 
information. 

General Use this tab to set up the basic information about the employee, including login information. 

Reports Use this tab to grant this employee the right to run specific reports. 

Security Use this tab to grant access to various areas of the system to this employee. 

If you are using Dolphin Imaging with Dolphin Management, you will see additional tabs and options for setting up 
employees. For more information, refer to the Dolphin Management online help. 

3. Click one or more of the tabs to enter employee information as described below. 

At a minimum, you must enter a name and sort name on the General Tab. 

4. Click OK to save the employee's information. 

General Tab 
On this tab, you set up basic information about this employee, including information used to access the Dolphin Imaging system. 

To enter general information for an employee: 

1. Click the General tab if it is not already selected. 

The General tab appears. 

2. Enter the employee's name in the First/Last Name text box. 

3. Enter the employee's name as you want it to be sorted in the list of employees. 

4. Enter any other information for this employee. 



Dolphin Imaging User's Guide April 2011 

970 DI_USER_GUIDE-11.5   Rev. 1.01 

 
drop-down list box The salutation for this employee. 

First/Last Name The employee's name. This field is required. 

Sort Name The name displayed as it is sorted in the list of employees. This field is required. 

Greeting The name this employee prefers to be called, such as a nickname. 

Gender The employee's gender. 

Street Street address for this employee. 

City The city for the address, up to 52 characters. 

State The state or province for the mailing address. 

Zip The zip or postal code for the address. This can be any combination of letters and numbers up to 52 
characters long. 

Birthdate The employee's birth date. 

Phone #s An optional list of phone numbers for the employee. Dolphin Imaging formats numbers that you 
enter to a standard telephone number format. Each phone number is associated with one of the 
following types: Cell, Fax. Home, Mobile, Office, Other, Pager, Unknown, or Work. For more 
information, see "To add or change a phone number" on page 972. 

SSN/Govt ID # The social security number or other government-issued ID for this employee. 
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Email An optional email address for this employee. 

Mail Method The delivery mechanism that this employee prefers for correspondence.  One of the following: 
Standard Mail: Send printed letters (the default). 
Email: Send correspondence via email to the address in the Email field. 
Both: Send correspondence as both printed letters and via email to the address in the Email field. 

Initials This employee's initials. 

Login The unique ID that this employee uses to log in to Dolphin Imaging. 

Password The password that this employee uses to log in to Dolphin Imaging. For more information, see 
"Setting Up Password Requirements" on page 958. 

Last Change The date that this employee last changed his or her Dolphin Imaging password 

Force user to 
change password 
at next login 

Check this box to force this employee to change his or her password the next time he or she logs in 
to Dolphin Imaging. 

Type The employee type for this employee. Click   to select from the employee types you previously 
set up. For more information, see "Setting Up Employee Types" on page 967. 

License # This employee's license number. 

Tax # The social security number or tax ID for this employee. 

Fingerprint Indicates whether or not an optional fingerprint has been captured for this employee. Click   to 
capture a new fingerprint for the employee or to delete a fingerprint that you previously captured 
(see below). 
Note: Actual images of fingerprints are not stored anywhere in your system. The fingerprint scanner 
creates a unique ID based on the patterns on a person's finger. The actual fingerprint itself cannot 
ever be re-created or "stolen" from this ID. 
To enable fingerprint login for Dolphin Management, you must also enable this option on the 
General tab in System Options. For more information, see “General Tab” on page 969 and “Setting 
System Options” on page 70. 
For more information on using fingerprint information for security purposes, please consult your 
Dolphin sales and support representative. 

Signature Indicates whether or not a signature has been captured for this employee. Click   to capture a 
new signature or open an existing signature image. This feature is used by Dolphin Management 
only.  

Numbering Indicates the type of numbering to use on tooth charts (for example, those that appear in letters to 
dentists and other professionals). This option only appears for employees that are of type 
Orthodontist.  Possible values are General Dentistry, Orthodontic Quadrant, and Universal 
Quadrant.  For more information, see “setting Up Employee Types” on page 967. 

Language Set Assigns which language set this employee can use. This feature is used by Dolphin Management 
only.  

SMS Name SMS messaging name. This feature is used by Dolphin Management only.  

Specialty This employee's specialty (Orthodontics, Dental Hygienist, and so on). 
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To add or change a phone number: 

1. Click  in the Phone #s area. 

Or, 

Select an existing number and click  to change it. 

The Phone Number dialog box appears: 

2. Enter the number. 

Dolphin Imaging reformats the number that you enter to a standard format.  

3. Select the phone number type (Home, Work, Mobile, and so on) from the drop-down list.  

4. Optionally, set any other options. Then, click OK. 

 
Phone Number Enter a phone number for the employee. Dolphin Imaging formats numbers that you enter to a 

standard telephone number format.  

Phone Type Select one of the following types from this drop-down list box: Cell, Fax. Home, Mobile, Office, 
Other, Pager, Unknown, or Work. 

Note Enter information such as extension, best times to call, and so on. 

Use for SMS This feature is used by Dolphin Management only.  

Use for Phone 
Reminders 

This feature is used by Dolphin Management only.  

To remove a phone number: 

1. Select an existing number and click   
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To re-order the phone numbers in the Phone #s list: 

1. Select one of the listed phone numbers. 

2. Click  to more the selected phone number up in the list. 

Or, 

Click  to more the selected phone number down in the list. 

To add or change an email address: 

1. Click next to the Email Address list. 

Or, 

Select an existing email address and click  to change it. 

The Email Address dialog box appears: 

2. Enter the email address. Then, click OK. 

To remove an email address: 

1. Select an existing email address and click   
  

To re-order the email addresses in the list: 

1. Select one of the listed email addresses. 

2. Click  to more the selected email address up in the list. 

Or, 

Click  to more the selected email address down in the list. 

To open the Capture Fingerprint dialog box: 

1. Click  next to the Fingerprint field. 

The Capture Fingerprint dialog box opens. 
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To capture a new fingerprint for this employee: 

1. On the Capture Fingerprint dialog box, click Capture Fingerprint.  

2. Make sure a fingerprint scanner is attached to the computer that you are currently using.  

3. The employee must complete four good scans of their finger to obtain an accurate reading.  
 
Once the fingerprint is captured, the employee may log in to Dolphin Imaging using their fingerprint. For more 
information, see "Starting Dolphin Imaging" on page 22. 

To delete a fingerprint captured for an employee: 

1. On the Capture Fingerprint dialog box, click Delete Fingerprint.  

To close the Capture Fingerprint dialog box: 

1. Click OK.  

Reports Tab 
On this tab, you grant an employee permission to run specific reports. 

To grant permissions: 

1. Click the Reports tab. 

The Reports tab appears and lists all the reports on your system.  

2. Check the box for each report that you want this employee to be able to run. 

Or, 

Click Select All to check all the boxes. 

Or, 

Click Select None to uncheck all the boxes. 
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Security Tab 
On this tab, you grant access to various areas of the Dolphin Imaging system to an employee. The options you set on this 
window apply to a specific employee. 

To grant permissions: 

1. Click the Security tab. 

The Security tab appears. 

2. Check the box for each area of the system that you want this employee to be able to access. 

Or, 

Click Select All to check all the boxes. 

Or, 

Click Select None to uncheck all the boxes. 
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If you do not have Dolphin Management in addition to Dolphin Imaging, this dialog box may contain options that do not apply to 
your system. The following table lists only the options that apply to Dolphin Imaging. If you do have Dolphin Management 
installed, refer to the online help for that program for information on the Dolphin Management security options. 
Add Patient Check this box to allow this employee to add patients. 

Edit Patient Check this box to allow this employee to make changes to patients. 

Edit Menu Check this box to allow this employee to access the Edit menu and make changes 
to the various Dolphin setup options. If you grant this permission, you can enable 
access to specific options on the Edit menu.  

Clinic Check this box to allow this employee to use the treatment card. This feature is 
available with Dolphin Management only. 

Options Check this box to allow this employee to use the Options option on the Tools 
menu to set System Options.  

Edit  Edit Menu Option Check this box to allow this employee to use the specified option on the Edit 
menu. 

Delete a Patient Check this box to allow this employee to delete a patient. 

Allow Backdating of Treatment 
Card Entries 

Check this box to allow this employee to back-date entries on a patient's treatment 
card. This feature is available with Dolphin Management only. 

Save Treatment Card Entries Check this box to allow this employee to save entries on a patient's treatment 
card. This feature is available with Dolphin Management only. 
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Delete Fingerprint Files Check this box to allow this employee to delete files that contain fingerprint 
information.  
Note: Actual images of fingerprints are not stored anywhere in your system. The 
fingerprint scanner creates a unique ID based on the patterns on a person's finger. 
The actual fingerprint itself cannot ever be re-created or "stolen" from this ID. 

Capture Images Check this box to allow this employee to capture images for patients. 

Digitize and Link X-rays Check this box to allow this employee to digitize x-rays and link x-ray images to 
patient pictures (superimpositions). 

Orthodontic and Surgical 
Treatment Simulation 

Check this box to allow this employee to use the Treatment Simulation features. 

ImPlanner Check this box to allow this employee to use ImPlanner features. 

Edit/Morph Images Check this box to allow this employee to edit and morph patient images. 

Imaging Configuration (Page 
Setup, Layout, Custom Analy... 

Check this box to allow this employee to configure Dolphin Imaging, including 
using Dolphin Screen editor and the Custom Analysis editor. 

Edit Imaging Main View 
Preferences 

Check this box to allow this employee to edit general preferences for the Dolphin 
Imaging main screen. 

Edit Slide Show Sequences Check this box to allow this employee to edit slide show sequences. 

Edit Questionnaires Check this box to allow this employee to edit questionnaires. 

Export (copy, save, drag) Imaging 
Data 

Check this box to allow this employee to export Dolphin Imaging data to other 
programs by copying and pasting, saving to a file, or dragging and dropping. 

Archive Load Patients Check this box to allow this employee to load patients from an archive. 

Archive Save Patients Check this box to allow this employee to save patients to an archive. 

Print images, tracings, 
measurements 

Check this box to allow this employee to print patient images, tracings, and 
measurement tables. 

View Patient Details Check this box to allow this employee to view detailed information in the patient's 
chart. 

Create/Copy/Paste/Delete 
Timepoints and Images 

Check this box to allow this employee to create, copy and paste, or delete 
timepoints and images. 

Cloak and Uncloak Patient Names Check this box to allow this employee to toggle whether patient names are 
cloaked on the Dolphin Imaging main screen. 

Relationships Tab 
On this tab, you specify any relationships this employee has that you want to track. For example, you can associate patients with 
non-patient family members. 
As delivered, Dolphin Imaging has the following relationships defined: Aunt, Brother, Father, Grandfather, Grandmother, 
Guardian, Mother, Partner, Self, Sister, Spouse, Stepmother, and Uncle. One of the advantages of tracking non-patient members 
of patients' families is that you can later convert that non-patient to a patient. For example, you can add a patient's younger 
sibling to the relationship manager.  Should this person require treatment, you'll already have the information in the relationship 
manager, and you can change this person's status from non-patient to patient. You can add new relationships or change the 
configuration of any of the existing relationships.   



Dolphin Imaging User's Guide April 2011 

978 DI_USER_GUIDE-11.5   Rev. 1.01 

To open the Relationships tab: 

1. Click the Relationships tab. 

The Relationships tab appears. 

 
Member Of The group to which this employee belongs (for example, the ABC Dental Group), the other members of 

that group, and their relationship to this employee. 
Add: Click this button to add a group membership to this employee. 
Delete: Click this button to delete this employee from a group.  

Relationships The name, type (patient, non-patient, billing party, etc) and relationship of people to  this employee. 
Add: Click this button to add a relationship.  
Edit: Click this button to edit a relationship. 
Delete: Click this button to delete a relationship. 

Partner Integration Tab 
This tab is reserved for current and future third-party integrations. Contact your Dolphin support representative for further 
information. 
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Editing or Deleting an Employee 

To edit or delete an employee: 

1. Select Employees... from the Edit menu. 

A dialog box opens that you can use to look up an existing employee or add a new employee. 

2. Enter the employee's name, and click OK. 

Or, 

Click All, and select from a list of employees currently entered on your system. 

The Edit an Employee dialog box opens.  

3. Make any changes to the employee's information, and click OK. 

Or, 

Click Delete to delete this employee's information. 

For information on the fields on this dialog box, see "Add an Employee" on page 969. 
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Part XII: Appendices 
This part of the Dolphin Imaging User’s Guide includes the following appendices: 

• Reference Tables: includes the following tables for your reference: analyses, cephalometric landmarks and their 
definitions, page setup tokens and their definitions, DLS reserved tokens and their definitions, and DLS diagnostic lists 
and codes. 

• DOLPHIN.INI File: describes how to set up Dolphin Imaging options on your dolphin.ini file. 

• Digital Radiographic System Integration: provides information about the digital radiographic systems with which the 
Dolphin Imaging System has been integrated. 

• Practice Management System Integration: provides information about the practice management systems with which 
the Dolphin Imaging System has been integrated. 

• Recommended Readings: provides a list of recommended readings. 
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A Reference Tables 
This appendix includes the following tables for your reference: 

• Analyses 

• Cephalometric landmarks and their definitions 

• Page setup tokens and their definitions 

• DLS reserved tokens and their definitions 

• DLS diagnostic lists and codes 

Cephalometric Analyses 
The following lists the standard and Dolphin-proprietary analyses available on the Digitize dialog box. In the Digitize dialog box, 
an at-sign (@) indicates a Dolphin-proprietary analysis. Square brackets ([ ]) indicate a custom analysis created for a specific 
doctor, practice, or institution. All other analyses are standard analyses. For more information on the Digitize dialog box, see 
Chapter 10. 
The following analyses are Dolphin-proprietary: 

• Profilogram 

• Superimpose 

• Treatment Plan 

The following standard lateral analyses are supported: 

ABO Alabama Alexander 

Arnett/Gunson FAB Ortho Arnett/Gunson FAB Surgery Arnett/McLaughlin 

Bjork Bjork II Bjork III 

COGS CVM Delaire 

Downs Downs-Northwestern Gerety 

Holdaway Iowa Jarabak 

Legan McLaughlin McNamara 

Moshiri Surgical Quadrilateral Ricketts 

Ricketts, Comprehensive Ricketts-Roth-Jarabak Roth-Jarabak 

Roth-Williams AEO Sassouni Sassouni+ 

Steiner Tweed   



A Reference Tables Part XII: Appendices 

DI_USER_GUIDE-11.5   Rev. 1.01 983 

The following standard frontal analyses are supported: 

Grummons Grummons Simplified 
Frontal  

Ricketts 

Simplified  Slick/Good Standard 

The following standard arch analyses are supported: 

Arch Calibration Bolton - Anterior Bolton - Full Arch 

Both Arches Lower Arch Upper Arch 

Cephalometric Landmarks 
The following sections define lateral and frontal cephalometric landmarks. These sections include a table defining the landmarks 
and illustrations of the landmarks. 

Lateral Landmarks 
The following table lists static lateral cephalometric landmarks. This table only applies if you are digitizing a lateral X-ray. For an 
illustration of these landmarks, see the two figures below the table. 

Landmark Description 

A point Deepest point of the curve of the maxilla, between the anterior nasal spine (ANS) and the dental 
alveolus. 

Anatomical 
Gnathion 

Midpoint between the most anterior and inferior point on the bony chin. (Brodie, 1941) 

ANS The tip of the anterior nasal spine. 

Antegonial Notch Point at the lateral interior margin of the antegonial protuberance. 

Articulare Posterior border of the neck of the condyle. 

B Point Most posterior point in the concavity along the anterior border of the symphysis. 

Basion Most inferior posterior point of the occipital bone at the anterior margin of the occipital foramen. 

Bridge of Nose Mid-point from the soft tissue Nasion to the Tip of Nose; first contour encountered along the length 
of the profile on the nose. 

Center of 
Symphysis (D) 

The center of the symphysis structure. 

Clinoidale Posterior point of the roof of the orbit, where it meets anterior of the sella turcica. 

Columella Point Nasal Base. 

Condylion Most posterior superior point of the condyle. 

Cribiform Point Point of intersection of the planum with greater wing of the sphenoid. 

DC Point Center of the neck of the condyle on the Nasion-Basion line. 
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Distal L6 Distal surface of the lower first molar, perpendicular to the occlusal plane. 

Distal U6 Distal surface of the upper first molar, perpendicular to the occlusal plane. 

Dorsum Sella Most posterior superior point of the pituitary fossa. 

Floor of Sella Most inferior point of the pituitary fossa. 

Gonion Location depends on the analysis: 1) most convex point along the inferior border of the Ramus; or, 
2) most convex point where the posterior inferior curve of the ramus meet. 

L1 Labial Gingival 
Border 

Labial cemento-enamel junction (CEJ) of the lower central incisor. 

L1 Lingual Gingival 
Border 

Lingual cemento-enamel junction (CEJ) of the lower central incisor.    

L1 Root Root apex of the lower central incisor. 

L1 Tip Tip of the lower central incisor. 

L6 Occlusal Point on the occlusal surface crown of the lower first molar. (Same as U6 Occlusal if the molars 
occlude.) 

Lower Lip Most anterior point on the curve of the lower lip. 

Mechanical Porion Highest point of the ear canal; most superior point of the external auditory meatus. 

Menton Most inferior point of the symphysis. 

Mesial L6 Mesial surface of the lower first molar, perpendicular to the occlusal plane. 

Mesial U6 Mesial surface of the upper first molar, perpendicular to the occlusal plane. 

Nasion Intersection of the internasal suture with the nasofrontal suture in the midsagittal plane. 

Occlusal Plane 
Distal 

Point where the upper and lower first molars occlude. If molars do not occlude, point is the bisection 
of the occlusal crown surface of the upper and lower first molars. 

Orbitale Lowest point of the roof of the orbit; most inferior point of the external border of the orbital cavity. 

PM Point on the symphysis between B point and Pogonion, where the bone curves from convex to 
concave. 

PNS Tip of the posterior nasal spine. 

Pogonion Most anterior point on the mid-sagittal symphysis. 

Porion Highest point of the ear canal; most superior point of the external auditory meatus. 

PT Point Intersection of the inferior border of the formen rotundum with the posterior wall of the 
pterygomaxillary fissure. 

R1 Most concave point on the interior of the ramus. Used to locate Xi point. 

R2 Most convex point on the exterior border of the ramus along the vertical. Used to locate Xi point. 

R3 Most inferior border along the top of the ramus. Used to locate Xi point. 
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R4 Most superior border along the bottom of the ramus. Used to locate Xi point. 

Ramus Point Most posterior point up the border of the ramus. 

Roof of Orbit Most superior point of the roof of the orbit. 

S.T. Glabella Most anterior point on the frontal bone. (Krogman & Sassouni, 1957) 

Sella Center of the pituitary fossa of the sphenoid bone. 

Sella Est-1 Midline of the patient’s head, located at the occipital level of the head. 

Sella Est-2 Midline located 45 degrees to the Frankfort plane at the posterior crown of the head. 

Sella Est-3 Midline straight up from the orbitale. 

Sella Est-4 Midline back of the head, along the Frankfort plane. 

Soft Tissue Menton The most inferior point of the soft tissue chin. 

Sphenoid Point of the greatest convexity between the anterior contour of sella turcica and planum 
sphenoidale. 

ST A-Point Soft tissue point A; most concave point between the subnasale and the anterior point of the upper 
lip. 

ST B-Point Most concave point between the lower lip and the soft tissue chin. 

ST Nasion Soft tissue profile’s most concave point at the bridge of the nose. 

ST Pogonion Point on the anterior curve of the soft tissue chin. 

Stomion Midpoint between stomion superius (lowest point of the upper lip) and stomion inferius (highest point 
of the lower lip). 

Stomion Inferius Most superior point on the curve of the lower lip. 

Stomion Superius Most inferior point on the curve of the upper lip. 

Subnasale Point where the nose connects to the center of the upper lip.    

Temporale Point where the anterior wall of the temporale meets the anterior extension of the sphenoid bone. 

Throat Point Intersection of lines tangent to the neck and the throat. 

Tip of Nose Pronasale. Point of the anterior curve of the nose. 

Trichion Frontal hairline at the midline.    

U1 Labial Gingival 
Border 

Labial cemento-enamel junction (CEJ) of the upper central incisor. 

U1 Lingual Gingival 
Border 

Lingual cemento-enamel junction (CEJ) of the upper central incisor. 

U1 Most Labial Most labial surface of the upper central incisor. 

U1 Root Root apex of the upper central incisor. 
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U1 Tip Incisal tip of the upper central incisor. 

U6 Occlusal Point on the occlusal surface crown of the upper first molar. (Same as L6 Occlusal if the molars 
occlude.) 

Upper Lip Most anterior point on the curve of the upper lip. 

Vertex Most superior point on the head, along the midline. 

Vertical Lower "Lower" point that establishes "Vertical," the natural head position line. (Harvard analysis) 

Vertical Upper "Upper" point that establishes "Vertical," the natural head position line. (Harvard analysis) 

Lateral teeth (base) diagram 
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Lateral tracing (base) diagram 

 
  

Frontal Landmarks 
The following table lists static frontal cephalometric landmarks. This table only applies if you are digitizing a frontal X-ray. 

Landmark Description 

A Point Deepest point of the curve of the maxilla between the anterior nasal spine and the dental 
alveolus. 

Antegonial notch R (AG) Highest point in the antegonial notch on the patient’s right side. 

Antegonial notch R (GA) Highest point in the antegonial notch on the patient’s left side. 

Condylion, Left Most superior point of the condylar head of the patient’s left side. 

Condylion, Right Most superior point of the condylar head on the patient’s right side. 

Crista Galli Most superior point on the Crista Galli. 

Jugal Process, L Intersection of the zygonmatic buttress and outline of the tuberosity on the patient’s left side. 

Jugal Process, R Intersection of the zygonmatic buttress and outline of the tuberosity on the patient’s right side. 

L1 Labial Gingival, L Cemento-enamel junction (CEJ) of the mandibular incisor on the patient’s left side. 
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L1 Labial Gingival, R Cemento-enamel junction (CEJ) of the mandibular incisor on the patient’s right side. 

L1 Labial Gingival, R 
(open) 

With the patient’s mouth properly opened by a bite block, digitize the cemento-enamel junction 
(CEJ) of the mandibular incisor on the patient’s left side. 

L1 Mesial, L Mesial tooth surface of the mandicular incisor on the patient’s left side. 

L1 Mesial, L (open) With the patient’s mouth properly opened by a bite block, digitize the mandibular cuspid tip on 
the patient’s left side. 

L1 Mesial, R Mesial tooth surface of the mandicular incisor on the patient’s right side. 

L1 Mesial, R (open) With the patient’s mouth properly opened by a bite block, digitize the mandibular cuspid tip on 
the patient’s right side. 

L1 Tip, L Maxillary incisal tip on the patient’s left side. 

L1 Tip, L (open) With the patient’s mouth properly opened by a bite block, digitize the mandibular cuspid tip on 
the patient’s left side. 

L1 Tip, R Maxillary incisal tip on the patient’s right side. 

L1 Tip, R (open) With the patient’s mouth properly opened by a bite block, digitize the mandibular cuspid tip on 
the patient’s right side. 

L3 Tip, L Tip of the mandicular cuspid on the patient’s left side. 

L3 Tip, L (open) With the patient’s mouth properly opened by a bite block, digitize the mandibular cuspid tip on 
the patient’s left side. 

L3 Tip, R Tip of the mandicular cuspid on the patient’s left side. 

L3 Tip, R (open) With the patient’s mouth properly opened by a bite block, digitize the mandibular cuspid tip on 
the patient’s right side. 

L6 Buccal, L Most buccal point of the mandibular first molar on the patient’s left side. 

L6 Buccal, R Most buccal point of the mandibular first molar on the patient’s right side. 

L6 Buccal, R (open) With the patient’s mouth properly opened by a bite block, digitize the most buccal point of the 
maxillary first molar on the patient’s right side. 

Menton Most inferior point on the border of the mandible, directly inferior to the mental protuberance. 

Nasal cavity, L Most lateral and widest aspect of the bottom of the nose on patient’s left side. 

Nasal cavity, R Most lateral and widest aspect of the bottom of the nose on patient’s right side. 

Occlusal Plane Distal, L Intersection or midpoint of the maxillary and mandibular first molar crown. 

Occlusal Plane Distal, R Intersection or midpoint of the maxillary and mandibular first molar crown. 

Orbitale, Right Most inferior point on the outline of the right orbital margin. 

Pogonion Most anterior point on the mid-sagittal symphysis. 

Porion, L Most superior point of the patient’s left external auditory meatus. 
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Porion, R Most superior point of the patient’s right external auditory meatus. 

ST Pogonion Point on the anterior curve of the soft tissue chin. 

U1 Labial Gingival, L Cemento-enamel junction (CEJ) of the maxillary incisor on the patient’s left side. 

U1 Labial Gingival, R Cemento-enamel junction (CEJ) of the maxillary incisor on the patient’s right side. 

U1 Mesial, L Mesial tooth surface of the maxillary incisor on the patient’s left side. 

U1 Mesial, R Mesial tooth surface of the maxillary incisor on the patient’s right side. 

U1 Tip, L Maxillary incisal tip on the patient’s left side. 

U1 Tip, R Maxillary incisal tip on the patient’s right side. 

U3 Tip, L Tip of the maxillary cuspid on the patient’s left side. 

U3 Tip, R Tip of the maxillary cuspid on the patient’s right side. 

U6 Buccal, L Most buccal point of the maxillary first molar on the patient’s left side. 

U6 Buccal, R Most buccal point of the maxillary first molar on the patient’s right side. 

Zygomatic Suture L (ZL, 
ZA) 

Zygomatic-frontal suture, intersecting the orbit on the patient’s right side. 

Zygomatic Suture R 
(ZR, AZ) 

Zygomatic-frontal suture, intersecting the orbit on the patient’s right side. 

Page Setup Tokens 
The following tables list the tokens you can use to place variable information (such as patient name or page number) in the 
header or footer.  

Token Description 

AgeInMonths The patient’s current age in months. 

AgeInMonthsAt 
CurrTimepoint 

The patient’s age at the current timepoint expressed in months. For example, if the patient is 10 
years 4 months old, this token evaluates to 124. 

AgeInYears The patient’s current age in years. 

AgeInYearsAtCurr 
Timepoint 

The patient’s age at the current timepoint. The patient’s age is rounded down to the year. For 
example, if the patient is 10 years 4 months old, this token evaluates to 10. 

AgeModMonths The number of months since the patient’s last birthdate expressed in months.  

AgeMODMonthsAtCurr 
Timepoint 

The number of months since the patient’s last birthdate at the current timepoint expressed in 
months. For example, if the patient is 10 years 4 months old, this token evaluates to 4. 

PatientBirthday The patient’s birth date. 

PatientFirstName The patient’s first name. 

PatientGender The patient’s gender. 
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PatientID The ID assigned to this patient. 

PatientLastName The patient’s last name. 

PatientNotes All the notes entered for this patient. 

PatientNotesN The specified line of patient notes, where N specifies the notes line. 

PatientPhone1 The first telephone number on file for the patient. 

PatientPhone2 The second telephone number on file for the patient. 

PatientRace The category specified for this patient in the Norm field on the Patient Charts or Patient Lookup 
dialog box.  

TimePointDate Date of the current timepoint. 

TimePointName Name assigned to the current timepoint. 

The following table lists the doctor information tokens, which you can use to print information entered when the Dolphin Imaging 
software was installed. 

Token Description Token Description 

DoctorAddr1 The first line of the doctor’s address. DoctorName The doctor’s name. 

DoctorAddr2 The second line of the doctor’s address. DoctorPhone1 The first telephone number for the doctor. 

DoctorAddr3 The third line of the doctor’s address. DoctorPhone2 The second telephone number for the doctor. 

DoctorAddr4 The fourth line of the doctor’s address.     

The following table lists the before/after tokens, which you can use for side-by-side layouts or in cut/paste mode. 

Token Description 

ChangeableTimePoint The name assigned to the timepoint for the "after" picture.  

ChangeableTimePointDate The date of the timepoint for the "after" picture.  

ChangedImageName The name for the "after" picture. 

ChangedImageNotes Notes for the "after" picture.  

ChangedImageTitle The title for the "after" picture.  

ImageName A single picture name, or the name for the "before" picture. This token is only available for 
layouts with only one picture, side-by-side layouts, or in the cut/paste mode. 

ImageNotes Notes for a single picture, or the notes for the "before" picture. This token is only available for 
layouts with only one picture, side-by-side layouts, or in the cut/paste mode. 
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ImageTitle A single picture title, or the title for the "before" picture. This token is only available for layouts with only 
one picture, side-by-side layouts, or in the cut/paste mode. 

TimePointDate The date that the timepoint was created. 

TimePointName The name assigned to this timepoint. 

The following table lists the image/layout-specific tokens, which you can use for side-by-side layouts or in cut/paste mode. These 
tokens are not always available. 

Token Description 

CurrentAnalysisName Name of the current analysis. Available for cephalometric images only. 

LayoutName Name of the image layout. 

LayoutNotes Notes about the image layout as entered using the Layout editor or by editing the 
DOLPHIN.INI file (currently unavailable). 

The following table lists other tokens you can use to specify formatting. 

Token Description 

Page The page number. 

PrintDate The date that the layout was printed. 

PrintTime The time that the layout was printed. 

DLS Reserved Tokens 
The following table lists the Reserved token fields that you can insert into your template or questionnaire. These tokens insert 
information defined in the patient’s chart in Dolphin Imaging. 
If you are using Dolphin Imaging in conjunction with Dolphin Management, all the tokens listed below are available to you. If you 
are not using Dolphin Management, some of the tokens listed below are not available. 

Token Description 

DoctorBirthday The doctor’s birthday. 

DoctorCell The doctor’s mobile phone number. 

DoctorCity The city for the doctor’s address. 

DoctorCompany The name of the doctor’s practice. 

DoctorCountry The country for the doctor’s address. 

DoctorEmail The doctor’s email address. 

DoctorFax The doctor’s fax number. 

DoctorFirstName The doctor’s first name. 

DoctorGender The doctor’s gender. 
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DoctorHomePhone The doctor's home phone number. 

DoctorLastName The doctor’s last name. 

DoctorNickName The doctor’s nickname. 

DoctorOfficePhone The doctor’s office phone number 

DoctorPager The doctor’s pager number. 

DoctorSpeciality The doctor’s specialty. 

DoctorState The state for the doctor’s address. 

DoctorStreet The doctor’s street address. 

DoctorTitle The doctor’s title. 

DoctorZip The zip code for the doctor’s address. 

He_She Capitalized "He" or "She" depending on the patient's gender as defined in the PatientGender field. 

her_him Lowercase "him" or "her" depending on the patient's gender as defined in the PatientGender field. 

her_his Lowercase "his" or "her" depending on the patient's gender as defined in the PatientGender field. 

Him_Her Capitalized "Him" or "Her" depending on the patient's gender as defined in the PatientGender field. 

His_Her Capitalized "His" or "Her" depending on the patient's gender as defined in the PatientGender field. 

GuardianBirthday The guardian’s birthday. 

GuardianCell The guardian’s mobile phone number. 

GuardianCity The city for the guardian’s address. 

GuardianCompany The name of the company where the guardian works. 

GuardianCountry The country for the guardian’s address. 

GuardianEmail The guardian’s email address. 

GuardianFax The guardian’s fax number. 

GuardianFirstName The guardian’s first name. 

GuardianGender The guardian’s gender. 

GuardianHomePhone The guardian's home phone number. 

GuardianLastName The guardian’s last name. 

GuardianNickName The guardian’s nickname. 

GuardianOfficePhone The guardian’s office phone number 

GuardianPager The guardian’s pager number. 
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GuardianState The state for the guardian’s address. 

GuardianStreet The guardian’s street address. 

GuardianTitle The guardian’s title. 

GuardianZip The zip code for the guardian’s address. 

InsuranceContact The contact person at the insurance company. 

InsuranceCompany The name of the insurance company. 

InsuranceCity The city for the insurance company’s address. 

InsuranceCountry The country for the insurance company’s address. 

InsuranceFax The insurance company’s fax number. 

InsuranceOfficePhone The insurance company’s office phone number 

InsuranceState The state for the insurance company’s address. 

InsuranceStreet The insurance company’s street address. 

InsuranceZip The zip code for the insurance company’s address. 

PatientBirthday The patient’s birthday. 

PatientCell The patient’s mobile phone number. 

PatientID The patient's ID. 

PatientTitle The patient’s title. 

PatientFirstName The patient's first name. 

PatientNickname The patient’s nickname. 

PatientCity The city for the patient’s address. 

PatientCountry The country for the patient’s address. 

PatientCompany The company for which the patient works. 

PatientEmail The patient’s email address. 

PatientFax The patient’s fax number. 

PatientGender The patient's gender. An "F" for female or "M" for male. 

PatientHomePhone The patient's home phone number. 

PatientLastName The patient's last name. 

PatientModel The number of the patient’s study model. 

PatientNorm The most appropriate category for this patient. Used only if you use comparisons to racial and gender 
norms in your practice. 
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PatientOfficePhone The patient’s office phone number 

PatientPager The patient’s pager number. 

PatientSalutation The salutation to use for letters to this patient. 

PatientStreet The patient’s street address. 

PatientState The state for the patient’s address. 

PatientZip The zip code for the patient’s address. 

ReferralBirthday The referring doctor’s birthday. 

ReferralCell The referring doctor’s mobile phone number. 

ReferralCity The city for the referring doctor’s address. 

ReferralCompany The name of the referring doctor’s practice. 

ReferralCountry The country for the referring doctor’s address. 

ReferralEmail The referring doctor’s email address. 

ReferralFax The referring doctor’s fax number. 

ReferralFirstName The referring doctor’s first name. 

ReferralGender The referring doctor’s gender. 

ReferralHomePhone The referring doctor's home phone number. 

ReferralLastName The referring doctor’s last name. 

ReferralNickName The referring doctor’s nickname. 

ReferralOfficePhone The referring doctor’s office phone number 

ReferralPager The referring doctor’s pager number. 

ReferralState The state for the referring doctor’s address. 

ReferralStreet The referring doctor’s street address. 

ReferralTitle The referring doctor’s title. 

ReferralZip The zip code for the referring doctor’s address. 

TimepointDate The date of the timepoint. 

TimepointName The name of the timepoint. 

UserAddress1 Your address, line 1 

UserAddress2 Your address, line 2 

UserAddress3 Your address, line 3 
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UserAddress4 Your address, line 4 

UserName Your Name. 

UserPhone Your telephone number 

she_he Lowercase "he" or "she" depending on the patient's gender as defined in the PatientGender field. 

son_daughter Lowercase "son" or "daughter" depending on the patient's gender as defined in the PatientGender field. 

DLS Diagnostic Lists and Codes 
This section contains the diagnostic lists and codes that were included with the Dolphin Letter System. You can remove or 
modify any of the lists and their codes You can also create your own lists by using codes from your current system or by 
borrowing from the codes listed on the following pages. 

Airway Evaluation  

Code Clinical Term 

00 Nasal 

02 Mouth 

06 Allergies, chronic nasal congestion 

Anterior Bite Depth 

Code Clinical Term Code Clinical Term 

1 Anterior bite depth: Normal 10-20% 5 Anterior bite depth: Very deep >100% 

2 Anterior bite depth: Slight 20-40% 6 Anterior bite depth: Shallow 0-10% 

3 Anterior bite depth: Moderate 40-60% 7 Anterior bite depth: Functional openbite 

4 Anterior bite depth: Deep 60-100% 8 Anterior bite depth: Anatomic openbite 

Archform  

Code Clinical Term Code Clinical Term 

32 Normal maxillary arch width 38 Wide maxillary arch 

34 Constricted maxillary arch 40 Normal mandibular arch width 

35 Constricted mandibular arch 42 Wide mandibular arch 
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Canine Classification  

Code Clinical Term Code Clinical Term 

00 Class II 03 Class I 

02 End to end 04 Class III 

Caries Prone 

Code Clinical Term 

1 High 

2 Average 

3 Low 

Chief Concerns 

Code Clinical Term Layman Term 

1 None indicated by patient   

2 Second opinion desired   

3 Continuation of care   

4 Overjet   

5 Crowding The teeth appear crowded due to insufficient space in the dental arch 

6 Underbite   

10 Spacing There are spaces between the teeth 

11 Diastema Space between upper front teeth 

12 Irregularly shaped teeth: {} Some teeth have irregular shapes 

13 Irregular tooth positions Some teeth are in irregular positions 

15 Overbite or deep bite   

16 Early loss of baby teeth Baby teeth have been lost too early 

20 Open bite Even when the mouth is closed, the upper and lower front teeth still do 
not properly touch 

25 Flared incisors   

30 Cross bite The teeth are in crossbite 

35 Smile esthetics   

40 Incisor rotations   
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45 Delayed eruptions   

46 Impacted teeth   

50 Missing permanent teeth: {} There are missing teeth 

54 Gingival recession There is recession of the gum tissue 

55 Tooth motion   

56 Gingival disease or gingival health 
related problems 

The gums are unhealthy and inflamed (gum disease) 

57 Periodontal support   

58 Excessive gingival display Too much gum showing when smiling (gummy smile) 

60 Excessive wear of dentition   

70 Lack of lip support The upper and lower lips are thin, and appear to be not sufficiently 
covering the teeth properly 

100 Deficient chin The lower jaw appears to be too small 

104 Prominent lower jaw The lower jaw appears to be too far forward 

105 Excessive lower jaw development   

110 Procumbent lower facial profile   

111 Facial asymmetry   

115 Lack of upper jaw development The upper jaw is too narrow 

200 Tooth sensitivity   

205 Jaw pain There is pain in the jaw area 

210 Ear pain   

211 Ear ringing or stuffiness There is continual ringing or stuffiness in the ears and in the head 

215 Neck pain   

220 Headache, facial or neck pain There are frequent headaches, facial pain or neck ache 

300 Chewing difficulties   

301 Change in bite (occlusion)   

305 Bruxing   

400 Jaw dysfunction or clicking The jaw does not function properly, or clicks when opening or closing 

405 Jaw locking open   

410 Jaw locking closed   
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415 Diminished mouth opening   

420 Thumb habit   

425 Tongue thrusting habit   

430 Speech difficulty   

Crossbite  

Code Clinical Term Layman Term 

10 No crossbite None of the teeth are in crossbite relationship 

18 Partial anterior crossbite (tooth #s:{}) The upper front teeth bite behind the lower front teeth (underbite) 

20 Complete anterior crossbite The upper back teeth bite on the inside on the right side (crossbite) 

21 Posterior right crossbite The upper back teeth bite on the inside on the left side (crossbite) 

22 Posterior left crossbite The upper back teeth bite on the inside on both sides (crossbite) 

23 Bilateral posterior crossbite The upper back teeth bite completely outside the lower back teeth (buccal 
crossbite) 

25 Buccal crossbite Some of the upper back teeth bite completely outside of the lower teeth 

27 Partial buccal crossbite (tooth#: {}) The upper front teeth bite behind the lower front teeth (underbite) 

Crowding  

Code Clinical Term Layman Term 

24 No crowding There is sufficient space for the teeth in both dental arches. 

30 Mild crowding in the maxillary arch The upper teeth are crowded due to insufficient space 

32 Mild crowding in the mandibular arch The lower teeth are crowded due to insufficient space 

34 Moderate crowding in the maxillary arch The upper teeth are crowded due to insufficient space 

36 Moderate crowding in the mandibular arch The lower teeth are crowded due to insufficient space 

38 Severe crowding in the maxillary arch The upper teeth are crowded due to insufficient space 

40 Severe crowding in the mandibular arch The lower teeth are crowded due to insufficient space 

42 Excessive spacing in the maxillary arch There is excessive space between the upper teeth 

44 Excessive spacing in the mandibular arch There is excessive space between the lower teeth 
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Code Dentist Term Code Dentist Term 

1 Severe overjet 20 Minimal overbite (edge to edge incisor relationship) 

2 Normal overjet 30 Mild crowding in the maxillary arch 

3 Minimal overjet (end to end incisors) 32 Mild crowding in the mandibular arch 

5 Moderate overjet 34 Moderate crowding in the maxillary arch 

14 Mild overbite (15-45%) 38 Severe crowding in the maxillary arch 

16 Normal overbite (0-10%) 36 Moderate crowding in the mandibular arch 

17 Moderate overbite (50-80%) 40 Severe crowding in the mandibular arch 

18 Severe overbite (100%, deep impinging overbite)     

Curve of Spee  

Code Clinical Term Code Clinical Term 

00 Flat mandibular 12 Deep Curve of Spee in the maxillary arch 

02 Deep Curve of Spee in the mandibular arch 14 Reverse Curve of Spee in the maxillary arch 

04 Reverse Curve of Spee in the mandibular arch 20 Normal Curve of Spee in the maxillary arch 

10 Flat Curve of Spee in the maxillary arch 22 Normal Curve of Spee in the mandibular arch 

Dental Class  

Code Clinical Term 

5 Class I 

6 Class II 

7 Class III 

Dental Class (2) 

Code Clinical Term Layman Term 

5 Class I The upper and lower back teeth fit together normally 

6 Class II The lower back teeth bite too far behind the upper back teeth 

8 Class II, division 1 The lower back teeth bite too far behind the upper back teeth 

9 Class II, division 2 The lower back teeth bite too far behind the upper and upper incisors tip 
inwards 
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7 Class III The lower back teeth bite significantly forward of the upper back teeth 

13 Class III tendency The lower back teeth bite too far forward of the upper back teeth 

12 Mild Class II tendency (end-to-
end) 

The lower back teeth bite slightly behind the upper back teeth 

10 Class II, division {}, subdivision {} The lower back teeth on the right side bite too far behind the upper back teeth 

11 Class III, subdivision {} The lower back teeth on the left side bite too far behind the upper back teeth 

Dental Profile  

Code Clinical Term Layman Term 

1 Upper Protrusive Upper teeth are too forward 

2 Upper Retrusive Upper teeth are too far back 

3 Lower Protrusive Lower teeth are too forward 

4 Lower Retrusive Lower teeth are too far back 

5 Bidental Protrusion Upper and lower teeth are too forward 

6 Bidental Retrusion  Upper and lower teeth are too far back 

Dentition Developmental Stage  

Code Clinical Term Layman Term 

1 Developmental stage: Primary Only baby teeth are present 

2 Developmental stage: Early mixed There is a mixture of mostly baby teeth and some permanent teeth 

3 Developmental stage: Middle mixed There is a mixture of baby teeth and permanent teeth 

4 Developmental stage: Late mixed Mostly permanent teeth, with some baby teeth still present 

5 Developmental stage: Permanent (adult) Only permanent teeth are present 

Dentition Developmental Stage (2) 

Code Clinical Term Code Clinical Term 

1 Primary dentition 4 Late mixed dentition 

2 Early mixed dentition 5 Permanent dentition 

3 Mixed dentition     
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Disposition  

Code Clinical Term Code Clinical Term 

1 Treatment recommendations have 
been accepted. 

6 Emergency treatment has been rendered. 

2 Treatment recommendations are 
being considered. 

7 Patient will be seen in near future; extraction of teeth has been 
prescribed. 

3 Delay extraction of teeth until 
diagnostic records have been 
reviewed. 

8 The patient's concerns were discussed thoroughly, and future care 
was suggested. 

4 A second opinion has been 
requested by the patient. 

9 We will look forward to seeing you. 

5 Postpone treatment due to financial 
concerns. 

    

Enamel Defects  

Code Clinical Term Code Clinical Term 

00 Hypocalification 04 Vertical cracks 

02 Intinsic staining 10 None 

Extracted & Congenitally Absent Teeth  

Code Clinical Term 

1 Extracted & Congenitally absent teeth: {} 

Extractions  

Code Clinical Term Layman Term 

00 Extract upper first permolars: 5, 12 Removal of the (2) first bicuspids on the upper arch 

02 Extract upper second permolars: 4, 13 Removal of the (2) second bicuspids in the upper arch 

06 Extract lower first premolars: 21, 28 Removal of the (2) first bicuspids in the lower arch 

08 Extract lower second premolars: 20, 29 Removal of the (2)second bicuspids in the lower arch 

10 Extract upper third molars Removal of the wisdom teeth in the upper arch 

12 Extract lower third molars Removal of the wisdom teeth in the lower arch 

14 Early extraction of primary teeth: {} Early removal of baby teeth to allow space for erupting adult teeth 

16 Extract upper second molars: 2, 15 Removal of the (2) second molars in the upper arch 
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18 Extract one incisor: {} Removal of one lower incisor 

19 Serial extraction procedures Early removal of baby teeth and later permanent teeth to gain space for 
alignment and to aid normal eruption 

20 Try non-extraction therapy No removal of teeth are planned at this time, but a re-evaluation will be 
needed later 

22 Non-extraction therapy The treatment simulation does not require removal of teeth 

Facial Balance  

Code Clinical Term Code Clinical Term 

38 Prognathic maxilla 46 Inadequate maxillary width on full smile 

39 Vertical maxillary deficiency 47 Insufficient upper lip length 

41 Vertical growth pattern 48 Maxillary deficiency 

42 Bialveolar protrusive 49 Mandibular deficiency 

43 Flat facial profile 50 Prognathic mandible 

44 Convex (full) facial profile 51 Short lower face height 

45 Vertical maxillary excess 52 Excessive lower facial height 

Fixed Appliances  

Code Clinical Term Layman Term 

1 Rapid palatal expansion Upper jaw expander 

2 Headgear Headgear "Night gear" 

3 Partial upper orthodontic bonding Partial upper braces 

4 Partial lower orthodontic bonding Partial lower braces 

5 Full upper and lower orthodontic bonding Full upper and lower braces 

6 Full upper orthodontic bonding Full upper braces 

7 Full lower orthodontic bonding Full lower braces 

8 Lip bumper   

9 { } { } 
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Frenum  

Code Clinical Term 

1 Maxillary Labial - Heavy 

2 High Lingual 

3 High Mandibular Labial 

Functional Analysis  

Code Clinical Term 

1 Able to chew 

5 Debilitated chewing apparatus 

10 Unable to incise food 

Functional Appliance  

Code Clinical Term Layman Term 

1 Fixed Herbst Bite - Jumping Appliance Herbst Bite - Jumping Appliance 

2 Jasper Jumper Jasper Bite Jumper 

3 { }   

Functional Shift  

Code Clinical Term Code Clinical Term 

00 Anterior {}mm 06 Vertical {}mm 

02 Right lateral {}mm 10 None 

04 Left lateral {}mm     

Gingival Attachment 

Code Clinical Term Layman Term 

1 Thin Attached Gingiva Thin gum tissues 

2 Lack of Attached Gingiva Gum tissues very thin in some areas 

3 Gingival Recession   
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Habits 

Code Clinical Term Code Clinical Term 

57 Ant tongue 61 Fingersucking 

58 Lat Tongue 62 Lip Biting 

59 Thumbsucking 63 Occi Grind 

60 Night Thumb 64 Mentalls Hb 

Habits II  

Code Clinical Term Layman Term 

1 Thumb / Finger   

2 Tongue Thrust Tongue thrust swallow 

3 Bruxing - Slight Some night grinding 

4 Bruxing - Moderate Moderate night grinding 

5 Bruxing - Severe Severe night grinding 

6 Mouth Breather Breathes through mouth 

Headgear  

Code Clinical Term Code Clinical Term 

172 Cervical Headgear 174 Vertical Headgear 

173 Combl Headgear 175 Watch Headgear 

History  

Code Clinical Term Code Clinical Term 

1 Non-contributory 216 Significant stress experience 

5 Medical involvements 220 Orthodontic treatment in past 

6 Previously diagnosed migraine headaches 225 Previous bicuspid extractions 

10 Facial trauma 230 Third molar extractions 

11 Whiplash injury 235 Gradual crowding of teeth 

15 Congenital syndrome 240 Congenital absence tooth #{} 

20 Increasing awareness of pain 245 Primary tooth extraction/loss 

30 Tonsilar enlargement 300 Orthognathic jaw surgery-jaw locking 
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35 Familial trait expressed 400 Occlusal splint treatments-jaw locking 

36 Sinus involvements 401 Jaw locking 

100 Increasing jaw movement limitation 405 Intracapsular TM joint surgery 

105 Mouth breathing habit 410 Arthoscopic TM joint surgery 

106 Tongue thrust habit 415 Increasing awareness of joint sounds 

110 Thumb/finger habit 416 Jaw dysfunction related to pregnancy 

115 Behavior control problems 417 Jaw dysfunction related to yawning 

125 Bruxing, clenching 418 Jaw dysfunction related to dental procedure 

200 Early primary tooth loss 419 Jaw dysfunction related to general anesthesia application 

205 Late primary tooth loss 420 Jaw dysfunction related to one episode of chewing 

215 Orthodontic treatment ongoing     

Hygiene/Periodontic Health  

Code Clinical Term Code Clinical Term 

00 Excellent 04 Fair 

02 Good 06 Poor 

Impacted Teeth  

Code Clinical Term 

1 {} 

Impacted Teeth Evident Clinically 

Code Clinical Term 

1 Impacted teeth evident clinically: {} 

Included Radiographs 

Code Clinical Term Code Clinical Term 

1 None 4 Ceph Lateral - Date ({date}) 

2 Full Mouth Series - Date ({date}) 5 {X-ray type} ({date}) 

3 Panorex - Date ({date})     
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Lip Posture  

Code Clinical Term Layman Term 

1 Normal   

2 Apart   

3 Upper incisors on lower lip   

4 Short upper lip   

5 Hypertonic Tight muscles 

6 Hypotonic Loose muscles 

7 Thin Thin lips 

8 Full Full lips 

Lips at Rest  

Code Clinical Term 

65 Apart 

66 Together 

80 Lower lip behind upper incisor 

Lips Evaluation  

Code Clinical Term 

00 Balanced 

02 Full 

04 Recessive 

Mandibular Arch Length  

Code Clinical Term 

1 Mandibular arch length: Deficient {}mm 

2 Mandibular arch length: Excessive {}mm 

3 Mandibular arch length: Adequate 
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Mandibular Arch Length II  

Code Clinical Term Layman Term 

1 Mandible: Adequate No crowding in lower jaw 

2 Mandible: Crowded - Slight 1-2mm Slight crowding in lower jaw 

3 Mandible: Crowded - Moderate 3-5mm Moderate crowding in lower jaw 

4 Mandible: Crowded - Severe 6+mm Severe crowding in lower jaw 

5 Mandible: Spaced - Slight 1-2mm Slight spacing in lower jaw 

6 Mandible: Spaced - Moderate 3-5mm Moderate spacing in lower jaw 

7 Mandible: Spaced - Severe 6+mm Severe spacing in lower jaw 

Mandibular Position  

Code Clinical Term 

00 Orthognathic 

02 Retrognathic 

04 Prognathic 

Mandibular Width  

Code Clinical Term Layman Term 

1 Constricted Narrow lower jaw 

2 Broad Wide lower jaw 

Maxilla Position  

Code Clinical Term 

00 Orthognathic 

02 Retrognathic 

04 Prognathic 
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Maxillary Arch Length 

Code Clinical Term 

1 Maxillary arch length: Deficient {}mm 

3 Maxillary arch length: Adequate 

2 Maxillary arch length: Excessive {}mm 

Maxillary Arch Length II  

Code Clinical Term Layman Term 

1 Maxilla: Adequate No crowding in upper jaw 

2 Maxilla: Crowded - Slight 1-2mm Slight crowding in upper jaw 

3 Maxilla: Crowded - Moderate 3-5mm Moderate crowding in upper jaw 

4 Maxilla: Crowded - Severe 6+mm Severe crowding in upper jaw 

5 Maxilla: Spaced - Slight 1-2mm Slight crowding in upper jaw 

6 Maxilla: Spaced - Moderate 3-5mm Moderate crowding in upper jaw 

7 Maxilla: Spaced - Severe 6+ mm Severe spacing in upper jaw 

Maxillary Width 

Code Clinical Term Layman Term 

1 Constricted Narrow upper jaw 

2 Broad Wide upper jaw 

Maximum Opening  

Code Clinical Term 

1 { } mm 

Midline - Mandibular  

Code Clinical Term Layman Term 

1 Right { } mm Lower midline to the right 

2 Left { } mm Lower midline to the left 
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Midline - Maxillary  

Code Clinical Term Layman Term 

1 Right { } mm Upper midline to the right 

2 Left { } mm Upper midline to the left 

Midlines  

Code Clinical Term Code Clinical Term 

27 Max to Rt. 39 Mn to Rt. 

38 Max to Lft. 40 Mn to Lft. 

Missing Teeth  

Code Clinical Term Layman Term 

1 { } Missing 

Opening Deviation 

Code Clinical Term Layman Term 

1 Left Jaw opens deviating to left 

2 Right Jaw opens deviating to right 

Oral Hygiene  

Code Clinical Term 

84 Good 

85 Fair 

86 Poor 

Oral Hygiene II 

Code Clinical Term 

1 Good 

2 Fair 

3 Poor 
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Orthodontic Diagnosis  

Code Clinical Term Code Clinical Term 

1 Anterior open bite 205 Maxillary central diastema 

5 Anterior deep bite 206 Enamel mottling 

10 Posterior open bite 210 Lack of posterior vertical support 

15 Lingually inclined upper incisors 215 Excessive tooth mobility 

16 Lingually inclined lower incisors 216 Defective restorations # {} 

20 Gummy smile appearance 300 Facial asymmetry 

25 Class I molar relationship 305 Retrognathic facial profile 

30 Class I cuspid relationship 310 Prognathic facial profile 

35 Class II molar relationship 311 Flat facial profile 

40 Class II cuspid relationship 315 Long vertical facial pattern 

45 Class III molar relationship 320 Short vertical facial pattern 

50 Class III cuspid relationship 325 Short upper lip posture 

55 Maxillary dental crowding 340 Skeletal maxillary protrusion 

60 Mandibular dental crowding 345 Skeletal maxillary retrusion 

65 Maxillary and mandibular dental crowding 350 Skeletal mandibular protrusion 

70 Maxillary dental spacing 355 Skeletal mandibular retrusion 

75 Mandibular dental spacing 360 Skeletal bimaxillary protrusion 

80 Generalized dental spacing 365 Skeletal maxiallary and mandibular retrusion 

81 Short upper lip 370 Maxillary vertical excess 

82 Constricted circumoral musculature 375 Maxillary vertical deficiency 

85 Maxillary incisor protrusion 380 Mandibular vertical excess 

90 Mandibular dental spacing 385 Mandibular vertical deficiency 

100 Dental bimaxillary protrusion 386 Excessive curve of spee 

105 Maxillary incisor retrusion 390 Maxillary transverse discrepancy 

106 Traumatic maxillary intrusion 395 Mandibular transverse discrepancy 

110 Mandibular incisor retrusion 400 Constricted palatal formation 

120 Dental bimaxillary retrusion 401 Enlarged tonsilar tissues 
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125 Maxillary midline discrepancy {} mm 405 Constricted mandibular arch formation 

130 Mandibular midline discrepancy {} mm 410 Enlarged maxillary torus 

131 Maxillary central incisor diastema {} mm 415 Enlarged mandibular torus 

132 Centric relation/centric occlusal discrepancy 420 Cleft lip 

135 Anterior crossbite 425 Cleft palate 

140 Right posterior crossbite 430 Cleft lip and palate 

145 Left posterior crossbite 431 Generalized periodontal bone loss 

146 Right crossbite tendency 432 Periodontal bone loss tooth # {} 

147 Left crossbite tendency 500 Gingival stripping # {} 

150 Supernumerary tooth present # {} 505 Gingival inflammation 

155 Congenital tooth absence # {} 510 Gingival hyperplasia 

156 Crossbite # {} 515 Maxillary labial frenum hypertrophy 

160 Impacted tooth # {} 520 Mandibular labial frenum hypertrophy 

165 Blocked out tooth # {} 525 Lingual frenum hypertrophy 

166 Severely rotated # {} 600 Lack of cuspid guidance 

170 Tooth pain and sensitivity 605 Lack of incisal guidance 

175 Apparent tooth/arch size discrepancy 610 Posterior balancing interferences 

180 Root resorption # {} 615 Posterior working interferences 

185 Missing tooth # {} 620 Dual-bite habit 

186 Edentulous condition both arches 625 Prognathic mandibular posturing habit 

187 Edentulous upper arch 630 Mouth breathing habit 

188 Edentulous lower arch 635 Enlarged tosilar tissues 

189 Retained primary tooth # {} 640 Tongue/finger habit 

190 Possible ankylosis # {} 645 Anterior tongue thrust 

200 Peg lateral incisor # {} 650 Posterior tongue thrust 

201 Abnormal tooth development     
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Overbite  

Code Clinical Term Layman Term 

16 Normal (0-10%) The front teeth overlap normally in the vertical dimension 

14 Mild (15-45%) The vertical overlap of the front teeth is excessive (overbite) 

17 Moderate (50-80%) The vertical overlap of the front teeth is excessive (overbite) 

18 Severe (100%, deep impinging overbite) The incisor overbite is so excessive that the lower incisors hit the palate 

19 Openbite The front teeth do not touch when biting down (open bite) 

20 Edge to edge The front teeth are biting edge to edge (minimal overbite) 

Overbite II  

Code Clinical Term Layman Term 

1 Normal Vertical overlap of front teeth overlap normally 

2 Deep Bite Slight (30%) Upper and lower teeth overlap excessively 

3 Deep Bite Moderate (40%) Upper and lower teeth overlap excessively 

4 Deep Bite Moderate (60%)  Upper and lower teeth overlap excessively 

5 Deep Bite Severe (80%) Upper and lower teeth overlap severely 

6 Deep Bite Very Severe (100%) Upper and lower teeth overlap very severely 

7 Open Bite Slight ( 0 - 1mm) Upper and lower front teeth don't meet 

8 Open Bite Moderate (2 - 3 mm) Upper and lower front teeth are moderately open 

9 Open Bite Severe (4+ mm) Upper and lower front teeth are severely open 

10 Posterior Open Bite - Right Right back teeth don't meet 

11 Posterior Open Bite - Left Left back teeth don't meet 

Overjet  

Code Clinical Term Layman Term 

1 Overjet: Excessive {} mm The upper incisors are too far in front of the lower incisors (overjet) 

2 Overjet: Normal The upper front teeth bite slightly ahead of the lower, which is normal 

3 Overjet: Edge to Edge The front teeth are biting edge to edge (minimal overjet) 

4 Overjet: Pseudo Class III The lower front teeth bite in the front of the upper front teeth (underbite) 
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Overjet (2)  

Code Clinical Term Code Clinical Term 

1 Severe 4 Underbite (negative overjet) 

2 Normal 5 Moderate 

3 Edge to edge     

Overjet II  

Code Clinical Term Layman Term 

1 Normal Horizontal overlap of front teeth is normal 

2 Slight 1-3 mm Horizontal overlap of front teeth is slightly excessive 

3 Moderate 4-6 mm Horizontal overlap of front teeth is moderately excessive 

4 Severe 7 + mm Horizontal overlap of front teeth is severely excessive 

5 Edge to Edge Front teeth bite edge to edge, with no overbite 

6 Negative Upper teeth bite behind lower teeth 

Patient's Next Step 

Code Clinical Term Layman Term 

00 Observation No treatment is needed now; we will send a reminder for your next check-up 

02 Full diagnostic records Please schedule an appointment for full diagnostic records to aid in development of a 
treatment plan 

04 Partial diagnostic 
records 

Please schedule an appointment for partial diagnostic records to aid in development of 
a treatment plan 

06 Consultation Please schedule a consultation to discuss the diagnosis and treatment plan 

08 Periodontal evaluation A more thorough evaluation of the gums by a periodontist is necessary 

10 Schedule to start 
treatment 

You may schedule your first appointment to start orthodontic treatment 

Periodental Health  

Code Clinical Term Layman Term 

1 Localized Gingivitis Localized inflammation of gums 

2 Mild Gingivitis Mild inflammation of gums 

3 Moderate Gingivitis Moderate inflammation of gums 
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4 Severe Gingivitis Severe inflammation of gums 

5 Mild periodontal disease Mild periodontal disease 

6 Moderate periodontal disease   

7 Severe periodontal disease   

Post Treatment Concerns  

Code Clinical Term Code Clinical Term 

00 Root resorption on incisors 08 Maintenance of space closure 

02 Third molars may need to be extracted in the 
future 

10 Cervical decalcification due to poor oral hygiene during 
treatment 

04 Maintenance of deepbite correction 12 Treatment goals not reached due to patient's non-
compliance 

06 Late Class III type growth 14 Waiting for full eruption of the second molars 

Posterior Crossbites 

Code Clinical Term 

1 Posterior crossbites are absent 

2 Posterior crossbites are present 

Radiographic Interpretations  

Code Clinical Term Code Clinical Term 

1 No radiographs were taken at the time of this report 205 Degenerative osteoarthristis of left articular 
eminence 

2 Radiographs available indicate morphology within 
normal limits 

210 Steroid necrosis--right temporomandibular joint 

5 Anterior displacement of right mandibular condyle 215 Steroid necrosis--left temporomandibular joint 

6 Anterior displacement of left mandibular condyle 220 Ankylosis, fibrous--right temporomandibular joint 

10 Posterior displacement of right mandibular condyle 225 Ankylosis, fibrous--left temporomandibular joint 

15 Posterior displacement of left mandibular condyle 230 Ankylosis, osseous--right temporomandibular 
joint 

20 Degenerative osteoarthritis of right mandibular 
condyle 

235 Ankylosis, osseous--left temporomandibular joint 

25 Degenerative osteoarthritis of left mandibular condyle 240 Chondroma--right temporomandibular joint 

30 Flattening of superior surface of right condylar head 245 Chondroma--left temporomandibular joint 
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35 Flattening of superior surface of left condylar head 250 Rheumatoid arthritis--right temporomandibular 
joint 

40 Osteophyte formation--anterior surface of right 
condyle 

255 Rheumatoid arthritis--left temporomandibular 
joint 

45 Osteophyte formation--anterior surface of left condyle 300 Elongated and calcified right stylohyoid ligament 
(Eagle's syndrome) 

50 Agenesis of right mandibular condyle 305 Elongated and calcified left stylohyoid ligament 
(Eagle's syndrome) 

55 Agenesis of left mandibular condyle 310 Fractured odontoid process 

60 Hypoplasia of right mandibular condyle 315 Lateral displacement of second cervical vertebra 

65 Hypoplasia of left mandibular condyle 320 Rotational displacement of second cervical 
vertebra 

70 Hyperplasia of mandibular right condyle 325 Degenerative osteoarthritis of cervical vertebra 

75 Hyperplasis of mandibular left condyle 330 Compression of cervical intervertebral spaces 

76 Bone cyst formation right condyle 335 Fractured cervical vertebra--spinous process 

77 Bone cyst formation left condyle 340 Fractured cervical vertebra--left transverse 
process 

80 Lack of translation of right condyle upon joint 
extension 

345 Fractured cervical vertebra--right transverse 
process 

85 Partial translation of right condyle upon joint 
extension 

350 Osseous fusion of first cervical vertebra to 
occipital bone 

90 Lack of translation of left condyle upon joint extension 355 Osseous fusion of first and second cervical 
vertebra 

95 Partial translation of left condyle upon joint extension 360 Osseous fusion of second and third cervical 
vertebra 

100 Right horizontal condylar angle beyond normal limits 
on submental-vertex view 

365 Osseous fusion of third and fourth cervical 
vertebra 

105 Left horizontal condylar angle beyond normal limits 
on submental-vertex view 

370 Osseous fusion of fourth and fifth cervical 
vertebra 

200 Degenerative osteoarthristis of right articular 
eminence 

375 Radiographs appear to be within normal limits 
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Refer To  

Code Clinical Term Code Clinical Term 

235 Refer for ENT Evaluation 239 Refer for DDS Prophy & Exam 

236 Refer for TMJ Evaluation 240 Refer for 3rd Molar Removal, post ortho 

237 Refer for Freegingival Graft 241 Frenectomy may be needed post ortho 

238 Refer for Complete Perio Eval.     

Removable Appliance  

Code Clinical Term Layman Term 

1 Upper Bite plane Upper plastic bite opener 

2 Lower Bite plane Lower plastic bite opener 

3 Upper Hawley Upper plastic retainer 

4 Lower Hawley Lower plastic retainer 

5 Splint Plastic bite repositioner 

6 Splint Therapy Plastic bite repositioner 

7 Inclined Plane Plastic bite jumper 

00 Removable lower expander   

02 Quad helix appliance   

04 Bite plane   

06 Lip bumper   

08 Facebow   

10 High pull headgear   

12 Occlusal splint   

14 Facemask   

16 Bionator   

18 Twin Block Appliance   

20 Frankel   

22 Herbst   

24 Removable upper expander   

26 Intraoral elastics   
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28 Habit appliance   

30 Bite splint   

32 Upper spring retainer   

34 Lower spring retainer   

36 Removable upper retrainer   

38 Removable lower retainer   

Retention  

Code Clinical Term Code Clinical Term 

228 Mx Hw Mn 3-3 232 Mn Hw only 

229 Mx Hw LLA 233 Mn Ling Arch 

230 Mx Hw Mn Hw 234 Positioner 

231 Mx Hw only     

Skeletal Class 

Code Clinical Term Code Clinical Term 

1 Class I 3 Class II Div. II 

2 Class II Div. I 4 Class III 

Skeletal Evaluation  

Code Clinical Term Layman Term 

00 No skeletal imbalance The examination revealed no skeletal imbalance 

02 Prognathic maxilla The upper jaw is too far forward of the other facial structures 

04 Retrognathic maxilla The upper jaw is underdeveloped and is behind its ideal position 

06 Prognathic mandible The lower jaw is too far forward of the other facial structures 

08 Retrognathic mandible The lower jaw is underdeveloped, and is too far behind the upper jaw 

10 Skeletal openbite The jaw growth pattern has lead to insufficient overlap of the upper and lower 
teeth (open bite) 

12 Skeletal deepbite The jaw growth pattern has lead to excessive overlap of the upper and lower 
teeth 

14 Mandibular asymmetry to the 
right 

Uneven lower jaw growth has caused the chin to deviate to the right 



Dolphin Imaging User's Guide April 2011 

1018 DI_USER_GUIDE-11.5   Rev. 1.01 

16 Mandibular asymmetry to the 
left 

Uneven lower jaw growth has caused the chin to deviate to the left 

18 Excessive vertical 
development 

There is excessive vertical development of the upper jaw 

20 Deficient vertical development Deficient vertical development of the jaws has caused short facial height 

30 Narrow maxilla The upper jaw is narrow 

Skeletal Profile  

Code Clinical Term Layman Term 

1 Class I Normal skeletal profile 

2 Class II The lower jaw has not grown forward sufficiently 

3 Class III The lower jaw has grown ahead of the upper jaw 

Skeletal Vertical  

Code Clinical Term Layman Term 

1 Open Bite Long narrow facial pattern 

2 Deep Bite Short square facial pattern 

3 Normal Bite Normal vertical facial pattern 

Spacing 

Code Clinical Term Code Clinical Term 

40 Mild maxillary spacing 46 Moderate mandibular spacing 

42 Mild mandibular spacing 48 Excessive maxillary spacing 

44 Moderate maxillary space 50 Excessive mandibular spacing 

Status at Appointment 

Code Clinical Term Layman Term 

00 an initial examination initial examination appointment 

02 an observation observation appointment 
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Surgery 

Code Clinical Term Code Clinical Term 

177 Mx Frenectomy 180 Prob Mn Adv. Surg. 

178 Mn Frenectomy 181 Prob Mn Setback Surg. 

179 Prob Mx Impac surg.     

Third Molars 

Code Clinical Term Code Clinical Term 

87 No 3rd Molars 90 Max 3rds Only 

88 3rds pre & impac 91 Mn 3rds Only 

89 3rds pre & erupt     

Timing 

Code Clinical Term Code Clinical Term 

127 9 Months 130 18 Months 

128 12 Months 131 24 Months 

129 12-18 months 132 30 Months 

TM Joint Diagnosis 

Code Clinical Term Code Clinical Term 

1 Asymptomatic, functioning within normal limits 202 Functional subluxation of the left TM joint 

5 Myofacial pain dysfunction syndrome 205 Left TM joint hyperextension 

6 Psychological stress implications 206 Right TM joint hyperextension 

7 Potential Migraine headache involvement 210 Dysfunctional right TM joint subluxation 

100 Right TM joint capsulitis 215 Dysfunctional left TM joint subluxation 

105 Left TM joint capsulitis 220 Right TM joint closed lock tissue 
derangement 

110 Right TM joint soft tissue derangement/non-pathologic 225 Left TM joint closed lock tissue derangement 

115 Left TM joint soft tissue derangement/non-pathologic 300 Right condylar osteoarthrosis 

120 Right TM joint anterior disk displacement with reduction 305 Left condylar osteoarthrosis 

125 Right TM joint anterior disk displacement without 
reduction 

310 Right fractured condyle 
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130 Left TM joint anterior disk displacement with reduction 315 Left fractured condyle 

135 Left TM joint anterior disk displacement without reduction 320 Right condylar agenesis 

140 Medial component to disk displacement 325 Left condylar agenesis 

145 Lateral component to disk displacement 330 Right condylar ankylosis 

201 Functional subluxation of the right TM joint 335 Left condylar ankylosis 

TMJ 

Code Clinical Term Code Clinical Term 

79 No TMJ 82 Bilateral 

80 Clicking on the right side 83 Crepitus 

81 Clicking on the left side     

TMJ Clicking 

Code Clinical Term Layman Term 

1 Right Clicking Right joint click 

2 Left Clicking Left joint click 

3 Bilateral Clicking Right and left joint click 

4 Right Crepitus Grating noise in right joint 

5 Left Crepitus Grating noise in left joint 

TMJ Clinically Evident or Reported 

Code Clinical Term Code Clinical Term 

1 TMJ clicks clinically evident or reported: Not 
evident 

6 TMJ clicks clinically evident or reported: Lt "Pt Hx 
only" 

2 TMJ clicks clinically evident or reported: Rt 
palpable 

7 TMJ clicks clinically evident or reported: Rt & Lt "Pt 
Hx only" 

3 TMJ clicks clinically evident or reported: Lt 
palpable 

8 TMJ clicks clinically evident or reported: Rt & Lt, esp. 
Rt 

4 TMJ clicks clinically evident or reported: Rt & Lt 
palpable 

9 TMJ clicks clinically evident or reported: Rt & Lt, esp. 
Lt 

5 TMJ clicks clinically evident or reported: Rt "Pt Hx 
only" 
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TMJ Pain  

Code Clinical Term Code Clinical Term 

1 TMJ Pain: Not reported 4 TMJ Pain: Right and Left temporal areas 

2 TMJ Pain: Right temporal area 5 TMJ Pain: Right & left, especially right 

3 TMJ Pain: Left temporal area 6 TMJ Pain: Right & left, especially left 

TMJ Pain II 

Code Clinical Term Layman Term 

1 Right Pain Pain in right TMJ 

2 Left Pain Pain in left TMJ 

3 Bilateral Pain Pain in both joints 

4 Closed Lock Jaw won't completely open 

5 Open Lock Jaw won't completely close 

TMJ Symptoms 

Code Clinical Term Code Clinical Term 

1 No signs of symptoms of dysfunction noted 230 Stiff neck--left side 

5 Cephalgia--right frontal area 235 Cervical crepitus upon movement of neck 

10 Cephalgia--left frontal area 240 Right shoulder pain 

15 Cephalgia--right temporal area 245 Left shoulder pain 

20 Cephalgia--left temporal area 250 Numb sensation in left upper arm 

25 Cephalgia--right parietal area 255 Numb sensation in right upper arm 

30 Cephalgia--left parietal area 300 Ear pain--right ear 

35 Cephalgia--right occipital area 305 Ear pain-left ear 

40 Cephalgia--left occipital area 310 Fullness/stuffiness--right ear 

45 Cephalgia--at vertex of cranium 315 Fullness/stuffiness--left ear 

50 Right greater occipital nerve neuralgia 320 Itchiness--right ear 

55 Left greater occipital nerve neuralgia 325 Itchiness--right ear 

60 Right temporal arteritis 330 Dizziness/lightheadedness 

65 Left temporal arteritis 335 Loss equilibrium 
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70 Right maxillary sinus pain 340 Hearing loss 

75 Left maxillary sinus pain 345 Tinnitis--right ear 

80 Sinus drainage/chronic postnasal drip 350 Tinnitis--left ear 

85 Pain on right side of face 400 Right retroorbital pain or pressure 

90 Pain on left side of face 405 Left retroorbital pain or pressure 

95 Pain in right cheek or cheekbone 410 Photophobia 

100 Pain in left cheek or cheekbone 415 Occasional blurring or vision/tearing 

105 Right hemifacial paraxysmal neuralgia 500 Right preauricular pain or pressure 

110 Left hemifacial paraxysmal neuralgia 510 Left preauricular pain or pressure 

115 Neuralgia--right supraorbital nerve 515 Right temporomandibular joint pain or pressure 

120 Neuralgia--left supraorbital nerve 520 Left temporomandibular joint pain or pressure 

125 Neuralgia--right infraorbital nerve 525 Pain in right lower jaw 

130 Neuralgia--left infraorbital nerve 530 Pain in left lower jaw 

135 Maxillary odontalgia (tooth sensitivity) 535 Popping/clicking in right TMJ upon opening only 

140 Mandibular odontalgia (tooth sensitivity) 540 Popping/clicking in left TMJ upon opening only 

145 Right suboccipital pain 545 Reciprocal (opening and closing) clicks right TMJ 

150 Left suboccipital pain 550 Reciprocal (opening and closing) clicks left TMJ 

155 Facial numbness 555 Crepitus--right temporomandibular joint 

160 Trigeminal Neuralgia--right opthalmic division 560 Crepitus--left temporomandibular joint 

165 Trigeminal Neuralgia--left opthalmic division 600 Restricted opening of mouth 

170 Trigeminal Neuralgia--right maxillary division 605 Right mandibular deviation upon opening 

175 Trigeminal Neuralgia--left maxillary division 610 Left mandibular upon opening 

180 Trigeminal Neuralgia--right mandibular division 615 Deviation of the mandible upon protrusion 

185 Trigeminal Neuralgia--left mandibular division 620 Limited ability to move mandible to the right 

190 Bell's Palsey--right side of face 625 Limited ability to move mandible to the left 

195 Bell's Palsey--left side of face 630 Mouth "locks shut" 

200 Constant sore throat 635 Mouth "locks open" 

205 Feeling of foreign object in throat 640 Pain when chewing food 

210 Pain on right side of neck 645 Difficulty chewing food 
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215 Pain of left side of neck 650 Difficulty swallowing food 

220 Pain in back of neck 655 Constant clearing of the throat 

225 Stiff neck--right side     

Tongue 

Code Clinical Term 

1 Large 

Treatment 

Code Clinical Term Code Clinical Term 

120 Phase I treatment 124 Lower arch only 

121 Phase II treatment 125 Upper arch only 

122 Full band treatment 126 Phase I into Phase II 

123 Retainers only     

Treatment Duration 

Code Clinical Term Code Clinical Term 

0 {} 24 24 

18 18 28 28 

20 20 32 32 

22 22     

Treatment Objectives 

Code Clinical Term Code Clinical Term 

182 Reduce Overjet 202 Elim tongue thrust 

183 Resolve Crowding 203 Elim thumb habit 

184 Open Bite 204 Elim finger habit 

185 Close Open Bite 205 Advance Mandible 

186 Cls let open bite 206 Hold max growth 

187 Close Ext spaces 207 Bring max forward 

188 Close Max Dias 208 Advance incisors 
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189 Close Mn Dias 209 More Inc Torque 

190 Close Dias 8 & 9 210 Upright meso molars 

191 Corr Rotations 211 Bring ectopic in 

192 Corr Crossbite 212 Bond Remain Tth 

193 Corr Midlines 213 Ph I into Ph II 

194 Retract Incisors 214 Hold vertical growth 

195 Bring impacted teeth in 215 Create Lip Comp 

196 Expand max arch 216 Watch Cl III grow 

197 Expand mand arch 217 Watch root resorp 

198 Expand both arches 218 Assymetrical mandible growth 

199 Distal Mx Rt side 219 Reduce gummy smile 

200 Distal Mx Lft side 220 Level & align 

201 Distal Max Arch 221 Detail the occlusion 

Treatment Simulation 

Code Clinical Term Layman Term 

00 Comprehensive orthodontic treatment Comprehensive orthodontic treatment to address all the noted problems 

02 Partial orthodontic treatment Limited orthodontic treatment to address the chief complaints only 

04 TMJ therapy TMJ therapy to diagnose and address the joint problems 

06 Phase I orthodontic treatment Early interceptive orthodontic treatment to minimize the developing 
problems 

08 Re-evaluate Future evaluation to determine the necessity and timing of orthodontic 
treatment 

10 Re-treatment Re-treatment of the orthodontic problem is necessary 

12 No treatment indicated No orthodontic treatment is indicated at this time 

14 Orthognathic surgery Surgical correction of the underlying jaw abnormality 

Treatment Recommendations 

Code Layman Term 

1 Diagnostic records - comprehensive orthodontic evaluation 
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Code Clinical Term Code Clinical Term 

1 Diagnostic records--comprehensive orthodontic/TM 
joint evaluation 

280 RX supracrestal gingival fibrotomy 

5 Occlusal analysis--articulated models 281 RX maxillary labial frenectomy 

6 Postional analysis--hand held models 285 Repair fixed appliance 

10 Radiographic survey of skeletal morphology 290 Repair removable appliance 

15 Radiographic survey of dentition 295 Tooth positioner 

20 Radiographic survey of TM joints 300 Gnathological tooth positioner 

25 Magnetic resonance image of TM joints 305 Occlusal equilibration 

30 Arthrographic survey of TM joints 310 Upper spring retainer 

35 Evaluate for surgery to widen the palate 315 Lower spring retainer 

40 Evaluate for surgery to advance the maxilla 320 Upper adapter retainer 

45 Evaluate for surgery to retract the maxilla 325 Lower adapter retainer 

50 Evaluate for surgery to advance the mandible 330 Upper Hawley retainer 

55 Evaluate for surgery to retract the mandible 335 Lower Hawley retainer 

60 Evaluate for surgery to correct vertical discrepancy 340 Upper Circumferential retainer 

65 Evaluate for prosthetic/restorative treatment 345 Lower circumfrential retainer 

70 Evaluate for periodontic treatment 350 Thumb/finger restraining appliances 

71 Free gingival graft 351 Psychological support to discontinue thumb 
habit 

75 Evaluate for airway obstruction 400 Functional appliance growth modification 
treatment 

80 Evaluate for TM joint surgical intervention 405 Frankel Regulator FR-1 appliance for muscular 
adaptation 

100 Comprehensive orthodontic treatment 410 Frankel Regulator FR-2 appliance 

105 Orthodontic/surgical treatment 415 Frankel Regulator FR-3 appliance 

110 Two stage removable and fixed orthodontic appliance 
treatment 

420 Bionator functional appliance 

125 Continuation of current orthodontic treatment 425 Herbst functional appliance 

130 Dental alignment and arch coordination 430 Ligated anterior repositioning splint (LARS) 

135 Full fixed orthodontic appliances 435 Orthopedic corrector functional appliance (OPC) 

140 Upper full arch fixed appliance 440 Biofinisher appliance (verticalizer) 
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145 Lower full arch fixed appliance 500 Pretreatment guidance 

150 Upper 2x4 fixed appliance 501 Interceptive treatment 

155 Upper 2x4 fixed appliance with headgear 502 Placed on recall; to be seen in {} 

160 Lower 2x4 fixed appliance 505 Phase 1 interceptive/corrective treatment 

165 Upper anterior fixed appliance 510 Extraction # {} 

170 Lower anterior fixed appliance 515 Surgical exposure # {} 

171 Open/maintain space for bridgework 516 Surgical exposure and ligation of # {} 

175 Mandibular holding arch 520 Myofunctional evaluation and treatment as 
indicated 

180 Maxillary Nance holding arch 525 Eliminate gum chewing habit 

185 Cervical headgear 526 Reduce caffeine consumption 

190 Esthetic ceramic brackets 527 Reduce nicotine consumption 

195 Oblique headgear 530 Muscular deprogramming treatment and 
reevaluation 

200 Vertical pull headgear 535 RX anti-inflammatory medication 

205 Face-mask reverse traction to the maxilla 540 RX muscle relaxant medication 

206 J-hook headgear 545 RX physical therapy evaluation and treatment 

210 Chin-cup traction to the mandible 550 RX psychological evaluation and treatment as 
indicated 

215 Upper bite plane retainer 555 Ear evaluation 

220 Upper bite plane expander 560 Maxillary 2nd molar extraction regimen 

225 Upper sagittal appliance 561 Molar distalization followed by individual tooth 
retraction 

230 Lower sagittal appliance 562 Nance holding arch 

235 Rapid palatal expansion appliance 600 TM joint repositioning splint therapy 

245 Lower removable expansion appliance 605 TM joint stabilizing splint therapy 

250 Lower fixed expansion appliance 610 Postpone treatment awaiting further growth 
development 

255 Jasper Jumper anchorage 611 Postpone treatment due to behavioral problems 

260 Magnet molar distalization 612 Re-evaluate after muscular relaxation therapy 

265 Upper arch treatment only 613 Re-evaluate after anti-inflammation treatment 

270 Lower arch treatment only 614 Re-evaluate after symptom observation period 
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271 Partial appliance correction 615 Re-evaluate after Phase 1 orthodontic treatment 

275 Enamel reproximation (ERP) 616 Re-evaluate after completion of splint therapy 

Treatment Status 

Code Clinical Term Layman Term 

00 Consultation The next step is a consultation to review the treatment plan 

01 New patient exam The initial examination has not been completed 

02 Observation The patient has been placed on recall for future observation 

03 Start The patient is ready to start treatment 

04 Will Call We are waiting for a decision regarding whether to start treatment 

05 Phase I The patient is in Phase I treatment 

06 Interim The patient is currently between Phase I and Phase II of treatment 

07 Full Active The patient is currently in comprehensive orthodontic treatment 

08 Partial treatment The patient is currently in partial orthodontic treatment 

09 Retention The patient is currently in supervised orthodontic retention 

10 Phase II The patient is ready to start Phase II of the orthodontic treatment 

11 Transfer patient The patient transferred to our office from another office with orthodontic treatment in 
progress 

12 Re-treatment The patient is undergoing re-treatment for the original orthodontic problem 

13 Surgery The patient will have orthognathic surgery 

14 TMJ patient (TMJ) The patient has temporomandibular joint (TMJ) concerns 

15 Inactive   

16 delete chart   

18 New patient NO 
SHOW 

The patient missed the first scheduled appointment and needs to be contacted to 
reschedule 
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B DOLPHIN.INI File 
  
This appendix describes how to set up Dolphin Imaging options on your dolphin.ini file. The dolphin.ini file contains 
system settings for the Dolphin Imaging software. Some of these settings are required to configure the Dolphin Imaging 
software’s operation. Other settings are automatically maintained by the program to dynamically record its state. 
If you installed Dolphin Imaging initially on a computer running Microsoft Windows 7, Vista, or Server 2008, the dolphin.ini 
file is installed and maintained in your Dolphin folder. In your Windows folder, a "stub" dolphin.ini file is installed that 
contains a copy of [Environment] section from the dolphin.ini file in your Dolphin folder. 
If you installed Dolphin Imaging initially on a computer running an earlier Microsoft Windows version, even if you later upgraded 
to Windows 7, Vista, or Server 2008, the dolphin.ini file is installed in both your Dolphin and Windows folders. In this case, 
settings are maintained in the dolphin.ini file in your Dolphin folder, and those settings override any settings made in the 
file in your Windows folder 
A practice with several Dolphin Imaging workstations can have several dolphin.ini files, so that the operation of the 
Dolphin Imaging program on each workstation can be customized.  

Caution: You should fully understand the contents of the dolphin.ini file before attempting to modify the file. Settings in 
this file determine how the Dolphin Imaging software behaves, and setting these options improperly can cause problems in the 
software’s functioning. 
The following sections describe the sections of the dolphin.ini file as defined by the identifying tags and how to use the 
dolphin.ini file manager to coordinate multiple dolphin.ini files on networked workstations in your practice. 
  

Contents of a Dolphin.ini File 
The dolphin.ini file is divided into sections, each of which is identified by a tag that looks similar to the following example. 

[Licensee] 

These tags identify the purpose of that section of the dolphin.ini file. For example, the tag above identifies the section of 
the dolphin.ini file that identifies the software licensee.  
Note: In some cases, several instances of a particular tag may appear in the dolphin.ini file. For example, your 
dolphin.ini file may contain more than one section identified as a page setup. In this case, a modifier identifies the type of 
page setup to which the options apply. For instance, your dolphin.ini file may contain the following tags: 

[Page Setup Defaults] 

   . 

   . 

   . 

 

[Page Setup Composite Layout} 

   . 

   . 

   . 

In this example, the dolphin.ini file defines page setup options to use as defaults for page types for which specific options 
are not set. Then, it defines page setup options that apply only to the Composite Layout. 
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In the dolphin.ini file, a semi-colon (;) begins a comment. When the Dolphin Imaging program encounters a semi-colon in 
evaluating the dolphin.ini file, it skips the rest of that line. 

[Cephalometrics] 
This section of the dolphin.ini file specifies cephalometric preferences. It specifies the defaults used on the Digitize Setup 
dialog box. For more information on Digitize Setup dialog box, see "Digitize Setup" on page 303. 
The following shows an example of this section. 

[Cephalometrics] 

Lateral=R.M. Ricketts 

Lateral Xray=McNamara 

Frontal=Ricketts Frn 

Frontal Xray=[PA] Standard 

Arch=Both Arches 

Digitize Method=On Screen Modify 

Digitize View=Lateral Xray 

Lateral Xray Analyses=214,140,462,531,530,526,525,524,523,527, 
   529,521,520,522,528 

Lateral Analyses=204,202,206,208,203,205,207,209,201,200,90 

Arch Analyses=40,39,37,38 

Frontal Analyses=213,212,211 

Frontal Xray Analyses=228,227,226 

RulerLength=100 

CalibrationMethod=Ruler 

LandmarkDetail=0 

DigiShowTracings=0 

Arch=name Specifies the names of one or more default analyses to use for model arch digitizing (available on any 
system with Image Capture enabled). When you select the model arch digitizing analysis icon on the 
Digitize Setup dialog box, the specified analyses are already selected. 

CalibrationMethod Specifies the default calibration method. Possible values are: 
Landmark: Calibrate using landmarks (default). 
Ruler: Calibrate using a calibration ruler. 

DigiShowTracings Specifies whether the Show Tracings check box on the Digitize dialog box is checked. Possible values 
are: 
0: The Show Tracings check box is not checked. 
1: The Show Tracings check box is checked. 

Digitize Method Specifies the digitize method selected by default when you open the Digitize Setup dialog box. Possible 
values are: 
On Screen Capture: Selects the "Capture image, then digitize" radio button as the default. 
On Screen Existing: Selects the "Digitize (clear any existing points)" radio button as the default. 
On Screen Modify: Selects the "Add/Modify points" radio button as the default. 
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Digitize View Specifies the Analysis icon selected by default when you open the Digitize Setup dialog box. Possible 
values are: 
Lateral: Selects 3-D lateral digitizing, available only on the DigiGraph. 
Lateral Xray: Selects lateral X-ray digitizing, available on any system with Image Capture enabled. 
Frontal: Selects 3-D frontal digitizing, available only on the DigiGraph. 
Frontal Xray: Selects frontal X-ray digitizing, available on any system with Image Capture enabled. 
Arch: Selects model arch digitizing, available on any system with Image Capture enabled. 

Frontal=name Specifies the name of the default analyses to display when viewing 3-D frontal images. 

Frontal 
Xray=name 

Specifies the name of the default analysis to use when viewing frontal X-ray images. 

LandmarkDetail Specifies whether the landmark descriptions are displayed in the Landmarks list box. Possible values 
are: 
0: Landmark descriptions are not displayed. 
1: Landmark descriptions are displayed. 

Lateral=name Specifies the name of the default analysis to use when viewing 3-D lateral images. 

Lateral Xray=name Specifies the name of the default analysis to use when viewing lateral X-ray images. 

RulerLength Specifies the default length in millimeters of the Calibration Ruler used for digitizing X-rays (default is 
100). 

The Lateral Xray Analyses = number, Lateral Analyses = number, Arch Analyses = number, 
Frontal Analyses = number, and Frontal Xray Analyses = number lines specify internal program numbers 
which you should not modify. 

[COCRPreferences] 
Determines sign preferences for CO/CR. If  these are set to 1, CO/CR numbers show their sign inverted 

[COCRPreferences] 

InvertVertical=0 

InvertHorizontal=0 

[defaults] 
This section of the dolphin.ini file specifies default values that the Dolphin Imaging program uses. Many of these default 
values can be overridden by options selected on dialog boxes in the Dolphin Imaging program. The following shows an example 
of this section: 

[defaults] 

ArchiveFilePath=c:\dolphin\archive 

AutoStartCharts=1 

GoToCaptureAfterNewPatient=1 
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TracingLineThicknessMMForPrinting=0.25 

CaptureFromFilePath=d:\imfidx10;e:\imfidx10 

UseStamps=1 

ImageToStampRatio=5 

MinimumStampSize=300 

;ExposeVideoBatchPrintWindow=1 

;PrintButton=PrintPreview 

;PrintButton=Print1:1Preview 

;PrintButton=Print1:1 

;PrintButton=PrintToVideoPrinter 

PrintButton=Print 

MeasurementsMode=0 

TracingOverlaysMode=0 

AllowPatientChanges=0 

DisplaySplashScreen=1 

MeasurementTableFontPointSize=12 

TracingPrintTextScale=0.9 

SelectPatientShowImages=1 

SelectPatientSortedBy=0 

Acquisition Image=X-ray Lateral 

tool bar=1 

Statusbar=0 

Title=0 

FitImages=1 

BackgroundColor=192,192,192 

Maximize Window when double-clicked=0 

BackgroundBitmap=(None) 

BitmapStyle=1 

Layout=Composite (Inkjet) 

ImageLoadStyle=1 

Acquisition Sequence=- Facial-Intraoral-Occlusal - 

SplashTime=2000 

ImageCount=26 

Acquisition Input=3 

ImageFileType=LEAD 

CompressionQFactor=20 

SelectPatientImagePreviewDefaults=(FACIAL,FRONTSMILE), 
   (FACIAL,FRONT),(DIGI,RIGHT),(DIGI,RIGHTXRAY) 

WindowMaximized=1 

HorizontalGuideLines=16673,5296,27720 

VerticalGuideLines=7152,29014 
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OneClickMaximized=1 

TruncMeasTracing=0 

OneClickPreload=1 

OneClickPreview=1 

OneClickFillColor= 

OneClickUseBGColor=0 

PatListColumnInfo=0 93 1 81 

Country=USA 

SilentDBMessage=0 

OneClickLayoutInfo=0 

OneClickTooltipInfo=0 

OneClickLockGuidelines=1 

MeasurementsInColor=1 

SlideShowMaximized=0 

SaveOriginals=1 

TurnOnIdNumberInTooltip=0 

PromptOnExit=1 

Recycle=1 

The following table describes each of the default settings: 

Setting Description 

Acquisition Image The name of the default image to be modified. This setting should only be changed by 
Dolphin support technicians. 

Acquisition Input Specifies the default input device for image capture. Possible values are: 
1: video 
2: Twain device 
3: Image file 
4: Windows clipboard 
5: Xray 

Acquisition Sequence Specifies the default image capture sequence automatically selected when you open the 
Capture Setup dialog box. 

AllowPatientChanges Specifies whether the patient’s demographic information can be changed. Possible values 
are: 
0: The New and Change buttons in the Patient Charts or Patient Lookup dialog box are 
hidden and inaccessible so that patient demographic information cannot be changed from 
the Dolphin Imaging program. 
1: The New and Change buttons appear in the Patient Charts or Patient Lookup dialog box 
so that patient demographic information can be updated and changed (default). 
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2: Used for integrated systems where patient creation is done in the office management 
system. This setting does not allow the operator to add new patients or delete patients, but it 
does allow merging patients. 
You may want to prohibit changes if you use management system software to create and 
modify patient demographic information and only view this information in Dolphin Imaging.  

ArchiveFilePath The initial location used to save or load archive files. 

AutoStartCharts Specifies whether to display the Patient Charts or Patient Lookup dialog box automatically 
when no patient is specified when the Dolphin Imaging program is started. Possible values 
are: 
0: Don’t automatically start with Patient Charts or Patient Lookup 
1: Automatically start with Patient Charts or Patient Lookup (default) 

BackgroundBitmap Indicates the Dolphin Imaging main screen background bitmap as set using the General 
Preferences dialog box. For display options for the background bitmap, refer to the 
BitmapStyle setting, below. 

BackgroundColor Indicates the Dolphin Imaging main screen background color as set using the General 
Preferences dialog box. This value is specified in red, green, and blue components 
separated by commas--R, G, B where R, G, and B are values between 0 and 255, inclusive. 
By default, this value is set to the color specified for the Microsoft Windows operating 
system. 

BitmapStyle Sets the default display style for the background bitmap (see the BackgroundBitmap setting, 
above) on the General Preferences dialog box. Possible values are: 
0: Center 
1: Tile 

CaptureFromFilePath Specifies the directories that the Dolphin Imaging program should automatically search to 
locate image files when capturing images from "image file, memory card." The first valid 
directory becomes the directory listed in the Choose an Image File dialog box.  
The default setting d:\imfidx10;e:\imfidx10 is used for Fujix-type digital 
cameras. On some systems, you might need to change the drives to e: and f: depending 
on which drives are assigned to the memory card. 

CloakPatientNames  Specifies whether patient names are hidden throughout Dolphin Imaging.  Possible values 
are: 
0: Patient names are not hidden (default). 
1: Patient names are hidden. 

CompressionQFactor Specifies the compression ratio of the default image format. This setting is ignored for any 
file format that does not use compression. Possible values for the LEAD file format are -9 
(highest compression) to -1 (lowest compression). Possible values for all other file formats 
are 255 (highest compression) to 2 (lowest compression). For a list of file formats, refer to 
the ImageFileType setting, below. 
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Country Specifies the country to use for addresses. 

DisplayPhotoCorner 
Roundedness  

Indicates whether the images on the Dolphin main screen and in print output should have the 
rounded corners. The value is the radius of the arc in screen coordinates. Set to 0 to use 
square corners. Defaults to 20. 

DisplayQuality  Corresponds to the menu option "Display quality/Speed" for smoothing the photo displayed. 
Note the higher quality, the slower the Dolphin Imaging runs to display them. Possible values 
are: 
0: traditional (default) 
1: good 
2: better 
3: best 

DisplaySplashScreen Indicates whether to display the splash screen. 

EventsLog Indicates whether Dolphin Imaging should log events in the database log. Possible values 
are: 
1: log database events (default). 
0: do not log database events. 

ExposeVideoBatch 
PrintWindow 

Specifies whether the Video Batch Print window should be displayed. Possible values are: 
1: show the DOS window for video print. 
0: do not show the DOS window for video print. 

FitImages Internal use only. This setting should always have a value of 1. 

GotoCaptureAfterNewPatient Specifies whether to go immediately to the Capture Setup dialog box after a new patient is 
added, automatically closing the Patient Charts or Patient Lookup dialog box. Possible 
values are: 
0: Do not immediately go to Capture Setup after adding a new patient. 
1: Immediately go to Capture Setup after adding a new patient (default).  

GrayCompressionQFactor Specifies the compression ratio of the default image format. This setting is ignored for any 
file format that does not use compression. Possible values for the LEAD file format are -9 
(highest compression) to -1 (lowest compression). Possible values for all other file formats 
are 255 (highest compression) to 2 (lowest compression). The default value is 2. For a list of 
file formats, refer to the GrayImageFileType setting, below. 

GrayImageFileType    Specifies the default image file format gray-scale images in the Dolphin Imaging program. 
This setting is used if another application needs to access Dolphin Imaging images directly. 
Gray-scale images you capture are stored in the format specified by this setting. Possible 
values are: FILE_LEAD, FILE_JFIF (the default), or FILE_JTIF.  FILE_LEAD only supports 
8-bit grays. The other formats support 8- and 16-bit grays. 
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When you load 8 or 16-bit gray-scale images, that bit-per-pixel setting is preserved. Images 
that are less than 8-bit are loaded as 8-bit. Other images are loaded as 16-bit. When you 
save images, the bit-per-pixel setting is preserved.   
Note: Some combinations of settings are not allowed by LeadTools, so they are mapped to 
valid combinations while preserving the file type. 

HorizontalGuideLines Indicates the positions of the horizontal alignment guidelines on the One-Click Capture 
Setup dialog box at the last time an image was saved.  

ImageCount Specifies the maximum number of image descriptors. 

ImageFileBitsPerPixel Indicates the number of bits used to represent each pixel in an image file. 

ImageFileOpenUseWin16 Indicates whether to use the Win16 or Win32 style dialog box for opening image files. The 
Win16 version offers image previews. Possible values are: 
0: Use the Win32 style dialog box (default) 
1: Use the Win16 style dialog box. 

ImageFileType Specifies the default image file format for color images in the Dolphin Imaging program. This 
setting is used if another application needs to access Dolphin Imaging images directly. Color 
images you capture are stored in the format specified by this setting. Possible values are: 
LEAD (the default); TARGA, TGA; BMP; OS2; TIF; GIF; PCX; JFIF, and JTIF. 
When you load 8 or 24-bit color images, that bit-per-pixel setting is preserved. Other images 
are loaded as 24-bit color. When you save images, the bit-per-pixel setting is preserved.   
Note: Some combinations of settings are not allowed by LeadTools, so they are mapped to 
valid combinations while preserving the file type. 

ImageLoadStyle Currently unused. 

ImageToStampRatio Specifies the image to stamp ratio denominator; the stamp's width or height can be 1/n size 
of the original image, where n is the value entered on this line. The minimum stamp size is 
specified by the MinimumStampSize setting, described below. 

Layout Specifies the starting layout for the One-Click Capture dialog box.  

MakeDfsCompatible Changes the way that Dolphin copies and renames files when changing an existing footer so 
that Dolphin is compatible with Microsoft DFS in multi-office practices. Possible values are: 
0: Disable this feature (default). 
1: Enable this feature. 
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Maximize Window when 
double-clicked 

Specifies that when a picture is clicked, the main dialog box should maximize to full-screen mode 
and the picture should be zoomed into full size. Possible values are: 
0: Do not maximize the window when a picture is double-clicked 
1: Maximize the window when a picture is double-clicked (default).  

MeasurementsIn 
Color 

Indicates whether the measurement table and tracings should use color to indicate deviation from 
norm. Possible values are: 
0: Do not use color 
1: use color (default).  

MeasurementsMode Specifies whether the measurements table displays with an asterisk (*) as the norm deviation 
marker or uses a polygon to visually indicate norm deviation. Possible values are: 
0: use an asterisk (*). 
1: use a polygon 

MeasurementTable 
FontPointSize 

Specifies the point size of the measurements table output. The measurements table always 
appears in the Courier font. By default, the font size is 10 points. 
Many users prefer 12 point font, and older versions of the Dolphin Imaging program use 12 point 
Courier. When printing the measurements in 12 point Courier with polygon norms, use the 
landscape orientation. 

MinimumStampSize Specifies the minimum size for the stamp's width or height. The ImageToStampRatio setting, 
described above, is used to specify the stamp size. 

OneClickFillColor Indicates the color to use in the blank area around an image on the One-Click Capture Setup 
dialog box and when saving a cropped image. This value is specified in red, green, and blue 
components separated by commas--R, G, B where R, G, and B are values between 0 and 255, 
inclusive. By default, this value is set to white. 

OneClickMaximized Indicates whether the One-Click Capture Setup dialog box is maximized. Possible values are: 
0: The dialog box is not maximized. 
1: The dialog box is maximized (default) 

OneClickLayoutInfo Indicates whether image information is displayed on each image in the layout preview. Possible 
values are: 
0: This feature is set to off. 
1: This feature is set to on. 

OneClickLock 
Guidelines 

Indicates whether the guidelines in the layout preview are locked. Possible values are: 
0: This feature is set to off. 
1: This feature is set to on. 
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OneClickPreload Specifies whether the first group of images should be automatically loaded into the image layout 
preview when using One-Click capture. Possible values are: 
0: Do not preload the images. 
1: Preload the images (default). 

OneClickPreview Specifies whether to display thumbnail previews of images in the Unused Images list on the One-
Click Capture dialog box. Possible values are: 
0: Do not use thumbnails. 
1: Use thumbnails (default). 

OneClickTooltipInfo Indicates whether image information is displayed as tooltips in the layout preview. Possible values 
are: 
0: This feature is set to off. 
1: This feature is set to on. 

OneClickUseBGColor Stores the setting of the Printer Bkgd Color check box on the One-Click Preferences dialog box. 

PatListColumnInfo Stores the settings for the order and size of the columns of the patient list on the Patient Charts or 
Patient Lookup dialog box.  

PrintButton Use these lines to pick the behavior of the Print button. Remove the semi-colon (;) in front of the 
option you want to use. The options are: 
PrintButton=PrintPreview: choose this option to see a print preview when the Print 
button is selected. 
PrintButton=Print1:1Preview: choose this option to see a print preview with the 1:1 
option when the Print button is selected. 
PrintButton=Print1:1: choose this option to print with the 1:1 option when the Print 
button is selected. 
PrintButton=PrintToVideoPrinter: choose this option to print to a video printer 
when the Print button is selected. 
PrintButton=Print: choose this option to print when the Print button is selected. 

PromptOnExit Indicates whether to prompt for Pre-Backup when the user exits. Possible values are: 
0: This feature is set to off. 
1: This feature is set to on (default). 

Questionnaire Indicates the questionnaire that is currently selected. 

Recycle Specifies whether to send deleted patients, images, or timepoints to the recycle bin, so that they 
can be recovered, if necessary.  
Note: This feature works for files on physically local disk drives only. You cannot send files from 
network drives to the recycle bin. For example, if your working folder is set in the [Environment] 
section of your dolphin.ini file to a local directory (such as C:\Dolphin\Working), you can use this 
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recycle option. However, if your working folder is set in the [Environment] section of your dolphin.ini 
file to a network drive (such as \\Server\Dolphin\Working or H:\Dolphin\Working where H is a 
mapped network drive), you cannot use this recycle feature. 
Possible values are: 
0: Delete patients, images, or timepoints without placing them in the recycle bin. This setting is the 
default. 
1: Send deleted patients, images, or timepoints to the recycle bin. 

SaveOriginals Indicates whether to save the original, unaltered images as captured from the camera. Possible 
values are: 
0: This feature is set to off. 
1: This feature is set to on (default). 

SelectPatientImage 
PreviewDefaults 

Specifies the default image shown for the selected patient in the Patient Charts or Patient Lookup 
dialog box. Possible values are DIGI RIGHT, DIGI RIGHTXRAY, DIGI FRONT, DIGI 
FRONTXRAY, DIGI ARCH, FACIAL RIGHT, FACIAL FRONTSMILE, FACIAL FRONT, IO RIGHT, 
IO CENTER, IO LEFT, IO UPPER,IO LOWER, MODEL, VTO, and XRAY.  

SelectPatientShow 
Images 

Specifies whether to automatically display a preview image when you select a patient name on the 
patient list in the Patient Charts or Patient Lookup dialog box. Possible values are: 
0: Do not display a preview image. 
1: Display a preview image.  

SelectPatientSorted 
By 

Specifies how to sort patient names in the patient list on the Patient Charts or Patient Lookup 
dialog box. Possible values are: 
0: Sort by last name. 
1: Sort by patient ID.  

Side-By-Side when 
double-clicked 

Specifies that when the side-by-side check box is checked on the Dolphin Imaging main screen, 
the feature can be activated by double clicking. Possible values are: 
0: This feature is set to off. 
1: This feature is set to on. 

SilentDBMessage Specifies whether to show errors returned from the database. Possible values are: 
0: Do not show errors. 
1: Show errors. 

SingleInstanceUI Specifies whether only one copy of Dolphin Imaging can be open at any given time. Possible 
values are: 
0: This feature is set to off. 
1: This feature is set to on (default). 
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SlideShowMaximized Indicates whether the Slide Show dialog box is maximized. Possible values are: 
0: The dialog box is not maximized. 
1: The dialog box is maximized (default). 

SplashSound Lists a series of wave files, separated by semicolons. One of these files will be played rather than 
the built-in sound for when the splash screen displays. 

SplashTime Specifies the maximum amount of time, in milliseconds, that the splash screen is displayed if no 
user interaction (mouse or key click) occurs. In addition to a number of milliseconds, you can also 
use one of the following values for this setting: 
0: Do not display the splash screen. 
-1: Display the splash screen until user interaction occurs. 

Statusbar Specifies whether the status bar is displayed or hidden. Possible values are: 
0: Hide the status bar. 
1: Show the status bar. 

Title Specifies whether to display image titles by default. Possible values are: 
1: display image titles 
0: do not display image titles (default) 

ToolBar Specifies whether the tool bar is displayed or hidden. Possible values are: 
0: Hide the tool bar. 
1: Show the tool bar. 

TracingLineThickness 
MMForPrinting  

Specifies the thickness of printed tracing lines, in millimeters. Defaults to 0.25 mm. 

TracingOverlaysMode Specifies whether to start the Tracing program function with normal tracings comparisons or using 
the Profilogram feature. Possible values are: 
0: use normal tracings (default) 
1: use the Profilogram feature 

TracingPrintTextScale Specifies a scaling factor to adjust the font size for printing a combination of the measurement and 
tracings page. With the default font, text might appear too big to fit with the tracings. The option 
defaults to 0.7. 

TruncMeasTracing Indicates whether to crop the tracing so that it does not overlap with the measurements when 
printing a the patient’s tracing next to the measurements table.  
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TurnOnIdNumberInTooltip Displays Dolphin internal ID numbers of landmarks, table measurements, tracing lines, and 
tracing measurements. Used to design and modify custom analyses. Possible values are: 
0: Disable this feature (default). 
1: Enable this feature.  

TurnOnPredictor Indicates whether to use the digitization landmark predictor. When enabled, the landmark 
predictor displays two lines on the x-ray whose intersection identifies the predicted location of 
the landmark. Possible values are: 
0: Disable this feature (default). 
1: Enable this feature. 

UseOldPatientList Specifies that you want to use the Patient Charts dialog box with Dolphin Imaging Premium 
instead of using the Patient Lookup dialog box. Possible values are: 
0: Use Patient Lookup (default). 
1: Use Patient Charts. 

UseStamps Specifies whether to use lower resolution pictures in the image layout. Using this option causes 
the image layout to load more quickly. If you maximize an image in the layout, the high 
resolution picture is displayed. Possible values are: 
0: Do not generate or use lower resolution pictures. 
1: Use lower resolution pictures for the image layout. 

VerifyImageSave Specifies whether to run extra network checking upon saving files. Can slow performance. 
Possible values are: 
0: Do not run extra network checking upon saving files. 
1: Run extra network checking upon saving files. 

VerticalGuideLines Indicates the position of the vertical alignment guideline on the One-Click Capture Setup dialog 
box at the last time an image was saved.  

WindowMaximized Indicates whether the Dolphin Imaging window is maximized. Possible values are: 
0: The window is not maximized. 
1: The window is maximized (default) 

WindowPos Specifies the default window position for Dolphin Imaging windows. Specify this option using the 
following format: 
WindowPos=FLAGS,SHOWCMD,MinPos,MaxPos,NormPos 
where: 
FLAGS specifies the position of the minimized window and the method by which the window is 
restored. You can use either or both of the following flags: 
1: Specifies that the x and y positions of the minimized window may be specified. This flag must 
be specified if the coordinates are set using the MinPos parameter. 
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2: Specifies that the restored window will be maximized regardless of whether it was maximized 
before it was minimized. This setting is valid only the next time the window is restored. It does 
not change the default restoration behavior. This setting is only valid if the setting value 3 is 
specified for the SHOWCMD parameter. 
SHOWCMD specifies the current show state of the window. This member may be one of the 
following: 

0: Hides the window and passes activation to another window. 
1: Activates and displays the window. If the window is minimized or maximized, it is 
restored to its original size and position. 
2: Activates a window and displays it as an icon. 
3: Activates a window and displays it as a maximized window. 
4: Displays a window in its most recent size and position. The window that is currently 
active remains active. 
5: Activates a window and displays it in its current size and position. 
6: Minimized the specified window and activates the top-level window in the system’s 
list. 
7: Displays a window as an icon. The window that is currently active remains active. 
8: Displays a window in its current state. The window that is currently active remains 
active. 

MinPos specifies the position of the window’s top-left corner when the window is minimized. 
The position is specified as x, y coordinates. 
MaxPos specifies the position of the window’s top-left corner when the window is maximized. 
The position is specified as x, y coordinates. 
NormPos specifies the position of the window’s top-left corner when the window is minimized. 
The position is specified as x, y coordinates. 

[Environment] 
This is one of the most important sections of the dolphin.ini file. It specifies where the Dolphin Imaging software should 
look for important system and database files. The following shows an example of this section. 

[Environment] 

working=C:\Dolphin\Working 

archive=C:\Dolphin\Archive 

Imagelib=C:\Dolphin\Working 

IMPLANTS=C:\Dolphin\Working\Implants 

LandmarkPath=c:\Dolphin\Landmark 

SoundPath=c:\DOLPHIN\SOUNDS\Margaret 

DIGI=C:\Dolphin 

SYS=C:\Dolphin 

UseDB=1 

DolDBServer=(local) 

archive Specifies where the Dolphin Imaging archive list (database index file) resides. By 
default, this directory is set to C:\Dolphin\Archive. 
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DIGI Specifies the directory where the Dolphin Imaging program resides. By default, this 
directory is set to C:\DOLPHIN. 

DolDBServer MSDE database server name. This setting only applies to Dolphin Premium. 

ImageLib Specifies where the Image Library image files reside. To change the location of the 
Image Library files, contact Dolphin. Simply changing this path name will not 
successfully change this location. By default, this directory is set to 
C:\Dolphin\Working. 

Implants Specifies where the ImPlanner Implant image files reside. By default, this directory is 
set to C:\Dolphin\Working\Implants. 

LandmarkPath Specifies where the text descriptions for the Landmarks reside. By default, this 
directory is set to LandmarkPath=c:\Dolphin\Landmark. 

SecurityKeyContactServer Specifies the name or IP address of the computer to which the USB security dongle is 
attached. 

SecurityKeyContactServerFallback Specifies the action to take if the specified security key server is not found. Possible 
values are: 
0: Do not look for other security keys. 
1: Look for other security keys according to the default protocol order: local key via 
server, local key via driver, remote key (default). 

SoundPath Specifies where the Landmark sound files reside. For more information on specifying 
landmark sound files, see "Landmark Sounds" on page 1052. 

SYS Specifies the directory where the Dolphin Imaging program resides. By default, this 
directory is set to C:\DOLPHIN 

tmp Specifies the directory for temporary files. This setting is optional. 

useDB Specifies whether this Dolphin Premium is installed. Do not change this setting. 
Possible values are: 
0: This installation is not Dolphin Premium. 
1: This installation is Dolphin Premium. 

working Specifies where all Dolphin Imaging files reside. By default, this directory is set to 
C:\Dolphin\Working. 
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The following example shows how you would set the working, archive, currvol, and Imagelib lines of this section 
in a network environment: 

working=Z:\dolphin\working 
archive=Z:\dolphin\archive 
Imagelib=Z:\DOLPHIN\WORKING 

where Z: is the mapped server drive where the patient files are stored. 

[Export] 
This section of the dolphin.ini file provides options used to customize any special export options for specific layouts or 
pictures. The export options for Dolphin Letter System (DLS) pictures are configured in this section. The following shows an 
example of this section. 

[Export] 

DLSLetterImage=Letter Picture, PCX, c:\dolphin\letters\export\<id>.pcx 

File1=DLS Composite (JPG), JFIF, C:\Dolphin\Letters\Export\<id>c<tp>.jpg 

File2=DLS Facial (JPG), JFIF, C:\Dolphin\Letters\Export\<id>f<tp>.jpg 

File3=DLS Intraoral (JPG), JFIF, C:\Dolphin\Letters\Export\<id>i<tp>.jpg 

File4=DLS Occlusal (JPG), JFIF, C:\Dolphin\Letters\Export\<id>o<tp>.jpg 

File5=DLS X-Ray (JPG), JFIF, C:\Dolphin\Letters\Export\<id>x<tp>.jpg 

File6=DLS Misc (JPG), JFIF, C:\Dolphin\Letters\Export\<id>m<tp>.jpg 

ExportPath=C:\Dolphin\ 

ExportResolution=640 x 480 

ExportType=Bitmap 

FileAlwaysOverwrite=0 

ExportBitsPerPixel=8 

Each export setup line is specified on a separate line using the following format: 
File#=Label, Format, [BitsPerPixel,] FullPathFileFormula 

   [ExitRoutineBatchFile=FullPathExitRoutineBatch] 
The following table describes the elements of each export setup line: 

File# Indicates the export file for which this setup applies, where # is a number between 1 and 35. 

Label Identifies the layout or picture to which these export options apply. The label is free-form text. Try to use a 
short label. 

Format Indicates the image format. Possible values are: PCX, TGA, TIF, GIF, BMP, JFIF (JPEG), LEAD 

BitsPerPixel Indicates the number of bits per pixel for the image. Possible values are: 4, 8, 16, and 24. This element is 
optional. If you do not specify this element, it defaults to the selected format default. 
Note: Not all formats support all color resolutions. 
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FullPathFileFormula Indicates variables for which values are substituted at run-time. You can use the following variables: 
<id>: the current patient ID 
<tp>: the current patient timepoint 

This section also includes the following options: 

ExportPath Path to use to export patient records. 

ExportResolution Resolution to use when exporting patient images. 

ExportType Image format to use when exporting patient images. 

FileAlwaysOverwrite Indicates whether to overwrite files when exporting patient records. Possible values are: 
0: Do not overwrite. 
1: Overwrite 

ExportBitsPerPixel Number of bits per pixel to use when exporting patient images. 

[Gendex] 
This section is only needed if you are using the Gendex digital X-ray equipment package. In this case, this section specifies the 
Gendex image path. An example of this section appears below: 

[Gendex] 

GendexImagePath=C:\DOLPHIN\GENDEX 

In addition, the Dolphin Program installation directory must contain a subdirectory called GENDEX. You can create this 
subdirectory if it does not exist. 

[History] 
This section of the dolphin.ini file defines following items: 

• the Timepoints listed in the Timepoints list box on the Patient Lookup or Patient Charts dialog box. 

• the image keywords available on the Image Property dialog box. 

• the patient keywords available on the Details pane of the Patient Information dialog box. 

For more information on these dialog boxes, see Chapter 3 and Chapter 4. 
The following shows an example of this section: 

[History] 

TP.0=3 

TP.1=Final 

TP.2=Progress 

TP.3=Initial 
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IMGKW.0=3 

IMGKW.1=Facial 

IMGKW.2=Intro-oral 

IMGKW.3=X-ray 

  

PATKW.0=51 

PATKW.1=Class I 

PATKW.2=Class II div 1 

PATKW.3=Class II div 2 

PATKW.4=Class III 

PATKW.5=Ankylosis-primary 

PATKW.6=Ankylosis-permanent 

PATKW.7=Ectopic eruption 

PATKW.8=Premature Loss 

PATKW.9=Post. X-Bite 

PATKW.10=Ant. X-Bite 

PATKW.11=Missing teeth 

PATKW.12=Peg U2 

PATKW.13=Impacted U3 

PATKW.14=Supernumerary 

PATKW.15=Pathology 

PATKW.16=Ectopic/Impacted 

PATKW.17=High Angle 

PATKW.18=Open Bite 

PATKW.19=Deep Bite 

PATKW.20=VME 

PATKW.21=Asymmetry 

PATKW.22=TMD/MPD Trauma CL/CLP (facial clefts) 

PATKW.23=Ext 4s 

PATKW.24=Ext 5s 

PATKW.25=Ext U4s 

PATKW.26=Ext U5s 

PATKW.27=Ext L1 

PATKW.28=Ext U5-L4 

PATKW.29=Ext U4-L5 

PATKW.30=Asym Exts 

PATKW.31=Mand Adv. 

PATKW.32=Mand Setback 

PATKW.33=Mx Adv 

PATKW.34=Mx Setback 

PATKW.35=Mx Impaction 
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PATKW.36=Mx Downgraft 

PATKW.37=Surg Mx Expansion 

PATKW.38=Genioplasty 

PATKW.39=Segmental Mx 

PATKW.40=Non-Sx Compensation 

PATKW.41=Space Maintenance 

PATKW.42=Serial Extractions 

PATKW.43=Bite Splint 

PATKW.44=Functional Appliance 

PATKW.45=Implants 

PATKW.46=Phase I 

PATKW.47=Phase II 

PATKW.48=Re-Tx 

PATKW.49=Perio 

PATKW.50=Pre-Prosth 

PATKW.51=Endo 

TP.0=n Indicates the number of timepoints in the timepoint list. 

TP.#=name Each timepoint is defined on a separate line in this format, where # is a number assigned to this timepoint 
and name is the name of the timepoint as it appears in the Timepoints list box. In the Timepoints drop-
down list box on the Patient Charts dialog box, these timepoints are listed in reverse order (in this 
example, Initial would be at the top of the list). 

IMGKW.0=n Indicates the number of images keywords in the keywords list. 

IMGKW.#=name Each image keyword is defined on a separate line in this format, where # is a number assigned to this 
keyword and name is the name of the keyword as it appears in the keywords list.  

PATKW.0=n Indicates the number of patient keywords in the keywords list. 

PATKW.#=name Each patient keyword is defined on a separate line in this format, where # is a number assigned to this 
keyword and name is the name of the keyword as it appears in the keywords list.  

[ImageDescriptors] 
This section of the dolphin.ini file defines the various images that the Dolphin Imaging program uses. You use these 
images to create image sequences.  
Note: Please consult a Dolphin support technician before making any changes to the image descriptors. 
The information for each image is defined on a separate line using the following format: 

imageName=imageCode,view,type,size,iconType 
The following table describes each of the elements in the definition. 
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imageName Name of the image being defined. 

imageCode A number used in the [Sequences] and [Capture Sequence sequenceName] sections to 
reference the image in an image sequence. For more information on these dolphin.ini file sections, see 
"Image Sequences" on page 1048. 

view Identifies the general classification of the image. Possible values are: 
DIGI: DigiGraph images 
FACIAL: facial photograph images 
IO: intra-oral photograph images 
MODEL: model arch images 
X-RAY: X-ray images 

type Identifies the type of image under the general classification. 

size Specifies the height and width of the image. 

iconType Indicates the type of icon used to represent this image on the Patient Charts or Patient Lookup dialog box. For 
more information, see Chapter 4. 

The following shows an example of this section: 
[ImageDescriptors] 

3D Lateral=1,DIGI,RIGHT,640,480,R 

Lateral Ceph=2,DIGI,RIGHTXRAY,640,480,Rx 

3D Frontal=3,DIGI,FRONT,640,480,F 

Frontal Ceph=4,DIGI,FRONTXRAY,640,480,Fx 

Arch Diagnostic=5,DIGI,ARCH,640,480,A 

Facial Lateral=6,FACIAL,RIGHT,413,480,R 

Facial Frontal=7,FACIAL,FRONT,413,480,F 

Facial Frontal Smiling=8,FACIAL,FRONTSMILE,413,480,Fs 

Occlusal Upper=9,IO,UPPER,640,448,Up 

Occlusal Lower=10,IO,LOWER,640,448,Lo 

Intraoral Left=11,IO,LEFT,640,352,L 

Intraoral Center=12,IO,CENTER,640,352,C 

Intraoral Right=13,IO,RIGHT,640,352,R 

Arch study model Upper=14,MODEL,UPPER,640,480,Up 

Arch study model Lower=15,MODEL,LOWER,640,480,Lo 

Arch study model Left=16,MODEL,LEFT,640,480,L 

Arch study model Center=17,MODEL,CENTER,640,480,C 

Arch study model Right=18,MODEL,RIGHT,640,480,R 

X-ray Lateral=19,XRAY,RIGHT,800,600,C/P 

X-ray Intraoral Panoramic=20,XRAY,PANORAMICXRAY,800,400,C/P 
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X-ray Frontal=21,XRAY,FRONT,800,600,C/P 

X-ray Upper Occlusal=22,XRAY,UPPER,800,600,C/P 

X-ray Lower Occlusal=23,XRAY,LOWER,800,600,C/P 

X-ray Right Periapical Set=24,XRAY,PERIRIGHT,800,600,C/P 

X-ray Center Periapical Set=25,XRAY,PERICENTER,800,600,C/P 

X-ray Left Periapical Set=26,XRAY,PERILEFT,800,600,C/P 

[ImagePrintingAdjustments] 
This section of the dolphin.ini file applies only for a DOS-based Dolphin Imaging system that has been upgraded to 
Windows. It applies to Export and PrintToVideoPrinter commands available on the File menu on these systems. 
This section of the dolphin.ini file compensates for differences in the aspect ratio of images captured on a DOS-based 
Dolphin Imaging system (TARGA captured images) and images captured in the Windows-based Dolphin Imaging system. These 
differences in the aspect ratio cause the images appear to be too skinny or too fat. 
The following shows an example of this section. 

[ImagePrintingAdjustments] 

DefaultImageType=Auto                                               ;   VGA, TARGA, or Auto 

ExportPrompt=No                                                            ;   Yes, No 

PrintToVideoPrinterPrompt=No                                ;   Yes, No 

PrintToVideoNonVideoPrinterPrompt=No               ;   Yes, No 

DefaultImageType Set this option to Auto to have the Windows-based Dolphin Imaging software 
attempt to guess the image aspect ratio 

TightBorders Set this option to expand single images to fill the entire page. Possible values 
are: 
1: Expand single images to fill the entire page. 
2: Do not expand single images. 

ExportPrompt, 
PrintToVideoPrinterPrompt, 
PrintToVideoNon 
VideoPrinterPrompt 

Set these option to No in most cases. Set these option to Yes only if the user 
needs to have more control in the Dolphin Imaging user interface over setting 
the image aspect ratio. 

Image Sequences 
You use the following sections of the dolphin.ini file to specify the standard and custom automatic image capture 
sequences that are defined for Dolphin Imaging. 

• [Sequences]: You use this section to define defaults for image capture sequences. 

• [Capture Sequence sequenceName]: You use individual [Capture Sequence] sections to override the 
settings specified in the [Sequences] section for a particular image capture sequence. 

Note: Use a hyphen (-) before and after a sequence name so to make it easier to distinguish between single image names and 
sequence names (for example: "- Facials -"). 
The following table defines the image codes that are assigned to the individual images. You use these image codes to specify 
which pictures to include in an image sequence. 
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Image Code Description Image Code Description 

0 3D Lateral 13 Model Upper 

1 Lateral Ceph 14 Model Lower 

2 3D Frontal 15 Model Left 

3 Frontal Ceph 16 Model Center 

4 Arch 17 Model Right 

5 Facial Right 18 X-ray Lateral 

6 Facial Front 19 X-ray I/O Panoramic 

7 Facial Front Smile 20 X-ray Frontal 

8  Occ Upper 21 X-ray Occ Upper 

9 Occ Lower 22 X-ray Occ Lower 

10 I/O Left 23 X-ray Periapical Right 

11 I/O Center 24 X-ray Periapical Center 

12 I/O Right 25 X-ray Periapical Left 

The following options can be applied to any image in an image sequence: 

Filename Indicates the file name for an image file. You can specify this option in one of two ways: 
(Filename, name): name specifies the name of the file containing the image.  
(Filename, ?Next): specifies that the name of the file containing the image is the next in a series of image 
files. Dolphin Imaging uses the previous file name and increments the last character of the name by one. For an 
example of using this option, see "Capture Sequence" on page 1051.  

Mirror Specifies that a Buccal mirror should be used when this picture is taken. To set this option on, specify it as follows: 
(Mirror,1). 

UpsideDown Indicates that the image should be flipped upside down when it is captured. To set this option on, specify it as 
follows: (UpsideDown,1). 

Brightness Adjust the image brightness. Specify a number between -1000 to 1000 as follows: (Brightness, 25). 

Contrast Adjust the image contrast. Specify a number between -1000 to 1000, For example: (Contrast, 100). 

Equalize Equalize the image colors. To set this option on, specify it as follows: (Equalize,1). 

Hue Adjust color hues. Specify a number between -359 to 359 (color wheel degrees) as follows: (Hue, 50). 
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Rotate Rotate the image the specified number of degrees. Specify a number between -359 to 359 (degrees) as follows: 
(Rotate, 90). 

Saturation Adjust the image’s color saturation. Specify a number between -1000 to 1000 as follows: (Saturation, 300). 

Sharpen Adjust the image sharpness. Specify a number between -1000 to 1000 as follows: (Sharpen, 150). 

[MorphMovie] 
This section of the dolphin.ini file specifies options for the 2D Morphing feature. For more information, see Chapter 9. 
The following shows an example of this section. 

[MorphMovie] 

FillWithWhite=0 = 

 0 

FillWithWhite Specifies the behavior to use during 2D morphing if Dolphin Imaging runs out of pixels to process the morph 
algorithm. Possible values are: 
0: Use the last valid pixel to fill in as needed (default). 
1: Use white pixels to fill in as needed. 

[Sequences] 
This section of the dolphin.ini file specifies the default settings for the standard and custom automatic image capture 
sequences that are defined for Dolphin Imaging. You can override the sequences defined in this section in the [Capture 
Sequence sequenceName] sections. For more information, see "Capture Sequence sequenceName" on page 1051. 
You specify each image sequence on a separate line in the following format: 

sequenceName=[imageCode [option ...] ...] 
where sequenceName is the name of the image sequence, imageCode is the code for an image in the sequence (see "Image 
Sequences" on page 1048), and option indicates an option for processing this image (see "Image Sequences" on page 1048). 
An image sequence can have any number of images. For example, the following line defines an image sequence called - 
Facial-Intraoral-Occlusal -. 

- Facial-Intraoral-Occlusal -=5,6,7,12,11,10,8((UpsideDown,1)), 
         9((UpsideDown,1)) 

The following shows an example of this section. 
[Sequences] 

- Facial-Intraoral-Occlusal -= 

- Ceph (Scan) -=18 

- Pano (Scan) -=19 

- Std with Buccal Mirror -= 

- Facial-Intraoral -= 

- Quick -= 

- Models -= 

- Photo/Slide Archive (Scan) -= 

- Facials ONLY-= 

- X-Rays (Scan) -= 
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This example defines eight image sequences but only specifies the images for two of them. The - Ceph (Scan) - image 
sequence is defined to contain one image, image code 18 (X-ray Lateral). The - Pano (Scan) - image sequence is also 
defined to contain one image, image code 19 (X-ray I/O Panoramic). 

[Capture Sequence sequenceName] 
You use individual [Capture Sequence] sections to override the settings specified in the [Sequences] section for a 
particular image capture sequence. You specify each image in the sequence on a separate line in the following format: 

imageCode=[(option)], ...] 
where imageCode is the code for an image in the sequence and option indicates an option for processing this image (see 
"Image Sequences" on page 1048). An image sequence can have any number of images.  
This section also indicates the layout name to use in One-Click Capture for this capture sequence and the source device from 
which to capture the images. For more information on the layout names, see "[Layouts]" on page 1053. 
Possible source devices are: 
1: Video  
2: Twain device, such as a scanner  
3: Image file  
4: Microsoft Windows Clipboard 
5: Xray 
If the guidelines on the One-Click Capture dialog box have been locked, this section specifies the location of the guidelines. 
The following shows an example of this section. 

[Capture Sequence - Facial-Intraoral-Occlusal -] 

6=(Filename, dsc00001.jpg) 

7=(Filename, ?Next) 

5=(Filename, ?Next) 

11=(Filename, ?Next) 

12=(Filename, ?Next) 

10=(Filename, ?Next) 

8=(Filename, ?Next),(UpsideDown,1) 

9=(Filename, ?Next),(UpsideDown,1) 

SourceDevice=3 

Layout=Composite (Inkjet) 

HorizontalGuideLines=16384,27531 

VerticalGuideLines=20314,10692,27924 

This example uses a series of image file names. The first image specifies the image file name for image code 6 as 
dsc00001.jpg. Dolphin Imaging looks for the next image in the series (image code 7) in a file called dsc00002.jpg. For 
each subsequent image in the series, Dolphin Imaging increments the file name by one. Dolphin Imaging also flips the last two 
image files (image codes 8 and 9) upside down when capturing them. In this example, the source device is an image file (3) and 
the layout name to use in One-Click Capture is Composite (Inkjet). 
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[Landmark Definitions] 
This section of the dolphin.ini file provides the landmark definitions, which you can see by clicking More>> on the Digitize 
dialog box. For more information on the Digitize dialog box, see "Digitize Landmarks" on page 306. Each landmark has a 
definition in this section. 
The following shows an example excerpt from this section: 

[Landmark Definitions] 

Ruler Point 1=One of the points necessary to calibrate the size of 
   this image. Accuracy in locating this point determines the 
   accuracy of your final measurements. 

Ruler Point 2=One of the points necessary to calibrate the size of 
   this image. Accuracy in locating this point determines the 
   accuracy of your final measurements. 

Mechanical Porion=The most superior point of the external auditory 
   meatus. 

Porion=The most superior point of the external auditory meatus. 

Orbitale=The most inferior point of the external border of the 
   orbital cavity. 

      . 

      . 

      . 

<End of List>=This is the end of the landmark list to digitize.  
   If you are finished, simply hit "Ok" now. 

[Landmark Sounds] 
This section of the dolphin.ini file defines options for the Read the Landmarks feature on the Digitize dialog box. For more 
information on the Digitize dialog box, see "Digitize Landmarks" on page 306. 
This section begins with the PlaySound line, which is set to 1 if the Read the Landmarks check box is checked.  
The rest of the lines in this section list the sound files to use for each landmark. Each landmark’s sound files are defined on a 
separate line. Several sound files may be defined for each landmark. When reading the landmarks, the Dolphin Imaging program 
searches for the indicated sound files in order and plays the first file found for that landmark. 
The following shows an example excerpt from this section: 

[Landmark Sounds] 

PlaySound=1 

Mechanical Porion=PORION.WAV;porion2.wav;porion3.wav;porion4.wav; 
      porion5.wav 

Porion, Right=PORION.WAV;porion2.wav;porion3.wav;porion4.wav; 
      porion5.wav 

      . 

      . 

      . 

<End of List>=End of List.wav;End of List2.wav;End of List3.wav; 
      End of List4.wav;End of List5.wav 
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[Layouts] 
This section of the dolphin.ini file specifies the layouts available in the Layout drop-down list box on the Dolphin Imaging 
main screen. Each layout is specified on a separate line in the following format: 

layoutName=layoutTag, #ofPictures, (pictureType, location, size)[, (pictureType, location, size),...] 
The (pictureType, location, size) group of options should be provided for each picture in the layout. If the layout contains more 
than one picture, the (pictureType, location, size) groups should be separated by commas. 
The following table defines the format elements used to define layouts: 

layoutName Specifies the name of the layout as it appears in the Layout drop-down list box on the Dolphin Imaging main 
screen. 

layoutTag Specifies an internal tag of up to eight characters used to identify the layout. 

#ofPictures Specifies the number of pictures in the layout. 

pictureType Two numbers, separated by commas, that specify the type of a particular picture in the layout. 

location Two numbers, separated by commas, that specify x, y coordinates for the location of a particular picture in the 
layout. 

size Two numbers, separated by commas, that specify width and height of a particular picture in the layout. 

The following shows an example of this section: 

[Layouts] 

3D Lateral=3DLateral,1,(0,0,-1,-1,764,800) 

3D Frontal=3DFrontal,1,(0,2,-1,-1,764,800) 

Digitized - Ceph Lateral=CephLateral,1,(0,1,-1,-1,764,800) 

Digitized - Ceph Frontal=CephFrontal,1,(0,3,-1,-1,764,800) 

Arch=Arch,1,(0,4,-1,-1,764,800) 

Lateral X-ray=Ceph,(5,0,2,-1,800,600) 

Panoramic X-ray=Ceph,(5,1,2,-1,800,400) 

X-ray Images=XrayImages,8,(5,0,2,-1,134,140),(5,2,137,-1,134,140), 
   (5,1,272,-1,134,140),(5,3,407,-1,134,140),(5,4,2,140,134,140), 
   (5,5,137,140,134,140),(5,6,272,140,134,140), 
   (5,7,407,140,134,140) 

Study Models=StudyModels,5,(3,0,2,-1,134,140), 
   (3,1,137,-1,134,140),(3,2,272,-1,134,140), (3,3,2,140,192,144), 
   (3,4,213,140,192,144) 

Cut Paste & Superimposed=CutPaste,8,(4,0,2,-1,134,140), 
   (4,1,137,-1,134,140),(4,2,272,-1,134,140),(4,3,407,-1,134,140), 
   (4,4,2,140,134,140),(4,5,137,140,134,140),(4,6,272,140,134,140), 
   (4,7,407,140,134,140) 
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Simple=Simple,6,(1,0,2,-1,144,167),(1,2,155,-1,144,167), 
   (1,3,308,-1,144,167),(2,0,2,175,144,79),(2,2,155,175,144,79), 
   (2,1,308,175,144,79) 

Composite (InkJet)=CompInk,8,(1,0,2,-1,144,167), 
   (1,2,160,-1,144,167),(1,3,318,-1,144,167),(2,3,2,180,144,101), 
   (2,4,318,180,144,101),(2,0,2,295,144,79),(2,2,160,295,144,79), 
   (2,1,318,295,144,79) 

[Licensee] 
This section of the dolphin.ini file identifies the person or organization for whom the Dolphin Imaging software has been 
licensed. This information is used on the Dolphin Imaging splash screen, the About Box, in the tokens used for headers and 
footers in Page Setup, and by the Dolphin Letters System. The following shows an example of this section. 

[Licensee] 

Name=Dr. Robert B. Evans 

Address1=6325 De Soto Avenue 

Address2=Woodland Hills, CA 91367 

DoctorPhone1=818 435 1368 

DoctorPhone2= 

Address1 First line of the licensee’s address. 

Address2 Second line of the licensee’s address. 

DoctorPhone1 First telephone number for the licensee.  

DoctorPhone2 Second telephone number for the licensee. 

Name Name of the person or organization for whom the software has been licensed. 

[name Page Setup] 
These sections of the dolphin.ini file specify page setup options for the type of page layout identified by name. These 
options are specified in the Dolphin Screen Editor, which is described in Chapter 7. 
Note: The Page Setup feature is an advanced feature of the Dolphin Imaging program. Please consult a Dolphin support 
technician before making any changes in Page Setup. All changes to the Page Setup should be done using the Dolphin Screen 
Editor. 
The following shows an example of one of these sections. This example specifies the default page setup.  

[Page Setup Defaults] 

Header={PatientFirstName} {PatientLastName} 

Footer=Photos produced electronically using the Dolphin DIGITAL  
   Imaging System. 

Header.font=Arial,80,0,400, ,00000000 

Landscape=1 

Margins=0,0,0,0 

HFBorders=1 
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AdjustToPrintableArea=1 

Labels=0, 

PrintDriver=Use default printer 

BgPrtColor=0x00FFFFFF 

The values specified in this section may be overridden for a particular page or layout type in a page setup section specific to that 
page or layout type. 

[namePostCaptureAdjustments] 
These sections of the dolphin.ini file specify post capture adjustments for the type of image capture identified by name. 
For example, your dolphin.ini file might contain a section called [FacialPostCaptureAdjustments] that would 
define adjustments that Dolphin Imaging should perform to one or more of the facial pictures after capturing them. The post 
capture adjustments for each image in the section are specified on a separate line in the following format: 

imageName=[(option, value),...] 
You can specify the following adjustments. 

Option Description Possible values  

Brightness Adjust the image brightness. -1000 to 1000 

Contrast Adjust the image contrast. -1000 to 1000 

Equalize Equalize the image colors. 0 or 1 (1 sets this option on) 

GrayScale Import the image as a gray scale image 0 or 1 (1 sets this option on) 

Hue Adjust color hues. -359 to 359 (color wheel degrees) 

Mirror Specify that the image was taken using a mirror 0 or 1 (1 sets this option on) 

Rotate Rotate the image the specified number of degrees -359 to 359 

Saturation Adjust the image’s color saturation. -1000 to 1000 

Sharpen Adjust the image sharpness. -1000 to 1000 

UpsideDown Flip the image upside down. 0 or 1 (1 sets this option on) 
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The following shows an example of one of these sections. This example specifies post capture adjustments for the intra-oral 
pictures. 

[IoPostCaptureAdjustments] 

Right= 

Center= 

Left= 

UpperOcclusal=(UpsideDown, 1), (Brightness, 110), (Saturation, 70) 

LowerOcclusal=(UpsideDown, 1) 

[Patient Lookup] 
This section of the dolphin.ini file specifies options for the Patient Lookup dialog box. For more information, see "Patient 
Lookup (Dolphin Premium)" on page 94. 
The following shows an example excerpt from this section.  

[Patient Lookup] 

FILN=1 

FullList=0 

LiveSearch=0 

  

FILN  Indicates whether the First Initial Last Name search feature is enabled. When this feature is enabled, typing 
"smi" in the Look For drop-down list box and clicking Find Now returns Steve MIller. Possible values are: 
0: This feature is not enabled. 
1: This feature is enabled (default). 

FullList  Lists all patients in the patient list when you open the Patient Lookup dialog box. 
Note: This feature is not recommended if you have more than 500 patients. Enabling this feature when you 
have a large patient list makes opening the Patient Lookup dialog box very slow. 
Possible values are: 
0: Open the Patient Lookup dialog box with a blank patient list (default). 
1: Open the Patient Lookup dialog box with all patients listed in the patient list. 

LiveSearch  Search for patients as you type characters in the Look For drop-down list box, rather than waiting until you click 
Find Now.  0 is off (default), 1 is on. 
Note: This feature is not recommended if you have a large patient list, a slow computer, or a slow network. 
Enabling this feature under these circumstances makes searching for patients very slow. 
Possible values are: 
0: This feature is not enabled (default). 
1: This feature is enabled. 
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[Presentation] 
This section of the dolphin.ini file specifies options for the slide show feature. For more information on using this feature, 
see "To set up a new slide show" on page 197. 
The following shows an example excerpt from this section.  

[Presentation] 

LastSeq=Standard 

AutoShow=0 

Repeat=0 

SlideDuration=2 

SlideTransition=<Random> 

SQS.0=6 

SQS.1=Standard,0,Initial 

SQ.1.0=10 

SQ.1.1=13,Initial 

SQ.1.2=12,Initial 

SQ.1.3=10,Initial 

SQ.1.4=22,Initial 

SQ.1.5=21,Initial 

SQ.1.6=24,Initial 

SQ.1.7=20,Initial 

SQ.1.8=23,Initial 

SQ.1.9=50,Initial 

SQ.1.10=51,Initial 

SQ.1.Trans=Concentric inward fill 

SQS.2=Intraorals,-3,Initial 

      . 

      . 

      . 

AutoShow Indicates whether the Auto Show check box is checked by default on the Slide Show Setup dialog box. 
Possible values are: 
0: This check box is not checked (default). 
1: This check box is checked. 

LastSeq Indicates the name of the last sequence selected the last time the slide show was run. 

Repeat Indicates whether the Repeat Show check box is checked by default on the Slide Show Setup dialog box. 
Possible values are: 
0: This check box is not checked (default). 
1: This check box is checked. 

SlideDuration Indicates the default value in the Slide Duration In Seconds text box on the Slide Show Setup dialog box. 



Dolphin Imaging User's Guide April 2011 

1058 DI_USER_GUIDE-11.5   Rev. 1.01 

SlideTransition Indicates the default slide transition style on the Slide Show Setup dialog box. 

SQS.0 Indicates the total number of saved sequences. 

SQS.n Indicates the sequence name, timepoint index, and timepoint name for the sequence specified by n. For 
example, the entry SQS.1=Standard,0,Initial provides the following information for the first 
saved sequence: 
�����the sequence name is Standard. 
�����the timepoint index is 0. 
�����the timepoint name is Initial. 
 
 
The entry SQS.2=Intraorals,-3,Initial provides the following information for the second 
saved sequence: 
�����the sequence name is Intraorals. 
�����the timepoint index is -3. 
�����the timepoint name is Initial. 

SQ.n.0 Indicates the total number of images for the sequence specified by n. 

SQ.n.1 to 
SQ.n.x 

Indicate the image type and timepoint name for the image specified by x in the sequence specified by n. For 
example, the entry SQ.1.1=13,Initial provides the following information for the first image in the 
first saved sequence: 
�����The image type is 13. 
�����The timepoint name is initial. 
The entry SQ.1.10=51,Initial provides the following information for the tenth image in the first 
saved sequence: 
�����The image type is 51. 
�����The timepoint name is Initial. 

SQ.n.Trans Indicates the value in the Slide Transition drop-down list box on the Slide Show Setup dialog box for the 
sequence specified by n.  
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[PrintToTarga] 
If you have a digital color printer (inkjet, laser, or photographic printer), you do not need to use this section of the 
dolphin.ini file. This section of the dolphin.ini file specifies options for the advanced system feature used for printing 
on specially configured systems with Truevision TARGA 16 (and compatible) boards. Typically, these systems were upgraded 
from a DOS version of Dolphin Imaging with video printers. The following shows an example of this section. 

[PrintToTarga] 

BatchFile=c:\DOLPHIN\USRPRTGA.BAT 

BatchFile Identifies a batch file that will be invoked after the user selects the "Print to Video Printer" from the Dolphin 
Imaging main screen. Dolphin support technicians use this batch file allows to modify and customize the output to 
the Dolphin-configured video printer (typically Sony, Toshiba, or Panasonic models). For more information on this 
batch file, consult your Dolphin support technician. 

[Race] 
This section of the dolphin.ini file provides a mapping of the files containing information about racial norms to the names 
that appear in the Norm group box on the Info tab of the Patient Lookup dialog box. The following shows an example of this 
section. 

[Race] 

DefaultRace=Other 

Caucasian=Anglo American 

Japanese=Japanese 

Chinese=Chinese,Asian,South Pacific,American Indian,Korean 

Hispanic=Latin 

Black=African American 

Other=N/A 

DefaultCaucasian=Anglo American 

DefaultJapanese=Japanese 

DefaultChinese=Chinese 

DefaultHispanic=Latin 

DefaultBlack=African American  

DefaultOther=N/A 

Black The norm file to use if Black is specified on the Patient Lookup dialog box. 

Caucasian The norm file to use if Caucasian is specified on the Patient Lookup dialog box. 

Chinese The norm file to use if Chinese is specified on the Patient Lookup dialog box. 

DefaultBlack The default norm file to use if Black is specified on the Patient Lookup dialog box. 

DefaultCaucasan The default norm file to use if Caucasian is specified on the Patient Lookup dialog box. 

DefaultChinese The default norm file to use if Chinese is specified on the Patient Lookup dialog box. 

DefaultHispanic  The default norm file to use if Hispanic is specified on the Patient Lookup dialog box. 
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DefaultJapanese The default norm file to use if Japanese is specified on the Patient Lookup dialog box. 

DefaultOther The default norm file to use if Other is specified on the Patient Lookup dialog box. 

DefaultRace The norm file to use if no racial norm is specified on the Patient Lookup dialog box. 

Hispanic The norm file to use if Hispanic is specified on the Patient Lookup dialog box. 

Japanese The norm file to use if Japanese is specified on the Patient Lookup dialog box. 

Other The norm file to use if Other is specified on the Patient Lookup dialog box. 

Note: The settings in this section are used for initial display purposes only. Dolphin Imaging retains only its base categories 
(Caucasian, Japanese, Chinese, Hispanic, Black, and Other); it does not retain any race selections within those base categories. 
For example, if you select a race setting of Asian for a patient, the next time you display that patient’s information, it will display a 
race setting of Chinese (one of its base categories). 

[Sidexis] 
This section is only needed if you are using the Sidexis digital X-ray equipment package and the Sidexis program is not installed 
in C:\SIDEXIS\SIDEXIS.EXE. In this case, this section specifies the full path name of the Sidexis program. An example 
of this section appears below: 

[Sidexis] 

ExePath=D:\SIDEXIS\SIDEXIS.EXE 

[name Tracings] 
These sections of the dolphin.ini file specify options for the type of tracings identified by name. These options are 
specified in the Tracing Preferences dialog box, which is described in "To set tracing preferences." Your dolphin.ini file 
must contain the following tracings sections:  

[Primary Tracings] 

[Overlay Tracings] 

[Frontal Xray Primary Tracings] 

[Lateral Xray Primary Tracings] 

[Frontal Primary Tracings] 

[Lateral Primary Tracings] 

[Lateral Overlay Tracings] 

[Lateral Xray Overlay Tracings] 

[Arch Overlay Tracings] 

[Arch Primary Tracings] 

[VTOTracingPreferences] 

Each of these sections is defined using the following format: 
[name Tracings] 
Teeth=Option,Color 
Tracing=Option,Color 
Numbers=Option,Color 
Streaming=Option,Color 
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Profile=Option,Color 
Landmarks=Option,Color 
ShowImage=0 

Option can have the following values: 

Normal Display this tracing normally. This corresponds to checking the associated check box on the Overlay Tracing 
Preferences dialog box. 

Off Do not display this tracing. This corresponds to unchecking the associated check box on the Overlay Tracing 
Preferences dialog box. 

Color indicates the color in which to display the specified tracing as specified on the Overlay Tracing Preferences dialog box. 
The [Arch Overlay Tracings], [Arch Primary Tracings], [Lateral Xray Primary Tracings], 
[Lateral Overlay Tracings], [Lateral Xray Overlay Tracings], and 
[VTOTracingPreferences] sections also have a ShowImage line, which specifies whether the photograph image 
should be shown when overlaying the tracing. Set this option to 1 to show the image or 0 to hide the image. 
The following shows an example of one of these sections. This example specifies preferences for primary tracings. 

[Primary Tracings] 

Teeth=NORMAL,BLUE 

Tracing=NORMAL,GREEN 

Numbers=NORMAL,RED 

Streaming=NORMAL,YELLOW 

Profile=NORMAL,CYAN 

Landmarks=NORMAL,33023 

The following shows an example of the VTO tracing preferences section, illustrating the ShowImage line: 
[VTOTracingPreferences] 

Teeth=NORMAL,DARK BLUE 

Tracing=OFF,BLACK 

Numbers=OFF,DARK RED 

Streaming=OFF,BLACK 

Profile=OFF,BLACK 

Landmarks=OFF,DARK CYAN 

ShowImage=1 
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[tool bar] 
This section of the dolphin.ini file is used to add customized buttons to the horizontal tool bar on the Dolphin Imaging main 
screen. You can add up to six custom buttons. 
Each custom button is defined on a separate line using the following format: 

keyName=buttonText,tooltipText,buttonBitmap,command 
The following table describes the elements of this format: 

keyName Name of this custom button definition. 

buttonText Text to display on the button itself to identify the buttons’s purpose. 

tooltipText Text to display as a tool tip if the user places the mouse pointer over the button for a few seconds. 

buttonBitmap Bitmap image to use for the button. 

command Command to run when the user clicks the button. 
This command can include replacable tokens, such as PatientID, that Dolphin pre-processes before running 
the command. You can include any of the replacable tokens defined for the page setup feature. These tokens 
are defined in "Page Setup Tokens" in Appendix A. 

The following shows an example of this section. 
[tool bar] 

InvisalignTreat=Treat,Start Align Treat with this patient's info, 
   c:\dolphin\buttons\aligntreat.bmp,"C:\Program Files\ 
   Align\Treat2\bin\Treat2.exe" "C:\Program Files\Align\ 
   Patient Database\{PatientID}\{PatientID}.adf" 

OrthoCad=OrthCad,Start OrthoCAD with this patient's info, 
   c:\dolphin\buttons\orthocad.bmp,"C:\Program Files\ 
   Cadent\OrthoCad\OrthoCad.exe" c:\orthocad\models\{PatientID}.3dm 

  

[VtoMovementOverrides] 
This section of the dolphin.ini file defines the Treatment Simulation soft tissue movements. Any operation that does not 
appear in this section does not affect soft tissue movement. Each movement override is specified on a separate line in the 
following format: 
Command=Landmark,Op+,#+,Op-,#- 
where: 

• Command is a Treatment Simulation operation (such as CMD_A1_HORZ_TMM). 

• Landmark is a landmark (such as UPPER_LIP, STOMION_SUPER, LOWER_LIP, and so on) 

• Op+, Op- are one of the following: "*" - multiplication, "/" - division, "+" - addition, "-" - subtraction 

• #+, #- are any real number 
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For example: 
[VtoMovementOverrides] 

CMD_B1_HORIZ_TMM=(STOMION,/,6,/,6),(STOMION_INFER,/,2,/,2),(LOWER_LIP,/,2,/,2
),(ST_B_POINT,/,2,/,2) 
CMD_A_POINT_HORIZ_TMM=(SUBNASALE,/,4,/,4),(ST_A_POINT,/,2,/,2) 

Managing Multiple Dolphin.ini Files 
A practice with several Dolphin Imaging workstations can have several dolphin.ini files, so that the operation of the 
Dolphin Imaging program on each workstation can be customized.  
Typically, you set up these dolphin.ini files as follows: 

• You create a global dolphin.ini file that contains the default settings for all workstations in your practice. This file 
contains the settings for the Dolphin Imaging program except for preferences and presentations. 

• You create a local dolphin.ini file for each workstation in your practice. This file contains the settings that are 
customized for this particular workstation such as preferences and presentations. Any settings in this file override the 
settings in the global dolphin.ini file. The [Environment] section of the local dolphin.ini file indicates the 
location for the global dolphin.ini file. 

The Dolphin imaging program provides a dolphin.ini file manager that you can use to coordinate these dolphin.ini 
files. 
Two common reasons to use a global dolphin.ini file are: 

• Your want to use the same  dolphin.ini settings for all the workstations in your office. The benefits of using a 
global dolphin.ini file on all workstations include: 

Consistency within your practice: Changes to settings made in the global dolphin.ini file (except for 
preferences and presentations) are reflected on all workstations. 

Ease of making changes: You only need to make changes to dolphin.ini settings once. For example, if you 
change your server, you can change this setting in the global dolphin.ini file instead of changing the 
dolphin.ini file settings on each workstation. 

• You want to configure a notebook computer for both office and home use. 

When setting up a global dolphin.ini file, keep the following points in mind: 

• Settings in a local dolphin.ini file always override settings in a global dolphin.ini file. 

• Settings in the [Environment] section of a global dolphin.ini file must use universal naming convention (UNC) 
path names, such as \\server\c\dolphin\working. These settings cannot use the usual Microsoft path 
names, such as c:\dolphin\working. 

• The [Environment] section of each local dolphin.ini file must identify the location of the global dolphin.ini 
file. You use the dolphin.ini file manager to set this location for each workstation. 

• Each workstations'  local dolphin.ini file will contain entries created by the dolphin.ini file manager (such 
as  common=, commontemp=, alternate1=, alternate2=, and so on) as well as any customized settings for that 
workstation (such as preferences and presentations).  
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To start the dolphin.ini file manager: 

1. In the Microsoft Windows Explorer, open the folder in which the Dolphin Imaging Program is installed (typically 
c:/Dolphin). 

2. Double-click DolIniManager.exe to start the dolphin.ini file manager. 

The Dolphin INI Manager dialog box opens. 

 

Available Global 
(Alternative) INI Files 

Lists the global dolphin.ini files available on your network. 

Add INI path Click this button to add a dolphin.ini file to the list of available global INI files.  

Use Selected INI Click this button to use the file selected in the list of available global INI files as the global 
dolphin.ini file for this workstation.  

Edit Local INI Click this button to edit the local dolphin.ini file for this workstation.  

Edit Sel. INI Click this button to edit the file selected in the list of available global INI files.  

Show Advanced Click this button to access the dolphin.ini file manager's advanced options.  

Currently Selected Global 
INI 

Specifies the global dolphin.ini file that this workstation is currently set to use.  

Apply and Close Click this button to apply your changes and exit the dolphin.ini file manager.  

Cancel and Close Click this button to cancel your changes and exit the dolphin.ini file manager. 
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Setting up Global and Local DOLPHIN.INI Files 

To set up global and local dolphin.ini files: 

1. Decide which of your existing dolphin.ini files you want to use as the global dolphin.ini file. 

2. Start the dolphin.ini file manager, if you haven't already done so. 

3. Using the dolphin.ini file manager, copy the dolphin.ini file that you want to use as your global 
dolphin.ini file to your server. 

Typically, you should store the global dolphin.ini file in the following directory: 
\\server\c\dolphin\working\global. You should store it in a location that is regularly backed up.  

Note: Do not store your global dolphin.ini file in C:\DOLPHIN or C:\WINDOWS on any computer. 

4. For each workstation, use the dolphin.ini file manager to add this dolphin.ini file to the list of available 
global dolphin.ini files. 

5. In the dolphin.ini manager dialog box, select the new global dolphin.ini file from the Available Global 
(Alternative) INI Files list. Then, click Edit Sel. INI. 

6. In the [Environment] section of the new global dolphin.ini file, change all path names to universal naming 
convention (UNC) path names. Save the file, and exit from Notepad. 

Settings in the [Environment] section of a global dolphin.ini file must use universal naming convention (UNC) 
path names, such as \\server\c\dolphin\working. These settings cannot use the usual Microsoft path 
names, such as c:\dolphin\working. 

Note: You need to perform this step only once. You do not need to perform it on each workstation. 

7. For each workstation, use the dolphin.ini file manager to select this dolphin.ini file as the global 
dolphin.ini file. 

8. For each workstation, use the dolphin.ini file manager to empty the workstation's local dolphin.ini file. 

Emptying a workstation's local dolphin.ini file removes all entries except those created by the dolphin.ini 
file manager (such as  common=, commontemp=, alternate1=, alternate2=, and so on). 

Note: If you are using a global dolphin.ini file, you must empty the workstation's local dolphin.ini file. 
Otherwise, Dolphin reads the local settings, but it still save settings in the global dolphin.ini file. This can result 
in unexpected behavior. For example, if you edit a layout on your computer and save it, you will not see those 
changes, but everyone else using the global dolphin.ini file will see them.  

For each workstation, click Apply and Close to apply your changes and close the dolphin.ini file manager. 
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Configuring a Notebook Computer 

To configure a notebook computer for both office and home use: 

1. Start the dolphin.ini file manager, if you haven't already done so. 

The Currently Selected Global INI should be blank. If it is not, then this computer is already using a global 
dolphin.ini file. In this case, follow the procedure to configure a notebook computer that is already using a 
global dolphin.ini file (below). 

2. Copy the computer's local dolphin.ini file to c:\bin\network. 

You may need to create a new subfolder called network in the c:\bin folder.  

3. Copy the computer's local dolphin.ini file to c:\bin\local. 

You may need to create a new subfolder called local in the c:\bin folder.  

4. Add the c:\bin\network\dolphin.ini file to the list of available global dolphin.ini files. 

You can use the comment Network to identify this dolphin.ini file. 

To begin configuring a notebook computer that is already using a global dolphin.ini file for both home and office 
use: 

1. Use Microsoft Windows Explorer to copy the file c:\dolphin\dolphin backup.ini to 
c:\bin\local. 

Or, 

Use Microsoft Windows Explorer to copy the global dolphin.ini file to c:\bin\local. 

2. If you copied c:\dolphin\dolphin backup.ini, rename dolphin backup.ini in c:\bin\local to dolphin.ini. 

To complete the configuration: 

1. Add the c:\bin\local\dolphin.ini file to the list of available global dolphin.ini file. 

You can use the comment Local to identify this  dolphin.ini file. 

At this point, the Available Global (Alternative) INI Files list includes two paths:  

[Network] c:\bin\network\dolphin.ini 

[Local] c:\bin\local\dolphin.ini 

2. Select the local path from the Available Global (Alternative) INI Files list. Then, click Edit Sel. INI. 

3. In the [Environment] section of this dolphin.ini file, change all path names to use Microsoft path names path 
names (such as c:\dolphin\working). Save the file, and exit from Notepad. 

4. Select the network path from the Available Global (Alternative) INI Files list. Then, click Edit Sel. INI. 
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5. In the [Environment] section of this dolphin.ini file, change all path names to use universal naming convention 
(UNC) path names, such as \\server\c\dolphin\working). Save the file, and exit from Notepad. 

6. Empty the workstation's local dolphin.ini file. 

7. Select the dolphin.ini file to use depending on the computer's current location. 

Select the local path if the notebook is currently being used at home. Select the network path if the notebook is 
currently being used at the office. 

8. Click Apply and Close to apply your changes and close the dolphin.ini file manager. 

Note: Since you will need to use the dolphin.ini file manager to select the appropriate dolphin.ini file 
each time you change location, you may want to create a shortcut to the dolphin.ini file manager on the 
notebook computer's desktop. For more information, refer to your Microsoft Windows documentation. 

To change locations (either work or home): 

1. Start the dolphin.ini file manager, if you haven't already done so. 

2. Select the dolphin.ini file to use depending on the computer's current location. 

Select the local path if the notebook is currently being used at home. Select the network path if the notebook is 
currently being used at the office. 

3. Click Apply and Close to apply your changes and close the dolphin.ini file manager. 

4. Start Dolphin Imaging. 

Note: To make patients available for use off-line (not connected to the office network), you must archive those patients to a 
location on the notebook's C: drive, and then retrieve them from that location to use them locally. To make all patients available 
off-line, you  can copy the entire archive and working folders from the server to  the notebook's C: drive.  
If you are using Dolphin Premium, you must also copy the database files and have a local Microsoft SQL server running. For 
more information, contact your Dolphin representative. 

Adding a New Global Dolphin.INI File 

To add a new global dolphin.ini file to the list of available global INI files: 

1. Click Add INI Path... 

The Ini Entry Information dialog box opens, as shown below. 

2. Enter a comment that describes the global dolphin.ini file you want to add. 

The comment you enter will appear in the Available Global (Alternative) INI Files list on the Dolphin INI Manager dialog 
box. 

3. Type the full directory and file name for the global dolphin.ini file you want to add in the Full Path text box. 
Then, click OK 

Or, 
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Click the Browse... button to browse for the global dolphin.ini file you want to add. 

Typically, the global dolphin.ini file is stored in the following directory on your server: 
\\server\c\dolphin\working\global\dolphin.ini. 

4. Click OK to close this dialog box and add the global dolphin.ini file. 

The global dolphin.ini file you specified appear in the Available Global (Alternative) INI Files list on the Dolphin 
INI Manager dialog box. 

 
Comment Enter a description of the global dolphin.ini file you want to add. This comment will appear in the 

Available Global (Alternative) INI Files list on the Dolphin INI Manager dialog box 

Full Path Type the full directory and file name for the global dolphin.ini file you want to add in this text box 
((typically,  \\server\c\dolphin\working\global\dolphin.ini). 

Browse... Click this button to browse for the global dolphin.ini file you want to add. 

Selecting a Global Dolphin.ini File 

To select a global dolphin.ini file to use for this workstation: 

1. Select a dolphin.ini file from the Available Global (Alternative) INI Files list. 

2. Click Use Selected INI. 

The file you selected appears in the Currently Selected Global INI text box. 

3. Click Apply and Close to apply your change and exit the dolphin.ini file manager. 
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Editing a Dolphin.ini File 

To edit a local or global dolphin.ini file: 

1. Click Edit Local INI to edit the local dolphin.ini file for this workstation. 

Or, 

Select a global dolphin.ini file from the Available Global (Alternative) INI Files list. Then, click Edit Sel. INI. 

A Notepad window opens containing the appropriate dolphin.ini file. 

2. Use Notepad to any changes to the dolphin.ini file. 

Refer to your Microsoft Windows documentation for information on how to use Notepad. 

3. Use Notepad to save the dolphin.ini file. 

4. Save the file, and exit Notepad. 

Using Advanced Features 
The dolphin.ini file manager provides the following advanced features: 

• You can specify that you do not want to use any global dolphin.ini file. 

• You can delete a global dolphin.ini file from the Available Global (Alternative) INI Files list. 

• You can copy the local dolphin.ini file for this workstation to a particular folder. 

• You can remove all the contents of local dolphin.ini file for this workstation except for the entry in the 
[Environment] section that identifies the location of the  global dolphin.ini file. You would use this feature if you 
do not want to customize the Dolphin Imaging program's operation for this workstation. 

Each of these features is described below. 

To access the advanced features of the dolphin.ini file manager: 

1. Click Show Advanced. 

Additional buttons appear on the Dolphin INI Manager dialog box, as shown below. 
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Don't Use ANY 
Global INI 

Click this button to set this workstation to not use any global dolphin.ini file. In this case, 
the workstation only uses a local dolphin.ini file.  

Delete Entry Click this button to delete the selected global dolphin.ini file from the Available Global 
(Alternative) INI Files list.  

Copy Local INI to a 
Folder... 

Click this button to make a copy of the local dolphin.ini file for this workstation in another 
folder.  

Empty Local INI 
Except Global Entry 

Click this button to remove all entries from this workstation's local dolphin.ini file except for 
the entry in the [Environment] section that identifies the location of the global dolphin.ini 
file.  

To specify that this workstation should not use any global dolphin.ini file: 

1. Click Don't Use ANY Global INI. 

A dialog box appears asking you to confirm that you want this workstation to use only its local dolphin.ini file. 

2. Click Yes to set this workstation to use only its local dolphin.ini file. 

Or, 

Click No to cancel this operation and continue to use the selected global dolphin.ini file for this workstation in 
addition to its local dolphin.ini file. 
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To delete a global dolphin.ini file from the Available Global (Alternative) INI Files 

1. Select the global dolphin.ini file that you want to delete from the list. 

2. Click Delete Entry. 

A dialog box appears asking you to confirm that you want remove this global dolphin.ini file from the Available 
Global (Alternative) INI Files list.  

3. Click Yes to set this workstation to remove this global dolphin.ini file from the Available Global (Alternative) INI 
Files list.  

Or, 

Click No to cancel this operation. 

If you clicked Yes, the entry for the selected global dolphin.ini file is removed from the Available Global 
(Alternative) INI Files list. However, the file itself is not deleted from the computer's hard disk. 

To copy this workstation's local dolphin.ini file to another folder: 

1. Click Copy Local INI to a Folder.... 

The Save As dialog box opens so that you can select the folder in which to save a copy of the local dolphin.ini 
file. 

2. Select the folder in which you want to save the file. 

3. Optionally, enter the file name that you want to use for this file in the File Name text box. 

Typically, dolphin.ini files use the file name extension .ini. It is recommended that you do not change this 
extension. 

4. Click Save. 

To remove all entries from this workstation's local dolphin.ini file except for the global dolphin.ini file's location: 

Note: If you are using Dolphin Premium with Letters System (DLS), you must install DLS before completing this procedure. 

1. Click Empty Local INI Except Global Entry. 

A dialog box appears asking you to confirm that you want to remove all entries from this workstation's local 
dolphin.ini file except for the entry in the [Environment] section that identifies the location of the global 
dolphin.ini file. 

2. Click Yes to empty this workstation's local dolphin.ini file. 

Or, 

Click No to cancel this operation. 

Emptying a workstation's local dolphin.ini file removes all entries except those created by the dolphin.ini 
file manager (such as  common=, commontemp=, alternate1=, alternate2=, and so on). 
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When you empty a workstation's local dolphin.ini file, a backup copy of the original local dolphin.ini file 
is created and called dolphin.ini.erased. If needed, you can revert to this file. 

Note: The contents of the local dolphin.ini file are copied to the dolphin.ini.erased file each time 
you empty the workstation's local dolphin.ini file. If the dolphin.ini.erased file already exists, it is 
overwritten. If, for any reason, you empty the local dolphin.ini file more than once, you should manually save 
the existing dolphin.ini.erased file with another name so that your original file settings will still be available if 
you need to revert to them. 

Exiting from the Dolphin.ini File Manager 

To exit from the dolphin.ini file manager: 

1. Click Apply and Close to apply your changes and exit the dolphin.ini file manager. 

Or, 

Click Cancel and Close to cancel your changes and exit the dolphin.ini file manager. 
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C Digital Radiographic System Integration 
Dolphin Imaging supports direct TWAIN integration with many digital x-ray systems (such as Instrumentarium, Planmeca, and 
Gendex), alleviating the need to develop, support, and maintain custom x-ray integration 
In addition, Dolphin Imaging has custom integrations with several popular digital radiographic systems. If you have one of these 
systems, you can capture images from it into the Dolphin Imaging System. Before you begin capturing pictures from a digital 
radiographic system into Dolphin, you need to have the digital radiographic equipment and software correctly installed and 
integrated with Dolphin.  
The following digital radiographic system integrations are available. Dolphin Imaging provides complete documentation for these 
systems. 

Product Company Web Site  

CD-DENTTM OREX Computed Radiography Inc. www.orex-cr.com 

COMBI-XTM OREX Computed Radiography Inc. www.orex-cr.com 

ComCAT Imaging Sciences International www.imagingsciences.com 

DenOptixTM Gendix www.gendexxray.com 

DIGORA→ SOREDEX  www.soredex.com 

Dimax2  Planmeca Group  www.planmeca.com 

Dixi∅2 Planmeca Group  www.planmeca.com 

Kodak 8000C (**Orthodontic**) Kodak www.kodak.com 

Orthoceph→ OC100 D GE Healthcare www.gehealthcare.com/usen/dental/ 

Orthopantomograph→ OP100 D GE Healthcare www.gehealthcare.com/usen/dental/ 

ORTHOPHOS/SIDEXIS Sirona www.sirona.com 

Paxorama XiTM OREX Computed Radiography Inc. www.orex-cr.com 

Scan-X Air Techniques www.airtechniques.com 

Trophy (both orthodontic and dental)  Kodak www.kodak.com 



Dolphin Imaging User's Guide April 2011 

1074 DI_USER_GUIDE-11.5   Rev. 1.01 

D Practice Management System Integration 
Dolphin Imaging has been integrated with several popular practice management systems. By integrating your practice 
management system with the Dolphin Imaging System, you can easily share information between the two programs. Information 
that you enter using your practice management system is seamlessly imported into Dolphin, and the Dolphin patient images are 
available from the practice management system.  
The following practice management system integrations are provided by Dolphin. You can contact your Dolphin representative to 
purchase these integration packages, which include complete documentation: 

Product Company 

Dentrix Dentrix 

EagleSoft Patterson Technology  

OPMS KODAK 

Orthosoft KODAK  

Orthotrac Classic KODAK  

Orthotrac Classic Connect KODAK  

Orthotrac Office (OMS) KODAK  

OrthoWare KODAK  

Practiceworks Dental  KODAK  

SoftDent KODAK  

WinOMS CS KODAK  

The following practice management system integrations are provided by the practice management system provider. You can 
contact your practice management system representative to purchase these integration packages or find out more information 
from the company web site listed below: 

Product Company Web Site or E-Mail 

axiUm Academic Practice Management 
System 

Exan Academic www.exanacademic.com 

Arakis Arakis www.arakis.fr 

ClinicView ClinicView clinicview@earthlink.net 

CPS Clinical Product Suite Quality Systems, Inc. (QSI) www.qsii.com 
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Dental-Exec DSN Software (Data Systems Northwest) www.dsnsoft.com 

DentalVision Enterprise Discus Dental www.discusdental.com 

DentalVision Professional Discus Dental www.discusdental.com 

DENTECH for Windows Softech, Inc. www.dentech.com 

DOX (Dental Office Xpress) KSB Dental www.ksbdental.com 

EndoVision Discus Dental www.discusdental.com 

IMS for Orthodontics  IMS Specialty Services, Inc. www.ims-tech.com 

MEDIMS Nectech, Inc. www.medims.com 

OASiS  OASiS Software Pty Ltd www.oasis-
software.com.au 

OAsys OAsys, Inc. www.oasys-practice.com 

OMS Navigator OMS COMP (now Kodak) www.kodak.com 

OMSVision Discus Dental www.discusdental.com 

OneTouchTM  Ortho Computer Systems, Inc. (Ortho II) www.orthoii.com 

Oral Surgery-Exec DSN Software (Data Systems Northwest) www.dsnsoft.com 

Orthalis 4.0 Orthalis www.orthalis.fr 

OrthoChart OrthoChart, LLC www.orthochart.com 

OrthoExec New Horizons Software, Inc. www.nhsoftware.com 

OrthoExec Advanced Series New Horizons Software, Inc. www.nhsoftware.com 

OrthoManagerTM DrRx (formerly Centaur Management Systems, 
Inc.) 

www.orthomanager.com 

Perio-Exec DSN Software (Data Systems Northwest) www.dsnsoft.com 

PerioVision Discus Dental www.discusdental.com 

Power Practice Exan Mercedes Software www.exansoftware.com 

Robadent Robadent Softwarehouse. www.robadent.com 
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Tracker Bridge Network www.bridge-network.com 

ViewPointTM Ortho Computer Systems, Inc. (Ortho II) www.orthoii.com 

Windent 2000 Windent www.windent.com 

Windent EE Windent www.windent.com 

Windent OMS Windent www.windent.com 

Windent SQL Windent www.windent.com 

WOW Office Suite Orthodontic Software Solutions, LLC (OSS) www.osstoday.com 
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E Recommended Readings 
The following readings are recommended: 

• Alexander, R. G. (1986) The Alexander Discipline 

• Athanasiou, A. E. (1995) Orthodontic Cephalometry 

• Jacobson, A. (1995) Radiographic Cephalometry 

• Ricketts, Roth, et. al. (1982) Orthodontic Diagnosis and Planning, Volumes 1 and 2 

• ABO Guideline 

For more information on the Arnett/McLaughlin treatment simulation features, the following readings are recommended: 

• Facial keys to orthodontic diagnostics and treatment simulation. Part I. the problem. AJODO April 1993  
GW Arnett, RT Bergman,  

• Facial keys to orthodontic diagnosis and treatment simulation. Part II, the solution. AJODO May, 1993  
GW Arnett, RT Bergman 

• Soft Tissue Cephalometric Analysis: Diagnosis and Treatment planning of dentofacial deformity. AJODO 
1999;116:239-53. Arnett et al. 
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